
目 录

前言

第1部分 MATLAB基础知识
第1章 MATLAB概述

1.1 MATLAB 7简介
1.2 MATLAB 7的安装
1.3 MATLAB 7的工作环境

1.3.1 操作界面简介
1.3.2 运行命令窗口
1.3.3 命令窗口的显示方式
1.3.4 数值结果的显示方式
1.3.5 命令窗口的标点符号
1.3.6 输入变量
1.3.7 处理复数
1.3.8 命令窗口的控制命令
1.3.9 使用历史窗口
1.3.10 使用实录命令
1.3.11 当前目录浏览器和路径管理
1.3.12 设置当前目录
1.3.13 MATLAB的搜索路径
1.3.14 工作空间浏览器和数组编辑器
1.3.15 变量的编辑命令
1.3.16 数组编辑器
1.3.17 存取数据文件

1.4 MATLAB 7的帮助系统



1.4.1 纯文本帮助
1.4.2 演示（demo）帮助
1.4.3 帮助导航／浏览器
1.4.4 Contents帮助文件目录窗口
1.4.5 Index帮助文件索引窗口
1.4.6 Search帮助文件搜索窗口

1.5 小结
第2章 数组

2.1 创建数值数组
2.1.1 一维数组的创建方法
2.1.2 二维数组的创建方法
2.1.3 使用下标创建三维数组
2.1.4 使用低维数组创建三维数组
2.1.5 使用创建函数创建三维数组
2.1.6 创建低维标准数组
2.1.7 创建高维标准数组

2.2 操作数值数组
2.2.1 选取低维数组的对角元素
2.2.2 低维数组的形式转换
2.2.3 选取三角矩阵
2.2.4 Kronecker乘法
2.2.5 高维数组的对称交换
2.2.6 高维数组的维序号移动
2.2.7 高维数组的广义共轭转置
2.2.8 高维数组的降维操作

2.3 小结
第3章 矩阵和架构



3.1 稀疏矩阵
3.1.1 稀疏矩阵的存储方式
3.1.2 创建稀疏矩阵——使用sparse命令
3.1.3 创建稀疏矩阵——使用spdiags命令
3.1.4 查看稀疏矩阵的信息
3.1.5 稀疏矩阵的图形化信息

3.2 字符串数组
3.2.1 创建字符串数组——直接输入法
3.2.2 创建字符串数组——使用ASCII码
3.2.3 创建字符串数组——使用函数
3.2.4 处理字符串数组的空格
3.2.5 读取字符串数组的信息

3.3 构架数组
3.3.1 创建单构架数组——使用直接法
3.3.2 创建二维构架数组
3.3.3 创建三维构架数组
3.3.4 使用命令创建构架数组
3.3.5 访问构架数组的数据
3.3.6 设置构架数组的域属性

3.4 小结
第4章 矩阵分析

4.1 矩阵计算
4.1.1 进行范数分析——使用norm函数
4.1.2 进行范数分析——使用normest函数
4.1.3 条件数分析
4.1.4 数值矩阵的行列式
4.1.5 符号矩阵的行列式



4.1.6 矩阵的化零矩阵
4.2 线性方程组

4.2.1 非奇异线性方程组
4.2.2 奇异线性方程组
4.2.3 欠定线性方程组
4.2.4 超定线性方程组

4.3 矩阵分解
4.3.1 Cholesky分解
4.3.2 使用Cholesky分解求解方程组
4.3.3 不完全Cholesky分解
4.3.4 LU分解
4.3.5 不完全LU分解
4.3.6 QR分解
4.3.7 操作QR分解结果
4.3.8 奇异值分解

4.4 特征值分析
4.4.1 特征值和特征向量
4.4.2 稀疏矩阵的特征值和特征向量
4.4.3 特征值问题的条件数
4.4.4 特征值的复数问题

4.5 小结
第2部分 数据分析
第5章 函数分析和数值运算

5.1 函数的零点
5.1.1 一元函数的零点
5.1.2 多元函数的零点

5.2 数值积分



5.2.1 一元函数的数值积分
5.2.2 使用Simulink求解数值积分
5.2.3 求解瑕积分
5.2.4 矩形区域的多重数值积分
5.2.5 变量区域的多重数值积分

5.3 概率论和数理统计
5.3.1 双变量的概率分布
5.3.2 不同概率分布
5.3.3 数据分布分析
5.3.4 假设检验

5.4 小结
第6章 高级数值运算

6.1 插值
6.1.1 一维插值
6.1.2 人口数量预测——一维插值实例
6.1.3 二维插值
6.1.4 绘制二元函数图形——二维插值实例
6.1.5 样条插值
6.1.6 牛顿插值
6.1.7 多项式插值——牛顿插值实例
6.1.8 Chebyshev多项式插值
6.1.9 多项式插值——Chebyshev多项式插值实例

6.2 曲线拟合
6.2.1 多项式拟合
6.2.2 加权最小方差拟合
6.2.3 数据拟合——适用加权最小方差WLS方法

6.3 曲线拟合图形界面



6.3.1 曲线拟合
6.3.2 绘制拟合残差图形
6.3.3 进行数据预测

6.4 傅里叶分析
6.4.1 离散傅里叶变换
6.4.2 FFT和DFT
6.4.3 DFT的物理含义
6.4.4 使用DFS进行插值

6.5 小结
第7章 优化

7.1 常见优化问题
7.1.1 无约束非线性优化
7.1.2 求解二元函数的最小值——无约束非线性优化
7.1.3 非线性最小方差
7.1.4 计算函数的非线性最小方差
7.1.5 有约束的非线性优化
7.1.6 计算多元函数的极值——有约束的非线性优化
7.1.7 最小最大值的优化问题
7.1.8 优化对比
7.1.9 线性规划
7.1.10 二次规划
7.1.11 使用遗传算法求解二次规划

7.2 使用遗传算法求解优化
7.2.1 分析目标函数
7.2.2 优化求解
7.2.3 添加结果的可视性
7.2.4 设置算法的属性



7.2.5 设置“种群”属性
7.2.6 设置“中止”属性

7.3 优化“Banana”函数——优化方法对比
7.3.1 分析目标函数
7.3.2 BFGS优化法求解
7.3.3 DFP优化法求解
7.3.4 “无约束非线性”优化求解
7.3.5 “最小方差”优化求解

7.4 绘制帐篷——复杂的二次规划
7.4.1 设置约束条件
7.4.2 定义目标函数
7.4.3 进行优化求解
7.4.4 绘制优化求解的结果

7.5 小结
第8章 常微分方程

8.1 显性常微分方程
8.1.1 刚性和非刚性方程组
8.1.2 设置允许误差属性
8.1.3 设置输出参数属性
8.1.4 设置解法器其他属性

8.2 加权常微分方程
8.3 延迟微分方程
8.4 常微分方程的边界问题

8.4.1 MATLAB求解边界问题——bvp4c命令
8.4.2 求解带边界的常微分方程

8.5 小结
第9章 符号计算



9.1 符号对象和符号表达式
9.1.1 创建符号对象——使用sym命令
9.1.2 创建符号对象——使用syms命令
9.1.3 符号计算的运算符和函数
9.1.4 识别对象
9.1.5 确定符号表达式中的变量

9.2 符号精度计算
9.3 操作符号表达式

9.3.1 合并表达式——collect函数
9.3.2 展开表达式——expand函数
9.3.3 因式分解——factor函数
9.3.4 嵌套表达式——horner函数
9.3.5 计算最小分母公因式——numden函数
9.3.6 简化表达式——simplify函数
9.3.7 最简化表达式——simple函数
9.3.8 按书写方式显示表达式——pretty函数

9.4 替换符号表达式
9.4.1 替换重复字符串——subexpr函数
9.4.2 替换特定符号——subs函数

9.5 符号函数
9.5.1 求反函数——finverse函数
9.5.2 求复合函数——compose函数

9.6 符号微积分
9.6.1 求微分——diff函数
9.6.2 化简微分结果
9.6.3 求解矩阵微分
9.6.4 向量微分jacobian函数



9.6.5 符号极限
9.6.6 求解无限极限
9.6.7 求解左右极限
9.6.8 符号积分
9.6.9 矩阵积分
9.6.10 证明积分等式
9.6.11 交互近似积分
9.6.12 符号级数求和

9.7 符号积分变换
9.7.1 傅里叶变换
9.7.2 拉普拉斯变换
9.7.3 Z变换

9.8 符号矩阵的计算
9.8.1 线性代数运算
9.8.2 特征值运算

9.9 符号代数方程的求解
9.9.1 solve命令
9.9.2 求解非线性方程组
9.9.3 求解含参数方程组
9.9.4 求解超越方程组

9.10 符号微分方程的求解
9.10.1 dsolve命令
9.10.2 求解常微分方程
9.10.3 求解二阶常微分方程
9.10.4 求解常微分方程组

9.11 利用maple的资源
9.11.1 调用maple的相关命令



9.11.2 查看maple的帮助
9.12 可视化符号分析

9.12.1 单变量函数分析界面
9.12.2 泰勒级数逼近分析界面

9.13 小结
第3部分 数据可视化
第10章 二维图形

10.1 图形的基础知识
10.1.1 离散数据（函数）的可视化
10.1.2 连续函数的可视化
10.1.3 绘制图表的基础步骤

10.2 绘制二维图形
10.2.1 绘制二维图形——使用plot命令
10.2.2 设置曲线的属性
10.2.3 设置坐标轴范围
10.2.4 设置坐标轴显示方式
10.2.5 设置坐标轴系统
10.2.6 图形标识
10.2.7 叠绘
10.2.8 绘制双坐标轴图形
10.2.9 绘制多子图
10.2.10 交互式图形
10.2.11 使用fplot命令绘制图形
10.2.12 使用ezplot命令绘制图形

10.3 特殊图形
10.3.1 绘制面积图
10.3.2 绘制直方图



10.3.3 绘制二维饼图
10.3.4 绘制矢量图
10.3.5 绘制等高线
10.3.6 绘制伪色彩图
10.3.7 绘制误差棒
10.3.8 绘制二维离散杆图
10.3.9 绘制散点图
10.3.10 极坐标图形
10.3.11 柱坐标图形

10.4 小结
第11章 三维图形

11.1 绘制三维曲线
11.1.1 绘制三维图形——plot3命令
11.1.2 绘制三维曲线图——mesh命令
11.1.3 绘制等高线
11.1.4 绘制曲面图——surf命令

11.2 编辑三维图形
11.2.1 控制视角——view命令
11.2.2 控制旋转——rotate命令
11.2.3 设置背景颜色
11.2.4 设置图形颜色
11.2.5 设置数值轴的颜色
11.2.6 添加颜色标尺
11.2.7 设置图形的着色
11.2.8 控制照明——light命令
11.2.9 控制照明——lighting命令
11.2.10 控制材质——material命令



11.2.11 控制透视
11.2.12 控制透明

11.3 三维图形的简易命令
11.4 四维图形

11.4.1 绘制切片图——slice命令
11.4.2 绘制切面等位线图
11.4.3 绘制流线切面图

11.5 图形窗口
11.5.1 创建和控制图形窗口
11.5.2 使用工具栏编辑图形
11.5.3 使用绘图工具编辑图形
11.5.4 使用图形窗口进行数据分析

11.6 绘制复数变量图形
11.6.1 绘制复数图形原理
11.6.2 绘制复数图形——CPLXMAP命令
11.6.3 绘制复数曲面图——CPLXROOT命令

11.7 图形的打印和输出
11.7.1 图形打印的菜单操作方式
11.7.2 图形打印的命令操作方式

11.8 小结
第4部分 MATLAB编程
第12章 MATLAB编程基础知识

12.1 简单实例——排序函数
12.1.1 编写函数文件
12.1.2 编写脚本文件
12.1.3 运行代码
12.1.4 检测代码



12.2 M文件编辑器
12.2.1 打开文件编辑器
12.2.2 设置M文件编辑器的属性
12.2.3 设置M文件编辑器的打印属性

12.3 MATLAB的变量和关系式
12.3.1 M文件的变量类型
12.3.2 M文件的关键字
12.3.3 关系表达式
12.3.4 关系表达式的优先级
12.3.5 截断误差问题
12.3.6 逻辑表达式
12.3.7 逻辑运算函数

12.4 程序结构
12.4.1 顺序结构
12.4.2 if分支结构
12.4.3 switch分支结构
12.4.4 try-catch结构
12.4.5 while循环结构
12.4.6 for循环结构
12.4.7 绘制抛物线轨迹——综合实例

12.5 控制语句
12.5.1 结束循环——continue命令
12.5.2 终止循环——break命令
12.5.3 转换控制——return命令
12.5.4 输入控制权——input命令
12.5.5 使用键盘——keyboard命令
12.5.6 提示警告信息——error和warning命令



12.6 小结
第13章 MATLAB编程高级话题

13.1 程序的向量化
13.1.1 程序的向量化
13.1.2 向量化和循环结构对比
13.1.3 逻辑数组
13.1.4 使用logical命令创建逻辑数组
13.1.5 逻辑数组和向量化

13.2 脚本和函数
13.2.1 编写脚本文件
13.2.2 编写函数文件
13.2.3 编写P码文件

13.3 变量传递
13.3.1 变量检测命令
13.3.2 “变长度”变量函数
13.3.3 跨空间计算表达式的数值
13.3.4 跨空间赋值

13.4 字符串演算函数
13.4.1 内联函数——inline
13.4.2 求解函数零点
13.4.3 绘制函数图形
13.4.4 求解最值

13.5 程序的调试和剖析
13.5.1 直接调试法
13.5.2 工具调试法
13.5.3 程序剖析

13.6 小结



第5部分 图形用户界面
第14章 句柄图形

14.1 句柄图形体系
14.1.1 图形对象
14.1.2 句柄对象
14.1.3 句柄图形的结构
14.1.4 图形对象的属性

14.2 图形句柄的操作
14.2.1 创建图形对象
14.2.2 访问图形对象的句柄
14.2.3 使用句柄操作图形对象

14.3 图形对象的操作
14.3.1 设置图像属性——set命令
14.3.2 使用结构体设置属性
14.3.3 查询图形对象的属性——get命令
14.3.4 查看图形对象的默认属性
14.3.5 设置不同级别的属性
14.3.6 设置图形对象的默认属性

14.4 高层绘图命令
14.4.1 设置父对象属性——NextPlot属性
14.4.2 检查NextPlot属性——newplot命令
14.4.3 高层绘图文件的构成

14.5 坐标轴对象
14.5.1 坐标轴的几何属性
14.5.2 坐标轴的刻度属性
14.5.3 坐标轴的照相机属性

14.6 综合实例



14.6.1 穿越图形
14.6.2 动态反射图形

14.7 小结
第15章 图形用户界面基础

15.1 图形用户界面概述
15.2 使用M文件创建GUI对象

15.2.1 编写程序代码
15.2.2 运行程序代码

15.3 使用GUIDE创建GUI对象
15.3.1 启动GUIDE
15.3.2 添加“编辑框”控件
15.3.3 查看程序代码
15.3.4 运行GUI对象
15.3.5 创建GUI的注意事项

15.4 小结
第16章 创建菜单

16.1 定制标准菜单
16.2 使用GUIDE创建自定义菜单

16.2.1 创建图形界面
16.2.2 设置菜单属性
16.2.3 添加控件
16.2.4 添加“File”菜单的回调函数
16.2.5 添加“Thresholding Method”菜单的回调函数
16.2.6 添加“滚动条”控件的回调函数
16.2.7 添加其他控件的回调函数
16.2.8 编写主调函数
16.2.9 运行GUI对象



16.3 使用M文件创建自定义菜单
16.3.1 演示GUI的功能
16.3.2 添加“File”菜单的功能代码
16.3.3 添加“Options”菜单的功能代码
16.3.4 添加“Graphs”菜单的功能代码
16.3.5 添加主调函数
16.3.6 运行GUI对象

16.4 创建快捷菜单
16.4.1 编写程序代码
16.4.2 运行GUI对象

16.5 小结
第17章 添加控件

17.1 创建GUI对象的用户控件
17.1.1 添加控件组件
17.1.2 添加控件的功能代码
17.1.3 运行程序代码

17.2 图像切割界面——综合案例
17.2.1 分析GUI对象
17.2.2 规划GUI的设计过程
17.2.3 创建GUI的工具栏对象
17.2.4 准备图形对象的基础文件
17.2.5 处理指针对象
17.2.6 设置图形对象的属性
17.2.7 编写主程序代码
17.2.8 设置GUI对象的菜单选项
17.2.9 检测程序代码

17.3 小结



第6部分 MATLAB仿真
第18章 Simulink基础知识

18.1 Simulink概述
18.1.1 安装Simulink
18.1.2 启动Simulink

18.2 一个简单的仿真系统
18.2.1 添加模块
18.2.2 设置模块属性
18.2.3 连接模块
18.2.4 运行仿真系统

18.3 Simulink的工作环境
18.3.1 Simulink模型窗口界面
18.3.2 使用“File”菜单
18.3.3 使用“Edit”菜单
18.3.4 使用“View”菜单
18.3.5 使用“Simulation”菜单
18.3.6 使用“Help”菜单

18.4 Simulink中的数据类型
18.4.1 Simulink支持的数据类型
18.4.2 数据传递
18.4.3 向量化模块
18.4.4 使用Mux模块
18.4.5 标量扩展

18.5 Simulink的基本操作
18.5.1 Simulink模型的工作原理
18.5.2 操作模块
18.5.3 显示模块的属性



18.5.4 显示输出数值
18.5.5 连接线的分支
18.5.6 彩色显示信号线
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前  言

MATLAB是Mathworks公司推出的一套高性能数值计算和可视化
软件，它集数值分析、矩阵运算、信号处理和图形显示于一体，在系

统建模和仿真、科学和工程绘图及应用程序开发等方面有着广泛应

用。MATLAB以著名的线性代数软件包LINPAK和特征值计算软件包
EISPACK的子程序为基础，发展为一种开发性程序设计软件，因此
MATLAB已经由简单的矩阵计算软件分析发展成为通用性极高、带有
多种实用工具的运算操作平台。

为了帮助众多从业者提高软件使用及操作水平，作者精心编著了

本书。本书依照读者的学习规律，首先介绍基本概念和基本操作，在

读者掌握了这些基本概念和基本操作的基础上，再对内容进行深入的

讲解，严格遵循由浅入深、循序渐进的原则。本书按照MATLAB内在
的联系将各种工具、命令和命令面板交织编排在一起，这样编排虽然

不像帮助文档那样有层次感，但是对理解和掌握MATLAB却是大有帮
助的。

本书在内容的编排和目录组织上都十分讲究，争取让读者能够快

速掌握软件的使用方法。讲解具体知识的时候，尽量避免冗长的知识

讲解，直接切入主题，告诉读者如何实现特定功能，让读者在实际操

作中熟悉软件的使用。

和其他书籍相比，本书有何特点

1.取材广泛，内容充实
作者在讲解每一个知识点之前，充分考虑了MATLAB的知识和实

践工作的结合，精心挑选数学研究、图形设计、工程运用等各个领域



的应用，使读者不仅仅单纯地学到MATLAB的操作技巧，而且对创
意、思路有所提高。

2.内容深入
本书的所有实例都有一定的代表性和通用性，并不是为单纯介绍

某个命令而选取的，因此有些实例的步骤比较多，综合了MATLAB的
多个知识点，能够提高用户综合使用知识的能力。

3.讲解仔细
每个实例的制作步骤都以通俗易懂的语言阐述，并穿插讲解和技

巧文字，在阅读时就像听课一样详细而贴切。读者只需按照步骤操

作，就可以学习到MATLAB的相关功能。

本书包括的内容

本书总共包括8个部分25章的内容，全面地介绍了MATLAB的各
方面应用，下面详细介绍各章节的内容。

第1部分（第1章至第4章）介绍了MATLAB的基础知识，主要包
括MATLAB概述、数组、矩阵和架构及矩阵分析。
第2部分（第5章至第9章）主要讲解如何使用MATLAB进行数据

分析，内容包括函数分析和数值运算、高级数值运算、优化、常微分

方程和符号运算。

第3部分（第10章和第11章）详细分析了数据可视化的方法，主要
讲解了二维图形和三维图形的内容。

第4部分（第12章和第13章）介绍了MATLAB编程的内容，主要
包括MATLAB编程的基础知识和高级话题。
第5部分（第14章至第17章）详细讲解了图形用户界面的内容，主

要包括句柄图形、GUI基础、创建菜单和添加控件等。



第6部分（第18章至第20章）主要介绍了MATLAB仿真的内容，
包括Simulink基础知识、Simulink建模和子系统、S函数和仿真结果分
析。

第7部分（第21章至第23章）讲解了MATLAB的高级应用，包括
文件输入/输出、编译器和应用程序接口。
第8部分（第24章和第25章）将放在随书附赠的光盘中，主要内容

是用户工具箱，主要介绍了图形图像工具箱和信号工具箱。

读者评价摘选

本书第一版上市以来获得喜人销量，同时得到了读者的广泛好

评。下面节选几位热心读者在当当网（www.dangdang.com）上的评
价，以飨读者。
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第1部分 MATLAB基础知识

第1章 MATLAB概述
第2章 数组
第3章 矩阵和架构
第4章 矩阵分析



第1章 MATLAB概述

本章包括

◆MATLAB的安装

◆MATLAB的工作环境

◆MATLAB的常见命令

◆MATLAB的帮助系统

 
MATLAB是由MATRIX和LABORATORY两个英文单词的前3个字

母组合而成的。最初版本的MATLAB出现在20世纪70年代，由
FORTRAN语言编写，主要功能是实现程序库的接口功能。在20世纪
90年代，MATLAB已经发展成为国际公认的标准计算软件，在数值计
算方面功能十分强大，从这个时候起，MATLAB的内核就采用C语言
编写，增加了数据视图功能。在MATLAB推向市场之后，由于软件良
好的开放性和运行的可靠性，淘汰了该行业其他各种软件，许多工作

开始在MATLAB平台上重建。

1.1 MATLAB 7简介

MATLAB从第 1个版本到第 14个版本MATLAB 7.0（Release
14），软件本身已经有了很大的改善，下面简要对这些内容进行介
绍。

 
◆ 开发环境：在MATLAB 7.0中，用户可以同时使用多个文件和

图形窗口，可以根据自己的习惯和喜好来定制桌面环境，同时还可以



为自己定义常用的快捷键。

◆ 代码开发：支持函数嵌套、有条件中断点，可以使用匿名函
数定义单行函数。

◆ 数值处理：在最新的版本中，单精度算法、线性代数可以方
便用户处理更大的单精度数据，ODE可以求解泛函数，操作隐式差分
等式和求解多项式边界值问题。

◆ 数据可视化：提供了新的绘图界面窗口，可以不输入M函数
代码而直接在界面窗口中交互性地创建并编辑图形，同时可以直接从

图形窗口中创建对应的M代码文件。
◆ 文件I/O和外部应用程序接口：支持读入更大的文本文件，支

持压缩格式的MAT文件，可以动态加载、删除或者重载Java类，支持
COM用户接口等。

1.2 MATLAB 7的安装

MATLAB是一个功能强大的数学工具软件，只有在适当的系统环
境中才能正常运行。相对于MATLAB 7之前的几个版本，MATLAB 7
在安装时给用户提供了更为个性化的条件。本节将介绍MATLAB 7在
PC机的Windows操作系统中的典型安装方法。

注意

本节只介绍MATLAB 7在Windows操作系统中的安装方法，但是，MATLAB 7本身适合于

许多机型和操作系统，例如Macintosh和UNIX工作站等。在本书的后面章节中，如果没有特

别说明，所有的操作都是在Windows XP操作系统下的MATLAB 7中进行的。

 
在一般情况下，当用户将MATLAB的安装光盘插入光驱后，会自

动启动“安装向导”。如果向导没有自动启动，可以打开安装光盘中的



setup.exe应用程序，启动安装向导。
在安装过程中出现的所有界面都是标准界面，用户只需按照界面

中的提示进行操作，输入用户名、单位名以及软件产品的序列号等。

由于MATLAB 7的安装界面相对于MATLAB之前的版本有了较大改
变，下面主要介绍几个明显改变的地方。

首先，用户需要在“Installation Type”对话框中选择“Custom”单选
按钮才能自行选择软件安装的组件和目录等，如图1.1所示。

图1.1 选择自定义安装选项

当选择了 “Custom”单选按钮后，单击 “Next”按钮，就会出现
MATLAB安装选项的界面，即“Product and Folder Selection”对话框，
可以在该对话框中选择需要安装的组件，如图1.2所示。



图1.2 选择MATLAB组件界面

在“Product and Folder Selection”对话框的上面选框中，需要选择
MATLAB软件的安装位置和软件的名称。可以使用任意名称，同时也
可以将MATLAB软件安装在硬盘中的任何位置。单击该对话框中
的“Browse”按钮，选择相应的安装路径，也可以直接在选框中输入安
装路径名称。

提示

在默认情况下，系统会将MATLAB安装在系统盘中，可以使用该默认安装路径。但是，

由于MATLAB本身所占空间和资源较大，同时，经常使用MATLAB软件，会产生很多的临时

文件，这将给系统盘增加负担。因此，建议将MATLAB安装在其他磁盘中。

 
在对话框的 “Select products to install”列表框中，需要选择

MATLAB软件的安装组件。可以直接勾选相应的组件，进行安装。默
认情况下，系统会选中所有的组件，但是，对于一般的用户而言，很

多组件的专业性过强，没有安装的必要。所以，用户应该根据自己的

需要选择安装的组件。



为了帮助读者了解组件的构成，下面给出比较典型的组件组合方

式，如表1.1所示。

表1.1 MATLAB的安装组件

技巧

一般来讲，随着用户对MATLAB使用的深入，可能随时需要安装新的工具箱。如果这个

工具箱在安装光盘中已经包括了，可以再次使用光盘进行安装。如果该工具箱是新增的，可

以访问Mathworks公司的官方网站，单独下载工具箱的安装文件。

 
当选择了MATLAB的安装组件后，单击组件选择界面中

的 “Next”按钮，就会出现使用选项的界面，可以在界面中选择
MATLAB的使用选项，如图1.3所示。



图1.3 MATLAB选项界面

在MATLAB选项界面的上部，MATLAB为用户设置软件的密码。
如果选中该复选框，则可以设置操作密码。其他用户只能读取

MATLAB的所有相关文件，而不能编辑其中任何文件。当用户使用的
操作系统是多人共用的时，为了保护自行设置和编辑的MATLAB文
件，建议选中该复选框。

在该界面的中部，可以选择为MATLAB添加快捷方式的位置。系
统提供了三个位置：桌面、“开始”菜单和快速启动栏。可以根据需要
选择添加的位置，一般建议选中“Desktop”和“Programs folder on the
Start Menu”复选框。这样，可以很方便地启动MATLAB。
在该界面的底部，可以选择和MATLAB关联的文件扩展名。当选

中相应的文件扩展名后，在默认的情况下，系统会使用MATLAB打开
这些扩展名的文件。

1.3 MATLAB 7的工作环境



在将MATLAB安装到相应的硬盘上之后，可以启动MATLAB，查
看MATLAB的工作环境。
在一般情况下，可以使用两种方法来启动MATLAB。在上面小节

中，将快捷方式添加在桌面上了，因此可以双击桌面上的快捷方式图

标，打开如图1.4所示的操作界面（Desktop）。

图1.4 MATLAB操作界面的默认外观

如果没有添加MATLAB的桌面快捷方式，则需要使用电脑选择路
径matlab7.0\bin\win32文件夹中的MATLAB.exe应用程序，同样可以打
开MATLAB的操作界面。这两种方法的结果是完全相同的。

说明



尽管使用上面两种方法都可以启动MATLAB，但是，两种方法还是有区别的。如果使用

第二种方法启动MATLAB，系统会将matlab7.0\bin\win32作为一个默认的目录。因此，建议使

用第一种方法来启动MATLAB。

1.3.1 操作界面简介

MATLAB 7延续了MATLAB 6.x版本的操作界面，该操作界面中包
含了大量的交互性工作界面，例如：通用操作界面、工具包专用界

面、帮助界面和演示界面等。这些交互性界面组合在一起，构成了

MATLAB的默认操作界面。
在默认情况下，MATLAB的操作界面包含了3个最常见的界面：

命令窗口、历史命令窗口和工作空间浏览器，同时，在窗口的左下角

为“开始”按钮。

提示

在默认情况下，还可以在MATLAB的操作界面中看到名为“Current Directory”的交互界面

选项卡。如果单击该选项卡，该交互界面就会出现。该交互界面是一个十分常用的界面：当

前目录窗口。

 
下面详细介绍MATLAB中常见的几个交互界面。
 
◆ 命令窗口（Command Window）：这是MATLAB操作界面中

最为重要的窗口，也是用户进行各种操作的主要窗口。在这个窗口

中，可以输入各种MATLAB的命令、函数和表达式。同时，所有操作
和运算的结果也会在该窗口中出现（图形结果会单独显示）。

◆ 历史命令窗口（Command History）：在默认情况下，该命
令窗口出现在MATLAB操作界面的左下方。这个窗口中记录了用户已



经操作过的各种命令、函数和表达式。之所以记录这些信息，主要功

能有两个：方便用户回忆之前的操作，也可以方便用户对这些历史信

息进行编辑（例如：复制、重运行等）。

◆ 当前目录窗口（Current Directory）：在默认情况下，该命
令窗口出现在MATLAB操作界面的左上方的后台。在这个窗口中，可
以设置当前目录，展示目录中的M文件或者MAT文件等，同时，可以
编辑M文件等。

◆ 工作空间浏览器（Workspace Browser）：在默认情况下，该
命令窗口出现在MATLAB操作界面的左上方的前台。在这个窗口中，
可以查看工作空间中所有变量的类别、名称和大小。可以在这个窗口

中观察、编辑和提取这些变量。

◆ “开始”按钮（Start）：这个按钮是MATLAB 6.5版本后增加
的按钮。单击这个按钮以后，会出现MATLAB的快捷菜单。这个菜单
中分为两个部分，上半部分的菜单包含了各种交互界面，下半部分的

菜单选项的主要功能是：窗口设置、访问MATLAB公司的网页、查看
帮助文件等。

1.3.2 运行命令窗口

命令窗口（Command Window）是MATLAB的主要操作界面。关
于MATLAB的大部分操作命令和结果都需要在命令窗口中进行输入和
显示。本小节首先介绍命令窗口的外观特征。

由于命令窗口在默认情况下位于MATLAB操作界面的右方，可以
单击命令窗口右上角的 按钮，使命令窗口脱离操作界面，得到的

命令窗口如图1.5所示。



图1.5 单独的命令窗口

和MATLAB之间的版本相比，MATLAB 7命令窗口的菜单栏有了
一些调整。例如，相对于MATLAB 6.5，MATLAB 7的菜单栏中增加
了 “Debug”和 “Desktop”选项，减少了 “View”选项。其中，增
加“Debug”选项是为了方便用户编译M文件，“Desktop”选项则是方便
用户在界面置放方式上进行调换。

从MATLAB 6.x版本以后，当MATLAB在Windows操作系统中运行
时，命令窗口都会出现命令行提示符“>>”。

说明

如果希望将命令窗口嵌放回到MATLAB的操作界面中，可以选择命令窗口中

的“Desktop”→“Dock Command Window”命令，也可以直接单击菜单栏中的 按钮。

1.3.3 命令窗口的显示方式

本节中将主要介绍控制命令窗口的命令和操作设置，希望读者可

以全面了解MATLAB的命令系统。
在默认情况下，MATLAB 7对命令窗口中的字符或者数码设置了

不同的颜色，这样会使得用户方便地查看各种信息。用户可以根据自



己的需要，对命令窗口的字体风格、大小和颜色等进行自定义的设

置。

在 MATLAB 的 操 作 界 面 或 者 命 令 窗 口 中 选

择“File”→“Preferences”命令，打开“Preferences”对话框，可以在其中
设置字体格式等，如图1.6所示。

图1.6 参数设置对话框

选择“Preferences”对话框左窗格中的“Fonts”选项，在右侧会显示
命令窗口的字体属性。默认情况下，MATLAB将命令窗口（Command
Window）、历史窗口（Command History）和M文件编辑器（Editor）
中的字体设置为相同：字体类型是Monospaced，字体属性是Plain，大
小为10。而将帮助导航（Help Navigator）、当前记录窗口（Current
Directory）、 HTML文本文字、工作空间浏览器（Workspace



Browser）和内存数组编辑器（Array Editor）中的字体设置为相同：字
体类型是SansSerif，字体属性是Plain，大小为10。
对于上面两种字体类型，都可以在对应选项的下拉菜单中选择新

的属性，然后单击“Preferences”对话框中的“OK”按钮，完成属性的设
置。

注意

修改了字体的属性之后，这些设置都将被永久保留。这些设置不会随着MATLAB的关闭

或者开启而改变。但是，用户只能改变各个局部的字体属性，不能改变字体的分布设置。也

就是说，可以修改命令窗口的字体属性，但是命令窗口的字体和历史窗口的字体属性永远相

同。

 
和设置字体属性类似，可以为不同类型的变量设置颜色，以示区

别。选择“Preferences”对话框左窗格的“Colors”选项，在对话框右侧会
显示操作系统的字体颜色，如图1.7所示。



图1.7 设置字体颜色

在“Desktop tool colors”区域，可以设置MATLAB操作界面的工具
字体颜色。默认情况下，MATLAB会使用系统字体的颜色，可以根据
需要取消选中“Use system colors”复选框，然后选择字体颜色。
在对话框中部的“M-file syntax highlighting colors”区域，可以为各

种类型的字符设置颜色。MATLAB提供了6种不同类型的字符：关键
字、字符串、系统命令、注释、未结束的字符串和错误提示等。可以

根据自己的喜好来修改这些不同类型字符的颜色。

在对话框下部的“Sample”区域，显示的是用户设置的字体样式。
可以根据这个结果及时调整字体的颜色。如果对自行修改的字体颜色

不满意，单击“Restore Default Colors”按钮，重新启用系统默认的字体
颜色。

注意



尽管MATLAB为用户提供了十分宽松的环境来设置不同的颜色，但是，不能将不同类型

的字符串设置为相同的颜色。例如，可以修改“关键字”的颜色，但是不能将“关键字”和“注

释”设置成相同的颜色。

1.3.4 数值结果的显示方式

在默认情况下，命令窗口的数值结果都是以format short g的格式
来显示的，可以根据计算的要求来自行设置数据结果的显示方式。

说明

上面描述的是MATLAB数值结果的显示方式，而不是数值的计算精度。MATLAB只是为

了显示的简洁才采用了较少位数的显示，在实际存储和计算过程中使用的都是双精度。

 
表1.2显示的就是MATLAB中数值显示格式的种类、命令和含义。

表1.2 数据显示方式的常见命令

根据上面表格的介绍，可以直接在MATLAB的操作界面中输入相
应的命令，查看同一个变量a的不同显示结果，如图1.8所示。



图1.8 设置数值的显示格式

可以看出，对于同一个变量a=2.563753324578901，使用不同的格
式命令会在MATLAB中显示出不同的结果。

说明

从上面的操作结果可以看出，对于数值格式的设置，如果用户使用的是格式命令，相应

的设置只对当前的MATLAB命令窗口有效，一旦MATLAB窗口关闭，这些设置也会失效。系

统会恢复数值的默认格式。

1.3.5 命令窗口的标点符号



在MATLAB命令窗口中，不同的标点符号具有不同的运算含义，
所以有必要了解各种标点符号的具体含义，灵活使用标点符号，会给

运算带来很大的方便。表1.3归纳了各种常见标点符号的作用。

表1.3 MATLAB常见标点符号的功能

下面列举一些简单的例子来介绍常用标点符号的功能。

 
例1.1 在MATLAB中输入矩阵。
具体的输入步骤如下：

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
按“Enter”键，结束输入并执行命令，得到的结果如图1.9所示。



图1.9 输入数值矩阵

说明

从上面的操作结果可以看出，数值矩阵可以直接输入方括号“[ ]”。而矩阵中的数值间隔

使用的是逗号，每个数据行之间的分隔使用的是分号。最后，所有的标点都必须在英文状态

下输入，MATLAB无法辨识中文的标点符号。

 
例1.2 在MATLAB命令窗口中输入下面的续行命令：

按“Enter”键，结束输入并执行命令，得到的结果如图1.10所示。

图1.10 续行输入命令行

说明



上面的案例是在MATLAB的命令窗口环境中进行的，如果在“记事本”程序中运行上面的

命令，则不能使用续行号，只能让其自动换行。

 
例1.3 在MATLAB中进行数组点乘。
具体的操作步骤如下：

 

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
按“Enter”键，结束输入并执行命令，得到的结果如图1.11所示。

图1.11 MATLAB中的点乘

上面的计算结果是两个数组中对应元素的乘积，例如，4＝1×4；
10＝2×5；18＝3×6。

说明



在图1.11中，首先使用注释号%引出了注释行，在下面的计算行中首先输入黑点，然后输

入乘号，得到点乘的结果。如果在输入过程中没有输入黑点，MATLAB会提示计算错误，因

为这两个矩阵无法相乘。

1.3.6 输入变量

在MATLAB的计算和编程过程中，变量和表达式都是最基础的元
素。因此，如果需要深入学习MATLAB，十分有必要了解MATLAB关
于定义变量和表达式的基本规则。

在MATLAB中，为变量定义名称需要满足下列规则：
 
◆ 变量名称和函数名称有大小写区别。对于变量名称NumVar和

numvar，MATLAB会认为是不同的变量。exp是MATLAB内置的指数
函数名称，因此，如果输入exp(0)，系统会得出结果1；而如果输入
EXP(0) ， MATLAB 会 显 示 提 示 信 息 “??? Undefined
command/function'EXP'”，表明MATLAB无法识别EXP的函数名称，如
图1.12所示。

图1.12 函数名称区分大小写



◆  变量名称的第一个字符必须是英文字符。因此，5Var、
_matrix等都是不合法的变量名称。MATLAB 6.5以后的版本，变量名
称最多可以包含63个字符。

◆ 变量名称中不可以包含空格或者标点符号，但是可以包括下
画线。因此，变量名称Num_Var是合法的，但是变量名称Num、Var则
是不合法的。

提示

尽管MATLAB对于变量名称的限制较少，但还是建议用户在设置变量名称时考虑到变量

的含义。例如，在M文件中，变量名称inputname就比名称a易于理解。

 
在变量名称规则中，并没有限制用户使用MATLAB的预定义变量

名称，但是根据笔者经验，建议不要使用MATLAB预先定义的变量名
称。因为，用户每次启动MATLAB，系统就会自动产生这些变量，表
1.4列出了常见的预定义变量名称。

表1.4 MATLAB中的预定义变量

MATLAB没有限制用户使用这些预定义变量，可以在MATLAB的
任何文件中将这些预定义变量重新定义，赋予新值，然后重新计算。

下面的例子说明用户可以使用MATLAB内置的预定义变量。
例1.4 如何在MATLAB中使用预定义变量。
详细程序清单如下：



在程序清单的第一行中，用户直接输入了“pi”，可以显示系统的
预定义变量pi，在默认情况下，MATLAB会以“format short g”的数值格
式显示系统预先定义的数值3.1416。在后续的程序中，用户定义了变
量R，然后计算周长perimeter，得到的结果是37.699。
在后面的代码中，重新定义变量pi，将其数值设置为3.50，然后重

新计算周长，得到的结果是42，这就表明MATLAB已经将变量pi的值
改为3.50。也就是说，MATLAB接受用户重新定义的预定义变量pi的
数值。

然后使用命令clear，清除前面步骤中定义的所有变量，重新定义
半径，然后再次计算周长，得到的结果是 37.699。这就表明，
MATLAB又将变量pi的数值重新设置为3.1416。

说明



在MATLAB的IEEE算法规则中，被0除是允许的。这不会导致任何程序的中断，只是给

出警告信息，然后使用名称Inf或者NaN来记述。这些名称可以在后面的代码中得到合理运

用。

1.3.7 处理复数

在一般的数学运算软件中，复数属于一般的变量。之所以在本节

中单独介绍关于复数的问题，是因为在MATLAB中将复数作为一个整
体处理，而不是像其他程序语言那样把实部和虚部分开处理。而复数

的虚数单位用预定义变量i或者j表示。
在MATLAB中，核心处理工具是矩阵，因此需要了解复数矩阵的

处理方法和普通复数单数的差别。下面利用一些简单实例来说明

MATLAB如何处理复数。
例1.5  在MATLAB中输入复数 z1＝ 8＋ 10i， z2＝ 12＋ 6i，

。

具体的操作步骤如下：

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
按“Enter”键，结束输入并执行命令，得到的结果如图1.13所示。



图1.13 在MATLAB中输入复数

在图1.13所示的操作界面中，复数z1的输入方式是直接按照书面
习惯完成的，在这种书写格式中10i是一个完整的虚数部分，因此在10
和i之间不允许有任何的空格。这种书写格式符合大家实际运用的习
惯，但是仅限于使用在复数标量中，不能使用在复数矩阵中。

复数z2的输入方式则将虚数部分分开成6和i，同时使用乘号连
接。这种方式适用于复数矩阵。但是，需要注意的是，如果可以使用

第一种书写格式，尽量使用它，因为这种格式比复数z2的输入方式运
算速度要快。对于大型的复数矩阵，这种运算速度差别十分明显。

例1.6 在MATLAB中输入复数矩阵并进行矩阵运算。
具体的操作步骤如下：

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
按“Enter”键，结束输入并执行命令，得到的结果如图1.14所示。



图1.14 在MATLAB中输入复数矩阵

在这个例子中，使用数组方式输入了复数矩阵A，而使用数组元
素方式输入复数矩阵B，这两种方式都是十分常见的输入方式，效果
相同，可以根据习惯选择。从输入的繁易程度来看，第一种方法更加

简单，建议使用这种方法输入复数矩阵。

说明

复数矩阵的乘法和实数矩阵的乘法计算方法是完全相同的，在例1.6中，复数矩阵A的维

度是2×3，而复数矩阵B的维度是3×2，因此两个矩阵相乘得到的结果是一个2×2矩阵。

 
例1.7 在MATLAB中计算例1.6中复数矩阵C的实部、虚部、模和

相角。

具体的操作步骤如下：

step 1
在MATLAB的命令窗口中输入下列内容：

step 2



依次输入上面的各个变量名称，按“Enter”键，结束输入并执行命
令，得到的结果如图1.15所示。

图1.15 在MATLAB中计算复数的参量

说明

本例中的函数real、imag、abs、angle等都是MATLAB内置的函数，用来处理和计算复数

的参量。同时，这些函数的参数都可以是数组类型，这样函数可以对数组元素逐个发生作

用。

1.3.8 命令窗口的控制命令



在MATLAB的命令窗口中进行各种操作的时候，用户会经常遇到
一些编辑工作，例如：清除窗口的程序语句，清除图形或者关闭

MATLAB程序等。这些操作在MATLAB 7中大部分都可以使用对应的
菜单或者功能按钮来实现，但是，在用户编写M文件的时候，还是有
必要使用这些控制命令的，因此，在本节中归纳了MATLAB的常见控
制命令和对应功能，如表1.5所示。

表1.5 MATLAB中的常见控制命令

上面这些控制命令在整个MATLAB程序中都是通用的，也就是
说，既可以在命令窗口中输入这些控制命令，也可以在M文件或者
MAT文件的程序语句中使用这些控制命令，功能是完全相同的。例
如，在命令窗口中输入clear命令，将会清除工作空间中的变量；如果
在M文件中输入clear命令，也会清除变量。

说明

上面这些控制命令一直都是MATLAB中的基本通用命令，对各个版本都适用。如果使用

的是MATLAB 6.x或者更低版本，都可以使用上述命令。

1.3.9 使用历史窗口

在前面已经简单介绍了历史窗口（Command History）的作用，下
面将详细介绍如何合理使用MATLAB的历史窗口的功能。在MATLAB
中，利用历史窗口可以验证用户即时的想法，相当于可以随时进行各



种尝试和试验，边做边想。同时，MATLAB还提供了另外一个有效工
具实录命令diary。下面分别进行详细介绍。
在默认的情况下，历史窗口位于MATLAB操作桌面左下方的前

台，可以单击历史窗口右上方的 按钮，查看独立的历史窗口，如

图1.16所示。

图1.16 历史窗口

历史窗口的菜单栏和命令窗口的菜单栏相同，如果希望将历史窗

口嵌放回到MATLAB的操作界面中，可以选择历史窗口中
的“Desktop”→“Dock Command Window”命令，也可以直接单击菜单栏
中的 按钮。

在历史窗口中，记录着用户在MATLAB命令窗口中输入的所有命
令行（除非用户人为地删除历史窗口中的记录）。一般而言，完整的

历史记录包括：用户每次启动MATLAB的时间，每次启动MATLAB的
所有命令行。

用户不仅能在历史窗口中查看命令窗口中运行过的所有命令行，

而且可以根据需要编辑这些命令行。下面列举几个常见的编辑功能。

 



◆ 复制命令行：这种编辑功能适用于使用原来的部分命令行。
例如，用户需要输入新的命令行，有部分命令行和历史命令行重复，

则可以在历史窗口中点亮相应的命令行，然后单击鼠标右键，在弹出

的快捷菜单中选择“Copy”命令，如图1.17所示。

图1.17 复制历史命令行

复制历史命令行后，可以在命令窗口中的任何地方粘贴这些命令

行，如图1.18所示。



图1.18 粘贴历史命令行

粘贴历史命令行后，可以在此之后继续输入新的命令行，这样就

节省了重新输入这些命令行的时间。

说明

由于上面的操作需要在历史窗口和命令窗口中共同操作，因此需要首先将历史窗口嵌放

回到MATLAB的操作界面中。

 
◆ 运行命令行：这个操作的功能是运行原来输入的命令行，得

到原来命令行的结果。在历史窗口中选择需要运行的历史命令行，然

后单击鼠标右键，在弹出的快捷菜单中选择“Evaluate Selection”命令，
如图1.19所示。



图1.19 运行历史命令行

运行历史命令行后，在命令窗口中就会显示相应的运行结果，如

图1.20所示。



图1.20 运行的结果

说明

如果运行的是单行命令行，则可以直接使用鼠标左键来双击命令行；如果运行的是多行

命令行，则需要按下“Ctrl”键同时选择多行命令行。

 
◆ 创建M文件：可以根据需要将历史命令行编写成为M文件，

在历史窗口中选择需要运行的历史命令行，然后单击鼠标右键，在弹

出的快捷菜单中选择“Create M-File”命令，如图1.21所示。



图1.21 创建M文件

选择相应的菜单选项后，MATLAB就会调用M文件编辑器，并且
将用户选择的历史命令行填写在M文件编辑器中，如图1.22所示。



图1.22 创建完成的M文件

说明

M文件是MATLAB的重要应用之一，在后面的章节中将详细介绍如何使用和编辑M文

件。当通过历史命令行创建了M文件后，需要经过必要的操作才能得到完整的M文件。

1.3.10 使用实录命令

在MATLAB中，为用户提供了diary命令，用来创建“日志”文件。
在这个“日志”文件中，记录了当前命令窗口中的所有内容，包括命令
和计算结果等。文件的保存格式是ASCII码，因此需要使用“记事本”程
序或者其他文本软件来阅读日志文件。

在MATLAB程序启动的前提下，首先单击操作界面中的“Current
Directory”按钮旁边的浏览按钮，在打开的对话框中选择合理的路径。
在后面步骤中创建的日志文件会保存在该路径中。如果用户不修改路

径，MATLAB会将日志文件保存在默认的MATLAB7.0\work文件夹
中。

在用户修改了保存路径后，就可以在命令窗口中输入关于实录的

命令，创建日志文件。下面举例详细介绍。

例1.8 在MATLAB中创建名为“first_diary”的日志文件，并阅读该
日志文件，如图1.23所示。



图1.23 创建日志文件

详细的程序清单如下：

由于没有修改保存路径，因此可以在MATLAB7.0\work路径中找
到相应的日志文件，并用“记事本”程序打开该日志文件，如图1.24所
示。



图1.24 阅读日志文件

说明

使用上面的方法创建的日志文件不带有扩展名，一般可以使用文本编辑器或者MATLAB

的M文件编辑器来阅读和编辑该日志文件。

1.3.11 当前目录浏览器和路径管理

在MATLAB中包含大量的函数和数据库，当在命令窗口中输入命
令行的时候，MATLAB如何搜索到相应的函数和数据，怎样有效地管
理这些函数和数据库的路径、提高搜索的效率是本节的核心问题。

同时，在使用MATLAB的时候，会产生大量的MATLAB文件，如
何管理好这些文件也是一个重要的问题。如果不能有效地管理这些文

件，将会直接影响用户运行MATLAB的效率。



在MATLAB中，提供当前目录浏览器来管理各种文件。在默认的
情况下，当前目录浏览器在MATLAB操作界面的左上方的后台，单
击“Current Directory”选项卡，可以使目录浏览器在MATLAB的前台显
示。单击目录浏览器右上方的 按钮，可以查看目录浏览器的详细

外观，如图1.25所示。

图1.25 当前目录浏览器

在默认情况下，当前目录浏览器包括了菜单栏、当前目录设置

区、工具菜单和文件详细列表等。其中，用户需要经常使用的是文件

详细列表区域，在该区域中，可以运行或者编辑M文件，装载MAT数
据文件等，如图1.26所示。



图1.26 操作和编辑M文件

上面的操作过程十分简单，用户首先在当前目录浏览器中选择相

应的M文件，然后单击鼠标右键，在弹出的快捷菜单中选择对应的命
令。例如，用户希望运行对应的M文件，可以选择“Run”命令；用户希
望编辑该M文件，则选择“Open”命令，该M文件就会出现在M文件的
编辑器中。其他的操作都可以通过在该菜单中选择对应的选项来完

成。

1.3.12 设置当前目录

在默认的情况下，启动MATLAB的时候，系统会将当前目录设置
为“MATLAB7.0\work”或者“MATLAB7.0\bin\win32”，这取决于用户启
动MATLAB的方式，这在前面的内容中已经有了介绍。



对于“MATLAB7.0\work”这个目录路径，在该路径中存放用户的
文件是允许的，而且是安全的，因此可以沿用这个默认路径；而对

于“MATLAB7.0\bin\win32”这个目录路径，则不建议用户使用，如果
启动MATLAB的时候产生了这个路径，建议改变这个默认的目录路
径。

尽管可以沿用“MATLAB7.0\work”这个目录路径，但是根据笔者
经验，为了方便用户管理各种MATLAB文件，还是建议用户创建自己
的 工 作 路 径 ， 来 存 放 自 己 创 建 的 应 用 文 件 。 而

将“MATLAB7.0\work”这个目录路径作为临时目录使用。
创建工作目录的方法和在Windows中创建目录的方法完全相同，

读者可以参阅相应的书籍。下面建议将用户创建的工作目录设置为当

前目录，这是因为在MATLAB环境中，如果不特别指明存放目录，
MATLAB都会默认地将文件存放在当前目录中。如果将自己设置的工
作目录设置为当前目录，就可以保证MATLAB运行的可靠和便捷。
可以在当前目录浏览器中的目录设置框中输入新的工作目录，或

者单击该界面中的目录浏览按钮，选择新的工作目录，如图1.27所
示。



图1.27 设置当前目录

除了上面的方法，习惯了编程的用户也可以在命令窗口中输入控

制命令来修改当前目录。这种方法适用于MATLAB的各个版本，而且
控制命令不仅可以在命令窗口中使用，也可以在M文件中使用，效果
相同。设置当前目录的控制命令是cd，例如，用户需要将当前目录设
置 为 D:\Study\Matlab\mfiles ， 对 应 的 控 制 命 令 为 cd
D:\Study\Matlab\mfiles。

提示

使用上面两种方法设置的当前目录，只在当前开启的MATLAB环境中有效。如果用户重

新设置MATLAB应用程序，上面的设置操作需要重新进行。

1.3.13 MATLAB的搜索路径

在MATLAB中，所有的文件都被存放在一组结构比较严谨的目录
路径中。MATLAB会将这些目录按照一定的次序设置为搜索路径的各
个节点。当用户运行MATLAB的时候，程序就会沿着这个设定好的路
径进行搜索，查找相应的文件、函数或者具体的数据。

当MATLAB进行搜索的时候，会按照一定的次序进行，例如用户
在命令窗口中输入命令：my_matlab，程序会首先在内存中搜索是否有
名为my_matlab的变量，如果没有找到，则再检查my_matlab是否是内
置的函数，如果没有搜索到结果，则在当前目录中检查是否有名为

my_matlab的M文件，如果还是没有搜索到，则在其他目录中检查是否
存在名为my_matlab的M文件。
上面的搜索过程就是MATLAB的典型搜索路径，了解这个搜索路

径就可以有效地进行路径管理，提高搜索效率和MATLAB的运行效



率。

如果有多个目录需要同时和MATLAB进行信息交换，应该将这些
目录设置在搜索路径中，这些目录中的所有内容就都可以被MATLAB
调用。或者，用户设置了某个目录来存放所有的文件和数据，这个目

录也应该被设置在MATLAB的搜索路径中。
可以在MATLAB的命令窗口中输入 “pathtool”命令或者选

择“File”→“Set Path”命令，打开“Set Path”对话框，在其中设置路径的
各个参数，如图1.28所示。

图1.28 “Set Path”对话框

在“Set Path”对话框中，单击“Add Folder”按钮，然后选择相应的
路径，就可以将该路径“D:\Study\Matlab\mfiles”设置到搜索路径中。
在“Set Path”对话框中，可以编辑任意一个现存的路径信息，例如，添
加子文件夹、移动文件夹的位置或者删除路径等，只需单击对话框中

的对应按钮。

提示



在“Set Path”对话框中，存在两种修改状态。如果在修改路径信息的时候，仅使用对话框

左侧的按钮，那么这种修改行为只是当前有效；如果在修改路径信息的时候，单击了对话框

中的“Save”按钮，则这种修改行为将永久有效。

 
除了上面的设置方法，MATLAB还提供了path命令来设置路径，

这个命令对于MATLAB的各个版本都适用。例如，可以使用path命令
查看MATLAB的路径信息，如图1.29所示。

图1.29 查看MATLAB的路径信息

提示

使用path命令完成的路径修改信息只在当前MATLAB的环境中有效，当重新启动

MATLAB后，使用该命令完成的路径信息都将失效。



1.3.14 工作空间浏览器和数组编辑器

在默认的情况下，工作空间浏览器位于MATLAB操作界面的左上
侧的后台，单击 “Workspace”选项卡，可以使工作空间浏览器在
MATLAB的前台显示。然后，单击工作空间浏览器右上方的 按

钮，可以查看工作空间浏览器的详细外观，如图1.30所示。

图1.30 工作空间浏览器

和其他MATLAB组件的界面相比，工作空间浏览器的菜单栏中多
了一个“Graphics”菜单项，当选中其中某个变量时，可以选择该菜单项
中的子选项，很方便地绘制相应的各种图形，如图1.31所示。

图1.31 图形选项菜单



在图形选项菜单中，可以选择各种常见的图表类型。如果菜单选

项中没有合适的图表类型，可以选择菜单中的“More Plots”选项，打
开“Plot Catalog”对话框，选择合适的图表类型，如图1.32所示。

图1.32 “Plot Catalog”对话框

“Plot Catalog”对话框的左侧是图形的分类，中间表示的是图表类
型，右侧则是用户选择的图表类型的描述。

说明

工作空间浏览器中的“Graphics”菜单选项是MATLAB 7中新增的，在MATLAB 6.x版本

中，并没有该菜单选项。



 
除了非常强大的图形绘制功能之外，工作空间浏览器还有其他多

种应用功能，例如内存变量的查阅、保存和编辑等。所有这些操作都

比较简单，只需在工作空间浏览器中选择相应的变量，然后右击鼠

标，在弹出的快捷菜单中选择相应的命令，如图1.33所示。

图1.33 编辑内存变量

对变量的操作可以从菜单选项的名称看出，例如，“Rename”菜单
选项表示对应的操作是重命名该变量；“Copy”菜单选项表示对应的操
作是复制该变量等。

1.3.15 变量的编辑命令



在MATLAB中，用户除了可以在工作空间浏览器中编辑内存变
量，还可以在MATLAB的命令窗口中输入相应的命令，来查阅和删除
内存变量。下面用简单的案例来说明如何在命令窗口中对变量进行操

作。

例1.9 在MATLAB命令窗口中查阅内存变量。
在命令窗口中输入who和whos命令，查看内存变量的信息，如图

1.34所示。

图1.34 查阅内存变量的信息

说明

who和whos命令适用于MATLAB的各个版本，两个命令的区别只在于内存变量信息的详

细程度。两个命令结果的列表次序随具体情况而不同。

 



例1.10 承接上面的例子，在MATLAB命令窗口中删除内存变量
Desp。
在命令窗口中输入下面的命令行：

得到的结果如图1.35所示。

图1.35 删除内存变量

和前面的例子对比可以看出，当运行clear命令后，将Desp变量从
工作空间删除，而且在工作空间浏览器中也将该变量删除。

说明

如果在命令窗口中直接输入clear命令，就可以删除工作空间中的所有变量；如果需要删

除多个内存变量，可以在clear命令后面依次添加删除的变量名称。

1.3.16 数组编辑器

在MATLAB中，数组和矩阵都是十分重要的基础变量，因此
MATLAB专门提供了数组编辑器这个工具来编辑数组。选择工作空间



浏览器中任意一个数组（就是class类别为double的内存变量），然后
单击工具栏中的“Open selection”按钮，或者直接双击该变量，就可以
打开该变量的数组编辑器，如图1.36所示。

图1.36 打开数组编辑器

注意

在MATLAB中，数组编辑器只支持一维或者二维数值数组，而不支持元胞数组、构架数

组、符号类数组、三维数组、字符串数组等。因此，在前面的步骤中，必须选择数值数组打

开相应的数组编辑器。

 
在上面的步骤中，打开了变量y的数组编辑器，如图1.37所示。

图1.37 变量的数组编辑器



可以在数组编辑器中直接编辑该变量，对于大型数组，使用数组

编辑器会给用户带来很大的便利。

1.3.17 存取数据文件

在MATLAB中，提供了Save和Load命令来实现数据文件的存取。
表1.6列出了命令的常见用法。

表1.6 MATLAB的文件存取命令

表1.6中列出了几个常见的文件存取命令，可以根据需要选择对应
的存取命令，对于一些比较少见的存取命令，可以查阅MATLAB的相
关帮助。

说明

在表1.6的命令当中，参数Filename可以带有路径，但是不能带扩展名；x、y、z代表变量

名称，个数不限，但是名称之间必须以空格来分隔；-ASCII参数表示数据将以ASCII格式来处

理，生成的文件可以使用文本编辑器来编辑，一般适用于数据较多的文件；如果命令行后面

没有- ASCII参数，在默认情况下，数据将以二进制格式来处理，生成以mat为扩展名的文件。

 
在MATLAB中，除了可以在命令窗口中输入相应的命令之外，也

可以在工作空间中选择相应的按钮，来实现数据文件的存取工作。例



如，可以选择工作空间浏览器中的“File”→“Save Workspace As”命令，
将所有变量保存到MAT文件中，如图1.38所示。

图1.38 保存所有的变量

当选择“Save Workspace As”命令后，打开“Save to MAT-File”对话
框，在对话框中输入数据文件的名称，然后选择保存路径，就可以保

存所有的变量。

如果需要保存部分变量，可以在工作空间浏览器中同时选择需要

保存的变量，然后单击鼠标右键，在弹出的快捷菜单中选择“Save
As”命令，将选择的变量保存到MAT文件中，如图1.39所示。



图1.39 保存部分变量

说明

当选择“Save As”命令后，同样可以打开“Save to MAT-File”对话框，在对话框中输入数据

文件的名称，然后选择保存路径，就可以保存所选择的变量。

 
在MATLAB的工作空间浏览器中，也可以加载数据。选择工作空

间浏览器中的“File”→“Open”命令，打开“Open”对话框，来加载数据
文件中的所有变量；同时，可以选择“File”→“Import Data”命令，打
开“Open”对话框，选择需要加载的数据文件，然后单击“打开”按钮，
打开“Import Wizard”对话框，从中选中希望加载的变量，如图1.40所
示。

图1.40 “Import Wizard”对话框

在“Import Wizard”对话框中，左窗格中是数据文件中的变量，可
以在这些变量中选择需要加载的变量，右窗格则是用户所选变量的预



览效果。在图1.40中，用户选择的是变量“my_array”，在右窗格中显示
了该变量的预览效果。

提示

如果某些数据是经过很复杂的计算过程得到的，为了避免再次重复计算，通常会使用

Save命令加以保存。如果在后面的操作中需要使用这些数据，则可以使用Load命令来加载。

1.4 MATLAB 7的帮助系统

MATLAB的各个版本都为用户提供了非常详细的帮助系统，可以
帮助用户更好地了解和运用MATLAB。因此，不论用户是否使用过
MATLAB，是否熟悉MATLAB，都应该了解和掌握MATLAB的帮助系
统。同时，在MATLAB 6.x以后的版本中，帮助系统的帮助方式、内
容层次相对于之前的版本发生了本质变化，因此，更加有必要了解

MATLAB 7的帮助系统。在本节中，将详细介绍MATLAB 7的帮助系
统。

1.4.1 纯文本帮助

在MATLAB中，所有执行命令或者函数的M源文件都有较为详细
的注释，这些注释都是用纯文本的形式来表示的，一般都包括了函数

的调用格式或者输入参数、输出结果的含义。这些帮助是最原始的

（相当于最底层的源文件），当MATLAB不同版本中函数发生变化的
时候，这些文本帮助也会同步更新。

下面使用简单的例子来说明如何使用MATLAB的纯文本帮助。
例1.11 如何在MATLAB中查阅帮助信息。



根据MATLAB的帮助体系，可以查阅不同范围的帮助，具体步骤
如下：

step 1
在 MATLAB 的 命 令 窗 口 中 输 入 help help 命 令 ， 然 后 按

下“Enter”键，查阅如何在MATLAB中使用help命令，如图1.41所示。

图1.41 使用help命令的帮助信息

图1.41中显示了如何在MATLAB中使用help命令的帮助信息，可
以详细阅读其中的信息来了解如何使用help命令。

step 2
在MATLAB的命令窗口中输入help命令，然后按下“Enter”键，查

阅关于MATLAB系统中的所有主题的帮助信息，如图1.42所示。



图1.42 查阅关于主题的帮助信息

step 3
在 MATLAB 的 命 令 窗 口 中 输 入 help topic 命 令 ， 然 后 按

下“Enter”键，查阅关于该主题的所有帮助信息，如图1.43所示。



图1.43 查阅主题下的函数帮助信息

提示

上面的步骤中，简单地演示了如何在MATLAB中使用help命令，来获得各种函数、命令

的帮助信息。在实际应用中，可以灵活使用这些命令来搜索所需的帮助信息。

 
例1.12 如何在MATLAB中搜索各命令的帮助信息，在M函数文

件中搜索包含关键字jacobian的所有M函数文件名，如图1.44所示。



图1.44 搜索M文件的帮助文件

1.4.2 演示（demo）帮助

在MATLAB中，各个工具包都有设计好的演示程序，这组演示程
序在交互界面中运行，操作非常简便。因此，运行这组演示程序，然

后研究演示程序的相关M文件，对MATLAB用户而言是十分有益的。
这种演示功能对提高用户对MATLAB的运用能力有着重要的作用。特
别对于那些初学者而言，不需要了解复杂的程序就可以直观地查看程

序结果，可以加强用户对MATLAB的掌握能力。
在MATLAB的命令窗口中输入“demo”命令，就可以调用关于演示

程序的帮助对话框，如图1.45所示。



图1.45 MATLAB的demo帮助

可以在对话框的左窗格中选择演示的内容，例如选择“Graphics”选
项，在右窗格中会出现该项目下的各种类别的演示程序。单击对话框

中的“3-D Surface Plots”选项，MATLAB中会显示关于“3-D Surface
Plots”演示程序的介绍，然后单击对话框中的“Run this demo”选项，
MATLAB会打开“3-D Plots in Handle Graphics”对话框，这就是演示
demo的交互界面，如图1.46所示。



图1.46 显示demo的交互界面

演示该demo的是一个交互界面，可以调整该界面中选项按钮的数
值，改变图形的显示参数，这些修改的参数会出现在“Command
Window”框中，如图1.47所示。



图1.47 动态演示demo

除了可以在打开的动态界面中演示demo之外，还可以查看该demo
的程序代码，单击“Help”对话框中的“View code for graf3d”选项，查看
该GUI界面的MATLAB程序代码，如图1.48所示。



图1.48 查看demo的程序代码

提示

除了在命令窗口中输入demo命令来调用demo的“Help”对话框之外，还可以选择MATLAB

的操作界面中的“Start”→“Demos”命令，调用demo的对话框。

1.4.3 帮助导航／浏览器

在MATLAB中提供帮助信息的“导航/浏览器”交互界面是MATLAB
6.x以后的版本的重要改进，这个交互界面主要由帮助导航器和帮助浏
览器两个部分组成。这个帮助文件和M文件中的纯文本帮助无关，而
是MATLAB专门设置的独立帮助系统。该系统对MATLAB的功能叙述



得全面、系统，而且界面友好，使用方便，是用户查找帮助的重要途

径。

在MATLAB的命令窗口中输入命令“helpbrowser”或者“helpdesk”，
或者在操作界面中单击 按钮，打开帮助导航／浏览器交互界面，

如图1.49所示。

图1.49 帮助导航／浏览器界面

1.4.4 Contents帮助文件目录窗口

在默认情况下，当用户在MATLAB中打开帮助导航／浏览器交互
界面时，界面会显示“Contents”选项卡。这个选项卡使用了节点可展开
的目录树来列出各种帮助信息，直接使用鼠标来单击相应的目录条，

就可以在浏览器中显示出相应标题的HTML帮助文件。
这个窗口是向用户提供全方位系统帮助的向导，层次清晰、功能

划分规范，可以查找相应的帮助信息。例如，初学用户希望了解



MATLAB ， 可 以 选 择 对 话 框 中 的 “MATLAB” →“Getting
Started”→“Introduction”→“What Is MATLAB?”选项，在浏览器中查看
关于MATLAB的HTML帮助文件，如图1.50所示。

图1.50 查看帮助文件的目录

提示

在MATLAB的帮助浏览器中，除了提供HTML类型的帮助文件，还提供了PDF类型、Web

类型的帮助文件。对于不同类型的文件，在目录树中对应文件名称之前的符号会有所不同。

1.4.5 Index帮助文件索引窗口

在MATLAB中，为了提高用户使用帮助文件的效率，专门为命
令、函数和一些专用术语提供了索引表。选择交互界面中的“Index”选
项卡，然后在“Search index for”文本框中输入需要查找的名称，在其下



面就会出现与此匹配的词汇列表。同时，在浏览器的界面中显示相应

的介绍内容。

例如，在“Search index for”文本框中输入“sin”进行搜索，得到的
结果如图1.51所示。

图1.51 查看“sin”的信息

提示

在MATLAB 7中，交互界面的“Index”选项中添加了A～Z的字母索引体系，当用户单击其

中一个字母的时候，会在其下的列表中显示含有该字母的资源信息。

1.4.6 Search帮助文件搜索窗口



和前面“Index”选项卡不同，在“Search”选项卡中，可以利用关键
字在全文中查找到与关键字相匹配的内容。在“Search”选项卡中的搜
索范围是整个HTML文件而不仅仅是专业术语，因此其覆盖面更加广
泛。

在默认的情况下，该选项卡中的搜索方式是全文搜索。例如，

在“Search for”文本框中输入“laplace”，就可以在整个HTML文件中搜
索含有该字母片断的内容，如图1.52所示。

图1.52 在“Search”选项卡中查看“laplace”的信息

在搜索结果的底部，有 “Search Support Database on Web for
laplace”超链接，单击该链接，MATLAB就会启动IE在相关网站上搜索
关于laplace的资源信息。同时，在搜索界面的底部，显示了“18 pages
contain the word:laplace”的字样，表明搜索的结果个数。
在帮助浏览器中会显示每个搜索结果的HTML文件，同时将关键

字“laplace”高亮显示，方便用户查阅相应的信息。



注意

在MATLAB 6.5以后的版本中，MATLAB开始支持关键字之间的逻辑运算符AND、OR、

NOT等，这些逻辑运算符都需要大写，同时必须和关键字之间保持间隔。

1.5 小结

在本章中，首先向读者介绍了MATLAB软件的特点，然后循序渐
进地介绍了如何安装MATLAB 7以及MATLAB 7的工作环境、帮助系
统等内容，希望通过本章的学习，读者能够对MATLAB有一个直观的
印象。在后面的章节中，将详细介绍关于MATLAB的基础知识和基础
操作方法。

 

◆   ◆   ◆



第2章 数  组

本章包括

◆创建数值数组

◆操作数值数组

 
数组是MATLAB的基础内容，几乎所有的数据都是用数组的形式

进行储存的，因此，MATLAB又被称为矩阵实验室。从MATLAB 5.x
版本开始，基于面向对象的考虑，这些数组就成为MATLAB中的内建
数据类型（Built-in Data Type），而数组运算就是定义这些数据结构的
方法。在本章中，将介绍关于数组类型和数组运算的内容。

2.1 创建数值数组

创建数组是所有MATLAB运算和操作的基础，针对不同维度的数
组，MATLAB提供了多种创建方法，分别可以创建不同要求的数组类
型。在本节中，将分别根据数组维度以及方法的不同来介绍如何创建

数组。

2.1.1 一维数组的创建方法

在MATLAB中，一维和二维数组都被认为是比较低维的数组。它
们的创建方法比较简单，同时，也是创建高维数组的基础条件，下面

将以简单的例子来说明如何在MATLAB中创建各种不同的数组类型。
例2.1 在MATLAB中，使用不同的方法来创建一维数组。



step 1
在MATLAB的命令窗口中输入下面的程序代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到以下结

果：

上面的结果基本演示了在MATLAB中创建一维数组的方法。
 
◆ 直接输入法：在上面的程序代码中，data1和data2就是直接输

入法。其中data1在输入数据的时候，使用了分号，创建了一维列数
组；data2则在创建过程中使用了空格，因此创建了一维行数组。

◆ 步长生成法：在上面的程序代码中，data3和data4的创建方法
就是步长生成法，其通用方法是a:inc:b，其中a表示的是数组的第一个



元素，inc是创建数组之间的间隔，也就是步长，b则是数组中的最后
一个元素。其中inc可以省略，默认的数值为1。

◆ 定数线性采样法：在上面的程序代码中，data5的创建方法就
是定数线性采样方法，该方法在设定“总个数”的条件下，均匀采样分
布生成一维行数组，这种方法的调用格式为：x=linspace(a,b,n)，其中a
和b分别是数组的第一个和最后一个元素，n表示的是采样点数。

◆ 定数对数采样法：在上面的程序代码中，data6的创建方法就
是定数对数采样法。这种方法在设定“总个数”的条件下，经过“常用对
数”采样生成一维行数组。这种方法的调用格式为x=logspace(a,b,n)。

说明

在步长生成法中，步长参数inc的数值可以是正数，也可以是负数，当inc是正数的时候，

必须满足a＜b；当inc是负数的时候，必须满足a＞b。

2.1.2 二维数组的创建方法

在本节中将介绍如何在MATLAB中创建二维数组。
例2.2 在MATLAB中创建二维数组。

step 1
在MATLAB的命令窗口中输入下面的程序代码：

step 2
查看程序结果。在命令窗口输入变量名称，可以得到下面的程序

结果：



上面的例子基本演示了在MATLAB中创建二维数组的方法，Data1
的创建方法比较直接，得到的结果就是输入的结果；Data2的创建方法
则是更加普遍的方法，关于该方法需要注意下面的内容：

 
◆ 整个输入数组必须以方括号“[]”作为创建的首尾。
◆ 数组的行和行之间必须用分号“;”间隔。
◆ 数组的列和列之间必须用逗号“,”间隔。

提示

上面使用的创建方法适用的范围比较窄，当数组的行或者列数比较大的时候，该创建方

法就会显得比较烦琐，至于其他方法将在后面章节中加以介绍。

2.1.3 使用下标创建三维数组

在MATLAB中，习惯将二维数组的第一维称为“行”，第二维称
为 “列 ”，而对于三维数组，其第三维则习惯性地称为 “页 ”。在
MATLAB中，将三维或者三维以上的数组统称为高维数组。由于高维
数组的形象思维比较困难，在本节中将主要以三维为例来介绍如何创

建高维数组。

例2.3 使用下标引用的方法创建三维数组。

step 1
在MATLAB的命令窗口中输入下面的程序代码：



step 2
查看程序结果。在命令窗口中输入变量名称，可以得到下面的程

序结果：

step 3
创建新的高维数组。在MATLAB的命令窗口中输入下面的程序代

码：

step 4
查看程序结果。在命令窗口中输入变量名称，可以得到下面的程

序结果：



说明

从结果中可以看出，当使用下标的方法创建高维数组的时候，需要使用各自对应的维度

的数值，没有指定的数值则在默认情况下为0。

2.1.4 使用低维数组创建三维数组

本节将介绍如何在MATLAB中使用低维数组创建三维数组。
例2.4 使用低维数组创建高维数组。

step 1
在MATLAB的命令窗口中输入下面的程序代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到以下结

果：



提示

从结果中可以看出，由于三维数组中“包含”了二维数组，因此可以通过二维数组来创建

各种三维数组。

2.1.5 使用创建函数创建三维数组

本节将介绍如何利用MATLAB的创建函数来创建三维数组。
例2.5 使用函数命令来创建高维数组。

step 1
使用cat命令来创建高维数组。在MATLAB的命令窗口中输入下面

的程序代码：

step 2



查看程序结果。在命令窗口中输入变量名称，可以得到以下结

果：

说明

cat命令的功能是连接数组，其调用格式为C = cat(dim,A1,A2,A3,A4...)，其中，dim表示的

是创建数组的维度，A1，A2，A3，A4表示的是各维度上的数组。

step 3
使用repmat命令来创建数组。在MATLAB的命令窗口中输入下面

的程序代码：

step 4
查看程序结果。在命令窗口中输入变量名称，可以得到以下结

果：



说明

repmat命令的功能在于复制并堆砌数组，其调用格式B = repmat(A,[m n p...])中，A表示的

是复制的数组模块，第二个输入参数则表示该数组模块在各个维度上的复制个数。

step 5
使用reshape命令来创建数组。在MATLAB的命令窗口中输入以下

代码：

step 6
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明

reshape命令的功能在于修改数组的大小，因此可以将二维数组通过该命令修改为三维数

组，其调用格式为B = reshape(A,[m n p ...])，其中A就是待重组的矩阵，后面的输入参数则表

示数组各维的维度。

2.1.6 创建低维标准数组

除了前面介绍的方法，MATLAB还提供了多种函数来生成一些标
准数组，用户可以直接使用这些命令来创建一些特殊的数组，下面将



使用一些简单的例子来说明如何创建标准数组。

例2.6 使用标准数组命令创建低维数组。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明

并不是所有的标准函数命令都可以创建多种矩阵，例如eye、magic等命令就不能创建高

维数组。同时，对于每个标准函数，参数都有各自的要求，例如gallery命令中只能选择3或者

5。

2.1.7 创建高维标准数组

本节将介绍如何使用标准数组函数来创建高维标准数组。

例2.7 使用标准数组命令创建高维数组。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明

限于篇幅，在这里就不详细介绍各种命令的参数和使用方法了，有需要的读者请自行阅

读相应的帮助文件。

2.2 操作数值数组

在MATLAB中，除了需要创建数组之外，还需要对数组进行各种
操作，包括重组、元素变换、提取、旋转等操作，MATLAB都提供了
对应的函数命令，本节中将以简单的实例来说明这些命令的使用方



法。由于数组维度的不同将会带来MATLAB不同的操作要求，因此，
将按不同的数组维度来讨论数组的操作。

2.2.1 选取低维数组的对角元素

低维数组的操作比高维数组的操作在运算或者使用上要简单，因

此在本节中将首先使用实例来介绍如何操作低维数组。

例2.8 使用diag命令来选取对角元素或者创建矩阵。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明

从结果中可以看出，diag命令的功能可以是选取矩阵对角线的数组，也可以将某个数组

创建矩阵，用户可以很方便地利用该命令来处理矩阵对角线的数据。

 
对于diag命令中参数k的含义，可以用图2.1来形象地说明。

图2.1 diag命令中参数k的含义



2.2.2 低维数组的形式转换

例2.9 对数组或者矩阵进行形式转换：对称变换和旋转。

step 1
在MATLAB的命令窗口中输入如下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



这段代码中演示了各种转换命令，下面简要介绍各种命令的含

义。

 
◆ fliplr：以数组的垂直中线为对称轴，交换左右对称位置上的

数组元素。

◆ flipud：以数组的水平中线为对称轴，交换左右上下对称位置
上的数组元素。



◆ rot90：逆时针旋转二维数组90°。

2.2.3 选取三角矩阵

例2.10 选取数组上三角或者下三角矩阵。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明



在上面的步骤中，tril命令的功能是提取矩阵的下三角矩阵，triu命令的功能在于提取矩阵

的上三角矩阵，两个命令中的参数k的含义和diag命令相同。

2.2.4 Kronecker乘法

例2.11 演示Kronecker乘法的不可交换性。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明

从结果中可以看出，对于相同的两个矩阵，交换后的乘积是不同的结果，因此就证明了

Kronecker乘法的不可交换性。关于Kronecker乘法，请读者自行查阅相应的书籍。

2.2.5 高维数组的对称交换

对于高维数组，由于在结构上多了维度，因此在操作方法上多了

一些操作其他维度的命令，在本节中还是以简单的实例来介绍这些函

数的使用方法。

例2.12 对三维数组进行对称交换。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明

在MATLAB中，flipdim(A,k)命令的第一个输入变量A表示的是被操作的数组，第二个输

入变量k指定的是对称面。1表示的是与数组行平行的平分面，2表示的是与数据列平行的平分

面，3表示的是与数据页平行的平分面。



2.2.6 高维数组的维序号移动

例2.13 对三维数组进行“维序号移动”。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



2.2.7 高维数组的广义共轭转置

例2.14 对三维数组进行广义共轭转置。

step 1
在MATLAB的命令窗口中输入以下代码：



step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明



在MATLAB中，permute命令的第一个输入变量是被转置的数组，第二个变量表示的是转

置方式的行数组，该行数组中元素位置号代表的是新数组的维序号数值。

2.2.8 高维数组的降维操作

例2.15 使用squeeze命令来撤销“孤维”，使高维数组降维。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



2.3 小结

在本章中，依次介绍了如何在MATLAB中创建和操作数值数组，
这些内容都是MATLAB的基础知识，因此希望读者能够熟练掌握。其
中数值数组是MATLAB所有操作的重要内容，在后面的章节中，将主
要介绍如何使用MATLAB进行数值运算。

◆   ◆   ◆



第3章 矩阵和架构

本章包括

◆创建稀疏矩阵

◆分析稀疏矩阵的信息

◆创建字符串数组

◆处理字符串数组的信息

◆创建构架数组

◆访问构架数组的数据

 
在第2章中，重点讲解了数值数组这种数据类型。在MATLAB

中，除了使用数组来保存数据类型，还有其他的数据类型保存方法。

其中，矩阵是另外一种重要的形式。同时，MATLAB除了处理数值数
组之外，还可以处理非数值的数组，例如字符串数组或者其他综合数

据类型数组等。在本章中，将重点讲解矩阵和非数值数组这部分的内

容。

3.1 稀疏矩阵

在MATLAB中，系统使用两种方法来存储数据，也就是满矩阵的
形式和稀疏矩阵的形式，简称满矩阵和稀疏矩阵。在很多情况下一个

矩阵中只有少数元素是非零的，对于满矩阵MATLAB是会使用相同的
空间来储存零元素和非零元素，这种储存方法对于大多数元素为0的稀
疏矩阵而言，将会造成大量的浪费。因此，对于稀疏矩阵，MATLAB



提供了特殊的存储方法，同时提供了特殊的操作函数和运算法则，下

面详细介绍。

3.1.1 稀疏矩阵的存储方式

在MATLAB中，一般使用3个矩阵来存储稀疏矩阵，假设有一个
m×n的矩阵，其中有nnz个非零元素，存储在长度为nz max的矩阵中。

 
◆ 第一个矩阵用来存储所有的非零元素，该矩阵的长度为nz

max。
◆ 第二个矩阵用来存储所有的非零元素的行指标，该矩阵的长

度也是nz max。
◆ 第三个矩阵用来存储每一列的开始处指针和一个标志着这3个

矩阵结束的指针，该矩阵的长度为n＋1。
 
根据上面的介绍可知，一个稀疏矩阵需要存储nz max个浮点数和

nz max＋n＋1个整数，因此，存储一个稀疏矩阵需要8*nz max＋4*（nz
max＋n＋1）个字节的单元。对于稀疏矩阵和满矩阵的存储差异，
MATLAB提供了下面的转换命令：

 
◆ SM＝sparse（A）将其他存储方式转换为其他的稀疏矩阵形

式。

◆ FM＝full（A）把矩阵存储方式从任何一个存储形式转换为满
矩阵形式。

3.1.2 创建稀疏矩阵——使用sparse命令



由于满矩阵的运算得到的结果还是满矩阵，因此如果不通过相应

的命令将不会创建稀疏矩阵。在MATLAB中，提供了多个命令来创建
稀疏矩阵，经常使用的有sparse和spdiags两种。其中，sparse命令的调
用格式如下：

该命令表示使用[i,j,s]的行创建m×n维稀疏矩阵S；在这条命令中，
s表示的是按照排列的所有非零元素构成的向量。i，j分别表示的是非
零元素的行下标和列下标向量。

例3.1 使用sparse命令创建稀疏矩阵。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



step 3
查看存储信息。为了加强对稀疏矩阵的存储信息的理解，可以使

用whos命令查看各变量的信息：



3.1.3 创建稀疏矩阵——使用spdiags命令

在MATLAB中，spdiags命令的调用格式如下：

该调用命令的功能是抽取和创建带状对角稀疏矩阵。在上面的参

数中，m和n分别表示指定矩阵的行和列的维数。d表示的是长度为p的
整数向量，B是满矩阵，用来指定A矩阵的对角线位置上的元素。

说明

在MATLAB中，还提供了从外部数据转换为稀疏矩阵的命令spconvert，用户可以首先通

过load命令加载外部数据，然后使用该命令创建稀疏矩阵。

 
例3.2 使用spdiags命令来创建稀疏矩阵。

step 1
在MATLAB的命令窗口中输入以下代码：



step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

说明

在MATLAB中，还提供了创建特殊稀疏矩阵的各种命令，例如speye、spones、sprand、

sprandsym等，关于这些命令的详细使用方法可以查看相应的帮助文件。

3.1.4 查看稀疏矩阵的信息

由于稀疏矩阵的维度一般比较大，直接查看系数矩阵不利于用户

查看系数矩阵的信息，为此MATLAB提供了查看稀疏矩阵定量信息和
图形化信息的函数，主要用来查看稀疏矩阵的非零元素信息和图形化

稀疏矩阵信息。

 
◆ n=nnz(x) 查看稀疏矩阵中的非零元素个数。



◆ s=nonzeros(A) 返回稀疏矩阵中的非零元素数值。
◆ n=nz max(S) 返回稀疏矩阵中存储非零元素的空间长度。
 
例3.3 查看某稀疏矩阵的元素信息。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明

从结果中可以看出，在默认的情况下，稀疏矩阵中非零元素的个数和存储非零元素的长

度相同。

3.1.5 稀疏矩阵的图形化信息

除了信息查询函数之外，MATLAB还提供了查看稀疏矩阵的图形
化命令spy，其具体的调用格式如下：

其中S表示的是稀疏矩阵，LineSpec表示的是线型属性的字符串，
markersize则表示的是标记大小。
例3.4 查看稀疏矩阵的图形化信息。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
按“Enter”键，得到的图形如图3.1所示。



图3.1 稀疏矩阵S的图形

step 3
在MATLAB的命令窗口中输入以下代码：

step 4
按“Enter”键，得到的图形如图3.2所示。



图3.2 稀疏矩阵的图形

3.2 字符串数组

尽管在MATLAB的主要运算对象是数值数组，但是在实际运用中
也会经常需要处理字符串对象，因此在MATLAB中也提供了有关字符
串数组操作的函数。正是因为字符串和数值属于不同的数据类型，所

以在创建和操作中有许多地方和数值数组有明显的差异，在本节中将

分别介绍字符串数组的相关操作情况。

3.2.1 创建字符串数组——直接输入法

在MATLAB中，可以使用多种方法创建字符串数组，在本节中将
以各种简单的实例来说明如何创建各种要求的字符串数组。

例3.5 通过直接输入法来创建字符串数组。

step 1
在MATLAB的命令窗口中输入以下代码：



step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

从以上程序代码可以得知创建字符串数组的基本方法：

 
◆ 直接在单引号对内输入字符串的内容。
◆ 当字符串文字中包含单引号时，每个单引号符号需要使用连

续的2个单引号字符。
◆ 可以使用小的字符串构成长的字符串。

3.2.2 创建字符串数组——使用ASCII码

例3.6 通过ASCII码的转换来创建字符串数组。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2



查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

说明

从上面的结果可以看出，在MATLAB中，可以使用char和double在字符串数组和数值数组

之间转换，其中数值数组就是字符串对应的ASCII码。

step 3
通过ASCII码实现字符串变量大小写的转换。在命令窗口中输入

以下代码：

step 4
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

提示

在MATLAB中，大小写字符串的ASCII码相差32，因此使用数值数组之间的加法或者减

法来实现大小写变换。



3.2.3 创建字符串数组——使用函数

例3.7 通过数组创建函数来创建字符串数组。

step 1
在MATLAB的命令窗口中输入如下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明

在MATLAB中，使用上面三个函数来创建字符串时，不需要注意每个字符串变量的长度

是否相等，同时应该注意空串和空格串的差别。

3.2.4 处理字符串数组的空格

为了方便用户操作字符串数组，MATLAB提供了多种字符串的操
作函数，包括对字符串进行转换、裁减、连接、查找等功能，这些函



数内容繁多，在本章中将主要介绍比较常见的字符串操作函数，其他

具体函数请读者自行查阅帮助文件。

例3.8 使用不同的方法来处理字符串中的空格。

step 1
在MATLAB的命令窗口中输入如下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

说明

从上面的结果可以看出，两个不同的命令都可以用于清除字符串中的空格，但是具体的

用法和功能还是略有不同的，strtrim命令的功能主要是清除字符串前后的空格，deblank命令

的功能则是清除字符串尾部的空格。



3.2.5 读取字符串数组的信息

例3.9 使用函数查找、替代和读取字符串中的信息。

step 1
替代字符串。在MATLAB的命令窗口中输入如下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

说明

在上面的结果中，字符串变量 str通过命令 strrep将字符串变量 s1中的 “good”替换

为“great”。

step 3
读取字符串数组的信息。在MATLAB的命令窗口中输入如下代

码：

step 4
查看程序结果。按“Enter”键，可以得到如下结果：



说明

在上面的程序代码中，通过使用strread命令从原始的字符串中读取各种具体有效的数值

信息。

step 5
查找字符串中的“<>”符号，得出有效信息。在MATLAB的命令窗

口中输入如下代码：

step 6
查看程序结果。按“Enter”键，可以得到如下结果：

说明



在上面的程序代码中，首先将某个HTML代码中的字符串添加到变量s中，然后将这个字

符串切断为各个部分，并删除“<”和“>”字符串，最后使用循环语句来将各个字符串信息显示

出来。

3.3 构架数组

在MATLAB中，构架数组是一个比较特殊的数组类型，在该数组
中可以存放各种不同类型的数据。构架数组的基本组成部分是构架，

数组中的每个构架都是平等的，它们主要用下标进行区分。构架必须

在划分了“域”之后才能使用，数据不能直接存放在构架数组中，而只
能直接存放在构架的域中。而构架中的“域”可以存放任何类型、任何
大小的数组，而且不同构架数组中的同名域中可以存放不同的内容。

鉴于构架数组具有上面这些特殊之处，在本节中将介绍如何在

MATLAB中创建、操作和运用构架数组。

3.3.1 创建单构架数组——使用直接法

构架数组实质上具有面向对象的数据结构功能，具有属性名称、

属性数值两个主要对象域，对此MATLAB提供了多种创建方法来构建
构架数组，在本节中，将以具体的实例来说明如何创建构架数组。

例3.10 使用直接法来创建某个关于病人的构架数组。

step 1
创建维度为1×1的构架数组。在MATLAB的命令窗口中输入如下

代码：



step 2
查看该构架数组的存储信息。使用whos命令查看数组信息，其具

体的信息如下：

step 3
查看该构架数组的具体信息。在MATLAB的命令窗口中输入下面

的代码：

在以上代码中，patient只有一个构架，其总共有4个数值域：
name、billing、test和medi_information，其中medi_information又有两



个子域：city和date。向子域中直接添加数值是创建构架数组的最常用
方法。

提示

当用户在命令窗口中直接输入构架名称的时候，MATLAB只会显示构架的域名以及对应

的信息，如果需要查看各个构架数组中具体名域的数值，则需要引用对应的具体名称。

3.3.2 创建二维构架数组

例3.11 沿用上面的实例，创建二维构架数组。

step 1
直接扩充构架数组的维度。在MATLAB的命令窗口中输入如下代

码：

step 2
查看该构架数组的存储信息。使用whos命令查看数组信息，其具

体的信息如下：



step 3
利用上面的数组创建新数组。在MATLAB的命令窗口中输入如下

代码：

step 4
查看程序结果。在命令窗口中输入变量名称，可以得到下面的程

序结果：

step 5
访问构架数组的信息。在MATLAB的命令窗口中输入如下代码：

提示



从上面的结果中可以看出，对于高维构架数组也可以使用直接对子域进行赋值的方法进

行创建，同时可以使用高维构架数组来创建低维构架数组。

3.3.3 创建三维构架数组

例3.12 沿用上面的实例，创建三维构架数组。

step 1
直接扩充构架数组的维度。在MATLAB的命令窗口中输入如下代

码：

step 2
查看该构架数组的存储信息。使用whos命令查看数组信息，其具

体的信息如下：

step 3
查看该构架数组的结构图。由于三维构架数组比较难以理解，下

面的图形列出了具体的结构图，如图3.3所示。



图3.3 三维构架数组的图形化结构

3.3.4 使用命令创建构架数组

例3.13 使用struct命令创建构架数组。

step 1
调用struct命令，创建构架数组。在MATLAB的命令窗口中输入如

下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明

在MATLAB中，创建构架数组的命令struct的调用格式为s = struct('field1', values1,'field2',

values2, …)，其中field表示的是构架数组的域，values表示数组域的数值。

3.3.5 访问构架数组的数据

由于构架数组比较特殊，因此如果希望在其他的应用程序或者模

块中使用构架数组，则需要能够访问构架数组中的数据，下面使用例

子来说明如何访问构架数组的数据。

例3.14 访问构架数组的数据。

step 1
在MATLAB的命令窗口中输入如下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：



说明

在以上代码中，patient和mypatient变量是前面小节中创建的构架数组，这里演示了不同

的引用方法。

 
例3.15 在程序代码中调用构架数组中的数据，并绘制对应的图

形。

step 1
创建构架数组。在MATLAB的命令窗口中输入如下代码：

step 2



查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

step 3
编 写 绘 图 函 数 命 令 。 选 择 命 令 窗 口 编 辑 栏 中

的“File”→“New”→“M-File”命令，打开M文件编辑器，在其中输入如
下代码：

在输入上面的程序代码后，将其保存为“concen.m”文件。

step 4
运行函数。在MATLAB的命令窗口中输入如下代码：

step 5
查看结果。输入这行代码后，得到的计算结果如下：



同时，可以得到的图形如图3.4所示。

图3.4 绘制结果的图形

3.3.6 设置构架数组的域属性

由于构架数组的域是存放数据的场所，因此调取和设置构架数组

中数据的前提就是了解或者熟悉构架数组的域名，尽管在前面的章节

中曾经介绍过访问构架数组域名的方法，但是这种方法并不能获得其

他命令能够处理的域名。为了解决这个矛盾，MATLAB提供了关于处
理域名的各种命令，在本节中将主要介绍一些常见命令。

例3.16 使用fieldnames命令获取构架数组的域属性。



step 1
创建构架数组。在MATLAB的命令窗口中输入如下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

step 3
获取域名属性。在MATLAB的命令窗口中输入如下代码：

step 4
查看程序结果。按“Enter”键，可以得到如下结果：

step 5
获取其他对象的域名属性。在MATLAB的命令窗口中输入如下代

码：

step 6
查看程序结果。按“Enter”键，可以得到如下结果：



例3.17 使用getfield命令来获取域属性。

step 1
创建构架数组。在MATLAB的命令窗口中输入如下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

step 3
获取域名属性。在MATLAB的命令窗口中输入如下代码：



step 4
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

 
例3.18 使用setfield命令来设置域属性。

step 1
创建构架数组。在MATLAB的命令窗口中输入如下代码：

step 2
查看程序结果。在命令窗口中输入变量名称，可以得到如下结

果：

step 3
查看构架数组的信息。在MATLAB的命令窗口中输入如下代码：

step 4
查看程序结果。按“Enter”键，可以得到下面的程序结果：



3.4 小结

MATLAB除了可以处理常见的数值对象信息之外，还可以处理非
数值对象的信息。本章主要讲解了如何创建和处理稀疏矩阵、字符串

数组和构架数组。其中，字符串数组和构架数组在工程应用中有广泛

应用。因此，了解如何创建和处理这些非数值数组，是后面章节讲解

数值分析的基础。

◆   ◆   ◆



第4章 矩阵分析

本章包括

◆矩阵分析

◆线性方程组

◆矩阵分解

 
前面章节已经介绍过，MATLAB的基本运算单元是数组，因此本

章内容将从矩阵分析的数值计算开始介绍。在MATLAB中，数值运算
主要通过函数或者命令来实现，而由于在MATLAB中所有的数据都是
以矩阵的形式出现的，其对应的数值运算包括两种类型：一种是针对

整个矩阵的数值运算，也就是矩阵运算，例如求解矩阵行列式的函数

det；另外一种是针对矩阵中的元素进行运算的函数，可以称为矩阵元
素的运算，例如求解矩阵中每个元素的余弦函数cos等。

4.1 矩阵计算

矩阵分析是线性代数的重要内容，也是几乎所有MATLAB函数分
析的基础。在MATLAB 7.0中，可以支持多种线性代数中定义的操
作，正是其强大的矩阵运算能力才使得MATLAB成为优秀的数值计算
软件。在本节中，将主要介绍关于矩阵分析的内容。

4.1.1 进行范数分析——使用norm函数



根据线性代数的知识，对于线性空间中的某个向量x＝{x1，x2，

…，xn}，其对应的p级范数的定义为 ，其中的参数p＝

1，2，…，n。同时，为了保证整个定义的完整性，定义范数数值
。

矩阵范数的定义是基于向量的范数的，具体的表达式为：

在实际应用中，比较常用的矩阵范数是1、2和∞阶范数，其对应
的定义如下：

在上面的定义式 中，Smax{ATA}表示的是矩阵A

的最大奇异值的平方，关于奇异值的定义将在后面章节中介绍。

说明

之所以在本节中介绍范数分析的内容，是因为矩阵的范数将直接影响通过MATLAB求解

得到的数值解的精度。

 
在MATLAB中，求解向量和矩阵范数的命令如下：
 
◆ n = norm(A)计算向量或者矩阵的2阶范数。
◆ n = norm(A,p)计算向量或者矩阵的p阶范数。

说明



在命令n = norm(A,p)中，p可以选择任何大于1的实数，如果需要求解的是无穷阶范数，

则可以将p设置为inf或者-inf。

 
例4.1 根据定义和norm来分别求解向量的范数。

step 1
进行范数运算。选择命令窗口菜单栏中的“File”→“New”→“M-

File”命令，打开M文件编辑器，在其中输入以下程序代码：

在输入上面的代码后，将其保存为“normex.m”文件。

step 2
查看运算结果。在MATLAB的命令窗口中输入“normex”后，

按“Enter”键，得到计算结果如下：



提示

从以上结果可以看出，根据范数定义得到的结果和norm命令得到的结果完全相同，通过

上面的代码可以更好地理解范数的定义。

 
例4.2 根据定义和norm来分别求解Hilbert矩阵的范数。

step 1
进行范数运算。选择命令窗口菜单栏中的“File”→“New”→“M-

File”命令，打开M文件编辑器，在其中输入以下程序代码：



在输入上面的代码后，将其保存为“normex2.m”文件。

step 2
查看运算结果。在MATLAB的命令窗口中输入“normex2”，然后

按“Enter”键，得到计算结果如下：

step 3



查看矩阵A的数值元素。在上面的步骤中，分别使用定义和norm
命令来求解Hilbert矩阵A的范数，查看A的具体元素，如下所示：

说明

在MATLAB中，Hilbert矩阵是著名的病态矩阵，主要用来分析矩阵的性能。用户可以使

用hilb命令来创建该矩阵，其元素满足等式A（i,j）＝1／（i＋j－1）。

4.1.2 进行范数分析——使用normest函数

当需要分析的矩阵比较大时，求解矩阵范数的时间就会比较长，

因此当允许某个近似的范数满足某种条件时，可以使用normest函数来
求解范数。在MATLAB的设计中，normest函数主要是用来处理稀疏矩
阵的，但是该命令也可以接受正常矩阵的输入，一般用来处理维数比

较大的矩阵。

normest函数的主要调用格式如下：
 
◆ nrm = normest(S) 估计矩阵S的2阶范数数值，默认的允许误

差数值维为1e-6。
◆ nrm = normest(S,tol) 使用参数tol作为允许的相对误差。
 
例4.3 分别使用norm和normest命令来求解矩阵的范数。



step 1
在MATLAB的命令窗口中输入以下命令：

提示

在上面的程序代码中，首先创建了Wilkinson的高维矩阵，然后分别使用norm和normest命

令求解矩阵的范数，并统计了每个命令所使用的时间。

step 2
查看计算得到的矩阵范数。在命令窗口中输入对应的变量名称，

得到的结果如下：

说明

从以上结果可以看出，两种方法得到的结果几乎相等，但在消耗的时间上，normest命令

明显要少于norm命令。

 

step 3



修改矩阵的维度，重新求解范数。在MATLAB的命令窗口中输入
以下命令：

从以上结果可以看出，维度越大则两个命令求解所消耗时间的差

别越大，建议在求解大型矩阵的范数时，使用normest命令。

提示

关于每个命令的计算时间，和运行命令的硬件环境以及是否首次运行软件有关，因此读

者运行的时间结果可能和这里显示的不同，但是两者之间的大小关系不会变化。

4.1.3 条件数分析

在线性代数中，描述线性方程Ax＝b的解对b中的误差或不确定性
的敏感度的度量就是矩阵A的条件数，其对应的数学定义是：

k＝‖A-1‖·‖A‖

根据基础的数学知识，矩阵的条件数总是大于等于1。其中，正交
矩阵的条件数为1，奇异矩阵的条件数为∞，而病态矩阵的条件数则比



较大。

依据条件数，方程解的相对误差可以由以下不等式来估算：

在MATLAB中，求取矩阵X的条件数的命令如下：

例4.4 以MATLAB产生的Magic和Hilbert矩阵为例，使用矩阵的
条件数来分析对应的线性方程解的精度。

step 1
进行数值求解。在MATLAB的命令窗口中输入以下命令：

说明

在上面的程序代码中，首先产生Magic矩阵，然后使用近似解和准确解进行比较，得出计

算误差。

step 2



查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

说明

从以上结果可以看出，矩阵M的条件数5.418，这种情况下引起的计算误差是很小的，其

误差是完全可以接受的。

step 3
修改求解矩阵，重新计算求解的精度。在命令窗口中输入以下代

码：

step 4
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



说明

从以上结果可以看出，该矩阵的条件数为1.7945e＋016，该矩阵在数学理论中就是高度病

态的，这样会造成比较大的计算误差。

4.1.4 数值矩阵的行列式

在MATLAB中，求解矩阵行列式的命令比较简单，其调用格式如
下：

d = det(X)求解矩阵X的行列式，如果输入的参数X不是矩阵，而
是一个常数，则该命令返回原来的常数。

 
例4.5 求解矩阵的行列式。

step 1
求解矩阵的行列式。在MATLAB的命令窗口中输入以下命令：



step 2
查看求解的结果。在输入上面的程序代码后，按“Enter”键，得到

的结果如下：

说明

在上面的程序代码中，首先使用randint命令产生随机矩阵，然后使用det命令来计算这些

矩阵的行列式。

4.1.5 符号矩阵的行列式

需要说明的是，det命令除了可以计算数值矩阵的行列式之外，还
可以计算符号矩阵的行列式，下面举例说明。

例4.6 求解符号矩阵的行列式。

step 1



在MATLAB的命令窗口中输入以下命令：

说明

在上面的程序代码中，使用det命令求解矩阵A的行列式表达式B，然后使用simple命令来

化简表达式B。

step 2
查看运行的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

提示

从以上结果可以看出，使用det命令也可以求解符号矩阵的行列式。关于符号运算的其他

命令，可以查看符号运算的章节。

4.1.6 矩阵的化零矩阵

对于非满秩的矩阵A，存在某矩阵Z，满足A·Z＝0，同时矩阵Z是
一个正交矩阵，也就是说Z′·Z＝I，则矩阵Z被称为矩阵A的化零矩阵。
在MATLAB中，求解化零矩阵的命令为null，其具体的调用格式如
下：

 



◆ Z = null(A) 返回矩阵A的化零矩阵，如果化零矩阵不存在，
则返回空矩阵。

◆ Z = null(A,'r') 返回有理数形式的化零矩阵。
 
例4.7 求解非满秩矩阵A的化零矩阵。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

step 3
求解有理数形式的化零矩阵。在MATLAB的命令窗口中输入以下

命令：

step 4



查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

4.2 线性方程组

线性方程组是线性代数中的主要内容之一，也是理论发展最为完

整的部分，在MATLAB中也包含了多种处理线性方程组的命令，限于
篇幅，在本节中就不详细展开各种理论和对应的命令，主要处理三种

方程：恰定方程组、超定方程组和欠定方程组，下面详细介绍。

4.2.1 非奇异线性方程组

在线性代数中，恰定方程组是指方程组的个数和未知量个数相等

的方程组，在恰定方程组中矩阵A是方阵，矩阵B可能是向量也可能是
方阵。对于恰定方程组，MATLAB提供了一个十分方便的命令，左
除“\”。根据系数矩阵A的奇异属性，该命令可以得到不同的结果：

 
◆ 如果恰定方程是非奇异的，则左除命令给出了恰定方程组的

精确解。

◆ 如果恰定方程组是奇异的，MATLAB会显示提示警告信息，
同时给出解NaN。



 
下面分别使用例子来详细说明如何使用该命令求解方程组。

例4.8 求解非奇异矩阵的线性方程的解。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

从以上结果可以看出，方程组的系数矩阵A的行列式为1，则系数
矩阵A是非奇异的，因此MATLAB可以给出准确的数值解。同时，该
数值解和系数矩阵相乘，得到的结果和原来的数值完全相同。

说明



在上面的代码中，首先使用pascal命令创建了数值矩阵，该命令是MATLAB的内置函数，

该命令将产生一个对称的正定矩阵，矩阵的数值取自Pascal三角形。

4.2.2 奇异线性方程组

例4.9 求解奇异矩阵的线性方程的解。

step 1
在MATLAB的命令窗口中输入以下命令：

说明

从以上结果可以看出，MATLAB会显示提示信息，表示该矩阵是奇异矩阵，因此无法得

到精确的数值解。

step 2
查看矩阵信息。用户可以使用多种命令来查看矩阵A是否是奇异

的，如下：

说明



从上面的结果可以看出，矩阵A的行列式为0，同时矩阵的秩为2，表示该矩阵A是严格奇

异的，MATLAB将无法给出精确的数值解。

 
对于恰定方程组，如果数值解有解，则可以使用矩阵A的伪逆矩

阵pinv(A)来得到方程的一个解，其对应的数值解为pinv(A)*B，下面举
例来说明。

例4.10 使用伪逆矩阵的方法求解奇异矩阵的线性方程的解。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

说明

从以上结果可以看出，通过使用伪逆矩阵的方法，可以求解得到数值解，同时该数值解

可以精确地满足结果。

step 3



修改需要求解的数值。在MATLAB的命令窗口中输入以下命令：

step 4
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

说明

从以上结果可以看出，通过该方法求解得到的结果并不完全满足原来的数值条件，并不

具有上面步骤中的精度。

4.2.3 欠定线性方程组

在线性代数的理论中，欠定线性方程组是指方程组的未知量个数

多于方程个数的问题，这类问题的解不是唯一解，MATLAB 7.0将首
先寻求一个基本解，然后再寻求非零解。从解法的角度来看，

MATLAB 7.0采用的是QR分解的方法来求解欠定线性方程组。下面举
例来详细说明。

例4.11 求解欠定线性方程组。

step 1



在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

说明

从以上结果可以看出，直接通过左除求解得到的数值解和使用QR分析得到的数值解是完

全相同的，因此读者可以了解到MATLAB求解欠定方程组的原理。

4.2.4 超定线性方程组



超定线性方程组是指方程组的个数比未知数个数多的情况，对于

这种情况，MATLAB提供了伪逆矩阵的方法来求解，关于该方法在前
面已经介绍过，本节将利用一个具体的实例来说明如何求解超定线性

方程组。

例4.12 求解超定线性方程组。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



说明



从以上结果可以看出，尽管左除和伪逆矩阵的方法求解得到的数值解都具有足够的精

度，但是使用伪逆矩阵得到的数值解的范数要小。

4.3 矩阵分解

矩阵分解主要是指将一个矩阵分解为几个比较简单的矩阵连乘的

形式，无论是在理论上还是在工程应用上，矩阵分解都是十分重要

的。在MATLAB中，线性方程组的求解主要基于三种基本的矩阵分
解，Cholesky分解、LU分解和QR分解，对于这些分解MATLAB都提
供了对应的函数。除了上面介绍的几种分解之外，在本节中还将介绍

奇异值分解和舒尔求解两种比较常见的分解。

4.3.1 Cholesky分解

Cholesky分解是把一个对称正定矩阵A分解为一个上三角矩阵R和
其转置矩阵的乘积，其对应的表达式为：A＝R′R。从理论的角度来
看，并不是所有的对称矩阵都可以进行Cholesky分解，需要进行
Cholesky分解的矩阵必须是正定的。
在MATLAB中，进行Cholesky分解的是chol命令：
 
◆ R = chol(X) 其中X是对称的正定矩阵，R是上三角矩阵，使

得X=R′R。如果矩阵X是非正定矩阵，该命令会返回错误信息。
◆ [R,p]=chol(X) 该命令返回两个参数，并不返回错误信息。

当X是正定矩阵时，返回的矩阵R是上三角矩阵，而且满足等式X＝
R′R，同时返回参数p＝0；当X不是正定矩阵时，返回的参数p是正整
数，R是三角矩阵，且矩阵阶数是p－1，并且满足等式X（1∶p－1，1∶p
－1）＝R′R。



提示

对对称正定矩阵进行分解在矩阵理论中是十分重要的，用户可以首先对该对称正定矩阵

进行Cholesky分解，然后经过处理得到线性方程的解，这些内容将在后面的步骤中通过实例

来介绍。

 
例4.13 对对称正定矩阵进行Cholesky分解。
 

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



说明

从以上结果中可以看出，R是上三角矩阵，同时满足等式C＝RTR＝X，表明上面的

Cholesky分解过程成功。

step 3
修改矩阵信息。在MATLAB的命令窗口中输入以下命令：

step 4
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

提示



从以上结果中可以看出，当将原来正定矩阵的最后一个元素减1后，矩阵将不是正定矩

阵，并且满足条件X（1∶p－1，1∶p－1）＝RTR。

4.3.2 使用Cholesky分解求解方程组

例4.14 使用Cholesky分解来求解线性方程组。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

从以上结果可以看出，使用Cholesky分解求解得到的线性方程组
的数值解和使用左除得到的结果完全相同。其对应的数学原理如下：

对于线性方程组Ax＝b，其中A是对称的正定矩阵，其A＝RTR，
则根据上面的定义，线性方程组可以转换为RTRx＝b，该方程组的数
值为x＝R\（RT\b）。



提示

尽管两个方法得到的结果相同，但是其复杂度却不相同。假设A是n×n的方阵，则命令

chol的计算复杂度是o（n3），而左除命令“\”的计算复杂度为o（n2）。

4.3.3 不完全Cholesky分解

对于稀疏矩阵，MATLAB提供了 cholinc命令来做不完全的
Cholesky分解，该命令的另外一个重要功能是求解实数半正定矩阵的
Cholesky分解，其具体的调用格式如下：

 
◆ R = cholinc(X,droptol) 其中参数X和R的含义和chol命令中的

含义相同，其中droptol表示的是不完全Cholesky分解的丢失容限，当
该参数为0时，则属于完全Cholesky分解。

◆ R = cholinc(X,options) 其中参数options用来设置该命令的相
关参数；具体来讲，options是一个结构体，包含了droptol、michol和
rdiag三个参数。

◆ R = cholinc(X,'0') 完全Cholesky分解。
◆ [R,p] = cholinc(X,'0') 和命令chol(X)相同。
◆ R = cholinc(X,'inf')  采用Cholesky-Infinity方法进行分解，

Cholesky-Infinity方法是基于Cholesky分解的，但是可以用来处理实半
正定分解。

 
例4.15 使用cholinc命令对矩阵进行Cholesky分解。

step 1
在MATLAB的命令窗口中输入以下命令：



step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

step 3
检验是否满足分解条件。在MATLAB的命令窗口中输入以下命

令：

step 4
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



提示

从以上结果可以看出，尽管cholinc命令可以求解得到分解结果，但是该分解结果并不能

保证开始的等式关系。

4.3.4 LU分解

LU分解又被称为是高斯消去法，它可以将任意一个方阵A分解为
一个“心理”下三角矩阵L和一个上三角矩阵U的乘积，也就是A＝LU。
其中，“心理”下三角矩阵的定义为下三角矩阵和置换矩阵的乘积。
在MATLAB中，求解LU分解的命令为lu，其主要调用格式如下：
 
◆ [L,U] = lu(X) 其中X是任意方阵，L是“心理”下三角矩阵，U

是上三角矩阵，这三个变量满足的条件式为X＝LU。
◆ [L,U,P] = lu(X) 其中X是任意方阵，L是“心理”下三角矩阵，

U是上三角矩阵，P是置换矩阵，满足的条件式为PX＝LU。
◆ Y = lu(X) 其中X是任意方阵，把上三角矩阵和下三角矩阵合

并在矩阵Y中给出，满足等式为Y＝L＋U－I，该命令将损失置换矩阵



P的信息。
 
例4.16 使用lu命令对矩阵进行LU分解。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



从以上结果可以看出，方阵的LU分解满足以下等式条件：

A＝LU、U-1L-1＝A-1和det（A）＝det（L）det（U）

step 3
使用三个输出变量的命令形式。在MATLAB的命令窗口中输入以

下命令：

step 4
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



从以上结果可以看出，使用三个输出变量的命令满足以下等式关

系：

PA＝LU和PL＝L′

在上面的等式中，L′表示的是使用两个输出变量求解的LU分解矩
阵结果。

step 5
使用LU分解来求解线性方程组。在MATLAB的命令窗口中输入以

下命令：



step 6
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

说明

从以上结果可以看出，无论是两个输出变量还是三个输出变量的命令得到的结果，都和

使用左除命令得到的结果相同。

4.3.5 不完全LU分解

对于稀疏矩阵，MATLAB提供了函数luinc进行不完全的LU分解，
其调用格式如下：

 
◆ [L,U] = luinc(X,droptol) 命令中各参数X和R的含义和lu命令

中的含义相同，其中droptol表示的是不完全LU分解的丢失容限，当该
参数为0时，则属于完全LU分解。

◆ [L,U] = luinc(X,options) 参数options设置了关于LU分解的各
种参数。

◆ [L,U] = luinc(X,'0') 0级不完全LU分解。
◆ [L,U,P] = luinc(X,'0') 0级不完全LU分解。



 
例4.17 使用luinc命令对稀疏矩阵进行LU分解。

step 1
加载稀疏矩阵，并绘制稀疏矩阵图形。在MATLAB的命令窗口中

输入以下命令：

step 2
查看求解的结果。在输入上面的程序代码后，按“Enter”键，得到

的图形如图4.1所示。

图4.1 系数矩阵和LU分解结果图形

提示



由于加载的系数矩阵维度比较大，因此如果直接使用数据查看很难看出或者分辨出矩阵

的性质。在上面的实例中，使用了Spy命令来查看矩阵的属性。

step 3
使用luinc命令对稀疏矩阵进行LU分解。在命令窗口中输入以下命

令：

step 4
查看求解的结果。在输入上面的程序代码后，按“Enter”键，得到

的图形如图4.2所示。



图4.2 使用luinc命令得到的结果

step 5
使用不同的误差容忍度对稀疏矩阵进行LU分解。在命令窗口中输

入以下命令：



step 6
查看求解的结果。在输入上面的程序代码后，按“Enter”键，得到

的图形如图4.3所示。



图4.3 使用不同的误差容忍度

step 7
绘制“droptol-nnz”图形。在本命令中，droptol表示的是LU分解的

丢失容限，nnz则表示系数矩阵中非零元素的个数，用户可以绘制两个
变量之间的关系。在MATLAB的命令窗口中输入以下代码：

step 8
查看求解的结果。在输入上面的程序代码之后，按“Enter”键，得

到的结果如图4.4所示。



图4.4 丢失容限和nnz的关系

step 9
绘制“droptol-norm”图形。在本命令中，droptol表示的是LU分解的

丢失容限，norm则表示LU分解的相对误差，用户可以绘制两个变量之
间的关系。在MATLAB的命令窗口中输入以下代码：

step 10
查看求解的结果。在输入上面的代码后，按“Enter”键，得到的图

形如图4.5所示。



图4.5 丢失容限和相对误差的图形

4.3.6 QR分解

矩阵的正交分解又被称为QR分解，也就是将一个m×n的矩阵A分
解为一个正交矩阵Q和一个上三角矩阵R的乘积，也就是说A＝QR。
在MATLAB中，进行QR分解的命令为qr，其调用格式如下：
 
◆ [Q,R] = qr(A) 矩阵R和矩阵A的大小相同，Q是正交矩阵，

满足等式= AQR，该调用方式适用于满矩阵和稀疏矩阵。
◆ [Q,R] = qr(A,0) 比较经济类型的QR分解。假设矩阵A是一个

m×n的矩阵，其中m>n，则命令将只计算前n列的元素，返回的矩阵R
是n×n矩阵；如果mn≤，该命令和上面的命令[Q,R] = qr(A)相等。该调
用方式适用于满矩阵和稀疏矩阵。

◆ [Q,R,E] = qr(A) 该命令中，Q是正交矩阵，R是上三角矩
阵，E是置换矩阵，满足条件关系式A·E＝Q·R，该调用方式适用于满
矩阵。

 



例4.18 使用qr命令对矩阵进行QR分解。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

从以上结果可以看出，矩阵R是上三角矩阵，同时满足等式A＝
QR，在以下步骤中，将需要证明Q矩阵是正交矩阵。

step 1



证明矩阵Q的正交性。在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

从以上结果可以看出，矩阵Q的行列式是1，同时，矩阵中每列数
据之间的点乘结果都近似为0，因此Q是正交矩阵。

提示

由于Q是正交矩阵，因此经过QR分解得到的矩阵R和原来的矩阵A是等秩的，可以通过分

析R的秩来计算矩阵A的秩。

4.3.7 操作QR分解结果



在MATLAB中，除了提供qr命令之外，还提供了qrdelete和qrinsert
命令来处理矩阵运算的QR分解。其中，qrdelete的功能是删除QR分解
得到矩阵的行或者列；qrinsert的功能则是插入QR分解得到矩阵的行或
者列。下面以qrdelete命令为例，说明如何调用该命令。

 
◆ [Q1,R1] = qrdelete(Q,R,j) 返回矩阵A1的QR分解结果，其中

A1是矩阵A删除第j列得到的结果，而矩阵A＝QR。
◆  [Q1,R1] = qrdelete(Q,R,j,'col')  计算结果和 [Q1,R1] =

qrdelete(Q,R,j)相同。
◆  [Q1,R1] = qrdelete(Q,R,j,'row')  返回矩阵A1的QR分解结

果，其中A1是矩阵A删除第j行的数据得到的结果，而矩阵A＝QR。
 
例4.19 对矩阵QR分解得到的矩阵进行删除运算。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



在上面的结果中，满足等式C＝Q1·R1，其中C就是矩阵A删除对应
数据行的结果，也就是上面结果中的A2矩阵。

step 3
证明Q1矩阵的正交性。在MATLAB的命令窗口中输入以下命令：

step 4
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



从以上结果可以看出，矩阵Q1的行列式是1，同时，矩阵中每列
数据之间的点乘结果都近似为0，因此Q1是正交矩阵。

说明

在MATLAB中，qrinsert命令和qrdelete命令的调用方法几乎相同，在这里就不详细介绍该

命令的用法了，下面将用一个简单的例子说明如何使用qrinsert命令。

 
例4.20 对矩阵QR分解得到的矩阵进行插入运算。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



从以上结果中可以看出，满足等式Aqr＝Q1·R1，其中Aqr就是矩阵
A删除对应数据行的结果，也就是上面结果中的A2矩阵。

step 3
证明Q1矩阵的正交性。在MATLAB的命令窗口中输入以下命令：



step 4
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

4.3.8 奇异值分解

奇异值分解在矩阵分析中有着重要的地位，对于任意矩阵

A∈Cm×n，存在酉矩阵（Unitray matrix），U＝[u1，u2，…，un]，V＝
[v1，v2，…，vn]，使得：

UTAV＝diag（σ1，σ2，…，σp）

其中参数σ1≥σ2≥…≥σp，p＝min{m，n}。在上面的式子中，{σi，

ui，vi}分别是矩阵A的第i个奇异值、左奇异值和右奇异值，它们的组
合就称为奇异值分解三对组。

在MATLAB中，计算奇异值分解的命令如下：
 



◆ [U,S,V] = svd(X) 奇异值分解。
◆ [U,S,V] = svd(X,0) 比较经济的奇异值分解。
◆ s = svds(A,k,0) 向量s中包含矩阵A分解得到的k个最小奇异

值。

◆ [U,S,V] = svds(A,k,0) 给出矩阵A的k个最大奇异值分解对应
的矩阵。

 
例4.21 对矩阵进行奇异值分解。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

step 3



使用最经济的方法进行分解。在MATLAB的命令窗口中输入以下
命令：

step 4
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

 
例4.22 使用svd和svds命令对稀疏矩阵进行奇异值分解。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



说明

在上面的程序结果中，sl表示的是该稀疏矩阵的4个最大奇异值，ss则是表示该稀疏矩阵

的6个最小奇异值。

step 3
绘制数据结果图形。在MATLAB的命令窗口中输入以下命令：

step 4
查看求解的结果。输入上面的程序代码后，按“Enter”键，得到的

结果如图4.6所示。



图4.6 最大4个奇异值

说明

从图4.6中可以看出，使用svd和svds命令求解的结果在某个误差容限之内，结果十分相

近。

4.4 特征值分析

在线性代数的理论中，对于n×n方阵A，其特征值λ和特征向量x满
足以下等式：

Ax＝λx

其中，λ是一个标量，x是一个向量。把矩阵A的n个特征值放置在
矩阵的对角线上就可以组成一个矩阵D，也就是D＝diag（λ1，λ2，

…，λn），然后将各特征值对应的特征向量按照对应次序排列，作为



矩阵V的数据列。如果该矩阵V是可逆的，则关于特征值的问题可以描
述为：

A·V＝V·D A＝V·D·V-1

在MATLAB中，提供了多种关于矩阵特征值处理的函数，可以使
用这些函数来分析矩阵的特征值的多种内容，下面分别详细介绍。

4.4.1 特征值和特征向量

在MATLAB中，求解矩阵特征值和特征向量的数值运算方法简单
描述为：对矩阵进行一系列的House-holder变换，产生一个准上三角矩
阵，然后使用QR法迭代进行对角化。对于一般读者来讲，可以不用了
解这些计算原理。关于矩阵的特征值和特征向量的命令比较简单，具

体的调用格式如下：

 
◆ d= eig(A) 仅计算矩阵A的特征值，并且以向量的形式输出。
◆ [V,D] = eig(A) 计算矩阵A的特征向量矩阵V和特征值对角阵

D，满足等式AV =VD。
◆ [V,D] = eig(A,'nobalance') 当矩阵A中有截断误差数量级相

差不大时，该指令更加精确。

◆ [V,D] = eig(A,B) 计算矩阵A的广义特征向量矩阵V和广义特
征值对角阵D，满足等式AV =BVD。

◆ d = eigs(A,k,sigma) 计算稀疏矩阵A的k个由sigma指定的特
征向量和特征值，关于参数sigma的取值，请读者查看相应的帮助文
件。

提示



当只需了解矩阵的特征值的时候，推荐使用第一条命令，这样可以节约系统的资源，同

时可以有效地得出结果。

 
例4.23 对基础矩阵求解矩阵的特征值和特征向量。

step 1
对矩阵进行特征值分析。在MATLAB的命令窗口中输入以下命

令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

step 3
检验分析得到的结果。在MATLAB的命令窗口中输入以下命令：

step 4



查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

提示

从以上结果中可以看出，V矩阵的行列式为1，是可逆矩阵，同时求解得到的矩阵结果满

足等式AV＝VD。

 
例4.24 计算当矩阵的元素和截断误差相当的时候，矩阵的特征

值和特征向量。

step 1
对矩阵进行特征值分析。在MATLAB的命令窗口中输入以下命

令：

说明

在上面的程序代码中，ER1表示的是默认的误差，ER2则表示的是经过“nobalance”参数处

理后的误差。



step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

说明

从以上结果可以看出，如果矩阵中的元素和截断误差相当时，如果在命令中不选

用“nobalance”参数，则求取的结果是有严重计算错误的。当矩阵A来自程序中的中间计算结果

而且结果中包含了eps元素时，就会发生上面的情况。



4.4.2 稀疏矩阵的特征值和特征向量

例4.25 使用eigs命令求取稀疏矩阵的特征值和特征向量。

step 1
生成稀疏矩阵，并求取特征值。在MATLAB的命令窗口中输入以

下命令：

step 2
查看求解的结果。在输入了上面的程序代码后，按“Enter”键，得

到的图形如图4.7所示。



图4.7 计算的图形结果

说明

在本例中，矩阵A是一个对称的正定矩阵，维度是632，其对应的特征值均匀分布在（0

8）上，但是特征值4重复出现了18次。

4.4.3 特征值问题的条件数

在前面的章节中，曾经介绍过如果在MATLAB中求解代数方程的
条件数，这个命令不能用来求解矩阵特征值对扰动的灵敏度。矩阵特

征值条件数定义是对矩阵的每个特征值进行的，其具体的定义如下：

在上面的等式中，νli，νri分别是特征值λi所对应的左特征行向量和

右特征列向量。其中，θ（·，·）表示的是两个向量的夹角。
在MATLAB中，计算特征值条件数的命令如下：



 
◆ c = condeig(A) 向量c中包含了矩阵A中关于各特征值的条件

数。

◆  [V,D,s] = condeig(A)  该命令相等于 [V,D] = eig(A)和 c =
condeig(A)的组合。

 
例4.26 使用命令分别求解方程组的条件数和特征值条件数。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

说明

从以上结果来看，方程的条件数很大，但是矩阵特征值的条件数则比较小，这就表明了

方程的条件数和对应矩阵特征值条件数是不等的。



step 3
重新计算新的矩阵，进行分析。在MATLAB的命令窗口中输入以

下命令：

step 4
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

说明

从以上结果中可以看出，在上面的例子中方程组的条件数很小，而对应的特征值条件数

则有两个分量，相当大。

 
例4.27 对亏损矩阵进行条件数分析。

step 1



在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

说明

在上面的步骤中，矩阵A是代数重复度为5、几何重复度为1的亏损矩阵，这是一个十分

特殊的矩阵，其方程组的条件数和特征值的条件数都很大。eig命令是不能适用于这类矩阵

的，所求得的结果是不可信的。

4.4.4 特征值的复数问题

在理论中，即使是实数矩阵，其对应的特征值也有可能是复数，

在实际应用中，经常需要将一对共轭复数特征值转换为一个实数块，



为此MATLAB提供了以下命令：
 
◆ [VR,DR] = cdf2rdf(VC,DC) 将复数对角形转换成实数对角

形。

◆ [VC,DC] = rsf2csf(VR,DR) 将实数对角形转换成复数对角
形。

说明

以上命令的参数中，DC表示的是含有复数的特征值对角阵，VC表示对应的特征向量矩

阵，DR表示的是含有实数的特征值对角阵，VR表示对应的特征向量矩阵。

 
例4.28 对矩阵的复数特征值进行分析。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：



4.5 小结

矩阵是MATLAB最重要的数值对象，几乎所有复杂的MATLAB操
作都是基于矩阵的。因此，熟悉常见的矩阵分析是十分必要的。本章

主要介绍了矩阵的常见运算、方程组的求解、矩阵分解和特征值的分

析等。在讲解这些内容的时候，都分别讲解了这些分析方法的理论背

景以及适用范围，并结合具体的例子进行讲解。

◆   ◆   ◆
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第5章 函数分析和数值运算

本章包括

◆ 函数的零点分析

◆ 一元函数的数值积分

◆ 多重数值积分

◆ 概率分布

◆ 假设检验

 
MATLAB除了可以对矩阵进行分析之外，还可以对函数进行处

理。对于常见的高等数学问题，MATLAB都可以有效地进行分析。因
此，MATLAB被广泛应用于数据实验中。对于微积分、概率论等常见
问题，MATLAB提供了对应的命令。读者可以十分便利地计算和处理
对应的问题。

5.1 函数的零点

对于某任意函数f(x)，在求解范围之内可能有零点，也可能没有零
点，可能只有一个零点也可能有多个甚至是无数个零点。因此，这就

给程序求解函数零点增加了很大的难度，没有可以求解所有函数零点

的通用求解命令。在本节中，将简单讨论一元函数和多元函数的零点

求解问题。

5.1.1 一元函数的零点



在所有函数中，一元函数是最简单的，同时也是可以使用

MATLAB提供的图形绘制命令来实现可视化的。因此，在本节中将首
先讨论一元函数零点的求取方法。在MATLAB中，求解一元函数零点
的命令是fzero，其调用格式如下：

 
◆ x = fzero(fun,x0) 参数fun表示的是一元函数，x0表示求解的

初始数值。

◆ [x,fval,exitflag,output] = fzero(fun,x0,options) 参数options的
含义是指优化迭代所采用的参数选项，该参数和后面章节中讲解到的

fsolve、fminbnd、fminsearch等命令的options都是相同的“模块”；在输
出参数中，fval表示对应的函数值，exitflag表示的是程序退出的类
型，output则是反映优化信息的变量。

 
例5.1  求函数f（x）＝x2sinx－x＋1在数值区间[-3，4]中的零

点。

step 1
绘制函数的图形。在MATLAB的命令窗口中输入以下命令：



step 2
查看图形。输入以上程序代码后，按“Enter”键，得到的图形如图

5.1所示。

图5.1 函数的图形

说明



之所以在求解函数零点之前，需要绘制函数的图形，是为了能够在后面的步骤中使用

fzero命令时，更好地选择初始数值x0。

step 3
求解函数的零点。在MATLAB的命令窗口中输入以下命令：

step 4
查看求解的结果。在命令窗口中输入计算的变量名称，得到的结

果如下：

从以上结果可以看出，函数f（x）＝x2sinx－x＋1在[-3，4]范围内
的三个零点数值解为-2.5708、-1.6194和2.9142。

提示

对于一元多项式函数，MATLAB提供了roots命令来求解多项式函数的所有零点，该命令

的基本原理是求解多项式伴随矩阵的特征值来求解。

5.1.2 多元函数的零点

一般来讲，多元函数的零点问题比一元函数的零点问题更难解

决，但是当零点大致位置和性质比较好预测时，也可以使用数值方法

来搜索到精确的零点。



在MATLAB中，求解多元函数的命令是fsolve，其具体的调用格
式如下：

 
◆ x = fsolve(fun,x0) 解非线性方程组的数值解。
◆ [x,fval,exitflag,output] = fsolve(fun,x0,options) 完整格式。
 

例5.2 求二元方程组 的零点。

step 1
绘制函数的图形。在MATLAB的命令窗口中输入以下命令：

step 2



查看图形。在输入以上代码后，按“Enter”键，得到函数图形如图
5.2所示。

图5.2 函数图形

step 3
编 写 求 解 函 数 的 M 文 件 。 选 择 命 令 窗 口 菜 单 栏 中

的“File”→“New”→“M-File”命令，打开M文件编辑器，在其中输入以
下程序代码：

在输入以上程序代码后，将其保存为“fsolvefun.m”文件。

step 4
求解二元函数的零点。在MATLAB的命令窗口中输入以下代码：

step 5



查看求解结果。在输入以上代码后，按“Enter”键，得到以下结
果：

说明

从以上结果可以看出，由于原来的二元函数是对称的，因此所求解的未知数结果是相等

的，由于在以上实例中设置了显示迭代，因此在以上结果中显示各优化信息。

5.2 数值积分

微积分是高等数学的重要知识，在工程实践中，微积分有着十分

广泛的应用，因此如何通过计算机实现微积分是十分重要的内容。在

MATLAB中，可以使用多种方法来实现微积分的运算：数值积分、符
号积分、样条积分和Simulink模拟积分等。在本章中，主要介绍数值
积分和样条积分，并辅以介绍符号积分和Simulink积分等方法。



5.2.1 一元函数的数值积分

在MATLAB中，对一元函数进行数值积分的命令是quad和quadl。
一般来讲，quadl命令比quad命令更加有效，它们的主要功能在于计算
闭型数值积分，其对应的详细调用格式如下：

 
◆ q = quad(fun,a,b,tol,trace) 采用递推自适应Simpson法计算积

分。

◆ q = quadl(fun,a,b,tol,trace) 采用递推自适应Lobatto法计算积
分。

 
下面详细介绍这两个函数的参数含义：

 
◆ fun：被积函数，可以是字符串、内联函数、M函数文件名称

的函数句柄。被积函数中一般使用x作为自变量。
◆ a、b：被积函数的上限和下限，必须都是确定的数值。
◆ tol：标量，控制绝对误差，默认的数值是精度10-6。

◆ trace：如果该输入变量的数值不是零，则随积分的进程逐点
绘制被积函数。

说明

在更为完整的调用命令q = quadl(fun,a,b,tol,trace,p1,p2…)中，p1和p2表示的是通过程序向

被积函数传递的参数。

 
例5.3 求解积分 的数值。

step 1



分析参数方程。根据微积分的基础知识，该积分的数值实际上是

某曲线的长度，该函数对应的参数方程如下：

step 2
绘制函数图形。因此为了了解该积分的数学含义，可以绘制该函

数的图形。在MATLAB的命令窗口中输入以下程序代码：

step 3
查看函数图形。在输入以上程序代码后，按“Enter”键，得到的函

数图形如图5.3所示。

图5.3 函数图形



step 4
编 写 被 积 函 数 的 M 文 件 。 选 择 命 令 窗 口 菜 单 栏 中

的“File”→“New”→“M-File”命令，打开M文件编辑器，在其中输入以
下程序代码：

在输入以上程序代码后，将代码保存为“hcurve.m”文件。

step 5
使用quad和quadl命令来求解数值积分。在命令窗口中输入以下程

序代码：

step 6
查看求解结果。在命令窗口中输入变量名称，得到求解的结果如

下：

step 7
设置积分的求解属性，重新求解数值积分。在命令窗口中输入以

下程序代码：

step 8
查看求解结果。在输入以上代码后，按“Enter”键，得到以下结

果：



说明

从以上结果可以看出，当设置了比较小的误差后，使用quad和quadl命令求解得到的结果

精度有很大的差别。

5.2.2 使用Simulink求解数值积分

例5.4 使用Simulink求解积分 的数值。

step 1
选择MATLAB菜单栏中的“File”→“New”→“Model”命令，打开模

型编辑器，向其中添加对应的模型块，如图5.4所示。



图5.4 添加系统的模块

step 2
设置系统模块的属性。双击图5.4中的“MATLAB Fcn”模块，打开

对应的模块属性对话框，在其中设置被积函数表达式，如图5.5所示。

图5.5 设置系统模块的属性

step 3



设置系统仿真的时间，运行系统仿真。将系统仿真的时间设置为

3π，然后运行仿真，得到的结果如图5.6所示。

图5.6 查看仿真的结果

step 4
查看被积函数的图形。从图5.6中可以看出，通过Simulink积分得

到的结果是17.22。同时，可以查看被积函数的图形，如图5.7所示。

图5.7 被积函数的图形

5.2.3 求解瑕积分



例5.5 求解积分 的数值。

step 1
分析积分的问题。在以上积分表达式中，由于在x＝0时，被积函

数 的数值趋近于无穷大，也就是 。因此，以上积分属于

瑕积分或者称为开型积分，这和以上有限积分在性质上有比较大的差

异。同时根据基础的高等数学知识，该积分数值为 。

step 2
求解积分数值。在MATLAB的命令窗口中输入以下代码：

step 3
查看求解结果。在命令窗口中输入变量名称，得到求解的结果如

下：

step 4
使用符号方法来求解。在MATLAB的命令窗口中输入以下代码：



step 5
查看求解结果。在命令窗口中输入变量名称，得到求解的结果如

下：

提示

从以上结果可以看出，使用符号方法求解得到的结果和数值积分得到的结果相同，精度

都是可以接受的，但是，符号运算比数值运算更加占用系统资源。

5.2.4 矩形区域的多重数值积分

多重数值积分可以认为是一元函数积分的推广和延伸，但是情况

比一元函数要复杂，在本节中，将主要介绍如何在MATLAB中计算二
重数值积分。

在MATLAB中，计算二重数值积分的命令为dblquad，其具体的调
用格式如下：

这些参数中，fun表示的是积分函数，xmin,xmax表示的是变量x的
上下限，ymin，ymax表示的是变量y的上下限；tol表示的是积分绝对
误差，默认数值为10-8；method表示的是积分方法的选项，默认选项
为@quad，可以选择@quadl或者自己定义的积分函数句柄。
例5.6 求解积分 的数值。

step 1



求解积分数值。在MATLAB的命令窗口中输入以下代码：

step 2
查看求解结果。输入以上代码后，按“Enter”键，得到求解的结果

如下：

step 3
使用符号运算求解积分数值。

step 4
查看求解结果。输入以上代码后，按“Enter”键，得到求解的结果

如下：

5.2.5 变量区域的多重数值积分

前面所介绍的都是固定数值的二重积分运算方法，但是在实际应

用中，二重积分并不都是矩形计算区域，在计算区域中会包含变量表

达式，也就是说，积分区域可以表示成为以下形式：

R＝{（x，y）|a≤x≤b，c（x）≤y≤d（x）}

需要求解的积分表达式为：



对于以上积分表达式，进行数值计算的表达式为：

在以上表达式中wm和vn表示的是权重，取决于一维积分方法。关

于二重积分的数值分析的表达式如图5.8所示。

图5.8 二重积分数据点

根据图5.8中数据点区域，需要自行编写M文件，来计算以上数值
积分，在本节中，将使用一个简单的例子说明如何计算二重数值积

分。

例5.7 求解积分 的数值。

step 1



编写一维数值积分的M文件。选择命令窗口菜单栏中
的“File”→“New”→“M-File”命令，打开M文件编辑器，输入以下程序
代码：

在输入以上程序代码后，将代码保存为“smpsns_fxy.m”文件。

step 2
编写二重数值积分的M文件。选择命令窗口菜单栏中

的“File”→“New”→“M-File”命令，打开M文件编辑器，输入以下程序
代码：





在输入以上程序代码后，将代码保存为“int2s.m”文件。

step 3
进行二重积分计算。在MATLAB的命令窗口中输入以下代码：

step 4
查看求解结果。在命令窗口中输入变量名称，然后按“Enter”键，

得到求解的结果如下：



说明

在以上程序结果中，Vs1和Vs2是分别通过不同的计算方法得到的结果，error1和error2是

计算结果和真实结果之间的误差。

 

step 5
绘制函数图形。在MATLAB的命令窗口中输入以下代码：

step 6
查看图形。输入以上程序代码后，按“Enter”键，得到的结果如图

5.9所示。



图5.9 函数图形

5.3 概率论和数理统计

在本节中，将主要介绍在MATLAB中运用概率论和数理统计的方
法，主要的内容包括概率分布、数理统计和假设检验等。在每个具体

的小节中，分别介绍如何在MATLAB中运用相关知识，对于具体的背
景知识，请读者查看对应的书籍。

5.3.1 双变量的概率分布

概率分布是概率论和数理统计的基础知识，在MATLAB中，提供
了处理常见概率分布的各种命令，包括二项分布、泊松分布、χ2分

布、t分布等概率分布。这些内容比较简单，这里就不详细展开介绍
了，感兴趣的读者可以查阅相应的帮助文件。

在本节中将主要介绍如何在MATLAB中处理双变量或者多变量的
概率分布的情况。首先介绍如何处理双变量 t分布（ bivariate t
distribution）。根据基础的概率知识，描述双变量t分布的重要参数是



线性相关矩阵κ和自由度η。下面举例说明如何在MATLAB中显示多元t
分布的图形。

例5.8  在MATLAB中使用图形来显示双变量 t分布（bivariate t
distribution），其中两个变量服从的分布分别为：t(1)和t(5)，也就是
说，两个变量的自由度分别为1和5。下面使用图形显示在两个变量线
性相关矩阵κ的不同取值下的分布情况。

step 1
绘制二元概率分布的图形。在MATLAB的命令窗口中输入以下代

码：



step 2



查看图形。在输入程序代码后，按“Enter”键，得到的图形如图
5.10所示。

图5.10 双变量t分布的图形

对于以上程序代码做如下说明：

 
◆ 在以上程序代码中，mvtrnd命令的功能是从多元t分布中产生

随机数据矩阵，关于其具体的用法，可以查看对应的帮助文件。

◆ tcdf命令的功能是产生t分布的累积概率数值，具体的用法请
查阅相应的帮助文件。

提示

从图5.10中可以看出，两个变量之间的线性相关矩阵系数值的绝对值越接近1，两个变量

的分布越为紧密；而两个变量之间的线性相关矩阵系数值的绝对值越接近0，两个变量的分布

越为稀疏。

5.3.2 不同概率分布



在MATLAB中，除了绘制两个相同分布变量之外，还可以绘制两
个不同随机分布的变量的数据分布图，下面举例详细说明。

例5.9 两个相关随机变量，分别服从Gamma分布和t分布，两个
变量相互独立，且具体的随机变量参数为Gamma（2，1）和t（5），
在MATLAB中绘制两个变量的数据分布图形。

step 1
绘制二元概率分布的图形。在MATLAB的命令窗口中输入以下代

码：



step 2
查看图形。在输入程序代码后，按“Enter”键，得到的图形如图

5.11所示。



图5.11 两个独立随机变量的图形

5.3.3 数据分布分析

在实际应用中，用户经常需要根据有限的试验数据，推测该样本

数据所满足的数据分布情况，在本节中，将使用一个简单的实例来演

示如何在MATLAB中推测数据分布情况。
例5.10 通过命令产生满足t分布的多元变量，然后使用自定义的

概率密度函数来推测两个变量满足的多元正态分布N（μ1，μ2，σ1，

σ2），其中参数分别表示均值和标准方差；然后绘制图形来验证这种

推测是否正确。

step 1
绘制二元概率分布的图形。在MATLAB的命令窗口中输入以下代

码：



step 2
查看图形。在输入程序代码后，按“Enter”键，得到的图形如图

5.12所示。



图5.12 数据分布图形

5.3.4 假设检验

假设检验是数理统计中的一个重要内容，在MATLAB中可以实现
多种常见概率分布的假设检验，例如单侧检验、双侧检验、均值检

验、方差检验等多种。在本节中，将以几个简单的例子来说明如何在

MATLAB中进行假设检验。
例5.11 对某试验数据进行平均值的正态分布单侧检验，总体的

标准差已知，并且假设检验的置信水平为5%，假设检验的平均值为
100。

step 1
进行假设检验。在MATLAB的命令窗口中输入以下代码：



step 2
查看图形。在输入程序代码后，按“Enter”键，得到的图形如图

5.13所示。



图5.13 单侧假设检验图形

提示

在以上程序代码中，首先输入了关于该假设检验的参数，然后根据正态分布反函数来求

取满足假设检验条件的均值数值，最后在正态分布曲线中绘制出假设检验的图形。

step 3
修改假设检验的条件，进行假设检验。修改假设检验条件为均值

110，重新进行假设检验。在MATLAB的命令窗口中输入以下代码：

step 4
查看图形。在输入程序代码后，按“Enter”键，得到的图形如图

5.14所示。



图5.14 修改条件后的假设检验

step 5
绘制累积概率密度函数的图形。为了对比上面两种不同的假设检

验条件，可以绘制概率密度函数的图形。在MATLAB的命令窗口中输
入以下程序代码：



step 6
查看图形。在输入程序代码后，按“Enter”键，得到的图形如图

5.15所示。

图5.15 累积概率密度图形



说明

图5.15中显示了在两种不同的分布下的假设检验情况，实际上，可以在同一个图形中显

示多个不同分布的假设检验情况。

step 7
绘制power函数。power函数的定义是假设检验中拒绝检验的概

率，绘制该函数的图形也可以查看不同的假设检验的情况。在

MATLAB的命令窗口中输入以下程序代码：

step 8
查看图形。在输入程序代码后，按“Enter”键，得到的图形如图

5.16所示。



图5.16 power函数的图形

step 9
使用Monte Carlo模拟检验power函数的检验结果。在MATLAB的

命令窗口中输入以下程序代码：



step 10
查看图形。在输入程序代码后，按“Enter”键，得到的图形如图

5.17所示。



图5.17 Monte Carlo检验图形

5.4 小结

在本章中，依次向读者介绍了函数零点、数值积分和概率论等内

容，这些内容是MATLAB进行数值运算的重要部分。在后面的章节
中，将向读者介绍如何使用MATLAB进行数据分析。

◆   ◆   ◆



第6章 高级数值运算

本章包括

◆数据插值

◆曲线拟合

◆傅里叶（Fourier）分析

 
数据分析在各个领域有着广泛的应用，尤其是在数学、物理等科

学领域和工程领域的实际应用中，会经常遇到进行数据分析的情况。

例如，在工程领域根据有限的已知数据对未知数据进行推测时经常需

要用到数据插值和拟合的方法，在信号工程领域则经常需要用到傅里

叶变换的工具，在物理或工程领域中则经常需要根据现实情况抽象出

微分方程，进行数值求解，等等。这些常见的数据分析方法在

MATLAB中都可以实现。
对于熟悉MATLAB基本命令的读者而言，通过本章的内容读者可

以了解到各命令的使用场合以及内在关系，同时获得综合运用命令解

决实际问题的思路和借鉴的经验。在本章中，将分别介绍插值、拟

合、傅里叶变换等各种内容。

6.1 插值

插值（Interpolation）是指在所给定基准数据的情况下，研究如何
平滑地估算出基准数据之间其他点的函数数值。每当其他点上函数数

值获取的代价比较高时，插值就会发挥作用。



在MATLAB中提供了多种插值函数，这些插值函数在获得数据的
平滑度、时间复杂度和空间复杂度方面有着完全不同的性能。在本章

中，将主要介绍一维插值命令 interp1，二维插值命令 interp2等
MATLAB内置函数。同时，还将根据不同的插值方法自行编写M文
件，完成不同的插值运算，例如Lagrange插值、Newton插值等，下面
分别介绍。

6.1.1 一维插值

在MATLAB中，一维插值表示的是对一维函数y＝f（x）进行插
值，为了让读者更加形象地了解一维插值的含义，图6.1列出了一维插
值的图形。

图6.1 一维插值的含义

在图6.1中，实心点（x，y）表示的是已知数据点，空心点（xi，

yi）中的横坐标xi代表的是需要估计数值的位置，纵坐标yi表示插值后

运算的数值。

在MATLAB中，一维多项式插值的方法通过命令interp1实现，其
具体的调用格式如下：

 



◆ yi = interp1(x,Y,xi) 在该命令中，x必须是向量，Y可以是向
量也可以是矩阵。如果Y是向量，则必须与变量x具有相同的长度，这
时xi可以是标量，也可以是向量或者矩阵。

◆ yi = interp1(Y,xi) 在默认情况下，x变量选择为1:n，其中n是
向量Y的长度。

◆ yi = interp1(x,Y,xi,method) 输入变量method用于指定插值的
方法，具体的插值方法将在本章后面的内容中详细介绍。

◆ yi = interp1(x,Y,xi,method,'extrap') 对超出数据范围的插值
运算使用外推方法。

◆ yi = interp1(x,Y,xi,method,extrapval) 对超出数据范围的插
值数据返回extrapval数值，一般为NaN或者0。

◆ pp = interp1(x,Y,method,'pp') 返回数值pp为数据Y的分段多
项式形式，method指定产生分段多项式pp的方法。

提示

在MATLAB中，还提供了interp1q命令作为interp1的快速命令，对于数据间隔不均的数

据，interp1q命令运行的速度比interp1命令要快，主要原因在于interp1q命令没有对输入数据进

行检测，关于该命令的详细使用方法请读者查看相应的帮助文件。

 
在上面的命令中，method参数的取值和对应的含义如下：
 
◆ nearest：最邻近插值方法（nearest neighbor interpolation）。

这种插值方法在已知数据的最邻近点设置插值点，对插值点的数值进

行四舍五入，对超出范围的数据点返回NaN。
◆ linear：线性插值（linear interpolation），这是interp1命令中

method的默认数值。该方法采用直线将相邻的数据点相连，对超出数
据范围的数据点返回NaN。



◆ spline：三次样条插值（cubic spline interpolation），该方法采
用三次样条函数获取插值数据点，在已知点为端点的情况下，插值函

数至少具有相同的一阶和二阶导数。

◆ pchip：分段三次厄米特多项式插值（piecewise cubic Hermite
interpolation）。

◆ cubic：三次多项式插值，与分段三次厄米特多项式插值方法
相同。

◆ v5cubic：MATLAB 5中使用的三次多项式插值。

6.1.2 人口数量预测——一维插值实例

为了让读者直观地看到上面各个不同插值方法的差别，下面举例

演示不同方法的插值。

例6.1 使用不同的方法来对基础数据进行插值运算，并比较各种
方法的不同。

step 1
某城市在1900至1990年中，每隔十年统计该城市的人口数量，得

到的结果如下：

上面数据的单位是百万，以上面的数据为基础，对没有进行人口

统计的年限的人口数量进行推测，分别使用不同的插值方法。

step 2
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入下面的程序代码：



当输入以上代码后，将上面的代码保存为“intexa.m”文件。

step 3
查看计算结果。在命令窗口中输入“intexa”，然后按“Enter”键，得

到的对比结果如图6.2所示。



图6.2 不同插值方法得到的结果

同时，使用“Nearest”插值方法得到的结果如图6.3所示。



图6.3 使用“Nearest”方法得到的结果

step 4
根据不同的插值方法，估计中间年限的人口数目。选择命令窗口

菜单栏中的“File”→“New”→“M-File”命令，打开M文件编辑器，在其
中输入下面的程序代码：



在输入以上程序代码后，将其保存为“runexa.m”文件。

step 5
查看计算结果。在命令窗口中输入“runexa”，然后按“Enter”键，

得到的结果如下：

说明

从上面的结果可以看出，使用不同的插值方法得到的预测数据会略有差别，上面的结果

中“Nearest”方法得到的结果是偏差最大的一种，其他方法则差别不大。

 
根据上面的实例，下面简要比较各种插值在执行速度、占用内存

大小以及获得数据的平滑度方面的性能，如表6.1所示。

表6.1 各种插值方法的比较

说明



前面多次使用到了MATLAB中关于M文件的基础知识，来实现各种插值方法的功能，关

于M文件的使用方法请读者查看相应的章节。

6.1.3 二维插值

二维插值是高维插值的一种，主要应用于图像处理和数据的可视

化，其基本思想与一维插值大致相同，它是对两个变量的函数z＝
f（x，y）进行插值。
其对应的插值原理示意如图6.4所示。

图6.4 二维插值示意图

在MATLAB中，二维插值的常用函数是interp2，其调用格式如
下：

 
◆ ZI = interp2(X,Y,Z,XI,YI) 原始数据x、y和z决定插值函数z

＝f（x，y），返回的数值Z1是（X1，Y1）在函数z＝f（x，y）上的
数值。

◆ ZI = interp2(Z,XI,YI) 其中如果Z的维度是n×m，则有x＝
1∶n，y＝1∶m。

◆ ZI = interp2(Z,ntimes)  在两点之间递归地进行插值ntimes
次。



◆ ZI = interp2(X,Y,Z,XI,YI,method) 使用选定的插值方法进行
二维插值。

 
关于上面命令中的参数，应注意下面的内容：

 
◆ 对于其他高维插值的命令，使用格式与此大致相同。
◆ 在上面的命令中，X、Y和Z是进行插值的基准数据。XI、YI

是待求插补函数值ZI的自变量对组，虽然随着维度的增加，插值的具
体操作变得越来越复杂，但是基本原理和一维插值的情况相同，调用

名称也很类似。

◆ 参数X和Y必须满足一定的条件，首先X和Y必须是同维矩
阵，同时矩阵中的元素，无论是行向还是列向，都必须是单调排列。

最后，X和Y必须是Plaid格式的矩阵，所谓Plaid格式的矩阵，是指X矩
阵每一行的元素依照单调次序排列，并且任何两行都是相同的；Y矩
阵每一列的元素依照单调次序排列，并且任何两列都是相同的。

◆ 对于XI和YI数据系列，一般需要使用meshgrid命令来创建。
具体的方法为：给定两个变量的分向量，然后通过meshgrid命令产生
对应的数据系列。

说明

关于该命令的method参数，其含义和前面小节中interp1命令的method参数类似，只是参

数数值linear表示的是双线性插值方法。

6.1.4 绘制二元函数图形——二维插值实例

例6.2 以二元函数 为例，首先经过“仿真”获取基础数

据，生成一组基础的稀疏“测量数据”，然后使用二维插值得到更细致



的数据，完成绘图。

step 1
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入下面的程序代码：

完成上面的程序代码后，将其保存为“intexp3.m”文件。

step 2
查看程序结果。在命令窗口中输入“intexp3”后，按“Enter”键，得

到的结果如图6.5所示。



图6.5 根据基础数据绘制的三维图形

step 3
添加二维插值的命令代码。打开上面步骤保存的intexp3文件，然

后在M文件编辑器中添加下面的程序代码：

输入了上面的命令后，保该代码，形成完整的“intexp3.m”文件。

step 4
查看程序代码结果。在命令窗口中输入 “intexp3”后，

按“Enter”键，得到的结果如图6.6所示。

图6.6 完成插值后的图形



例6.3 在三维图形表面上添加等高线，使用二维插值的方法来计
算等高线的数据点坐标，同时使用Streamslice命令绘制三维图形表面
等高线数据点的梯度。

step 1
在MATLAB的命令窗口中输入下面的代码：

step 2
查看程序结果。输入程序代码后，按“Enter”键，得到的结果如图

6.7所示。



图6.7 完成的三维图形

说明

在上面的两个例子中，多次用到了关于MATLAB图形对象操作的命令，主要涉及了图形

颜色、角度等属性，关于这些命令的详细使用方法读者可以查看相关的章节。

6.1.5 样条插值

除了前面章节中提到的一维和二维插值方法之外，MATLAB还提
供了样条插值的方法。样条函数的主要思想是，假设有一组已知的数

据点，目标是找到一组拟合多项式，在多项式拟合的过程中，对于每

组相邻的样本数点，用三次多项式去拟合样本数据点之间的曲线。为

了保证拟合的唯一性，对这个三次多项式在样点处的一阶、二阶导数

加以约束。因此，除了研究区间的端点之外，所有样本点之间的数据

也能保证连续的一阶和二阶导数。

关于样条插值的主要命令如下：



 
◆ yy = spline(x,y,xx)
◆ pp = spline(x,y)
◆ yy＝ppval(pp,xx)
 
在上面的命令中，（x，y）表示的是样点数据，xx则是插值的数

据点系列。下面将利用几个简单的例子来说明spline函数的使用方法。
例6.4 对基础数据进行样条插值运算，分别使用样条函数和一维

插值命令，并对插值结果进行比较。

step 1
在MATLAB的命令窗口中输入下面的代码：

step 2
查看程序代码的结果。当输入以上代码后，按“Enter”键，得到的

结果如图6.8所示。



图6.8 显示插值图形

例6.5 使用样条插值进行圆形数据插值。

step 1
在MATLAB的命令窗口中输入下面的代码：

step 4
查看程序代码的结果。当输入以上代码后，按“Enter”键，得到的

结果如图6.9所示。



图6.9 圆形数据插值

6.1.6 牛顿插值

插值一直是工程和科学中的重要内容，根据工程中不同的实践要

求，已经发展出了多种插值运算方法。因此，除了MATLAB内置的插
值函数之外，还可以根据实践需要编写插值运算的M文件，然后将其
运算在其他合适的领域。在本节中，将详细介绍如何使用牛顿

（Newton）插值方法进行数据插值。
首先，有必要了解牛顿（Newton）插值方法的基本原理。对于N

＋1个已知数据系列{（x0，y0），（x1，y1），…，（xN，yN）}，可
以被下面的N－1阶的多项式循环引用，满足下面的N个数据系列
{（x0，y0），（x1，y1），…，（xN－1，yN－1）}的等式：

同时，需要满足的约束条件为n0（x）＝a0；



根据上面的等式方程组，得到的牛顿插值的数值系数满足下面的

等式：

根据数学归纳法，得到牛顿插值方法的系数通式为：

说明

关于上面系数运算的过程，需要使用到一些基础的数学知识，限于篇幅分析过程就不在

这里详细介绍了。

6.1.7 多项式插值——牛顿插值实例

在本节将使用一个简单的实例，来说明如何使用牛顿插值法进行

数值插值。

例6.6 以函数 为基准函数，分别采用不同阶数的牛顿

插值多项式，然后比较不同阶数的插值误差。

step 1



选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M
文件编辑器，在其中输入下面的程序代码：

将程序代码保存为“newtonp.m”文件，在后面的步骤中需要引用该
程序代码进行牛顿插值运算。

step 2
在MATLAB的命令窗口中输入下面的代码：



step 3
查看程序代码的结果。在输入以上代码后，按“Enter”键，得到牛

顿插值的结果，如图6.10所示。



图6.10 牛顿插值图形

step 4
进行插值误差分析。在MATLAB的命令窗口中输入下面的代码：

step 5
查看程序代码的结果。输入以上代码后，按“Enter”键，得到的结

果如图6.11所示。



图6.11 牛顿插值的误差结果

说明

从上面的结果中可以看出，增加牛顿插值多项式的阶数，并不能显著地减少插值的误

差。同时，在插值数值范围两侧出现了明显的振荡现象，这种现象被称为插值情况的Runge现

象，因此，牛顿插值在5阶以上就很少使用。

6.1.8 Chebyshev多项式插值



在前面所介绍的插值方法中，主要研究的是在已知数据条件下，

如何在各种约束条件下完成不同的插值结果，在插值问题中，还涉及

另外一个层次的问题，也就是如何选择插值所需要的基础数据点。前

面章节的例子中，选择的基础数据点都是等分数据点，但是，这种方

法并不是最佳的。在本节中，还是以上面小节的实例为例子，也就是

以函数 为基准函数，选择不同间距的基准数据，然后使用

基础数据进行整体数据的插值工作。

根据前面的例子可知，由于在数据范围两侧出现了振荡现象，因

此，如果在此例中在两侧选择数据点的密度大于在中间范围选择数据

点，就可以很有效地提高数据插值的精度。Chebyshev多项式提供了下
面的数据选择方法：

在标准化的数据范围[-1，+1]内选择下面的数据点：

  其中，参数k＝0，1，…，N。

在任意一个有限的区间[a，b]内，存在下面的等式关系：

满足这个关系式的基础数据点系列满足如图6.12所示的图形。



图6.12 选择基础数据点

6.1.9 多项式插值——Chebyshev多项式插值实
例

例6.7 以函数 为基准函数，使用上面介绍的选择数据

点的方法选择基础数据点，然后进行牛顿插值，最后比较不同阶数的

插值误差。

step 1
在MATLAB的命令窗口中输入下面的程序代码：



step 2
查看程序代码的结果。当输入以上代码后，按“Enter”键，得到的

结果如图6.13所示。



图6.13 完成的插值结果

step 3
在MATLAB的命令窗口中输入下面的程序代码：

step 4
查看程序代码的结果。当输入以上代码后，按“Enter”键，得到的

结果如图6.14所示。



图6.14 各阶插值误差

提示

根据上面的实例结果可以看出，当用户使用Chebyshev方法来选择基础数据点时，可以十

分有效地清除Runge的现象，提高数值插值的效率。

6.2 曲线拟合

在科学和工程领域，曲线拟合的主要功能是寻求平滑的曲线来最

好地表现带有噪声的测量数据，从这些测量数据中寻求两个函数变量

之间的关系或者变化趋势，最后得到曲线拟合的函数表达式y＝
f（x）。从“插值”一节中可以看出，使用多项式进行数据拟合会出现
数据振荡或者Runge的现象，而Spline插值的方法可以得到很好的平滑
效果，但是关于该插值方法有太多的参数，不适合曲线拟合的方法。



同时，由于在进行曲线拟合的时候，认为所有测量数据中已经包

含了噪声，因此，最后的拟合曲线并不要求通过每一个已知数据点，

衡量拟合数据的标准则是整体数据拟合的误差最小。一般情况下，

MATLAB的曲线拟合方法使用的是“最小方差”函数来进行曲线拟合，
其中方差的数值是拟合曲线和已知数据之间的垂直距离。和插值相

同，对于曲线拟合也存在着各种不同的标准，为了满足不同的拟合要

求，同样需要自行编写对应的M文件。
在本节中，将分别介绍几种比较常见的曲线拟合方法，最后，还

将介绍MATLAB提供的曲线拟合界面操作方法。

6.2.1 多项式拟合

在MATLAB中，提供了polyfit函数来计算多项式拟合系数，其设
定曲线拟合的目标是最小方差（Least Squares）或者被称为最小二乘
法，polyfit函数的调用格式如下：

 
◆ [p,S,mu] = polyfit(x,y,n)
◆ [y,delta] = polyval(p,x,S,mu)
 
其中，x和y表示的是已知测量数据，n是多项式拟合的阶数。同时

参数μ满足下面的等式 ，其中μ1＝mean（x），μ2＝std（x），

而且μ＝[μ1，μ2]
通过上面的命令，最后可以得到的拟合曲线的多项式为：

y＝p1xn＋p2xn-1＋…＋pnx＋pn+1

说明



由于最小方差的标准是比较常见的拟合要求，这里就不详细展开了，感兴趣的读者可以

查看对应的数学书籍，或者查看polyfit的M文件中的程序代码。

 
例6.8 使用polyfit命令进行多项式的数值拟合，并分析曲线拟合

的误差情况。

step 1
在MATLAB的命令窗口中输入下面的程序代码：

step 2
查看程序代码的结果。在输入以上代码后，按“Enter”键，得到的

曲线拟合图形如图6.15所示。



图6.15 多项式拟合结果

这个例子中使用了函数erf来产生基础数据，该函数是MATLAB的

内置误差函数，其表达式为 。关于该函数的详细知

识，可以查看对应的帮助文件。

说明

这个例子并不复杂，但是如果能够了解例子中各个参数的含义，就能加深对polyfit命令各

参数的含义。

6.2.2 加权最小方差拟合

所谓加权最小方差（Weighted Least Squares），就是根据基础数
据本身各自的准确度（或者被称为可靠性）的不同，在拟合的时候给



每个数据以不同的加权数值。这种方法比前面所介绍的单纯最小方差

方法要更加符合拟合的初衷。

对于N阶多项式的拟合公式，所要求解的拟合系数需要求解线性
方程组，其中线性方程组的系数矩阵和需要求解的拟合系数（也就是

变量）矩阵分别为：

使用加权最小方差（WLS）方法求解得到的拟合系数为：

其对应的加权最小方差为表达式JW＝[Aθ－y]TW[Aθ－y]最小。

6.2.3 数据拟合——适用加权最小方差WLS方法

例6.9 根据WLS数据拟合方法，自行编写使用WLS方法拟合数据
的M函数，然后使用WLS方法进行数据拟合。

step 1
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入下面的程序代码：



在输入以上代码后，将其保存为“polyfits.m”文件。

step 2



使用上面的程序代码，对基础数据进行LS多项式拟合。在
MATLAB的命令窗口中输入下面的程序代码：

step 3
查看程序代码的结果。输入以上程序代码后，按“Enter”键，得到

的拟合结果如图6.16所示。



图6.16 使用LS方法求解的拟合结果

step 4
对上面的基础数据，用户可以使用polyfit命令进行拟合。在命令

窗口中输入下面的程序代码：

step 5
查看程序代码的结果。输入以上程序代码后，按“Enter”键，得到

的拟合结果如图6.17所示。



图6.17 使用默认命令得到的拟合结果

提示

从上面的例子中可以看出，LS方法其实是WLS方法的一种特例，相当于将每个基础数据

的准确度都设为1。但是，自行编写的M文件和默认的命令结果不同，请读者自行仔细比较。

 
例6.10 同时使用WLS和LS方法对基础数据进行拟合，然后画出

对比图形。

step 1
在MATLAB的命令窗口中输入下面的程序代码：



step 2
查看程序代码的结果。当输入以上程序代码后，按“Enter”键，查

看拟合的结果如图6.18所示。



图6.18 WLS和LS方法得到的拟合结果

说明

从图6.18可以看出，使用WLS得到的拟合结果比LS得到的拟合结果更加准确，只是参数

比LS的参数更多。

6.3 曲线拟合图形界面

在MATLAB 7.0中，为用户提供了曲线拟合图形界面，用户可以
在该界面中直接进行曲线拟合。在该界面中，用户可以实现Spline曲
线拟合，也可以对同一组数据系列使用多种拟合方法、绘制拟合残余

等多种功能。最后，该界面还可以将拟合结果和估计数值保存到

MATLAB的工作空间中。



6.3.1 曲线拟合

在本节中，将以一个简单的例子来演示如何使用该界面完成拟合

工作。

例6.11 以例6.10中的基础数据为例，使用曲线拟合图形界面完成
各种拟合工作，下面分步骤详细介绍。

step 1
在MATLAB的命令窗口中输入下面的程序代码：

step 2
查看程序代码的结果。输入代码后，按“Enter”键，得到的图形如

图6.19所示。



图6.19 基础数据图形

step 3
打开“Basic Fitting-1”对话框。选择图形窗口中的“Tools”→“Basic

Fitting”命令，打开关于该数据的拟合图形界面，如图6.20所示。



图6.20 打开“Basic Fitting-1”对话框

step 4
查看对话框。当选择上面的菜单选项后，就可以打开默认情况下

的对话框，如图6.21所示。



图6.21 默认的“Basic Fitting-1”对话框

step 5
查看图形的变化。MATLAB在打开拟合图形对话框的同时，还会

为原始的图形添加图例，如图6.22所示。



图6.22 添加图例后的图形

说明

在MATLAB中，会将原始的基础数据名称设置为“data1”，用户可以直接在图形窗口中修

改这个名称。在本实例中，为了简化步骤，保存默认的名称。

step 6
展开对话框，选择数据拟合的类型，同时在图形中显示拟合的结

果方程。将默认的“Basic Fitting-1”对话框展开，在“Check to display
fits on figure”列表框中选择“cubic”选项，然后选中“Show equations”复
选框，如图6.23所示。



图6.23 选择数据拟合的类型

step 7
查看图形的变化。当选择了上面的选项后，原始图形会显示拟合

图形和方程，如图6.24所示。



图6.24 数据拟合的结果

提示

如果选中对话框中的“Center and scale X data”复选框，MATLAB会将基础数据拟合为平均

值为0，单位标准方差的数据。并不是所有的数据都适合上面的方法，当系统检测出用户使用

该方法在不合适的位置，会显示对应的警告信息。

6.3.2 绘制拟合残差图形

延续前一节的步骤。

step 8
绘制拟合残差图形，并显示残差的标准差。选择“Basic Fitting-

1”对话框中的“Plot residuals”复选框和“Show norm of residuals”复选
框，如图6.25所示。



图6.25 显示拟合残差以及其标准差

step 9
查看绘制的结果。当选择了上面的选项后，MATLAB会在原始图

形的下方绘制残差图形，并在图形中显示残差的标准差，得到的结果

如图6.26所示。



图6.26 显示拟合的残差

说明

在“Basic Fitting-1”对话框中，可以选择残差图形的图表类型：Bar、Scatter和Line，可以

在对应的选项框中选择图表类型；同时，可以选择绘制残差图形的位置：Subplot和Separate

figure两个选项。在默认情况下，图表类型为Bar，位置为Subplot。

step 10
保存拟合的结果。单击 “Basic Fitting-1”对话框中的 “Save to

workspace”按钮，打开“Save Fit to Workspace”对话框，在其中设置保
存选项，如图6.27所示。



图6.27 保存拟合的结果

step 11
查看保存结果。当保存了上面的拟合结果后，返回到MATLAB的

命令窗口中，查看保存的结果：

6.3.3 进行数据预测

延续前一节的步骤。



step 12
对数据进行预测。再次展开“Basic Fitting-1”对话框，打开该对话

框中的“Find Y = f(X)”面板，在“Enter value(s)”选框中输入“10:15”，然
后单击“Evaluate”按钮，在其下面的选框中会显示预测的数据。最后，
选择“Plot evaluated results”复选框，将预测的结果显示在图形中，如图
6.28所示。

图6.28 预测数据

step 13
查看绘制结果。当选择上面选项后，MATLAB会在原来图形基础

上显示预测的数据，如图6.29所示。



图6.29 显示预测数据的图形

说明

在“Find Y = f(X)”面板的“Enter value(s)”选框中，用户可以输入任何合理的MATLAB表达

式，例如已经定义过的变量，或者数学表达式等。

step 14
保存预测的数据。单击 “Find Y = f(X)”面板中的 “Save to

workspace”按钮，打开“Save Results to Workspace”对话框，在其中设置
保存数据选项，然后单击“OK”按钮，保存预测的数据，如图6.30所
示。



图6.30 保存预测数据

step 15
查看保存结果。当设置了保存选项后，返回到MATLAB的命令窗

口中，查看保存的结果：

提示



这个例子比较简单，基本演示了如何使用曲线拟合曲线界面的方法，用户可以根据实际

情况，选择不同的拟合参数，完成其他的拟合工作。

6.4 傅里叶分析

傅里叶（Fourier）分析在信号处理领域有着广泛应用，现实生活
中大部分信号都包含多个不同频率组分，这些信号组件频率会随着时

间或快或慢地变化。傅里叶（Fourier）分析和傅里叶变换是用来分析
周期或者非周期信号的频率特性的数学工具。

从时间的角度来看，傅里叶分析包括连续时间和离散时间的傅里

叶变换，总共有四种不同的傅里叶分析类型：连续时间的傅里叶系

列、连续时间的傅里叶变换、离散时间的傅里叶变换和离散傅里叶系

列/变换等。其中，离散傅里叶系列/变换是最容易被程序化的，因此
在本节中将详细讲解离散傅里叶系列和变换的内容。

6.4.1 离散傅里叶变换

在信号领域中，离散傅里叶变换的定义如下：从某连续时间信号

中每T秒根据下面的关系选取信号数据系列：{x[n＝x]（nT），n＝0∶M
－1}
该数据系列的离散傅里叶变换（DFT）和逆离散傅里叶变换

（IDFT）的定义为：



关于这两种傅里叶变换，MATLAB提供了FFT和IFFT命令来求
解。FFT是指快速傅里叶变换，使用了快速的算法来计算上面两种傅
里叶变换。其相应的调用命令如下：

 
◆ Y = fft(X,n,dim)
◆ y = ifft(X,n,dim)
 
在命令中，n表示离散系列的次序编号，X表示离散信号序列。

说明

关于FFT命令的原理，由于比较复杂，在这里就不详细展开了，感兴趣的读者可以查阅

相应的信号书籍。

 
例6.12 使用FFT，从包含了噪声信号在内的信号信息中寻找组成

信号的主要频率。

step 1
产生原始信号，并绘制信号图形。在MATLAB命令窗口中输入下

面的程序代码：



step 2
查看原始信号的图形。在输入以上代码后，按“Enter”键，得到的

原始图形如图6.31所示。

图6.31 原始噪声信号

说明

以上程序代码产生的信号中包含了主频率为50Hz和120Hz，同时信号中包含了均值为0的

随机噪声信号，之所以这样设置信号属性，是为了在后面的步骤中进行频率分析。



step 3
对信号进行傅里叶变换。在MATLAB命令窗口中输入下面的程序

代码：

step 4
查看信号转换图形。在输入上面代码后，按“Enter”键，得到的信

号转换图形如图6.32所示。



图6.32 经过傅里叶变换的信号

说明

从上面的傅里叶变换结果可以看出，在频率为50Hz和120Hz的地方有较强的信号，而在

其他地方则没有明显的信号信息。因此，通过傅里叶变换可以从信号中区分频率分布。

6.4.2 FFT和DFT

前面曾经提到过，MATLAB提供了FFT函数命令来实现离散傅里
叶变换（DFT），该命令对应的是快速计算算法。为了让读者更加直
观地了解到FFT命令算法相对于DFT算法的优势，在本节中，将使用
一个简单的例子，分别使用FFT和DFT方法进行傅里叶变换，比较两
者的优劣。

例6.13 分别使用FFT和DFT方法实现傅里叶变换，并比较两者的
优劣。

step 1
在MATLAB命令窗口中输入下面的程序代码：



step 2
查看程序结果。在输入程序代码后，按“Enter”键，得到的结果如

图6.33所示。



图6.33 两种变换方法得到的结果

step 3
比较两个方法的计算时间。在MATLAB命令窗口中输入下面的程

序代码：

step 4
查看程序结果。在输入程序代码后，按“Enter”键，得到的结果如

下：

从结果可以看出，使用DFT完成傅里叶变换的时间是1.742s，而使
用FFT方法完成傅里叶变换的时间是0.01s。



提示

从上面的实例中可以看出，两种方法得到的傅里叶变换结果相同，但是所消耗的时间和

资源是完全不同的，FFT方法明显优于DFT方法。

6.4.3 DFT的物理含义

由于DFT在公式表达式上比较复杂，因此读者也许不能理解DFT
的物理含义，为了能够让读者更加容易理解DFT的物理含义，在本节
中从一个连续信号中选择不同的时间间隔的离散信号，并对各种离散

信号进行DFT转换。
其中连续信号的表达式如下：

x（t）＝sin（1.5πt）＋0.5cos（3πt）

在本节中，将从这个连续信号中选择不同周期的离散信号，并对

其进行离散傅里叶变换，最后绘制各种信号图形和转换图形。

例6.14 从上面的连续信号表达式中选择不同间隔的离散信号，
然后进行离散傅里叶变换，最后绘制各种图形。

step 1
在MATLAB命令窗口中输入下面的程序代码：





step 2
查看程序代码结果。当输入了上面的程序代码后，按“Enter”键，

得到的结果如图6.34所示。



图6.34 离散信号和傅里叶变换后的图形

提示

通过图6.34对比离散数据点的选择个数对离散信号和傅里叶变换的影响，从图形中可以

形象地看出傅里叶变换的物理含义。

6.4.4 使用DFS进行插值

MATLAB提供了一维快速傅里叶变换（FFT）进行插值的内置函
数interpft，该函数主要通过傅里叶变换将输入的数据变换到频域，然
后使用更多点的傅里叶变换，变换到时域，因此其结果就是对数据进

行增采样，进行插值。

interpft函数的主要调用格式如下：



在上面的命令中，x表示的是需要进行插值的数据系列，n表示希
望采用n点傅里叶逆变换变回到时域中，dim则表示这种插值需要在指
定的维度上进行。

说明

由于上面的命令比较简单，关于该命令的使用方法和具体实例，请读者自行查阅相应的

帮助文件，这里就不详细介绍了。

 
在本节中，将主要介绍如何使用DFS进行数据插值。要使用DFS

来进行数据插值，首先需要从信号序列X（k）中选择数据点，并使用
下面的公式进行插值运算：

根据上面的公式，读者可以自行编写M文件，然后使用编写的文
件进行插值运算。

例6.15 根据上面的基础插值公式，自行编写使用DFS方法进行
插值的M文件，然后以f（t）＝sin（πt）＋0.5sin（0.5πt）为主信号，
以z（t）＝rand（1，n）－0.5为噪声信号，产生基础数据，最后使用
DFS进行插值。

step 1
选择命令窗口编辑栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入下面的程序代码：



在输入以上程序代码后，将其保存为“interp_DFS.m”文件，在后
面的步骤中，将会使用该函数进行数据插值。

step 2
在MATLAB的命令窗口中输入下面的程序代码：



step 3
查看程序代码结果。输入程序代码后，按“Enter”键，得到结果如

图6.35所示。



图6.35 对DFS进行数据插值

提示

在上面的例子中，首先根据公式编写关于DFS数据插值的M文件程序代码，然后使用不

同的精度对基础信号进行数据插值，读者可以仔细查看程序代码，有助于对DFS数据插值原

理的理解。

6.5 小结

在本章中依次介绍了如何使用MATLAB来进行常见的数据分析：
数据插值、曲线拟合和傅里叶分析等，这些应用相对于前面章节的内

容而言，更加复杂，涉及的数学原理也比较深入，因此建议在阅读本

章内容的时候，能够结合数学原理一起理解。在后面的章节中，将介

绍如何使用MATLAB进行符号运算。



◆   ◆   ◆



第7章 优  化

本章包括

◆非线性优化

◆线性规划

◆二次规划

◆使用遗传算法求解优化

◆工程优化实例

 
在科学工程领域中，优化有着十分广泛的应用。根据数学理论定

义，优化是指在某种约束条件下，寻求目标函数的最大值或者最小

值。将以上定义转换为数学公式为：

在以上公式中，x表示的是变量向量，也就是x＝（x1，x2，…，
xn）；f（x）也就是优化情况下的目标函数，S表示的是x所承受的约
束条件。如果x没有接受任何的约束条件，或者S是数值条件下的全
集，则该优化为非约束优化；否则，则是约束优化。对于上面这些问

题，本章都会详细介绍。

7.1 常见优化问题

本节主要讲解常见的优化问题，首先介绍非约束优化的内容，然

后介绍约束优化的内容，最后，将介绍线性规划和二次规划这两种在

实际中比较常见的优化问题。本节中所涉及的内容将都是MATLAB内



置的函数，同时有些比较复杂的优化处理工具将会涉及Optimization
Toolbox中的函数和内容，如果希望自行演示本节中的程序代码，应安
装Optimization Toolbox组件。

7.1.1 无约束非线性优化

前面已经介绍过，无约束优化相当于约束集为全集。MATLAB为
解决非约束优化提供了fminsearch和fminunc两种函数，其对应的详细
调用格式如下：

在以上命令格式中，参数比较繁多，下面分部分详细介绍。

 
◆ 输入参数：参数“fun”表示的是优化的目标函数，参数x0表示

执行优化的初始数值，参数“options”表示的是进行优化的各种属性，
一般需要使用optimset函数进行设置。

◆ 输出参数：参数x表示最优解；fval表示最优解对应的函数数
值；参数“exitflag”则表示函数退出优化运算的原因，取值为1，0
和-1，其中数值1表示函数收敛于最优解，0则表示函数迭代次数超过
了优化属性的设置，-1则表示优化迭代算法被output函数中止；参
数“output”是一种结构体变量，显示的是关于优化的属性信息，例如优
化迭代次数和优化算法等。

说明

在MATLAB中，fminsearch一般适用于没有约束条件的非线性优化情况，对于线性优化的

情况，将在后面的章节中详细介绍。

 
fminunc函数的调用格式如下：



该函数的大部分参数的含义和fminsearch函数相同，而输出参
数“grad”表示的是函数在最优解处的梯度；参数“hessian”则表示目标函
数在最优解的Hessian矩阵数值；参数“exitflag”表示的也是停止最优求
解的类型，但是其取值包括了-2，-1，0，1，2和3。因此，该函数比
以上函数能够更加详细地描述优化情况，关于其具体的含义，请读者

自行查看相应的帮助文件。

7.1.2 求解二元函数的最小值——无约束非线性
优化

在本节中，将介绍如何使用这两种比较常见的函数来求解优化问

题。

例7.1 求解二元函数 在全集范围之内的最

小值，分别使用不同的优化函数和优化属性，为了能够直观地查看优

化求解情况，可以在求解之后绘制二元函数的图形。

step 1
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：

在以上程序代码中，g表示的是f函数的偏导数，满足以下方程
组：



在输入完以上程序代码后，将其保存为“optfun.m”文件。

step 2
选择优化的初始数值[1，1]，分别使用不同的函数求解优化。在

MATLAB的命令窗口中输入以下程序代码：



说明

在以上结果中，使用fminuc函数求解的最优解为（0，0），而且迭代的次数为2，对应的

优化求解方法为“large-scale: trust-region Newton”；使用fminsearch函数求解的最优解为（0，

0），且迭代次数为81，使用的优化求解方法为“Nelder-Mead simplex direct search”。因此，在

相同的初值条件下，两个方法求解的性质不同。

step 1
选择优化的初始数值[-1，1]，分别使用不同的函数求解优化。在

MATLAB的命令窗口中输入以下程序代码：





从以上程序结果可以看出，当修改了优化的初始条件后，各种优

化函数所使用的迭代次数会有明显的改变。因此，设置初值条件该直

接影响优化求解的效率。

说明

在使用不同函数来求解函数的优化条件时，多次使用了optimset函数来设置优化属性，关

于该函数的具体使用方法请读者自行查看帮助文件。

step 4



在[-1.5，1.5]范围内绘制二元函数 的图形，并

从图形中显示对应的函数数值。在MATLAB的命令窗口中输入以下程
序代码：

step 5
查看函数图形。在输入代码后，按“Enter”键，查看函数图形，如

图7.1所示。

图7.1 三维函数图形

说明

从图7.1可以看出，（0，0）是该函数在全局范围内的最小值，通过以上函数都可以求解

到该最优解。

7.1.3 非线性最小方差



非线性最小方差（nonlinear least-squares）是非线性约束优化的一

种特例，其优化的目标函数为： ，其中 就是所谓的方

差函数。如果熟悉前面章节介绍的曲线拟合内容，就会发现该目标函

数就是曲线拟合的函数。因此，以上问题也被称为是非线性数据拟合

（nonlinear data-fitting）。
在MATLAB中，为了求解非线性最小方差，提供了lsqnonlin函数

命令，其最完整的调用格式如下：

在以上命令中，函数的参数比较复杂，下面详细介绍各参数的具

体含义：

 
◆ 输入参数：参数fun表示的是优化的目标函数，参数x0表示的

是优化的初值条件，lb是进行优化求解的下限，ub是进行优化求解的
上限，相当于lb≤x≤ub；参数options则表示进行优化求解的优化属性。

◆ 输出参数：参数x表示所求得的最优解；参数resnorm则表示
二阶范数，在数值上等于sum(fun(x).^2)；参数residual则表示优化求解
后的残数；参数lambda则表示函数在最优解处的拉格朗日数值；其他
参数和其他优化命令中的含义相同。

提示

在以上命令格式中，并不是所有的参数都是必须输入的，在输入参数部分，只有fun、x0

是必须的，而在输出参数部分，只有x是必须的。MATLAB之所以提供了以上许多参数，是为

了方便用户自行研究和比较优化的属性。

7.1.4 计算函数的非线性最小方差



例7.2 以函数 为基准函数，对其进行非线性最小方差

运算，同时以最小方差为目标进行数据拟合。

step 1
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：

在输入以上程序代码后，将其保存为“flq.m”文件。

step 2
进行非线性最小方差求解。在MATLAB的命令窗口中输入以下程

序代码：

step 3
查看程序结果。在输入以上程序代码后，按“Enter”键，得到的结

果如下：



step 4



分析非线性方差运算的数据残余。在命令窗口中输入以下程序代

码：

step 5
查看图形。在输入程序代码后，按“Enter”键，得到的结果如图7.2

所示。

图7.2 数据残余的图形

说明

限于篇幅，关于该命令中的其他参数在这里就不详细介绍了，感兴趣的读者可自行阅读

相应的帮助文件。

7.1.5 有约束的非线性优化



有约束条件的优化情况比无约束条件的优化情况要复杂很多，处

理起来也更困难，种类也比较繁杂，限于篇幅，这里不能将所有的约

束优化都进行讨论，仅限于讨论MATLAB内置函数fmincon的使用方
法。首先，fmincon函数主要用于解决具有下面约束条件的优化：

该函数的完整调用格式如下：

该函数的参数比较复杂，下面详细介绍各种参数的含义：

 
◆ 输入参数的含义：参数fun表示的是优化目标函数，x0表示的

是优化的初始值，参数A、b表示的是满足线性关系式A·x≤b的系数矩
阵和结果矩阵；参数Aeq、beq表示的是满足线性等式Aeq·x＝beq的矩
阵；参数lb、ub表示满足参数取值范围lb≤x≤ub的上限和下限；参数
nonlcon表示需要参数满足的非线性关系式c（x）≤0和ceq（x）＝0的
优化情况；参数options就是进行优化的属性设置。

◆ 输出参数的含义：exitflag表示程序退出优化运算的类型，取
值为-2，-1，0，1，2，3，4和5，其数值对应的类型在这里就不详细
展开了；output参数包含了多种关于优化的信息，包含了iterations、
funcCount、algorithm、cgiterations、 stepsize和 firstorderopt等；参数



lambda则表示 lower、upper、ubineqlin、eqlin、 ineqnonlin和eqnonlin
等，分别表示优化问题的各种约束问题的拉格朗日参数数值。

提示

尽管各种优化命令中都包含了以上一些主要参数，但是在不同的优化命令中，参数的含

义是不相同的，不要认为相同参数的含义都一致。

7.1.6 计算多元函数的极值——有约束的非线性
优化

例7.3  求解在约束条件0≤x1＋2x2＋3x3≤72下，函数f（x）＝-
x1x2x3的最小值的最优解以及最优解的数值。

step 1
转换约束条件，将以上约束条件转换为以下关系式：

提示

由于在fmincon中，所有的约束条件都是以以上不等式形式出现的，因此在本步骤中需要

将原来的约束条件转换为不等式方程组。

step 2
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：



将以上程序代码保存为“optcon.m”文件，该文件将是最优解的目
标函数。

step 3
在MATLAB的命令窗口中输入以下程序代码：

step 4
查看优化信息。在输入了以上程序代码之后，按“Enter”键，

MATLAB就会进行优化运算，并显示对应的优化信息：

在以上程序中显示了实际上起作用的约束条件和优化终止的类

型。

step 5
查看优化的结果。在MATLAB的命令窗口中输入以下程序代码：



提示

从以上优化结果中，可以看出各种具体的优化信息，进而进行优化分析。由于在以上步

骤中，没有显示迭代过程，在该优化结果中的output参数显示了迭代次数为8。

step 6



重新设置优化条件，进行优化运算。将最优问题的约束条件修改

为以下关系式：

同时，将初值设置为[1，1，1]，然后进行优化求解，得到的结果
如下：



提示

从以上条件可以看出，当修改了关于优化的各种属性后，优化问题会发生质的改变，因

此在进行优化求解问题的时候，需要特别注意优化求解的条件。

7.1.7 最小最大值的优化问题

最小最大值的优化问题是一个比较特殊的问题，其表示的是从一

系列最大值中选取最小的数值，相当于求解以下优化问题：



在以上目标函数中， F（ x）＝ [f1（ x）， f2（ x），…，
fN（x）]T。该函数的参数和使用方法和前面介绍的fmincon完全相同。
下面使用简单的实例来介绍如何使用该函数命令。

例7.4 求解函数F（x）＝[f1（x），f2（x），f3（x），f4（x），
f5 （ x ） ]T 的 最 小 最 大 值 ， 其 中 各 分 函 数 依 次 为

f4（x）＝-x1－x2和f5（x）＝x1＋x2－8。

step 1
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：

在输入以上程序代码后，将该代码保存为“mnmax.m”文件。

step 2
求解最小最大值的优化问题。在MATLAB的命令窗口中输入以下

程序代码：



在以上求解过程中，首先设置了初值条件，然后直接调用函数求

解优化问题。

step 3
重新设置优化条件，求解优化问题。在命令窗口中输入以下程序

代码：



说明

和其他的优化求解方法相似，当修改优化条件后，相同的优化问题将会得出不同的结

果。同时，尽管可以使用optimset来设置各种优化的属性，但是对于不同的优化问题，

MATLAB提供了不同的优化属性，可以使用“optimset funname”来查看优化对应的优化情况属

性，在后面步骤中将做出演示。

step 4



查看优化属性。在命令窗口中输入“optimset fminimax”，查看该函
数的所有相关优化属性：

说明

在本实例中，也可以通过修改优化的初值条件来重新进行优化，在这里限于篇幅，就不

重复展开详细计算了，请读者自行尝试。

7.1.8 优化对比



例7.5 使用函数 产生的基础数据，并分别使用“最小

最大值优化”和“非线性最小方差优化”的方法对基础数据进行数据拟
合，最后绘制拟合图形。

step 1
在MATLAB的命令窗口中输入以下程序代码：

step 2
查看程序代码的结果。输入程序代码后，按“Enter”键，得到的图

形如图7.3所示。



图7.3 绘制数据拟合的结果

step 3
查看优化求解信息。在显示数据拟合的结果的同时，MATLAB也

会显示关于优化求解的信息：

说明



在以上程序代码中，fm表示的是使用最小最大方法求解得到的拟合系数，fln则是使用最

小方差的方法求解得到的拟合系数。

7.1.9 线性规划

线性规划是一种特殊的优化问题，在这种优化问题中，目标函数

和约束条件都是线性的，对于这种优化问题，可以使用比较特殊的方

法来求解。典型的线性规划问题为：

在MATLAB中，求解线性规划的命令为linprog，其完整的调用格
式如下：

关于该命令中各参数的含义，请读者参考前面的fmincon命令。
例7.6 求解线性规划，其中目标函数为f（x）＝-3x1－2x2，其中

参数满足以下关系式：0≤x1，x2≤10，同时，该目标函数满足以下约束
条件：

为了更加深入地理解线性规划的含义，在本例中将分别使用线性

规划和约束优化的方法，求解以上规划问题。



step 1
在MATLAB的命令窗口中输入以下程序代码：

step 2
查看线性规划求解的结果。在命令窗口中输入以下程序代码：



说明

从以上结果可以看出，使用线性规划求解得到的最优解为（0.33，1.5），与最优解对应

的函数值为-4。同时，第二个约束条件满足，其他的约束条件都没有满足。

step 3
查看约束条件求解的结果。在命令窗口中输入以下程序代码：



说明

从上面求解的结果中可以看出，使用约束条件求解得到的结果和线性规划相同。同时，

关于各种约束条件的朗格朗日系数相同。

step 4
对比两种方法的使用时间。在命令窗口中输入以下程序代码：

提示

从以上结果可以看出，使用线性规划的时间为0.09s，而使用约束条件求解的优化问题则

需要花费0.13s，性能上明显劣于线性规划的方法。

 
在本节的最后，针对该实例绘制出线性规划的图形，通过该图可

以直观地理解直线规划的几何含义，如图7.4所示。



图7.4 线性规划的几何含义

7.1.10 二次规划

二次规划是指其目标函数最高次数为2的优化问题，典型的二次规
划的格式如下：

在MATLAB中，求解线性规划的命令为quadprog，其完整的调用
格式如下：

关于该命令中的各参数的含义，请读者参考前面的fmincon命令。
例 7.7  求 解 二 次 规 划 ， 其 目 标 函 数 为

，同时，其满足的约束条件为：



step 1
将二次规划进行转换，转换为标准形式。根据线性代数知识，得

到的结果为：

step 2
进行二次规划求解。在MATLAB的命令窗口中输入以下代码：

step 3
查看二次规划求解的结果。在MATLAB的命令窗口中输入以下代

码：



在以上二次规划问题中，求得的最优解为（0.6667，1.3333），对
应的函数数值为-8.222。同时，对应的拉格朗日系数为（3.1111，
0.4444，0）。

7.1.11 使用遗传算法求解二次规划

在本节的最后，将介绍如何使用遗传算法来求解这个二次规划问

题。使用本节中的方法，应首先安装“Genetic Algorithm and Direct
Search Toolbox”，遗传算法是近年来发展迅速的计算方法，将在后面
章节中详细介绍，下面分步骤介绍如何使用该方法来求解以上实例。

例7.8 使用遗传算法求解以上二次规划问题。
 

step 1
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：

然后将以上程序代码保存为“quadopt.m”文件，该文件是该二次规
划的目标函数。



step 2
设置二次规划求解的条件。在MATLAB的命令窗口中输入以下代

码：

step 3
设置规划求解的参数。在命令窗口中输入 “psearchtool”，打

开“Pattern Search Tool”对话框，并在其中设置规划的参数，如图7.5所
示。

图7.5 设置优化条件



在“Pattern Search Tool”对话框中设置二次规划的参数，介绍如
下：

 
◆ 在“Objective function”文本框中输入“@quadopt”，其中quadopt

就是在前面步骤中设置的二次规划的目标函数。

◆ 在“Start point”文本框中输入“x0”，表示的是进行优化求解的
初始条件数值；在前面使用quadprog求解时，并没有设置该选项，但
是使用遗传算法时必须指定初始条件的数值。

◆  在 “Constraints”区域中设置了二次规划的约束条件。其
中“Linear inequalities”文本框表示的是不等式约束条件A·x≤b，分别
在“A”和“b”文本框中输入对应的参数；“Linear equalities”文本框中表
示的是等式约束条件Aeq·x＝beq，在本实例中没有任何等式约束，因
此两个选框为空；“Bounds”文本框表示的是变量的取值范围lb≤x≤ub，
在本实例中，只有下限，没有上限，因此在“Lower”文本框中输
入“lb”。

step 4
运行规划求解。单击对话框“Run solver”区域的“Start”按钮，进行

规划求解，并得出对应的结果，如图7.6所示。



图7.6 规划求解的结果

在对话框的“Status and results”信息框中，描述的是该二次规划的
结果和求解信息，具体信息如下：

说明

从以上信息可以看出，目标函数的最优解为-8.222220526797175，最后，还描述了优化求

解中止的类型。

 



在 “Final point”列表框中显示的是该二次规划的最优解坐标
（0.6667，1.3333），和前面步骤中使用quadprog方法求解得到的最优
解相同。

7.2 使用遗传算法求解优化

所谓遗传算法（genetic algorithm）是指，基于自然选择的方法来
求解优化问题。由于自然选择是生物进化的重要步骤，因此该方法被

称为遗传算法。在遗传算法中，将重复修改个体的总数，在每个计算

步骤中，将在当前总数的条件下随机选择个体，作为计算下一代的“父
体”，然后使用这些“父体”来产生下一代的“子体”。在多次连续的数据
代中，将会通过优化解决方法来实现进化。

在MATLAB中，可以使用遗传算法解决标准优化算法无法解决或
者很难解决的优化问题，例如，当优化问题的目标函数是离散的、不

可微的、随机的或者高度非线性化的时候，使用遗传算法就会比前面

章节中介绍的优化方法更有效、更方便。

在本节中，将以一个例子来说明如何使用“Genetic Algorithm and
Direct Search”工具箱中提供的函数进行优化求解。

说明

在“Genetic Algorithm and Direct Search”工具箱中，提供了大量的函数，来方便进行优化

求解。如果希望了解这些函数代码，可以在命令窗口中输入“type funname”查看具体代码。

7.2.1 分析目标函数

例7.9  使用遗传算法来求解优化问题，求解命令都将使用
到“Genetic Algorithm and Direct Search”工具箱中的内置函数。由于这



些函数一般都比较复杂，因此，在对应的地方将尽量做出必要的解

释，来帮助读者理解优化求解的方法。

step 1
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：

以上程序代码将是在本实例中优化的目标函数，将该代码保存

为“shufcn.m”文件。

step 2
绘制上面代码文件的函数图形。在MATLAB的命令窗口中输入以

下代码：

输入以上代码后，按“Enter”键，得到的图形如图7.7所示。



图7.7 绘制的函数图形

step 3
查看plotobjective函数的M文件程序代码。在以上命令行中，调用

了 plotobjective函数，这个函数是 “Genetic Algorithm and Direct
Search”工具箱中的内置函数，用来绘制目标函数的图形，其具体的程
序代码如下：



以上程序代码多次使用了绘制图形的常见命令，这里大致介绍上

面代码的主要含义：首先根据输入的变量情况绘制曲面图，然后绘制

相应的等高线。关于具体每个语句的含义，请读者查看本书中介绍图

形绘制的章节。

说明

从以上绘图结果可以看出，在本节中之所以选择该函数，是因为该函数本身有很多的数

据“浅滩”，使用普通的优化方法取得最优解会十分困难。



7.2.2 优化求解

前面已经分析了目标函数的特点，在本节中，将开始对函数进行

优化求解。下面详细介绍优化求解的步骤。

step 1
设置遗传算法的参数。在MATLAB的命令窗口中输入以下代码：

说明

在使用遗传算法的时候，需要首先设定两个必要的参数：拟合函数（目标函数）和优化

问题的变量个数。在本实例中，目标函数为shufcn，变量个数为2。

step 2
运行遗传算法，进行优化求解。在MATLAB的命令窗口中输入以

下代码：

说明

在以上程序代码中，ga是“Genetic Algorithm and Direct Search”工具箱中的内置函数，表

示使用遗传算法来求解FitnessFunction的最小值，并返回最优解的各种信息。

step 3
分析ga命令的调用格式。在MATLAB中，ga命令的完整调用格式

如下：

 



其中各参数的具体含义如下：

 
◆ 输入参数：fitnessfun表示的是最小值优化问题的目标函数，

nvars表示的是该目标函数中变量的个数，options则是该优化问题的优
化属性。

◆ 输出参数：变量x表示的是求解的最优解，变量fval表示的是
最优解所在的函数值；变量exitflag表示的是GA算法停止的类型；变量
output则表示解算器运行的各信息，可以查看output中各分量变量的信
息；变量population返回最优解的总体；变量scores则返回最优解总体
的总数信息。

提示

输入参数中options的功能是用来设定遗传算法的优化求解属性，和前面章节中介绍的其

他优化命令类似，可以使用专门的命令来设置options的具体属性。在Genetic Algorithm and

Direct Search Toolbox中，提供了gaoptimset命令来设置属性，并返回一个结构体变量options。

step 4
查看优化求解的结果。在MATLAB的命令窗口中输入以下代码：

从以上结果中可以看出，最优解为（-1.44823，-0.797518），同
时最优解处的函数结果数值为-185.48，最后，遗传算法的总体代数为
82。



说明

遗传算法通过使用一系列作用在遗传总体种群的操作，进行优化求解。其中，“种群”是

指在某个特定空间中的数据点。在默认情况下，初始种群是随机产生的，下一代的种群则是

通过当前种群中每个个体的“适应度”来选取获得的。

7.2.3 添加结果的可视性

使用遗传算法求解优化问题的一个最显著的优势就是，可以将优

化的结果可视化。在本节中，将设置结果的可视性属性。下面分步骤

详细讲解。

step 1
添加优化结果的可视化属性。使用GAOPTIMSET命令添加遗传算

法的图形属性选项：GAPLOTBESTF和GAPLOTSTOPPING，在命令
窗口中输入以下程序代码：

提示

在这行代码中，gaplotbestf和gaplotstopping都是“Genetic Algorithm and Direct Search”工具

箱中的内置绘图函数。其中，函数gaplotbestf的功能是绘制当前种群中的最佳和平均个体的数

量；函数gaplotstopping的功能则是绘制满足停止标准的百分比图形。

step 2
查看函数gaplotbestf的程序代码。和前面步骤类似，可以通过type

命令查看上面两个函数的程序代码，这里仅仅列出了函数gaplotbestf的
程序代码：



在以上程序代码中，引用了state的遗传算法的各种属性，因此，
该函数图形显示的是在运行遗传算法过程中的各种计算结果属性。

说明

对于函数gaplotstopping，也可以使用type命令进行查看，限于篇幅，在这里就不详细列出

其代码了，请读者自行分析。

7.2.4 设置算法的属性

前面已经完成了遗传算法的优化求解，在本节中，将重新设置遗

传算法的属性，对前面的问题进行重新求解。然后将求解的过程和前

面章节进行比较分析。下面详细讲解计算的过程。

step 1
重新运行遗传算法，进行优化求解。在命令窗口中输入以下程序

代码：



step 2
查看函数求解过程的图形。除了显示以上优化结果之外，

MATLAB还会显示对应的函数图形，其中，在运行之中的函数图形如
图7.8所示。

图7.8 运行中的遗传算法属性图形

step 3
查看函数求解结束的图形。当系统结束遗传算法优化的时候，该

函数图形如图7.9所示。



图7.9 运行结束的遗传算法属性图形

step 4
从图7.9可以看出，该优化求解问题中止的原因在于“Generation”的总数满足了系统设置的

约束条件，也就是约束满足率为“100％”，其他的约束条件则都没有满足。

7.2.5 设置“种群”属性

在遗传算法中，“种群”属性是十分重要的属性。该属性将直接影
响计算的速度和结果。因此，在本节中，将详细讲解如何设置“种
群”属性。

step 1
设置遗传算法的“种群”属性。在MATLAB的命令窗口中输入以下

程序代码：

这行代码使用的是gaoptimset的调用格式：



在这种调用格式中，引用了原来的优化属性变量oldopts，然后将
其中的param1修改为value1，其他的属性数值则保持不变。在以上步
骤中，将默认的初始种群范围修改为[-1 0；1 2]，其他的属性也延用上
面步骤中的属性设置。

在遗传算法中，初始种群的范围必须是包含两行数据的矩阵，如

果该矩阵只有一列数据，则每个变量的变化范围都是相同的。例如，

用户设置“种群”的取值范围为[-1；1]，则变量的所有初始范围都是
从-1到1。

提示

根据前面介绍的遗传算法，种群的属性将直接影响遗传算法的性能，甚至将直接影响计

算结果，因此，可以根据目标函数的特征来设置“种群”属性。除了上面步骤中设置的数值范

围属性，还可以设置“种群”的大小属性，具体的设置方法可查看对应的帮助文件。

step 2
重新运行遗传算法，求解优化。在MATLAB的命令窗口中输入以

下程序代码：

step 3
查看函数求解过程的图形。在显示求解信息的同时，MATLAB还

会显示对应的优化图形，如图7.10所示。



图7.10 运行中的优化属性图形

step 4
查看函数求解结束的图形。当优化求解过程完成后，得到的优化

属性的图形如图7.11所示。

图7.11 运行后的优化属性图形



说明

从图7.11可以看出，该优化求解问题中止的原因在于“Stall”的总数满足了系统设置的约束

条件，也就是约束满足率为“100％”，其他的约束条件则都没有满足。

7.2.6 设置“中止”属性

在遗传算法中，“中止”属性和“种群”属性一样，是决定计算结果
和效率的重要参数。在本节中，将重点演示如何设置“中止”属性。

step 1
设置遗传算法的“中止”属性。在MATLAB的命令窗口中输入以下

程序代码：

提示

在以上步骤中，将遗传算法中的“中止”最大“代数”设置为250，延迟最大代数为50，在后

面的步骤中可以查看该修改的属性对遗传算法的影响。

step 2
重新运行遗传算法，求解优化。在MATLAB的命令窗口中输入以

下程序代码：



step 3
查看函数求解结束的图形。在修改了优化属性后，对应的优化属

性图形如图7.12所示。

图7.12 修改属性后的优化图形

说明

在“Genetic Algorithm and Direct Search”工具箱中，还提供了其他多个函数和工具，用来

分析优化问题，限于篇幅这里就不详细介绍了，请读者自行查看帮助文件。

7.3 优化“Banana”函数——优化方法对比

在优化领域中，二元函数f（x，y）＝100（y－x2）2＋（1－x）2

经常作为检测优化方法的对象函数，这个函数又被称为Rosenbrock's
Banana测试函数。这个测试函数有一片浅谷，许多优化算法都很难超
越这个浅谷，进而无法取得最优解。在本节中，将分别使用前面介绍

的多种优化方法来求解最优解，并比较各种方法的不同。



7.3.1 分析目标函数

例7.10 使用不同的方法来求解Banana函数的最小值，并比较各
种方法的优劣。

step 1
绘制Banana函数的图形。在MATLAB的命令窗口中输入以下程序

代码：

step 2



查看Banana函数的图形。在输入以上程序代码后，按“Enter”键，
得到的图形如图7.13所示。

图7.13 绘制目标函数的图形

说明

在以上图形中，首先绘制了目标函数的曲面图，然后选择（ -1.9，2）为起始点

（Begin），选择（1，1）为终止点（End）。在以上数据点中，（-1.9，2）为后面步骤中使

用优化求解的初始条件，而（1，1）则是该函数的优化解，因此比较各种优化方法从起始点

到终止点的过程，就可以比较各种优化方法的优劣。

step 3
编 写 优 化 方 法 的 输 出 函 数 。 选 择 命 令 窗 口 菜 单 栏 中

的“File”→“New”→“M-File”命令，打开M文件编辑器，在其中输入以
下程序代码：



说明

输入以上程序代码后，将其保存为“bandemOutFcn.m”文件，该程序代码的主要功能在于

绘制优化求解迭代的数据点，因此可以显示各优化方法的过程。

7.3.2 BFGS优化法求解



前面已经分析了目标函数的特点和性质，在本节中，将使用BFGS
方法来求解这个优化问题。 BFGS（ Broyden–Fletcher–Goldfarb–
Shanno）是解决无约束非线性优化问题的一种方法。BFGS优化法源自
牛顿优化法，主要是寻求目标函数的固定点（梯度为0的点）。在寻求
优化的过程中，将目标函数在极值附近的区域近似为二阶泰勒展开

式。具体的原理和算法比较复杂，这里就不详细介绍了。下面主要讲

解如何设置优化参数。

step 1
使用“Broyden-Fletcher-Goldfarb-Shanno”优化方法求解优化。在

MATLAB的命令窗口中输入以下程序代码：

step 2
查看优化结果。在输入以上程序代码后，按“Enter”键，得到的结

果如下：



从以上程序代码中可以看出，使用此优化方法优化迭代的次数为

34，同时函数评估的次数为50，得到的结果为（0.9998，0.9996），和
最后的最优解（1，1）很接近，表示该优化求解结果正确。

提示

在以上求解过程中，首先使用optimset命令将“LargeScale”的属性设置为“off”，这是因为

在后面的步骤中需要设置“InitialHessType”属性，也就是设置初始的拟牛顿矩阵类型，这种属

性只有在Medium-Scale算法中才有，因此需要将Large-Scale的功能设置为off。

step 1
查看优化求解过程的图形。除了得到优化结果之外，以上方法还

可以得到求解过程，如图7.14所示。

图7.14 优化求解的过程

说明



在图7.14中，数据点表示的就是使用对应的方法进行优化求解的时候，整个过程中迭代

的坐标数值。从以上过程中可以看出，在迭代开始的时候，数据点比较分散，表示开始的时

候数据并不收敛。

7.3.3 DFP优化法求解

在本节中，将讲解如何使用DFP（Davidon-Fletcher-Powell）方法
求解这个优化问题。DFP优化法可以接近当前状态并满足曲线属性的
前提下，找到方程组的解。DFP方法广泛应用于多维度优化求解问
题，是第一个拟牛顿方法。其具体的原理和算法比较复杂，此处不详

细展开。下面具体讲解如何使用DFP求解优化。

step 1
使用“Davidon-Fletcher-Powell”优化方法求解优化。在MATLAB的

命令窗口中输入以下程序代码：

step 2
查看程序结果。在输入以上程序代码后，按“Enter”键，得到的结

果如下：



从以上程序代码中可以看出，使用该优化方法优化迭代的次数为

45，同时函数评估的次数为64，得到的结果为（1，1），表示该优化
求解结果正确。

说明

“Davidon-Fletcher-Powell”方法和“Broyden-Fletcher-Goldfarb-Shanno”方法最大的区别在

于 “InitialHessType” 属 性 的 不 同 。 在 “Broyden-FletcherGoldfarb-Shanno” 方 法

中 ， “InitialHessType” 属 性 为 “scaled-identity” ， 而 在 “Davidon-Fletcher-Powell” 方 法

中，“InitialHessType”属性为“identity”。这些参数的具体含义比较复杂，请读者自行查看对应

的帮助文件。

step 3
查看优化求解过程的图形。除了得到优化结果之外，以上方法还

可以得到求解过程，如图7.15所示。



图7.15 优化求解的过程

说明

从以上求解过程可以看出，当修改了“InitialHessType”属性后，优化求解的迭代过程、次

数和计算精度将会发生质的飞跃。

7.3.4 “无约束非线性”优化求解

本节中，将使用前面讲解的“无约束非线性优化”的方法来求解目
标函数。下面详细介绍操作步骤。

step 1
使用“无约束非线性”的优化方法求解优化。在MATLAB的命令窗

口中输入以下程序代码：

step 2



查看程序结果。在输入以上程序代码后，按“Enter”键，得到的结
果如下：

step 3
查看优化求解过程的图形。和前面节类似，MATLAB会显示该优

化求解过程的图形，如图7.16所示。

图7.16 优化求解的过程

说明



从以上过程可以看出，使用“无约束非线性”的优化方法来求解以上优化问题时，优化的

迭代次数增加，迭代的效率也降低，出现了多处反复循环的迭代情况。

7.3.5 “最小方差”优化求解

在本节中，将利用非线性最小方差的方法来求解目标函数，关于

该方法的原理，前面章节已经介绍过，这里不再重复说明。下面详细

介绍计算步骤。

step 1
使用“最小方差”的优化类型，并且使用Gauss-Newton的优化算

法。在MATLAB的命令窗口中输入以下程序代码：

step 2
查看程序结果。在输入以上程序代码后，按“Enter”键，得到的结

果如下：



step 3
查看优化求解过程的图形。和前面类似，MATLAB会显示该优化

求解过程的图形，如图7.17所示。

图7.17 优化求解过程的图形

说明



和前面的优化方法相比，最小方差的求解方法对应的优化迭代次数最小，同时，迭代效

率最高，几乎没有任何反复的迭代情况出现。

7.4 绘制帐篷——复杂的二次规划

在本节中需要求解的规划问题有着明显的实际背景：假定某圆形

帐篷的形状是由某个约束条件的优化问题决定的，可以使用

Optimization Toolbox中的大型优化功能来解决这个优化问题。假定圆
形帐篷需要掩盖方形帐篷柱，具体来讲，帐篷有5个帐篷柱，上面搭着
弹性覆盖物。从这个结构中可以看出帐篷的原始形状，这个原始形状

对应的就是某能量函数的最小值，能量函数由帐篷表面的位置数据和

数据点的梯度的平方模决定。

从以上介绍可以看出，创建原始帐篷的过程就是求解二次规划的

过程，下面分步骤来详细介绍创建的过程。

7.4.1 设置约束条件

例7.11 使用二次规划的方法来创建原始帐篷的图形。

step 1
绘制原始帐篷的顶柱。在MATLAB的命令窗口中输入以下程序代

码：



step 2
查看程序代码的结果。在输入以上程序代码后，按“Enter”键，得

到的结果如图7.18所示。

图7.18 绘制帐篷的顶柱

说明

在图7.18中，largeL矩阵中的数值表示的是顶柱的高度数值，其中，中间顶柱的高度为

0.5，侧边的顶柱高度为0.3，这些顶柱将决定帐篷的主要形状。



step 3
绘制帐篷的下限约束表面。在MATLAB的命令窗口中输入以下程

序代码：

step 4
查看程序代码的结果。在输入了以上程序代码后，按“Enter”键，

得到的结果如图7.19所示。

图7.19 添加下限的曲面

step 5
设置帐篷的优化初始值，并可视化。在命令窗口中输入以下程序

代码：



step 6
查看程序代码的结果。在输入了以上程序代码后，按“Enter”键，

得到的结果如图7.20所示。

图7.20 设置优化的初始值表面

step 7
进行向量转换。为了将实际问题转换为标准的优化问题，需要重

新将以上矩阵转换为向量，经过转换后，L代表的是初始数值，sstart
表示的是下限。在命令窗口中输入以下程序代码：



step 8
查看程序代码的结果。在输入以上程序代码后，按“Enter”键，得

到的结果如图7.21所示。

图7.21 形状转换式例

7.4.2 定义目标函数



前面分析并绘制了帐篷的基本框架，同时分析了绘制帐篷的约束

条件。在本节中，将分析绘制帐篷这个规划问题的目标函数，并分析

其特点。

step 1
定义目标能量函数。根据前面的介绍，绘制帐篷的目标能量函数

为：

其中， 是能量函数的离散拟合，同时，其中的变量满

足lb≤x。在MATLAB的命令窗口中输入以下代码：

提示

根据以上定义，能量函数的每个数据点都只受最邻近的数据点的影响，这个主要特点保

证了Hessian矩阵H是一个稀疏矩阵，同时结构会比较特殊。同时，矩阵H的这种特性也保证了

可以使用large-scale算法来求解最优问题。

step 2
查看矩阵结构。在命令窗口中输入以下代码：

step 3
查看矩阵结构图形。在输入以上程序代码后，按“Enter”键，得到

稀疏矩阵的结构，如图7.22所示。



图7.22 稀疏矩阵的结构

7.4.3 进行优化求解

根据前面分析的目标函数和约束条件，本节将对该目标函数进行

求解。优化求解得到的将是符合约束条件和目标函数的数据的坐标。

在后面的章节中，将根据这些数据点坐标绘制帐篷的曲线。下面详细

讲解求解过程。

step 1
绘制数据点的相对位置。由于在后面的步骤中，在求解优化的时

候需要显示状态窗口，因此在进行优化运算之前，需要首先以样本数

据为例绘制其中的相对位置图形。在MATLAB的命令窗口中输入以下
程序代码：

step 2



查看绘制的结果。输入上面代码后，按“Enter”键，得到的图形如
图7.23所示。

图7.23 各个数据点的相对坐标

说明

在图7.23中，每个组件的坐标数值都是相对其上下限而绘制的，如果某个数据点达到了

其约束条件，则绘制成红色数据点；如果其严格处于上下限之间，则绘制为蓝色数据点。

step 3
绘制数据点的归一化的相对梯度。在命令窗口中输入以下程序代

码：

step 4



查看绘制结果。在输入上面代码后，按“Enter”键，得到的图形如
图7.24所示。

图7.24 各个数据点的相对单位梯度图形

说明

在图7.24中，当某组件的梯度在某个限度内接近0，则绘制为红色；其他的数据点则绘制

成蓝色。最后，在以上图形中，tentdata是示例数据，和本规划无关。

step 5
设置优化属性，进行优化求解。在命令窗口中输入以下程序代

码：

step 6
查看优化求解过程的图形。在以上程序代码中，首先设置需要显

示关于迭代过程的状态窗口，然后在该优化条件下，进行二次规划求



解，得到的“Progress Information”对话框如图7.25所示。

图7.25 显示迭代过程信息

提示

以上对话框是优化过程结束后的迭代信息，上面一个图形表示的就是各数据的相对位

置，下面一个图形表示的是各数据点的相对梯度。同时，在对话框的下方左侧显示了关于迭

代过程的主要信息。

step 7
查看优化信息的图形。同时，运行优化求解后，MATLAB还会显

示“Algorithm Performance Statistics”对话框，该对话框显示了关于优化
算法运行的各种信息，如图7.26所示。



图7.26 算法运行属性

说明

在图7.26中，主要显示了在优化过程中每次迭代运行的优化回归属性，具体的属性比较

复杂，在这里就不详细介绍了。

7.4.4 绘制优化求解的结果

本节将根据前面章节计算出来的优化结果，绘制出符合条件的帐

篷外形。下面详细讲解绘制的过程。

step 1
利用优化结果绘制曲面图。在命令窗口中输入以下程序代码：



step 2
查看程序代码的结果。在输入上面代码后，按“Enter”键，得到的

图形如图7.27所示。

图7.27 绘制求解的曲面图

step 3



设置帐篷表面的属性。在命令窗口中输入以下程序代码：

step 4
查看代码的结果。输入上面代码后，按“Enter”键，得到的图形如

图7.28所示。

图7.28 绘制的帐篷

7.5 小结

优化问题在实际的工作中应用十分广泛，在工程、投资、建设等

多个领域都有广泛使用。本章主要介绍了如何使用MATLAB求解常见
的优化问题，同时还介绍了如何使用遗传算法来求解优化。最后，还

介绍了两个比较典型的例子，来分析如何使用优化求解具体问题。

◆   ◆   ◆



第8章 常微分方程

本章包括

◆显性常微分方程

◆加权常微分方程

◆延迟微分方程

◆常微分方程的边界问题

 
常微分方程在工程和科学领域有着十分广泛的应用，许多工程的

模块都可以抽象成为常微分方程，但是限于当前的数学知识，大部分

的常微分方程都没有解析解，或者求取的解析解不方便后续的分析，

因此如何运用数值方法求解常微分方程将是十分重要的内容。

在MATLAB中，提供了多种数值求解常微分方程的命令，来求解
多种关于常微分方程的问题：初值问题、延迟微分方程和微分的边界

问题。在本章中，将分别使用具体的例子来介绍这些问题的求解方

法。

8.1 显性常微分方程

在数学理论中，显性常微分方程具有以下形式：

y′＝f（t，y） y（t0）＝y0

在以上公式中，y′、y和y0都是以变量t为参数的向量，其中y（t0）
＝y0就是该常微分方程的初值条件，微分方程需要求解的是y（t）。



尽管显性常微分方程在形式上具有统一性，但是在微分方程的性

质上有很大的区别，因此MATLAB对于求解常微分方程提供了多个命
令：ode45、ode23、ode113、ode15s、ode23s、ode23t和ode23tb等，以
下表8.1列出了各命令的使用情况。

表8.1 常微分方程组的解法

8.1.1 刚性和非刚性方程组

对于常微分方程，在求解过程中需要接触到一个十分重要的概念

——刚性（stiffness），一个常微分方程组的刚性将直接决定求解方法
和精度。如果微分方程的Jocabian矩阵的特征值相差悬殊，则这个方程
组被称为刚性方程组。对于刚性方程组，为了能够保持解法的稳定，

步长选取会很困难，因此有些方法将无法用来求解刚性方程组，而有

些方法由于对方程组的刚性要求不严，则可以用来求解刚性方程组。

具体来讲，MATLAB中常见的方法对刚性方程组的适用范围为：
 
◆ 刚性方程组：ode15s、ode23s、ode23b和ode23t（适合轻微刚

性）

◆ 非刚性方程组：ode45、ode23和ode113
 



在MATLAB中，用来求解显性常微分方程组的各种命令的调用格
式是完全一致的，为了叙述方便，下面在介绍解算命令时将用solver来
代替具体的命令，在实际运用时需要将solver改为对应的命令（例如
ode45），具体的调用格式如下：

 
◆ [t,Y] = solver(odefun,tspan,y0,options)
◆ [t,Y,TE,YE,IE] = solver(odefun,tspan,y0,options)
 
其中，各参数的具体含义如下：

 
◆ 参数“odefun”表示的是ODE函数的名称。
◆  参数“tspan”有两种可能，当tspan表示的是二元向量[t0，tf]

时，tspan是用来定义求解数值解的时间区间；当tspan表示的是多元向
量[t0，t1，…，tf]时，命令将会在tspan定义的时间序列进行数值求
解，此时tspan的元素必须按照单调次序排列。

◆ 参数y0表示的是微分方程的初始数值。
◆ 参数options用来设置算法的参数，当用户输入变量的个数为3

时，算法将会采用默认设置，options的具体数值可以由函数odeset来获
得。

◆ 参数t是所求数值解的自变量数据列向量。
◆ 参数Y表示的是所求微分方程的因变量数据矩阵。
◆ 参数TE，YE，IE只有在设置了“Event”记录时，才有对应的输

出数据。

 
关于常微分方程的属性设置options和“Event”记录属性的内容，都

将在后面的章节中详细介绍，这里就不展开分析了。

例8.1 使用MATLAB的命令来求解非刚性方程组的数值解：



其中初值条件为：y1（0）＝0，y2（0）＝1和y3（0）＝1。

step 1
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：

在输入程序代码后，将函数保存为“euler.m”文件，该函数将是微
分方程组函数。

step 2
在MATLAB的命令窗口中输入以下命令：

step 3



查看程序代码的结果。在输入以上程序代码后，按“Enter”键，得
到的结果如图8.1所示。

图8.1 微分方程的数值解

这个例子比较简单，但是基本上演示了求解常微分方程的步骤：

step 1
把t和Y作为输入变量，将Y′作为输出变量，编写常微分方程的M

文件。

step 2
设置微分方程求解的参数：时间跨度、初始数值和求解器参数

等。

step 3



调用合适的微分方程求解命令，求解以上微分方程，得到数值

解。

说明

由于MATLAB进行的微分方程求解得到的都是数值解，而无法得到解析解。为了显示这

些数值解的变化情况，经常需要借助MATLAB的图形功能，这部分的内容请查看相应的章

节。

 
例8.2 使用MATLAB的命令来求解下面刚性方程组的数值解：

其中初值条件为：y1（0）＝1、y2（0）＝0和y3（0）＝0。

step 1
选择命令窗口编辑栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：

在输入程序代码后，将函数保存为“stiffex1.m”文件，该函数将是
微分方程组函数。

step 2
在MATLAB的命令窗口中输入以下命令：



step 3
查看程序代码的结果。在输入以上程序代码后，按“Enter”键，得

到的结果如图8.2所示。

图8.2 常微分方程的数值解

说明

在以上方程组中，由于其jacobian矩阵的特征值相差比较大，因此属于刚性方程组，需要

使用ode15s命令进行求解，读者可以自行尝试使用ode45命令求解的方法。



8.1.2 设置允许误差属性

前面讲过的需要求解的微分方程比较简单，因此在求解过程中并

没有设置解法器参数options，但是如果需要求解的微分方程比较复
杂，则需要根据情况来设置相应的参数。在MATLAB中，可以设置各
种解法器属性的参数，例如允许误差参数、输出参数、Jacobian矩阵参
数和步长参数等。

在详细介绍各种解法属性之前，首先使用命令来定义各种属性。

在MATLAB中，定义解法器参数的命令为odeset函数，其常用的调用
格式如下：

 
◆ options = odeset('name1',value1,'name2',value2,...)，用参数名称

和参数数值来分别定义解法器的各种参数。

◆  options = odeset(oldopts,'name1',value1,...)，修改原来解法器
options结构体oldopts，改变的是指定参数的数值。

说明

在设置解法器的属性参数之前，有必要首先了解各参数的默认数值，可以使用odeset命令

来查看所有属性的默认数值。

 
下面将详细介绍各种解法器参数的设置。其中，允许误差（Error

Tolerance）参数如表8.2所示。

表8.2 允许误差的属性参数



说明

关于微分方程的计算误差理论比较复杂，需要了解的是，对于同一个微分方程的问题，

设置不同的误差属性，会直接影响方程的求解时间和效率。

 
例8.3 设置允许误差的属性，重新求解例8.1中的非刚性微分方程

组。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看程序代码的结果。在输入以上程序代码后，可以查看两种属

性条件下所消耗的时间：



说明

从以上结果可以看出，通过设置误差属性，求解该微分方程所用时间为0.01s，而使用默

认的误差属性所用的时间为0.03s。

step 3
比较两种方法的精度。在MATLAB的命令窗口中输入以下命令：

说明

从以上结果可以看出，使用设置误差属性后的时间间隔数为85，使用默认属性的时间间

隔数为77，因此，设置误差后的精度比默认情况要高。

step 4
绘制设置解法器属性后的数值解图形。在命令窗口中输入以下命

令：



step 5
查看程序代码的结果。在输入以上程序代码后，按“Enter”键，得

到的图形如图8.3所示。

图8.3 设置属性后的图形

说明



从图8.3可以看出，该图形和默认属性条件下求解的图形在外观上没有太大的区别，这是

因为精度差别不能在外观上显示比较出来。

8.1.3 设置输出参数属性

在MATLAB中，解法器输出（Solver Output）参数如表8.3所示。

表8.3 解法器输出的属性参数

说明

在参数“OutputFcn”中，除了可以使用odeplot命令之外，还可以使用odephas2、odephas3

和odeprint等函数命令，也可以自行编写对应的绘制函数。

 
例8.4 设置解法器输出的属性，重新求解例8.1中的非刚性微分方

程组。

step 1
使用默认属性。在MATLAB的命令窗口中输入以下命令：



step 2
查看程序代码的结果。在输入以上程序代码后，按“Enter”键，得

到的结果如图8.4所示。

图8.4 默认输出条件下的图形

step 3
重新设置输出属性，并求解微分方程。在命令窗口中输入以下命

令：

step 4
查看程序代码的结果。在输入以上程序代码后，按“Enter”键，得

到的结果如图8.5所示。



图8.5 修改输出属性后的图形

同时，在MATLAB的命令窗口中显示求解的各种信息：

提示

如果不希望采用系统默认的绘制函数，可以使用两种方法进行修改：在默认绘图函数的

基础上，进行必要的修改，得出自行编写的绘图函数；在使用默认函数绘制的图形上，使用

绘图命令进行必要的编辑。

step 5
查看默认函数的程序代码。如果希望使用第一种方法来编写绘图

函数，首先需要分析默认函数的程序代码，以函数“odeplot”为例，其
默认的保存路径为…MATLAB7.0\toolbox\matlab\funfun，其程序代码
如下：







说明

可以从上面程序代码中选择相应位置，修改图形的相关属性，然后保存函数就可以设置

用户自定义的函数，具体的做法这里不再介绍。

8.1.4 设置解法器其他属性

关于解法器的其他属性，这里就不详细介绍了。感兴趣的读者可

以查阅MATLAB中的相关帮助文件，下面选择一个比较综合的例子说
明如何设置属性，来求解具体的实例。

例8.5 求解小球反弹的轨迹模型，该小球在反弹后速度变为下落
速度的90％，使用微分方程来求解小球运动的轨迹。



step 1
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：

在输入以上程序代码后，将其保存为“bounce.m”文件。

step 2
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：

输入以上程序代码后，将其保存为“events.m”文件，该函数为该微
分方程的求解过程中的“定位事件”函数，这个函数将在ode相关命令运
行时被调用。

step 3
进行微分方程的求解。在MATLAB的命令窗口中输入以下代码：



step 4



查看程序代码的结果。在输入以上程序代码后，按“Enter”键，得
到的图形如图8.6所示。

图8.6 小球运动轨迹图形

8.2 加权常微分方程

加权常微分方程的通用形式如下：

M（t，y）y′＝f（t，y） y（t0）＝y0

在该方程中，M（t，y）被称为加权函数，是一个矩阵。矩阵中
的元素包含了y和t两个变量，并且一般无法转换为一维函数，否则就
可以直接转换为右侧的函数表达式。在MATLAB中，求解加权常微分
方程的步骤大致如下：

step 1
编写加权函数M（t，y）的M文件。

step 2



通过odeset命令设置微分方程的“mass”属性。

step 3
选择合适的ode类函数来求解微分方程。
 
在本节中，将以一个比较简单的例子来说明如何求解加权常微分

方程。

例8.6 求解以下加权常微分方程，其中

同时，微分方程函数如下：

根据以上微分方程的参数矩阵，其对应的微分方程组如下：



在以上方程组中，（X，Y）表示的是物体的坐标数值，θ表示物
体运动的角度，同时对应的初始数值为y0＝[0；4；2；20；π/2；2]。

step 1
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：

在输入以上程序代码后，将其保存为“mass.m”文件，该文件将是
在后面的步骤中调用的加权函数。

step 2
选择命令窗口菜单栏中的“File”→“New”→“M-File”命令，打开M

文件编辑器，在其中输入以下程序代码：



在输入以上程序代码后，将其保存为“massode.m”文件，该函数代
码将是在后面的步骤中需要求解的微分方程组。

说明

在以上两个函数中，都使用到了外部参数m1、m2、L和g，这些参数都将在后面步骤中通

过程序代码进行赋值。

step 3
在MATLAB的命令窗口中输入以下程序代码：



step 4
查看程序代码的结果。在输入以上程序代码后，按“Enter”键，得

到的结果如图8.7所示。



图8.7 微分方程的数值解

说明

在MATLAB中，除了可以解决加权常微分方程（又被称为线性隐式常微分方程）之外，

还可以解决完全隐式常微分方程，对应的命令是ode15i，同时设置该隐式常微分方程初始条

件的命令是decic。关于这两个命令的详细内容请查看帮助文件。

8.3 延迟微分方程

在数学理论中，延迟微分方程具有以下形式：

y（t）＝f（t，y（t），y（t－τ1），…，y（t－τk））

在该函数表达式中，时间跨度区间为[t0，tf]，τ1，…，τk都是常

数，表示的是正的时间延迟，同时满足t0＜tf。
在MATLAB中，求解延迟微分方程的命令为dde23，其完整的调

用格式如下：



各参数的具体含义如下：

 
◆ ddefun：代表的是延迟微分方程的M文件函数。其具体的格

式为dydt = ddefun(t,y,Z)，其中t代表的是当前时间数值，y是列向量，
Z（:，j）代表y（t－τj）。

◆ lags：代表的是时间延迟向量，kτ保存在变量lags（k）中。
◆ history：代表的是y在时间t0之前的数值，可以使用3种方式来

定义history：使用函数y（t）来定义y在时间t0之前的数值；使用一个
常数向量来定义y在时间t0之前的数值，此时y在时间t0之前的数值被认
为是常数；使用前一个时刻的方程解sol来定义y在时间t0之前的数值。

◆ tspan：代表时间跨度区间为[t0，tf]，函数将返回时间段的延
迟微分方程的数值解。

◆ options：关于解法器的参数，可以使用ddeset函数来定义。

说明

上面命令的返回数值sol是一个结构体变量，具有7个属性数值，可以使用相应的程序代码

命令来查看具体的属性参数。

 
例8.7 求解以下延迟微分方程组：

同时，该方程各变量的历史数据满足y1（t）＝y2（t）＝y3（t）＝
1，其中t≤0，求解的时间区间为[0，5]，延迟的数据量为[1，0.2]。

step 1



编 写 微 分 方 程 的 代 码 。 选 择 命 令 窗 口 菜 单 栏 中

的“File”→“New”→“M-File”命令，打开M文件编辑器，在其中输入以
下程序代码：

在输入以上程序代码后，将其保存为“ddexlde.m”文件，该文件将
是在后面的步骤中调用的微分方程组。

step 2
编 写 历 史 数 据 的 代 码 ， 选 择 命 令 窗 口 菜 单 栏 中

的“File”→“New”→“M-File”命令，打开M文件编辑器，在其中输入以
下程序代码：

在输入以上程序代码后，将其保存为“ddexlhist.m”文件，该文件
将是在后面的步骤中调用的历史函数。

step 3
求解微分方程。在MATLAB的命令窗口中输入以下代码：

step 4



查看程序代码的结果。在输入以上代码后，按“Enter”键，得到的
结果如图8.8所示。

图8.8 微分方程的数值解

说明

在以上程序代码中，通过sol.x和sol.y来引用命令dde23求解的数值，然后使用绘图命令绘

制对应的结果图形。

8.4 常微分方程的边界问题

一般情况下，微分方程的边界问题可能有解，也可能无解，可能

有唯一解，也可能有无数解。在本节中讨论的问题主要局限在有唯一

解的范围内。在有唯一解的情况下，求解边界问题有三种基本的方

法：

 



◆ 叠加法：假设微分方程和边界条件都是线性的，问题可以转
换为可以使用ode类命令求解的初值问题。

◆ 试射法：问题转换为对漏缺的初值的搜索问题，一旦漏缺的
初值被确定，问题就会转换为初值问题。

◆ 松弛法：首先猜测满足边界条件的区间网点上的解值，然后
利用微分方程进行迭代改善。

8.4.1 MATLAB求解边界问题——bvp4c命令

在MATLAB中，提供了bvp4c命令来求解边界问题，该命令使用
的是有限元方法，属于松弛法，所得到的精度比较均匀。将常微分方

程组整理成以下形式：

同时，满足的边界条件为g（y（a），y（b））＝0。其中a和b是
微分方程求解区间的上限和下限，也就是y在[a，b]中进行数值求解。
更一般的情况是，MATLAB还可以求解带有未知参数的微分方

程，其具体形式如下：

其中参数满足的边界条件为g（y（a），y（b），p）＝0，变量p
是未知参数，需要通过边界条件来充分决定。

MATLAB中求解微分方程的相关命令如下：
 
◆ solinit = bvpinit(x,yinit,parameters) 生成bvp4c命令所必需的

猜测数据网格。



◆ sol = bvp4c(odefun,bcfun,solinit,options) 给出微分方程边界
问题的数值解。

◆ sxint = bvpval(sol,xint) 计算微分方程积分区间内任何一点
的解值。

 
下面详细介绍各命令的参数含义：

 
◆ 在bvpinit命令中，变量x的含义是对指定边界区间[a，b]上的

初始网格；yinit则是对数值解的初始猜测数值，可以是常数向量或者
函数向量。当yinit是常数向量时，表示解分量中所在所有初始网点上
的猜测值都会取yinit；当yinit是函数向量时，表示在解向量所有分量
所在的网点上取值为函数值。

◆ 在命令bvp4c中，odefun表示计算导数的M函数文件，其格式
为dydx=odefun(x,y)，或者包含未知参数的格式dydx=odefun(x,y,p)；
bcfun是描述边界条件的函数，其具体格式为res=bcfun(ya,yb)，或者包
含未知参数的格式res=bcfun(ya,yb,p)；solinit表示的是对方程解的猜测
解，它是一个结构体，包含x、y和p三个属性，可以由bvpinit命令获
得。

◆ 在命令bvpval中，sol是bvp4c的输出变量，xint则是需要计算
区间的参数数值。

说明

命令bvp4c的输出结果sol，同样是结构体变量，可以使用结构体的相关命令来引用求解的

结果，然后进行后续的处理。

8.4.2 求解带边界的常微分方程



例8.8 求解以下微分方程：

同时该方程的边界条件为y′（0）＝0，

根据相关的数学知识可知，该微分方程有解析解，表达式为

，因此在本例中可以将数值求解得到的数值和该表达式中的数

值进行对比。

step 1
编 写 微 分 方 程 的 代 码 。 选 择 命 令 窗 口 菜 单 栏 中

的“File”→“New”→“M-File”命令，打开M文件编辑器，在其中输入以
下程序代码：

在输入以上程序代码后，将其保存为“emdenode.m”文件，该文件
将是在后面的步骤中调用的微分方程组。

step 2
编 写 边 界 条 件 数 据 的 代 码 。 选 择 命 令 窗 口 菜 单 栏 中

的“File”→“New”→“M-File”命令，打开M文件编辑器，在其中输入以
下程序代码：

在输入以上程序代码后，将其保存为“emdenbc.m”文件，该文件将
是在后面的步骤中调用的边界条件函数。



step 3
求解微分方程。在MATLAB的命令窗口中输入以下代码：

step 4
查看代码的结果。输入以上代码后，按“Enter”键，得到的结果如

图8.9所示。



图8.9 微分方程求解的图形结果

说明

在以上结果中，使用微分方程求解得到的是数值的唯一解，但是这并不是普遍情况，并

不是所有的边界问题都能得到唯一解。

 
例8.9 求解以下微分方程：

同时该方程满足边界条件为y（0）＝0和y（4）＝−2。

step 1
编 写 微 分 方 程 的 代 码 。 选 择 命 令 窗 口 菜 单 栏 中

的“File”→“New”→“M-File”命令，打开M文件编辑器，在其中输入以
下程序代码：



在输入以上程序代码后，将其保存为“twoode.m”文件，该文件将
是在后面的步骤中调用的微分方程组。

step 2
编 写 边 界 条 件 函 数 的 代 码 。 选 择 命 令 窗 口 菜 单 栏 中

的“File”→“New”→“M-File”命令，打开M文件编辑器，在其中输入以
下程序代码：

在输入以上程序代码后，将其保存为“twobc.m”文件，该文件将是
在后面的步骤中调用的边界条件函数。

step 3
求解微分方程。在MATLAB的命令窗口中输入以下代码：



step 4
查看程序代码的结果。在输入以上程序代码后，按“Enter”键，得

到的第一个数值结果如图8.10所示。



图8.10 第一个数值求解的结果

由于该微分方程有两个数值解，两个数值解的结果如图8.11所
示。

图8.11 两个数值解的图形

说明



从以上结果可以看出，在对应的微分方程和边界条件下，解出了两个满足条件的数值

解。

8.5 小结

常微分方程在工程和科研中应用越来越广泛，许多实际问题最后

都归结为常微分方程问题。利用MATLAB可以对常微分方程进行数值
求解，并提供多种命令，用于处理常微分方程的边界问题。

◆   ◆   ◆



第9章 符号计算

本章包括

◆符号对象

◆符号表达式

◆符号函数

◆符号微积分

◆符号代数方程组

◆符号微分方程

◆符号积分变换

◆利用maple

 
在MATLAB中，符号计算可以用推理解析的方式进行，避免数值

计算带来的截断误差，同时符号计算可以得到正确的封闭解或者精确

的数值解。而且，在MATLAB 7.0中调用符号计算的命令十分简单，
和读者在教科书中使用的公式符号大体相同，可以十分容易地被接

受。

在MATLAB中，符号数学工具箱（Symbolic Math Toolbox）中的
工具都是建立在数学计算软件maple的基础上的。因此，如果在
MATLAB 7.0中进行符号运算，MATLAB会调用maple进行运算，然后
将结果返回到MATLAB 7.0的命令窗口中。正是因为这个原因，当
MATLAB 7.0进行软件升级时，符号计算工具箱也随之升级，这些升
级内容对于普通用户来说，差别还是比较细微的，对于有比较大变化

的地方，在本章的相关位置也会分别给出说明。



在MATLAB中，符号运算实质上属于数值计算的补充部分，并不
能算是MATLAB的核心内容。但是，关于符号计算的命令、符号计算
结果的图形显示、计算程序的编写或者帮助系统等，都是十分完整和

便捷的。

9.1 符号对象和符号表达式

在科学工程中，数值运算是十分重要的内容，但是自然科学理论

中，各种公式、表达式以及相应的推导等也是十分重要的，这些就是

符号运算解决的重点内容。在MATLAB中，数值和数值变量用于数值
的存储和各种计算，而符号对象、变量、函数以及相应的操作都是用

来形成符号表达式，然后按照相关数学内容的规则进行运算，得出相

应的解析解。

9.1.1 创建符号对象——使用sym命令

和在MATLAB中使用数值计算一样，使用数值表达式的变量必须
首先进行变量赋值，否则MATLAB会返回变量错误信息。符号数学工
具箱也沿用该规则，也就是说，在进行符号运算之前，首先需要定义

符号对象，然后利用这些符号对象去构建表达式，最后才能进行符号

运算。

从以上介绍可以看出，创建符号对象是进行符号运算的基础，

MATLAB提供了多种创建符号对象的命令。数值、字符串、符号对象
是MATLAB中常见的三种变量，MATLAB提供了将数值或者字符串变
量转化为符号对象的方法，同时也提供了将符号对象转换成为数值或

者字符串变量的方法。



本节首先介绍如何创建符号对象，关于其他的转换方法将在后面

小节中详细介绍。定义符号对象的常见命令是sym，常见的调用格式
如下：

在以上调用格式中，使用sym命令创建了符号对象Sym1和Sym2。
下面详细介绍这两种调用格式的含义。

Sym1=sym(argn,flagn)将数值或者数值表达式转换为符号对象
Sym1，参数flagn的作用是定义转换的符号对象应该符合的格式，其具
体的选项和含义如下：

 
◆ 'd' 用最接近的十进制浮点精确表示。
◆ 'e' 当表示数值计算时，带估计误差的有理表示。
◆ 'f' 用十六进制浮点表示。
◆ 'r' 这是MATLAB的默认设置，用最接近有理表示的形式。
 
表达式Sym2=sym('argv',flagv)将指定的字符串变量argv转换为符号

对象Sym2，参数flagv的作用也是定义转换的符号对象应该符合的格
式，其具体的选项和含义如下：

 
◆ 'positive' 限定A表示为正的实型符号变量。
◆ 'real' 限定A为实型符号变量。
◆ 'unreal' 限定A为非实型符号变量。
 
例9.1 将数值或者数值表达式转化为符号对象，使用不同的转换

格式。

step 1



在MATLAB的命令窗口中输入下列内容：

step 2
按“Enter”键，就会得到这段代码的结果，如图9.1所示。

在以上程序中，分别将数值3/4，数值表达式log(10)、exp(2)等转
换为符号变量，差别在于不同的转换格式。根据以上结果，可以看出

转换格式对结果的影响。

step 3
查看程序结果的信息。在以上结果中，sym1～sym4都是符号变

量，而my_sym则是符号矩阵，可以在MATLAB中输入whos来查看这
些变量的类别和大小：

注意



前面已经介绍过MATLAB将数值或者表达式转换为符号变量时，默认格式是r，因此，如

果不使用格式转换参数，得到的结果就是变量sym4。以上结果并不存在实质上的优劣，应该

根据需要选择转换的格式。

 

例9.2 在MATLAB中，使用符号变量验证积分等式

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
在MATLAB的命令窗口中输入“Integral”，然后按“Enter”键，就会

得到如下所示的结果：

在MATLAB中，对数Ln用自然对数Log表示。因此，上面程序代

码得到的结果就是

。整个程序代码相当于以下等式： ，因此也就证明

了积分等式

由于积分结果是对数函数，为了让最后的结果在数学上有意义，

在以上程序代码中将积分变量定义为正的实型符号变量，因此格式参

数为positive。而积分上下限则是实数型的，因此格式参数为real。

说明

本实例中，使用积分符号int进行符号运算，在MATLAB中还提供了其他运算符号进行符

号运算，这些符号和经典教科书中的符号大致类似，这些内容将在后面详细介绍。



 
例9.3 在MATLAB中，使用不同的格式输入符号变量，并比较不

同格式间的差异。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
在MATLAB的命令窗口中输入“sd”，然后按“Enter”键，就会得到

如下所示的结果：

在以上程序代码中，显示了在MATLAB中定义符号变量的常用方
法，建议读者使用第一种创建方法，这是因为这种创建方法在任何版

本的符号工具箱中都适用，而且产生的符号数值表示是绝对准确的。

提示

尽管从以上演示结果来看，使用第一种和第二种方法创建的结果相同，但是还是建议使

用第一种方法，因为使用符号计算比较占用计算机的资源，第一种创建方法比较节省资源。

9.1.2 创建符号对象——使用syms命令

除了前面介绍的sym命令，MATLAB还提供了syms命令来创建符
号对象，这个命令是sym命令的快捷方式，使用起来比sym命令更加简



捷，并且可以同时将多个变量创建为符号对象，下面将详细介绍如何

在MATLAB中使用syms命令。
在MATLAB中，syms命令的常见调用格式如下：

在以上调用格式中，arg1、arg2…表示的是变量，可能是数值变量
也可能是字符串变量，而flagv表示的是转换格式，和sym命令相同。
例9.4 使用syms命令创建符号变量。

step 1
在MATLAB的命令窗口中输入下列内容：

说明

在以上程序语句中，第一行代码clear all的作用是删除内存中储存的所有变量，这样在程

序的最后可以使用whos命令查看由syms创建的符号变量。

step 2
按“Enter”键，就可以得到如下所示的结果：

从以上结果可以看出，使用syms命令可以同时将三个变量设置为
符号变量。实际上代码syms alpha beta thro real相当于以下几行代码：

这两种代码得到的结果是完全相同的，因此如果灵活使用syms命
令，就可以省略烦琐命令，这符合MATLAB符号运算简捷的特点。



使用sym和syms都可以创建符号对象或者是符号变量，下面介绍
MATLAB中关于符号变量的命名规则。符号变量也是MATLAB中的常
见变量类型，其命名规则和数值变量规则相同，主要规则如下：

 
◆ 变量名可以由英文字母、数字或者下画线组成。
◆ 变量名必须由英文字母开始。
◆ 组成变量名称的字符长度不能超过31。
◆ MATLAB会区别变量名称的大小写。

9.1.3 符号计算的运算符和函数

现在已经知道如何在MATLAB中创建符号对象，但是，仅仅创建
符号对象还不能利用MATLAB中的符号资源，如果希望使用MATLAB
解决更丰富的符号问题，则需要创建符号表达式。

和数值表达式一样，构成符号表达式的基础元素是运算符和函

数。无论在形式、名称上，还是在使用方式上，符号运算的运算符和

函数与数值计算几乎完全相同，这些相同的地方会给用户在MATLAB
编程上带来极大的方便。下面简单介绍符号计算中的运算符和函数的

使用方法：

 
◆ 基础运算符：对于加、减、乘、左除、右除、求幂等计算，

符号运算和数值运算的符号和使用方法完全相同；同时，对MATLAB
中特有的点乘、点除等特殊计算方式，符号运算同样支持。

◆  关系运算符：MATLAB的符号运算提供了两种关系运算
符：“= =”和“～ =”，分别表示两个符号对象相等和不等。关系运算符
返回的是逻辑值1和0，1表示关系运算成立，0则表示关系运算不成
立。



◆ 三角、双曲函数：在MATLAB中，除了函数atan2只能用在数
值运算之外，所有的三角函数、双曲函数以及对应的反函数，都可以

用在符号运算中。

◆ 指数、对数函数：在MATLAB中，指数函数可以通用于数值
运算和符号运算中。但是对于对数函数，在符号运算中只能使用log函
数，而不能使用log2和log10函数。

◆ 复数函数：在MATLAB中，关于复数的共轭、实部、虚部和
求模等，在符号运算和数值运算中完全相同。但是，在符号运算中，

没有提供求相角的函数。

◆ 矩阵代数命令：在MATLAB中，关于矩阵代数命令在数值运
算和符号运算中几乎完全相同，只是关于求解奇异解的svd命令有所不
同，将在后面章节中详细介绍。

注意

在创建符号表达式之前，有必要了解构建表达式的符号和函数，这样就不会在后面的步

骤中造成不必要的错误，例如不应该使用ln函数而应该使用log函数，否则会返回错误信息。

9.1.4 识别对象

在MATLAB中，数值对象、字符串对象和符号对象都是常见的对
象类型，都分别有着不同的运算规则，但有时这些不同的对象类型在

外观上没有太大的区别，为了避免用户在使用过程中造成混淆，

MATLAB提供了识别不同对象类型的命令。常见的识别对象命令有
class、isa和whos等，可以根据需要来选择不同的命令，识别不同的对
象。下面将使用一个简单的案例来说明如何使用这些命令。

例9.5 使用MATLAB命令来识别不同的对象类型。



step 1
在MATLAB的命令窗口中输入下列内容：

在以上程序代码中，分别创建了数值、字符串和符号对象，这

样，在后面的步骤中可以使用命令来识别不同的对象。

step 2
使用class命令来判断不同的对象类型，在命令窗口中输入下列内

容：

在以上程序代码中，使用class命令来判断上面步骤中创建的对象
类型，得到的结果是double（双精度）、char（字符串）和sym（符号
对象）。

注意

通过class命令判断的对象类型结果是字符串变量，也就是说class(my_number)返回的结果

是字符串“double”，为了创建字符串数组需要使用char命令。

step 3
使用isa命令来判断不同的对象类型，在命令窗口中输入下列内

容：



在以上程序中，通过使用isa命令来判断变量的类型，返回逻辑值
1说明上面程序的判断是正确的，也就是说my_number是双精度
（double）类型，my_char是字符串（char）类型，my_sym是符号
（sym）类型。

step 4
使用whos命令来判断不同的对象类型，在命令窗口中输入下列内

容：

之所以输入的命令是“whos my_char my_number my_sym”，而不是
直接输入命令“whos”，是因为在前面的步骤中创建了其他变量，为了
简化查询结果，就直接查询上面三个变量的类型。

9.1.5 确定符号表达式中的变量

为了简化符号对象的操作和计算，MATLAB为用户提供了findsym
命令，可以实现对符号表达式中符号变量或者指定数目的变量的确

定。其常见的调用格式如下：

 
◆ r = findsym(S) 确定符号表达式或者矩阵S中自由符号变量。



◆ r = findsym(S,n) 确定符号表达式或者矩阵S中靠x最近的n个
独立符号变量。

 
例9.6 使用MATLAB的命令来确定符号表达式中的变量。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
确定下面简单符号表达式中的符号变量信息：

step 3
确定下面简单符号表达式中的符号变量信息：

step 4
确定下面简单符号表达式中的符号变量信息：

从以上简单实例中可以看到findsym函数的使用方法和其使用范
围，在实际应用中可以灵活使用该命令。

9.2 符号精度计算



前面的章节中，已经介绍过符号计算的一个重要特点就是计算过

程中不会出现舍入误差，可以进行任意精度的计算。也就是说，如果

希望计算结果精确，那么就应该牺牲计算时间和存储空间，使用符号

计算来得到足够高的计算精度。在MATLAB的符号计算工具箱中，提
供了三种不同类型的计算精度：

 
◆ 数值类型：MATLAB 7.0中的浮点算术计算。
◆ 有理数类型：MAPLE中的精确符号计算。
◆ VPA类型：MAPLE的任意精度算术计算。
 
这三种不同的运算方式各有利弊，需要在使用过程中根据计算精

度、时间和存储空间的要求，选用不同的计算精度。

例9.7 在MATLAB中，使用不同的精度计算数学表达式。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
在MATLAB的命令窗口中依次输入var_float、var_char，查看计算

结果如下：

step 3



使用whos命令查看不同结果的数据类型，得到的结果如下：

从以上运算结果中可以看出，浮点运算结果var_float并不精确，
但是计算所占的内存最小，而且运算速度最快。在MATLAB 7.0中，
双精度输出的数字位数由format命令控制。在以上运算过程中，存在
着三种计算误差：第一种误差来自于由计算1/3的除法舍入误差，第二
种误差来自于相加得到的舍入误差，第三种误差来自于二进制转换为

十进制的结果。

而另外一面，符号运算结果var_char则十分精确，但是所需要的时
间和占用的内存资源都是很大的。而且，通过最后的命令可以看出，

符号计算得出的结果都是字符串，尽管从形式上是数值，但是在变量

类型上还是字符串。

如果需要从精确解中获得任意精度的解，并改变默认的精度，把

任意精度符号解变成数值解，需要使用MATLAB 7.0提供的命令：
digits和vpa，这两条命令的调用格式如下：

 
◆ digits(d) 设置今后数值计算以d位相对精度进行。
◆ digits 显示当前采用的数值计算精度。
◆ R = vpa(A) 在digits指定的精度下，给出A的数值型符号结果

R。
◆ R = vpa(A,d) 在d位相对精度下，给出A的数值型符号结果

R。

注意



除了使用vpa(A,d)命令指定精度之外，所有vpa(A)的精度都会受前面的digits命令控制，其

默认精度是32。而且其变量A既可以是符号对象，也可以是数值对象，但是命令运行后得到

的结果都是符号对象。

 
例9.8 在MATLAB中，显示不同的显示精度。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
在MATLAB中输入“[s1；s2；v1；v2]”后，按“Enter”键，查看运算

的结果。

step 3
在MATLAB中输入“digits”后，按“Enter”键，结果如下：

注意

尽管在命令行v2=vpa(abs(s1-s2),64)中将精度改为64，但是这个命令并没有改变全局的符

号数值，因此digits命令得到的结果还是默认的数值32。



9.3 操作符号表达式

从前面的介绍可以发现，符号运算的结果一般比较繁杂，不直

观，为此MATLAB为用户提供了处理符号表达式和函数的操作命令，
例如因式分解、展开、简化等，这些命令都可以增加符号表达式的可

读性。这些命令的共同点是它们完成的都是符号表达式的恒等变换，

MATLAB提供了多个函数，如collect、expand、factor、horner等，灵
活使用这些命令，可以增加符号表达式结果的可读性，下面将分别详

细介绍这些函数的用法和应用。

9.3.1 合并表达式——collect函数

在MATLAB中，collect函数的调用格式如下：
 
◆ R = collect(S) 将表达式S中相同次幂的项合并，S可以是表

达式或者符号矩阵。

◆ R = collect(S,v) 将表达式S中v的相同次幂项合并，v的默认
值是x。

 
该函数实现的功能是符号表达式中的同类项合并。

例 9.9  在 MATLAB 中 ， 按 照 不 同 的 方 式 合 并 表 达 式
中的参数同类项。

step 1
在MATLAB的命令窗口中输入下列内容：



step 2
在MATLAB中输入“R=[R1；R2；R3]”后，按“Enter”键，查看使用

不同方式合并的结果：

step 3
在MATLAB中输入“RM=collect(Exper)”后，查看MATLAB默认情

况下的合并类型，得到的结果如下：

step 4
重新输入表达式，将Exper表达式中的符号改为w、 t，查看

MATLAB合并的不同的结果，得到的结果如下：

step 5
分析以上计算结果：



从step 2的结果可以看出，当使用不同的合并条件时，同样的符号
表达式会得出不同的结果，因此在实际应用中应该根据需要选择不同

的合并条件。

从step 3的结果可以看出，MATLAB的默认合并条件是按照变量x
进行合并，因此RM和R1得到的表达式完全相同。
从step 4的结果可以看出，当表达式中没有变量x的时候，

MATLAB会按照首先出现的符号变量进行同类项合并。

注意

合并同类项的函数collect功能只能是按照参数进行合并，结果未必比原来的表达式更加简

单。如果希望简化其表达式，还需要使用其他简化命令。

9.3.2 展开表达式——expand函数

在MATLAB中，expand函数的功能是将符号表达式展开，其调用
格式如下：

参数表达式S中如果包含函数，MATLAB会利用恒等式变形将其
写成相应的和形式。这个展开函数主要用于多项式、三角函数、指数

函数和对数函数。

例9.10 在MATLAB中，使用expand对各种类型函数进行展开。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2



在MATLAB中输入“R＝[R1；R2；R3]”后，按“Enter”键，查看使
用不同方式合并的结果：

从以上实例可以看出，MATLAB中的expand函数可以使用多项
式、三角函数、指数函数或者对数函数中的恒等式进行展开，得到关

于各个符号变量的最简表达形式。

其中，前面两个等式分别来自于以下恒等式：

注意

展开函数expand同样有其使用范围，MATLAB并不能解决所有的恒等式变换的问题，除

了上面例子中演示的函数类型，其他复杂的恒等式MATLAB将无法处理。

9.3.3 因式分解——factor函数

在MATLAB中，factor函数的功能是将符号多项式进行因式分解，
其调用格式如下：

其中S是多项式或者多项式矩阵，系数是有理数，MATLAB会将
表达式S表示成为系数为有理数的低阶多项式相乘的形式；如果多项
式S不能进行在有理数范围内因式分解，该函数会返回S本身。
例9.11 在MATLAB中，演示如何在有理数范围内对多项式xn－

yn进行因式分解，其中n是[1，8]范围内的整数。



step 1
在MATLAB的命令窗口中输入下列内容：

step 2
在MATLAB的命令窗口中输入“f”，然后按“Enter”键，就可以得到

相应的结果：

从中可以看出，MATLAB中的factor命令是在有理数范围内进行因
式分解的，例如x8－y8＝（x－y）（x＋y）（x2＋y2）（x4＋y4），分

解的结果中因子（x4＋y4）在有理数范围内无法继续分解，但是在实

数范围内却可以继续分解。

注意

以上实例演示了factor函数在多项式中的应用，除了可以在对项式中有着强大的分解能

力，factor函数还可以在正整数质数分解中广泛应用，可以使用该命令对实数进行质数分解。

 
例9.12 在MATLAB中对正整数系列f（n）＝10n－1进行质数分

解，其中n是[1，9]范围内的整数。

step 1



在MATLAB的命令窗口中输入下列内容：

step 2
在MATLAB的命令窗口中输入“f”，然后按“Enter”键，就可以得到

相应的结果：

在以上程序代码中，使用factor命令求解了上面所有数值的质数分
解结果，最后一行程序代码中则使用了conj命令求得复数的共轭。

提示

实际上，具有整数分解功能的函数 factor并不属于符号工具箱（ Symbolic Math

Toolbox），而是属于特殊数学函数工具箱（MATLAB Function），但是两个函数名称都是

factor。因此，当使用该函数时，MATLAB会调用数学函数工具箱（MATLAB Function）中的

factor函数。

9.3.4 嵌套表达式——horner函数

在MATLAB中，horner函数的功能是将符号表达式转换为嵌套形
式，调用格式如下：



其中P是符号多项式矩阵，函数horner将其中每个多项式转换成它
们各自的嵌套形式。

例9.13 在MATLAB中演示对多项式的嵌套分解。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
在MATLAB的命令窗口中输入“r”，然后按“Enter”键，得到的结果

如下：

提示

horner函数完成的结果并不是多项式的因式分解结果，而只是将多项式化解为符号变量的

嵌套格式，如果希望完成因式分解，则需要使用factor命令。

 
例9.14 在MATLAB中演示对多变量的多项式的嵌套分解。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2



在MATLAB的命令窗口中输入“R”，然后按“Enter”键，得到的结
果如下：

说明

从以上结果可以看出，当输入的多项式中包含着多个变量时，MATLAB会对每个变量进

行嵌套分解，将第一个变量分解完成以后，再对下一个变量进行嵌套分解。

9.3.5 计算最小分母公因式——numden函数

在MATLAB中，numden函数的功能是提取表达式的最小分母公因
式和分子多项式，其调用格式如下：

其中A是符号多项式，N（Numerator）是计算得到的最小分母公
因式，D（Denominator）则是计算的相应分子多项式。

 

例9.15 在MATLAB中计算多项式 的分母和分子。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看运算的结果。按“Enter”键，就可以得到如下的结果：



step 3
分析计算结果。根据基础数学知识，上面两个分式相加的结果如

下：

可以看出n就是结果中的分母部分，d就是分子部分。

9.3.6 简化表达式——simplify函数

在MATLAB中，simplify函数的功能是根据一定规则对符号表达式
进行简化，其调用格式如下：

其中S表示的是符号表达式或者矩阵，R是经过简化后的符号表达
式。

提示

该函数是一个强有力的具有普遍意义的工具，它可以用于指数、对数、三角函数等各种

数学表达式，MATLAB会利用MAPLE化的简化规则对表达式进行简化。

 
例9.16 在MATLAB中使用simplify函数简化符号表达式。

step 1



在命令窗口中输入以下内容：

step 2
在MATLAB的命令窗口中输入“R”，然后按“Enter”键，就可以得

到如下结果：

说明

从结果中可以看出，在MATLAB中使用simplify函数可以完成各种类型的恒等变换，包括

指数、对数和三角变换等。

9.3.7 最简化表达式——simple函数

在MATLAB中，simple函数的功能是运用包括simplify在内的各种
命令将符号表达式转换为最简洁的形式，其常见的调用格式如下：

 
◆ r = simple(S) 该函数公式的功能是使用不同的变换简化规则

对符号表达式进行简化，返回表达式S的最简形式。如果S是符号表达
式矩阵，则返回表达式矩阵变成最短的形式，而不一定是使每一项都

最短；如果不给定输出参数r，该函数将显示所有使表达式S变短的最
简化形式，并返回其中最短的一个表达式。



◆ [r,how] = simple(S) 不显示简化的中间结果，只是显示寻找
到的最短形式以及所有可以使用的简化方法。r是符号表达式的结果，
how则是使用的方法。

 
函数simple的目标是使符号表达式最短，使用最少的字符来表

示，使用simply函数通常能够得到理想的结果，为了达到这种要求，
simple函数会根据情况调用不同的简化方法，表9.1列出了常见的简化
方法。

表9.1 simple函数调用的简化方法

以上调用方法，有些已经在前面章节中介绍过，有些则没有，下

面简单介绍simple函数常用调用函数的使用环境：
 
◆ 函数radsimp用来处理包含根式的表达式。
◆ 函数combine将表达式中以求和形式、乘积形式或者幂形式出

现的各项进行合并。

◆ 函数convert将一种形式转换成另一种形式。
 



例 9.17  在 MATLAB 中 使 用 simple 命 令 化 简 表 达 式

step 1
在命令窗口中输入以下内容：

step 2
如果希望查看MATLAB使用simple命令调用的所有相关命令，可

以在命令窗口中输入“simple(f)”，然后按“Enter”键，得到的结果如
下：

说明



从以上结果可以看出，MATLAB会调用所有相关的命令，分别得出化简的结果，然后比

较所有的化简结果，选择其中最简化的结果，在本例中的结果是1/（x－1）/x。

step 3
简化显示结果。如果只想查看最后的结果，则需要将化简的表达

式赋给变量，在命令窗口中输入下列表达式，得到的结果如下：

可以看出，将simple的结果赋给变量R后，MATLAB就只会显示最
简化的结果，而省去了所有的中间结果。

根据基础数学知识，可以将表达式化简如下：

对比以上结果可以看出，MATLAB使用simple命令得到的简化结
果和基础数学知识化简的结果相同。

 
例 9.18  在 MATLAB 中 使 用 simple 命 令 化 简 表 达 式

step 1
在命令窗口中输入以下内容：

step 2



在 MATLAB 的 命 令 窗 口 中 输 入 “R ＝ [R1 ， R2]” ， 然 后
按“Enter”键，得到的结果如下：

从以上程序代码中可以看出，可以多次使用simple命令来达到最
简的表达式，表达式R1和R2都是化简的步骤，如下：

说明

尽管simple和simplify命令都是用来化简表达式的，但是simple命令的功能比较强大，以上

例子表明simple命令可以多次简化表达式，而simplify命令则不能多次简化表达式。

9.3.8 按书写方式显示表达式——pretty函数

在MATLAB中，pretty函数的功能是按习惯的“书写”方式显示符号
表达式，其常见的调用格式如下：

 
◆ pretty(S)：将符号表达式用书写方式显示出来，使用默认的

宽度79。
◆ pretty(S,n)：将符号表达式用书写方式显示出来，使用指定的

宽度n。
 
例9.19 在MATLAB中使用pretty函数显示数值矩阵。

step 1
在MATLAB的命令窗口中输入以下内容，创建符号对象：



step 2
查看并简化符号矩阵B，在命令窗口中输入以下内容：

说明

在以上程序代码中，Pascal命令返回的是数值矩阵，该函数是MATLAB中的内置函数。而

后面的程序代码中分别显示B和书写形式的矩阵B。

 
例9.20 在MATLAB中使用pretty函数显示符号表达式。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
查看书写形式的符号表达式P，在命令窗口中输入以下内容：



从以上结果可以看出，pretty函数除了可以简化符号数值矩阵之
外，还可以简化符号表达式。

例9.21 在MATLAB中使用pretty函数显示一元二次方程的通解。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
查看书写形式的符号表达式f，在命令窗口中输入以下内容：

9.4 替换符号表达式

在MATLAB中，符号计算的结果一般比较复杂，显得比数值计算
烦琐，其中一个主要原因是有些子表达式多次出现在不同的地方。为

了解决这个问题，MATLAB提供了通过符号替换的方式来使表达式的
输出形式简化，进而得到比较简单的表达式。



在MATLAB的符号工具箱中，提供了两个函数subexpr和subs，来
实现符号表达式的替换，下面分别介绍这两个命令。

9.4.1 替换重复字符串——subexpr函数

在MATLAB中，subexpr函数的功能是将表达式中重复出现的字符
串用变量替换，其常用的调用格式如下：

 
◆ [Y,SIGMA] = subexpr(X,SIGMA)  指定用变量SIGMA的值

（该变量必须是符号对象）来替代符号表达式中重复出现的字符串。

替换的结果由变量Y返回，被替换的字符串则由变量SIGMA代替。
◆ [Y,SIGMA] = subexpr(X,'SIGMA') 这种形式和前一种形式

的区别在于，第二输入参数是字符或者字符串，它用来替换符号表达

式中重复出现的字符串。

 
例9.22 在MATLAB中，使用相关命令来求解方程ax3＋bx2＋cx＋

d＝0的通解表达式。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在MATLAB的命令窗口中输入“R=subexpr(t)”，然后按“Enter”键，

得到系统默认的化简结果如下：



step 3
接着在MATLAB的命令窗口中输入以下内容：

step 4
然后在MATLAB的命令窗口中依次输入s、r，查看化简结果如

下：

从以上示例中可以看出，当没有输入替换参数的时候，MATLAB
会使用默认值SIGMA。以上计算结果很烦琐，但是使用simple命令并
不能简化，因为表达式中并不存在可以合并、展开或者因式分解的表



达式，但是subexpr命令使用替换的方法就可以使整个表达式在外观上
显得简化了很多。

说明

在MATLAB中，符号表达式中被置换的子表达式是系统自行寻找的，其置换的原理和

pretty命令相似，在pretty命令中，使用%1，%2替换比较长的子表达式。而且，只有比较长的

子表达式才会被置换，对于比较短的表达式，即使存在多次重复的子表达式，也不会被替

换。

9.4.2 替换特定符号——subs函数

在MATLAB中，subs函数的功能是使用指定符号替换符号表达式
中的某一个特定符号，相对于subexpr命令，subs命令是一个通用的替
换命令，subs命令的常用调用格式如下：

 
◆ R = subs(S) 用工作空间中的变量替换符号表达式S中的所有

符号变量，如果没有指定某符号变量的值，则返回值中该符号变量不

被替换。

◆ R = subs(S, new) 用新的符号变量new替换原来符号表达式S
中的默认变量。确定默认变量的规则和函数findsym规则相同。

◆ R = subs(S,old,new) 用新的符号变量new替换原来符号表达
式S中的变量old，当new是数值形式的符号时，实际上用数值替换原来
的符号来计算表达式的值，只是所得结果还是字符串形式。

 
例9.23  在MATLAB中，使用subs函数替换符号表达式中的变

量。



step 1
在MATLAB的命令窗口中输入以下内容：

step 2
使用subs函数查看默认的替换结果：

step 3
在MATLAB的命令窗口中输入以下内容：

step 4
查看替换结果：

step 5
在MATLAB的命令窗口中输入以下内容：

step 6
查看替换结果：



提示

以上例子并不复杂，但是演示了subs函数一些常见用法，可以选择类似的例子来尝试各

种不同的使用方法和结果。

9.5 符号函数

在MATLAB中，在处理符号对象的时候，除了需要了解前面介绍
的符号表达式内容之外，还需要了解关于符号函数的相应操作。在

MATLAB 7.0的符号工具箱中，提供了关于符号函数的求反和复合函
数，下面详细介绍这两类函数的应用。

9.5.1 求反函数——finverse函数

在MATLAB中，finverse函数的功能是求某函数的反函数。反函数
是高等数学的一个基本内容，其基本概念如下：对于函数f（x），在
实数范围内，存在某函数g（g），使得g（f（x））＝x，则函数
g（g）就被称为函数f（x）的反函数。

finverse命令的常见调用格式如下：
 
◆ g = finverse(f) 对默认的自变量求反函数g。
◆ g = finverse(f,v) 对指定的自变量为v的f（v），求反函数

g（v）。
 
例9.24 在MATLAB中，分别求解不同类型函数的反函数。



step 1
在MATLAB的命令窗口中输入下列内容：

step 2
在MATLAB的命令窗口中输入“g”，然后按“Enter”键，得到的结

果如下：

说明

在以上程序代码中，分别使用finverse函数求得了对数、三角函数和多元函数的反函数。

其中，当对多元函数指定不同的变量时，求得的反函数则会不同。

 
例9.25 在MATLAB中，求解函数f（t）＝t2的反函数。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
在输入以上代码后，按“Enter”键，得到以下结果：



当某个函数的反函数不唯一的时候，MATLAB会出现以上提示信
息： “Warning: finverse(t^2) is not unique.”，该信息提示用户使用
finverse函数返回的只是多个反函数中的一个，在本实例中得到的结果
是 ，而没有显示另外一个反函数 。

9.5.2 求复合函数——compose函数

在MATLAB中，compose函数的功能是产生复合函数。复合函数
是数学分析中经常遇到的问题，其基本概念为：对于函数f（x）和x＝
g（y），两个函数的复合函数就是f（g（y））。
在MATLAB中，compose命令的常用调用格式如下：
 
◆  compose(f,g)  对 f（g）和v＝g（g）求得复合函数 fg＝

f（g（g））。
◆ compose(f,g,x,y,z) 对函数f（x）和v＝g（y），求得复合函

数 。

 
例9.26 在MATLAB中，实现复合函数。

step 1
在MATLAB的命令窗口中输入下列内容：



step 2
在MATLAB的命令窗口中输入“comp”，然后按“Enter”键，查看使

用复合函数得到的结果：

从以上结果可以看出，对于相同的两个基础函数，如果使用不同

类型的变量，复合函数的结果会互不相同，因此，在进行函数复合

时，需要注意变量的选择。

提示

在MATLAB中，compose(f,g)命令其实是compose(f,g,x,y,z)命令的默认形式。在这种情况

下，x、y都是由findsym函数自动对f和g函数进行辨认而定的自变量。

9.6 符号微积分

在数学分析中，微积分一直是十分主要的内容，整个高等数学就

是建立在微积分运算的基础上，同时，微积分也是微分方程体系的基



础内容。在MATLAB中，提供了一些常见的函数来支持这些微分运
算，所涉及的领域包括极限、微分、积分和级数等各个方面。

尽管和数值计算相比，符号运算一般需要消耗更多的内存资源，

但是这并不意味着符号运算没有使用的场合。在有些情况下，符号计

算处理比数值计算会更加便捷。下面将详细介绍符号运算在微积分中

的应用。

9.6.1 求微分——diff函数

当创建了符号表达式后，就可以使用diff函数来对它们进行微分运
算。在MATLAB中，diff命令的常用调用格式如下：

 
◆ diff(S, 'v') 将符号‘v’当作变量，对符号表达式或者符号矩阵

S求得微分。
◆ diff(S,n) 将符号表达式S中的默认变量进行n阶微分预算，其

中默认的变量可以使用函数findsym来确定，参数n必须是正整数。
◆ diff(S, 'v',n) 将符号‘v’当作变量，对符号表达式或者符号矩

阵S求得n阶微分。
 
例9.27 在MATLAB中，使用diff函数求解f（x，y）＝x2＋2xy－

3y2的一阶偏导和二阶偏导数值。

step 1
在MATLAB的命令窗口中输入以下内容：



step 2
在MATLAB的命令窗口中输入“[dfdx;dfdy;dfdxdy;dfdydx]”，然后

按“Enter”键，可以得到以下结果：

在以上程序代码中，通过使用简单的diff命令，证明了微积分中的

一个结论： 。在本例中，f（x，y）＝x2＋2xy－3y2，

因此根据上面程序的结果，两者满足 。

9.6.2 化简微分结果

例 9.28  在MATLAB中，使用 diff函数求解常见的多项式
的一阶导数数值，并使用MATLAB中相关的命令简化

求解的结果。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2



在MATLAB的命令窗口中依次输入f1、f2，查看求导结果如下：

step 3
对以上结果进行化简，使用前面介绍过的simple命令，得到的结

果如下：

根据相关的微积分知识，多项式 的微分结果如下：

提示

从以上例子可以看出，diff函数的结果并不一定是最简洁的，如果希望得到最简的微分结

果，经常需要使用多种化简命令。

9.6.3 求解矩阵微分



例9.29 在MATLAB中，求解多项式矩阵 的下

面各阶微分数值：

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在MATLAB的命令窗口中依次输入以上各个求导变量，查看求导

结果如下：

提示

从以上例子中可以看出，diff命令不仅可以适用于单个多项式、变量，还可以适用于多项

式矩阵当中，灵活使用diff命令可以求解各种微分数值。

9.6.4 向量微分jacobian函数



在数学分析中，微分运算也可以对列向量进行，所得的结果也是

一个列向量。在数学分析中，多元向量f函数f的jacobian矩阵的定义如
下：

对于多元向量函数 和向量变量v＝[v1，…，vm]，

其函数f的jacobian矩阵为

说明

当f是矩阵的时候，求导必须对各个元素进行，但是自变量必须定义在整个矩阵上。

 
在MATLAB中，jacobian函数的调用格式如下：

其中f是一个符号列向量，v是指定进行变换的变量组成的行向
量。

例9.30 沿用例9.29中的矩阵A，将其转换为两个列向量B1和B2，

分别求解两个列向量的jacobian矩阵。

step 1
在MATLAB的命令窗口中输入以下内容：



step 2
在MATLAB的命令窗口中输入“g1jacob、g2jacob”，查看列向量的

jacobian矩阵：

根据例9.29可以得知， ，在本例中可以得到列

向量为 。然后分别求解上面两

个列向量的jacobian矩阵。

step 3
求解两个jacobian矩阵的行列式，得到的结果如下：

提示



jacobian函数的第一个参数是列向量，而第二个参数则必须是行向量。同时，雅可比矩阵

的行列式一般比较复杂，需要使用符号表达式的简化命令进行化简。

9.6.5 符号极限

根据高等数学的基础知识可知，表达式的极限是微分的基础。极

限的定义则是当自变量趋近某个范围或者数值时，函数表达式的数

值。无穷逼近也是微积分的基本思想，因此极限是整个微积分的基

础。在MATLAB中，提供了函数limit求解表达式或者函数的极限，其
常用的调用格式如下：

 
◆ limit(F,x,a) 求解当x→a时，符号表达式F的极限。
◆ limit(F,a) 符号表达式F采用默认自变量，该函数求得F的自

变量趋近于a时的极限值。
◆ limit(F) 符号表达式F采用默认自变量，并且以a=0为自变量

的趋近值，该函数求得F的自变量趋近于a时的极限值。
◆ limit(F,x,a,'right') 该函数求解符号表达式F的右极限，也就

是自变量从左边趋近于a的函数极限值。
◆ limit(F,x,a,'left') 该函数求解符号表达式F的左极限，也就是

自变量从右边趋近于a的函数极限值。
 

例9.31 在MATLAB中，求解表达式 的

极限数值。

step 1
在MATLAB的命令窗口中输入以下内容：



step 2
在命令窗口中输入“[F1，F2]”，查看极限表达式的数值如下：

根据微积分的相关知识，求解表达式的极限可以使用各种方法，

在MATLAB中程序会调用各种方法来求解各种极限数值。

说明

以上实例中，使用的是MATLAB的默认格式来求解极限数值。MATLAB会自动认定自变

量x，同时认定自变量x的趋近数值为0。

9.6.6 求解无限极限

例9.32 在MATLAB中，证明常用极限表达式 。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在命令窗口中输入“[F1；F2]”，查看极限表达式的数值如下：



说明

根据limit命令的格式，当极限的范围是无穷大时，MATLAB中用字符inf来替代，得到的

结果证明MATLAB的相关命令正确。

9.6.7 求解左右极限

例9.33 在MATLAB中，求解f（x）在x＝0处的左右极限和极限

数值，其中函数f（x）当x≠0时， ；当x＝0时，f（x）＝0。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在命令窗口中输入“[fl；fr；f]”，查看极限表达式的数值：

说明

从以上求解结果可以看出，左极限的数值为-1，右极限的数值为1，由于左右极限数值不

等，则可以得出结果极限不存在，在MATLAB中用NaN来表示。

step 3



绘制函数图形。最后，为了让读者了解上面表达式的极限情况，

绘制该函数的图形以便形象地了解函数形态，相应的程序代码如下：

得到的图形如图9.1所示。

图9.1 绘制函数的图形

从图9.1可以很清楚地看到，函数在x＝0的地方间断，左侧为数
值-1，右侧为数值1，因此函数在x＝0的地方不存在极限数值。

交叉参考

以上程序代码都是用来绘制函数图形的，如果不太熟悉相关的命令，可以参考本书中介

绍MATLAB绘图的章节。

9.6.8 符号积分



在数学分析中，积分和微分是一种互逆的运算。积分包括不定积

分、定积分、旁义积分和重积分等，一般来讲，积分比微分更难求

解。在MATLAB的符号数学工具箱中，提供了函数int来求解符号积
分。int命令可以直接接通MAPLE，进行十分有效的求积。
和数值积分相比，符号积分的指令简单，适应性比较强，但是可

能会占用较长的时间。有时符号积分可能会给出比较冗长的符号表达

式。如果求解的是不可积的表达式，int命令会返回积分的原式并显示
警告信息。

在MATLAB中，int命令的常用调用格式如下：
 
◆ R = int(S) 用默认的变量求符号表达式S的不定积分。
◆ R = int(S,v) 用符号变量v作为变量求符号表达式S的不定积

分数值。

◆ R = int(S,a,b) 符号表达式采用默认变量，该函数求默认变量
从a变到b时符号表达式S的定积分数值。如果S是符号矩阵，则积分对
各个元素分别进行积分。

◆ R = int(S,v,a,b) 用符号变量v作为变量求符号表达式S的定积
分数值。

说明

在int命令中，a和b不仅可以是常数变量，也可以是符号表达式和其他数值表达式，分别

表示积分表达式的上限和下限。

 

例9.34 在MATLAB中，求表达式 的不定积分结果。

step 1



在MATLAB的命令窗口中输入以下内容：

step 2
在命令窗口中输入“F”，然后按“Enter”键，查看不定积分的结果如

下：

根据以上结果可以看出，积分结果满足下列积分等式：

MATLAB给出了其中的一个不定积分结果 ，没有

给出其中的常数C。

说明

从以上程序可以看出，int命令得到的结果一般比较冗长，需要使用简化命令来简化结

果。

9.6.9 矩阵积分

例9.35 在MATLAB中，求矩阵 的积分结果。

step 1



在MATLAB的命令窗口中输入以下内容：

step 2
在命令窗口中输入“I”，然后按“Enter”键，查看不定积分的结果：

step 3
在命令窗口中输入“pretty(I)”，然后按“Enter”键，查看新的结果：

说明

从分析结果中可以看出，当积分对象是符号矩阵的时候，int命令会对矩阵中的元素依次

进行积分，得出积分结果。

9.6.10 证明积分等式

例9.36 在MATLAB中，使用int积分命令验证正态分布的结果。

step 1



在MATLAB的命令窗口中输入以下内容：

step 2
在命令窗口中输入“R”，然后按“Enter”键，查看定积分的结果：

step 3
在MATLAB的命令窗口中输入以下内容：

step 4
在命令窗口中输入“F”，然后按“Enter”键，查看定积分的结果：

step 5
在命令窗口中输入“pretty（F）”，然后按“Enter”键，查看简化后

的定积分结果：



根据微积分的相关知识，标准正态分布满足 。因

此，在本实例中，使用相应的积分变换可以得到 。在以上程

序代码中，得出的结果就是1/a^(1/2)*pi^(1/2)。在后面的步骤中，将a
设定为任意实数的符号变量，MATLAB将会根据变量a的不同情况来
得到积分结果。

说明

在以上程序代码的后面步骤中，将a设定为real，这个时候变量a既是MATLAB工作空间的

变量，也是MAPLE内核工作空间的一个实变量。如果希望清除该变量a，使用命令clear a只能

将其在MATLAB的工作空间中删除该符号对象，在MAPLE的内核工作空间中则存在着变量，

应该使用“syms a unreal”将其从MAPLE的内核中清除。

9.6.11 交互近似积分

除了上面提供的int命令之外，MATLAB还提供了一个交互性的近
似积分命令rsums，该命令可以计算一元函数在某有限的闭区间的积分
数值。在MATLAB中，rsums命令的调用格式为：rsums(f,a,b)其中f是
积分表达式，a和b分别为积分的上下限。
例9.37 在MATLAB中，使用rsums命令求解函数f（x）＝（x－

1）3＋x2＋4x在积分区间[-1，2]的积分结果。

step 1



在MATLAB的命令窗口中输入以下内容：

step 2
输入以上命令后，按“Enter”键，MATLAB会自动调用近似积分的

交互界面，如图9.2所示。

图9.2 交互近似积分界面

说明

在默认的情况下，交互近似积分界面的下方有一个滑动键，该滑动键用来设置函数曲线

下方的矩形个数。默认情况下，矩形的个数为10。当滑动键向右调节时，矩形数会增加，最

大的矩形个数为128。

step 3



调整积分矩形的个数。向右调整滑动键，将其设置为128，查看近
似积分的数值，如图9.3所示。

图9.3 调整积分精度

step 4
在命令窗口中输入“int(f,-1,2)”，计算函数的准确积分数值，结果

如下：

说明

从以上结果可以看出，精确值为21/4＝5.25，而近似积分的数值为5.250069，精度应该可

以达到一般的要求。

9.6.12 符号级数求和



在数学分析中，级数求和是一个重要的内容，MATLAB提供了
symsum命令来对符号表达式进行求和，symsum命令的调用格式如
下：

 
◆ r = symsum(s,a,b) 将符号表达式s中的默认变量从a变到b时

的有限和。

◆ r = symsum(s,v,a,b) 将符号表达式s中的变量v从a变到b时的
有限和。

 
例9.38 在MATLAB中，使用symsum命令求解各种常见级数求

和。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在命令窗口中输入“S=[s1；s2；s3]”，然后按“Enter”键，查看求解

的结果如下：

以上计算结果分别对应的级数运算如下：



提示

在表达式s3中，用sym命令将“k!”转换为符号变量，在后来的运算过程中，MATLAB会

将“k!”视为符号。由于MATLAB中没有定义阶乘的运算法则，如果不使用该命令，MATLAB

会返回错误信息。

9.7 符号积分变换

在数学分析中，通过数学变换将复杂的计算转换为简单的计算是

一个重要的手段。其中，积分变换是数学变换中的一个重要内容。所

谓积分变换，就是通过积分计算，把一类函数A变换成另一类函数B，

函数B一般是含有参量a的积分 。这一变换的目的就是将函数

类A中的函数f（ t）通过积分运算变成另外一个函数类B中的函数
F（a）。积分变换计算公式中的k（t，a）就是积分变换的核，而
f（t）叫做原函数，F（a）叫做像函数。
积分变换的方法在自然科学和工程实际中有着广泛的应用，是一

个不可或缺的运算工具。本节将介绍三个主要的积分变换：傅里叶变

换、拉普拉斯变换和Z变换。

9.7.1 傅里叶变换



在时域中的f（t）与它在频域中的傅里叶变换F（w）之间存在着
如下的关系：

根据以上积分定义，可以使用前面章节介绍的int命令直接求解，
但是，MATLAB提供了专门的傅里叶变换程序：fourier和ifourier命
令。在本小节中，将详细介绍MATLAB中的这些命令，对于积分定义
的方法，感兴趣的读者请自行尝试。

在MATLAB中，fourier和ifourier命令的调用格式如下：
 
◆ Fw=fourier(ft,t,w) 求时域上函数ft的傅里叶变换Fw，其中ft

是以t为自变量的时域函数，Fw是以圆频率w为自变量的频域函数。
◆ ft=ifourier(Fw,w,t) 求频域上函数Fw的傅里叶反变换ft，其

中ft是以t为自变量的时域函数，Fw是以圆频率w为自变量的频域函
数。

 
例9.39 在MATLAB中，分别使用fourier命令和原始积分定义求

解表达式的积分结果。

step 1
在MATLAB的命令窗口中输入以下内容：



说明

在以上程序代码中，fy1和fy2是使用fourier变换命令求得的计算结果，fd1和fd2则是根据

积分定义计算得到的结果，由此可以比较两种不同计算方法得到的结果。

step 2
在MATLAB的命令窗口中依次输入计算结果的数组：

以上程序代码中计算的积分表达式依次为：

；根据积分运算，得到的结果是

；根据积分运算，得到的结果是

说明

根据以上程序，使用fourier命令得到的结果和根据定义得到的结果一致，而且fourier命令

一般得到的就是比较简化的结果，而根据定义得到的结果则不一定比较简化。

 



例 9.40  使 用 fourier 变 换 命 令 证 明 积 分 等 式

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在MATLAB的命令窗口中输入“Yw”，查看积分结果如下：

由于积分表达式的上下限不是无限值，而是有限数值范围

为了能够使用傅里叶变换求解积分表达式的数值，引入了Heaviside(t-
a)函数，该函数的数学含义是单位阶跃函数，当自变量t≥a时，函数的
数值为1；当自变量t＜a时，函数的数值为0。
根据以上分析得知，函数“Heaviside(t+tao/2)-Heaviside(t-tao/2)”的

数值在自变量范围 内为1，在其他的范围内则为0。这就等于变

相限定了积分表达式的积分范围。

根 据 以 上 程 序 代 码 ， 傅 里 叶 变 换 得 到 的 结 果 为

因此以上程序代码就等于证明了



提示

在MATLAB 7.0的符号数学工具箱中，增加了dirac和heaviside两个函数，它们的功能是产

生单位脉冲函数和阶跃函数。在以前的版本中，MATLAB只是借用了MAPLE函数库中关于

heaviside函数的定义，如果希望在MATLAB中运算该函数，必须从MAPLE函数库中调用。

9.7.2 拉普拉斯变换

在数学分析中，拉普拉斯（Laplace）变换和反变换的定义如下：

由于该变换也是用积分来定义的，因此，可以用int命令直接求解
拉普拉斯变换。同时，MATLAB中提供了专门的拉普拉斯变换程序：
laplace和ilaplace命令。下面将详细介绍MATLAB中的这些命令，对于
积分定义的方法，感兴趣的读者请自行尝试。

在MATLAB中，laplace和ilaplace命令的调用格式如下：
 
◆ Fs=laplace(ft,t,s) 求时域上函数ft的拉普拉斯变换Fs，其中ft

是以t为自变量的时域函数，Fs是以复频率s为自变量的频域函数。
◆ ft=ilaplace(Fs,s,t) 求频域上函数Fs的拉普拉斯反变换ft，其

中ft是以t为自变量的时域函数，Fs是以复频率s为自变量的频域函数。



 
例 9.41  证 明 拉 普 拉 斯 变 换 的 时 移 性 质 ：

其中，f是任意一个函数，u则是前面介绍的阶跃函数，L代表的是
拉普拉斯变换。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在MATLAB的命令窗口中，查看积分变化的结果：

从以上程序代码中可以看出，ft＝f（t－t0）u（t－t0），FS就是ft
函 数 对 应 的 拉 普 拉 斯 变 换 的 结 果 ，

。最后，FS_t的结果是将

FS的反拉普拉斯变换，结果就是ft＝f（t－t0）u（t－t0）。

提示

在本实例中，使用的laplace变换和ilaplace变换都是完整的调用格式命令，这并不意味着

laplace命令没有默认格式。但是，一般情况下，建议不要使用默认格式，以免造成一些不必



要的错误，同时还会占用计算机的内存资源。

9.7.3 Z变换

和前面两个变换不同，Z变换适用于离散的因果系列，Z变换和其
反变换定义如下：

关于Z变换有很多具体的计算方法，通常用到的有三种：幂级数
展开、部分分式展开和围线积分法。在MATLAB中，和Z变换相关的
命令采用的是围线积分法，对应的命令是 ztrans，其表达式是

。对应的调用命令如下：

 
◆ FZ=ztrans(fn,n,z) 求时域函数fn的Z变换FZ，fn是以n为自变

量的时域序列，FZ是以复频率z为自变量的频域函数。
◆ fn =iztrans(FZ,z,n) 求频域函数FZ的Z反变换fn，fn是以n为

自变量的时域序列，FZ是以复频率z为自变量的频域函数。
 
例9.42 在MATLAB中，对以下函数实现Z变换。

step 1
在MATLAB的命令窗口中输入以下内容：



step 2
在 MATLAB 的 命 令 窗 口 中 输

入“[simple(z1);simple(z2);simple(z3)]”，查看Z变换后的表达式：

 
例9.43 在MATLAB中，对以下函数实现Z的反变换。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在MATLAB的命令窗口中输入“[z1；z2；z3]”，查看Z反变换后的

表达式：



9.8 符号矩阵的计算

矩阵计算一直都是MATLAB计算的核心内容，关于数值矩阵运算
的内容在前面章节中已经介绍过，这里就不重复介绍了。而在

MATLAB的符号工具箱中，符号矩阵的运算规则和数值矩阵的运算规
则大致相同，没有添加新的运算规则，这就给用户使用符号矩阵带来

了极大的方便。本节将主要介绍符号矩阵的一些简单应用。

9.8.1 线性代数运算

符号对象的线性代数运算和双精度的线性代数运算一样，读者可

以查阅数值计算的相应内容来了解有关线性代数运算的一些规则和注

意事项。下面将利用符号对象进行相应的线性代数计算。

例9.44 在MATLAB中使用符号对象进行基础的矩阵运算。

step 1
在MATLAB的命令窗口中输入以下内容：

在以上程序代码中，引入了符号对象t，同时产生了包含变量t的
Hilbert矩阵H，这就相当于在Hilbert矩阵中引入了参数t。

step 2
查看创建的Hilbert矩阵H：



step 3
将符号对象t设置为参数1，MATLAB会自动计算出原始的Hilbert

矩阵，使用的命令为前面章节介绍过的Subs，结果如下：

提示

当使用命令subs将符号对象t替换为数值1后，MATLAB会自动进行数值运算，这样原来的

符号矩阵就直接转换为数值矩阵Hib。可以将符号t替换为其他的任何数值，MATLAB也会计

算出对应的数值矩阵。

step 4
计算符号矩阵H的行列式的倒数：

由于H是关于t的符号矩阵，而通过det(H)命令计算该符号矩阵的
行列式，该行列式也是关于t的符号表达式，而其对应的倒数d也就是
关于t的符号表达式。

step 5
展开以上符号表达式d，得到的结果如下：



step 6
由于以上符号表达式d太复杂，可以将其简化，结果如下：

提示



上面两个步骤中，使用的都是符号表达式的相关命令。可以看出，符号矩阵H的相关矩

阵运算结果也是符号表达式，符号表达式的命令都可以使用。

step 7
计算H矩阵的逆矩阵X，得到的结果如下：

step 8
计算Hilbert矩阵的逆矩阵，得到的结果如下：



在以上程序代码中，将前面步骤中求得的X矩阵中参数t设置为1，
就可以求得Hilbert矩阵的逆矩阵。

提示

在以上步骤中，使用了多种数值矩阵的命令，例如det、inv等，从程序的结果中可以看

出，这些常见命令都可以用在符号表达式中。

9.8.2 特征值运算

特征值运算一直是矩阵运算的重要内容，在符号矩阵中，同样提

供了数值矩阵类似的求解特征值的命令eig。和它们对应的任意精度计
算的命令则是eig(Vpa(A))。
例9.45 在MATLAB中，使用符号对象进行矩阵运算。

step 1
在MATLAB的命令窗口中输入以下内容：

在以上程序代码中使用代码sym(gallery(5))创建一个5阶的符号矩
阵A，然后对该符号矩阵A进行乘幂计算得到矩阵B。

step 2
查看乘幂的结果矩阵B：



可以看出，A的5阶乘幂是零矩阵。根据线性代数的基础知识可
知，A是零幂矩阵，其对应的所有特征值都应该是0。

step 3
求解符号矩阵A的特征多项式：

在以上程序代码中，使用poly命令求解符号矩阵A对应的特征多项
式，由于矩阵A的特征值为0，因此其特征多项式就是一个5阶的表达
式。

step 4
求解符号矩阵A的特征值：

从以上程序结果可以看出，通过符号矩阵的eig命令，可以直接求
解数值矩阵的特征值，得到的结果为0。

step 5
求解任意精度下符号矩阵A的特征值，得到的结果如下：



step 6
求解符号矩阵A的约当（Jordan）标准型，得到的结果如下：

step 7
求解符号矩阵A的矩阵指数，得到的结果如下：

step 8
求解符号矩阵A的矩阵元素指数，得到的结果如下：



说明

在以上程序中分别使用expm和exp命令求解矩阵指数和元素指数数值，对于两个命令的差

别，请查看相应的帮助文件。

9.9 符号代数方程的求解

在代数和数学分析内容中，求解方程一直都是十分重要的内容。

从代数理论的角度来讲，一般代数方程包括线性、非线性和超越方程

等。本节将主要介绍符号代数方程的命令和实例。

9.9.1 solve命令

对于上述的方程类型，MATLAB提供了统一的求解命令solve。当
方程组不存在符号解时，同时如果没有其他的自由参数时，solve命令
会给出数值解。

在MATLAB中，solve命令的调用格式如下：
 
◆ g = solve(eq) 其中eq可以是符号表达式或不带符号的字符串

表达式，该函数的功能是求解eq=0的方程，其中自变量采用默认变
量，通过函数findsym来确定。

◆ g = solve(eq,var) 求解方程eq＝0，其自变量由参数var指定。
其中eq和上一种调用方式相同。返回值g是由方程的所有解构成的列向



量。

◆ g = solve(eq1,eq2,...,eqn) 求解符号表达式或不带符号的字符
串表达式eq1，eq2，….，eqn所构成的方程组，其中自变量采用默认
变量，可以通过函数findsym来确定。

◆ g = solve(eq1,eq2,...,eqn,var1,var2,...,varn) 求解符号表达式
或不带符号的字符串表达式eq1，eq2，….，eqn所构成的方程组，其
中自变量由参数var1，var2，…..，varn确定。

提示

当输出参数的数目和方程组的数目相等的时候，方程组的解将分别赋给每个输出参数，

并且按照字母表的顺序进行排列。

9.9.2 求解非线性方程组

例9.46 求解非线性方程组 的数值解。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在命令窗口中输入结果矩阵，得到的结果如下：

说明



从以上结果可以看出，MATLAB会成对地输出方程组的数值解。如果没有引入新的变

量，则会分别输出x和y的结果。因此，建议引入新的变量。

9.9.3 求解含参数方程组

例9.47 求解含有参数a的非线性方程组 的解。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在命令窗口中输入结果矩阵，得到的结果如下：

9.9.4 求解超越方程组

例9.48 求解超越方程组 的解。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
在命令窗口中输入结果矩阵，得到的结果如下：



以上程序结果中，并没有显示方程组的解，只是显示方程结果的

属性和维度。在本例中，变量x和y都是符号变量，维度都是2×1。

step 3
查看各个变量的具体数值，得到的结果如下：

说明

如果没有指定该方程组的变量，MATLAB会使用findsym函数依次将x、y作为方程的自变

量，最终的结果会和本实例的结果有所差别，请读者自行尝试。

9.10 符号微分方程的求解

相对于符号线性代数方程组的求解，微分方程的求解稍微复杂一

些，限于本章的篇幅，这里只介绍如何使用MATLAB求解常微分方程
组，MATLAB同样可以求解偏微分方程组，但是求解起来十分复杂。
在本书的前面章节中，曾经介绍了微分方程的数值求解方法，与

初值问题求解相比，微分方程边值问题的求解显得复杂和困难。但

是，对于符号求解而言，不论是初值问题还是边值问题，其求解微分

方程的指令都很简单。另一方面，符号微分方程的计算可能会花费较

多的时间，可能得不到简单的解析解，可能得不到封闭形式的解，甚



至可能得不到解。从这个角度来看，微分方程的数值解和解析解是互

补的方法。

9.10.1 dsolve命令

本节将介绍如何使用符号微分方程进行求解，在MATLAB中，
dsolve命令的常见调用格式如下：

 
◆ r = dsolve('eq1,eq2,...', 'cond1,cond2,...', 'v')
◆ r = dsolve('eq1','eq2',...,'cond1','cond2',...,'v')
 
上面两个命令的功能是：求由eq1，eq2…….指定的常微分方程的

符号解。常微分方程以变量v作为自变量，参数cond1，cond2…….用
来指定方程的边界条件或者初始条件。如果不指定v作为自变量，则将
默认的t作为自变量。

说明

和solve命令类似，dsolve命令也有更为简单的形式。但是根据笔者的经验，建议在理解

微分方程组的独立变量以及对次序理解充分的时候，才使用简单的形式。

9.10.2 求解常微分方程

例9.49  求常微分方程 的通解，然后求解在初值条件

x（0）＝1的数值解。

step 1
在MATLAB的命令窗口中输入以下命令：



step 2
在命令窗口中输入“solution”，查看求解的结果：

在以上程序代码中，S1是微分方程的通解，S2则是初值条件下的
特解。在默认情况下，MATLAB会依次使用C1、C2作为通解的常量符
号。

9.10.3 求解二阶常微分方程

例9.50 求二阶常微分方程 的通解。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
在命令窗口中输入“S”，查看求解的结果：

在以上程序中，求解的方程为y（x），而不是方程y（t），如果
在命令中没有特别指明方程自变量x，得到的结果将是关于自变量t的



表达式，如下：

注意

在常微分方程中，用大写字母D表示一次微分，则D2、D3分别表示二次、三次微分运

算。再次提醒读者，MATLAB是区分大小写的，只能用D表示微分，使用小写字母d就无法辨

识该符号。

9.10.4 求解常微分方程组

例9.51 求常微分方程组 的通解。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看以上微分方程组的求解结果：



注意

如果不使用符号微分方程组的方法，而使用数值方程的方法来求解，相应的求解方法相

比较而言则会非常复杂。

9.11 利用maple的资源

在maple软件中，有2000多条符号计算命令，前面章节中已经多次
使用了maple的相关命令，但是这些都只涉及最常见的命令。在
MATLAB中，为了进一步利用maple软件的符号计算能力，可以利用
多种MATLAB和maple中的接口程序。其中，sym和maple可以直接调
用maple中计算程序，而mhelp、mfun等命令则可以对maple的相关函数
进行查询和查看等。

9.11.1 调用maple的相关命令

在MATLAB中，可以使用sym命令定义maple软件中的相关命令，
然后使用设置后的符号变量，调用相应的相关命令。

例9.52 在MATLAB中求解数值的阶乘。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看程序完成的结果：



可以看出，当需要在MATLAB中引用maple的命令时，不能直接
调用命令，而只能用MATLAB中相关的符号命令来变相地引用命令。

step 3
利用以上程序，计算5!的数值，得到的结果如下：

例9.53 在MATLAB中利用maple的“rsolve”命令，求解递归方程
的通解。

step 1
利用maple中的命令求解递归方程 的通解，

在MATLAB的命令窗口中输入以下内容：

在以上程序中，使用maple命令直接调用resolve命令，求解以上递
归方程，然后使用class命令查看R变量的类别。

step 2
在命令窗口中输入以下内容，查看上面命令得到的结果：

说明



从以上结果可以看出，通过maple命令MATLAB可以求解得到递归方程的结果，而且该结

果的变量属性是字符串，而不是符号对象。

step 3
将以上结果转换为符号对象，并修改其显示效果：

step 4
利用maple中的命令求解递归方程 的通解，在

MATLAB的命令窗口中输入以下内容：

说明

在以上程序中，字段“F(1..2)=1”代表的就是初值条件F（1）＝1，F（2）＝1，这种表达

方法是在软件maple中的用法。

step 5
查看该表达式的初值条件，在MATLAB的命令窗口中输入以下内

容：



在以上程序中，将符号表达式Sr中的n替换为1和2，就相当于求解
表达式的初值条件F（1）和F（2），得到的结果都是1，可见表达式
符合初值条件。

9.11.2 查看maple的帮助

前面已经介绍了如何在MATLAB中调用maple的命令，限于篇
幅，此处不能介绍maple中的所有命令，如果需要了解某个命令在
maple中的使用方法，需要使用maple的帮助。下面将介绍如何在
MATLAB中获得maple的帮助。
例9.54 在MATLAB环境中查阅maple的各种帮助文件。

step 1
查看关于命令“mhelp”的帮助，输入“mhelp”，然后按“Enter”键，

得到如下的结果：

step 2
查阅maple在线帮助的索引条目，输入“mhelp index”命令，然后

按“Enter”键，得到如下的结果：



step 3
查阅maple中的具体分类目录，输入“mhelp index[function]”命令，

然后按“Enter”键，得到如下的结果：

step 4
查看具体函数的帮助文件，在MATLAB中输入“mhelp rsolve”，然

后按“Enter”键，查看查询结果：



从以上结果可以看出，一般函数的帮助信息包括：函数的表达

式、参数说明、描述和函数实例等，可以查阅其他函数的帮助信息。

9.12 可视化符号分析

在MATLAB中，符号数学工具箱为符号函数的可视化提供了一组
简易的命令，本节中将着重介绍两个数学分析的可视化界面：单变量

函数分析界面和泰勒级数逼近分析界面。其中，单变量函数分析界面

由命令funtool引出，泰勒级数逼近分析界面由命令taylortool引出，引
出界面之后，后续的所有操作都可以直接在界面上进行，下面分别详

细介绍。

9.12.1 单变量函数分析界面



在MATLAB中，单变量函数分析界面主要用来分析单变量函数的
关系，最多可以分析两个函数之间的关系。对于习惯使用计算器或者

只是做一些简单的符号计算和图形处理的用户，该分析界面是一个很

好的选择。该计算器操作十分简单，可视性强。其调用格式为：

funtool。当输入该命令后，MATLAB会调用如图9.4所示的界面。

图9.4 单变量函数分析的默认界面

图9.4是MATLAB调用单变量函数分析的默认界面，可以看出，在
默认情况下，函数f＝x，g＝1，同时自变量x的取值范围是[-2*pi,
2*pi]，常数a＝1/2。同时，可以看出，这个函数界面由两个图形窗口



和一个函数运算控制窗口这三个独立窗口组成。在任何时候，两个图

形窗口只有一个处于激活状态。而函数运算控制窗口上的操作只能对

被激活的函数图形窗口起作用。

为了演示如何使用该运算界面，下面将修改f和g的函数表达式，
查看各种操作的结果和图形的变化，修改后的界面如图9.5所示。

图9.5 修改函数表达式和范围

在函数操作界面中，第一排的按钮都是针对函数f的，功能依次为
求导（对应“df/dx”按钮）、积分（“inf”按钮）、简化（“simple”按
钮）、提取函数的分子（“numf”按钮）、提取函数表达式的分母
（“denf”按钮）、求倒数（“1/f”按钮）和求反函数（“invf”按钮）等。



第二排的按钮主要用来处理函数f和常数a之间的运算，包括加、
减、乘、除等，对应的按钮中的符号表示了对应的操作。第三排的按

钮主要用来处理两个函数f和g之间的运算。其他按钮的功能可以直接
从按钮的符号了解到，最后一个按钮“swap”的功能是实现两个函数的
转换。最后一排的按钮主要用来进行计算器自身的操作，下面详细介

绍各个按钮的具体功能：

 
◆ Insert：将当前激活窗口中的函数插入到函数列表fxlist中。
◆ Cycle：依次循环显示fxlist中的函数。
◆ Delete：从fxlist列表中删除当前激活窗口中的函数。
◆ Reset：将计算器恢复到初始状况。
◆ Help：关于该界面的所有帮助内容。
◆ Demo：关于该界面的演示内容。
◆ Close：关闭该界面的所有窗口。
 
最后，该界面实际上是一个已经制作好的GUI界面，如果希望查

看其源程序，或者在其基础上修改源程序，可以单击界面中

的“Help”按钮，MATLAB会调用相关的命令，然后单击“View code for
funtool”选项，打开该GUI界面对应的M文件，如图9.6所示。



图9.6 查看GUI界面的M源程序

说明

根据前面的介绍读者也许已经发现，该数学分析界面中的按钮功能针对函数f的居多，针

对函数g的居少，但是可以使用“swap”按钮转换两个函数的位置。

9.12.2 泰勒级数逼近分析界面

在MATLAB的符号工具箱中，为用户提供了“taylor”命令来求解符
号表达式的泰勒级数展开式，使用该命令可以求解任何符号表达式在

任意数据点的泰勒级数展开式。泰勒级数逼近是一种十分常见的函数

分析方法，该工具的功能主要是分析某范围内的函数形态，因此，如

果能够绘制对应范围内的函数图形，可以更加直观地分析函数的泰勒

级数逼近和原来函数的形态。

为了满足以上条件，MATLAB提供了泰勒级数逼近分析界面，调
用该界面的命令为taylortool，当用户在命令窗口中输入该命令后，



MATLAB会自动调用界面，如图9.7所示。

图9.7 泰勒级数分析的默认界面

在“Taylor Tool”界面中，a表示级数的展开点，N表示级数展开阶
数，可以通过右侧的按钮来改变数值，也可以在选框中输入阶数的数

值。函数级数展开的默认范围是（-2π，2π），可以在对应的选框中修
改范围的数值。可以修改级数展开的所有参数，来查看界面的对应变

化，如图9.8所示。



图9.8 对不同函数进行泰勒展开

9.13 小结

本章介绍了关于符号计算的详细内容，包括符号对象、表达式、

符号操作、符号代数方程、符号微分方程等，了解这些内容后，基本

上可以对MATLAB中如何实现符号运算有一个大概的了解。在后面的
章节中，将介绍如何在MATLAB中实现数据和函数的可视化。

◆   ◆   ◆



Part 3

第3部分 数据可视化

第10章 二维图形
第11章 三维图形



第10章 二维图形

本章包括

◆绘制二维曲线

◆编辑二维曲线的属性

◆绘制特殊图形

 
前面章节已经介绍了MATLAB在数据处理、运算和分析中的各种

运用。和其他科学计算工具类似，MATLAB也提供了强大的图形编辑
功能。通过图形，可以直观地观察数据间的内在关系，也可以十分方

便地分析各种数据结果。从最初的版本开始，MATLAB就一直注重数
据的图形表示，而且在更新版本的时候不断地使用新技术来改进和完

善可视化的功能。

在本章中，将详细介绍MATLAB的图形形成原理；曲线、曲面绘
制的基本技巧；如何编辑图形参数；如何标记图形等。这些操作大部

分只涉及了MATLAB中的高层命令，这些命令格式简单，容易理解。
对于底层的图形操作，将在后面章节中详细介绍。

最后，相对于MATLAB的6.x版本，MATLAB 7提供功能十分强
大、使用非常方便的图形编辑功能，使得原来十分复杂的图形编辑功

能变得十分简单。这些内容将在本章的最后部分加以介绍。

10.1 图形的基础知识

在正式学习和熟悉MATLAB的图形编辑功能之前，有必要了解
MATLAB中图形绘制的基本原理和基础步骤。在本节中，大致将



MATLAB图形的数据源分成离散和连续两个部分，来介绍在MATLAB
中如何绘制这两种图形。由于是介绍基础知识，所以选取的函数形式

比较简单，主要是为了介绍绘制图形的原理和步骤。

10.1.1 离散数据（函数）的可视化

在MATLAB中，绘制离散数据的原理十分简单。对于离散数据数
组x＝[x1，x2，x3，…，xn]，y＝[y1，y2，y3，…，yn]，MATLAB会将
对应的向量组（x1，y1），（x2，y2），….，（xn，yn）用直角坐标中

的点序列表示。一般情况下，MATLAB中的离散序列所反映的只是某
确定区间的对应关系（也就是函数关系），不能反映无限区间上的对

应关系。

例10.1 绘制离散函数 的图形，其中自变

量n是取值范围是（0，16）的整数。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
按“Enter”键，MATLAB会弹出名为“Figure1”的图形对话框，如图

10.1所示。



图10.1 离散函数的可视化

以上程序语句十分简单，但是已经涉及MATLAB中图表绘制的多
个方面。下面详细介绍各个语句的含义：

 
◆ 程序语句“plot(n,y,'mh','markersize',15);”是图表绘制的主要命

令，其中第三个参数'mh'的作用是设置数据点的色彩和点形，其中m表
示颜色是“品红”，h表示数据点形是“六角星符”，关于其他颜色和点形
参数将在后面章节中详细介绍；参数'markersize'用来设置标记的大小
属性，15就是其属性值。

◆  程序语句“axis([0,17,5,6.2])”的功能是设置图表坐标轴的范
围，其中横坐标轴（X轴）的刻度范围是[0,17]；纵坐标轴（Y轴）的
刻度范围是[5,6.2]。在MATLAB中对坐标轴的其他设置将在后面章节
中详细介绍。



◆  程序语句“grid on”的功能是添加分格线。在默认情况下，
MATLAB会为所有坐标轴都添加分格线，如果需要单独对其中某个坐
标轴添加分格线，需要使用句柄图形的内容，这将在后面的章节中介

绍。

注意

在默认情况下，当用户在命令窗口中输入plot命令，MATLAB程序就会将图表显示

在“Figure1”对话框中，而且该对话框会与MATLAB的操作界面独立。如果希望将图表在命令

窗口中显示，可以单击工具栏中的 按钮。

10.1.2 连续函数的可视化

在MATLAB中，绘制连续函数的图表原理基本和离散函数相同，
也就是在一组离散自变量上计算相应的函数值，然后将各个数据组用

点来表示。这似乎和离散函数相比，没有太大的区别。在MATLAB
中，将这些离散数据点转化为连续函数的方法是：减少离散数据点的

间隔，增加更多的数据点，计算各个数据点的函数数值，这个方法相

当于微分的思想；另外一个方法就是直接将相邻的数据点用直线连接

起来，用线性关系来替代其他的函数关系。

注意

在MATLAB中，使用两个方法都可以绘制连续函数的图形。但是，如果函数的自变量采

样点数不够多，两种方法绘制的连续图形都会有很大的误差。

 

例10.2 绘制函数 的图形，其中自变量x

是取值范围是（0，16）的所有实数。



step 1
在MATLAB的命令窗口中输入下列内容：

step 2
按“Enter”键，就可以得到相应的结果，如图10.2所示。

图10.2 连续函数的表示方法

step 3



分析图形结果。

以上图表命令中，Picture1和Picture3使用的是数组x1和y1，
Picture2和Picture4使用的是图表数组x2和y2。从以上对比可以很明显
地看出，当自变量使用的数组离散数据间隔变小后，图表可以更明显

地表示出函数的形态。

Picture1和Picture3尽管也表现出了大概的形态，但是在图表的局
部有明显的失真，不能很好地表示函数性态。

同时，从以上程序可以看出，对于离散数据，MATLAB的plot命
令在默认情况下会自动将这些离散数据用直线连接起来，使之成为连

续曲线。

注意

在以上程序语句中，为了对比效果更加明显，将四幅图形绘制在同一个图形窗中。因

此，所有的图表就变成了子图表。在MATLAB中，绘制子图表的命令是subplot，该命令在实

际应用中会经常用到。

10.1.3 绘制图表的基础步骤

从前面的内容中，应该基本了解了在MATLAB中绘制图表的方
法。在本节中，将归纳一下MATLAB中绘制图表的基本步骤，具体步
骤如下：

step 1
准备图表的数据。这是基础的步骤，因为图表就是用来显示数据

变化规律的，因此，首先需要为绘制图表准备数据。一般而言，需要

首先确定图表绘制的范围，然后选择对应范围的自变量，最后计算对

应的函数数值。



step 2
设置显示图表的位置。这个步骤主要是针对多子图的情况。当用

户绘制多子图的时候，则需要设置每个子图表的显示位置。对应的命

令就是前面用过的subplot命令，可以使用该命令指定相应的窗位。

step 3
绘图，并设置相应的参数。这是在MATLAB中绘图的主要步骤，

对应的命令就是plot，可以使用该命令绘制图表，同时可以设置图表
的参数，例如线型、颜色和数据点形等。完成该命令后，基本上就完

成了图表的大致外观。

step 4
设置坐标轴属性。从这个步骤开始，就开始了对图表的编辑工

作。可以设置坐标轴的刻度范围，添加坐标轴的分格线等。

step 5
添加图形注释。完成图表的基础外观并设置了坐标轴属性后，还

可以添加一些注释信息，例如图表的标题、坐标轴名称、图例和文字

说明等。对于这些注释，MATLAB都提供了对应的命令。可以使用命
令来方便地设置各种注释。

说明

在以上步骤中，step 1和step 3是最基础的，通过这两个步骤基本上就可以完成图表的绘

制工作，其他步骤都可以认为是对图表的编辑步骤。

10.2 绘制二维图形



在MATLAB中，二维曲线和三维曲线在绘制方法上有较大的差
别，相对而言，绘制二维曲线比三维曲线要简单，因此，在本节中介

绍如何在MATLAB中绘制二维曲线。

10.2.1 绘制二维图形——使用plot命令

在MATLAB中，绘制二维曲线的基本命令是plot，其他的绘制命
令都是以plot为基础的，而且调用方式都和该命令类似，因此，在本
节中将详细介绍plot的使用方法。
在MATLAB中，调用plot的方法有下面三种。
 
（1）plot(X,'PropertyName',PropertyValue,...)
其中参数X表示的是绘制图表的数据，'PropertyName'表示的是图

表属性的选项字符串，例如，线型、颜色和数据点形等；

PropertyValue表示对应属性的选值。对于参数X的不同类型，
MATLAB会做不同的处理，详细内容如下：

 
◆ 当X是实数向量时，MATLAB会以X向量元素的下标为横坐

标，元素数值为纵坐标绘制连续曲线。

◆ 当X是实数矩阵时，MATLAB会绘制矩阵中每列数值元素相
对于其下标的连续曲线，因此绘制的图表结果中包含了多个图表，个

数等于X矩阵的列数。
◆ 当X是复数矩阵的时候，以列为单位，分别以矩阵元素的实部

为横坐标，以元素的虚部为纵坐标绘制连续曲线。

 
（2）plot(X,Y,'PropertyName',PropertyValue,...)



和以上命令相比，该命令多了一个参数Y，其中X、Y都是图表的
数据数组。其他参数的含义和以上命令相同。同样，对于参数X、Y的
不同数据类型，MATLAB也会做不同的处理，详细内容如下：

 
◆ 当X、Y是同维向量时，MATLAB会以X和Y元素为横、纵坐

标绘制曲线。

◆ 当X是向量，Y是某维数值与X向量相同的矩阵时，MATLAB
会绘制多个连续曲线，默认情况下这些曲线的颜色都会不同；曲线的

个数等于Y矩阵的另外一个维数，X向量是曲线的横坐标。
◆ 当X是矩阵，Y是向量时，情况和上面相同，Y向量是这些曲

线的纵坐标。

◆ 当X、Y是同维矩阵时，MATLAB会以X、Y对应元素为横、
纵坐标绘制曲线，因此，曲线的个数就是矩阵的列数。

 
（ 3 ） plot(X1,Y1, X2,Y2, X3,Y3,

…'PropertyName',PropertyValue,...)
该命令和第二种命令相似，只是同时在图形窗口中绘制多个曲

线，这些曲线之间没有相互的约束。

例10.3 演示以下案例，了解plot命令三种调用形式。

step 1
在MATLAB的命令窗口中输入下列内容：



step 2
按“Enter”键，就可以得到相应的结果，如图10.3所示。

图10.3 演示plot基础命令

step 3
分析图形结果。在子图“Picture1”中，使用的命令是“plot(y)”，其

中变量y是一个100×5的矩阵，数值就是函数y=ex×k的计算结果。根据
前面的结果，MATLAB会绘制5组（矩阵的列数）曲线，而且曲线是



以列向量的元素下标为单位，因此，最大下标为100。而且从结果中可
以看出，这5条曲线的颜色是不同的。

 
在子图“Picture2”中，使用的命令是“plot(t,y)”，由于t是一个100维

的行向量，y是一个100×5的矩阵，因此，MATLAB会以t为横坐标绘制
5条颜色各异的曲线。
在子图 “Picture3”中，使用的命令是 “plot(y,t)”，其情况和子

图“Picture2”类似，只是这5条曲线都会以t为共同的纵坐标。
在子图“Picture4”中，使用的命令是“plot(t)”，由于t是一个100维的

行向量，因此，MATLAB会绘制以下标为横坐标的元素曲线。

注意

在图10.3中，为了显示各个图表坐标系的不同，使用了xlabel、ylabel命令来添加图表的横

坐标和纵坐标，这些命令在编辑图表时也是很常见的，将在后面的章节中详细介绍。

 
例 10.4  在 MATLAB 中 绘 制 复 数 矩 阵

的图形，并在图形中显示对应的图

例。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
按“Enter”键，就可以得到相应的结果，如图10.4所示。



图10.4 绘制复数矩阵

在图10.4中，复数矩阵中三个元素分别以实部为横坐标，以虚部
为纵坐标将以上曲线绘制在同一个图形窗中。为了便于分辨曲线的表

达式，使用命令legend添加了图表的图例说明。

提示

从以上步骤中可以看出，在MATLAB的同一个图形窗中绘制不同的曲线命令十分简单，

只需将这些函数表达式写成复数形式，直接使用plot命令就可以完成。

10.2.2 设置曲线的属性

为了能够使曲线更加直观，同时也为了能够在复杂图形中分辨各

个数据系列，在MATLAB中，可以为曲线设置不同的颜色、线型和数
据点形属性。在MATLAB中，关于曲线的线型和颜色参数的设置如表
10.1所示。

表10.1 MATLAB中线型和颜色的设置



之所以将曲线的线型和颜色一起介绍，是因为在使用plot命令时
这两个参数经常一起使用，例如“r:”表示的是曲线是红色的虚线。在命
令 plot(X,'PropertyName',PropertyValue,...) 中 ， 如 果 没 有 输 入 参
数'PropertyName'和PropertyValue的数值，MATLAB会将线型和颜色的
属性设置为默认值，线型的默认值是“实线”；颜色的默认值则依次是
蓝、绿、红、青等。如果只有一条曲线，曲线的颜色则是蓝色。

说明

表10.1中列出的是基础颜色，在MATLAB中还可以了使用RGB颜色系统来为曲线设置颜

色。在RGB颜色系统中，颜色由数组元素数值来控制，将在后面的章节中详细介绍。

 
在MATLAB中，除了可以为曲线设置颜色、线型之外，还可以为

曲线中的数据点设置属性。这样，就可以选择不同的数据点形，很方

便地将不同的曲线区分开来。MATLAB中的数据点形的属性如表10.2
所示。

表10.2 MATLAB中的数据点形



例10.5 在区间[0，4π]上，绘制函数 的曲线，

同时将在相同的图形窗中绘制该曲线的包络线 的曲线。对包

络线和基本曲线使用不同的线型，并且为曲线上的数据点设置点形。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
按“Enter”键，就可以得到相应的图形，如图10.5所示。



图10.5 设置曲线属性

step 3
分析图形结果。在以上图表绘制语句中，只使用一个命

令 “plot(x,yb,'-k',x,-yb,'-
k',x,y,'-.ro','LineWidth',2,MarkerEdgeColor','g','MarkerFaceColor','y','Marke
rSize',6)”就将图表绘制完成。
其中yb和-yb数据系列是曲线的网络线，其曲线的属性是'-k'，也就

是黑色的实线；数组y就是函数的曲线，其曲线的属性是'-.ro'，因此曲
线 是 红 色 的 点 画 线 ， 同 时 数 据 标 记 是 空 心 圆 圈 。 参

数 'MarkerEdgeColor'将空心圆圈的边框颜色设置为绿色 (g)，参
数 'MarkerFaceColor'将空心圆圈的填充颜色设置为黄色 (y)，参
数'MarkerSize'将空心圆圈的大小设置为6。

说明

从以上例子可以看出，在MATLAB中只需使用简单的程序语句就可以设置图形的各种属

性。灵活使用线型、颜色和数据标记的参数，可以绘制出十分美观的图形。



10.2.3 设置坐标轴范围

图表的坐标轴对图表的显示效果有着明显的影响，尽管MATLAB
提供了考虑比较周全的坐标轴默认设置，但是并不是所有图形的默认

效果都是最好的，用户可以根据需要和偏好来设置坐标轴的属性。为

此，MATLAB提供了一系列关于坐标轴的命令，用户可以根据情况选
取合适的命令，调整坐标轴的取向、范围、刻度和高宽比等。表10.3
列出了MATLAB中关于坐标轴的常见命令。

表10.3 MATLAB中关于坐标轴的常见命令

表10.3中列出的命令，主要是用于图表坐标轴的控制，在前面的
内容中已经接触到了坐标轴范围的控制命令axis([xmin xmax ymin
ymax])，用于设置图表各坐标轴的刻度范围。在本节中，将利用几个
例子来说明如何在MATLAB中对图形的坐标轴进行控制。

例10.6 在MATLAB中绘制函数 中的图表。

step 1
首先，使用MATLAB默认的坐标轴范围绘制该图表，在命令窗口

中输入以下内容：

step 2



查看图形结果。按“Enter”键，就可以得到相应的图表，如图10.6
所示。

图10.6 绘制默认图表

step 3
修改坐标轴刻度范围，在MATLAB的命令窗口中输入下列内容：

step 4
查看结果。按“Enter”键，就可以得到相应的图表，如图10.7所

示。



图10.7 修改后的图表

从两个图表的对比中可以发现，修改后的图表在描述整个函数性

态上要好于默认的图表。这是因为自变量x在整个范围 中，大部

分的函数值都比较小，例如 tan（1.5）＝14.1014， tan（1.55）＝

48.0785等。但是 ，tan（1.57）＝1256。也就是说，函数在

自变量的很小范围 内，递增得十分明显。如果使用MATLAB的

自动刻度范围，就无法显示整个图表的变化趋势。

说明

在以上步骤中，之所以将Y轴的最大值设置为50，是因为根据反正切函数，当正切值为

50的时候，对应的X数值为1.5508，比较接近pi/2，不会使函数的范围损失太大。

10.2.4 设置坐标轴显示方式

例10.7 在MATLAB中使用不同的坐标轴显示方式绘制长轴为4，
短轴为3的椭圆。



step 1
在命令窗口中输入以下内容：

step 2
按“Enter”键，就可以得到对应的图表，如图10.8所示。

图10.8 不同的坐标轴显示方式

10.2.5 设置坐标轴系统

例10.8 在不同的坐标轴系统中绘制函数 的图形。

step 1



在命令窗口中输入以下内容：

step 2
按“Enter”键，就可以得到对应的图形，如图10.9所示。

图10.9 不同的坐标轴系统



step 3
分析图表结果。图10.9中总共包括了6个子图表，下面详细介绍这

6个图形的内容。
在“Normal”子图表中，使用的是默认坐标轴系统，也就是变量x、

y都在直角坐标系中，而且刻度范围采用MATLAB的默认设置。
在“Y-Logx”子图表中，将X坐标轴转化为log x的对数坐标系，而Y

坐标轴保持直角坐标系。由于这个操作涉及了坐标轴的转换，因此需

要涉及图表的底层指令。在以上程序中，使用对象图柄语句

set(gca,'XScale','log','YScale','linear')将X坐标轴转换为log，而Y坐标轴
保持默认的linear数值；“LogY-X”子图表和第二个子图表基本类似，只
是将Y坐标轴转化为log y，而将X坐标轴保持为直角坐标系。
在“Y-revX”子图表中，将X坐标轴倒置，Y坐标轴保持不变。同

样，这个操作涉及了图表坐标轴的转换，因此使用了图表底层的指

令：set(gca,'XDir','reverse','YDir','normal')。同理，在“revY-X”子图形
中，将Y坐标轴倒置，X坐标轴保持不变。
在 最 后 一 个 子 图 表 中 ， 使 用 底 层 命 令

set(gca,'XGrid','on','YGrid','off')设置了图表的分格线属性：设置X坐标
轴的分格线，而将Y坐标轴的分格线清除。

说明

图10.9的所有子图表对坐标轴的操作都是使用对象图柄命令完成的，因为对于这些操作

MATLAB没有提供现成的高层命令。对于这些语句，将在后面的章节中详细介绍其语法。熟

悉对象编程的读者可以直接从语句中了解到其作用。

10.2.6 图形标识



在MATLAB中提供了多个图形标识命令，来添加多种图形标识。
常见的图形标识包括：图形标题、坐标轴名称、图形注释和图例等。

关于这些图形标识，MATLAB提供了简洁命令方式以及精细命令方
式。在本节中，将使用一个简单的实例来说明图形标识的使用方法。

例 10.9  在 MATLAB 中 绘 制 函 数

，同时在图形中标识出两个

曲线的交点和曲线的属性。

step 1
打开M文件编辑器，在其中定义myfun函数，在编辑器中输入以下

内容：

之所以要在M文件编辑器中定义该函数，是为了在后面步骤中求
解两个曲线的交点，将以上函数保存为myfun.m文件，然后关闭文件
编辑器。

说明

以上程序语句十分简单，在MATLAB中编写M文件将在后面的章节中详细介绍。本章中

需要编写该M文件的原因是后面步骤中需要使用fzero函数来求解曲线的交点。

step 2
在MATLAB的命令窗口中输入以下内容：



step 3
按“Enter”键，就可以得到对应的图形，如图10.10所示。



图10.10 完成的图形标识

step 4
分析图形结果。

 
在图10.10中为图形添加了多个图形标识：坐标轴、标题、文本注

释、箭头注释等。其中，坐标轴和标题的设置方法十分简单，直接引

用简单命令即可，这里就不介绍了。而文本注释和箭头注释相对比较

复杂，下面详细分析这两种注释内容。

命令行“text(xrt,yrt,'\fontsize{16}\leftarrow\fontname{隶书}交点')”为
两个曲线交点添加了文本注释“交点”。其中参数xrt和yrt表示插入文本
注 释 的 位 置 ， 也 就 是 坐 标 点 （ xrt,yrt ） 。 而 参

数'\fontsize{16}\leftarrow\fontname{隶书}交点'则定义了注释文字类型
（隶书）和大小（16）以及文本内容（交点），其中参数leftarrow表
示为文本添加左向箭头。



命令 “annotation1 = annotation('textarrow', [0.6625 0.5036],[0.2262
0.372], 'LineWidth',1,'HeadStyle','cback2', 'String',{'这是一个','递增函数'},
'FontName','IFontb.fon',
'FontSize',9,'HorizontalAlignment','left','TextBackgroundColor',[1 1
1],'TextLineWidth',1, 'TextEdgeColor',[0 0 0]);”则为图形添加了带有箭头
的图形注释。其中“[0.6625 0.5036],[0.2262 0.372]”表示添加箭头的两个
坐标数值，后面的参数分别设置了图形注释文本的属性。

说明

程序语句中的fzero函数的用法，可以使用MATLAB的帮助文件来查询。该函数的功能是

求解某公式的零点。

10.2.7 叠绘

在MATLAB中，可以使用多种命令在同一个图形窗中绘制不同图
形，但是在实际应用中，会遇到在已经完成的图形中再绘制曲线的情

况。为了能够达到这种效果，MATLAB为用户提供了hold命令。在
MATLAB中，hold命令的常用调用格式为：

 
◆ hold on 启动图形保持功能，当前坐标轴和图形都将保持，

此后绘制的图形都将添加在这个图形之上，并且自动调整坐标轴的范

围。

◆ hold off 关闭图形保持功能。
◆ hold 在hold on和hold off命令之间进行切换。
 
例 10.10  在 MATLAB 中 依 次 绘 制 函 数

的曲线，然后再将f2（x）



向下平移50个单位。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
查看图形结果。按“Enter”键，得到第一个函数的曲线，如图10.11

所示。

图10.11 第一个函数的曲线

step 3
在MATLAB的命令窗口中输入以下内容：

step 4



查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图
10.12所示。

图10.12 添加第二个函数的曲线

step 5
在MATLAB的命令窗口中输入以下内容：

step 6
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.13所示。



图10.13 添加第三个函数的曲线

step 7
最后，在MATLAB的命令窗口中输入以下内容：

step 8
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.14所示。



图10.14 单独绘制最后一个函数的曲线

说明

以上步骤并不复杂，但是比较形象地说明hold命令的作用。在一个函数曲线绘制完成

后，使用了hold on命令，开启图形保持功能，因此在图形中添加第二个函数曲线的时候，第

一个函数的曲线会保留在窗口中。由于没有关闭图形保持功能，因此可以直接在这个基础上

添加第三个函数的曲线；而当使用hold off命令关闭图形保持功能后，再次绘制函数曲线时，

图形窗口中就只有最后一个函数的曲线。

10.2.8 绘制双坐标轴图形

双坐标轴问题是科学计算和绘图中经常遇到的问题，当需要将同

一自变量的两个（或者多个）不同量纲、不同数量级的函数曲线绘制

在同一个图形中时，就需要在图形中使用双坐标轴。为了满足这种需

求，MATLAB提供了plotyy命令。plotyy命令的常用调用格式如下：
 



◆ plotyy(x1,y1,x2,y2) 以左、右不同纵轴绘制x1-y1、x2-y2两条
曲线。

◆ plotyy(x1,y1,x2,y2,FUN) 以左、右不同纵轴绘制x1-y1、x2-
y2两条曲线，曲线类型由FUN指定。

◆ plotyy(x1,y1,x2,y2,FUN1,FUN2) 以左、右不同纵轴绘制x1-
y1、x2-y2两条曲线，x1-y1曲线类型由FUN1指定，x2-y2曲线类型由
FUN2指定。

说明

在以上命令格式中，左坐标轴用于绘制x1-y1数据系列，右坐标轴用于绘制x2-y2数据系

列。坐标轴的范围和刻度都可以自动产生。参数FUN、FUN1、FUN2可以是MATLAB中所有

可以接受的二维绘图命令，例如plot、bar、linear等。

 
例10.11 某公司统计了公司近半年的销售收入（Income）和边际

利润率（Profit_Margin）的数据，为了方便财务人员进行查看，需要
在同一个图形窗中绘制两组数据的变化趋势。现在需要在MATLAB中
实现以上要求。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.15所示。



图10.15 绘制的基础双轴图形

step 3
在MATLAB的命令窗口中输入以下内容：

step 4
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.16所示。



图10.16 经过编辑后的曲线

step 5
分析以上图形结果。

在step 1中，使用plotyy函数绘制了基础的双轴曲线，对于第一个
数据系列Income使用的图表类型是直方图（bar），对于第二个数据系
列Profit_Margin使用的图表类型是直线（plot）。在没有任何编辑之
前，MATLAB会将这两个曲线的属性都设置为默认值，例如两个曲线
的颜色都是蓝色等。

在step 2中，通过使用底层的图形句柄语句来设置两个曲线的属
性，例如线宽、填充颜色、数据标记等。这些语句的功能主要是编辑

图形的外观，让图形的对比更加明显。这些语句都涉及了图形句柄的

内容，这些内容将在后面的章节中详细介绍，这里就不展开了。

提示

如果需要在双轴图表图形中添加文字标记，那么text命令添加的标记位置是由左纵轴决定

的，同时，前面介绍的图例命令legend在双轴图形中无法正常使用。



10.2.9 绘制多子图

在前面的内容中已经多次涉及在一个图形窗中布置多个独立的子

窗口的情况。在同一图形窗中绘制多个子图，可以很方便地将几个独

立图形进行对比。在MATLAB中，提供了subplot命令来绘制子图。
subplot命令的常见调用格式如下：

 
◆ subplot(m,n,p) 该命令的功能是将图形窗口分成m×n个子窗

口，然后在第p个小窗口中创建坐标轴，将其设置为当前窗口。
◆ subplot(m,n,p,'replace') 如果在绘制图形的时候已经定义了

坐标轴，该命令将删除原来的坐标轴，创建一个新的坐标轴系统。

◆ subplot(m,n,p,'align') 该命令的功能是对齐坐标轴。
◆ subplot(h) 使句柄h对应的坐标轴成为当前坐标轴。
◆ subplot('Position',[left bottom width height]) 在指定位置开

辟子图，并将其设置成当前坐标轴。

说明

在命令subplot(m,n,p)中，p代表的是子图的编号。子图序号编排规则是：左上方是第1

幅，然后向右向下依次编号，这个命令产生的子图分割按照默认值设置。而在命令

subplot('Position',[left bottom width height])中，指定位置的四元数组必须采用标化坐标，图形

窗的高和宽分别是[0，1]，左下方的坐标是（0，0）。最后，所有的subplot命令产生的子图都

是相互独立的。

 
例 10.12  在 MATLAB 中 ， 用 子 图 绘 制 函 数

的图形，分别使用不同的子图绘制

命令。



step 1
在MATLAB的命令窗口中输入下列内容：

step 2
按“Enter”键，结束输入并执行命令，得到的结果如图10.17所示。

图10.17 绘制多子图图形

说明

在以上命令中，如果最后一个子图的绘制命令中将子图的高度增加，例如改为0.7，那么

最后一个子图会将上面所有的子图覆盖。

10.2.10 交互式图形



在MATLAB中，除了前面介绍的图形编辑命令之外，还提供了一
些和鼠标操作相关的命令，也就是交互式图形命令。例如，当将某个

函数的曲线绘制完成以后，有时候希望知道某个自变量数值下的函数

值，这个时候使用ginput命令可以十分便利地通过鼠标来读取二维平
面图形中的任意一点的坐标值。

除了ginput命令之外，MATLAB还提供了gtext、zoom等命令，这
些命令都和鼠标操作有关。在这些命令中，除了ginput命令只能用于
二维图形之外，其他的命令都可以用在二维和三维图形中。其中

ginput命令和zoom命令经常一起使用，可以从图形中获得比较准确的
数据。在MATLAB中，ginput命令的常用调用格式如下：

 
◆ [x,y] = ginput(n) 该命令的功能是用鼠标从二维图形上获取n

的数据点的坐标数值，用“Enter”键结束取点。
◆ [x,y] = ginput 取点的数目不受限制，这些数据点的坐标数值

保存在[x,y]中，通过“Enter”键结束取点。
◆ [x,y,button] = ginput(...) 返回值button记录了每个数据点的

相关信息。

说明

这个命令和其他图形命令的机理不同，其他命令是将各个数据点绘制到图形中，而该命

令则是从已经绘制完成的图形中获取数据点的信息。同时，该命令只适合于二维图形。命令

中的n只能选取正整数，表示选择数据点的个数。

 
在MATLAB中，ginput命令经常和zoom命令一起配合使用。zoom

命令的功能在于实现对二维图形的缩放，其常见的调用格式如表10.4
所示。



表10.4 MATLAB中的zoom命令

说明

在MATLAB中，使用zoom命令完成的缩放工作是标准的Windows操作：单击左键，就可

以将图形放大；也可以使用鼠标拉出一定的区域后将区域进行放大。单击右键完成的则是相

反的操作，也就是将图形缩小。默认的缩放因子是2，可以使用factor来修改这个缩放因子。

 
例10.13 在MATLAB图形窗中实现动态绘图：使用鼠标左键选取

曲线的数据点，用鼠标右键结束，然后使用曲线将以上所有数据点连

接起来，绘制曲线。

step 1
在MATLAB的命令窗口中输入下列内容：



step 2
查看图形结果。输入代码之后，按“Enter”键，MATLAB会弹出图

形窗，使用鼠标左键选择数据点，然后单击鼠标右键，结束数据点选

取，得到的图形如图10.18所示。

图10.18 绘制动态图形

step 3
重新选择数据，绘制新图形。以上图形程序对数据点的选取次

序、个数没有任何限制，可以根据需要随意选取。因此，可以重新选

择数据点，然后使用鼠标完成图10.19所示的图形。



图10.19 修改动态图形

说明

在以上程序中，使用了循环语句来依次将用户使用鼠标选取的数据点信息添加到对应的

数组中。然后使用样条函数对选取的数据点进行插值，在程序的最后，使用plot命令绘制插值

后的曲线。

10.2.11 使用fplot命令绘制图形

通过前面的介绍，读者应该已经对plot命令有了一定的了解，其
实MATLAB对于图形不同的数据来源提供了不同的绘图命令。其中比
较常见的命令是fplot和ezplot命令，两种命令的适用范围互不相同。在
本节中，将通过具体的实例详细介绍这两种命令的使用方法。

简单来说，前面介绍的plot命令是将函数数值得到的数值矩阵转
化为连线图形。但是，在实际应用中，如果不太了解某个函数随自变

量变化的趋势，而使用plot命令绘制该图形时，就有可能因为自变量
的范围选取不当而使函数图形失真。可以根据微分的思想，将图形的



自变量间隔取得足够小来减小误差，但是这种方法会增加MATLAB处
理数据的负担，降低效率。

对于以上问题，MATLAB提供了fplot命令来解决。该命令用来指
导如何通过函数取得绘图的数值数据矩阵，命令通过内部的自适应算

法动态决定自变量的间隔：当函数值变化比较缓慢时，自变量的间隔

会取得大一点；当函数数值变化比较剧烈时，自变量的间隔就会取得

小一点。这样，就可以便于保证绘图的质量和效率。

在MATLAB中，fplot命令的常用调用格式如下：
 
◆  fplot(function,limits,tol,LineSpec)  在这个命令中，参数

function表示需要绘制曲线的函数名称；limits表示绘制图形的坐标轴
取值范围，可以有两种方式：[xmin xmax]表示的是图形X坐标轴的取
值范围，[xmin xmax ymin ymax]则表示X、Y坐标轴的取值范围；tol表
示函数相对误差容忍度，默认值为2e-3；LineSpec表示图形的线型、
颜色和数据点等。

◆ [...] = fplot(function,limits,tol,n,LineSpec,P1,P2,...) 在这个命
令中，fplot函数通过相关参数计算取值后，向函数传递P1,P2等参数数
值。

 

例10.14 在MATLAB中绘制函数 的图形。

提示

这两个函数的表达式并不复杂，但是两个函数有着明显区别。y1的函数在x=0附近变化较

大，如果希望很好地表现函数变化，需要在零点附近将自变量的间隔减少；函数y2在整个取

值范围之内变化都比较平缓，因此需要使用fplot来解决这个问题。

step 1



打开MATLAB的M文件编辑器，在其中输入以下函数表达式：

然后将其保存为fplot_fun.m文件，这个文件就是后面步骤中需要
绘制的函数表达式。

step 2
在MATLAB的命令窗口中输入以下内容：

step 3
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.20所示。

图10.20 使用fplot命令绘制图形



说明

在以上步骤中，首先使用fplot命令绘制两个函数的图形，然后定义自变量的取值范围，

再使用plot命令绘制函数的图形，图形在外观上是完全一致的，但是在处理效率上有很大区

别。

10.2.12 使用ezplot命令绘制图形

ezplot命令是MATLAB为用户提供的简易二维图形命令。其命令
名称的前两个字符“ez”的含义就是“Easy to”，表示对应的命令是简易
命令。这个命令的最大特点就是：不需要用户对图形准备任何数据，

即可直接画出字符串函数或者符号函数的图形。

在MATLAB中，ezplot命令的常用调用格式如下：
 
◆ ezplot(f)  在默认的自变量范围[-2π，2π]内绘制函数f的曲

线。

◆ ezplot(f,[min,max]) 在用户自定义的自变量范围内绘制函数f
的曲线。

◆ ezplot(f,[min,max],fig) 在指定的图形窗口中，在自定义的自
变量范围内，绘制函数f的曲线。

说明

在以上函数中，参数f可以是字符表达函数、符号函数、内联函数等，但是所有的函数类

型只能是一元函数。在默认情况下，ezplot命令会将函数表达式和自变量写成图形名称和横坐

标名称，可以根据需要使用title、xlabel命令来命名图名和横坐标名称。

 

例10.15 在MATLAB中绘制函数 的图形。



step 1
在MATLAB的命令窗口中输入以下内容：

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.21所示。

图10.21 使用ezplot命令绘制图形

从图10.21中可以看出，首先使用syms命令将t设置为符号变量，
然后输入符号表达式，最后使用ezplot命令来绘制图形。用户并没有为
函数准备任何的自变量的数据，MATLAB自动为其选定自变量范围，
同时计算相应的函数数值。

提示



在ezplot命令中，不能使用plot命令中的参数为曲线指定曲线线型、色彩等，同时也不允

许同时在一个图形窗口中绘制多个图形。但是，前面介绍的text、grid、zoom等命令还是可以

适用于ezplot命令。

10.3 特殊图形

MATLAB为用户提供了不少特殊图形的命令，使用这些绘图命令
可以很方便地绘制出一些特殊图形：面积图、直方图、矢量图等。这

些图形使用基础的plot命令也是可以完成的，但是操作步骤比较复
杂。而使用MATLAB内部已经设置好的命令就可以很方便地完成这些
特殊图形。

在本节中，将选取MATLAB的一些典型的二维和三维特殊图形的
命令，介绍在MATLAB中绘制图形的方法。之所以将二维和三维曲线
一起介绍，是因为这些特殊图形的命令有很多是二维和三维通用的。

10.3.1 绘制面积图

MATLAB为用户提供了绘制面积图的命令area。这个命令的主要
特点是：在图形中绘制多条曲线时，每条曲线都是将前面的曲线当作

基线，然后取值绘制曲线。area命令的常见调用格式如下：
 
◆ area(Y) 这是比较常见的调用格式，将以向量Y的下标为横

坐标轴，以向量Y的元素数值为纵坐标轴来绘制面积图。
◆ area(X,Y) 当X和Y都是向量的时候，这个命令绘图的结果和

plot(X,Y)相同，只是在默认的X轴最小值0和数值Y之间有填充效果；
当X是向量，Y是矩阵的时候，则以向量X为横坐标轴，以矩阵的列元
素的累积数值为纵坐标数值绘制填充图形。



◆ area(...,basevalue) 在这个命令中，为面积图设置了填充的基
值数值，如果没有指定该参数的数值，MATLAB会将该数值设置为
0。

说明

对于area命令绘制的基础图形，前面介绍的图形编辑命令都可以使用。例如grid、

colormap等命令都可以使用在该命令绘制的图形中。

 
例10.16 在MATLAB中绘制面积图。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的图形如图

10.22所示。



图10.22 完成的面积图形

说明

在以上程序代码中，使用了高级图形句柄语句set(gca,'Layer','top')将面积图的图层设置为

最顶层，这样图形的分格线就可以显示在其上面。

10.3.2 绘制直方图

在MATLAB中，提供了命令bar和bar3来绘制二维和三维垂直条形
图，提供了命令barh和bar3h来绘制二维和三维水平条形图。两种绘制
命令有很多相似的地方，但是也有一些不同，在本节中将使用两个简

单的实例来说明两种命令的用法。在MATLAB中，命令bar的常用调用
方式如下：

 
◆ bar(Y) 为向量Y中的每一个元素绘制一个条形。
◆ bar(x,Y) 在指定的横坐标轴x上绘制Y，其中参数x必须是严

格递增的向量。



◆ bar(...,width) 参数width用来设置条形的相对宽度和条形之
间的间距。其默认值是0.8，如果将参数width设置为1，则条形之间没
有间距。

◆ bar(...,'style') 参数style用来设置条形的形状类型，可以选择
的数值是“group”和“stack”。MATLAB的默认数值是“group”。如果选择
的数值是“stack”，则MATLAB会绘制累积直方图。

 
命令bar3和以上命令大致相同，只是由于bar3命令绘制的是三维

直方图，因此在命令bar(...,'style')中参数style的取值可以为 'detached',
'grouped'或者'stacked'。同时，MATLAB的默认值为'detached'。关于这
些参数的具体含义可以从后面的具体实例中直观地了解到。

说明

命令barh和bar3h的调用方法和命令bar和bar3大致相同，只是将结果的垂直条形图转换为

水平条形图。

 
例10.17 某公司统计了该公司3个部门在5个月内的销售情况，现

在公司需要将这些销售数据绘制成直方图，来方便公司销售部门查看

和对比。在MATLAB中，可以根据统计的数据来绘制多种直方图。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2



查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图
10.23所示。

图10.23 完成的直方图

在第一个子图中，绘制的是MATLAB的默认直方图；第二个子图
绘制的是累积直方图，因为使用的参数是“stack”；第三个子图绘制的
是水平累积直方图，相当于将第二个子图旋转90度得到的图形；最后
一个子图将直方图的宽度设置为1.5，从结果可以看出直方图中的各个
条形有交叉的情况。

例10.18 在MATLAB中绘制三维直方图，为了简化绘制步骤可以
使用函数cool返回的数值，具体步骤如下。

step 1
在MATLAB的命令窗口中输入以下命令：



step 2
查看图形结果。输入代码之后，按“Enter”键，得到的图形如图

10.24所示。

图10.24 三维直方图

10.3.3 绘制二维饼图

饼图是分析数据比例中常用的图表类型，主要用于显示各个项目

与其总和的比例关系，它强调的是部分与整体的关系。MATLAB提供
了pie和pie3命令分别绘制二维和三维饼图。
在MATLAB中，pie命令的常见调用方式如下：
 
◆ pie(X) 绘制向量X的饼图，向量X中的每一个元素就是饼图

中的一个扇形。

◆ pie(X,explode) 参数explode和向量X是同维矩阵，如果其中
有非零的元素，X矩阵中对应的位置元素在饼图中对应的扇形将向外
移出，加以突出。



◆ pie(...,labels) 参数labels用来定义对应扇形的标签。

说明

命令pie3的参数格式和命令pie大致相同，只是最后显示的结果是一个三维的饼图。

 
例10.19 在MATLAB中绘制二维饼图，分析各个部门销量所占的

比例。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.25所示。



图10.25 绘制二维饼图

10.3.4 绘制矢量图

矢量图在工程领域有着广泛的应用，特别是在物理或者通信系统

中有着更为重要的应用。在MATLAB中可以使用quiver命令十分方便
地绘制向量场的形状。

quiver命令的常用调用格式如下：
 
◆ quiver(x,y,u,v) 在坐标点（x，y）的地方使用箭头图形来绘

制向量，其中（u，v）是对应坐标点的速度分量，参数x，y，u，v必
须是同维向量。

◆ quiver(u,v) 在x-y平面坐标系中等距的坐标点上绘制向量
（u，v）。

◆ quiver(...,scale) 参数scale用来控制图中向量长度的实数，其
默认数值是1。可以根据需要重新设置该数值，以免绘制的向量彼此重
叠。

 
例10.20 在MATLAB中绘制peaks函数得到的矢量图。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2



查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图
10.26所示。

图10.26 绘制矢量图

在以上程序中，首先使用函数gradient产生peaks函数数据点的导
数数值，然后将其结果当作是quiver函数的输入数值，产生矢量图的
数据；在程序的最后一行，使用contour函数绘制了等高线，使整个图
形更加美观。

10.3.5 绘制等高线

等高线原来是属于地理领域的名词，后来等高线的概念引入到数

学或者物理领域。在MATLAB中，等高线图实质上给出函数的“地形
图”，等高线把曲面上高度相同的点连在一起。在默认情况下，
MATLAB就是画出相应于一系列相等的空间 z值的等高线。在
MATLAB中，提供了contour和contour3命令绘制二维和三维等高线，
使用这些命令可以很方便地绘制一些比较复杂的等高线。



其中，contour命令的常用调用方式如下：
 
◆ contour(Z) 变量Z就是需要绘制等高线的函数表达式。
◆ contour(Z,n) 参数n是所绘图形等高线的条数。
◆ contour(Z,v) 参数v是一个输入向量，等高线条数等于该向

量的长度，而且等高线的数值等于对应向量的元素数值。

◆ [C,h] = contour(...) C是等高线矩阵，h是等高线的句柄。
 
例10.21 在MATLAB中绘制peaks函数所得到的二维等高线。

step 1
在MATLAB的命令窗口中输入以下命令。

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.27所示。



图10.27 绘制二维等高线

10.3.6 绘制伪色彩图

在MATLAB中，伪色彩图（Pseudocolor）是指一个规则的矩形矩
阵，该矩阵中的颜色有矩阵数值决定，对应的命令是pcolor(C)。
MATLAB使用C矩阵中的每四个节点来决定一个矩形表面的颜色。伪
色彩图在效果上来看，相当于从上面向下看的一个表面图。因此，命

令pcolor(X,Y,C)相当于命令surf(X,Y,0*Z,C)和view([0 90])的组合。
在MATLAB中，pcolor命令的常见调用格式如下：
 
◆ pcolor(C) 绘制C矩阵的伪色彩图，默认情况下是线性插值

绘图。

◆ pcolor(X,Y,C) 在平面坐标系统中的（x，y）坐标点绘制C矩
阵的伪色彩图。

 
例10.22 在MATLAB中绘制函数peaks的伪色彩图。



step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.28所示。

图10.28 绘制伪色彩图

在以上程序代码中，使用了shading interp来设置图形的明暗对比
情况，然后使用前面介绍的contour命令来绘制等高线，并使用clabel命
令为等高线设置数值标示。在程序的最后，为整个图形添加了颜色标

尺，来显示各个颜色对应的数值。



这些命令在编辑图形的颜色属性时是经常遇到的，在后面的章节

中，将会对这些命令进行详细介绍。

10.3.7 绘制误差棒

误差线在数据分析中有着重要的应用，在原始图形中添加数据误

差线，可以方便用户直观地查看各个数据点的误差变化范围。

MATLAB为用户提供了errorbar命令，可以绘制沿着一曲线画出误差棒
形图，其中误差棒是数据的置信水平或者沿着曲线的偏差。当命令输

入参数是矩阵时，则按矩阵的数据列画出误差棒。

在MATLAB中，errorbar命令的常见调用格式如下：
 
◆ errorbar(Y,E) 绘制出向量Y的曲线，然后显示在向量Y的每

个元素的误差棒。误差棒表示曲线Y上面和下面的距离，因此误差棒
的长度是2E。

◆ errorbar(X,Y,E) X、Y和E必须是同类型的参量。如果三个
参数都是向量，MATLAB会绘制出带长度为2E、对称误差棒于曲线
点；如果三个参数都是矩阵，MATLAB则会绘制出带长度为E（i，
j），并对称误差棒于曲面点。

 

例10.23  在MATLAB中绘制函数 的图

形，同时绘制对应数据点的误差棒。

step 1
在MATLAB的命令窗口中输入以下命令：



step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.29所示。

图10.29 绘制曲线的误差线

在以上程序中，使用程序代码E = std(y)*ones(size(x))得到每个数
据点的误差范围，其中，std(y)函数计算得到的是函数系列y的标准
差。为了能够更好地显示误差线，将自变量x的间隔设置得较大，但是
为了保持曲线特性，也不能将其设置得过大。由于矩阵E中的所有元
素的大小相等，因此，曲线中每点的误差棒长度相等。

说明



从以上操作步骤中可以看出，误差棒线的绘制图可以像普通图形那样进行编辑，例如添

加分格线，设置坐标轴属性，设置绘制曲线的属性等。

10.3.8 绘制二维离散杆图

离散杆图也是一种常见的图形类型，这种图形沿着x坐标轴将坐标
点用直线和基准线相连，也就相当于从数据点向坐标轴作垂线，数据

点有数据标记显示。在MATLAB中，提供了二维和三维离散杆图的绘
图命令stem和stem3。
在MATLAB中，绘图命令stem的常见调用格式如下：
 
◆ stem(Y) 绘制向量Y的离散杆图，由于没有参数X的信息，

默认情况下X是沿着x坐标轴等距的、系统自动产生的数值系列。
◆ stem(X,Y) 参数X和Y必须是同维向量，绘制以X为横坐标、

Y为纵坐标的离散杆图。
◆ stem(...,LineSpec) 其他参数和前面命令相同，其中LineSpec

设置的是直线的属性。

说明

命令stem3，其参数和stem大致相同，只是绘制离散杆图的参数为三维参数，其他参数都

是类似的，可以查看MATLAB的帮助文件。

 

例10.24  在MATLAB中绘制函数 的离散杆

图，同时绘制该函数的直线图形。

step 1
在MATLAB的命令窗口中输入以下命令：



step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.30所示。

图10.30 绘制二维离散杆图

说明

根据图10.30可以看出，离散杆图可以很直观地展示每个数据点的函数数值大小情况，离

散杆图中的垂线相当于各个数据点的Y轴数值。



10.3.9 绘制散点图

在MATLAB中，提供了scatter、scatter3和plotmatrix三种命令来绘
制散点图。这三种不同的散点图可以绘制出不同效果的散点图。其

中，scatter命令的常见格式如下：
 
◆ scatter(X,Y) 绘制关于X和Y的散点图，由于没有设置散点图

的其他属性，因此MATLAB会采用默认的颜色和大小绘制数据点。
◆ scatter(X,Y,S) 参数S表示的是绘制数据点的颜色和大小。
 
命令scatter3和以上命令相似，只是绘制的散点图是三维效果的，

详细信息可以查阅MATLAB的帮助文件。
例10.25 在MATLAB中绘制柱体的三维散点图。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.31所示。



图10.31 柱形的三维散点图

说明

在以上步骤中，首先使用cylinder命令产生三维柱体的数据，然后将其计算得到的数据赋

给数组X、Y和Z。在后面的程序代码中，使用repmat、prod函数产生了散点图的颜色和大小的

数组。关于这些函数的用法，可以查看MATLAB的帮助文件。

 
plotmatrix命令的常见格式如下：
plotmatrix(X,Y, 'LineSpec')) 其中X和Y分别是多维矩阵，X的维

度是p×n，Y的维度是p×m，命令plotmatrix将会绘制出一个分割成m×n
个子图的散点图，其中第（i，j）个子散点图是根据Y第i列和X第j列
数据绘制而成的。

例10.26 在MATLAB中使用plotmatrix命令来分析数据之间的统计
关系。

step 1
在MATLAB的命令窗口中输入以下命令。



step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

10.32所示。

图10.32 表现数据的统计特征

说明

从图10.32可以看出，左边的子图形中的直方图表示变量X数据列的数据大致服从均值为0

的正态分布，而其他散点图则表示X的两个数据列之间几乎是不相关的；中间的子图则表示X

的同一列数据列是正相关；最后的子图则表示X、Y之间完全不相关。

10.3.10 极坐标图形

前面已经介绍了MATLAB在直角坐标系中的绘图命令和编辑命
令，在MATLAB中，除了可以在熟悉的直角坐标系中绘图之外，还可



以在极坐标或者柱坐标中绘制各种图形。在MATLAB中，绘制极坐标
图形的主要命令是polar，其常用的调用格式如下：

 
◆ polar(theta,rho) 该命令使用极角theta和极径rho绘制极坐标

图形。

◆ polar(theta,rho,LineSpec) 参数LineSpec表示的是极坐标图
形中的线条线型、标记和颜色等主要属性。

 
例10.27 在MATLAB中绘制简单的极坐标图形。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的图形如图

10.33所示。



图10.33 简易极坐标图形

10.3.11 柱坐标图形

在MATLAB中，绘制柱坐标图形的主要命令是pol2cart，这个命令
用于将极坐标或者柱坐标的数值转换成为直角坐标系下的坐标值，然

后使用三维绘图命令进行绘图，也就是在直角坐标系下绘制使用柱坐

标值描述的图形。

例10.28 在MATLAB中绘制简单的柱坐标图形。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入以上代码后，按“Enter”键，得到的图形如图

10.34所示。



图10.34 柱坐标图形

10.4 小结

在本章中，主要讲解了在MATLAB中如何绘制和编辑二维图形。
在MATLAB中，用户可以绘制函数的二维图形，并可以根据需要编辑
二维图形的属性。最后，对于一些常见的特殊图形类型，MATLAB也
分别提供了相应的命令，用户可以方便地绘制出对应的图形。

◆   ◆   ◆



第11章 三维图形

本章包括

◆绘制三维图形

◆设置三维图形属性

◆设置照明

◆设置透视属性

◆绘制四维切片图

◆绘制复数变量图

◆图形的输出和打印

 
前面已经介绍过如何在MATLAB中绘制二维图形，本章将详细介

绍如何绘制三维图形。三维图形比二维图形复杂，在编辑三维图形的

时候，会涉及例如灯光、材质或者照明之类的属性。同时，除了三维

图形，MATLAB中还可以绘制四维图形和复数图形等。本章将针对这
些内容进行详细讲解。

11.1 绘制三维曲线

下面将详细介绍在MATLAB中绘制三维曲线的命令和方法。尽管
二维绘图和三维绘图在很多地方是共通的，但是三维曲线在很多方面

是二维曲线没有涉及的，因此，本节需要详细介绍三维曲线的命令方

法。

11.1.1 绘制三维图形——plot3命令



和二维曲线命令相似，plot3命令是绘制三维曲线的基础命令，也
是最简单的命令，其调用格式和plot非常相似，具体的调用格式如
下：

plot3(X,Y,Z,LineSpec, 'PropertyName',PropertyValue,....)  对于
不同的输入参数X、Y和Z，该命令会得出不同的曲线结果。

 
◆ 当X、Y和Z是同维向量时，MATLAB会绘制以X、Y和Z元素

为x、y、z坐标的三维曲线。
◆ 当X、Y和Z是同维矩阵时，MATLAB会绘制以X、Y和Z对应

列元素为x、y、z坐标的三维曲线，曲线的个数等于矩阵的列数。
◆ 参数LineSpec主要是定义曲线的线型、颜色和数据点等；参

数PropertyName是曲线对象的属性名，PropertyValue是对应属性的取
值。

 
例11.1 在MATLAB中绘制圆锥螺线的三维图形。
根据高等数学知识，圆锥螺线的三维参数方程如下：

在以上参数方程中，圆锥角为2α，旋转角速度为ω，直线速度为
v。为了简化绘制过程，在本实例中仅保留参数t来绘制三维曲线，具
体步骤如下：

step 1
在MATLAB的命令窗口中输入以下内容：



step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

11.1所示。

图11.1 绘制三维圆锥曲线

说明

在MATLAB中，三维曲线的绘制命令plot3主要用来绘制单参数的三维曲线，对于有多个

参数的曲线，需要使用其他的绘图命令。

11.1.2 绘制三维曲线图——mesh命令



当绘制三维曲线的时候，除了需要绘制单根曲线，还经常需要绘

制三维曲线的曲线图和曲面图，为此MATLAB提供了mesh和surf命
令，分别用来绘制三维曲线图和曲面图，这里将详细介绍这些函数的

用法。在MATLAB中，绘制三维函数z＝f（x，y）的时候进行数据准
备的原理基本上等于以下程序代码：

在这段代码中，得到的X、Y数组就是x-y平面上的自变量采样“格
点”矩阵。其中，dx、dy表示两个自变量的取值间隔。而X、Y则使用
相应的命令产生了数据点的矩阵。MATLAB会以此数据点矩阵为自变
量的取值，绘制相应的网格线。

在MATLAB中，mesh的常用调用方式如下：
 
◆ mesh(z) 以z为矩阵列、行下标为x、y轴自变量，绘制网线

图。

◆ mesh(x,y,z) 最常用的网格线调用格式。
◆ mesh(x,y,z,C) 最完整的调用方式，画出由C指定颜色的网格

线。

 
以上调用格式中，相同参数的含义是一致的，因此在这里仅仅解

释最完整的调用方式中各个参数的含义：其中，x、y是自变量“格
点”矩阵；z是建立在“格点”之上的函数矩阵；C是指定各点用色的矩
阵，一般情况下可以省略。默认情况下，没有指定矩阵C，MATLAB
会认为C＝Z。
例11.2 在MATLAB中绘制函数peaks的三维网格线。

说明



peaks是MATLAB的内置函数，是一个二元函数，作用是返回Gaussian（高斯）分布的数

值。默认情况下，peaks的参数x和y的取值范围都是[-3，3]。函数peaks(N)将会返回一个N×N

矩阵，该函数在显示三维图形中有着广泛的应用，本小节为了简化步骤，可以绘制peaks(25)

的曲线。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

11.2所示。

图11.2 使用mesh命令绘制三维曲线

在以上程序代码中，使用了colormap函数来为三维图形设置颜
色，该命令是MATLAB的内置函数，可以使用RGB和HSV系统对曲线
进行着色。可以在图形窗口中选择 “Edit”→“Colormap”命令，打



开“Colormap Editor”对话框，在该对话框中对图形的颜色进行更加详
细的设置，如图11.3所示。

图11.3 “Colormap Editor”对话框

在 “Colormap Editor”对话框中，可以选择 “Tools”→“Standard
colormaps”命令，查看colormap命令的常见参数，例如hot、jet、bone
等，这些参数其实是MATLAB内部程序设定的颜色参数。例如，cool
代表的是“cyan-magenta”颜色，也就是本实例中的颜色。

说明

colormap函数经常被用来为三维曲线设置颜色，了解该函数的参数会使三维曲线的颜色

设置十分方便。可以在MATLAB中查看关于该函数的帮助信息。

11.1.3 绘制等高线

在MATLAB中，还有很多和mesh命令相互联系的命令，例如
meshz、meshc等，这些命令的调用格式都和mesh命令相似，只是在功



能上有些区别，主要区别如下：

 
◆ meshc的功能是在mesh命令绘制的三维曲面图下绘出等高线。
◆ meshz的功能是在mesh命令的作用之上增加绘制边界的功能。
 
例11.3 在MATLAB中绘制函数peaks的三维曲面的等高线和边界

曲线。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

11.4所示。

图11.4 绘制三维曲线的等高线



step 3
在MATLAB的命令窗口中输入以下内容：

step 4
查看图形结果。输入代码之后，按“Enter”键，得到的曲线如图

11.5所示。

图11.5 绘制三维曲线的边界曲线

11.1.4 绘制曲面图——surf命令

在MATLAB中，绘制三维曲面图的主要命令是surf，该命令可以
绘制已经着色的三维曲面。默认的着色方法是得到相应的网格后，对

每一个网格依据该网格所代表的节点的色值来定义该网格的颜色。

在MATLAB中，surf命令的常见调用格式如下：



 
◆ surf(z) 以z为矩阵列、行下标为x、y轴自变量，绘制曲面

图。

◆ surf(x,y,z) 最常用的曲面图线调用格式。
◆ surf(x,y,z,C) 最完整的调用方式，画出由C指定用色的曲面

图。

 
该命令中的参数和mesh命令类似，这里就不再重复介绍了。本节

中将使用一个简单的例子来介绍surf命令的使用方法。
 
例11.4 在MATLAB中绘制函数peaks的三维曲面图。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2
查看图形结果。输入代码之后，按“Enter”键，得到的曲面图如图

11.6所示。



图11.6 使用surf命令绘制三维曲面图

与mesh命令类似，在MATLAB中也有一些和surf命令相互联系的
命令，例如surfl、surfc等，这些命令的主要功能如下：

 
◆ surfl的功能是产生一个带有阴影效果的曲面，该阴影效果是

基于环绕、分散、特殊光照等模型得到的。

◆ surfc的功能是在surf命令的作用之上增加曲面的等高线。
 
例11.5 在MATLAB中绘制函数peaks的三维曲面图的阴影曲面和

等高线。

step 1
在MATLAB的命令窗口中输入以下内容：

step 2



查看图形结果。输入代码之后，按“Enter”键，得到的图形如图
11.7所示。

图11.7 绘制阴影效果的曲面

step 3
在MATLAB的命令窗口中输入以下内容：

step 4
查看图形结果。输入代码之后，按“Enter”键，得到的图形如图

11.8所示。



图11.8 绘制三维曲面的等高线

11.2 编辑三维图形

本节将详细介绍如何进行三维图形的编辑。对于三维图形，除了

可以像二维图形那样编辑线型、颜色等，还需要编辑三维图形的视

角、材质、照明等。这些内容都是三维图形的特殊编辑工作，都是二

维图形所没有的，因此需要详细介绍关于三维图形的编辑工作。

11.2.1 控制视角——view命令

三维视图表现的是一个空间内的图形，可以从不同的位置和角度

来观察该图形。而且，对于空间视图变化比较大的三维视图，使用不

同的视角会产生完全不同的效果。为了可以对每个图形使用最佳的视

觉角度，MATLAB提供了对图形进行视觉控制的命令，主要有两类命
令，其中第一类命令为view，可以使用该命令来改变图形的观察点；
另一类命令为rotate，使用这个命令，可以直接对三维图形进行旋转。
在MATLAB中，view命令的常见调用格式如下：



 
◆ view(az,el)、view([az,el]) 该命令的功能是为三维空间图形设

置观察点的方位角。方位角az（azimuth）和仰角el（elevation）是按照
以下方法定义的两个旋转角度：做一个通过用户视点和z轴的平面，该
平面会和xy平面有一个交线，该交线和y轴的负方向之间有一个夹角，
该夹角就是视点的方位角；在通过视点和z轴的平面上，用一条直线来
连接视点和坐标原点，该直线和xy平面的夹角就是观察点的仰角。

◆ view([x,y,z]) 在笛卡儿坐标系中将视角设置为沿着向量[x,y,z]
指向原点，例如view([0,0,1])=view(0,90)。也就是在笛卡儿坐标系中将
点(x,y,z)设置为视点。

◆ view(2) 设置默认的二维形式视点。其中az＝0，el＝90。
◆ view(3)  设置默认的三维形式视点。其中az＝-37.5，el＝

30。
 
例 11.6  在 MATLAB 中 从 不 同 的 视 角 查 看 三 维 函 数

的图形。

step 1
在MATLAB的命令窗口中输入以下命令：



step 2
查看图形结果。输入以上代码后，按“Enter”键，得到的图形如图

11.9所示。

图11.9 为三维图形设置视角

说明

MATLAB为用户设置了视点转换矩阵命令viewmtx。该命令计算一个4×4阶的正交的或者

透视的转换矩阵，该矩阵将一个四维的、齐次的向量转换到一个二维的平面中。关于该命令

的信息，可以查看相应的帮助文件。



11.2.2 控制旋转——rotate命令

在MATLAB中，rotate命令的常见调用格式如下：

该命令将图形句柄h的对象绕方向旋转一个角度。其中参数h表示
的是被旋转的对象（例如线、面等）；参数direction有两种设置方
法：球坐标设置法，将其设置为[theta,phi]，其单位是“度”；直角坐标
法，也就是[x,y,z]；参数alpha是绕方向按照右手法则旋转的角度。

说明

与命令view不同的是，用户使用了命令rotate，则通过旋转变换改变了原来图形对象的数

据。而命令view则没有改变原始数据，只是改变视角。

 
例11.7 在MATLAB中从不同的视角查看函数peaks的三维图形。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入以上代码后，按“Enter”键，得到的图形如图

11.10所示。



图11.10 图形对象的旋转

说明

从图11.10可以看出，使用命令view旋转的是坐标轴，而使用命令rotate旋转的是图形对象

本身，而坐标轴保持不变。

 
在MATLAB中，还提供了一个动态旋转命令rotate3d，使用该命令

可以动态调整图形的视角，直到用户觉得合适为止，而不用自行输入

视角的角度参数，下面使用一个简单的实例来说明如何使用命令

rotate3d。
例11.8 在MATLAB中动态调整函数peaks的三维图形的视角。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2



查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.11
所示。

图11.11 原始的peaks函数图形

step 3
在MATLAB的命令窗口中输入以下命令：

step 4
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.12

所示。



图11.12 旋转三维图形

从图11.12可以看出，当用户输入rotate3d命令后，图形中出现旋转
的光标，可以在图形窗口的区域中按住鼠标左键来调节视角，在图形

窗口的左下方会出现用户调整的角度，在本例中Az＝-71；El＝16。

提示

为了能够在MATLAB中获得最好的视觉效果，可以先使用rotate3d命令使用鼠标来操作调

节视角，然后再使用指令将调整后的视角加以固定。例如在本例中，首先使用rotate3d命令将

图形调整到合适的视角，然后将图形中显示的视角数值设置到view函数中。

11.2.3 设置背景颜色

图形的色彩是图形的主要表现因素，丰富的颜色变化可以让图形

更具有表现力。在MATLAB中，提供了多种色彩控制命令，这些命令
分别适用于不同的环境，可以对整个图形中的所有因素进行颜色设

置。



在MATLAB中，设置图形背景颜色的命令是colordef，该命令的常
用调用格式如下：

 
◆ colordef white 将图形的背景颜色设置为白色。
◆ colordef black 将图形的背景颜色设置为黑色。
◆ colordef none 将图形背景和图形窗口的颜色设置为默认的

颜色。

◆ colordef(fig,color_option) 将图形句柄fig的图形的背景设置
为由color_option设置的颜色。

说明

colordef命令属于设置图形对象的上层命令，它将影响其后产生的图形窗口中的所有图形

对象的颜色设置。当在第一个参数fig中指定了设置颜色的图形窗口的图柄或者字符串，其影

响就限于指定的图形窗口。

 
例11.9 在MATLAB中为函数peaks的图形设置不同的背景颜色。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.13

所示。



图11.13 设置不同的背景颜色

说明

在MATLAB中，用户除了可以设置图形的背景颜色之外，还可以设置图形中坐标轴的颜

色。其相关的命令为whitebg，限于篇幅，本书中不展开分析该命令，感兴趣的读者可以查阅

MATLAB的帮助文件。应当注意的是whitebg命令只影响当前或者指定图形窗口的坐标轴的颜

色。

11.2.4 设置图形颜色

从前面的内容中可以看出，在MATLAB中可以很方便地设置图形
的背景颜色。但是，修饰图形的颜色，则还需要使用其他的命令。在

MATLAB中处理图形颜色的重要命令是colormap。前面已经多次接触
到了该命令，在本小节中将详细介绍该命令的使用方法以及相应的原

理。



MATLAB采用颜色映像来处理图形颜色，也就是RGB色系。在
MATLAB中，每种颜色都是由三个基色的数组表示的。数组元素R、G
和B在[0,1]区间取值，分别表示颜色中红、绿、蓝三种基色的相对亮
度。通过对R、G、B大小的设置，可以调制出不同的颜色。在
MATLAB中，当使用绘图命令时，所有线条的颜色都是通过RGB调制
出来的，表11.1列出一些常见的颜色配比方案。

表11.1 常见的颜色配比方案

当调好相应的颜色后，就可以使用MATLAB中的常见绘图命令来
调用这些颜色，例如mesh、surf等，调用色图的基本命令是：

其中，函数的变量[R,G,B]是一个三列矩阵，行数不限，这个矩阵
就是所谓的色图矩阵。在MATLAB中，每一个图形只能有一个色图。
色图可以通过矩阵元素的直接赋值来定义，也可以按照某个数据规律

产生。

MATLAB预定义了一些色图矩阵CM数值，它们的维度由其调用
格式来决定：



 
◆ CM 返回维度为64×3的色图矩阵。
◆ CM(m) 返回维度是m×3的色图矩阵。
 
表11.2列出了MATLAB中的色图矩阵名称以及含义。

表11.2 MATLAB中的CM名称

例11.10 在MATLAB中绘制函数peaks的图形，同时设置该图形
的颜色。

step 1
在MATLAB的命令窗口中输入以下命令。

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.14

所示。



图11.14 使用cool绘图

11.2.5 设置数值轴的颜色

除了colormap函数，MATLAB还提供了多种颜色设置命令，来设
置图形中其他元素的颜色特性，其中caxis命令和colorbar命令是经常使
用的命令，下面将详细介绍这两个命令的调用方式。在MATLAB中，
caxis命令的主要功能是设置数值轴的颜色，控制数值和色彩间的对应
关系，常用调用格式如下：

 
◆ caxis([cmin cmax]) 在[cmin cmax]范围内与色图矩阵中的色

值相对应，并依此为图形着色。如果数据点的数值小于cmin或大于
cmax，则按照等于cmin或cmax进行着色。

◆ caxis auto MATLAB自动计算出色值的范围。
◆ caxis manual 按照当前的色值范围设置色图范围。
◆ caxis(caxis) 和caxis manual实现相同的功能。
 



例11.11 在MATLAB中绘制函数peaks的图形，同时设置该图形的
颜色。

step 1
在MATLAB的命令窗口中输入以下命令。

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.15

所示。

图11.15 使用caxis命令为图形设置颜色

11.2.6 添加颜色标尺

在MATLAB中，colorbar命令的主要功能是显示指定颜色刻度的颜
色标尺，其常用调用格式如下：

 



◆ colorbar 更新最近生成的颜色标尺。如果当前坐标轴系统中
没有任何颜色标尺，则在图形的右侧显示一个垂直的颜色标尺。

◆ colorbar('vert') 添加一个垂直的颜色标尺到当前的坐标轴系
统中。

◆ colorbar('horiz') 添加一个水平的颜色标尺到当前的坐标轴
系统中。

 
例11.12 在MATLAB中绘制函数peaks的图形，同时在图形中添

加水平颜色标尺。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.16

所示。



图11.16 为图形添加水平颜色标尺

说明

在图11.16中只是向前面步骤完成的图形中添加了水平颜色标尺，但是其数值信息却更加

详细。可以通过对比标尺中的数值和图形中的颜色，而查看出对应数据点的数值。

 
例11.13 在MATLAB中绘制函数peaks的图形，使用不同的色图

矩阵来为该图形设置不同的颜色。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.17

所示。



图11.17 为图形设置不同的颜色

说明

从图11.17可以看出，当为图形设置不同的颜色矩阵时，同一个图形会显示出不同的颜

色，同时配有颜色标尺可以很清楚地查看对应的数值。

11.2.7 设置图形的着色

在MATLAB中，除了可以为图形设置不同的颜色之外，还可以设
置颜色的着色方式。对于绘图命令mesh、surf、pcolor、fill等创建的图
形非数据处的着色由shading命令决定。在MATLAB中，shading命令有
三种参数选项。

 
◆ shading flat 使用平滑方式着色。网格图的某条线段，或者

曲面图中的某整个贴片都是一种颜色，该颜色取自线段的两端，或者

该贴片四顶点中下标最小那点的颜色。

◆ shading interp 使用插值的方式为图形着色。使用网线图线
段，或者曲面图贴片上各点的颜色由该线段两端，或者该贴片四顶点



的颜色线性插值而得。

◆ shading faceted 以平面为单位进行着色，是系统默认的着色
方式。在flat用色基础上，再在贴片的四周勾画黑色网线。

 
例11.14 在MATLAB中绘制圆柱图形，然后使用三种不同的着色

方式为图形着色。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.18

所示。



图11.18 设置图形的不同着色方式

说明

实质上，命令shading是编辑图形的高层命令，相当于设置当前轴上的“面”对象的

EdgeColor和FaceColor属性，可以使用后面章节中的底层命令得到相同的效果。

11.2.8 控制照明——light命令

在三维图形中，除了填充颜色和着色处理之外，还需要设置图形

的灯光设置、照明模式和反射光处理，这样图形才能显得更加美观。

在本小节中，将介绍关于三维图形照明控制的相关命令，灵活使用这

些命令可以使三维图形显得更加真实。下面将首先介绍灯光light命
令，这是MATLAB中进行光照的基础命令，功能是为图形建立光源，
其调用格式如下：

其中PropertyName属性名是一些用于光源的颜色、位置和类型等
的变量名，更为详细的介绍可以查阅相应的帮助文件。关于light命
令，需要了解的信息如下：

 
◆ 在使用这个命令之前，MATLAB会对图形采用强度各处相等

的漫射光源。用户开始使用该命令，光源本身并不会出现，但是图形

中的各个对象所有和“光”相关的属性都会被激活。
◆ 该命令的参数可以省略，当用户不输入任何参数的时候，

MATLAB会采用默认设置的光照：白光、无限远、透过[1，0，1]射向
坐标轴。

◆  对于该命令中的位置属性，可以选择两个数值：infinite和
local。前者表示光照的位置是无限远，后者表示光照的位置是近光。



 
例11.15 在MATLAB中绘制peaks函数的三维图形，然后使用不

同的照明效果。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.19

所示。

图11.19 不同的照明控制

说明

在图11.19中，“Default”子图形采用的是默认光照效果，“Red-Local Light”子图形采用的光

照是红色的近光，而且射向图形的角度是[1 0 1]。从图中可以明显地看出光照对图形显示的影



响。

11.2.9 控制照明——lighting命令

除了和灯光相关的light命令，MATLAB还提供了设置曲面光源模
式的lighting命令，使用该命令可以显示不同的照明模式，但是lighting
命令必须在light命令执行后才能起作用，该命令的调用格式如下：

 
◆ lighting flat 平面模式，这是系统的默认模式。入射光均匀

洒落在图形对象的每个面上，主要和faced一起配合使用。
◆ lighting gouraud 点模式。先对顶点颜色进行插补，再对顶

点勾画的面色进行插补。

◆ lighting phong 对顶点处法线插值，再计算像素的反光。表
现效果最好，但是比较耗时。

◆ lighting none 关闭所有的光源。
 
例11.16 在MATLAB中绘制圆柱图形的三维图形，然后使用不同

的照明效果。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2



查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.20
所示。

图11.20 不同的光照效果

11.2.10 控制材质——material命令

在本小节的最后，介绍另外一个十分常见的material命令，该命令
可以控制光照效果的材质属性，也就是设置图形表面对光照反射的模

式，其常用的调用格式如下：

 
◆  material options  该命令使用预定义的反射模式。对于

options的不同选项，其对应的选项含义如下：
 
●shiny 使对象比较明亮。镜反射份额较大，反射光的颜色取决

于光源颜色。

●dull 使对象比较暗淡。漫反射份额较大，反射光的颜色取决于
光源颜色。



●metal 使对象有金属光泽。反射光的颜色取决于光源颜色和图
形表面的颜色，这是MATLAB内部的默认设置。

●default 返回到MATLAB中的默认设置。
 
◆ material([ka kd ks n sc]) 该命令可以使用专门的个性化设

置，对反射的要素进行直接的设置，对应参数的含义如下：

 
●ka 设置无方向性、均匀的背景光的强度。
●kd 设置无方向性的漫反射的强度。
●ks 设置有硬反射光的强度。
●n 设置控制镜面亮点大小的镜面指数。
●sc 设置镜面颜色的反射系数。
 
例11.17 在MATLAB中绘制peaks函数的三维图形，同时设置不

同的光照效果。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.21

所示。



图11.21 设置不同的光照效果

11.2.11 控制透视

在MATLAB中使用mesh、surf等命令绘制三维图形，在默认情况
下，MATLAB会隐藏重叠在后面的网格线，有时用户需要看到隐藏的
网格线，这个时候需要使用透视控制命令。在MATLAB中，透视控制
命令如下：

 
◆ hidden off 透视被缩压的图形。
◆ hidden on 消隐被缩压的图形。
 
例11.18 在MATLAB中演示透视效果。

step 1
在MATLAB的命令窗口中输入以下命令：



step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.22

所示。

图11.22 透视球体

11.2.12 控制透明

从MATLAB 6.x版本开始，系统增加了透明处理的相关命令，该
命令的主要功能是使用透明技术显示复杂图形的内部结构，和前面章

节介绍的色彩和光照控制类似，透明技术也可以为数据显示提供可视

化的手段。

在MATLAB中，将透明度设置为[0，1]区间上的数值，其中0表示
图形是全透明的，1表示图形是不透明的，这种量化的数值被称为
Alpha值。在MATLAB中，每一个图形窗口中都有一个透明表，在默



认情况下，图形透明表是一个数组，其元素的数值都是在[0，1]区间
中取值，其中第一个元素数值为0，最后一个元素的数值为1，其他元
素按照均匀递增方式进行排列。

限于篇幅，本书对于图形透明设置的原理就不详细介绍了，在本

小节中，主要介绍MATLAB中透明度的处理方式。以根据3个m×n数值
矩阵X、Y和Z所绘制得到的曲面为例，MATLAB有三种透明度的处理
方式：

 
◆ 标量：使所有的数据点都设置相同的透明度。
◆ 线性数据：使曲面数据点的透明度按照某个指定维度的方向

线性变化。

◆ m×n矩阵：使每个数据点选取不同的透明度。
 
以上处理方式分别对应MATLAB中的Alpha函数中的参数，当参

数是标量时，曲面中的所有数据点都是相同的透明度；当Alpha函数中
的参数是线性数据时，曲面的透明度按照某个维度的方向线性变化。

除了使用Alpha函数分别设置曲面数据点的透明度之外，
MATLAB还提供了alim函数来设置透明度的上下限，将其上下限设置
为 。在MATLAB中设置透明度的上下限需要和上下限模

式配合使用。MATLAB的对应命令是alim，其参数就是对应设置Alpha
轴的上下限。

例11.19 在MATLAB中显示peaks函数的不同线性透明度效果。

step 1
在MATLAB的命令窗口中输入以下命令：



step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.23

所示。

图11.23 设置不同的线性透明度

说明

从图11.23可以看出，上图透明度沿着X轴不断加强，下图的透明度则沿着Y轴不断加强。

 
例11.20 在MATLAB中显示peaks函数的三维图形，将图形的上

半部分设置为不透明，下半部分设置为全透明。

step 1



在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.24

所示。

图11.24 设置图形上下两个部分的透明度

说明

在MATLAB中，当函数alpha中的参数是数值矩阵或者标量时，其得到的结果就是不同的

透明度设置情况。但是，alpha函数还可以选择其他的参数类型，设置的是图形透明度映射方

法，参数分别是none、scaled和direct，对应不同的透明度映射方式。在本例中，选择scaled映

射方式表示的是将alim上下限映射到透明表的一段。其他映射方式可以参考MATLAB的帮助

文件。

 



例11.21 在MATLAB中显示peaks函数的三维图形，将图形的透
明度设置为V型，也就是在z方向上中部最透明，上下两部分最不透
明。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.25

所示。

图11.25 设置三维图形的特殊透明度

说明



在图11.25中使用了alphamap命令来设置图形窗的透明度表，参数数值为vdown，表示图

形的透明度情况是中部最透明，上下两部分则最不透明。关于alphamap命令的详细信息，可

以参考MATLAB的相关帮助文件。

11.3 三维图形的简易命令

和绘制二维函数的图形类似，在MATLAB中，绘制三维函数的图
形，同样也有一些简易命令，和三维绘图常见的各种命令相对应，三

维图形的简易命令包括ezmesh、ezmeshc、ezsurf和ezsurfc等。
这些命令都是在对应的绘图命令前面添加了ez的字样，表示是一

种简易命令。关于这些常见命令的调用格式和前面小节中简易命令相

似，就不重复介绍了。在本小节中，将使用各种实例来说明这些函数

的用法。

 
例11.22 在MATLAB中，使用三维图形的简易命令来绘制函数

的曲面线以及等高线。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.26

所示。



图11.26 绘制三维图形网格线以及等高线

说明

和前面介绍的二维简易命令类似，用户只是指定了二元函数中参数的定义域，和整个三

维函数的表达式，通过简易命令就可以绘制出相应的图形。

 
例11.23 在MATLAB中，在圆域上绘制函数f（x，y）＝x2＋y2的

图形，同时为该函数图形设置相应的颜色和光照信息。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.27

所示。



图11.27 使用三维简易命令绘图

说明

在三维简易命令ezsuf中，当选用circ参数时，表示的是指定图形在“圆域”上绘制。相应的

圆域是极坐标系，该命令可以十分方便地绘制圆域中的图形。

11.4 四维图形

对于三维图形，可以利用z＝z（x，y）的函数关系来绘制函数，
该函数的自变量只有两个，从自变量的角度来讲，就是二维的。但

是，在实际生活和工程应用中，有时会遇到自变量个数为3的情况，这
个时候自变量的定义域是整个三维空间。而计算机有显示维度，只能

显示三个空间变量，不能表示第四维的空间变量。对于这种矛盾关

系，MATLAB采用了颜色、等位线等手段来表示第四维的变量。

11.4.1 绘制切片图——slice命令



在MATLAB中，使用slice等相关命令来显示三维函数切面图、等
位线图，可以很方便地实现函数上的四维表现。slice命令的常用调用
格式如下：

 
◆ slice(V,sx,sy,sz) 显示三元函数V＝V（X，Y，Z）所确定的

超立体形在x轴、y轴和z轴方向上的若干点的切片图，各点的坐标由数
量向量sx，sy，sz指定。

◆ slice(X,Y,Z,V,sx,sy,sz) 显示三元函数V＝V（X，Y，Z）所确
定的超立体形在x轴、y轴和z轴方向上的若干点的切片图。也就是说，
如果函数V＝V（X，Y，Z）有一个变量X取值X0，则函数V＝
V（X0，Y，Z）变成一立体曲面的切片图。各点的坐标由数量向量
sx，sy，sz指定。

◆ slice(V,XI,YI,ZI) 显示由参量矩阵XI，YI和ZI确定的超立体
图形的切片图。参量XI，YI，ZI定义了一个曲面，同时会在曲面的点
上计算超立体V的数值。

◆ slice(...,'method') 参数method用来指定内插值的方法。常见
的方法包括linear、cubic和nearest等，分别对应不同的插值方法。

说明

在MATLAB中，和slice相关的命令还有contourslice和streamslice等，分别绘制出不同的切

片图形。在通常的情况下，需要将上面多种切片图一起使用。

 
例11.24 在MATLAB中表现水体水下射流速度数据flow的切片

图。

step 1
在MATLAB的命令窗口中输入以下命令：



step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.28

所示。

图11.28 切片图

说明

在以上程序代码中，最后的程序代码行都是对该三维图形进行颜色和视角的编辑工作，

目的是为了使用户能够更好地查看该图形。关于这些代码的说明将在后面的章节中详细介

绍。

11.4.2 绘制切面等位线图



例11.25 在MATLAB中表现水体水下射流速度数据flow的切面等
位线图。

step 1
在MATLAB的命令窗口中输入以下命令。

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.29

所示。

图11.29 切面等位线图

11.4.3 绘制流线切面图



例11.26 在MATLAB中绘制函数peaks的流线切面图。

step 1
在MATLAB的命令窗口中输入以下命令。

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.30

所示。



图11.30 流线切面图

11.5 图形窗口

除了在MATLAB的命令窗口中输入命令来创建图形之外，还可以
借用MATLAB提供的图形窗口，这是一个交互式的窗口，可以很方便
地编辑各种图形。MATLAB 7.0相对于之前的6.x版本，在图形窗口的
功能上有了较大的改进，可以在该图形窗口界面上实现几乎所有的编

辑功能。

在命令窗口中输入绘图命令后，MATLAB就会自动调用图形窗
口，因此用户也许并不了解该窗口的创建方法以及作用。为此，这里

首先介绍如何创建和控制图形窗口，后面将介绍如何利用图形窗口编

辑MATLAB的图形。

11.5.1 创建和控制图形窗口

在MATLAB中，创建图形窗口的命令是figure，该命令的常见调用
格式如下：

 
◆ figure：创建一个图形窗口对象。
◆ figure('PropertyName',PropertyValue,...)：按照用户自定义的

属性来创建一个图形窗口对象，可以对该图形窗口设置相应的属性。

◆ figure(h)：如果图形句柄h已经存在，则该命令会使得该图形
窗口成为当前窗口。如果图形句柄h不存在，则创建一个句柄值为h的
图形窗口对象。

◆ h = figure(...)：返回图形窗口对象的句柄。
 



如果希望了解当前或者已知图形句柄的窗口信息，可以使用以下

命令：

 
◆ get(n)：返回句柄值为n的图形窗口的参数名称以及当前数

值。

◆ set(n)：返回可为句柄值为n的图形窗口的参数名称以及可以
为这些参数设置的数值。

 
例11.27 在MATLAB中，使用相应的命令创建一个图形窗口对

象。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.31

所示。



图11.31 创建图形窗口对象

说明

在默认情况下，如果只是输入命令“figure”，则会创建名为“Figure 1”的图形窗口。而在以

上程序行中输入的命令为“figure(3)”，创建的窗口名称则为“Figure 3”。

 
例11.28 在MATLAB中，使用相应的命令查看例11.27中创建的图

形窗口属性。

step 1
在MATLAB的命令窗口中输入“get(3)”，得到以下窗口信息：



step 2
在MATLAB的命令窗口中输入“set(3)”，得到以下窗口信息：

说明

限于本书的篇幅，上面两段程序代码中都省略了一些图形窗口的信息，用户可以自行在

MATLAB命令窗口中演示相应的命令行代码。由于在以上步骤中，只是创建了基础图形窗

口，没有设置其他的窗口信息，因此上面程序描述的就是默认窗口信息。

11.5.2 使用工具栏编辑图形

相对于MATLAB 6.x以及之前更新的版本，MATLAB 7.0对图形窗
口的工具栏进行了较大幅度的改进。其中，最显著的改进之处在于增

加了移动图形、在图形中动态取点以及为图形中的数据点增加pin等功
能。在本小节中，将使用一个简单的实例来显示这些新增的功能。



例11.29 在MATLAB中，使用简单的函数实例来演示MATLAB新
增的功能。

step 1
在MATLAB中绘制一个新的函数图形，该函数的源数据是一个

100×1的随机数值矩阵，由MATLAB的内置函数rand产生，可以使用
MATLAB 7中新增的工具栏来绘制该函数图形，如图11.32所示。

图11.32 利用窗口菜单创建图形

其中使用了“工作空间”中的绘图按钮直接绘制变量x的图形，当用
户选择了相应的图形类型后，MATLAB会自动创建图形，如图11.33所
示。



图11.33 创建图形窗口以及窗口图形

step 2
查看局部数据变化情况。可以单击图形窗口工具栏中的“放大”按

钮 ，然后选择需要放大的局部数据，在图形窗口中画出放大的范

围，如图11.34所示。当用户松开鼠标后，图形窗口中会显示放大后的
局部图形，可以在放大后的图形中编辑相应的图形，如图11.35所示。



图11.34 放大局部数据

图11.35 放大后的局部数据

step 3
移动图形，查看不同的数据范围。由于在以上步骤中放大了局部

数据，图形中X坐标轴的刻度范围变小，如果需要查看其他数据范围
的函数情况，就需要在图形窗口中移动图形。单击工具栏中的 按

钮，移动图形，如图11.36所示。



图11.36 移动图形

说明

当移动图形的时候，图形窗口中会显示“手形”的移动图标，表示图形处在移动当中。同

时，图形窗口中的X轴和Y轴刻度范围会自动调整，来实现最好的显示结果。

step 4
查看图形数据点的坐标值。单击工具栏中的取点按钮 ，然后

在图形窗口中选择图形中的数据点，查看该数据点的坐标值，如图

11.37所示。



图11.37 查看图形数据点的坐标值

说明

在图形中选择数据点后，MATLAB图形中就会显示数据点的坐标值，只要是函数图形中

的任何数据点，都可以很方便地查看该点的坐标值。

step 5
修改坐标值的显示方式。图11.37中显示的是默认方式，可以修改

坐标值的显示方式。选中上一步显示的坐标值框，然后单击鼠标右

键，在弹出的快捷菜单中选择 “Display Style”→“Window Inside
Figure”命令，如图11.38所示。当选择相应的选项后，可以查看修改后
的坐标值显示方式，如图11.39所示。



图11.38 修改坐标值的显示方式

图11.39 修改后的显示方式

说明

当确定坐标值的显示方式后，再次单击图形窗口工具栏中的“取点”按钮，就可以查看修

改后的坐标值显示方式。为了显示图形窗口的其他工具按钮，在本步骤中需要删除该坐标值

数值。

step 6



添加图形的注释文件。前面曾经使用过annotation命令来添加图形
注释，其实使用图形窗口可以很方便地完成这样的工作。选择图形窗

口工具栏中的“添加文字箭头”按钮 ，然后在图形中设置注释文字，

如图11.40所示。

图11.40 添加图形文字注释

说明

为了更好地解释图形窗口中的工具栏按钮，可以选择菜单栏中的“View”下拉菜单中的前

三个菜单选项，显示图形窗口的所有工具栏按钮。

step 7
移动图形窗口，查看图形注释文件。现在已经添加了图形的文字

注释，可以移动图形窗口来查看注释文件的变化，如图11.41所示。



图11.41 移动图形窗口

从图形窗口中可以看出，当用户移动图形窗口时，文字注释并不

会随着图形移动，而固定在图形注释文件的插入点上。

step 8
固定注释文件。选择所添加的文字注释，然后单击图形窗口中

的“pin to axes”按钮 ，再选择注释文件的固定点，如图11.42所示。

当固定图形中的注释文字后，再次移动图形窗口，就可以查看文字注

释已经固定在原来的数据点上，如图11.43所示。



图11.42 固定图形的注释文件

图11.43 移动图形窗口

11.5.3 使用绘图工具编辑图形

MATLAB 7.0在图形窗口中增加了绘图工具（Plot Tool）组件，该
组件由图形窗口面板（Figure Palette）、绘图浏览器（Plot Browser）
和属性编辑面板（Property Editor）组成。在默认情况下，该绘图工具



是隐藏的，如果希望调用该绘图工具，可以单击图形窗口中对应的显

示按钮。下面，通过一个简单的图形实例来说明如何调用和使用绘图

工具。

例11.30 在MATLAB中，绘制函数peaks的三维图形，然后使用
图形窗口中的绘图工具来编辑该三维图形的属性。

step 1
在MATLAB的命令窗口中输入以下命令，创建peaks函数的三维图

形。

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.44

所示。

图11.44 创建的图形窗口



step 3
单击图形窗口中的“Show Plot Tool”按钮，打开绘图工具（Plot

Tool）组件。由于绘图工具在默认情况下是隐藏的，因此需要调用绘
图工具组件，如图11.45所示。从图11.45中可以看出，绘图工具的三个
组件分别列在图形窗口的左、右侧和底部。其中图形窗口面板

（Figure Palette）列在图形窗口的左侧，绘图浏览器（Plot Browser）
列在图形窗口的右侧，属性编辑面板（Property Editor）列在图形窗口
的底部。下面简要介绍这些面板在编辑图形中所起的作用。

图11.45 打开绘图工具组件

 
◆ 图形窗口面板（Figure Palette）：在该图形编辑面板中，可

以为图形窗口添加新的子图（New Subplots），这个子图不受维度限
制，可以添加二维或者三维子图；在该编辑面板中，还可以为图形窗

口添加各种形式的注释（annotation）。最后，可以在该面板中查看图
形的变量。



◆ 绘图浏览器（Plot Browser）：在该面板中，可以查看图形中
的各个对象，例如坐标轴、变量或者整个图形对象等。同时，可以单

击该面板中的“Add Data”按钮，为图形添加新的数据。
◆ 属性编辑面板（Property Editor）：该面板将会根据用户在

图形窗口选择的对象显示不同的属性列表。可以在该面板中设置选中

的图形对象的各种属性，这是最有效的一个工具，可以避免繁杂的程

序代码而达到编辑图形的目的。

step 4
修改坐标轴的刻度间隔。在绘图浏览器（Plot Browser）中选

择“Axes”对象，属性编辑面板（Property Editor）中就会显示图形中所
有的坐标轴对象。选择“X Axis”选项卡，然后单击“Ticks”按钮，打
开“Edit Axes Ticks”对话框，选择其中的“X Axis”选项卡，然后在“Step
by”选框中输入新的间隔“5”，单击“Apply”按钮，就可以修改图形中的
X坐标轴的刻度间隔，如图11.46所示。

图11.46 “X Axis”选项卡



说明

前面已经介绍过，关于图形坐标轴的属性设置，一般需要借用图形的底层命令。但是，

使用图形窗口的绘图工具可以很方便地完成关于坐标轴的属性设置。

step 5
修改其他坐标轴的刻度间隔。可以重复以上步骤，设置Y坐标轴

的刻度间隔，修改后的图形如图11.47所示。

图11.47 修改坐标轴间隔后的图形

说明

从图11.47可以看出，当修改了坐标轴的刻度间隔后，X坐标轴和Y坐标轴刻度相对于原来

图形中的刻度间隔更密，对应的分格线也显得更详细。

step 6
修改坐标轴的显示比例。在绘图浏览器（Plot Browser）中选

择“Axes”对象，然后在属性编辑面板（Property Editor）中选择“X



Axis”选项卡，选择“X Scale”选框中的“Log”，并同时选中“Reverse”复
选框，得到的图形如图11.48所示。

图11.48 修改坐标轴的显示比例

以上操作相当于将X坐标轴设置为对数，并且反向显示。如果用
MATLAB的命令实现以上结果，会用到相关的底层命令。

提示

由于这个图形比较简单，所以仅仅演示了使用绘图工具编辑图形坐标轴的用法，对于图

形中的其他对象，都可以使用相同的方法来设置属性。

step 7
添加新的变量。由于以上图形中只有一个变量z，为了在后面的步

骤中添加新的图形对象，在本步骤中需要添加新的变量。切换到

MATLAB的命令窗口中，然后输入下列程序代码。

step 8



查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.49
所示。

图11.49 添加新变量后的图形窗口

提示

当在MATLAB中添加了新的变量后，在图形窗口面板（Figure Palette）中就会显示出添加

的变量。这样，就可以很方便地为添加的所有变量绘制和编辑图形。

step 9
向图形添加新的变量。选中图形，绘图浏览器（Plot Browser）中

的“Add Data”按钮会被激活。单击“Add Data”按钮，弹出“Add Data to
Axes”对话框，在该对话框中，首先选择添加变量的图形类型，如图
11.50所示。



图11.50 向图形中添加新的变量

提示

“Add Data to Axes”对话框提供了MATLAB中所有可行的图形类型，可以根据需要选择所

需的图形类型，在本例中选择的是“scatter”图形类型。

step 10
选择添加图形的数据来源。在“Add Data to Axes”对话框中，为所

选择的图形类型添加数据来源，本例添加的数据来源就是前面步骤设

置的变量x和y，如图11.51所示。为图形选择了新的图形变量后，单



击“OK”按钮，MATLAB就会在图形中添加该变量的散点图，如图
11.52所示。

图11.51 向图形中添加新的变量

图11.52 在图形中显示添加的变量



提示

添加了新的变量后，在默认情况下MATLAB的绘图浏览器（Plot Browser）会自动选中添

加的变量图形，因此在属性编辑面板（Property Editor)中会显示对应的属性。

step 11
添加新的子图。在前面的步骤中为图形添加了新的变量，在绘图

工具中还可以添加新的子图。选择图形窗口面板（Figure Palette）中
的“New Subplots”选项下的“2D Axes”选框中的添加子窗口，如图11.53
所示。打开的窗格中，可以选择子图的格式，如果选择纵向的方格，

则会添加纵向的子图。而在本例中，选择添加的是横向的子图，得到

的结果如图11.54所示。

图11.53 在图形中添加子图



图11.54 在图形中添加新的坐标系

step 12
添加子图的数据。使用step 1中的方法为新坐标轴添加新的数据，

在本步中选择的图表类型是“plot”，图表的数据来源则是x和y，如图
11.55所示。



图11.55 添加子图的图形数据

提示

由于在以上步骤中添加了新的坐标系，因此在本步骤中添加新数据时，需要首先选中对

应的坐标系，否则就相当于在原来的坐标系中添加变量。

step 13
编辑上面步骤中添加的子图。单击“Add Data to Axes”对话框中

的“OK”按钮，查看所完成的子图，如图11.56所示。在默认情况下，
MATLAB会选中添加的线性曲线。为了能够编辑坐标轴的范围，需要
选中图形的坐标轴，然后在属性编辑面板中修改X轴的刻度范围，如
图11.57所示。



图11.56 上面步骤中添加的子图

图11.57 修改坐标轴的刻度范围

step 14



修改子图的显示方式。由于图形的显示方式并不能很好地用于查

看图形，因此需要修改子图的显示方式。选择图形窗口面板（Figure
Palette）中的“New Subplots”选项下的“2D Axes”选框中的添加子窗
口，如图11.58所示。

图11.58 修改子图的显示方式

提示

在命令窗口中修改子图的属性，一般需要使用MATLAB中的底层绘图命令，而在图形编

辑窗口中只需使用一个简单的选项就可以了。

step 15
查看修改后的子图。当选择了子图显示方式的选项后，就可以查

看修改后的子图，如图11.59所示。



图11.59 修改后的子图

step 16
修改第一个子图的Y轴坐标范围。参考step 3，修改第一子图的坐

标轴的刻度和坐标轴范围，得到的结果如图11.60所示。



图11.60 修改子图的坐标轴范围

step 17
设置第一个子图的标题、边框和分格线。为了能够更加直观地查

看图形，可以为第一个子图设置标题、边框和分格线，在属性编辑面

板（Property Editor）中选中相应的选项，得到的结果如图11.61所示。

图11.61 设置子图的标题、边框

step 18
查看图形的其他属性。前面已经介绍了图形工具在图形编辑中的

常见应用，如果需要编辑图形的其他属性，可以选择相应的图形，然

后单击在属性编辑面板（Property Editor）中的“Inspector”按钮，打
开“Property Inspector”对话框，可以在其中设置图形对象的属性，如图
11.62所示。



图11.62 查看图形的其他属性

提示

可以在“Property Inspector”对话框中，设置该图形的所有相关属性。限于空间限制，属性

编辑面板（Property Editor）列出的仅仅是常见属性选项。

step 19
隐藏绘图工具。绘图工具的主要功能是编辑图形，完成图形的编

辑工作后，为了得到最后的图形，需要隐藏绘图工具。单击图形窗口

中的“Hide Plot Tools”按钮，隐藏绘图工具，如图11.63所示。单击图形
窗口中的“Hide Plot Tools”按钮后，整个图形窗口中就会只有图形，常
见的编辑窗口都会隐藏，适当编辑图形窗口的大小，得到的图形如图

11.64所示。



图11.63 隐藏绘图工具

图11.64 隐藏绘图工具后的图形窗口



11.5.4 使用图形窗口进行数据分析

在介绍数据分析的章节中已经了解到图形工具在数据分析中的重

要作用。基于这种原因，MATLAB在图形窗口增加了进行数据分析的
菜单选项，下面介绍如何使用图形窗口的选项进行简单的数据分析。

例11.31 使用图形窗口对例11.30中的图形进行数据分析。

step 1
打开数据分析的对话框。选中例11.30中的第一个子图，然后选择

菜单栏中的“Tools”→“Data Statistics”命令，如图11.65所示。

图11.65 选择“Data Statistics”命令

step 2
选择数据统计选项。当选择相应的选项后，系统会出现“Data

Statistics-1”对话框，其中显示了该图形中变量x和y的最小值、最大值



和平均值等，选择x和y的平均值，得到的图形如图11.66所示。

图11.66 选择数据分析选项

当选择了相应的变量参数后，MATLAB会自动在图形中添加该参
数数值的直线，并且会显示相应的图例，这样就可以在第一个子图中

直观地查看相应的统计信息。

提示

如果需要知道这些函数的统计信息，可以使用MATLAB中相关的统计函数，然后再使用

绘图命令将这些统计信息绘制在原来的图形中。而图形窗口中对应的选项则简化了相应的操

作过程，只需在对话框中选择相应的选项就可以了。

step 3
对图形中的数据进行拟合。选中第一个子图，然后选择菜单栏中

的“Tools”→“ Basic Fitting”命令，如图11.67所示。



图11.67 选择“Basic Fitting”命令

step 4
设置数据拟合的参数。当选择“Basic Fitting”命令后，MATLAB会

调用“Basic Fitting-1”对话框，可以在该对话框中设置拟合的参数，如
图11.68所示。



图11.68 设置数据拟合的参数

在“Basic Fitting-1”对话框中，可以设置拟合的选项，本例中选
择 “10th degree polynomial”选项，进行10阶拟合。然后选中 “Show
equations”复选框，表示在拟合的曲线中显示拟合的方程。最后，选
中“Plot residuals”复选框，表示绘制拟合的误差曲线。设置了拟合参数
后的基础图形如图11.69所示。



图11.69 设置拟合参数后的曲线

step 5
查看拟合的误差曲线。在前面的步骤中，选择了绘制拟合的误差

曲线，该曲线如图11.70所示。



图11.70 拟合的误差曲线

提示

由于在前面步骤中绘制了一个多子图的图形，因此MATLAB会在一个新的图形窗

口“Figure 2”中显示误差曲线。如果只绘制一个图形，则会在同一个图形窗口显示该误差曲

线。

step 6
创建图形的M文件。返回到“Figure 1”图形窗口中，然后选择菜单

栏中的“Tools”→“Generate M-File”命令，如图11.71所示。当选择相应
的菜单命令后，MATLAB会自动创建图形的M文件，如图11.72所示。



图11.71 创建绘制图形的M文件

图11.72 对应的M文件

11.6 绘制复数变量图形



MATLAB为用户提供了绘制复数变量图形的一些函数。对于复数
变量，MATLAB可以绘制出相应的实部和虚部，不过，MATLAB还可
以根据复数的结构绘制出更加复杂的图形。

11.6.1 绘制复数图形原理

MATLAB提供的绘制函数包括 CPLXMAP、 CPLXGRID和
CPLXROOT 等 ， 这 些 函 数 名 称 的 前 缀 CPLX 是 英 文 单 词
COMPLEX（复数）的缩写。这些函数的功能尽管各不相同，但是对
于所绘制的图形有一个共同的特点。

假定f（z）是某一函数，函数的变量是复数，使用CPLXMAP、
CPLXGRID或者CPLXROOT命令绘制的三维曲面图将会以函数的实部
为高度，以其虚部为颜色。在默认情况下，这些颜色的变化范围是

HSV颜色模式。
在MATLAB中，函数CPLXGRID将产生一个极坐标下的复数网格

数据点。例如，函数表达式CPLXGRID(m)将产生一个（m－1）
×（2m－1）的复数极坐标网格数据点。该命令和前面章节中的
meshgrid函数类似，功能是产生数据格点，只是这些数据格式都是复
数的，而不是实数的，其对应的M文件如下：

从以上程序代码可以看出，该函数产生的复数极径的数值范围是

[0，1]，极角的范围是[-π，π]，然后用极坐标的方法创建复数矩阵z，
而且矩阵维度是（m－1）×（2m－1）。

提示



在使用后续函数绘制复数图形时，该函数是绘制复数图形的基础函数，用来产生绘制图

形的数据系列点。

11.6.2 绘制复数图形——CPLXMAP命令

CPLXMAP命令的功能是绘制复数函数的图形，其语法是
CPLXMAP(z,f(z),bound)，其中参数z是定义域，f（z）是产生图形区域
的函数。为了更好地解释该函数的功能，下面来看调用该函数的M文
件：

在以上程序代码中，首先求得复数矩阵z和函数数值矩阵w中元素
的实部和虚部，然后确定绘制图形的坐标轴范围。在完成了数据准备

和坐标轴范围后，使用mesh命令绘制曲线图，该曲线图是一个平面
图，z向坐标值就是u的最小值；最后，使用surf命令绘制三维曲面图，



该曲面的z向坐标是函数矩阵w的实部数值，而函数矩阵v的虚部数值
则是填充曲面图的颜色矩阵。

提示

以上程序代码并不复杂，主要是将函数的参数根据图形设置的范围绘制三维曲面线和曲

线图，对于其中比较复杂的部分，可以不用理解，或者参考本书中M编程的章节。

 
例11.32 使用CPLXMAP命令绘制复数函数f（z）＝z3的三维图

形。

step 1
在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.73

所示。



图11.73 完成的复数图形

在图11.73中图形的高度就是复数函数f（z）＝z3计算结果的实

部，而其颜色则是按照计算结果的虚部数值进行染色的。

11.6.3 绘制复数曲面图——CPLXROOT命令

在MATLAB中，还提供了CPLXROOT函数来绘制复数函数f（z）
的n重根对应的曲面图，其对应的M文件如下：

使用以上程序代码，可以很轻松地画出比较复杂的复数数值解的

曲面图，下面使用一个简单的实例来说明。

例11.33 使用CPLXROOT函数绘制复数立方根的三维图形。

step 1



在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图11.74

所示。

图11.74 复数立方根的图形

11.7 图形的打印和输出

在本章的最后，将简要介绍如何在绘制图形后将完成的图形输出

或者打印。这里提到的输出，表示的是将完成的图形保存在其他文档

中，或者使用其他图形软件对该图形进行编辑。在MATLAB中若想进
行图形的打印和输出，可以使用图形窗口的菜单进行操作，也可使用

命令窗口中的命令。



使用菜单方式完成图形的打印和输出比较简单、直接；使用命令

方式完成图形的打印和输出比较丰富灵活，可以在M文件中调用相应
的命令，自动执行图形的打印和输出工作。

11.7.1 图形打印的菜单操作方式

为了演示如何使用图形窗口中的菜单进行图形输出，下面将以例

11.33完成的图形为例，来简单显示基本的操作方式。
例11.34 演示如何打印例11.33所绘制的三维图形。

step 1
进行页面设置。选择图形窗口中的“File”→“Page Setup”命令，打

开“Page Setup”对话框，在其中对打印结果进行页面设置，如图11.75
所示。

图11.75 设置打印页面



和其他常见软件（例如Word）打印页面类似，在MATLAB中打印
图形之前，必须设置图形的属性，例如图形尺寸、纸张大小、线型以

及文本类型等。在“Page Setup”对话框中，右方空白框中有一个图形
框，这是一个示意图形框，可以如实地反映打印图形在纸面中的位置

和相对大小。可以直接按住鼠标左键来移动该图形框，如图11.76所
示。

图11.76 移动图形的位置

当将鼠标放置在示意图上方时，会出现十字光标，可以自由移动

该打印图形的位置，直到移动到合适的位置为止。

step 2
预览待打印的图形。在以上步骤中已经设置了图形的属性，这就

基本完成了打印前的基本设置工作。现在可以预览待打印的图形，选

择图形窗口中的“File”→“Print Preview”命令，打开“Print Preview”对话
框，可以在其中预览待打印的图形，如图11.77所示。当将鼠标放在图



形的预览区时，鼠标会出现自动缩放的符号，单击鼠标左键，放大局

部的图形；单击鼠标右键，缩小局部的图形。

图11.77 图形预览

step 3
设置图形的标题。单击“Print Preview”对话框中的“Header”按钮，

打开“Figure Page Header”对话框，可以在该对话框中设置图形的标题
和日期格式，如图11.78所示。



图11.78 设置图形的标题

单击“Figure Page Header”对话框中的“OK”按钮，就可以完成对图
形标题的设置工作，设置的效果直接出现在完成的图形中，然后关闭

该对话框，MATLAB会自动保存所有的设置工作。

提示

在“Figure Page Header”对话框中，还可以设置不同字体的图形标题。单击对话框中

的“Header Font”按钮，打开“字体”对话框，在该对话框中选择标题的字体格式和大小。

step 4
打印设置。关闭“Figure Page Header”对话框，返回到图形窗口

中。选择菜单栏中的“File”→“Print Setup”命令，打开“打印设置”对话
框，在其中设置关于打印机的属性，如图11.79所示。



图11.79 设置打印机的属性

现在已经完成了图形打印的相关设置，返回到图形窗口中，选择

菜单栏中的“File”→“Print”命令，直接打印该MATLAB的图形。

11.7.2 图形打印的命令操作方式

在MATLAB中，关于图形打印的常见调用命令如下：
 
◆ print 将图形发送到由printopt定义的打印设置和系统打印命

令中。

◆ print filename 将图形输出到文件filename中，如果filename
没有扩展名，print命令会自动选择一个扩展名。

◆ print –ddriver  使用由ddriver定义的打印设置打印当前图
形。

◆ print –dformat 将当前图形复制到系统粘贴板上。
◆ print -dformat filename 以用户自定义的图形格式将图形输

出到用户自定义的filename文件中。
◆ print –smodelname 打印当前simulink模型smodelname。



◆ print ... –options 定义打印选项。
◆ [pcmd,dev] = printopt 返回当前系统的打印命令到字符串变

量pcmd和输出设备到变量dev中。
 
下面简单使用一个实例，来说明如何在MATLAB中合理运用以上

命令。

例11.35 使用MATLAB的命令操作方式来打印y＝sint函数的图
形。

在MATLAB的命令窗口中输入以下代码：

在输入以上代码后，图形会在Windows打印程序的管理下通过默
认的打印机输出。

11.8 小结

本章从各个方面向读者介绍了MATLAB如何实现数据和函数的可
视化，主要介绍了如何绘制二维和三维图形，以及如何设置图形外观

的各种属性：颜色、光照、透明、材质等。熟练掌握本章中的常见命

令，可以根据需要绘制各种个性化的图形。在后面的章节中，将介绍

如何在MATLAB中进行程序设计。

◆   ◆   ◆
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第12章 MATLAB编程基础知识

本章包括

◆M文件编辑器

◆变量和关系式

◆程序结构

◆控制语句

 
MATLAB在工程运算方面有着广泛的应用，不仅有强大的数值运

算、符号运算、矩阵运算和绘图功能，还可以像C语言、FORTRAN等
高级语言一样进行程序设计，编写扩展名为.m的M文件。自行编写M
文件可以灵活地解决各种实际问题，同时也可以在科学研究中加深应

用。

MATLAB为用户编写M文件提供了编辑器和编译器，可以使用这
些工具完成复杂运算和应用。而且，MATLAB内置的函数大都是M文
件函数，因此，了解M文件的结构也有助于理解各种函数，同时，可
以在原始的M文件基础上生成和扩展自己的函数库。
简单来讲，所谓的M文件就是将处理问题的各种命令融合在一个

文件中，该文件以.m为扩展名，然后由MATLAB系统进行编译，得出
相应的运行结果，具有相当强大的可开发性和扩展性。在本章中，将

介绍MATLAB编程的各种基础知识，同时对于MATLAB 7.0版本添加
的新内容，例如函数句柄、程序性能优化等，也将加以介绍。

12.1 简单实例——排序函数



在详细介绍MATLAB编程的知识之前，首先介绍一个比较简单的
实例，从而了解如何在MATLAB中编写函数文件和M文件，可以先对
M文件有个直观的了解。下面主要介绍程序编写的步骤、编译过程
等，对于各种语言结构和含义，将在后面章节中详细介绍。

12.1.1 编写函数文件

例12.1 在MATLAB中，编写对数据进行排序的函数文件。

step 1
打开MATLAB的文件编辑器。单击命令窗口工具栏中的 按

钮，或者选择编辑栏中的“File”→“New”→“M-file”命令，打开M文件
编辑器，如图12.1所示。如果是第一次创建M文件，系统会将名字设
置为“Untitled”（未命名）的。

图12.1 M文件编辑器

注意



M文件编辑器是用户编写、编译M文件的主要操作界面，本章中几乎所有的操作都是在

该界面完成的。

step 2
在M文件编辑器中，编写“ssort”函数的代码。
程序的详细代码如下：

step 3
保存程序代码。当输入了以上代码后，单击文件编辑器工具栏中

的保存图标 ，或者选择菜单栏中的“File”→“Save as”命令，打

开“Save file as”对话框，保存所编写的程序代码，如图12.2所示。



图12.2 保存用户编写的程序代码

在默认情况下，MATLAB会将当前目录作为代码保存路径，在本
例中，该目录就是“…….\MATLAB7.0\work”。同时，由于在编写函数
的时候已经设置了函数名称，在保存该代码的时候，就会将函数名称

作为文件名，因此，本M文件的名称为ssort.m。
代码保存完以后，在M文件编辑器的标题栏中会自动显示对应的

保存路径。

注意

前面曾经建议在使用MATLAB的时候，建立自己的程序目录，而不使用MATLAB的默认

目录。但是在本实例中，为了简化步骤，采用了这种默认目录。尽管如此，还是建议在保存

代码时，选择自己创建的目录。



12.1.2 编写脚本文件

在MATLAB中，M文件编辑器除了可以编写函数文件，还可以编
写脚本文件。在脚本文件中，只是没有定义函数名称，其他的和上面

步骤类似，下面详细介绍。

例12.2 在MATLAB中，编写对数据进行排序的脚本文件。

step 1
重新打开M文件编辑器，然后输入如下所示的脚本文件的代码。

step 2
将以上程序代码保存为“test_sort.m”文件。

12.1.3 运行代码

前面分别完成了函数代码和脚本代码，接下来，可以运行和检测

代码。由于在test_sort的M文件中，已经调用了ssort函数，所以可以直



接运行test_sort文件，这样就将两个代码都检测了，下面详细介绍如何
检测。

例12.3 运行并检测数字排序程序。

step 1
将保存程序的目录设置为MATLAB的当前目录，然后在MATLAB

的命令窗口中输入“test_sort”，按“Enter”键，得到的结果如图12.3所
示。

图12.3 检测程序代码

可以看出，当在命令窗口中输入脚本文件名称“test_sort”后，
按“Enter”键，MATLAB会自动调用脚本程序语句的内容。同时，
MATLAB的命令窗口中出现了“Waiting for input”，表示系统处于接收
数据的状态。

step 2
在程序的提示下，依次输入排序的数值，得到的结果如图12.4所

示。



图12.4 运行程序代码

当输入了相应的数值后，MATLAB会调用代码中的相应代码，得
出排序的结果。同时将程序处理过程中的变量填入工作空间中。

step 3
重新输入变量数值，查看新的排序结果，得到的结果如图12.5所

示。



图12.5 重新运行程序代码

当在命令窗口中重新输入脚本文件的名称“test_sort”后，MATLAB
会再次调用相应的程序代码，可以在代码的提示下重新输入数值，得

到新的排序结果。同时，MATLAB工作空间中的各个变量已经被覆盖
成新的数值。

提示

一般而言，函数程序代码的中间变量都是局部变量，存放在函数自身的工作空间中。而

脚本程序代码中得到的变量都是全局变量，存放在MATLAB的工作空间中。

12.1.4 检测代码

现在已经完成了程序代码的编写并运行了程序代码，下面将检测

前面小节中为代码所编写的帮助和说明文字。



step 1
查看两段程序代码的帮助信息。在命令窗口中依次输入“help

ssort”和“help test_sort”，查看代码的在线帮助信息，得到如下的结
果：

关于该函数和脚本文件的帮助信息，就是前面步骤中用户在编写

代码时，为各个代码添加的注释文字。但是，对于ssort函数而言，注
释文字不仅仅包括代码中显示的文字，之所以只显示该段文字，是因

为在编写代码的时候，在后面一段注释文字前面添加了空格。

提示

可以合理应用上面关于代码注释文字的规则，对于不希望显示的注释文字，可以在注释

文字前面添加空格行。在本实例中，隐藏显示的注释文字是关于该段代码的变量定义，一般

情况下不需要显示该帮助信息。

step 2
查看M文件的详细代码。在命令窗口中依次输入 “type

ssort”或“type ssort.m”，查看对应M文件的详细代码，得到如下的结
果：



12.2 M文件编辑器

前面已经使用M文件编辑器编写了基础的函数代码和脚本代码，
下面将详细介绍该编辑器的使用方法和注意事项。

12.2.1 打开文件编辑器

首先，M文件编辑器不会随着MATLAB的启动而启动，只有在用
户编写M文件时，该编辑器才启动。但是，需要注意的是，M文件编



辑器不仅可以用来编辑M文件，还可以对M文件进行交互性调试。而
且，M文件编辑器还可以阅读和编辑其他ASCII码文件。通常情况下，
可以使用以下方法来打开M文件编辑器。

 
◆ 可以单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开M文件编辑器，这种方法适用
于创建新的M文件。

◆  如果需要编辑或者修改已经存在的M文件，可以单击
MATLAB工具栏中的 按钮，或者选择菜单栏中“File”→“Open”命

令，打开Windows系统中标准的“Open”对话框，然后在对话框中选择
需要编辑的M文件，单击“打开”按钮，就可以打开该文件对应的编辑
器。

◆ 除了可以在对话框中使用菜单选项来打开M文件编辑器，还
可以在命令窗口中输入“edit”命令，打开新的文件编辑器；或者输
入“edit filename”打开一个存在的M文件的编辑器，其中filename是M文
件的名称，可以带扩展名也可以不带扩展名。

提示

尽管在命令窗口中打开M文件编辑器比较简单，但这样做也有局限。当打开的M文件不

是保存在MATLAB的当前目录中，系统会返回错误信息，无法打开对应的文件编辑器。

 
例12.4 使用窗口命令打开前面创建的ssort文件。
将“…….\MATLAB7.0\work”目录设置为MATLAB的当前目录，然

后在命令窗口中输入“>> edit ssort”命令，按“Enter”键，得到的图形如
图12.6所示。



图12.6 打开ssort文件

12.2.2 设置M文件编辑器的属性

有过编程经历的人员也许都有这样的经验，不同的编程人员对编

辑器的界面、字体、段落格式等都有自己的偏好。对此，MATLAB为
用户提供了自定义这些属性的功能，用户可以选择相应的菜单选项来

设置各种属性。在本小节，主要介绍如何设置M文件编辑器中的重要
属性。下面通过实例来介绍如何进行编辑器的设置工作。

例12.5 自定义设置M文件编辑器的属性。

step 1



单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器。然
后选择文本编辑器菜单栏中的 “File”→“Preferences”命令，打
开“Preferences”对话框，选择“Colors”选项，设置M文件编辑器中的各
种字体颜色，如图12.7所示。

图12.7 设置M文件的各类字体颜色

在 “Preferences”对话框的左侧，可以为程序语句中的关键字
（Keywords）、注释（Comments）、字符串（Strings）、未结束的字
符串（Unterminated strings）、系统命令（System commands）和错误
信息（Errors）等设置高亮显示的字体颜色。可以根据自己的喜好来设
置各种字体颜色，只需在对应选项右侧的选项中选择对应的颜色。

step 2



设 置 M 文 件 编 辑 器 中 的 显 示 选 项 。 选 择 左 窗 格 中
的“Editor/Debugger”选项下的“Display”选项，在右窗格选中“Enable
datatips in edit mode”复选框，如图12.8所示。

图12.8 设置M文件编辑器的显示选项

在默认情况下，MATLAB不会选中“Enable datatips in edit mode”复
选框，选中它后，当将光标移动到编辑器文件中某变量名称时，就会

出现一个快捷菜单，显示出该变量所存放的具体数据，这种设置有利

于用户阅读程序代码。

step 3
设置M文件的保存选项。选择左窗格中的“Autosave”选项，设置M

文件的保存选项，如图12.9所示。



图12.9 设置M文件的保存选项

在右窗格中还可以设置M文件备份的选项，默认情况下，系统设
置每5分钟保存用户编写的程序代码，但用户可以根据自己的情况来修
改这个数值。

注意

完成以上所有设置工作后，单击“Apply”按钮，将自定义的设置应用在后面编写的程序代

码中。设置完所有的选项属性后，单击“OK”按钮，退出该对话框。

12.2.3 设置M文件编辑器的打印属性

在MATLAB中还可以设置M文件的打印效果。之所以介绍如何设
置M文件的打印效果，是因为在编写M文件程序的时候，经常需要编
写相应的程序代码文件。下面通过具体的例子来进行讲解。



例12.6 自定义设置M文件编辑器的打印效果属性。

step 1
在打开的M文件编辑器中，选择菜单栏中的 “File”→“Page

Setup”命令，打开“Page Setup：Editor”对话框，选择“Layout”选项卡，
设置M文件的版面布局，如图12.10所示。

图12.10 设置M文件的版面布局

提示

在默认的情况下，MATLAB会选中“Print header”复选框，则打印的页面中会显示M文件

所在的完整路径、文件创建日期和页数等信息。如果是比较长的程序代码，可以勾选“Print

line numbers”复选框，在程序代码中出现代码的行数标记。

step 2
设置版头属性。选择“Page Setup：Editor”对话框中的“Header”选

项卡，设置M文件的版头属性，如图12.11所示。



图12.11 设置版头属性

在“Header”选项卡中，可以设置版头的边框、页数的显示方式和
布局等属性。在本实例中，选择了“Simple two line”的布局，将版头信
息分成两行显示；选择“Shaded box”的边框属性，设置带有阴影的边
框。

step 3
设置打印的字体属性。选择 “Page Setup： Editor”对话框中

的“Fonts”选项卡，设置M文件的打印字体属性，如图12.12所示。



图12.12 设置打印的字体属性

 
在默认情况下，MATLAB会选中“Use Editor font”单选按钮，这样

打印代码出现的结果就会和M文件编辑器中的字体相同。如果希望使
用自行设置的字体，可以首先选择“Use custom font”单选按钮，然后在
出现的下拉菜单中选择相应的字体信息。

12.3 MATLAB的变量和关系式

在MATLAB中，可以进行常用的加、减、乘、除和幂等运算，对
于简单的计算可以直接在命令窗口中输入表达式，MATLAB会将计算
的结果保存在默认的ans变量中。与C语言不同，在MATLAB中使用变
量可以不预先定义。

尽管MATLAB的程序内核是C语言，但是在具体的变量和语法规
则上，MATLAB还是和C语言有着不同的要求和体系。下面将首先介
绍MATLAB的变量和关系式的规则和信息。

12.3.1 M文件的变量类型

在复杂的程序结构中，变量是各种程序结构的基础。因此，

MATLAB中的变量也有自己的命名规则，大致规则如下：必须以字母
开头，之后可以是任意字母、数字或者下画线，同时变量命名不能有

空格，变量名称区分大小写。最后，在MATLAB 7.0中，变量名称不
能超过63个字符，第63个字符之后的部分都将被忽略。
在MATLAB中有一些默认的预定义变量，用户在设置变量时应该

尽量避免和这些默认的变量相同，否则会给程序代码带来不可预测的

错误。表12.1列出了常见的预定义变量。



表12.1 MATLAB中的预定义变量

在编写程序代码的时候，可以定义全局变量和局部变量两种类

型，这两种变量类型在程序设计中有着不同的应用范围和工作原理。

因此，有必要了解这两种变量的使用方法和特点。

当每一个函数在运行的时候，都会占有独自的内存，这个工作空

间独立于MATLAB的基本工作空间和其他函数的工作空间，这样的工
作原理保证了不同的工作空间中的变量相互独立，不会相互影响，这

些变量都被称为局部变量。

在默认情况下，如果没有特别声明，函数运行过程中使用的变量

都是局部变量。如果希望减少变量传递，可以使用全局变量，在

MATLAB中，定义全局变量需要使用命令global，其调用格式如下：

通过这个简单的命令，就可以使MATLAB允许几个不同的函数空
间以及基本工作空间共享同一个变量。每个希望共享全局变量的函数

或者MATLAB基本工作空间必须逐个对具体变量进行专门的定义。
如果某个函数在运行过程中修改了全局变量的数值，则其他函数

空间以及基本工作空间内的同名变量数值也会随之变化。

注意

尽管MATLAB对全局变量的名称没有特别的限制，但是为了提高程序的可读性，建议采

用大写字母来命名全局变量。同时，将全局变量尽量放在函数体的首部。



12.3.2 M文件的关键字

在命名变量名称时，还应该注意到MATLAB预留了一些关键字并
且不允许用户对其进行重载，因此定义变量名称的时候，应该避免使

用这些关键字，否则系统会显示类似于缺少操作数之类的错误提示。

在MATLAB中，可以使用“iskeyword”命令来查看MATLAB中的关键
字，得到的结果如下：

12.3.3 关系表达式

在MATLAB的常见分支或者循环控制结构中，经常会遇到判断结
构，根据某种条件的数值0或者1而得出不同的结论，因此首先需要通
过某种表达式来产生这种逻辑上的判断数值0或者1。在MATLAB中，
能够产生这种逻辑数值0或者1的表达式有关系表达式和逻辑表达式，
下面将详细介绍如何使用关系表达式。

关系表达式是针对两个变量的表达式，可能是两个数值变量或者

字符串变量，通过表达式之间的关系得出逻辑值0（ false）或者



1（true），取决于两个变量之间的关系。关系表达式的通用命令如
下：

其中，a和b可以是算术表达式、变量、字符串等，op是一种逻辑
关系。如果以上表达式表达的关系是正确（true）的，则表达式返回
数值1；如果表达式表达的关系是错误的，则返回数值0。表12.2列出
了MATLAB中常见的逻辑关系。

表12.2 MATLAB中的常见逻辑关系

例12.7 在MATLAB中，使用关系运算符进行运算，得到相应的
结果。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
在以上关系表达式中，op数组储存的就是各个表达式的结果，查

看其数值，得到的结果如下：



step 3
查看逻辑运算数值的变量类型，得到的结果如下：

注意

在以上6个关系表达式中，最后一个表达式比较的是字符串，之所以返回的数值是1，是

因为在MATLAB中字符串关系是按照字母表次序来排列的。最后，通过class函数来判断op数

组的变量类型，得到的结果就是logical类型。

 
例12.8 在MATLAB中，以数值矩阵（数组）为单位，进行关系

表达式的运算。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
查看关系表达式的运算，得到的结果如下：



step 3
将以上数值c和d进行关系运算，得到的结果如下：

从以上程序代码中可以看出，一个数值矩阵或者数组可以和一个

标量进行关系运算，其运算规则是将矩阵的数值依次和标量数值进行

关系运算，得出相应的关系结果，返回一个逻辑的矩阵；同时，同维

的矩阵也可以相互进行关系运算，运算规则是将对应数值进行关系运

算，同样可以得到一个逻辑矩阵。

但是，如果将不同维的矩阵进行关系运算，MATLAB将无法完成
其关系运算，返回相应的错误信息，提示用户两个矩阵应该同维。

注意

在MATLAB中，字符串变量本身就是一个矩阵变量，因此关系表达式只能比较长度相同

的字符串变量，否则MATLAB就会返回错误信息。

12.3.4 关系表达式的优先级

和其他编程语言类似，在MATLAB中，关系表达式之间也存在优
先级问题。下面将结合具体的例子来说明关系表达式的优先级。

例12.9 在MATLAB中，分析关系表达式和算术运算的优先级。



step 1
在MATLAB的命令窗口中输入下列内容：

step 2
查看关系运算的结果，得到的结果如下：

通过以上程序代码可以看出，无论是否使用括号进行算术运算，

得到的结果都是相等的，也就是说，Op1和Op2是完全相同的。这就表
明在MATLAB运算中，算术表达式的优先级高于关系表达式，所以是
否添加括号不会影响最后的关系运算结果。

关于表达式Op3和Op4，原理和上面分析的完全相同。由于加、减
是算术运算的最底层，因此本实例使用加、减运算和关系运算进行比

较。

提示

尽管在MATLAB中，算术表达式的优先级高于关系表达式，在进行关系运算时可以不添

加括号，就可以得出正确的结果，但是，根据笔者的经验，当进行复杂的算术表达式的关系

运算时，还是建议使用相应的括号，避免产生运算中的误解。

12.3.5 截断误差问题



在MATLAB中，数值计算的截断误差问题是十分重要的问题。在
使用关系表达式时，特别是在比较关系表达式时，要十分注意截断误

差问题。本小节中，将结合具体的例子来说明截断误差。

例12.10 在MATLAB中，对数值进行关系运算。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
查看关系运算的结果：

根据结果可以看出，尽管 ，数值a也等于0，但是

MATLAB却认为两个变量数值不相等，因此op1的逻辑数值为0，op2
的逻辑数值为1。造成这样结果的原因是，MATLAB在数值运算中的

截断误差（roundoff error）。在MATLAB中，表达式 得到的数

值并不直接等于0，而是等于1.2246×10-16，所以，当将变量a和b进行
比较时，返回的是逻辑值0（false）。

step 3
修改程序代码，重新比较两个数值大小：



在以上程序代码中，为了避免MATLAB的数值运算截断误差，将
两个数值a和b进行比较时，使用的表达式为｜a－b｜＜1.0×10-15，也

就是说，判断两个数值变量之间的数值间隔是否足够小，这样就可以

避免MATLAB中的运算截断误差。

12.3.6 逻辑表达式

在MATLAB中，逻辑表达式是通过逻辑关系符将两个或者多个进
行连接得到的逻辑数值。在MATLAB中，为用户提供了三种比较常见
的逻辑运算符：AND、OR和XOR，这三种逻辑运算符是二元关系运
算符，同时，MATLAB还提供了一个非二元关系运算符NOT。表12.3
列出了MATLAB中常见的逻辑运算符。

表12.3 MATLAB中的常见逻辑运算符

例12.11 在MATLAB中，使用逻辑表达式进行数值逻辑运算。

step 1
在MATLAB的命令窗口中输入下列内容：



step 2
查看逻辑运算的结果：

例12.12 在MATLAB中，综合使用逻辑和关系运算得出逻辑结
果。

step 1
在MATLAB的命令窗口中输入下列内容：

step 2
查看运算结果：

以上实例并不复杂，主要是为了介绍关系表达式和逻辑表达式的

优先级问题。由于上面表达式中op2和op3是完全相同的，因此可以看



出逻辑运算符~的优先级要高于关系运算符>。下面简要介绍MATLAB
中关系运算符和逻辑运算符的优先级情况，包括算术运算符在内，其

优先级依次为：

 
◆ 所有的算术运算符的优先级最高，高于关系和逻辑运算符。
◆ 其次是所有的关系运算符（= =，~=，>，>=，<，<=），关

系运算符从左向右运算。

◆ 接着是逻辑上的NOT运算符~。
◆ 再下来是逻辑上的AND运算符&，运算顺序是从左向右。
◆ 最后是逻辑上的XOR运算符|，运算顺序是从左向右。

12.3.7 逻辑运算函数

下面将介绍MATLAB中的逻辑运算函数，或者称为is类函数。当
函数判断的条件成立时，该类函数将会返回逻辑数值1；当函数判断的
条件不成立时，该类函数将会返回逻辑数值0。这些函数都可以用在关
系表达式或者逻辑表达式中，也可以用来作为程序结构的判断条件。

表12.4列出了MATLAB中常见的逻辑函数。

表12.4 MATLAB中的常见逻辑函数

12.4 程序结构



和其他编程语言类似，MATLAB也给用户提供了判断结构来控制
程序流的执行次序。一般来讲，决定程序结构的语句有顺序语句、分

支结构和循环结构三种，每种语句结构都有各自的流控制机制，相互

配合使用可以实现功能强大的程序。由于MATLAB的这种控制命令用
法和其他语言用法十分类似，因此本节只结合MATLAB的特点来对控
制命令进行简要的介绍。

12.4.1 顺序结构

顺序结构是最遵循逻辑思路的程序代码结构，批处理文件就是典

型的顺序语句的文件，这种语句不需要任何特殊的流控制。这种顺序

结构是最基础的程序结构，也是其他控制流语句中的重要组成部分。

例12.13 在MATLAB中，使用顺序结构编写绘制函数的图形。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2
单击M文件编辑器中的 “保存 ”按钮，将以上程序代码保存

为“ezexm”。

step 3



返回到MATLAB的命令窗口，输入“ezexm”，然后按“Enter”键，
得到的结果如图12.13所示。

图12.13 得到的程序结果

在以上程序代码中，首先定义符号变量，然后定义积分表达式，

进行积分运算，最后调用ezplot命令绘制积分函数的图形。这样的程序
代码流程符合逻辑顺序，而且容易阅读，容易理解，这是顺序结构的

重要优点。

说明

关于ezplot命令的详细使用方法，读者可以阅读本书的相关章节。

12.4.2 if分支结构

如果在程序中需要根据一定条件来执行不同的操作，就可以使用

条件语句，在MATLAB中提供了if分支结构，或者被称为是if-else-end
语句。根据不同的条件情况，if分支结构有多种形式，其中最简单的



用法是：如果条件表达式expression为真，则执行组命令statements，否
则跳过该组命令，其格式如下：

如果expression是一个空数组，MATLAB会认为条件表达式为假。
在MATLAB中，if分支结构的更为普遍的调用格式如下：

如果条件语句只有两种可能的选择，则其调用格式如下：

在大多数情况下，条件表达式会由关系表达式或者逻辑表达式组

成，这些表达式返回的都是逻辑值0或者1，将作为条件判断的依据。
为了提高程序代码执行的效率，MATLAB会尽可能少地检测这些表达
式的数值。

例12.14 在MATLAB中，使用if分支结构编写求解一元二次方程
ax2＋bx＋c＝0的程序代码，并且运行检测该代码结果。

step 1
分析分支结构的判断条件。根据基础数学知识可知，一元二次方

程ax2＋bx＋c＝0的根的性质直接取决于判别式△＝b2－4ac的数值。当
△＝0时，该方程有两个相等的实根；当△＞0时，该方程有两个互不
相等的实根；当△＜0时，该方程有两个虚根。

step 2



单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 3



单击M文件编辑器中的 “保存 ”按钮，将以上程序代码保存
为“calc_root.m”。

step 4
返 回 到 MATLAB 的 命 令 窗 口 ， 输 入 “calc_root” ， 然 后

按“Enter”键，根据程序代码的提示，依次输入方程的系数，得到的结
果如下：

提示

在以上结果中，用户分别输入不同情况下的系数数值，得出不同条件下方程的解。这样

就可以检测程序代码中if分支结构语句的有效性。

 



最后，在使用if分支结构时，需要注意以下几个问题：
 
◆ if分支结构是所有程序结构中最灵活的结构之一，可以使用任

意多个elseif语句，但是只能有一个if语句和一个end语句。
◆ if语句可以相互嵌套，可以根据实际需要将各个if语句进行嵌

套，来解决比较复杂的实际问题。

12.4.3 switch分支结构

和C语言中的switch分支结构类似，在MATLAB中适用于条件多而
且比较单一的情况，类似于一个数控的多个开关。其一般的语法调用

方式如下：

在以上语法结构中，expression是一个标量或者字符串，MATLAB
可以将表达式中的数值依次和各个case命令后的数值进行比较。如果
比较结果为假，MATLAB会自取下一个数值进行比较，一旦比较结果
为真，MATLAB会执行相应的命令，然后跳出该分支结构。如果所有
的比较结果都为假，也就是表达式的数值和所有的检测值都不相等，

MATLAB会执行otherwise部分的语句。
例12.15 在MATLAB中，使用switch分支结构来判断用户输入的

数值。

step 1



单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2
单击M文件编辑器中的 “保存 ”按钮，将以上程序代码保存

为“calc_root.m”。

step 3
返回到MATLAB的命令窗口，输入“swcase”，然后按“Enter”键，

根据程序代码的提示，依次输入不同的值，得到的结果如下：

提示



在switch分支结构中，case命令后的检测不仅可以为一个标量或者字符串，还可以为一个

元胞数组。如果检测值是一个元胞数组，MATLAB将把表达式的值和该元胞数组中的所有元

素进行比较，如果元胞数组中某个元素和表达式的值相等，MATLAB认为比较结果为真。

12.4.4 try-catch结构

在MATLAB中，try-catch结构的功能和error类似，主要用来对异
常情况进行处理。其相应的语法结构如下：

在以上语法结构中，try后面的命令语句会被执行，只有当这些语
句执行过程中出现错误时，catch控制语句就会捕获它，执行相应的语
句。如果执行catch语句后的命令又出现错误，MATLAB就会终止该程
序结构。

例12.16 在MATLAB中，使用try-catch语法结构判断数组错误。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



step 2
单击M文件编辑器中的 “保存 ”按钮，将以上程序代码保存

为“calc_root.m”。

step 3
返 回 到 MATLAB 的 命 令 窗 口 ， 输 入 “try_catch” ， 然 后

按“Enter”键，根据程序代码的提示，依次输入不同的值，得到的结果
如下：

从以上实例可以看出，当输入的数组序号超过了数组的维度时，

MATLAB会显示错误信息，同时显示系统的错误提示“Index exceeds
matrix dimensions”。

提示

在MATLAB中，lasterr命令的功能是显示最后的错误信息，该命令返回的信息是字符串类

型，经常和try-catch结构配合起来使用，显示用户错误的信息。关于该命令的详细用法，可以



查阅MATLAB的帮助文件。

12.4.5 while循环结构

除了分支结构，MATLAB还提供了多个循环结构。和其他编程语
言类似，循环语句一般用于有规律的重复计算。被重复执行的语句称

为循环体，控制循环语句流程的语句称为循环条件。下面首先介绍

while循环结构。在MATLAB中，While循环结构的语法形式如下：

while循环的次数是不固定的，只要表达式的值为真，循环体就会
被执行。通常表达式给出的是一个标量，但是也可以是数组或者矩

阵，如果是后者，那么while循环要求所有的元素数值为真。
例12.17 在MATLAB中，使用while循环结构对数据进行统计，

计算输入数值数组的平均值和标准差。

step 1
分析程序的数学公式。根据统计学的基础知识，可以分析得到样

本的平均值和标准差的公式分别为：



其中，参数N表示用户输入的数值个数，ix表示各个输入的数值。
对于这两种基础统计量，MATLAB提供了mean和std命令进行计算，在
本例中，为了演示while循环结构，编写计算这些参量的简单代码。

step 2
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



step 3
单击M文件编辑器中的 “保存 ”按钮，将以上程序代码保存

为“stats.m”。

step 4
返回到MATLAB的命令窗口，输入“stats”，然后按“Enter”键，根

据程序代码的提示，依次输入不同的值，得到的结果如下：

从本例可以看出，当输入任意的负数时，MATLAB会自动跳出
while循环结构，只统计前面输入非负数值，得到相应的统计结果。

step 5
使用MATLAB的内置函数进行数值统计，检测程序是否正确，得

到的结果如下：



从以上结果可以看出，使用MATLAB内置的函数进行数据量的统
计时，得到的结果和上面编写程序的结果相同。

12.4.6 for循环结构

在MATLAB中，另外一种常见的循环结构是for循环结构，其常用
的调用格式如下：

在以上语法结构中，variable被称为是循环变量，循环体被重复执
行的次数是确定的，该次数由for命令后的表达式expression决定。
例12.18 在MATLAB中使用for循环结构完成例12.17的数值统计

功能。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



step 2
单击M文件编辑器中的 “保存 ”按钮，将以上程序代码保存

为“stats2.m”。

step 3



返回到MATLAB的命令窗口，输入“stats2”，然后按“Enter”键，根
据程序代码的提示，依次输入不同的值，得到的结果如下：

在以上程序代码中，使用for循环替代了while循环结构，同样得出
了数值的统计结果。同时，这段程序代码通过数值个数来控制循环，

可以统计的数值范围比较大，可以统计包括负数在内的统计信息。

说明

while循环和for循环都是比较常见的循环结构，但是两个循环结构还是有区别的。其中最

明显的区别在于，while循环的执行次数是不确定的，而for循环的执行次数是确定的。

12.4.7 绘制抛物线轨迹——综合实例

对于比较复杂的MATLAB程序，经常需要将各种程序结构综合起
来使用，才能解决复杂的问题。下面介绍一个比较简单的实例，来分

析如何综合应用这些程序结构。

例12.19 在MATLAB中，通过程序来演示小球的抛物线轨迹。

step 1
分析小球的抛物线轨迹模型。假定用户抛小球的速度，也就是小

球的初始速度是vo，小球的抛射初始角度是θ。根据基础的物理知识可
知，小球在水平和垂直方向上的速度分量分别为：



在本实例中，程序代码需要求解的是抛物线轨迹上水平距离的最

长距离，根据相关知识，其距离的求解公式如下：

在以上公式中，g代表的是重力加速度，在本实例中该参数选择的
数值为-9.82。而对应的小球在垂直方向上的最高距离为：

step 2
根据本实例的要求，可以输入抛射小球的初始速度，然后得出相

应的计算数据。单击MATLAB命令窗口工具栏中的 按钮，打开M文

件编辑器，输入以下程序代码：





step 3



单击M文件编辑器中的 “保存 ”按钮，将以上程序代码保存
为“ball.m”。

step 4
返回到MATLAB的命令窗口，输入“ball”，然后按“Enter”键，根

据程序代码的提示，依次输入不同的值，得到的结果如下：

除了以上数值结果之外，MATLAB还会绘制相应的图形结果，如
图12.14所示。



图12.14 初始速度为20时的轨迹

step 5
修改初始速度数值，将其改为45，得到的结果如下：



同时，MATLAB会给出对应的图形结果，如图12.15所示。

图12.15 初始速度为45时的轨迹

提示

在上面比较综合的实例中，在程序代码中多次用到了if分支结构和for循环结构，功能是

实现多种情况下的小球运行的轨迹，可以在MATLAB环境中自行运行该程序代码。

12.5 控制语句

在使用MATLAB设计程序时，经常会遇到提前终止循环、跳出子
程序、显示错误信息等情况，因此还需要其他的控制语句来实现上面

这些功能。在MATLAB中，对应的控制语句有 continue、break、
return、echo等，在本节中将详细介绍这些控制语句。

12.5.1 结束循环——continue命令



在MATLAB中，该命令的功能是结束程序的循环语句，也就是跳
过循环体中还没有执行的语句，其调用格式比较简单，直接在程序中

写出continue语句就可以了。下面使用一个简单的实例来说明continue
命令的使用方法。

例12.20 通过简单的案例说明continue命令的使用方法。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器，

输入以下程序代码：

提示

之所以在以上程序代码中的第二段代码前面添加了%，是为了首先将其当作注释，不运

行这段代码，在后面的程序中将注释符号删除后就可以重新运行。

step 2
将以上代码保存为“break_continue.m”文件，然后在MATLAB的命

令窗口中输入“break_continue”，按“Enter”键，就可以得到对应的结
果：



step 3
打开“break_continue.m”文件，然后在编辑器中修改其代码，得到

的结果如下：

以上程序代码相当于将前面例中的注释符号删除，然后保存这种

修改即可。

step 4
在 MATLAB 的 命 令 窗 口 中 输 入 “break_continue” ， 然 后

按“Enter”键，就可以得到对应的结果：

说明



在上面程序代码中使用了break语句，其功能就是跳出相应的程序代码。

12.5.2 终止循环——break命令

在MATLAB中，break命令的功能在于终止本次循环，跳出最内层
的循环，而不必等到循环的结束而是根据条件退出循环，常常和if语
句结合起来运用来终止循环。

例12.21 在MATLAB中寻求Fibonacci数组中第一个大于700的元
素以及其数组标号。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2
将以上代码保存为“Fib.m”文件，然后在MATLAB的命令窗口中输

入“Fib”，按“Enter”键，就可以得到对应的结果：

从以上结果可以看出，在Fibonacci数组中第一个大于700的数值是
987，其对应的数组标号是16。



12.5.3 转换控制——return命令

在通常情况下，当被调函数执行完后，MATLAB会自动把控制转
至主调函数或者指定窗口。如果在被调函数中插入return命令，可以强
制MATLAB结束执行该函数并把控制转出。

return命令可以使正在运行的函数正常退出，并返回调用它的函数
继续运行，经常用于函数的末尾，用来正常结束函数的运行。在

MATLAB的内置函数中，很多函数的程序代码中引入了return命令，下
面引用一个简要的det函数代码：

在以上程序代码中，首先通过函数语句来判断参数A的类型，当A
是空数组时，直接返回d=1，然后结束程序代码。

12.5.4 输入控制权——input命令

在MATLAB中，input命令的功能是将MATLAB的控制权暂时交给
用户，然后，用户通过键盘输入数值、字符串或者表达式，通过回车

将输入的内容输入到工作空间中，同时将控制权交还给MATLAB，其
常用的调用格式如下：

 
◆ user_entry = input('prompt')  将用户键入的内容赋给变量

user_entry。



◆ user_entry = input('prompt','s') 将用户键入的内容作为字符
串赋给变量user_entry。

说明

对于以上第一个调用格式，可以输入数值、字符串、元胞数组等各种形式的数据，第二

个调用格式，无论用户输入怎样的变量，都会以字符串的形式赋给变量user_entry。

 
例12.22 在MATLAB中演示如何使用input函数。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2
将以上代码保存为“test_input.m”文件，然后在MATLAB的命令窗

口中输入“test_input”，然后按“Enter”键，就可以得到对应的结果：



说明

在以上程序代码中，使用isempty来接收用户输入的“Enter”键，当什么字符串都不输入的

时候，将当用户输入的是Y。

12.5.5 使用键盘——keyboard命令

在MATLAB中，将keyboard命令放置到M文件中，将停止文件的
执行并将控制权交给键盘。通过提示符K来显示一种特殊状态，只有
当使用return命令结束输入后，控制权才交还给程序。在M文件中使用
该命令，对程序的调试和在程序运行中修改变量都会十分便利。

例12.23 在MATLAB中，演示如何使用keyboard命令。

step 1
在MATLAB的命令窗口中输入以下内容：

从以上程序代码可以看出，当输入keyboard命令后，在提示符的
前面会显示k提示符，而当输入return后，提示符恢复正常的提示效
果。



说明

在MATLAB中，keyboard命令和input命令的不同在于，keyboard命令允许用户输入任意多

个MATLAB命令，而input命令只能输入赋值给变量的数值。

12.5.6 提示警告信息——error和warning命令

在MATLAB中，当编写M文件的时候经常需要提示一些警告信
息。为此，MATLAB提供了下面几个常见的命令：

 
◆ error('message') 显示出错信息message，终止程序。
◆ errordlg('errorstring','dlgname') 显示出错信息的对话框，

对话框的标题为dlgname。
◆ warning('message') 显示警告信息message，程序继续进行。
 
例12.24 借用前面的“stats2.m”文件，修改其部分程序代码，使用

不同的警告样式，查看MATLAB的不同错误提示模式。

step 1
在MATLAB中，打开“stats2.m”文件，在编辑器中修改其程序代

码，并将其保存为“error_message.m”文件，修改的程序代码如下：



step 2
返回到MATLAB的命令窗口中，输入“error_message”，然后输入

数值1，得到的结果如图12.16所示。

图12.16 显示错误信息

当输入的数值总数小于2时，MATLAB调用错误信息对话框。当
单击对话框中的“OK”按钮后，将会自动退出程序代码。

step 3
打开“error_message.m”文件，在编辑器中修改其程序代码，然后

保存相应的程序代码，修改的程序代码如下：



step 4
返回到MATLAB的命令窗口中，输入“error_message”，然后输入

数值1，得到如下的结果：

step 5
打开“error_message.m”文件，在编辑器中修改其程序代码，然后

保存相应的程序代码，修改的程序代码如下：

step 6
返回到MATLAB的命令窗口中，输入“error_message”，然后输入

数值1，得到如下的结果：

说明

在以上程序代码中，演示了MATLAB中的不同错误信息显示方式。其中error和warning的

主要区别在于warning命令指示警告信息后继续运行程序。



12.6 小结

MATLAB除了本身提供大量可用的命令之外，还提供了扩展开发
的功能。可以根据需要编写相应功能的程序代码——M文件。本章主
要介绍了M文件的基础知识，包括数据类型、表达式和常见的程序结
构。由于MATLAB的内核是由C语言编写的，所以如果熟悉C语言，会
发现本章的内容十分熟悉。在以下章节中，将介绍MATLAB编程的一
些高级话题。

◆   ◆   ◆



第13章 MATLAB编程高级话题

本章包括

◆程序的向量化

◆逻辑数组

◆脚本文件

◆P码文件

◆变量传递

◆字符串演算函数

◆程序的调试和解析

 
前面章节已经介绍过MATLAB编程的基础知识和内容。读者可能

发现MATLAB编程的知识和C语言或者其他编程语言很相似，但是，
MATLAB的处理对象是矩阵，在编程中有一些其他编程语言不具备的
特点。在本章中，将主要讨论MATLAB编程的高级话题，了解这些高
级话题，对于提高MATLAB编程的效率以及理解MATLAB运行机理有
很大的好处。

13.1 程序的向量化

在MATLAB中，除了已经介绍的常见程序结构之外，还有一种特
有的方法：程序的向量化。向量化是一个程序概念，指的是使用向量

化的程序代码和语句来替代循环结构。向量化可以给MATLAB的程序
性能带来质的提高。在本节中，将介绍如何使用逻辑数组等向量化手

段来替代MATLAB中的循环结构，提高程序的性能。



13.1.1 程序的向量化

为了向读者介绍程序向量化的概念，在本小节的开始使用一个简

单的案例来对比循环结构和向量结构化的差别。该案例的目的是，计

算某数组元素的平方、平方根和立方根，该数组元素是从1到100的整
数。实现该案例的方法可以是循环结构，也可以是向量化程序，下面

详细介绍这两种方法。

例13.1 在MATLAB中，使用循环结构和向量化来求解数组的乘
幂计算。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2
将以上代码保存为“cycle.m”文件。然后单击MATLAB命令窗口工

具栏中的 按钮，打开一个新的M文件编辑器。在M文件编辑器中输

入以下程序代码：

step 3



将以上代码保存为“vector.m”文件。然后返回到MATLAB的命令窗
口中，输入“cycle”，按“Enter”键，得到的结果如下：

step 4
在MATLAB的命令窗口中输入“vector”，查看向量化程序的结果：



从以上程序段可以看出，两种方法得到的结果是完全相同的，但

是两个程序段的效率却有着明显的区别。粗略地讲，使用for循环的程
序结构计算速度会比使用程序向量化要慢15倍。造成这种情况的主要
原因在于，对于for循环的程序结构语句，MATLAB每次只能编译其中
的一行代码，因此对于前面的程序MATLAB需要编译300行程序代
码。而对于后面的向量化代码，MATLAB就只需编译仅仅4行代码。
同时，MATLAB本身就是设置为向量化程序代码的，这样的原因足以
提高程序效率。

说明

尽管向量化程序代码在效率和速度上有明显的优势，但是这种效率提高需要占用更多的

计算机内存，因为有很多的中间数组产生。但是，从整体上来讲，这种“代价”是值得的，效

率上的显著提高使得向量化程序整体上优于循环结构。

13.1.2 向量化和循环结构对比



在前一个实例中只是显示了向量化程序可以得到和循环结构相同

的结果，下面将有必要比较各种不同方法的效率。

例13.2  在MATLAB中，使用三种不同的方法来完成相同的运
算。这三种方法依次是：使用未初始化的数组和循环结构、使用初始

化的数组和循环结构和向量化方法。通过使用MATLAB内置的计时函
数来统计三种方法的运行时间。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



说明



以上程序代码中，通过使用tic和toc命令来统计三种程序结构的运行时间，三种代码的结

果是完全相同的，但是运行时间则有明显的差别。

step 2
将以上代码保存为“timings.m”文件，然后在MATLAB的命令窗口

中输入“timings”，按“Enter”键，就可以得到对应的结果：

上面程序代码的运行环境是MATLAB 7.0和Pentium 1.60GHZ，得
到的结果差异还是十分明显的。对于第一种方法，循环次数为1，但是
使用的时间却是最多的；第二种方法，循环次数是50，使用的时间却
明显减少；第三种方法循环次数最多，占用的时间最少。显然，从程

序效率角度来看，最后一种方法（向量化方法）是最佳的。

13.1.3 逻辑数组

前面曾经介绍过MATLAB有两种基础的数据类型：数值和字符
串。除了这两种数据类型，MATLAB还提供了一种数据类型：逻辑数
据。实质上，逻辑数据不能算是一个独立的数据类型，它其实是标准

的数值类型加上了一些“逻辑”的属性。可以通过关系和逻辑表达式创
建逻辑数组。在MATLAB中，可以通过使用whos命令来区分逻辑数组
和其他的数据数组。

例13.3 在MATLAB中创建逻辑数组，并通过命令来识别逻辑数
组。

step 1
在MATLAB的命令窗口中输入以下内容：



step 2
查看上面步骤得到的数组b，然后识别该数组类型，得到的结果如

下：

说明

从以上结果可以看出，数组b从外观上和数值数组完全相同，但是从类型角度来看，a属

于数值数组，但是b属于逻辑数组。

13.1.4 使用logical命令创建逻辑数组

除了使用关系表达式和逻辑表达式之外，可以使用logical命令来
创建逻辑数组。灵活使用该命令可以实现很多逻辑功能。

例13.4 在MATLAB中使用logical命令创建逻辑数组，并进行数
组运算。

step 1
在MATLAB的命令窗口中输入以下内容：



step 2
在命令窗口中依次输入以上数组名称，得到的结果如下：

step 3
查看各个数组的数据类型，得到的结果如下：

说明

从以上程序代码中可以看出，除了c数组之外，其他数组都是数据数组。也就是说，将逻

辑数组和其他数值数组运算后，得到的结果将是数值数组。

13.1.5 逻辑数组和向量化

前面之所以花费相当的篇幅来介绍如何使用逻辑数组，主要原因

在于逻辑数组可以在程序向量化中起到十分重要的作用，与之类似，



可以使用逻辑数组和循环语句来完成相同的功能，对比两者的效率。

例13.5 在MATLAB中，使用逻辑数组和循环结构完成相同的数
值运算功能：求解大于6000的所有数值的平方根。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器，

输入以下程序代码：



step 2
将以上代码保存为“logical.m”文件，然后在MATLAB的命令窗口

中输入“logical”，按“Enter”键，就可以得到对应的结果如下：



上面程序代码的运行环境是MATLAB 7.0和Pentium 1.60GHz，得
到的结果差异还是十分明显的。从以上结果可以看出，逻辑数组的方

法比循环结构速度提高了21倍。

说明

在这两个小节中，为了对比两种程序方法的性能和程序效率，多次使用了系统的内置函

数toc和tic，关于这两个函数的使用方法可以查看相应的帮助文件。

13.2 脚本和函数

前面的章节中已经介绍过，在MATLAB中编写的程序类型包括脚
本文件和函数文件，这两种类型的文件在很多方面都很相似，但是在

语法和使用上还是有很多不同的地方。前一节就曾举过简单的案例，

编写过脚本文件和函数文件，读者也许已经有了一些直观的感觉，在

本节中将详细介绍这两种文件。

13.2.1 编写脚本文件

脚本是一个扩展名为.m的文件，包括了MATLAB的多个命令，与
批处理文件类似，在MATLAB的命令窗口中直接输入该文件的名称，
MATLAB就会逐一执行文件中的各种命令，效果和在命令窗口中直接
输入命令相同。

对于一些比较简单的问题，从命令窗口中直接输入命令进行计算

是很简单的事情。但是，当命令的行数增加后，或者控制流的复杂度



增加后，直接从命令窗口中输入命令就显得比较烦琐，这个时候使用

脚本文件就比直接输入命令合适。

相对于函数文件，脚本文件的构成比较简单，主要特点如下：

 
◆ 脚本文件是一串按用户意图排列而成的MATLAB命令窗口。
◆ 脚本文件在运行后，所产生的所有变量都驻留在MATLAB的

基本工作空间中。只要用户不使用clear命令加以清除，而且只要
MATLAB的命令窗口不关闭，这些变量就会保存在基础空间中。

 
前面章节中已经多次编写了脚本文件，下面再次编写一个简单的

脚本文件，帮助读者理解脚本文件的概念。

例13.6 在MATLAB中，编写绘制三维镂空图形的脚本文件。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2



将以上代码保存为“loukong.m”文件，然后在MATLAB的命令窗口
中输入“loukong”，按“Enter”键，得到的图形如图13.1所示。

图13.1 程序代码运行的结果

step 3
在MATLAB的命令窗口中查看工作空间的变量，得到的结果如图

13.2所示。



图13.2 查看工作空间的变量

说明

从以上示例可以看出，在脚本文件中计算得到的中间变量都会保存在MATLAB的工作空

间中，不用clear命令清除，则会一直保存在工作空间中。

13.2.2 编写函数文件

和脚本文件不同，函数文件相当于一个“黑箱”，用户在外部只能
看到传给它的输入参数和输出的结果，内部运作是无法查看的。相对

于脚本文件，函数文件的主要特点如下：

 
◆ 从形式上看，函数文件的第一行总是以“function”引导的函数

声明行。该行还会罗列出函数与外界相联系的全部“标称”输入和输出
变量。如果对输入和输出变量加以限制，那么可以没有输入变量，也

可以输入任意数目的变量。



◆ MATLAB允许输入比标称数目少的变量，实现对函数的调
用。

◆ 从运行的角度来看，每当函数文件运行时，MATLAB就会专
门为其开辟一个临时工作空间。该空间被称为函数工作空间，所有的

中间变量都会被存放在函数工作空间中。当执行到函数文件的最后一

行代码，或者遇到return语句时，就会结束函数的运行，同时该临时函
数空间以及所有的中间变量都会被清除。

◆ 函数空间会随着具体的M函数文件的调用而产生，随着调用
结束而删除。函数空间是相对基础空间独立的、相对的。在MATLAB
整个运行期间，可以产生任意多个临时函数空间。

◆ 如果在函数文件中调用了某个脚本文件，则脚本文件产生的
变量都被存放在函数空间之中，而不是存放在基本空间中。

 
例13.7 在MATLAB中，编写简单的函数，并使用ezplot函数绘制

函数的曲线。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2
将以上代码保存为“myfun.m”。然后返回到MATLAB的命令窗口

中，输入以下代码：



step 3
查看图形结果。当输入以上程序代码后，按“Enter”键，就可以得

到如图13.3所示的图形。

图13.3 绘制的结果

step 4
在MATLAB的命令窗口中查看工作空间的变量，得到如下的结

果：

从以上查询结果可以看出，函数的中间变量f1、f2和f并没有保存
在工作空间中，工作空间中只有一个变量fh。



说明

以上程序代码中使用了图形句柄和ezplot命令，这些命令都是图形编辑的相关命令，有兴

趣的读者可以查看本书的相关章节。

13.2.3 编写P码文件

在MATLAB中，当一个M文件（脚本文件或者函数文件）被首次
调用时，无论是在MATLAB命令窗口中输入文件名，还是使用M文件
编辑器打开对应文件，MATLAB都会首先对该M文件进行语法分析，
并把生成的相应内部伪代码存放在内存中。这个内部伪代码简称P
码，全称为Psedocode。当再次调用该M文件时，MATLAB会直接运行
该文件在内存中的P码文件而不会对原始代码进行重复分析。
同时，在MATLAB中，分析器总是把M文件连同被它调用的所有

函数M文件一起变换为P码文件。P码文件和源代码文件有相同的文件
名，扩展名为.p，其运行速度要高于源代码文件，这种速度优势在规
模较大的文件中体现得更加明显。

除了MATLAB自动调用之外，还可以使用相应的命令来创建P码
文件。创建P码文件的主要功能在于保存密码，二进制的P码文件可以
执行代码的功能，但是不易于阅读，可以起到很好的保密效果。创建

P码文件的常用命令如下：

同时，MATLAB还提供了对内存中存在的P码文件进行操作的命
令，常见命令如下：

例13.8 在MATLAB中，查看内存中的所有P码文件，然后清除所
有P码文件，再次查看内存中的P码文件信息。



在MATLAB的命令窗口中输入以下代码：

如果在MATLAB的运行过程中，曾经打开或者编译某个M文件，
则在内存中会保存其对应的P码文件。

13.3 变量传递

在编写程序的时候，参数传递一直是十分重要的问题。如何合理

安排程序的变量传递直接关系到程序的效率，有时甚至关系到是否能

够完成程序功能的问题。在MATLAB中，提供了多种函数来实现变量
检测、传递，同时也提供了“变长度”输入输出变量，灵活使用这些命
令可以完成多种复杂的功能，下面详细介绍这些命令。

13.3.1 变量检测命令

在MATLAB中，提供了多个变量检测命令，用来判断输入和输出
变量的个数，相应的调用命令如下：

 
◆ n = nargin 在函数体内，用于获取实际的输入变量。
◆ n = nargin('fun') 获取“fun”指定函数的标称输入变量数目。
◆ n = nargout 在函数体内，用于获取实际的输出变量。
◆ n = nargout('fun')  获取“fun”指定函数的标称输出变量数

目。



◆ msgstring = nargchk(minargs, maxargs, numargs) 获取输入
变量的数目。

◆ inputname(n) 在函数体内使用，给出第n个输入变量的实际
调用变量名。

 
例13.9 在MATLAB中，使用nargin函数判断函数的输入变量个

数。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2
将其保存为 “foo.m”，然后返回到MATLAB的命令窗口中输

入“foo(9)”，得到的结果如图13.4所示。



图13.4 输入参数太少的提示信息

step 3
在MATLAB的命令窗口中输入“foo(pi,3,4)”，得到结果如下：

提示

在MATLAB中，nargin、nargout本身都是内置函数，而不是变量，因此不能使用赋值命令

对它们进行处理。

13.3.2 “变长度”变量函数

如果比较熟悉MATLAB的plot命令，就会发现一个问题：plot命令
的输入变量个数是可变的，可以调用plot(x,y)作为默认格式，也可以使
用最完整调用格式：



这个调用格式允许用户使用任意多的“属性名/属性值”对，来设置
绘制图形的属性。因此，plot函数为用户提供了可以选择的可变长度
变量。除了plot函数之外，MATLAB中还有很多函数可以接受“任意多
输入”，返回“任意多输出”。同时，MATLAB也为用户自行编写“变长
度”变量函数提供了函数：

 
◆ varargin “变长度”输入变量列表。
◆ varargout “变长度”输出变量列表。
 
例13.10 在MATLAB中通过“变长度”变量来绘制不同半径、不同

圆形的心形图。

step 1
单击MATLAB命令窗口工具栏的 按钮，打开M文件编辑器。在

M文件编辑器中输入以下程序代码：





step 2
将以上代码保存为“drawcardioid.m”，然后返回到MATLAB的命令

窗口中，输入“drawcardioid;”，按“Enter”键，MATLAB就开始绘制动
态图形，如图13.5所示。当MATLAB完成程序的循环后，就可以得到
绘制完成的图形，如图13.6所示。



图13.5 绘制中的动态图形

图13.6 绘制完成的图形

说明

在以上步骤中，用户没有输入函数的任何参数，MATLAB将采用默认的数值，也就是绘

制出圆心为原点，半径为1，外环半径也为1的心形图。

step 3



返回到MATLAB的命令窗口中，输入“drawcardioid(0,6);”，然后
按“Enter”键，得到的图形如图13.7所示。

图13.7 两个参量的绘制图形

step 4
在上面步骤绘制的图形基础上，再绘制一个不同半径的心形图。

返 回 到 MATLAB 的 命 令 窗 口 中 ， 然 后 输 入 命 令

行“drawcardioid(-1,2,8);”，按“Enter”键，得到的图形如图13.8所示。



图13.8 绘制新的心形图

说明

根据程序代码，当输入函数的两个参数时，圆心的x向坐标采用默认的数值0，第一参数

表示的是圆心的y向坐标，第二个参数表示的是圆的半径。因此，step 3命令绘制的图形是以

原点为中心，以6为半径的心形图。另外，为了将上面步骤绘制的心形图清除，然后绘制新的

心形图，需要在绘制命令之前输入clf命令。

 
根据以上程序代码，当调用函数时输入3个参数时，第一个参数和

第二参数分别表示心形图的圆心坐标，在本实例中该坐标为（-1，
2）。第三个参数表示的是心形图的半径，本实例中该数值为8。因
此，上面程序代码绘制的是外层的心形图。

step 5
查看绘制图形的数据数组。在MATLAB的命令窗口中输入以下代

码：



step 6
输入“coordinate”，按“Enter”键，得到的结果如下：

以上程序代码列出的数据就是函数drawcardioid的输出参量。在前
面步骤中，用户没有选择显示输出参量，因此程序并没有得出输出参

量。在用户编写M文件时，函数声明行中的“变长度”变量必须放在普
通的变量之后。为了帮助读者了解变长度变量定义的工作原理，下面

简要介绍varargin函数的工作原理。
在MATLAB中， varargin函数本身就是一个元胞数组，当

MATLAB调用包含了varargin函数的M文件后，函数输入变量的分配规
则是：输入变量按照先后次序逐个对应分配给函数定义的输入变量列



表中定义的普通变量，然后将剩余的输入变量分配到varargin元胞数组
中。因此，varargin元胞数组的长度取决于分配到的输入变量数。

说明

当编写M函数文件时，varargin的每个元胞应该当作一个“普通”输入变量处理。而

varargout的工作原理、规则和varargin相同，差别在于varargout处理的是输出变量和输出变量

之间的关系。

13.3.3 跨空间计算表达式的数值

在前面的章节中，已经分别介绍了实现不同工作空间之间变量传

递的两种渠道：函数的输入输出变量和全局变量。在MATLAB中，还
提供了其他方法来实现跨空间的变量传递，下面将介绍跨空间计算表

达式数值的命令，详细的调用格式如下：

 
◆ evalin(ws,expression) 跨空间计算串表达式的数值。
◆ evalin(ws,expression1，expression2) 跨空间计算替代串表达

式的数值。

 
例13.11 在MATLAB中，使用evalin命令来实现跨空间传递变量

数值。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



step 2
将以上代码保存为“exeval.m”文件，然后再次单击MATLAB命令

窗口工具栏中的 按钮，打开M文件编辑器。在M文件编辑器中输入

以下程序代码：

将以上代码保存为“p_exeval.m”文件，该文件是执行前面程序代码
的脚本文件。

step 3
返回到MATLAB命令窗口中，输入命令 “p_exeval”，然后

按“Enter”键，得到的图形如图13.9所示。



图13.9 程序完成得到的图形结果

当在MATLAB中运行以上程序代码时，会存在三种空间：基础工
作空间、主函数（exeval）空间和子函数（subexeval）空间。在每个
工作空间中，都存在着不同的参数theta和t的数值。

说明

从以上结果也可以看出，尽管运算得到的数值都是在子函数中进行的，但是由于参数取

自不同空间的数值，因此产生的结果也会互不相同。

 
在MATLAB中，命令evalin中的ws参数可以选取两个数值：base和

caller。下面分别介绍两种不同调用格式的机理。当调用
evalin(ws,expression)命令格式时，其执行机理如下：

 
◆ 当ws是base时，表示MATLAB运行eval('expression')时，将从

基本工作空间获得变量数值。

◆ 当ws是caller时，表示MATLAB在运行eval('expression')时，将
从主调函数工作空间中获得变量数值。主调函数是相对于被调函数而

言的。

 



当调用evalin(ws,expression1，expression2)命令格式时，其执行机
理如下：先从所在函数空间获取数值，用eval('expression1')计算原来字
符串表达式；如果计算失败，则再从ws指定的工作空间中获取变量数
值，用eval('expression2')计算替代字符串表达式的数值。

13.3.4 跨空间赋值

除了前面介绍的方法，MATLAB还提供了另外一种方法来实现不
同工作空间之间的变量传递，也就是跨空间赋值命令，其具体调用格

式如下：

表达式的意思是跨空间向变量var赋值。其具体的含义就是，将当
前工作空间中的变量val赋值给ws指定空间的变量var。
例13.12 在MATLAB中使用assignin命令跨空间赋值。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2



将以上代码保存为“assign.m”文件，然后返回到MATLAB的命令窗
口中，输入“assign”，按“Enter”键，得到的结果如图13.10所示。

图13.10 显示程序代码的结果

step 3
单击对话框中的“OK”按钮，然后在MATLAB命令窗口中输入

whos命令，查看程序得到的变量，如图13.11所示。



图13.11 查看程序的变量数值

说明

在以上程序代码中，相关的程序变量都是用户在程序语句中自行定义的，只有变量imfile

和cmap是通过assignin命令赋值得到的。

13.4 字符串演算函数

在MATLAB中，各种命令、表达式、语句以及由它们综合组成的
M文件，是实现各种计算目的的常见方法。同时，为了提高计算的灵
活性，MATLAB还提供了一种利用字符串进行计算的能力。利用字符
串可以构成函数，可以在运行中改变所执行的命令，可以被泛函命令

调用实现比较复杂的运算。

13.4.1 内联函数——inline



在MATLAB中，和字符串运算相关的函数主要有feval、eval和
inline函数等，关于eval和feval函数的具体使用方法，请查阅“数值计
算”的相关内容。在本小节中，将详细介绍内联函数inline的使用方
法。在MATLAB中，内联函数inline的调用格式如下：

 
◆ g = inline(expr) 将字符串表达式转换为输入变量自动生成的

内联函数。

◆ g = inline(expr,arg1,arg2,...) 将字符串表达式转换为arg1、
arg2输入变量自动生成的内联函数。

◆ g = inline(expr,n) 将字符串表达式转换为x、p1、p2……pn
输入变量自动生成的内联函数。

 
同时，MATLAB还提供了和inline函数相关的处理函数，主要有以

下函数：

 
◆ vectorize(inlilne_fun) 使内联函数适合数组运算的法则。
◆ char(inline_fun) 给出内联函数计算公式。

13.4.2 求解函数零点

前面已经讲解了inline函数的基本语法和定义，在本小节中，将通
过具体的例子来讲解如何使用inline函数求解函数的零点。
例13.13 在MATLAB中，求解超越函数f（t）＝sin2t·e-at－b｜t｜

的所有零点。

step 1



单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2
将以上代码保存为“inline_zero.m”文件，然后返回到MATLAB的命

令窗口中，输入“ainline_zero”，按“Enter”键，得到的结果如图13.12所
示。

图13.12 查看函数的零点分布



step 3
获得函数的零点初始近似数值。以上步骤显示了函数零点的大致

分布，现在需要获得近似初始数值。在MATLAB的命令窗口中输入以
下命令：

MATLAB会进入交互界面，可以动态地选取零点的近似数值，如
图13.13所示。

图13.13 动态选取零点近似数值

step 4
查看选取的结果。当选取了图形中的5个数据点后，MATLAB会

自动结束以上程序代码。可以在MATLAB的命令窗口中查看数据点的
坐标，得到的结果如下：



step 5
得到函数的精确零点数值。在MATLAB的命令窗口中输入以下代

码：

step 6
查看计算结果。在以上程序代码中，s表示的是函数准确的零点，

m是对应的函数数值，可以在MATLAB中查看其相应的数值：

说明

在以上程序代码中，最后两个零点的数值都是-0.6010，而不是0。但是，根据函数的定

义，f（0）＝0，因此0应该是函数的其中一个零点。MATLAB之所以没有查出这个零点，是

因为函数图形在x＝0的地方没有穿越坐标轴。

13.4.3 绘制函数图形

前面已经介绍过绘制函数图形的方法，但是，对于一些特殊的函

数或者表达式，使用绘图命令无法绘制具体的图像。例如，一些微分



方程的数值解组成的图形，很难通过plot命令来绘制。这种情况下，
通过inline函数就可以解决这个问题，下面通过具体的例子来说明如何
使用inline函数绘制函数图形。
例13.14 在MATLAB中，绘制陀螺运动的图形。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器，

输入以下程序代码：



完成以上程序代码后，将其保存为“tlyd.m”文件。在该文件中，
tlyd是主函数，而其中zbbh则是被调函数，也就是子函数。

step 2



返 回 到 MATLAB 的 命 令 窗 口 ， 输 入 命 令 “tlyd” ， 然 后
按“Enter”键，得到的起始图形如图13.14所示。当MATLAB开始运行程
序后，会呈现动态的陀螺运动，当程序循环结束后，就可以得出该程

序代码的结束图形，如图13.15所示。

图13.14 陀螺开始运动的图形



图13.15 陀螺结束运动的图形

说明

在以上程序代码中，首先使用inline函数定义了陀螺运动的微分方程，这就避免了在后面

的程序代码中使用字符串带来不必要的麻烦。

13.4.4 求解最值

求解最值的内容和方法前面已经介绍过，在本小节中，将介绍如

何使用inline函数来求解函数的最值。
例13.15  在MATLAB中，使用内联函数求解函数f（x，y）＝

100（y－x2）2＋（1－x）2在定义域范围内的极小值。

step 1
在MATLAB的命令窗口中输入以下程序代码：



step 2
查看使用单纯形求解的极小值点。在命令窗口中输入以下代码：

step 3
查看使用拟牛顿法求解的极小值点。在命令窗口中输入以下代

码：



step 4
为了方便查看该函数的特性，可以绘制该二元函数的曲面图形。

在MATLAB的命令窗口中输入以下代码：

step 5
查看图形结果。输入代码后，按“Enter”键，得到的图形如图13.16

所示。



图13.16 函数的图形

说明

从图13.16中可以看出，该函数有一片浅谷，因此在求解该函数的极小值时，许多算法难

以超过这个浅谷，这个函数就是著名的Rosen Brock的“Banana”测试函数。

13.5 程序的调试和剖析

和其他编程语言一样，当使用MATLAB编写M文件的时候，遇到
错误（在程序代码中称为Bug）在所难免，尤其是在比较大规模或者
多人参与的情况下，掌握程序调试的方法和技巧对提高工作效率很重

要。

一般来讲，程序代码的错误主要分为两种：语法错误（Syntax
Errors）和逻辑错误（Logical Errors）。其中，语法错误通常包括变量
名和函数名的误写、标点符号的缺漏或者end的漏写等，对于这类错



误，MATLAB会在运行或者P码编译的时候发现，然后终止执行并且
报错，用户很容易发现这类错误并改正。

对于逻辑错误，情况则相对比较复杂，处理起来也比较困难。主

要原因如下：逻辑错误一般会涉及算法模型、程序模型是否一致，同

时还涉及编程人员对程序算法的理解等；同时，逻辑错误的表现形态

也较多：程序运行正常，但是结果异常，或者程序代码不能正常运行

而中断。最后，逻辑错误相对于语法错误而言，更难查找错误原因，

因为逻辑错误一般是动态的，一旦停止运行，中间变量都会被删除，

很难跟踪程序变量的变化情况。

针对上面两种错误类型，本节将详细介绍两种常见的调试

（Debug）方法：直接调试法和工具调试法。同时，除了介绍如何进
行程序调试之外，还介绍如何对程序代码进行解析，以便能够对程序

运行的时间开销进行分析，来改善程序性能。

13.5.1 直接调试法

根据前面章节的介绍，读者可能已经发现MATLAB语言本身的特
点，该语言的向量化程度比较高，程序设计一般都显得比较简单。

MATLAB本身的运算能力强，命令系统比较简单，可读性比较强，因
此直接调试法往往十分有效。通常采用的直接调试法包括如下手段。

经过分析，将重点怀疑语句行或者命令行后面的分号去掉，或者

改成逗号，使得运算结果显示在屏幕上。

在有疑问的语句附近，添加显示某些关键变量值的程序语句，查

看变量数值；在程序的适当位置添加keyboard命令，在MATLAB执行
到相应的程序代码时，会暂停执行程序代码，同时会在命令窗口中显

示k>>提示符，可以查看或者修改变量的数值，然后在提示符后面输
入return命令行后，系统会返回到程序代码中，继续执行源文件。



例13.16 在MATLAB中，使用直接调试法来调试程序代码。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器，

输入以下程序代码：

step 2
将以上程序代码保存为“ballw.m”文件，然后在命令窗口中输

入“ballw(2,200)”，得到的图形如图13.17所示。当MATLAB完成了以上
程序代码后，得到的结果如图13.18所示。



图13.17 程序运行的结果

图13.18 程序的最终结果图形

说明

从以上执行情况可以看出，该程序代码没有任何的语法和逻辑错误，之所以选择该程序

代码，是为了在后面的步骤中演示如何直接调试程序代码。

step 3
显示封闭曲线的坐标数值。打开保存的“ballw.m”文件，然后将程

序代码修改如下：



修改以上程序代码后，将程序代码保存为“ballw.m”文件。

step 4
查看程序结果。返回到命令窗口，输入命令行“ballw(2,200)”，得

到的结果如下：



从以上程序结果可以看出，当在程序代码中添加一个简单的语

句“data=[x',y',z']”后，就可以在程序代码执行的过程中，查看封闭曲线
的所有坐标值数值。如果程序结果中封闭曲线不正常，则可以从以上

数据中查看数值的问题。

step 5
显示小球位置的坐标数值。打开上面步骤保存的“ballw.m”文件，

然后将程序代码修改如下：



修改以上程序代码后，将程序代码保存为“ballw.m”文件。

step 6
查看程序结果。返回到命令窗口，输入命令行“ballw(2,200)”，得

到的结果如下：

在以上步骤中，分别使用简单程序代码查看出关键的程序数据，

如果在程序运算过程中出现问题，则可以从以上程序数值中查看出相

应的问题。



13.5.2 工具调试法

前面已经演示了如何使用直接调试法来调试程序代码，但是如果

函数文件规模较大，文件的内嵌复杂，或者有较多函数、子函数、私

有函数待调用，直接调用法则可能会失败，这个时候则需要使用

MATLAB的专门调试工具：调试器。
MATLAB自带的M文件编辑器同时也是程序代码的编辑器，可以

在M文件编辑器中输入程序代码后，直接在其中进行调试，显得方便
和直观。M文件编辑器的功能已经介绍过，在本小节中将介绍该编辑
器的调试功能键和菜单选项。为了能够显示M文件编辑器的调试功
能，有必要调用某个M文件。下面调用的是“test_sort.m”文件，调用的
结果如图13.19所示。

图13.19 M文件调试器

在以上文件调试器中，当设置M文件进入调试阶段时，M文件编
辑器提供的调试功能键都会被激活，表示可以使用这些功能键来调试



程序代码。M文件的调试功能键如图13.20所示。

图13.20 调试功能键

将以上调试功能键从左到右依次命名为1，2，…，7，其对应的功
能介绍如下：

 
◆ 1号功能键：功能是断点设置（或者清除），对应的菜单选项

为“Debug”→“Set/clear breakpoints”，快捷键为“F12”，对应的MATLAB
命令为dbstop/dbclear。

◆  2号功能键：功能是清除全部断点，对应的菜单选项
为“Debug”→“Clear Breakpoints in All Files”，对应的MATLAB命令为
dbclear all。

◆ 3号功能键：功能是单步执行当前命令行，对应的菜单选项
为“Debug”→“Step”，快捷键为“F10”，对应的MATLAB命令为dbstep。

◆  4号功能键：功能是深入被调函数，对应的菜单选项
为“Debug”→“Step In”，快捷键为“F11”，对应的MATLAB命令为dbstep
in。

◆  5号功能键：功能是跳出被调函数，对应的菜单选项
为“Debug”→“Step Out”，快捷键为“Shift+F11”，对应的MATLAB命令
为dbstep out。

◆  6号功能键：功能是连续执行命令行，对应的菜单选项
为 “Debug”→“Continue”，快捷键为 “F5”，对应的MATLAB命令为
dbcont。

◆  7号功能键：功能是退出调试模式，对应的菜单选项
为“Debug”→“Exit Debug Mode”，对应的MATLAB命令为dbquit。



 
从以上介绍中可以看出，常见的调试功能键都可以从对应的菜单

选项实现，除了以上功能键之外，MATLAB还提供了其他的调试功
能。例如，如果希望修改或者设置条件断点，可以选择菜单选

项 “Debug”→“Set/Modify Conditional Breakpoint” ， MATLAB 会 弹
出“MATLAB Editor”对话框，如图13.21所示。

图13.21 设置条件断点

另外，如果希望设置程序代码的暂停设置，可以选择菜单选

项“Debug”→“Stop if Error/Warnings…..”，打开对应的对话框，如图
13.22所示。



图13.22 设置程序代码的警告信息

在MATLAB的M文件调试器中，除了常见的功能键和菜单选项之
外，还有一个“Stack”（空间堆栈）下拉菜单值得注意。在调试文件代
码时，可以通过改变它的内容来选取和操作不同工作空间的变量，如

图13.23所示。

图13.23 工作空间切换

下面通过一个实例来说明如何使用MATLAB的工具调试代码程
序。

例13.17 选用函数文件“ssort.m”和脚本文件“test_sort.m”，演示如
何在MATLAB中调试代码程序。

step 1
打开脚本文件“test_sort.m”，然后在程序代码的第13行添加程序断

点，得到的结果如图13.24所示。



图13.24 添加程序的断点

step 2
选择M文件编辑器的菜单栏中的“Debug”→“Run”命令，或者直接

按快捷键“F5”，开始该程序代码的调试工作，得到的结果如下：

从运行结果可以看出，程序代码可以不受影响地正常运行，但是

在添加程序断点的地方会显示程序语句，并会出现“K>>”提示符，当
输入“return”命令行后，程序可以继续进行。

step 3



除了可以使用“return”命令来返回程序代码的调试之外，还可以使
用“深入被调文件”按钮，来查看程序代码的运行情况：

提示

以上程序代码只是简单地演示了如何使用工具调试法来调试程序，对于其他的调试方

法，也许更适合于使用在比较复杂的程序代码中，可以自行尝试。

13.5.3 程序剖析

程序调试的主要目的在于对运行不正常的M文件的错误进行定位
和纠正，而程序剖析的主要功能在于对M文件的各项命令耗时进行分
析，用以提高整个程序代码的性能。特别是对于编程的初学者，对程

序代码进行剖析，寻找到程序代码的瓶颈地方，然后有针对性地重新

编写程序代码，直到MATLAB的剖析报告表明程序大部分的运行时间
被花费在内置函数中，就可以表明该程序代码的性能比较优良。

和程序调试类似，在MATLAB中进行程序剖析也有两种调用方
法：命令调用方法和图形界面调用方法。其中，在MATLAB中常见的
调用命令如下：



 
◆ profile on -detail level 开启程序剖析器，并清除以往的剖析

记录。

◆ profile off 暂停程序剖析器的运行。
◆ profile resume  保留以往的剖析数据，重新启动程序剖析

器。

◆ profile clear 清除以往的剖析记录。
◆ profile viewer 开启界面式的程序剖析器。

提示

在以上程序命令中，参数level可以选择三个数值：mmex、builtin和operator。它们分别指

定剖析数据的统计层次：M文件层、内建函数层和运算命令层。

 
例13.18 选用自行编写的M文件sierpinskihm.m，对其进行程序代

码的剖析。

step 1
打开已经编写完成的“sierpinskihm.m”，其代码显示如下：



step 2



启动界面式的代码剖析器。选择M文件编辑器中的菜
单“Desktop”→“Profiler”命令，或者在命令窗口中键入命令行“profile
viewer”，打开性能剖析器，如图13.25所示。

图13.25 程序代码剖析器

说明

在默认情况下，程序代码剖析器在MATLAB中会独立显示，如果希望操作方便，可以选

择该界面中的菜单选项“Desktop”→“Dock Profiler”，使剖析器放在MATLAB的操作桌面上。

step 3
运行代码剖析。在性能剖析器界面的“Run this code”文本框中，输

入运行分析的代码，在本例中输入“sierpinskihm(3)”，然后单击“Start
Profiling”按钮，开始进行代码剖析，如图13.26所示。



图13.26 运行程序代码的剖析

当单击“Start Profiling”按钮后，程序的剖析就开始了，这个时
候“Start Profiling”按钮变成灰色，程序将该按钮的功能变成不可用
（disabled）；而界面右上角的运行指示灯变成绿色，表示程序剖析处
于工作状态，同时，计时器数值连续累加，显示剖析器所经历的工作

时间，如图13.27所示。



图13.27 剖析程序当中

当程序运行结束时，剖析分析就会自动暂停，此时 “Start
Profiling”按钮恢复到原来的颜色，重新恢复所有的功能。运行执行灯
也会变成棕色，表示剖析分析处于暂停状态，计时数也可以近似反映

被剖析命令的总时间，如图13.28所示。



图13.28 剖析结果

在本实例中，剖析程序代码的时间为15s，同时在以上结果中显示
了关于该程序代码的“Profile Summary（分析汇总表）”。可以在这个
比较综合的结果中查看关于该程序的代码剖析结果，同时，当程序运

行结束后，会得到该程序的结果，如图13.29所示。

图13.29 程序运行的结果



step 4
分析代码剖析结果。以上剖析结果属于比较综合的内容，如果希

望了解比较详细的内容，可以单击界面中带有超链接的文字。在本例

中，单击“sierpinskihm”链接，查看对应的详细内容，其中关于消耗时
间的内容如图13.30所示。同时，MATLAB还会显示关于该程序代码的
运行性能列表，如图13.31所示。

图13.30 程序代码中最消耗时间的程序行



图13.31 程序代码的性能分析列表

以上剖析报告很详细地表明了该段程序代码的“瓶颈”位置，也就
是可以自行修改的关键程序行。

13.6 小结

本章主要介绍了MATLAB关于程序设计的高级话题，主要包括
MATLAB的向量化、脚本、变量传递和程序的调试和剖析等，这些内
容都是用户在MATLAB中进行程序设计时，提高程序编写能力的重要
知识，希望读者能够认真体会。

◆   ◆   ◆
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第14章 句柄图形

本章包括

◆句柄图形体系

◆图形句柄的操作

◆图形对象的操作

◆高层绘图命令

◆坐标轴对象

 
前面章节已经介绍了使用MATLAB绘制二维和三维图形的方法。

但是，在介绍绘制方法的时候，使用的都是MATLAB的高层绘图命
令，当用户希望“个性化”图形属性的时候，高层绘图命令就会有很大
的局限性，这个时候，句柄图为用户提供了强有力的功能。在本章

中，将详细介绍如何使用MATLAB的句柄图形绘制各种复杂图形。
本章的内容将更深入MATLAB可视化功能的内核，通过本章的内

容可以更深入地理解高层绘图命令，进而可以绘制更精确、更生动的

图形，同时，通过学习本章的内容还可以利用底层绘图命令和图形对

象属性开发专用的绘图函数。

在本章中，将详细介绍句柄图形体系、图形对象、属性和操作方

法，尽量做到由表及里、由浅入深地介绍各种内容，同时尽量做到突

出要点和难点，对各个对象最常用、最不可或缺、较难把握的属性进

行详细介绍。同时，在本章的最后，将介绍一些关于句柄图形的综合

案例，希望读者可以从中了解到句柄图形的使用方法。

14.1 句柄图形体系



句柄图形是对底层图形例程集合的总称，它实际上进行生成图形

的工作。这些细节通常隐藏在图形M文件的内部，但如果想使用它们
也是可以的。句柄图形可以被任何人用来改变MATLAB生成图形的方
式，不论是只想在一幅图里做一点小变动，还是想做影响所有图形输

出的全局变动。句柄图形允许用户定制图形的许多特性，而这用高级

命令和前几章里描述的函数是无法实现的。

底层绘图命令在使用起来不像高层命令那样简单易懂，但是底层

绘图命令直接操作基本绘图要素，可以更具个性化地表现图形。前面

已经介绍过，本章不会介绍句柄图形的全部内容。这里的目的只是对

句柄图形概念做基本了解，并提供足够多的信息，使得即使是偶尔使

用一下MATLAB的用户也可以利用句柄图形。

说明

前面那些章提供的图形功能被认为是高级的命令和函数，包括plot，mesh，axis及其他。

这些函数是建立在底层函数和属性的基础上，总称为句柄图形。

14.1.1 图形对象

前面多次提到句柄图形，在这里将详细介绍句柄图形的概念。在

MATLAB中，每个图形的每一组成部分是一个对象，每一个对象有一
系列句柄和它相关，而且每一个对象都有按需要可以改变的属性。

在计算机领域中，对象可以被粗略地定义为由一组紧密相关、形

成唯一整体的数据结构或函数集合。在MATLAB中，图形对象是一幅
图中很独特的成分，它可以被单独操作。

具体来讲，由MATLAB的图形命令产生的每一件东西都属于图形
对象，包括图形窗口或仅仅是图形，还有坐标轴、线条、曲面、文本

和其他对象。



说明

在MATLAB中生成的每个图形，都由多个图形对象组成，每个具体的图形不必包含全部

对象，但是每个图形都必须具备根屏幕和图形窗。

14.1.2 句柄对象

在MATLAB中，每一个对象都由一个数字来标识，叫做句柄。当
用户每次创建一个对象时，MATLAB就为它建立一个唯一的句柄。计
算机屏幕作为根对象常常是0。Hf_fig=figure命令建立一个新的图形窗
口，变量Hf_fig中返回它的句柄值。图形窗口的句柄为整数，通常显
示在图形窗口标题条中。其他对象句柄是MATLAB满精度的浮点值。
所有产生对象的MATLAB函数（例如plot、mesh、surf及其他）都

为所建立的每个对象返回一个句柄（或句柄的列向量）。有一些图形

由一个以上对象组成。比如，一个网格图由一个曲面组成，它只有一

个句柄；而waterfall图形由许多线条对象组成，每个线条对象都有各
自的句柄。例如，命令行“Hl_wfall=waterfall(peaks(20))”对线条返回一
个包含着20个句柄的列向量。

注意

虽然句柄变量也是MATLAB变量中的一种，可以取任意名字，但是遵循某些命名规则使

得能在M文件中很容易找到句柄变量。例如，可以将句柄变量以大写的H开头，跟之以一个辨

识对象类型的字母，然后是一个或几个描述符。当对象类型不知道时，用字母x，比如

Hx_obj。

14.1.3 句柄图形的结构



在MATLAB中，所有的图形对象按父对象和子对象组成层次结
构。计算机屏幕是根对象，并且是所有其他对象的父亲。图形窗口是

根对象的子对象；坐标轴和用户界面对象是图形窗口的子对象；线

条、文本、曲面、补片和图像对象是坐标轴对象的子对象，这种层次

关系在图14.1中给出。

图14.1 句柄图形的结构

根可包含一个或多个图形窗口，每一个图形窗口可包含一组或多

组坐标轴。所有其他的对象（除了uicontrol和uimenu外）都是坐标轴
的子对象，并且在这些坐标轴上显示。所有创建对象的函数当父对象

或对象不存在时，都会创建它们。例如，如果没有图形窗口，plot函
数会用默认属性创建一个新的图形窗口和一组坐标轴，然后在这组坐

标轴内画线。

14.1.4 图形对象的属性



所有对象都有一组定义其外貌和形状的属性，同时所有对象都有

属性来定义它们的特征。尽管许多属性所有的对象都有，但与每一种

对象类型（比如坐标轴、线、曲面）相关的属性列表都是独一无二

的。对象属性包括对象的位置、颜色、类型、父对象、子对象及其他

内容。每个不同对象都有和它相关的属性，可以改变这些属性而不影

响同类型的其他对象。

对象属性包括属性名和与它们相关联的值。属性名是字符串，它

们通常按混合格式显示，每个词的开头字母大写，比如“LineStyle”。
但是，MATLAB识别一个属性时是不分大小写的。另外，只要用足够
多的字符来唯一地标识一个属性名即可。例如，坐标轴对象中的位置

属性可以用“Position”，“position”，甚至是“pos”来调用。
用户不仅可以查询当前对象的任意属性值，而且可以指定大多数

属性的取值（在MATLAB 7.0中，对象的有些属性只是只读的）。用
户设定的属性值仅仅对特定的对象实例起作用，不会影响到不同对

象、不同实例的属性。如果希望修改以后创建对象的属性值，可以设

置属性的默认数值，这样的修改就可以影响后面创建的所有对象。

当用户在MATLAB中创建图形对象时，并不需要指定对象的每个
属性值，这是因为如果不指定属性值，MATLAB会对对象采用默认属
性值。如果希望自己创建的图形具有统一的风格，可以设置一组“用户
定义”的默认属性数值。

说明

在编写M文件的时候，可以使用属性名的缩写。但是笔者不建议这样做，以免带来不必

要的麻烦。

14.2 图形句柄的操作



从前面的内容中已经了解到图形对象的基础知识。下面，将介绍

如何对图形对象进行操作，包括创建图形句柄、获取图形对象的句

柄、使用句柄操作图形对象等，下面分别详细介绍。

14.2.1 创建图形对象

在前面介绍的所有图形对象中，除了根屏幕，其他所有的图形对

象都有相应的创建命令，这些创建命令名称都和相应的对象名称相

同。例如，函数text会创建一个text对象，figure函数会创建一个figure
对象，而且这些函数都是MATLAB的内置函数。每个命令在创建图形
对象的同时，也会返回图形对象的句柄，可以使用该对象句柄来查询

或者修改对象的属性值。

这些底层函数只能创建11种图形对象中的一个，并且将图形对象
置于适当的父辈对象之中。例如，patch命令会利用当前坐标轴中的默
认属性来创建方块对象，如果在执行该命令之前没有创建坐标轴、图

形窗对象，则MATLAB会自动创建这些对象。如果在执行该命令之前
已经有了这些对象，则方块对象将会绘制在之前的坐标轴对象中，而

且不会影响坐标轴对象中的其他对象。

说明

根据前面的介绍可知，如果使用高层绘图函数来绘制图形，添加新的图形对象会将前面

的操作全部覆盖，而使用底层绘图函数则不会造成这样的问题，只会在原来的基础上继续添

加对象或者修改属性。

 
表14.1列出了MATLAB 7.0中所有图形对象的创建函数。

表14.1 MATLAB中的图形对象创建函数



例14.1 在MATLAB中，创建一个图形对象，并设置简要的对象
属性。

step 1
在MATLAB的命令窗口中输入以下命令行：

step 2
查看图形结果。输入以上代码后，按“Enter”键，得到的图形如图

14.2所示。



图14.2 创建图形对象的实例

在以上程序代码中，通过axes命令创建了坐标轴对象，同时返回
坐标轴对象的句柄ah，在该命令行中设置了坐标系中x和y轴的坐标刻
度和颜色；然后使用底层命令surface来绘制曲面，在其中设置了数据
标记、数据点的颜色属等，在设置数据标记的表面颜色时，使用了get
函数来获取坐标轴的颜色属性，关于该函数的用法将在后面的章节中

详细介绍。

说明

从以上程序结果中可以看出，底层命令surface的默认绘制界面是二维图形，而不是三维

图形，这个命令和对应的高层命令surf有很大的区别。

step 3
在命令窗口中输入以下命令代码：

step 4



查看图形结果。输入以上代码后，按“Enter”键，得到的图形如图
14.3所示。

图14.3 修改视角后的图形

step 5
在以上图形对象中添加文本对象，在MATLAB的命令窗口中输入

以下代码：

step 6
查看图形结果。输入以上代码后，按“Enter”键，得到的图形如图

14.4所示。



图14.4 添加了文本对象的图形

以上对象创建函数还可以使用一个更加简单的调用格式：

该命令和上面步骤中使用的命令是等效的。

说明

以上命令行调用形式比正常的默认格式要简单很多，但是有时会导致输出效果与正常调

用格式有细微的差别，因此如果不太熟悉正常调用格式，不建议使用这种方法。

14.2.2 访问图形对象的句柄

前面已经介绍，MATLAB会给用户创建的每个图形对象指定一个
句柄，所有对象创建函数都能返回对象的句柄。如果需要访问对象的

属性，那么最好在创建对象时将对象的句柄赋给一个变量。因为，如

果设置图形对象的属性，首先需要知道该对象对应的句柄，在本小节

中，将介绍如何访问图形对象的句柄。在MATLAB中，获取图形对象
的句柄有下面几种常见的方法。

 



◆ 通过图形创建命令获取对象的句柄。在MATLAB中，无论用
户使用的是高层命令还是底层命令都可以返回图形对象的句柄。例

如：

在以上程序代码中，H_Line1、text1都是相应图形对象的句柄。
◆ 通过get函数访问图形对象的句柄。如果某图形对象的句柄已

知，可以在程序代码中通过get函数来访问该图形对象的句柄。通用的
调用格式如下：

H_pa=get(H_known,PV) 获取H_known句柄对象的句柄数值。
◆ 对于用户操作的当前对象，MATLAB提供了一些简便的访问

方法：

 
●gcf 返回当前图形窗口（CurrentFigure）的句柄。
●gca 返回当前图形窗口中的坐标轴（CurrentAxes）的句柄。
●gco  返回最近被鼠标点击的图形对象（CurrentObject）的句

柄。

 
◆ 使用对象的“标签”来访问对象句柄。可以通过‘Tag’属性来给

对象设置一个标签，然后就可以通过图形对象的标签来访问对象的句

柄。以下程序代码可以访问到相应的图形对象句柄：

下面举例说明如何利用上面介绍的方法来访问图形对象的句柄。

例14.2 使用高层命令绘制cost在[0，π/2]范围内的图形，然后添
加文字注释，最后访问图形对象句柄，修改文字注释的位置。

step 1



在MATLAB的命令窗口中输入以下代码：

step 2
查看图形结果。输入以上代码后，按“Enter”键。

step 3
添加文本注释。在上面步骤完成的图形中添加文本注释，输入以

下代码：

step 4
查看图形结果。输入以上代码后，按“Enter”键，得到的图形如图

14.5所示。

图14.5 添加文字注释

step 5



获取文本对象的句柄，并进行句柄操作。在命令窗口中输入以下

代码：

step 6
查看图形结果。输入以上代码后，按“Enter”键，得到的图形如图

14.6所示。

图14.6 修改文本的位置属性

step 7
查看图形对象的子类型。前面的步骤中已经修改了文本的属性，

现在可以看出图形中所有对象类型，在命令窗口中输入以下内容：

可以看出，当前坐标轴的子对象有直线和文本两个对象。以上代

码两次使用了get函数，获取相应的句柄和句柄类型，其中T是元胞数



组类型。

14.2.3 使用句柄操作图形对象

例14.2通过使用findobj函数查找当前图形对象中的子对象，除了
这个函数之外，MATLAB中还提供了其他句柄操作函数，使用这些函
数可以通过句柄操作来修改图形对象的属性。在本小节中，将介绍几

个常见的操作函数，希望能够帮助读者了解句柄操作的内容。

其中比较常用的函数是copyobj，这个函数的功能是将一个对象从
一个父对象复制到另外一个父对象中，其调用格式如下：

通过该命令创建的新对象与原来的对象唯一的差别在于Parent属
性和句柄。可以同时将多个对象复制到一个新的父对象中，也可以将

一个对象复制到多个父对象中。如果复制的对象包含有子对象，

MATLAB则会将子对象一起复制过去。
例14.3 绘制peaks函数的三维图形，然后将其复制到另外一个图

形中。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看图形对象类型。输入代码后，可以查看该图形对象类型，得

到的结果如下：



从以上结果可以看出，通过 peaks函数获得的图形对象
是“surface”，而且没有其他的子对象，程序得到的图形如图14.7所示。

图14.7 原始的图形对象结果

step 3
复制以上图形对象。在MATLAB的命令窗口中输入以下代码：

step 4
查看图形结果。输入以上代码后，按“Enter”键，得到的图形如图

14.8所示。



图14.8 复制的图形对象

说明

从以上程序结果中可以看出，尽管使用copyobj命令复制了图形对象的属性，但是由于底

层命令surface的默认二维视角，因此复制后的图形会是二维的。

step 5
修改复制后的图形对象的属性，在命令窗口中输入以下代码：

step 6
查看图形结果。输入以上代码后，按“Enter”键，得到的图形如图

14.9所示。



图14.9 修改后的图形对象

除了使用复制函数，MATLAB还提供了delete命令来清除图形句柄
对象，使用起来非常便捷，而且不会影响其他对象的属性。下面举例

说明如何使用delete命令清除图形对象。
例14.4 沿用例14.2，在添加了文本对象后，使用delete命令将其

清除。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看图形结果。输入上面代码后，按“Enter”键，得到的图形如图

14.10所示。



图14.10 原始图形

step 3
在MATLAB的命令窗口中输入以下代码：

step 4
查看图形结果。输入上面代码后，按“Enter”键，得到的图形如图

14.11所示。



图14.11 删除文本对象

14.3 图形对象的操作

通过上面介绍的任何一个方法创建图形对象后，对于图形对象的

操作主要就是查询、修改或者设置各个图形对象的属性值。对于图形

对象，可以访问查询其各个属性值，也可以根据需要设置属性值，最

后，可以根据需要设置默认属性值。在本节中将详细介绍如何修改、

访问对象属性和设置默认属性值。

14.3.1 设置图像属性——set命令

在MATLAB中，可以使用多种方法来设置创建的图形对象的属
性，其中最常用的设置方法包括创建图形时设置属性参数、使用set函
数设置相关属性、使用结构体数组来定义属性等，下面详细介绍各种

使用方法。



创建图形对象时设置属性。使用这种方法来设置属性的基本调用

格式如下：

其中，GraphicCommand代表的是MATLAB中可用的绘图命令，可
以是高层命令，也可以是底层命令。（PN，PV）是属性名、属性值
构成的属性对，属性对的数目没有任何的限制。例如，以下命令行就

可以在创建对象的时候设置相应的属性：

通过函数set设置图形对象的属性。在MATLAB中，set函数的常用
调用格式如下：

 
◆ set(H,'PropertyName',PropertyValue,...) 设置H句柄对象的

对应属性的属性值。

◆ set(H,'PropertyName') 显示H句柄对象PropertyName的全部
属性值。

 
例如，可以通过set函数将图形的y坐标轴移到图形的右侧，对应

的代码如下：

例14.5 绘制peaks函数的三维图形，并通过set函数查看各种属
性。

step 1
绘制三维图形。在MATLAB的命令窗口中输入以下代码：

以上命令行可以得到peaks函数的曲面图，同时将图形句柄保存在
变量H_figure中。为了节省篇幅，这里就不给出具体的三维图形了。



step 2
通过set函数查看可以设置的图形属性，得到的结果如下：



在以上结果中，如果某项属性对应的属性值为空，例

如“LineWidth: {}”，表示用户不能对该图形对象设置LineWidth属性；
如果对应的属性值不为空，用户则可以在对应的属性值列表中设置相

应的属性。

step 3
通过set函数查看图形的“Marker”属性列表，得到的结果如下：

从以上结果可以看出，可以从“Marker”属性的14个选项中选择任
何一个来设置图形标记的属性。

step 4
通过set函数设置图形标记的属性，相关的代码如下：

step 5
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.12所示。



图14.12 设置数据标记后的图形

14.3.2 使用结构体设置属性

除了以上方法之外，在MATLAB中用户还可以使用结构体数组直
接设置图表对象的属性。例如，可以定义一个结构体来设置图表对象

的属性：

然后再通过set函数选用以上结构体props，来设置图形对象的属
性，相应的代码如下：

相当于对当前图形窗口设置结构体props所定义的对应的属性。下
面将介绍几个综合设置图形对象属性的例子。

例14.6 在MATLAB中绘制克莱因瓶（Klein bottle）。

step 1
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，然
后在M文件编辑器中输入以下代码：



说明

克莱因瓶是指一种既没有内表面也没有外表面的单侧拓扑面，它是通过把逐渐变细的管

子的小的开端插入管壁并使它与大的开端相连而形成的。克莱因瓶主要参数是球体和导管的

半径，也就是上面程序代码中的变量a和c的数值。

step 2



将以上程序代码保存为文件“klein.m”，然后返回到MATLAB的命
令窗口中，输入“klein”，得到的结果如下：

step 3
查看图形结果。输入以上参数数值后，按“Enter”键，得到的图形

如图14.13所示。

图14.13 绘制得到的克莱因瓶

step 4
修改两个半径参数的数值，重新绘制克莱因瓶，得到的结果如

下：

step 5
查看图形结果。输入以上参数数值后，按“Enter”键，得到的图形

如图14.14所示。



图14.14 修改曲面参数绘制图形

说明

在以上程序代码中，分别使用高层和底层命令来设置图形的各种属性，可以看出，并不

复杂的程序可以绘制出比较复杂的图形。

 
例14.7 在MATLAB中绘制三维的地球图形。

step 1
单击命令窗口工具栏中的 按钮，打开一个空白的M文件编辑

器，然后在M文件编辑器中输入以下代码：



step 2
将以上程序代码保存为文件 “three_globe.m”，然后返回到

MATLAB的命令窗口中，输入“three globe”，得到的结果如图14.15所
示。

图14.15 程序绘制得到的图形



在以上程序代码中，通过代码“load topo”，加载topo.mat文件中的
数据程序， topo是MATLAB的自带数据文件，默认的保存路径
为…..\MATLAB7.0\toolbox\matlab\general。

说明

在以上程序代码中，首先定义结构体props，然后在绘图命令surface中引用该结构体，通

过这种方法来设置图形对象的属性。

14.3.3 查询图形对象的属性——get命令

在MATLAB中，可以使用get函数来查询图形对象的属性值。其常
见的调用格式如下：

 
◆ get(h) 获取h句柄对象所有属性的当前值。
◆ get(h,'PropertyName') 获取h句柄对象由PropertyName所指

定属性的当前值。

 
和前面介绍的set函数类似，get函数可以获取各种层次的对象属性

值。

例14.8 创建简单的图形对象，然后使用get函数获取各种对象的
属性。

step 1
创建简单的图形对象。在MATLAB的命令窗口中输入以下代码：

说明



运行简单的程序代码创建了4个图形对象，由于这些对象都没有使用参数，MATLAB会采

用各个对象的默认属性来绘制对象。同时，在创建这些对象之前，并没有创建图形窗口或者

坐标轴对象，MATLAB也会按照默认属性来创建这些对象。

step 2
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.16所示。

图14.16 创建的图形对象

step 3
查看该图形对象的所有属性值。在MATLAB的命令窗口中输

入“get(gca)”，得到用户绘制的图形对象的所有属性值，结果如下：



在以上属性数值列表中，许多属性选项都列出了具体的数值，例

如“CameraPosition =[1.5 1.5 9.16025]”，但是，也有一些属性列表只是
列出了数值的维度，例如“ColorOrder= [ (7 by 3) double array]”。因
此，如果需要了解对应属性的数值，则需要调用相应的格式，查看具

体数值。

step 4
查看该图形对象的“ColorOrder”属性值。在MATLAB的命令窗口

中输入“get(gca,'ColorOrder')”，得到如下的结果：



step 5
定义结构体，然后查询结构体中指代的图形对象属性。在

MATLAB的命令窗口中输入以下代码：

step 6
查看查询结果。在MATLAB的命令窗口中输入“output”，然后

按“Enter”键，查看属性查询结果，得到如下的结果：

14.3.4 查看图形对象的默认属性

在MATLAB中，如果需要了解图形对象的所有系统默认属性，可
以通过命令代码get(0,'factory')获得，结果如下：



从以上结果可以看出，系统默认的属性一般的标号为

FactoryPropertyName，后面显示的就是默认属性数值。
如果希望了解某种属性的具体数值，可以使用以下类似代码获

得：

说明

对于所有图形对象的属性，MATLAB系统都会有一个默认的系统属性值。

 
在MATLAB中，用户除了可以查询系统的默认属性数值，还可以

根据需要自定义各种图形对象的属性默认数值。在介绍如何设置对象

的默认属性值之前，将首先介绍MATLAB选用属性值的原理。
当用户在MATLAB中进行绘图或者需要了解对象属性值时，

MATLAB会从当前对象开始，在继承表中向上搜索，直到找到系统定
义或者用户自行设置的默认属性值，因此，用户定义的默认值越靠近



root对象，MATLAB搜索的范围也就越广。例如，如果在root级定义
line对象的默认值，MATLAB会对所有的line对象使用这个默认值；如
果在axes级中定义line对象的默认值，MATLAB会对该图形对象中的
line对象使用该默认值。

说明

如果在多级目录中定义了对象的默认值，那么与该对象最近的父对象级中定义的默认值

将被使用，因为该默认值是MATLAB中最先找到的默认值。

 
最后，还需要提醒读者的是，用户设置的默认值只对设置完成后

创建的对象有效，对于之前创建的图形对象无效。设置属性的默认值

使用的是set命令，只是在设定之前需要创建一个以Default开头，然后
跟着对象类型，最后是对象属性的字符串。例如，如果希望在当前的

图形窗口级设置line对象的LineWidth（线宽）默认属性数值为2.5点
宽，可以使用以下程序代码：

14.3.5 设置不同级别的属性

在MATLAB中，除了可以设置各种图像的属性，还可以设置属性
的不同级别。不同级别的属性，对句柄图像的适用范围也不同。下面

用具体的例子来说明如何设置不同级别的属性。

例14.9 对MATLAB设置图形对象中不同级别的默认属性，并查
看设置效果。

step 1
在MATLAB的命令窗口中输入以下代码：



step 2
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.17所示。

图14.17 得到的初始图形

step 3
重新设置图形标记图案的默认值。在MATLAB的命令窗口中输入

以下代码：

step 4
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.18所示。



图14.18 修改图形标记的默认值

step 5
打开新的图形窗口，然后绘制三维图形。在命令窗口中输入以下

代码：

step 6
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.19所示。



图14.19 重新绘制图形

从以上代码中可以看出，设置默认属性数值的级别会影响图形绘

制的结果。在第2步中，设置的默认图形标记属性的级别为当前图形窗
口（gcf），因此其默认属性值只适用在图形窗口Figure1中。因此，在
第3步中，用户绘制新的图形对象时，使用的是第1步中定义在根目录
中的默认属性值。

说明

从以上程序代码中可以看出，在不同级别中定义默认属性数值，其相应的使用范围和方

法都会有很大的区别，用户需要谨慎地设置不同级别的默认数值。

14.3.6 设置图形对象的默认属性

在MATLAB中，除了可以设置不同使用范围和级别的默认属性之
外，也可以根据需要删除用户设定的默认属性，例如，如果需要删除

设置的图形标记的默认属性，可以使用以下程序代码：



在输入以上代码后，查看系统中图形标记的默认属性，得到的结

果如下：

从以上程序代码中可以看出，在删除了用户设置的默认属性后，

MATLAB会返回系统设定的默认属性none，表明已经删除用户设定的
默认属性。除了可以删除用户设定的默认属性，用户也可以不使用用

户定义的默认属性，沿用以上例子，当用户在MATLAB的命令窗口中
输入以下程序代码：

按“Enter”键，得到的结果如图14.20所示。

图14.20 程序得到的结果

从以上程序代码可以看出，尽管用户设置了图形标记的默认图案

是“o”，但是在程序代码中将图形的标记设置为“factory”（系统默认）



的属性值，因此，得到的图形中图形标记还是默认的none，而不是用
户设置的“o”。
例14.10 设置当前坐标轴（gca）的默认属性，然后使用该默认

属性来绘制图形。

step 1
在MATLAB的命令窗口中输入以下代码：

step 2
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.21所示。

图14.21 绘制得到的图形

说明



在以上程序代码中，设置了默认图形颜色为橙色，同时设置每个图形中添加Y轴的网络

线，直线的线宽为2等属性。这些属性都是用户自行设置的，修改了系统默认的所有相关属

性。只要用户在此根目录下绘制图形，都将沿用该属性。

step 3
在新窗口中绘制图形。在MATLAB的命令窗口中输入以下代码：

step 4
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.22所示。

图14.22 绘制新的图形

说明



从以上程序代码可以看出，如果不删除设置的默认属性数值，在该root对象下绘制的所有

图形对象都将沿用该属性体系。

14.4 高层绘图命令

在详细介绍图形中的各个对象属性之前，首先介绍高层绘图命令

文件的组成情况，这样可以帮助读者更好地理解高层绘图命令。同时

还可以帮助读者理解底层绘图命令如何设置图形父对象的属性，下面

分别详细介绍。

14.4.1 设置父对象属性——NextPlot属性

当使用底层命令创建线、面、方、块等子对象时，就会涉及如何

在MATLAB系统中为这些对象准备图、轴的“父”对象的问题。在
MATLAB 中 ， 这 个 问 题 就 相 当 于 是 如 何 设 置 Axes 、 Figure
的“NextPlot”属性的问题。

Figure对象的“NextPlot”属性如下：
 
◆ Add：表示在当前设置下，允许添加子对象。其对应的高层

命令为hold on。
◆ Replacechildren：表示在当前设置下，清除所有子对象。对

应的高层命令为clf。
◆ Replace：表示清除所有子对象，并重设置为默认数值，对应

的高层命令为clf reset。
 
Axes对象的“NextPlot”属性：
 



◆ Add：表示在当前设置下，允许添加子对象。其对应的高层
命令为hold on。

◆ Replacechildren：表示在当前设置下，清除所有子对象。对
应的高层命令为cla。

◆ Replace：表示清除所有子对象，并重设置为默认数值，对应
的高层命令为cla reset。

说明

在MATLAB中， Figure的 “NextPlot”默认属性是 “Add”，Axes的 “NextPlot”默认属性

是“Replace”。另外，两个对象的重设命令“reset”不影响Position、Units的属性。

14.4.2 检查NextPlot属性——newplot命令

在MATLAB中，为了方便用户开发图形文件，专门设计了newplot
命令，该命令将自动执行对当前图、轴对象的“NextPlot”属性进行检
查，并完成相应的设置。具体功能如下：检查并设置当前图形窗

的“NextPlot”属性：
 
◆ 如果结果是ReplaceChildren，则清除图形中全部的子对象。
◆ 如果结果是Replace，则清除图形中全部的子对象，并将图的

对象属性设置为系统的默认数值。

◆ 如果结果是Add，则保留当前图形窗口中所有子对象和所有属
性不变。

 
检查并设置当前图形轴的“NextPlot”属性：
 
◆ 如果结果是ReplaceChildren，则清除图形轴中全部的子对象。



◆ 如果结果是Replace，则清除图形轴中全部的子对象，并将轴
的对象属性设置为系统的默认数值。

◆ 如果结果是Add，则保留当前图形轴中所有子对象和所有属性
不变。

14.4.3 高层绘图文件的构成

前面已经列出了MATLAB所有相关的底层绘图命令，而且已经向
读者介绍过，MATLAB的高层绘图函数都建立在底层绘图命令之上，
下面分析MATLAB的mesh.m文件，说明mesh命令是如何建立在surface
命令之上的。

例14.11 分析高层绘图命令mesh的文件构成。
在MATLAB的默认路径…\MATLAB7.0\toolbox\matlab\general中，

可以查看mesh.m文件的程序代码：



从以上程序代码中可以看到典型的高层绘图文件的构成：

 



◆ 调用命令newplot，检查并设置图和轴的NextPlot属性，然后
返回目标轴的句柄。

◆ 引用newplot返回的坐标轴句柄，或者修改坐标轴的属性，或
者访问坐标轴的属性。

◆ 调用图形对象创建命令，创建图形。

14.5 坐标轴对象

在图形对象的树形结构中，坐标轴对象（Axes）发挥着重要的作
用，其具体的属性有80多个，本节将介绍坐标轴对象中一些常见和重
要的属性。了解这些内容将会有助于更好地设置图形对象的属性。

14.5.1 坐标轴的几何属性

与前面介绍的图形对象类似，轴位框的几何属性主要由Position、
Units来指定。在MATLAB中，轴位框（Axes Position Rectangle）的含
义不同于坐标框，对于二维图形，两者指定的是同一个面积，对于三

维图形，轴位框指定的是图形所占用的最大平面面积，而不是三维坐

标轴。由于屏幕上没有显示轴位框线，因此这个概念初学者经常会混

淆。

在MATLAB中，关于坐标轴的 “单位 ”（Units）的默认属性
为“normalized”，可以使用get函数得到，相应的代码如下：

该属性的含义是轴对象使用“归一化”单位，在这种单位下，图形
对象窗口的几何属性值总是[0，0，1，1]，其他对象的单位则使用相
对单位。



说明

采用归一化单位的结果就是表明坐标轴和图形窗口的相对大小，当用户对图形窗进行缩

放时，坐标轴也会随之缩放，保持相对大小不变。如果采用其他单位设置，则不能保持这种

特性。

 
在MATLAB的高层命令中，可以使用subplot在同一个图形窗中创

建多个坐标轴对象，而且还可以产生任意大小的轴位框。但是各个轴

位框不能重叠，这个重叠问题必须使用底层命令来解决，涉及到的坐

标轴属性就是Position和Units，下面举例详细介绍。
例14.12 在MATLAB中，在同一个图形窗口中绘制三个函数的图

形。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



step 2
单击M文件编辑器中的 “保存 ”按钮，将以上程序代码保存

为“plotyyy”，然后返回到MATLAB的命令窗口中输入以下代码：



step 3
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.23所示。

图14.23 程序所绘制的图形

step 4
重新绘制图形。在MATLAB的命令窗口中输入以下代码：

step 5



查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图
14.24所示。

图14.24 最终得到的图形

说明

在以上程序代码中，使用变量pos来设置三个函数图形所在的轴位框，由于第三个函数的

轴位框采用了offset变量，因此第三个函数所在的坐标轴向右偏移。

14.5.2 坐标轴的刻度属性

在MATLAB中，没有现成的高层命令来设置图形的坐标轴刻度，
如果希望设置图形坐标轴的刻度，则需要调用相应的底层命令：

 
◆ set(gca,'Xtick',xs,'Ytick',ys) 设置二维坐标刻度。
◆ set(gca,'Xtick',xs,'Ytick',ys,'Ztick',zs) 设置三维坐标刻度。

说明



在以上命令中，xs、ys和zs可以是任何合法的实数向量，它们分别设置x、y和z轴的刻

度。

 
在MATLAB中，除了可以设置坐标轴的刻度属性之外，还可以设

置坐标轴的刻度模式，可以选择auto、manual两种刻度模式，由于比
较简单，这里就不展开解释了，感兴趣的读者请查阅相应的帮助文

件。

例14.13 在MATLAB中，绘制图形并自行设置坐标轴刻度的属
性。

step 1
在MATLAB的命令窗口中输入以下程序代码：

step 2
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.25所示。



图14.25 设置坐标轴刻度的属性

说明

在MATLAB中，坐标轴刻度位置的属性必须是一维数值数组，可以是等分数组，也可以

不是等分数组。而且，坐标轴刻度属性的元素数目必须和刻度位置数组的元素相等。当用户

对坐标轴设置属性值时，就不需要设置取值模式，MATLAB会自动决定取值模式。

14.5.3 坐标轴的照相机属性

在MATLAB中，可以设置坐标轴的照相机属性，这些属性都是以
坐标轴的属性为基础的，坐标轴的属性可以控制照相机的位置和角

度。一般来讲，可以使用相应的命令来直接访问坐标轴的照相机属

性，表14.2列出了其属性的设置和含义。

表14.2 照相机属性列表



照相机的各个属性的物理含义如图14.26所示。

图14.26 照相机属性的物理意义

在MATLAB中，照相机的CameraTarget属性在默认情况下的自动
取值为坐标框的中心；CameraViewAngle在自动取值情况下取最小
角，使场景张满整个轴位框；同时，照相机的Projection属性值为正视
投影。



例14.14 在MATLAB中，使用相应的程序代码进行数据可视化，
并且选用合适的照相机属性。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器，

输入以下程序代码：

step 2
将程序代码保存为“volize.m”，然后返回到MATLAB的命令窗口，

输入“volize”，然后按“Enter”键，得到的图形如图14.27所示。



图14.27 程序运行的结果

在以上代码中，首先加载MATLAB自带的数据文件wind，该数据
文件的默认保存路径为….\MATLAB7.0\toolbox\matlab\general。在程序
代码中，首先使用isosurface命令从wind文件选取数据，然后使用patch
创建“块”对象p。在后续的程序代码中，使用set函数设置图形对象的各
种属性。在程序的最后部分，使用各种照相机命令来设置图形的相机

属性。

提示

在第一行程序代码中，首先使用colordef命令设置了图形的颜色，关于该命令的主要信息

可以查看相应的帮助文件。

14.6 综合实例

前面已经分别介绍了句柄图形的各部分内容，但是，如果需要绘

制个性化和精美的图形，通常需要设置各种图形对象的属性。因此，

在此将介绍如何综合使用这些相关的命令来绘制复杂的图形。



14.6.1 穿越图形

穿越（fly-through）图形是一种特殊的图形效果，主要通过在三
维空间中不断连续变换图形对象的照相机（camera）属性来实现。最
后得到的效果就像是用户自身在三维空间穿越一样，就像在太空飞船

中穿越。之所以被称为穿越，是因为在该图形中可以查看到普通视角

中无法查看到的内部区域。

为了达到上面所描述的“特殊”图形效果，用户需要编写程序代
码，将图形的照相机（camera）属性沿着某个特殊的路径移动，例如
将图形的camera属性沿着x坐标轴移动。而且，为了达到穿越效果，需
要 同 时 修 改 图 形 对 象 的 位 置 （ CameraPosition ） 和 目 标
（CameraTarget）属性。
在本综合实例中，通过加载MATLAB自带的wind数据文件，绘制

出由风速矢量场所定义的三维图形空间的内部等势表面。可以穿越整

个三维空间，查看其内部表面区域。由系统自带的wind数据文件描述
了北美空间的空气势能。由于该实例比较复杂，下面需要分步骤详细

介绍整个动态图形的创建过程。

例14.15 在MATLAB中，绘制wind数据文件的穿越图形。

step 1
绘制等势表面。在MATLAB的命令窗口中输入以下程序代码：

step 2



查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图
14.28所示。

图14.28 绘制的风速等势表面

step 3
绘制穿越等势表面的圆锥流体。继续在MATLAB的命令窗口中输

入代码：

step 4
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.29所示。



图14.29 绘制圆锥流体

step 5
定义视角参数。前面已经创建了基础的平面图形，在创建三维图

形之前，需要首先定义视角参数。在MATLAB的命令窗口中输入以下
代码：

step 6
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.30所示。

图14.30 设置视角参数



step 7
指定图形光源。在MATLAB的命令窗口中输入以下代码：

step 8
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.31所示。

图14.31 设置图形的光源属性

注意

在以上程序代码中，首先设置了该图形的投影方式是透视，然后设置视角为25度，之所

以设置的角度为25度，是为了在后面的步骤中方便查看空间的内部表面。

 
在以上程序代码中，首先在照相机所在的位置创建一个光源，然

后将前面步骤创建的“块”对象中的环境光的光度（AmbientStrength）
设置为0.1，由于该数值十分接近0，表明环境光近乎为黑色；然后
将 “块 ”对象的镜面反射强度（ SpecularStrength）和漫反射强度
（DiffuseStrength）都设置为1，因此，“块”对象的反射强度很大。接



着将锥形流体的镜面反射强度（SpecularStrength）也设置为1。在程序
的最后，将图形窗的颜色设置为黑色。

step 9
选择图形光源的着色（Render）属性。在MATLAB的命令窗口中

输入以下代码：

提示

之所以需要在这个步骤中设置光源的着色属性，是因为前面步骤中在图形对象中设置了

光源。MATLAB提供了两种着色属性的设置：zbuffer和OpenGL。在本实例中，选择的是

zbuffer。关于这些着色属性的详细内容，感兴趣的读者可以查阅MATLAB中相应的帮助文

件。

step 10
定义照明路线。在MATLAB的命令窗口中输入以下代码：

在以上程序代码中，首先创建了一个从点（80，30，11）的流线
型照明路线，然后通过get函数获取该流线型直线对象的x轴、y轴和z
轴的数据，分别保存在数组xd、yd和zd中。最后，将该流线型直线对
象删除。

step 11
演示穿越效果。在MATLAB的命令窗口中输入以下代码：



step 12
查看图形结果。输入以上代码后，按“Enter”键，就可以实现最后

的穿越效果。由于是动态效果，很难在纸质条件下显示出来，下面分

别选取动态效果中的三幅图形，使读者感受到动态效果，图形依次如

图14.32、图14.33和图14.34所示。

图14.32 动态图形一



图14.33 动态图形二

图14.34 动态图形三

在以上程序代码中，为了演示出穿越效果，沿着相同的路径移动

照明的位置（position）和目标（target）属性。在本实例中，照明的目
标属性比x轴远5个元素值，之所以设置这个比较小的元素值，是为了
避免在后面的步骤中照明的位置和目标属性重合。



具体来讲，在程序代码中沿着前面步骤中设置的流线型照明路

线，同时更新数据点的照明位置和目标属性，然后沿着该照明路线移

动光源，最后，调用drawnow命令来绘制移动后的图形。本实例属于
MATLAB实时动画，这种图形保持图形窗中绝大部分的像素颜色不
变，而只更新部分像素的颜色来构成运动图像。

说明

在MATLAB中，drawnow命令的功能是进行屏幕刷新。为了显示实时动画，当新对象属

性设置完成后，应该刷新屏幕，使新对象显示出来。drawnow命令使得MATLAB暂停目前的

任务序列而去刷新屏幕，如果没有drawnow命令，MATLAB需要等所有的任务序列执行完成

后才会去刷新屏幕。

14.6.2 动态反射图形

前面已经介绍了设置图形对象的照相机属性来实现特殊的穿越效

果，在MATLAB中，还可以通过其他方法来创建动态图形。在本小节
中，将使用另外的方法来创建动态图形。

在MATLAB中，常见的动画有两种：影片动画和实时动画。其中
影片动画的基本原理如下：首先预先创建图形，将图形存放在缓冲

区，然后按照设置的条件逐帧播放。这种动画比较适合于播放比较复

杂的画面，但是计算方法计算量大，占用内存多，而且播放时间短。

在本小节中，将介绍的实例属于另外一种动态图形：实时动画。

这种动画比较适合于每次变化较少、图形精度不高的情况。在介绍动

态图形创建过程之前，首先介绍一个比较重要的属性：EraseMode。
在MATLAB中，实现实时动画的基本原理是：显示新对象、擦除

旧对象，同时不破坏背景图片。以上效果使用其他编程语言比较难实

现，但是在MATLAB中可以使用系统的EraseMode属性来十分便捷地



实现。MATLAB提供了下面4种常见的EraseMode属性，其对应的含义
如下：

 
◆ {normal}：计算整个图形画面的数据，重新绘制整个图形。

相对于其他的属性，选用该属性绘制的图形最准确，也最慢。

◆ none：对图形中所有的对象不做任何的擦除。该绘制模式下
绘制的图形不能被正确打印。

◆ xor：异或方式，对象的绘制和擦除应该由对象颜色和屏幕颜
色来决定，只画与屏幕颜色不同的对象数据点，只擦除与屏幕颜色不

一致的数据点。

◆ background：将旧对象的颜色变成背景颜色，实现擦除。
 
可以根据需要选用合适的擦除模式，同时根据不同的擦除模式选

择合适的着色模式，这样就可以创建自己所需的动画效果。

在实现该实例之前，简要介绍创建动画效果的大致步骤：

 

step 1
绘制初始图形。

step 2
计算出活动对象的新位置，并在新位置中显示该对象。

step 3
擦除原位置中原有对象，刷新屏幕。

step 4



重复以上两个步骤。

 
由于该实例比较复杂，下面分步骤详细介绍整个动态图形的创建

过程。

例14.16 在MATLAB中，绘制动态光线的反射图形。
为了让读者事先能够了解反射图形的动态性，在介绍创建步骤之

前，首先将动态图形的初始图形和过程图形显示给读者。其中，该动

态的初始图形如图14.35所示。该图形将会持续20秒的时间，其中当t＝
7的时候，图形如图14.36所示。

图14.35 初始图形



图14.36 程序的过程图形

在程序的最后还将需要显示该轨迹点的变化图形，如图14.37所
示。

图14.37 反射点的轨迹

下面将分步骤详细介绍以上动态效果的创建过程。



step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

step 2
查看图形结果。输入以上代码后，选择M文件编辑器中

的“Debug”→“Run”命令，按“F5”键，查看该部分代码的运行结果，如
图14.38所示。

图14.38 部分程序结果

在本实例中，顶板Ceiling是用来接收反射光的工具，因此其长度
范围必须满足所有反射光的射程。在以上程序代码中，使用的是fill命



令来创建该顶板对象。在MATLAB中，fill（和fill3）命令的功能是绘
制任意多边形。用户必须保证绘图数据首尾重合，使勾画的多边形封

闭。

说明

之所以在以上步骤中，显示部分程序代码的结果，是因为该程序代码比较复杂，为了让

读者了解各部分程序的功能，笔者将一边编写代码一边调试代码，得到部分结果。

step 3
返回到M文件编辑器中，然后继续输入以下程序代码：

step 4
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.39所示。

图14.39 添加半圆光源



说明

在以上程序代码中，首先定义了数组Zz，该数组中的数值表示的是光源半圆的数据点坐

标值，使用的是复数极坐标方法，然后在程序代码中使用fill绘制填充半圆图形，最后使用set

函数设置半圆图形的边缘颜色为红色，得到一个红色的半圆光源。

step 5
返回到M文件编辑器中，然后在以上代码后面输入以下程序代

码：

step 6
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.40所示。上面这段程序代码的原理和前段类似，只是具体的坐标数
值和颜色属性不同。

图14.40 添加反射半镜的对象



step 7
返回到M文件编辑器中，继续输入以下程序代码：

step 8
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.41所示。

图14.41 添加球心对象

在以上程序中，变量p1表示的是光源发射点，其坐标数值为
（9,7），p2变量是发射光线的延长线和横坐标的交点坐标。

step 9
返回到M文件编辑器中，继续输入以下程序代码：



step 10
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.42所示。

图14.42 添加发射光线对象

在以上程序代码中，首先将反射半圆数据数组（Zx）中的数据和
光源发射点p1的坐标相减，得到一个新的复数，使用angle函数来求解
该复数的相角；然后将反射半圆数据数组（Zx）中的数据和坐标轴数
据点p3的坐标相减，得到一个新的复数，使用angle函数来求解该复数
的相角。最后，计算两个相角的差值。

上面步骤计算得到的差值是一个数组，使用min函数求解该相角
差值的最小值和数组的序号kk。然后选择反射半圆数据数组（Zx）中
对应序号kk中的数值p2。在上面程序的



最后，绘制发射光线和发射光线的延长线。

step 11
返回到M文件编辑器中，继续输入以下程序代码：

step 12
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.43所示。

图14.43 绘制反射光线对象

在以上程序代码中，首先计算相角Af和复数长度L，然后以变量
p2为基础来计算反射光线在光板中的数据的坐标数值，最后使用plot
绘制反射光线。

step 13



返回到M文件编辑器中，继续输入以下程序代码：

step 14
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.44所示。

图14.44 添加弹簧对象

在以上程序代码中，xt代表的是弹簧对象的横坐标数组，yt代表
的是弹簧对象的纵坐标数组，为了实现弹簧的折线效果，引入了中间

变量Kt。其具体的算法请读者自己演示和分析，mod函数的用法请查
阅数值计算的章节。

step 15



返回到M文件编辑器中，继续输入以下程序代码：

step 16
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.45所示。

图14.45 添加图形的标题和说明

在以上程序代码中，首先使用title命令创建图形的标题对象，然
后使用text命令创建图形的时间说明文字。其中时间说明文字中使用了
特殊数学符号∈，在MATLAB中，该数学符号属于图形标识中的特殊
字符。该具体字符是MATLAB从Tex字符集中摘引了包括希腊字母在
内的140多个特殊字符。

说明



到本步为止，已经创建了该动态图形的初始图形界面，也就是当系统时间t=0时刻的图形

界面。各种图形对象已经绘制完成，同时显示了相应的说明文字，从本步开始，将需要创建

其他时刻的动态图形界面。

step 17
返回到M文件编辑器中，继续输入以下程序代码：

step 18
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.46和图14.47所示。



图14.46 t＝2.48时的图形界面

图14.47 t＝11.24时的图形界面

从以上程序结果中可以看出，当MATLAB开始运行循环程序时，
图形标题将会显示对应的运行时刻，而弹簧对象将开始上下振动，发

射光将会透射到反射透镜表面不同的位置，因此产生不同的反射光



线。程序将一直循环运行下去，直到时间变量t达到用户指定的20秒，
最后的结果在前面的章节中已经给出，这里不再重复。

说明

如果读者细心阅读上面while循环体内的程序代码，就会发现该代码和前面步骤中创建初

始图形界面的代码十分相似，只是添加了控制变量t。因此，在这里就不介绍其代码含义了，

请读者自行分析。

step 19
返回到M文件编辑器中，继续输入以下程序代码：

step 20
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

14.48所示。



图14.48 反射点轨迹图形

step 21
保存上面步骤的代码。前面已经完成了动态图形的创建工作，可

以将其保存为M文件。在本例中将其保存为“reflash.m”文件。

说明

保存了创建动态图形的代码后，在后面的步骤中运行该动态图形时，就可以直接在命令

窗口中输入“reflash”，查看动态图形。

14.7 小结

本章中介绍了句柄图形的内容，主要内容包括句柄图形体系、图

形句柄的操作、图形对象的操作、高层绘图命令和坐标轴对象等，这

些内容可以认为是“数据和函数的可视化”的后续内容，两章内容结合
起来可以对MATLAB中的图形设计有一个全面的概括。在后面的章节
中，将介绍图形用户界面的内容。



◆   ◆   ◆



第15章 图形用户界面基础

本章包括

◆使用GUIDE创建GUI

◆使用M文件创建GUI

◆创建自定义菜单

◆添加GUI的图形控件

 
有过编程经历的读者也许都会有类似的经验，一个可以发布的应

用程序通常都需要有一个友好的图形用户界面（Graphical User
Interface）。程序的用户界面是用户与计算机程序的交互方式，用户
通过键盘、鼠标等输入设备与计算机交换信息。图形用户界面（简称

GUI）是包含图形对象，如：窗口、图标、菜单和文本的用户界面。
用户以某种方式选择或激活这些对象，会引起动作或发生变化，例如

调用计算程序或者绘图等。

对于第一次接触GUI概念的读者，前面的文字介绍也许比较陌
生，但是其实大多数人已经接触过一些MATLAB定制的GUI对象，例
如，演示程序demo就是典型的图形用户界面。在命令窗口中输入demo
调用相应的演示程序，然后在图形界面中使用鼠标进行选择和点击，

查看相应的演示程序结果。

15.1 图形用户界面概述

一般情况下，开发实际的应用程序时应该尽量保证程序的界面友

好，因为程序界面是应用程序和用户进行交互的环境，在当前情况



下，使用图形用户界面是最常用的方法。提供图形用户界面可以使用

户更方便地使用应用程序，用户不需要了解应用程序怎样执行各种命

令，只需了解图形界面组件的使用方法；同时，用户不需要了解各种

命令是如何执行的，只要通过用户界面进行交互操作就可以正确执行

程序。

在MATLAB 7.0中，图形用户界面通常是一种包含了多种图形对
象的界面，典型的图形界面包括图形显示区域，功能按钮控件以及用

户自定义的功能菜单等。为了能够让界面实现各种功能，需要对各个

图形对象进行布局和事件编程，这样，当激活对应的GUI对象时，就
能执行相应的事件行为。最后，必须保存和发布自己创建的GUI，才
能应用GUI对象。

说明

在创建图形用户界面的时候，需要遵循不同的设计要求，因此创建出的图形界面也会千

差万别。但是，这并不意味着创建图形界面没有统一的标准，在设计图形界面时，除了保证

程序功能之外，还需要遵循一些统一的标准，这些标准将在后面详细介绍。

 
在介绍使用MATLAB进行M文件编程的时候曾经介绍过，在

MATLAB中，所有对象都可以使用M文件进行编写。GUI也是一种
MATLAB对象，因此，可以使用M文件来创建GUI。同时，使用M文
件创建GUI的方法也是最基础的，用户使用其他方法创建GUI图形界
面时，实现图形控件的各种功能时，也需要编写相应的程序代码。最

后，了解创建GUI对象的M程序代码，也可以帮助用户理解GUI的各种
组件和图形对象控件的常用属性等内容。

除了使用M文件创建GUI对象之外，MATLAB还为用户开发图形
界面提供了一个方便高效的集成开发环境：MATLAB图形用户界面开
发 环 境 （ MATLAB Graphical User Interface Development



Environment），简称为GUIDE。其主要是一个界面设计工具集，
MATLAB 7.0将所有GUI所支持的用户控件都集成起来，同时提供界面
外观、属性和行为响应方法的设置方法。除了可以使用GUIDE创建
GUI之外，还可以将设计好的GUI界面保存为一个FIG资源文件，同时
自动生成对应的M文件，该M文件包含了GUI初始化代码和组建界面
布局的控制代码。

使用GUIDE创建GUI对象执行效率高，可以交互式地进行组件布
局，还能生成保存和发布GUI的对应文件，下面详细介绍这两种文件
的内容和格式：

 
◆ FIG文件：该文件包含了GUI图形窗口以及其子对象的完全描

述，包含了所有相关对象的属性信息。可以调用hgsave命令或者使用
M文件编辑器的“File”→“Save”命令生成该文件。FIG文件是一个二进
制文件，包含了系列化的图形窗口对象。所有对象的属性都是用户创

建图形窗口时保存的属性。该文件最主要的功能是对象句柄的保存。

◆ M文件：该文件包含GUI设计、控制函数以及控件的回调函
数，主要用来控制GUI展开时的各种特征。该文件基本上可以分为
GUI初始化和回调函数两个部分，控件的回调函数根据用户与GUI的
具体交互行为分别调用。应用程序M文件使用openfig命令来显示GUI
对象。但是该文件不包含用户界面设计的代码，对应代码由FIG文件
保存。

说明

关于使用GUIDE创建GUI对象的具体步骤和对应的注意事项，将在后面的章节中利用具

体的实例详细介绍，这里就不展开介绍了。

15.2 使用M文件创建GUI对象



在介绍GUI对象的详细内容之前，为了让读者了解创建GUI对象
的两种基本方法，在本节中将使用两个简单的实例来说明各种方法的

特点。

15.2.1 编写程序代码

现在介绍如何使用M文件创建一个简单的GUI对象，该GUI对象中
不包含GUI菜单和控件，其和用户之间的互动通过键盘的按键和鼠标
操作来实现。对于这种类型的GUI对象，最好使用M文件来直接编写
而不适合使用GUIDE来创建。由于该实例比较复杂，下面详细介绍创
建该GUI对象的步骤。
例15.1 在MATLAB中，创建一个三维齿轮GUI对象。在该GUI界

面中，可以使用鼠标来控制齿轮运动的方向，使用方向键来控制查看

该三维对象的角度。

step 1
单击命令窗口工具栏中的 按钮，或者选择编辑栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，然
后在M文件编辑器中输入以下代码：







在以上程序代码中，首先定义了默认参数数值，然后设置程序代

码处理用户调用函数的参数处理工作，分别定义各种图形对象的绘制

数据，为后面步骤中创建图形对象打好了基础。

提示

上面程序代码中使用了多种编写代码结构和功能，如果对这些代码有疑问，请查看本书

中关于M文件编程的内容。



step 2
返回到M文件编辑器，然后输入以下代码：



step 3
查看程序代码的图形结果。以上程序代码的功能是绘制GUI对象

的初始图形，选择M文件编辑器中的“Debug”→“Run”命令，检测前面
程序的结果，如图15.1所示。

图15.1 GUI的初始图形结果

说明

从以上结果可以看出，创建GUI的初始图形结果使用的方法和程序代码与前面创建句柄

图形一样，可以参考对应章节的内容。

step 4
返回到M文件编辑器，然后输入以下代码：





15.2.2 运行程序代码



前面已经完成了程序代码的编写工作，下面详细讲解如何运行和

查看程序代码。

step 1
查看程序代码的结果。在以上程序代码中，设置了控制图形对象

的所有代码，选择M文件编辑器中的“Debug”→“Run”命令，检测前面
程序的结果，如图15.2所示。

图15.2 使用鼠标控制齿轮的运动

说明

从以上程序代码中可以看出，在初始情况下，齿轮处在整个底面对象的中部，当用户添

加了相应的行为程序代码后，使用鼠标就可以控制齿轮的运动情况。将齿轮在整个半圆底面

中滚动，实现互动的动态图形。

step 2



使用方向键来控制图形。除了可以用鼠标实现互动之外，还可以

用方向键控制查看图形的视角，如图15.3所示。

图15.3 使用方向键控制视角

说明

从以上结果可以看出，编写了对应的事件函数后，在相应的程序代码中添加回调参数，

就可以实现用户和界面的动态交互，这是使用M文件创建GUI对象的核心内容。

step 3
将以上代码保存为 “gear3d.m”文件，然后在命令窗口中输

入“GEAR3D('teeth', 60,'spokes', 6,'ratio', 4)”命令，按“Enter”键，得到的
图形如图15.4所示。



图15.4 使用自定义参数绘图

在以上命令行中，除了调用前面定义的gear3d函数之外，还设置
了用户自己设置的图形参数数值，然后根据对应的参数绘制图形。

15.3 使用GUIDE创建GUI对象

MATLAB中GUIDE给用户提供了多种设计模板，用户可以很轻松
地定制属于自己的GUI对象，同时自动生成对应的M文件框架，这样
就简化了GUI应用程序的创建工作。可以直接使用该框架来编写自己
的函数代码，因为GUIDE模板中包含了相关的回调函数，可以打开对
应的M文件，查看工作方式或者修改函数，实现用户自己所需的功
能。本节将使用一个简单实例来介绍如何使用GUIDE创建GUI对象。

15.3.1 启动GUIDE



下面将使用GUIDE来定制GUI对象的界面，然后使用M文件编写
对应的事件程序，完成整个GUI的创建工作，该GUI的最终结果如图
15.5所示。

图15.5 完成的GUI对象

在上面的GUI对象中，用户创建了一个简单的GUI对象，同时添
加了简单的控件对象。

下面分步骤来介绍如何创建该GUI对象。
例15.2 在MATLAB中，创建GUI对象。

step 1
启动GUIDE。单击MATLAB工作界面工具栏中的“GUIDE”图标，

启动MATLAB中的GUIDE，如图15.6所示。



图15.6 启动GUIDE

step 2
查看GUIDE。当选择对应的菜单后，即可打开“GUIDE Quick

Start”对话框，如图15.7所示。

图15.7 GUI模板设置界面

在上面的模板设计界面中，可以选择创建新的GUI对象或者打开
原来的GUI对象。在创建新的GUI对象中，MATLAB 7.0为用户提供了



空白模板（Black GUI）、带有控件的模板（GUI with Uicontrols）、
带有坐标轴和菜单的模板（GUI with Axes and Menu）和问答式对话框
（Modal Questions Dialog）四种模板。其中空白模板是MATLAB中的
默认模板，在本实例中将选用该模板创建GUI对象。

说明

除了可以使用菜单来打开GUIDE之外，还可以在命令窗口中输入GUIDE命令来启动

GUIDE。如果GUIDE已经启动，可以选择菜单栏中的“File”→“New”选项，打开新的GUIDE。

step 3
打开空白模板。在 “GUIDE Quick Start”对话框中选择 “Blank

GUI（Default）”选项，然后单击“OK”按钮，MATLAB会显示GUIDE
初始化对话框，如图15.8所示。当MATLAB完成GUIDE初始化之后，
就会显示GUI的空白模板，如图15.9所示。

图15.8 初始化对话框



图15.9 空白模板的编辑界面

step 4
设 置 模 板 的 显 示 属 性 。 选 择 空 白 模 板 菜 单 栏 中

的“File”→“Preferences”选项，打开“Preferences”对话框，然后在其中
选择“GUI”选项，选中“Show names in component palette”复选框，显示
控件面板中各个控件的名称，如图15.10所示。



图15.10 设置模板的显示属性

step 5
查看修改后的模块。单击“OK”按钮，就可以得到修改后的模板，

如图15.11所示。



图15.11 修改后的空白模板

说明

之所以需要显示控件面板中各个控件的名称，是因为这是用户首次接触到MATLAB的

GUI设计过程，显示控件名称可以有助于熟悉相应的控件。

15.3.2 添加“编辑框”控件

现在已经添加了空白的GUI界面，下面将需要在GUI界面上添
加“编辑框”控件，具体操作过程如下。

step 1
添加“编辑框（Edit Text）”控件对象。选择控件面板中的“Edit

Text”对象，然后将其添加到前面添加的“Panel”对象中，如图15.12所
示。



图15.12 添加编辑框控件

说明

在MATLAB中，编辑框控件的功能是控制用户编辑或者修改字符串的文本区域，该对象

的String属性包含了用户输入的文本信息。在Windows操作系统中，单击图形窗口中不会引发

编辑框的回调函数的执行。

step 2
设置控件的属性。选择 “编辑框 ”控件，然后单击 “Property

Inspector”按钮，打开“Property Inspector”对话框，选择“String”选项，
将其设置为“Hello,MATLAB!”，得到的结果如图15.13所示。



图15.13 设置左侧编辑框控件的属性

说明

对于左侧另外两个“编辑框”控件的属性，可以使用相同的方法进行设置。

15.3.3 查看程序代码

本小节的内容是整个开发的核心内容，前面章节的步骤只是完成

了界面的搭建。由于本例比较简单，该GUI对象不实现任何功能，因
此不需要为该GUI编写任何代码。但是，通过前面的步骤，MATLAB
已经生成了对应的代码。单击工具栏中的“M-file Editor”按钮，如图
15.14所示。查看默认生成的代码，如图15.15所示。



图15.14 选择查看程序代码

图15.15 默认的程序代码

提示

当第一次查看程序代码时，MATLAB会提示用户保存GUI对象。可以设定GUI的名称。在

本例中，该名称为“model”，保存在默认工作路径中。



15.3.4 运行GUI对象

前面小节已经依次完成GUI的设计工作，包括界面、控件、属性
设置等。在本小节中，将运行整个GUI对象，查看该GUI对象设计是
否成功。在MATLAB的命令窗口中输入“model”，然后按“Enter”键，
如图15.16所示。

图15.16 完成的GUI对象

15.3.5 创建GUI的注意事项

前面已经分步骤详细介绍了如何创建一个简单的GUI对象，在本
小节中，将介绍使用GUIDE来创建GUI的一些主要注意事项。
在MATLAB的GUIDE中，为用户提供了查看各种对象的对象浏览

器对话框。选择GUIDE菜单栏中的“View”→“Object Browser”命令，打
开“Object Browser”对话框，如图15.17所示。



图15.17 对象浏览器

在对象浏览器中，可以查看各个图形对象的名称和继承关系，当

GUI对象中包含多个控件时，在该对象浏览器中可以很方便地实现对
象管理。

说明

由于在本实例中，对象关系比较简单，因此在图15.17的对话框中没有出现层次展开按

钮，可以选用其他比较复杂的GUI对象，来查看对应的对象浏览器。

 
最后，将介绍设定GUI组态的对话框工具。选择GUIDE菜单栏中

的“Tools”→“GUI Option”命令，打开“GUI Options”对话框，在该对话
框中可以设置GUI初始状态的属性，如图15.18所示。



图15.18 GUI应用程序的选项对话框

在创建GUI对象的时候，“GUI Options”对话框中的各个属性都是
十分重要的，为了帮助读者更好地理解GUI的各种属性，下面详细介
绍对话框各个选项的具体含义。

 
1.重画行为（Resize behavior）
该选项的各个属性值表示MATLAB如何处理重画性质，MATLAB

提供了三个选项：

 
◆  Non-resizable：用户不能自行修改窗口的大小，这是

MATLAB的默认选项。
◆ Proportional：该选项允许MATLAB按照新的图形窗口尺寸来

重新绘制GUI控件，但是在重画过程中将不会改变标签中字体的大
小。对于设置过程始终不关闭的简单GUI工具和对话框来讲，该选项
是最佳的选择。

◆ User-specified：通过编程使重画过程中GUI按照用户指定的
方式进行改变，选用该选项后，需要用户编写ResizeFcn属性定义的回



调函数，该函数将根据新的图形窗口尺寸重新计算控件的大小和位

置。

 
2.命令行访问（Command-Line Accessibility）
当在MATLAB中创建图形对象时，各个图形对象的句柄可以通过

各种函数来访问。当用户创建GUI对象时，也需要创建一个图形窗
口，当在图形窗口中包含了坐标轴等对象时，需要编写命令行来访问

该图形窗口。在MATLAB中，可以为GUI设置三种命令访问权限：
 
◆ off：禁止命令对GUI图形窗口的访问。在这种情况下，GUI图

形窗口的图形句柄是隐藏的。为此，应用程序M文件将创建一个对象
句柄结构体来保存GUI中的所有用户控件句柄并将该结构传递给子函
数，保证GUI中句柄的准确使用。

◆ on：允许命令行对GUI图形窗口进行访问。
◆ User-specified：可以设置Handle Visibility和IntergerHandle两

个图形窗口属性值，来决定命令行是否能够访问图形窗口的句柄。

Handle Visibility属性决定图形窗口的句柄对访问当前图形窗口的命令
行是否可见，如果该属性值为off，则图形窗口的句柄从根对象的子对
象列表中删除，因此该图形窗口将不是当前图形窗口，但是该图形窗

口的句柄依然有效。IntergerHandle属性决定图形窗口的句柄是一个整
数还是浮点数。如果该属性值为off，MATLAB将使用浮点数来代替整
数。

 
3.生成FIG文件和M文件（Generate FIG-file and M-file）
如果希望通过使用GUIDE创建GUI对象的时候，同时生成FIG文件

和应用程序M文件，则可以选中“Generate FIG-file and M-file”单选按



钮。选中该单选按钮后，可以对其设置相应的属性选项，下面详细介

绍。

 
◆  生 成 回 调 函 数 原 型 （ Generate Callback Function

Prototypes）：当用户选中该复选框后，GUIDE将会在应用程序M文
件中为每一个控件添加一个回调函数（需要注意的是，组合框和静态

文本控件不包含Callback属性）。可以自行添加回调函数的程序代
码。

◆ 同一时间只允许运行一个应用程序实例（GUI Allows Only
One Instance to Run（Singleton））：选中该复选框后，MATLAB在
一次运行应用程序过程中只有一个GUI实例。如果GUI已经存在，
MATLAB将该GUI带到前台，而不会重新创建一个新的GUI图形窗
口。如果允许MATLAB显示多个GUI实例，则每一个调用命令都会创
建一个新的图形窗口。

◆  使用系统背景颜色设置（Using the System Background
Colors）：GUI控件所使用的颜色和计算机系统有关。如果选中该选
项，则使图形窗口的背景颜色和用户添加的控件默认背景颜色相互匹

配。

 
4.仅生成FIG文件（Generate FIG-file only）
如果不希望GUIDE生成对应的应用程序M文件，可以选中该选

项。当用户在界面设计编辑器中保存GUI对象时，GUIDE将仅仅创建
FIG文件，可以使用open命令或者hgload命令来显示该文件。当希望创
建一个与应用程序M文件完全不同的实例，可以选中该选项。

15.4 小结



在本章中，主要讲解了图形用户界面的基础知识，包括GUI界面
的常见创建方法。同时，结合两个具体的例子讲解了如何使用M文件
和GUIDE来创建GUI界面。最后，还介绍了在创建GUI时，需要注意
的常见问题。在后面的章节中，将会继续讲解GUI的高级话题。

◆   ◆   ◆



第16章 创建菜单

本章包括

◆定制标准菜单

◆使用GUIDE创建自定义菜单

◆编写回调函数

◆使用M文件创建自定义菜单

◆创建快捷菜单

 
和其他应用开发程序类似，在图形用户界面中，菜单是很重要的

组成对象。开发者可以根据自己的需要，创建各种功能菜单。这些菜

单能够丰富和完善图形用户界面的功能。根据菜单的创建方法，本章

首先介绍如何使用GUIDE创建图形界面的菜单，然后介绍如何使用M
文件创建菜单。最后，本章还要简单介绍如何创建快捷菜单的内容。

16.1 定制标准菜单

在GUI控件对象中，界面菜单（uimenu）是一个重要的组成部
分。在GUI对象体系结构中，Uimenu对象以Figure图形窗口为父对
象，和Axes坐标轴、Unicontrol界面控件为平等级别的组件。
在MATLAB中，可以根据需要在GUI对象中创建标准菜单，自行

设置菜单或者创建快捷菜单等。同时，可以设置菜单控件的各种属

性，例如添加快捷键、设置对应的回调函数等。因此，在GUI对象
中，可以设置菜单控件来完成多种功能。对于比较简单的GUI对象，



可以根据需要定制MATLAB图形窗口的标准菜单，设置不同的菜单属
性，下面介绍一个简单的实例，来说明如何定制标准菜单。

例16.1 创建一个简单的GUI对象，根据需要定制标准菜单。

step 1
创建一个默认的图形窗口。在MATLAB的命令窗口中输入以下命

令代码：

step 2
查看图形结果。输入以上代码后，按“Enter”键，得到默认的图形

窗口，如图16.1所示。在默认情况下，MATLAB的图形窗口会有一个
顶层菜单条（Top-Level Menu），在MATLAB 7.0中，该菜单条包括8
个菜单项目： File（文件）、Edit（编辑）、View（视图）、
Insert（插入）、Tools（工具）、Desktop（桌面）、Window（窗口）
和Help（帮助）。当用户单击每一个菜单项时，都会产生对应的下拉
菜单（Pull-Down Menu）。

图16.1 创建默认图形窗口

说明



在这些菜单项中，Desktop（桌面）选项是在MATLAB 7.0中添加的新菜单选项，在

MATLAB 6.x版本中没有该菜单选项。

step 3
查 看 Menu 属 性 列 表 。 在 命 令 窗 口 中 输 入 命

令“set(Handle_figure,'MenuBar')”，得到的结果如下：

从以上结果可以看出，标准菜单“MenuBar”有两个属性[ none |
{figure} ]。当对象的属性选取none时，表示图形窗口不显示标准菜单
以及对应的工具条；当对象的属性选取“figure”时，图形窗口将显示标
准菜单，这是图形窗口菜单的默认属性。

step 4
隐藏标准菜单。在有些程序项目中，为了不让用户对程序对象进

行操作，可以隐藏菜单。在命令窗口中输入以下代码：

step 5
查看图形结果。输入代码后，按“Enter”键，得到的结果如图16.2

所示。

图16.2 隐藏菜单选项后的图形窗口



提示

此外，还可以通过命令set(Handle_figure,'MenuBar','none')隐藏图形窗口的菜单选项。

step 6
恢复标准菜单。在命令窗口中输入以下代码：

step 7
查看图形结果。输入代码后，按“Enter”键，得到的结果如图16.3

所示。

图16.3 恢复菜单后的图形窗口

16.2 使用GUIDE创建自定义菜单

在前面已经介绍过，可以使用GUIDE或者M文件来创建GUI对
象。本节将选用一个实例来介绍如何使用GUIDE创建菜单对象，然后
实现各种功能。由于该实例比较复杂，因此将分小节详细介绍。

例16.2 创建一个GUI对象，可以在该图形界面中实现图像转换等
功能，其完成的最后结果如图16.4所示。



图16.4 完成后的GUI界面

16.2.1 创建图形界面

从图16.4可以看出，该图形窗口中的菜单选项是用户自定义的，
而不是MATLAB默认的标准菜单。在本实例中，菜单选项并不复杂，
只有两个菜单选项条：File和Thresholding Method，而且两个菜单选项
都分别有一些子菜单选项，用以实现各种功能。

step 1
打开“Menu Editor”对话框。打开一个默认的空白GUI设计面板，

然后选择该编辑界面的菜单栏中的“Tools”→“Menu Editor”命令，打
开“Menu Editor”对话框，如图16.5所示。



图16.5 菜单编辑器的外观

“Menu Editor”对话框是用户使用GUIDE创建菜单控件的主要操作
界面，可以在该对话框中添加和设置菜单控件的属性。

提示

一般情况下，GUIDE可以创建两种类型的菜单：在图形窗口的菜单栏中显示的菜单栏菜

单（Menu Bar），当用户在图形窗口对象上单击右键时弹出的快捷菜单（Context Menus）。

step 2
创建第一个菜单栏菜单。单击“Menu Editor”对话框中的“New

Menu”按钮，创建一个新的菜单栏菜单，然后在对话框右侧的列表中
设置其菜单属性，如图16.6所示。



图16.6 创建一个菜单选项

其中，Label选项就是菜单在GUI图形界面中的名称：“File”；Tag
属性选项就是用户在编写对应的应用程序中的引用名称“FileMenu”。

提示

在默认情况下，MATLAB会选中“Menu Editor”对话框中的“Enable this item”选项，表示当

GUI图形界面在启动的时候，该菜单选项是可用的。如果希望在启动GUI图形界面时禁用菜

单，应取消选中该选项。

step 3
添加第一个子菜单选项。单击“Menu Editor”对话框中的“New

Menu Item”按钮，添加第一个子菜单选项。然后在对话框右侧的列表
中设置其菜单属性，如图16.7所示。这个步骤中添加的子菜单选项，
就是GUI图形界面中“File”菜单的下拉菜单选项，该菜单选项的Label
是“Open Image”，Tag属性是“OpenMenuItem”，其他选项则保持系统的
默认设置。



图16.7 添加第一个子菜单选项

step 4
依次添加“File”菜单的其他子菜单选项。重复step 3的做法，依次

为“File”菜单添加其他子菜单选项，如图16.8所示。

图16.8 添加其他子菜单选项



上面步骤中添加的两个子菜单选项如下：

对于最后一个子菜单选项，为了将其和以上子菜单选项隔开，这

样前面两个子菜单选项就被分成一组，在其属性列表中选中

了“Separator above this item”，MATLAB会在该菜单选项上方添加一个
分隔线。

说明

目前已经完成了第一个菜单选项的设置过程，主要涉及的内容是设置菜单选项的外观属

性，但是在“Menu Editor”对话框中，除了可以设置外观属性之外，还可以设置其他菜单属

性，包括回调函数Callback等。

step 5
查看前面步骤设置的结果。单击“Menu Editor”对话框中的“OK”按

钮，保存上面步骤中的所有设置。然后选择空白GUI面板中
的“Tools”→“Run”命令，查看设置的结果，如图16.9所示。

图16.9 前面步骤设置的结果

说明



从图16.9可以看出，已经完成了“File”菜单选项的所有子菜单选项的外观属性。可见，使

用GUIDE创建GUI的菜单选项步骤十分简单有效。

step 6
重新打开“Menu Editor”对话框。关闭以上演示界面，然后返回到

GUI的设计界面中，重新打开“Menu Editor”对话框，如图16.10所示。

图16.10 重新打开“Menu Editor”对话框

说明

由于在前面的步骤中，已经运行了前面步骤的设置，MATLAB会为每个菜单选项设置相

应的回调函数，因此，在菜单选项的“Callback”选项中会出现对应的函数名称，单击旁边

的“View”按钮，就可以查看M文件中的对应函数。

step 7
添加新的菜单选项。使用和前面步骤类似的方法，可以依次添加

其他的菜单选项，如图16.11所示。



图16.11 添加新的菜单选项

说明

根据整个应用程序的需要，在以上步骤中，将“Thresholding Method”菜单选项设置为不可

用，因此当运行GUI对象时，该菜单选项将不可用。

step 8
查看新的菜单设置结果。单击“Menu Editor”对话框中的“OK”按

钮，保存所有设置。然后选择GUI面板中的“Tools”→“Run”命令，查看
设置的结果，如图16.12所示。



图16.12 查看菜单设置的结果

说明

由于在前面步骤中将“Thresholding Method”菜单选项设置为不可用，因此在启动GUI时，

将不能查看该菜单选项。

16.2.2 设置菜单属性

在为菜单创建基本的图形界面后，需要使用工具栏的按钮设置图

形界面中菜单的属性。下面详细讲解。

step 1
重新查看“Menu Editor”对话框。前面步骤设置了GUI对象中的所

有菜单选项，并且查看了运行的结果，现在介绍“Menu Editor”对话框
中的常见工具，如图16.13所示。



图16.13 “Menu Editor”对话框

step 2
查看对话框中的工具栏。在“Menu Editor”对话框中，可以使用对

话框中工具栏的各种按钮，来修改各种菜单选项的属性，具体的工具

栏如图16.14所示。

图16.14 工具栏按钮

将以上工具栏按钮依次命名为1～8，下面详细介绍各按钮的功
能：

 
◆  按钮1：创建新的菜单（New Menu）。单击该按钮后，

MATLAB就会创建一个新的菜单栏菜单选项。
◆ 按钮2：添加新的子菜单选项（New Menu Item）。单击该按

钮后，MATLAB就会在当前菜单选项下添加子菜单选项。该按钮只有
在添加菜单后才能使用。



◆ 按钮3：添加新的快捷菜单（New Context Menu）。单击该按
钮后，就会添加新的快捷菜单。当用户选择“Menu Bar”选项卡时，该
按钮不可用；只有选择“Context Menus”选项卡，才可以使用该按钮。

◆  按 钮 4 ： 将 菜 单 移 到 上 一 层 （ Move Selected Item
Backward）。该按钮只能用在子菜单选项中，单击该按钮后，子菜单
选项会被移到上层，变成菜单栏菜单。

◆ 按钮5：将菜单移到下一层（Move Selected Item Forward）。
该按钮也只能用于子菜单选项中，单击该按钮后，子菜单选项会被移

到下一层，变成更下层的菜单选项。

◆ 按钮6：将菜单选项向上移动一个单位（Move Selected Item
Up）。该按钮也只能适用于子菜单选项中，单击该按钮后，子菜单选
项会向上移动一个单位。

◆ 按钮7：将菜单选项向上移动一个单位（Move Selected Item
Down）。该按钮也只能适用于子菜单选项中，单击该按钮后，子菜单
选项会向下移动一个单位。

◆ 按钮8：删除菜单选项（Delete Selected Item）。单击该按钮
后，就可以删除所选中的菜单选项。

 
除了可以使用以上按钮设置各种菜单属性，对于比较详细的属性

设置，可以单击“Menu Editor”对话框中的“More options>>”按钮，打开
所选菜单选项的属性对话框，如图16.15所示。



图16.15 设置菜单选项的属性

说明

在“Property Inspector”对话框中，可以设置关于菜单的所有相关选项，相当于前面章节中

设置其他控件的属性。

16.2.3 添加控件

下面的工作是添加图形界面的菜单，但是，为了能够更好地演示

菜单的功能，在图形界面中，需要添加一些基础控件。具体操作步骤

如下。

step 1
添加控件。添加后的结果如图16.16所示。



图16.16 添加图形控件

step 2
分析控件的功能。添加各种控件的具体步骤，在这里就不详细介

绍了。下面详细介绍各种控件的类型、功能和重要属性：

 
◆  控 件 类 型 Axes （ 坐 标 轴 ） ， “Tag” 属 性

为“AxesImagen”；“Visible”属性为“Off”；功能：显示各种图像。
◆  控 件 类 型 Slider （ 滚 动 条 ） ， “Tag” 属 性

为“Slider1”；“Visible”属性为“Off”；功能：调整图像转换的参数数
值。

◆ 控件类型Checkbox（复选框），“String”属性为“Thresholding
automatically” ， “Tag” 属 性 为 “ActualAutomatico”；“Visible” 属 性



为“Off”；功能：提供自动转换功能。
◆  控 件 类 型 Pushbutton （ 按 钮 ） ， “String” 属 性

为“Thresholding”，“Tag”属性为“Umbralizar”；“Visible”属性为“Off”；
功能：实现图形转换功能。

step 3
查看对象浏览器。除了以上控件类型之外，在以上图形界面中还

有一些“静态文本”（Static Text）控件类型，用来作为各种控件的标
识。如果要了解GUI对象中各控件的结构类型，可以查看该GUI对象
的对象浏览器，如图16.17所示。

图16.17 查看GUI的对象结构

说明

从图16.17所示的对象结构中可以看出，该GUI界面的所有控件的Visible属性都是Off，因

此在加载图像文件之前，所有控件都是不可见的。



16.2.4 添加“File”菜单的回调函数

现在开始编写菜单对应的回调函数。回调函数的主要作用是就是

编写菜单的功能代码。本小节中，将首先介绍“File”菜单回调函数的编
写方法。

step 1
添加“Open Image”菜单选项的回调函数。回到“Menu Editor”对话

框中，选择“Open Image”选项，然后单击“Callback”选框后的“View”按
钮，如图16.18所示。

图16.18 编写“Open Image”的回调函数

step 2
编写回调函数代码。单击“View”按钮后，MATLAB就会切换到M

文件编辑器中对应的函数部分，可以在其中编写相应的程序代码，具



体代码如下：

说明

以上程序代码中，通过程序语句uigetfile打开图像文件，然后分别设置对应图形窗口中的

菜单选项的属性。

step 3
添加“Save Image”菜单选项的回调函数。回到“Menu Editor”对话

框中，选择“Save Image”选项，然后单击“Callback”选框后的“View”按
钮，在M文件编辑器中对应的位置编写保存文件的代码：



说明

在以上程序代码中，根据不同的保存文件和情况，显示不同的提示信息，只有当保存文

件符合系统的要求时，才会保存相应的文件。

step 4
添加“Close”菜单选项的回调函数。回到“Menu Editor”对话框中，

选择“Close”菜单选项，然后单击“Callback”选框后的“View”按钮，在M
文件编辑器对应的位置编写保存文件的代码：



提示

选择菜单选项中的“Close”选项时，会显示询问对话框，单击“Yes”按钮，关闭整个对话

框；单击“No”按钮，则返回程序。

16.2.5 添加“Thresholding Method”菜单的回调
函数

现 在 为 “Thresholding Method” 菜 单 编 写 对 应 的 回 调 函
数。“Thresholding Method”菜单是本例中的主要菜单，各选项分别对
应不同的图像处理方法。下面详细介绍编写的步骤。

step 1
添加“Thresholding Method”菜单的回调函数。在对话框中选中对

应的菜单选项，然后单击右侧的“View”按钮，添加相应的函数代码，
如图16.19所示。

图16.19 添加菜单选项的程序代码



step 2
添加具体的程序代码。所有子菜单选项对应的回调函数代码程序

如下：



step 3
查看图形转换函数的代码。在以上程序代码中，对不同的菜单选

项，调用了不同的图形转换函数，这些函数都是用户自行定义的函

数，对应的函数代码如下：











说明

在以上程序代码中，主要定义了三个图像转换函数：Kapur1、Triangular1和Iterativo1，分

别对应的转换方法是Kapur、Triangular和Iterative，关于这些方法的具体内容和操作信息，感

兴趣的读者可自行查阅关于图形转换的内容。

step 4
查看graythresh函数的程序代码。在以上程序代码中之所以没有另

外定义graythresh函数，是因为该函数是MATLAB的内置函数，其具体
代码如下：



step 5
查看图形句柄检测函数。最后，除了设置对应的图像转换函数，

还设置了检测图形句柄的函数NoChecked，具体程序代码如下：



这段程序代码的功能是检测菜单选项对象是否被选中，然后根据

检测的结果来设置不同的菜单选项调用函数。

说明

由于本小节的内容主要是介绍如何使用GUIDE创建菜单选项，同时设置菜单选项的属

性，并且添加菜单选项的程序代码，因此关于上面程序的具体含义就不详细分析了，感兴趣

的读者可查看关于M文件编程的内容。

16.2.6 添加“滚动条”控件的回调函数

在为图形界面中的菜单添加了回调函数之后，需要为“滚动条”控
件添加对应的回调函数。在本例中，滚动条控件的主要功能是调整图

像的灰度。下面详细讲解添加的步骤。

step 1
添加“slider1”滚动条的回调函数。首先需要为滚动条添加回调函

数，在GUIDE图形界面中选中“slider1”对象，单击右键，在弹出的快
捷菜单中选择“View Callbacks”→“Callback”命令，如图16.20所示。



图16.20 查看滚动条的回调函数

MATLAB会自动跳到添加滚动条回调函数的位置，编写的程序代
码如下：

step 2
查看图形转换函数的程序代码。在以上程序代码中，调用了两种

图像转换函数，具体代码如下：



16.2.7 添加其他控件的回调函数

在本例中，还有必要为图形界面中的其他控件添加回调函数。这

些控件包括复选框、按钮等。在进行图像转换的时候，会用到这些控

件。下面详细介绍操作步骤。

step 1
添加“ActualAutomatico”复选框的回调函数。在GUIDE图形界面中

选中“slider1”对象，然后单击右键，在弹出的快捷菜单中选择“View
Callbacks”→“Callback”命令，在M文件编辑器的对应位置编写如下代
码：



step 2
添加 “Umbralizar”按钮的回调函数。在GUIDE图形界面中选

中“Umbralizar”对象，然后单击右键，在弹出的快捷菜单中选择“View
Callbacks”→“Callback”命令，在M文件编辑器的对应位置编写代码如
下：

step 3



查看图像转换函数的代码。在以上程序代码中，调用了另外一种

图像转换函数GraficarHistoUmbral，其详细的函数代码如下：

16.2.8 编写主调函数

目前已经为控件和菜单添加了对应的回调函数。在本小节中，需

要编写调用这些回调函数的代码，也就是编写“CargarImagen”函数。
其对应的程序代码如下：



16.2.9 运行GUI对象

在完成整个图形用户界面的代码之后，可以开始检测这些代码的

功能。

step 1



选择图形文件。在MATLAB的命令窗口中输入“ThresGUI”，然后
按“Enter”键，直接运行前面步骤中的GUI对象，如图16.21所示。

图16.21 打开GUI对象

在以上图形界面中，选择“File”→“Open Image”命令，打开“Select
File to Open”对话框，可以在该对话框中选择对应的图形文件，该程序
支持的图形文件格式包括jpg、tif、gif、bmp、png、hdf、pcx、xwd、
ico、cur、ras、pbm、pgm、ppm等。

step 2
运行GUI程序。当选中对应的文件后，单击对话框中的“打开”按

钮，运行程序，结果如图16.22所示。



图16.22 运行整个程序

说明

从图16.22中可以看出，当添加图形后，“Thresholding Method”菜单选项被全部激活，可

以选用对应的图像转换方法。

step 3
选择图形转换类型。选择“triangular”菜单选项，然后在滚动条中

选择图像转换参数，单击“Thresholding”按钮，得到的结果如图16.23所
示。



图16.23 进行图像转换

说明

单击“Thresholding”按钮后，图像转换的结果会出现在右下方的图形窗口中，同时，其按

钮中的文字变为“next Threshold>>”。连续单击该按钮，就可以得出不同图像转换的结果。

step 4
保存转换后的图形。当完成了图形转换后，可以保存转换后的图

形文件，如图16.24所示。选择“File”→“Save Image”命令，打开“Save
file name”对话框，可以选择图形保存的路径和名称，设置保存属性后
单击“保存”按钮完成图形的保存工作。



图16.24 保存图形转换文件

step 5
查看保存图形。选择图形的保存路径，查看的图形结果如图16.25

所示。



图16.25 保存的图形文件

提示

可以使用合适的图片浏览软件查看保存的图形文件，其保存的文件就是前面操作转换的

图形文件。

step 6
退出GUI程序。选择图形窗口中的“File” →“Close”命令，打开对

应的关闭对话框，单击“Yes”按钮，就可以退出整个GUI程序，如图
16.26所示。



图16.26 退出GUI应用程序

说明

以上简单实例演示了使用GUIDE创建MATLAB的菜单选项的步骤，首先通过“Menu

Editor”对话框设置菜单的选项和外观属性，然后添加对应选项的回调函数，完成各种功能。

16.3 使用M文件创建自定义菜单

在了解了使用GUIDE创建菜单选项的方法之后，下面将以另外一
个案例来演示如何使用M文件创建自定义菜单。同样，该实例比较复
杂，在本节中将分小节详细介绍。

16.3.1 演示GUI的功能



例16.3 编写一个GUI对象，同时创建用户自定义的菜单，通过使
用自定义菜单来完成文件操作，最后需要完成的功能是绘制文件数据

图表。为了能够让读者大致了解该GUI对象的功能，下面简要演示
GUI对象的操作过程。

step 1
选择处理文件。首先，使用“File”菜单打开需要处理的文件，如图

16.27所示。

图16.27 读入数据文件

提示

本例需要完成的GUI对象中，“File”菜单选项包括了所有文件操作选项：读入文本文件、

读入Excel文件、保存文件和关闭GUI对象等。以上文件操作是“读入Excel文件”菜单选项。

step 2



定义数据系列。选择“Options”菜单选项中的菜单选项，定义对应
的数据系列：X数据列、Y数据列、Z数据列、误差线数据列、数据标
记等。在该本步骤中，定义的是Z列数据，如图16.28所示。

图16.28 定义图表的数据系列

step 3
绘制数据系列。当已经读入数据文件，并定义图表的数据系列

后，可以选择相应的菜单选项，绘制用户读入的数据系列，如图16.29
所示。



图16.29 选择绘图菜单

step 4
查看图形结果。当选择了相应的绘图方式后，在图形窗口中就会

显示绘图的结果，如图16.30所示。



图16.30 绘制的图形结果

从以上演示过程中可以看出，在本GUI对象中所有的操作都是通
过菜单选项完成的，该GUI对象中没有添加任何其他GUI的控件。同
时，这些菜单选项都是用户自己创建设计的，不是MATLAB的标准菜
单。

说明

由于每一个菜单选项功能都需要编写对应的调用函数，为了便于理解整个系统的功能，

在本实例中，将为每个调用函数编写一个M文件。最后，整个GUI对象将是一个包含多个M文

件的集合文件。

16.3.2 添加“File”菜单的功能代码

从本小节开始将详细介绍如何创建以上GUI对象。具体操作步骤
如下。



step 1
设计菜单选项的结构体系。由于在本实例中，所有的程序功能都

是通过自定义菜单选项实现的，因此，有必要设计菜单选项的体系结

构。

 
◆ “File”菜单：该菜单中包括了文件操作的所有菜单选项：读取

txt文件和Excel文件，保存文件、退出系统等。因此，该“File”菜单包
括了Read Txt File、Read Excel File：All、Read Excel File：Selected
Data、Save as和Quit菜单选项。

◆ “Options”菜单：该菜单选项中包括了添加数据的各种选项，
可以从菜单选项中选择相应的选项，来定义各种图表数据系列。

◆ “Graphs”菜单：该菜单选项包括了各种绘图的选项：2D和
3D，以及两种菜单选项下的各种绘图格式，这个菜单是绘图的主要菜
单选项。

step 2
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



将代码保存为“getdata.m”，该程序代码将是“File”菜单选项中读取
文件的菜单选项对应的程序代码。

step 3
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



将代码保存为“savefigas.m”，该程序代码将是“File”菜单下“Save
as”菜单选项对应的程序代码。

16.3.3 添加“Options”菜单的功能代码

根据前面的介绍可知“Options”菜单中各选项的功能是提供添加数
据系列的功能。在本小节中，将详细介绍该菜单对应的功能代码。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



将代码保存为“getcols.m”，该程序代码将是“Options”菜单下定义
数据系列的菜单选项对应的程序代码。

step 2
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



将代码保存为“getlabel.m”，它将是“Options”菜单下定义数据系列
名称的菜单选项对应的程序代码。

step 3
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

将代码保存为“window.m”，其将是“Options”菜单下“向图形中添
加数据”菜单选项对应的程序代码。

16.3.4 添加“Graphs”菜单的功能代码

根据前面的介绍可知，“Graphs”菜单选项的主要功能是提供各种
绘图选项。在本小节中，将为这些功能编写对应的程序代码。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：





将代码保存为“plot2d.m”，其将是“Graphs”菜单下“2D”菜单选项对
应的程序代码。

说明

在以上图形类别中，有一种图形类别比较特殊，这就是误差线类型。在以上程序代码

中，调用了函数barerror来绘制误差线，该函数需要用户单独定义。

step 2
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



将代码保存为 “barerror.m”，该程序代码将是Graphs菜单选项
中“2D”菜单选项下“barerror”菜单选项对应的程序代码。

step 3
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



将代码保存为“plot3d.m”，其将是“Graphs”菜单下“3D”菜单选项对
应的程序代码。



16.3.5 添加主调函数

在编写完各种菜单的功能代码后，将主要讲解如何添加本GUI对
象的主调函数。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：





将代码保存为“Qplot.m”，它将是该GUI对象的主程序代码。

step 2
分析程序代码。在以上程序代码中，反复使用uimenu命令创建各

种菜单选项。该命令是在MATLAB中创建菜单对象的主要命令，下面
选取其中的部分语句来分析该命令的用法。



在以上命令行中，首先使用 uimenu命令创建了一个标题
为“Options”的菜单选项，同时将该菜单选项的句柄赋值给变量mopt；
然后使用uimenu命令创建了“Y columns”菜单选项，该菜单选项对应的
回调函数是“getcols(“y”)”，同时，该菜单选项的快捷键为“Ctrl＋Y”，
该快捷键标记会出现在菜单名称后面。

说明

在MATLAB中，菜单选项的快捷键只有在菜单选项不可见时才有效。

16.3.6 运行GUI对象

在为GUI对象编写了各种功能代码之后，将运行GUI对象，检测
前面设计的各种功能。

step 1
读入Excel文件。以上步骤已经完成了所有的菜单选项的设置，现

在开始演示程序代码。首先读入准备好的“Qplot”Excel文件，如图
16.31所示。



图16.31 读入数据文件

step 2
定义数据系列。当读入了数据文件后，可以定义相应的数据系

列，在本例中除了需要添加X和Y数据系列之外，还需要添加误差线数
据系列，如图16.32所示。



图16.32 添加误差线数据系列

step 3
添加图形标题。在添加了所有的数据系列后，需要为图形添加图

形的标题，选择“Options”→“Axis Labels”命令，打开“Axis Legends”对
话框，在其中设置图形的标题，如图16.33所示。



图16.33 添加图形的标题

step 4
选择绘图类型。当设置了图形的标题后，需要选择对应的绘图类

型 ， 在 本 例 中 需 要 绘 制 的 是 误 差 线 的 直 线 ， 因 此 选

择“Graphs”→“2D”→“XY Line with error bar”命令，如图16.34所示。



图16.34 选择绘制的图形类型

step 5
查看图形结果。选择了相应的菜单选项后，MATLAB就会绘制出

对应的图形，如图16.35所示。



图16.35 绘制的图形结果

step 6
重新选择绘图类型。对于同一个数据文件，可以选择不同的绘图

类型，以显示该数据变化趋势。例如，在本实例中可以选

择“Graphs”→“2D”→“Vertical Bar with error bars”命令，查看重新绘制
的图形结果，如图16.36所示。



图16.36 重新选择图形类型

step 7
重新查看图形结果。选择了对应的图形类型后，MATLAB就会绘

制出对应的图形，如图16.37所示。



图16.37 修改后的图形

说明

读者还可以演示菜单选项的其他功能，限于篇幅，这里就不详细介绍这些内容了。

16.4 创建快捷菜单

在前面的章节中，已经详细介绍了如何创建菜单栏的菜单选项，

下面将介绍如何创建快捷菜单。快捷菜单就是当用户用右键选择对象

后，弹出的快捷菜单选项。因此，可以认为快捷菜单都是和某个图形

对象相联系，并通过鼠标右键来激活。创建快捷菜单的一般步骤如

下：

 

step 1



利用命令uicontextmenu创建快捷菜单对象。

step 2
利用命令uimenu来设置该快捷菜单对象的具体属性。

step 3
利用命令set将快捷菜单和图形对象联系起来。
 
在本节中将利用一个比较简单的实例来介绍如何在MATLAB中创

建快捷菜单。快捷菜单也是属于MATLAB的图形对象之一，因此可以
使用GUIDE来创建快捷菜单，也可以直接使用M文件来创建快捷菜
单。

在本实例中，将直接使用M文件来创建快捷菜单。

16.4.1 编写程序代码

例16.4 创建一个图形对象，然后创建一个与之联系的快捷菜
单，该菜单可以控制关于图形的各种属性。为了直观地了解该快捷菜

单的属性，在MATLAB的命令窗口中输入以下程序代码：

以上程序代码可以在图形对象中添加快捷菜单，如图16.38所示。



图16.38 演示完成的快捷菜单

在以上快捷菜单中，可以控制图形的颜色系统、转换图像方向、

显示图形的颜色条、绘制三维图形、设置图形的标题和坐标轴名称

等，下面分步骤详细介绍创建过程。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：



以上程序代码的主要功能是在图形对象中显示颜色条，对应的菜

单选项是“Togglecolorbar”。在以上程序代码中，首先判断图形中是否
有图形颜色条，如果没有颜色条，则向其中添加颜色条对象。

step 2
在M文件编辑器中添加以下程序代码：



这段代码的功能是重新设置图形像素的单位，对应的菜单选项

是“Colormap length”。当用户选择该菜单选项后，MATLAB就会显示
出对话框，提示用户输入图形像素的新单位，确定了新的图形像素

后，将使用该单位绘制图形。

step 3
在M文件编辑器中添加以下程序代码：



上面代码的功能是绘制当前图形数据的三维图形，对应的菜单选

项是“3D plot”。当用户选择该菜单选项后，MATLAB就会在新的图形
窗口中绘制新图形，而且默认情况下的图形类型是surf曲面图。

step 4
在M文件编辑器中添加以下程序代码：



上面代码的功能是设置图形中colormap数值范围，对应的菜单选
项为“Image limits”。当用户选中该选项后，MATLAB会显示相应的对
话框，可以在其中设置上限和下限，然后系统按照新的数值范围绘制

图形。

step 5
在M文件编辑器中添加以下程序代码：



以上代码的功能是设置图形的标题和X、Y坐标轴的名称，对应的
函数分别为titlecallback、xaxiscallback和yaxiscallback，对应的菜单选
项为“Title”、“X-axis Label”和“Y-axis Label”。当用户选用该菜单选项



后，会弹出相应的对话框，可以在其中设置图形的标题、X坐标轴和Y
坐标轴的名称。

step 6
在M文件编辑器中添加以下程序代码：



将全部的程序代码保存为“imagemenu.m”文件。在程序代码中，
首先使用uicontextmenu命令创建一个快捷菜单选项，然后使用uimenu
命令设置快捷菜单选项的属性，最后使用set命令将该快捷菜单选项和
图形句柄联系起来。

16.4.2 运行GUI对象

前面已经编写了关于快捷菜单的各种功能代码，在本小节中，需

要运行GUI对象，检测各种常见功能。具体操作步骤如下。

step 1
演示完成的程序代码。在命令窗口中输入以下代码：

提示

在以上程序代码中，首先使用imagesc命令显示一个图形对象，然后使用axis设置图形对

象的坐标轴属性，最后在以上图形中添加快捷菜单。

step 2
修改图形的颜色模式。选中程序代码绘制的图形对象，单击鼠标

右键，在弹出的快捷菜单中选择“Colormap”→“Spring”命令，修改图形
的颜色模式，如图16.39所示。



图16.39 修改图形的颜色模式

step 3
查看图形结果。选择以上菜单选项后，得出修改后的图形如图

16.40所示。



图16.40 修改后的图形

step 4
向图形界面添加“颜色条”。单击鼠标右键，在弹出的快捷菜单中

选择“Toggle colorbar”命令，如图16.41所示。



图16.41 添加颜色条

step 5
添加显示图形像素的对话框。单击鼠标右键，在弹出的快捷菜单

中选择“Toggle pixel values”命令，如图16.42所示。



图16.42 显示图形的像素数值

step 6
设置新的图形像素数值。单击鼠标右键，在弹出的快捷菜单中选

择“Colormap length”命令，弹出“New colormap length”对话框，在其中
可以设置新的图形像素数值，如图16.43所示。



图16.43 设置新的图形像素数值

step 7
查看三维图形结果。单击鼠标右键，在弹出的快捷菜单中选

择“3D plot”命令，MATLAB就会在新的图形界面中显示三维图形，如
图16.44所示。



图16.44 显示三维图形

step 8
重新设置图形界面的像素上下限。选择图形对象，单击鼠标右

键，在弹出的快捷菜单中选择“Image limits”命令，弹出“New image
limits”对话框，可以在其中设置图形对象像素的上下限，如图16.45所
示。



图16.45 设置新的图形像素范围

step 9
添加坐标轴的名称。最后，可以使用对应的菜单选项，添加图形

的标题和X、Y坐标轴的名称，得到的最后结果如图16.46所示。



图16.46 添加图形标题

16.5 小结

本章主要讲解的是如何在图形用户界面中添加菜单，并且为菜单

编写相应的功能代码。灵活使用菜单，会给用户GUI开发带来很大的
便利。同时，本章在最后还介绍了快捷菜单的创建方法。

◆   ◆   ◆



第17章 添加控件

本章包括

◆添加控件

◆添加控件的功能代码

◆规划GUI设计过程

◆设置CUI控件属性

 
在了解了如何创建GUI和GUI菜单的方法之后，在本章中将详细

讲解如何添加GUI中的控件。同时，在本章的最后，将结合前面章节
所讲的内容介绍一个综合案例。通过综合案例的讲解，让读者了解如

何开发实际的GUI界面。

17.1 创建GUI对象的用户控件

在前面的章节中，读者已经多次接触过GUI对象的用户控件。在
GUI中，用户控件是除了用户菜单之外，实现用户和计算机交互的重
要途径。在本小节中，将以一个比较简单的例子来介绍在MATLAB中
创建GUI用户控件的方法，在介绍具体方法的同时将介绍关于控件属
性的各种基本内容。

例17.1 编写一个关于图形三维显示的GUI，完成后的GUI如图
17.1所示。



图17.1 完成的GUI对象

在这个GUI中，包括了MATLAB的多种用户控件，例如按钮、滚
动条、复选框、编辑框、坐标轴等，由于这些控件类型都是MATLAB
的常用控件，下面分别介绍各种控件的创建方法和属性设置方法。

17.1.1 添加控件组件

在本小节中，将分步骤详细介绍如何添加各种控件组件。

step 1



打开GUIDE，然后向GUIDE中添加坐标轴控件。在控件面板中选
择“Axes”控件，然后将其添加到GUIDE中，如图17.2所示。

图17.2 添加坐标轴控件

step 2
添加滚动条（Slider）控件。在控件面板中选择“Slider”控件，然

后将其添加到GUIDE中，如图17.3所示。



图17.3 添加滚动条控件

在MATLAB中，滚动条控件的主要功能是使用户能够通过滚动条
来改变指定范围内的数值输入，滚动条的位置代表用户输入的数值。

在本实例中，该滚动条的功能是修改图形在三维坐标系中的位置坐

标。

step 3
分 析 滚 动 条 控 件 的 功 能 。 对 于 滚 动 条 控 件 ， 其 属

性“Max”和“Min”的数值决定滚动条数值范围的上下限，另外，属
性“SliderStep”是一个二元数组，第一个元素决定两端箭头操作滚动条
时的步长，第二个元素则决定了游标操作滚动条时的步长。关于滚动

条控件，还有一个重要的属性“Value”，其对应的属性为游标位置。

说明

关于以上内容，在本小节中将不会进行具体操作。该控件属性的详细设置将在后面章节

中进行介绍。



step 4
添加静态文本控件。在控件面板中选择“Static Text”控件，将其添

加到GUIDE中，然后打开该控件的属性列表对话框，将其“String”属性
设置为“_”，如图17.4所示。

图17.4 添加静态文本控件

说明

该静态文本的作用在于显示滚动条的数值增长方向，因此本控件对象对应的字符串文字

表示：当用户向右移动该静态文本时，其对应的数值是减少的。

step 5
添加复选框控件。在控件面板中选择“Check Box”控件，将其添加

到GUIDE中，然后打开该控件的属性列表对话框，将其“String”属性设
置为“transpose”，然后将其背景颜色设置为白色，如图17.5所示。



图17.5 添加复选框控件

在MATLAB的控件类型中，复选框和单选按钮的功能类似，只是
多个复选框控件可以同时选中。复选框为用户提供了一些可以独立选

择的选项进行程序模式设置，例如显示工具条与否以及生成回调函数

原型与否。在本例中，复选框的功能是提供用户选择图形显示的选

项，“transpose”选项的含义是将图形进行转置。

说明

对于复选框控件，属性“Max”和“Min”表示了复选框控件的两种状态。在默认情况下，

Max属性数值为1，Min属性数值为0。而属性“Value”则表示了与当前状态直接联系，当控件被

选中时，该属性数值为1；同时，当控件没有被选中时，属性数值为0。

step 6
添加其他的复选框控件。在本例中，为用户提供的图形选项还有

上下倒转、左右倒转，可以用和上面步骤类似的方法添加其他的复选



框控件，得到的结果如图17.6所示。

图17.6 添加其他复选框控件

说明

在以上控件名称中，flipud表示的是将图形进行上下转置，fliplr表示的是将图形进行左右

转置，对应的都是MATLAB中的相关函数。

step 7
复制上面步骤中添加的控件。根据本实例中的结果，该GUI对象

共有三个坐标轴系统，来显示不同截面的平面图形，因此在本步骤需

要复制上面步骤中添加的控件类型，得到的结果如图17.7所示。



图17.7 复制上面步骤中的控件

说明

在以上步骤中，除了使用简单的命令来复制前面步骤添加的控件之外，还需要使用排列

工具将以上控件进行排列，具体的使用方法参见前面的章节。

step 8
添加其他的图形控件。根据本实例的要求，为实现其他图形功

能，需要添加其他图形控件，具体的控件类型包括编辑框、静态文



本、按钮等，添加后的图形界面如图17.8所示。

图17.8 添加图形控件

step 9
分析图形控件的功能。

 
◆ 静态文本（Static Text）之所以被称为“静态”，是因为其中的

文字只是起到注释说明的作用，而不能产生“回调”函数。但是静态文
本框中的内容可以使用程序代码进行修改。

◆ 编辑框（Edit Text）控件，如果希望在其中输入多行数据行，
必须使用分号“；”或者逗号“，”来结尾，然后再回车进行换行。当某



个完整的命令长度超过了物理行时，MATLAB将会任其自动回绕。用
户在编辑框中输入的文字内容，会被编辑框中的“String”属性所接收，
其数值是由多行命令构成的“补尾字符串矩阵”。

提示

在MATLAB中，通常使用eval命令来解读字符串矩阵，但是该命令在解读矩阵时，是

沿“列”进行解读的，应该采取适当措施进行处理。

 
由于本实例的控件有限，对于MATLAB中的其他常见控件，下面

给出简要说明：

 
◆ 弹出式菜单（Pop-up Menu）：弹出式菜单将打开并显示一

个由其String属性定义的选项列表。当希望提供一些相互排斥的选项，
但不希望占用空间时，弹出式菜单将十分有用。在非激活状态，弹出

框中只显示选中的选项内容。该控件的“Value”属性是正整数，代表用
户所选中的选项。

◆ 列表框（Listbox）：和复选框类似，列表框中所列的选项不
是互斥的，可以同时选中列表框中的多项内容。当用户选中某些选项

后，对应的选项会变为突出显示。当然，只有将列表框中的“Max”属
性设置为大于2时，才能允许用户选择多个选项。当需要选择多个选项
时，需要同时按住“Ctrl”按键，然后使用鼠标进行点选。

◆ 单选按钮（Radio Button）：单选按钮和普通按钮在执行方式
上没有本质的差别，但是单选按钮通常是以组为单位，一组单选按钮

之间是一种互斥的关系，每组单选按钮只能有一个按钮被选中。该选

项被选中的属性由“Max”决定，不选中的时候，其属性则由“Min”决
定。



说明

对于其他的MATLAB控件，可以查看对应的MATLAB帮助信息，限于篇幅，这里就不详

细介绍了。

17.1.2 添加控件的功能代码

前面已经添加了GUI的控件，现在为这些控件添加对应的功能代
码。下面详细介绍操作步骤。

step 1
查看添加的控件效果。完成前面小节的添加工作后，可以查看添

加后的控件效果，如图17.9所示。



图17.9 添加控件的效果

step 2
当添加了所有控件后，需要为控件编写相应的程序代码。在

GUIDE界面中，打开GUI对象的代码编辑器，然后在其中输入以下代
码：



说明



以上程序代码是用户自定义的底层绘图函数，GUI中的相关控件的回调函数都将调用该

函数的程序代码，其主要功能是绘制各截面的图形。

step 3
编写GUI控件的回调函数。将打开的M文件编辑器回嵌到命令窗

口中，然后选择对应的控件回调函数名称，编写对应的回调函数，如

图17.10所示。

图17.10 编写GUI控件的回调函数

由于本实例中，控件的回调函数比较简单，下面显示所有回调函

数的代码：









17.1.3 运行程序代码

现在已经添加了控件，并且添加了控件对应的程序代码，下面运

行对应的程序代码。详细操作步骤如下。

step 1
查看默认的程序代码结果。在MATLAB的命令窗口中输

入“>>view3d”，然后按“Enter”键，得出默认的程序结果，如图17.11所
示。



图17.11 查看默认的程序结果

在默认情况下，绘制的三维数组是“rand(50,40,30)”，同时选择了
各个截面的坐标数值和图形选项，得到的三维图形在右下方的坐标轴

系统中显示。

step 2
返回到M文件编辑器中，输入以下程序代码：

step 3



查看图形结果。输入代码后，按“Enter”键，得到的结果如图17.12
所示。

图17.12 显示三个截面的图形

在以上程序中，定义了一个三维数组A3D，然后在图形界面中单
击“Display”按钮，就会显示对应的截面图。

step 4
显示三维图形。单击“Update 3D”按钮，得到的图形结果如图17.13

所示。



图17.13 显示三维图形

step 5
修改截面属性，重新查看图形结果。对于y-z截面，将其坐标数值

设置为“x＝70”，同时选中“flipud”选项；对于x-z截面，将其坐标数值
设置为“y＝30”，同时选中“transpose”选项；对于x-y截面，将其坐标数
值设置为“z＝60”，同时选中“fliplr”选项。设置这些属性选项后，单
击“Update 3D”选项，得到的结果如图17.14所示。



图17.14 修改后的图形界面

step 6
修改显示比例。在文本框中输入图形窗口显示比例，得到的图形

如图17.15所示。



图17.15 修改图形窗口的显示比例

step 7
查看三维图形。最后，为了更加直观地了解图形的结构，可以在

MATLAB的命令窗口中输入如下代码：

step 8
查看图形结果。输入程序代码后，按“Enter”键，得到的结果如图

17.16所示。



图17.16 函数的曲面图

在GUI对话框中，显示的是曲面图形的三个垂直截面图形结果，
尽管截面的图形结果也能显示数值变化趋势，但是曲面图更加直观地

显示了数据变化的结果。

17.2 图像切割界面——综合案例

在前面的章节中，已经介绍了如何在MATLAB中创建GUI对象的
方法，并介绍了如何创建GUI菜单、工具栏、控件的具体方法和注意
事项。本节将介绍一个比较综合的案例来说明如何综合利用这些方法

创建一个比较复杂的GUI对象。具体来讲，该GUI对象的主要功能是
动态演示绘制三元函数的切片图的过程，以某个三维数组为例，得到

的切片图如图17.17所示。



图17.17 完成的GUI图形界面

17.2.1 分析GUI对象

由于该GUI对象比较复杂，因此有必要认真地分析GUI对象的各
种功能和性能。首先，从GUI组件的角度分析，该GUI对象包括以下
组件：自定义GUI菜单选项、自定义GUI工具栏、自定义GUI用户控件
等；从用户和计算机的互动角度分析，该GUI包括了鼠标互动、控件
按钮互动等。

说明

该GUI对象的鼠标互动情况和前面章节中的鼠标互动不同，在本GUI对象中，除了互动之

外，还向该GUI对象中添加了其他图形对象：箭头。

 
下面详细分析该GUI中各种对象的具体属性。
 



◆  自定义菜单选项：在本GUI对象中，菜单选项还包括
了“help”菜单选项，该菜单选项会启动MATLAB的帮助系统，对于该
选项的创建方法将在后面章节中详细介绍。

◆ 自定义工具栏：在本GUI对象中，工具栏包括常见的绘图工
具选项和照明工具栏，而不是MATLAB中的默认菜单工具栏。之所以
选择该工具栏选项，是因为这些选项是查看该GUI中图形对象的常用
工具选项。

◆ 自定义用户控件：在本GUI对象中，用户控件包括两个下拉
菜单，分别用来选择图形的色图（ colormap）系统和透明度
（Alphamap）选项，这些选项都将直接影响图形对象的显示结果。

 
下面详细介绍该GUI对象的操作步骤。

step 1
首先在MATLAB的工作空间中创建一个三维数组[X，Y，Z]，和

一 个 同 维 向 量 V ， 然 后 输 入 命 令 sliceomatic(V) 或 者

sliceomatic(V,X,Y,Z)，调用该GUI对象。

step 2
通过鼠标来确定该三维图形的切面的坐标数值，包括X向、Y向和

Z向的切面坐标数值，该GUI允许用户在各个方向上分别确定多个切
面。当用户选择某个切面后，MATLAB会显示对应坐标条件下的切面
图形。

step 3
分别在两个下拉菜单中选择色图系统和图形透明度数值，来改变

图形显示的颜色和透明度。



step 4
使用照明工具栏中对应的按钮，修改查看三维切面图形的视角。

step 5
使用菜单选项来设置图形显示的各种属性。

step 6
使用help命令来查看相关命令的帮助信息。

说明

从以上分析中可以看出，该GUI对象几乎集合了所有关于图形属性的内容，比较复杂，

因此需要分章节详细介绍具体的创建过程。

17.2.2 规划GUI的设计过程

本实例整体比较复杂，涉及的对象比较繁多，因此为了有效地创

建整个GUI对象，在创建该GUI之前，必须首先对创建过程进行规
划。为了设置GUI中各个控件的属性，需要为创建控件编写对应的M
文件，同时，为调用各控件函数编写主函数的程序代码。为了显示整

个系统的完整性，将所有被调函数的M文件保存在“private”文件夹
中，主调函数则是保存在主文件中，下面分小节介绍如何创建各种控

件。

17.2.3 创建GUI的工具栏对象

从本小节开始将介绍如何在MATLAB中创建该GUI的工具栏对
象。在本例中，工具栏的主要功能是提供用户选择操作的工作。具体



操作步骤如下。

例17.2 创建17.2.1节中的GUI对象。

step 1
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，输
入以下代码：

在以上程序代码中，首先使用set命令将MATLAB中默认的图形窗
口工具栏设置为“none”，然后使用uitoolfactory命令添加MATLAB中的
默认工具栏按钮。主要有两种：注释（ annotation）和视角



（exploration）。最后，使用cameratoolbar添加相关的照明工具按钮。
这段程序的主要功能是为设置sliceomatic对象属性选择对应的工具栏
按钮。

说明

在这段程序代码的最后部分，考虑到了MATLAB版本兼容的问题，如果用户使用的

MATLAB版本是R13或者更新的版本，则调用最后的程序代码。

step 2
查看完成的图形界面。将以上程序代码保存为“figtoolbar.m”文

件，然后在命令窗口中输入“figtoolbar”，按“Enter”键，得到的图形如
图17.18所示。

图17.18 显示图形的工具栏对象

17.2.4 准备图形对象的基础文件



本例的主要功能是对图形对象进行各种操作，因此，在编写该

GUI对象的时候，需要首先创建关于图形图像的各种基础文件。在本
小节中，将详细讲解这些文件的准备过程。

step 1
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，输
入以下代码：





以上程序代码比较复杂，下面详细介绍其具体的含义：

 
◆  程 序 代 码 error(nargchk(1,4,nargin))……

d.reducenumbers(d.reducenumbers==0)=1的功能是判断函数的参数个
数，然后将isonormal的数据进行规一处理。

◆ 程序代码if nargin == 4……zmesh=zmesh'；end的功能是将函
数的参数进行转置，将列向量转换为行向量，这个步骤的主要目的在

于为后面图形转换做准备。

◆ 程序代码xdir='normal'……d.zlim = [zmesh(1) zmesh(end)]；end
的功能是，首先设置三向坐标系统的方向为正常方向，然后使用三个



循环结构将数据按照图形对象结构进行转换，并转换坐标轴方向，设

置坐标轴的刻度范围。

◆  程序代码 ly = 1:d.reducenumbers(1):size(d.data,2) ……d.zdir =
zdir的功能是，将三维数据转换为X/Y坐标轴中的数据系列，然后重新
设置坐标轴的方向。

◆ 程序代码else……appdata = d的功能和以上程序代码段类似，
只是处理的情况是函数的参数个数不是4个的情况，原理相同，这里就
不重复介绍了。

 
将以上程序代码保存为“sliceomaticsetdata.m”文件，该文件将是在

后面的步骤中绘制三维图形的基础文件。

step 2
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，输
入以下代码：





上面程序代码的主要功能是处理鼠标在图形对象中移动时的问

题。根据最后的GUI结果要求，当鼠标在各个坐标轴Slice控制面板中
移动时，应该显示出对应的光标符号，同时在图形窗口中显示对应的

截面。将以上程序代码保存为“sliceomaticmotion.m”文件，该文件也将
是在后面的步骤中绘制三维图形的基础文件。

说明

由于鼠标移动的事件必定会涉及鼠标光标、箭头符号等对象，因此，在以上程序代码

中，调用了setpointer、showarrowtip等相关函数，这些函数都将在后面详细介绍。

step 3
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，然
后在M文件编辑器中输入以下代码：



以上程序代码的功能在于设置图形各对象标签的属性，主要在于

设置标签的名称和启动标签编辑的功能。将以上程序代码保存

为“activelabel.m”，该M文件将在后面的程序代码中反复被调用。

说明

以上程序代码比较简单，但是和前面的程序代码有很大的区别。前面的程序代码都是实

现独立功能的，而这段代码的功能是创建被调函数。

step 4
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，输
入以下代码：



以上程序代码的功能是创建图形界面的Slice控件，该GUI对象中
包含了三个Slice控件对象，用来选择三维图形对象的三个切片面的坐



标数值。以上程序代码比较简单，只是涉及一些图形句柄的语句，这

里就不重复介绍了。

将以上程序代码保存为“slicecontrols.m”，其主要功能就是创建图
形界面中的Slice控件对象。

step 5
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，然
后在M文件编辑器中输入以下代码：

以上程序代码的功能是在图形界面的底部创建一个关于ISO的控
件，当选择该控件中的某个数值的时候，可以设置图形界面中的ISO
的属性数值。将以上程序代码保存为“isocontrols.m”文件，它将在后面
步骤中被调用。



step 6
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，输
入以下代码：







以上程序代码的主要功能是，依次创建各种图形对象，包括Slice
控件、ISO控件、下拉菜单选项等，该程序代码将是绘制Slice对象的
最 主 要 的 程 序 内 容 。 最 后 ， 将 这 段 程 序 代 码 保 存

为“setvolumerange.m”文件。

17.2.5 处理指针对象



在本例中，指针是一个特殊的对象。指针的主要功能是显示用户

的操作选择。本小节将主要演示如何编写和处理指针对象。

step 1
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，输
入以下代码：







以上程序代码的功能是设置不同情况下光标指针的形状，通过设

置“PointerShapeData”属性，程序代码设置了不同的指针形状。在
MATLAB中，“PointerShapeData”属性表示定义了16×16个像素组成的
光标指针形状，该矩阵的元素只能选择1、2和NAN三种数值。其中，
数值1代表的是黑色，数值2代表的是白色，NAN表示的是透明颜色。
最后，将这段代码保存为“setpointer.m”文件。

step 2
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，输
入以下代码：



这段代码的功能是显示光标指针的尖端部分，之所以编写以上程

序代码，是为了当用户使用鼠标选择相应的对象时，显示光标提示内

容。最后，将这段代码保存为“showarrowtip.m”文件。

step 3
单击命令窗口工具栏中的 按钮，或者选择菜单栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，输
入以下代码：



这段代码的主要功能是，返回当前图形对象的箭头对象和切面对

象，之所以编写以上程序代码，其目的在于根据当前图形中的箭头对

象信息进行操作。最后，将这段代码保存为“getarrowslice.m”文件。

17.2.6 设置图形对象的属性

本实例最核心的功能是设置图形对象的各种属性，为此需要编写

对应的各种代码，具体操作步骤如下。

step 1
单击命令窗口工具栏中的 按钮，打开一个空白的M文件编辑

器，输入以下代码：



这段代码的主要功能是，显示某个数据组中的对象属性数值。然

后，将以上程序代码保存为“popset.m”文件。

step 2
单击命令窗口工具栏中的 按钮，打开一个空白的M文件编辑

器，输入以下代码：

这段代码的主要功能是，设置新的对象属性数值，为了便于在后

面程序中调用该代码，将以上程序代码保存为“pushset.m”文件。

step 3
单击命令窗口工具栏中的 按钮，打开一个空白的M文件编辑

器，输入以下代码：



这段代码的主要功能是，检查图形对象是否包含某项属性值。然

后，将该程序代码保存为“propcheck.m”文件。

step 4
单击命令窗口工具栏中的 按钮，打开一个空白的M文件编辑

器，输入以下代码：



这段代码的主要功能是，设置图形对象的属性值，和MATLAB内
置的set函数功能类似，只是一次只能为某个图形对象设置单个属性
值。将以上程序代码保存为“slowset.m”文件。



step 5
单击命令窗口工具栏中的 按钮，打开一个空白的M文件编辑

器，输入以下代码：

这段代码的功能是，重新设置三维图形数据的数值范围。当运行

以上程序代码时，MATLAB会显示一个新的图形界面，提示用户输入
新的图形位置参数。

17.2.7 编写主程序代码

前面已经完成了GUI各组件代码的编写。本小节中，将详细讲解
如何编写该GUI的主程序代码。

step 1
单击命令窗口工具栏中的 按钮，打开一个空白的M文件编辑

器，输入以下代码：



在前面的小节中，曾经专门编写过处理箭头指针对象的代码，但

是本实例中还需要对箭头进行其他的处理。在以上程序代码中，首先

根据箭头指针的移动方向来显示不同的箭头形状，然后创建块对象，

将箭头对象接触过的图形界面位置数据保存到块对象中。

step 2



在打开的M文件编辑器中，输入以下代码：

这段代码的功能是，为某个切面箭头创建当前设置，同时显示对

应切面的控件数值。

step 3
在打开的M文件编辑器中，输入以下代码：





这段代码的功能是，在绘制的切面图上添加等高线。熟悉

MATLAB的用户也许想知道，为何没有使用CONTOURSLICE的内置
函数。这是因为，该程序代码处理的Slice截面并不是通过使用
MATLAB通用代码绘制的Slice截面。

step 4



在打开的M文件编辑器中，输入以下代码：

上面程序代码的功能是处理Isosurface的各种属性，具体分析如
下：



 
◆ 在MATLAB中，Isosurface表示的是在某数值体积内每个顶点

所在地方数值相等的表面，该曲面和等高线有些类似，因为这两种曲

面都是表示数值相等的位置。

◆ 当需要确定某个三维空间内取得某临界值（threshold value）
的数值范围，或者需要判断某三维空间内数据分布情况时，Isosurface
曲面是相当有用的，需要提醒读者注意的是，该三维数据空间必须是

有限的。

◆ 在MATLAB中，创建Isosurface曲面的常见命令是isosurface和
patch命令，而求解Isosurface曲面法线的命令是isonormals。因此，在
以上程序代码中，首先使用isosurface命令创建该Isosurface曲面，然后
设置曲面的表面颜色（facecolor）和边缘颜色（edgecolor）属性，最
后使用isonormals命令创建Isosurface曲面的法线。

说明

为了减少整个程序代码的运行时间，在以上程序代码中使用了reducepatch命令将创建

的“块”对象的表面数目减少到1000个，关于该命令的详细使用方法，请参阅MATLAB的帮助

文件。

step 5
在打开的M文件编辑器中，输入以下代码：



这段代码的功能是处理Isocap的各种属性。在MATLAB中，Isocap
表示的是在Isosurface曲面的空间限制平面，这些平面组成了Isosurface



曲面的空间范围。Isocap提供了Isosurface曲面内部空间的横截面视
角。

说明

在MATLAB中，通常使用isocaps命令来创建Isocap的数据，然后将该数据传递给patch命

令，创建出Isocap对象。和Isosurface曲面类似，Isocap对象在MATLAB中都属于patch对象，可

以对其设置所有patch相关的属性。

step 6
在打开的M文件编辑器中，输入以下代码：







在以上程序代码中，首先判断Slice截面的数目，然后将截面数据
转换为二维数据，最后，使用surface命令来创建表面对象，并设置该



表面对象的各种属性，主要设置的是图形对象的照明属性和透明属

性，具体的程序代码就不详细解释了，请读者自行分析和运行。

step 7
在打开的M文件编辑器中，输入以下代码：



以上程序代码的主要功能是将正常的切片图和质地处理过的切片

图进行转换。在MATLAB中，材质贴图（Texture mapping）是将一个



二维图像映射到三维图像的重要手段，其程序代码将颜色数据进行转

换，一次可以转换到平面图形中。

说明

在这些图形转换方法中，可以选择某种图形材质，例如森林、谷类等，将这些材质添加

到表面对象中，而无须进行任何的几何运算，关于该材质命令的具体使用方法请查阅相应的

帮助文件。

step 8
在打开的M文件编辑器中，输入以下代码：

以上程序中，使用findobj命令来返回所有标签为sliceomaticslice、
sliceomaticisosurface和sliceomaticisocap的“块”对象的句柄。

step 9
在打开的M文件编辑器中，输入以下代码：



在这段代码中，首先使用程序语句设置光标的属性，然后通过前

面步骤返回的对象句柄设置图形对象的属性，以上程序代码并不复

杂，请读者自行分析。



step 10
在打开的M文件编辑器中，输入以下代码：



在以上程序代码中，首先设置了箭头光标的属性，然后将光标分

为Slice截面选取光标和ISO颜色系统选取光标来分别设置属性对象。

step 11
在打开的M文件编辑器中，输入以下代码：



























上面程序是该GUI对象的主程序代码，因此显得比较冗长，但是
并不复杂，结构也十分清晰。首先调用sliceomaticsetdata函数为图形对
象准备数据，然后调用sliceomaticfigure命令绘制主要的GUI界面和主



要控件，然后根据sliceomaticfigure中各个参数的不同取值，来调用对
应的函数命令，因此，可以看到以上程序代码中存在着大量的case…
end和if…elseif…end循环分支结构。

说明

限于篇幅，关于各循环结构中程序代码的具体含义，在本小节中就不详细介绍了，请读

者自行分析。当完成了以上所有程序后，将代码保存为“sliceomatic.m”文件，该文件将是GUI

对象的主要程序代码。

17.2.8 设置GUI对象的菜单选项

从关于GUI功能的介绍中可以看出，本实例中设置了多个菜单选
项。用户选择对应的菜单选项，可以完成多种功能。下面详细讲解设

置菜单选项的步骤。

step 1
在打开的M文件编辑器中，输入以下代码：

以上程序代码功能是，通过fileparts命令获取M文件的路径名称，
然后使用fullfile命令还返回完整的文件名称。

说明

在MATLAB中，fileparts命令的功能是返回M文件的部分名称，其完整的调用方式为

[pathstr,name,ext,versn] = fileparts('filename')，其中pathstr表示文件保存路径，name表示文件名

称，ext表示文件后缀。



step 2
在打开的M文件编辑器中，输入以下代码：

以上程序代码功能是覆盖用户自行设置的对象属性，在程序代码

的开始，首先加载文件中的数据，然后设置图形界面中的对象属性。

step 3



在打开的M文件编辑器中，输入以下代码：

以上程序代码设置的是该GUI对象保存文件的属性，当用户在程
序代码中调用该程序时，将会直接设置所有的保存信息。

step 4
在打开的M文件编辑器中，输入以下代码：



以上程序代码的主要功能是设置“Controls”菜单选项的各种属性，
首先设置照明工具栏和注释工具栏中的按钮的检录属性“checked”的数
值。在MATLAB中，菜单选项的检录属性的取值有两个：on和off。默



认情况下，菜单选项的“checked”属性数值为“off”，不会显示检录符；
当其属性的数值为“on”时，如果用户选中该菜单选项，其选项就会出
现“√”标记。在本实例中，“Controls”菜单选项的主要功能是控制工具
栏的显示选项和图形对象的控制选项（透明度设置）等。

step 5
在打开的M文件编辑器中，输入以下代码：



这段代码的主要功能是设置“Object_Defaults”菜单选项的各种属
性，在本GUI实例中，“Object_Defaults”菜单选项提供用户设置Slice截
面的颜色、透明度、Isosurface曲面的光照和等高线的颜色等属性。可



以选择对应的菜单选项，来设置这些图形对象的默认属性。当用户选

中对应选项后，其选项就会出现“√”标记。

step 6
在打开的M文件编辑器中，输入以下代码：





这段代码的主要功能是设置关于Slice属性的快捷菜单选项，可以
设置Slice截面的颜色、透明度、照明处理、线宽等属性。代码的结构
并不复杂，因此请读者自行分析其代码含义。

step 7
在打开的M文件编辑器中，输入以下代码：



代码的主要功能是设置Isosurface曲面属性的快捷菜单选项，可以
设置该曲面的光照属性等。

step 8
在打开的M文件编辑器中，输入以下代码：











代码的主要功能是设置GUI图形界面的所有菜单选项，包括了菜
单栏菜单选项、各种快捷菜单等，使用的命令就是uimenu命令。最
后，将本小节中的程序代码保存为“figmenus.m”文件。

17.2.9 检测程序代码

在本小节中，将详细讲解如何检测前面设置的程序代码。由于本

GUI的功能较多，本例中，将选择几个重要的功能进行测试。

step 1



在MATLAB的命令窗口中输入以下命令：

step 2
查看图形结果。输入以上命令，然后按“Enter”键，会显示以下内

容：

同时，MATLAB会显示出程序代码的默认GUI图形界面，如图
17.19所示。

图17.19 默认的GUI图形界面

step 3
选择切片图的Z向坐标。在以上GUI图形界面中，可以使用鼠标选

择相应的切片面的Z向坐标数值，得到的结果如图17.20所示。



图17.20 选择切面Z向坐标

说明

从图17.20可以看出，当在“Z Slice”控件中选择Slice截面的Z坐标数值时，“Z Slice”控件的

对应坐标数值上会显示“箭头”光标对象，同时，在三维图形界面中显示以虚线表示的Slice截

面。

step 4
查看切片面结果。当选定了对应的Z向坐标后，单击鼠标右键，

在“Z Slice”控件中会显示出“箭头”光标对象，同时可以绘制出截面图
形，如图17.21所示。



图17.21 绘制Slice截面

说明

当没有设置截面的相关属性（色图系统、透明度）等时，程序代码会根据默认属性绘制

该截面对象，可以使用工具栏或者菜单来修改这些属性。

step 5
选择其他坐标轴向的切面。重复以上步骤，可以选择Slice截面的

X、Y和Z向坐标，来绘制各个方向的Slice截面，得到的结果如图17.22
所示。



图17.22 选择其他方向的截面

step 6
修改绘制图形的“colormap”属性。当绘制了各个方向的截面后，

现在可以选择“colormap”下拉菜单中的选项，修改其色图颜色。在本
步骤中选择的选项是“hot”，得到的结果如图17.23所示。



图17.23 修改图形对象的色图颜色

step 7
修改绘制图形的“Alphamap”属性。可以选择“AlphaMap”下拉菜单

中的选项修改图形对象的透明度属性。在本例中选择的透明度类型

为“vdown”选项，得到的结果如图17.24所示。



图17.24 修改图形对象的透明度属性

step 8
修改图形对象的视角。单击“照明”工具栏中的相关按钮，修改图

形对象的视角，得到的结果如图17.25所示。



图17.25 修改图形对象的视角

step 9
添加Isosurface曲面。选择“Iso Surface Controller”中的对应坐标数

值，单击鼠标左键，在该坐标数值中添加Isosurface曲面，得到的结果
如图17.26所示。



图17.26 添加Isosurface曲面

说明

为了方便后续步骤的操作，在添加Isosurface曲面之前，通过使用“照明”工具栏中的相关

按钮将图形的坐标轴转换为默认的三维坐标。

step 10
删除Isosurface曲面。选择上面添加的Isosurface曲面，然后单击鼠

标右键，在弹出的快捷菜单中选择 “Delete”选项，删除添加的
Isosurface曲面，如图17.27所示。



图17.27 删除Isosurface曲面

step 11
查看删除曲面后的图形。当用户选择了菜单选项后，就可以删除

该Isosurface曲面，得到的结果如图17.28所示。



图17.28 删除曲面后的图形对象

step 12
修改Slice截面的颜色属性。选择图形界面中的“AllSlices”→“Color

Faceted”选项，设置Slice截面的颜色属性，得到的结果如图17.29所
示。



图17.29 修改Slice截面的颜色属性

step 13
在Slice截面上添加等高线。选择Slice图形，然后单击鼠标右键，

在弹出的快捷菜单中选择“Add Contour”→“Auto（Slice）”选项，如图
17.30所示。



图17.30 添加等高线

说明

为了能够在后面的步骤中更好地显示等高线，将上面步骤中修改的颜色属性改为默认的

属性，这样才能正常显示等高线。

step 14
查看图形结果。选择以上菜单选项后，得到的结果如图17.31所

示。



图17.31 添加等高线后的图形界面

step 15
删除等高线。选择Slice图形，然后单击鼠标右键，在弹出的快捷

菜单中选择“Remove Contour”→“Auto（Slice）”选项，删除上面步骤
中添加的等高线，如图17.32所示。



图17.32 删除等高线

step 16
单击命令窗口工具栏中的 按钮，或者选择编辑栏中

的“File”→“New”→“M-file”命令，打开一个空白的M文件编辑器，输
入以下代码：



这段代码的主要功能是编写产生三维数据的函数blinnblob，该函
数可以产生绘制图形的多维数据。最后，将以上程序代码保存

为“blinnblob.m”文件。

step 17
单击命令窗口工具栏中的 按钮，打开一个空白的M文件编辑

器，输入以下代码：



代码的主要功能是根据blinnblob函数产生的三维数据，调用前面
步骤中编写的sliceomatic函数绘制Slice截面。最后，将以上程序代码
保存为“slicebucky.m”文件。

step 18
在MATLAB的命令窗口中输入如以下代码：

系统会显示以下信息：

step 19
查看图形结果。输入以上程序代码后，按“Enter”键，然后可以在

其中选择截面的坐标，如图17.33所示。



图17.33 绘制Slice截面

step 20
修改Isosurface曲面的数值。在“Iso Surface Contorller”控件中选择

对应的数值，添加Isosurface曲面，得到的结果如图17.34所示。



图17.34 添加Isosurface曲面

说明

可采用类似的方法设置该GUI对象的其他图形对象，并设置相应的图形属性，这里不重

复介绍了。

17.3 小结

在本章中，主要介绍了如何向图形用户界面添加控件，并为控件

添加对应的功能代码。最后，结合一个比较复杂的案例，讲解了如何

设计GUI，添加控件、菜单等选项，最后还讲解了如何测试GUI等。

◆   ◆   ◆
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第18章 Simulink基础知识

本章包括

◆Simulink的数据类型

◆Simulink的基础操作

◆Simulink的信号

◆Simulink的属性设置

 
在MATLAB中，Simulink是用来建模、仿真和分析动态多维系统

的交互工具。可以使用标准模型库或者自行创建模型库来描述、模

拟、评价和精化系统行为。同时，Simulink和MATLAB之间的联系十
分便捷，可以使用一个灵活的操作系统和应用广泛的分析和设计工

具。最后，除了可以使用Simulink建模和仿真之外，还可以通过其他
软件包产品来完成更多的分析任务。

在本章中，首先使用一个例子来说明Simulink的仿真创建过程，
然后介绍Simulink的工作环境和常见工具。由于Simulink的内容比较繁
多，在本章将主要介绍关于Simulink的基础知识。

18.1 Simulink概述

Simulink是一个复杂的应用系统，为了便于更直观地了解Simulink
的使用方法和操作界面，在本节中将首先介绍关于Simulink的一些基
础知识，包括Simulink概述和安装知识、创建方法等。
和MATLAB的其他组件（有时也会被称为软件包）相比，

Simulink的一个突出特点就是它完全支持图形用户界面（GUI），这样



就极大地方便了用户的操作。用户只需进行简单的拖拉操作就可以构

造出复杂的仿真模型，它的外观以方块图形的形式来呈现，而且采用

分层结构。从建模的角度来看，这种方法可以让用户将主要的精力放

在具有创造性的算法和模块结构的设计上，而不用将精力放在算法的

实现上。从分析研究的角度来看，Simulink模型可以让用户知道具体
环节的动态细节，而且还可以让用户清晰地了解到各系统组件、各子

系统、各系统之间的信息交换。

在Simulink环境中，可以观察到现实世界中摩擦、风阻等非线性
或者随机因素对系统行为的影响，同时可以在仿真过程中改变需要观

察的参数数值，观察系统行为的变化。这样，用户就可以摆脱复杂的

数学推演和烦琐的程序代码，直接探索各种因素的影响。

在MATLAB 7.0中，可以直接在Simulink环境中运行的工具包很
多，包括了通信、控制、信号、电力等各个领域，所涉及的内容也比

较广泛和专业。合理地使用这些工具包中的内容，就可以创建出各种

复杂的仿真模型，实现各种复杂的功能。在本章后面的部分内容中，

将会涉及这些工具包的内容，在对应的地方将进行详细介绍。

鉴于Simulink的实质功能，本章节的内容必定会涉及物理、信
号、控制或者工程等知识，为了能够让读者了解到Simulink的使用方
法，本章会在对应的部分对这些知识做必要的解释，希望读者可以在

了解背景知识的前提下体验到Simulink仿真的真实和精妙。

18.1.1 安装Simulink

在本书的第 1章中，已经介绍过如何安装MATLAB，而在
MATLAB中，Simulink是一个重要的组件，因此在第1章介绍的安装过
程中已经安装了关于Simulink的基础组件。如果要更加全面地了解
Simulink的应用方法，还需要安装Simulink的相关组件。插入MATLAB



7.0的光盘，启动安装程序，然后选择自定义安装方法，进入文件选择
对话框，选择需要安装的组件，如图18.1所示。

图18.1 选择安装Simulink的相关组件

为了更好地了解本章的内容，需要选择安装如下Simulink组件：
 
◆ Signal Processing Toolbox
◆ SimMechanics
◆ SimPowerSystems
◆ Simulink Accelerator
◆ Simulink Contorl Design
◆ Stateflow
◆ Real-Time Workshop
◆ Virtual Reality Toolbox
 
不需要担心以上组件会重复安装，如果已经在上一次的安装过程

中安装了某个组件，而在本次安装过程中再次选择安装该组件，



MATLAB会显示如图18.2所示的提示。

图18.2 显示覆盖某组件

系统提示用户在上一次的安装过程中已经安装了某些MATLAB组
件，这次是否将这些组件进行覆盖，如果希望重新安装这些组件，单

击“Yes to All”按钮；或者单击“Cancel”按钮后，返回到选择安装组件
的对话框，取消选中这些软件组件，再选择安装。

18.1.2 启动Simulink

作为MATLAB的重要组件，可以使用多种方法来启动Simulink。
其中，最简单的方法就是直接单击MATLAB命令窗口中的Simulink按
钮，如图18.3所示。



图18.3 使用按钮启动Simulink

除此之外，还可以使用下面两种方法：

 
◆ 在MATLAB的命令窗口中输入命令“>> Simulink”。
◆ 选择MATLAB菜单栏中的“File”→“New”→“Model”命令。
 
使用上面任何一种方式，都可以打开“Simulink Library Browser”对

话框，在该对话框中可以选择查看各种Simulink模块，如图18.4所示。



图18.4 Simulink模块库浏览器

在“Simulink Library Browser”对话框中，可以浏览Simulink的常用
模块，也可以创建新的模型，打开已经创建的模块等，因此，该对话

框可以认为是Simulink操作的基础版块，在后面的章节中将详细介绍
该对话框的使用方法。

提示

如果使用 “File”→“New”→“Model”命令来打开 Simulink系统，MATLAB除了会显

示“Simulink Library Browser”对话框之外，还会显示新建模块的窗口，在后面的章节中将详细

介绍该窗口。



18.2 一个简单的仿真系统

本节将首先介绍一个简单的仿真系统，演示创建Simulink仿真系
统的典型过程。这个例子只涉及了使用Simulink创建仿真系统的一般
过程，具体细节将在后面详细讲解。

18.2.1 添加模块

为了让读者直观地了解Simulink的使用方法，在本小节中将使用
一个比较简单的实例来说明Simulink的创建过程和步骤。
例18.1 添加新的Simulink模块。

step 1
单击“Simulink Library Browser”对话框中的 按钮，或者选择菜

单栏中的“File”→“New”→“Model”命令，打开一个空白模型窗口，如
图18.5所示。

图18.5 新建模型窗口



step 2
选择“Chirp Signal”信号源。选择左窗格的“Sources”模块库，然后

在右窗格中选择“Chirp Signal”模块，如图18.6所示。

图18.6 选择“Chirp Signal”信号源

提示

当在“Simulink Library Browser”对话框中选择相应的信号源后，在对话框的上半部分就会

显示关于该信号的基础介绍，可以通过这些基础的介绍来大致了解该信号的内容。

step 3
添加“Chirp Signal”信号源。选中“Chirp Signal”模块，然后按下鼠

标左键，将其拖到拖动到新建模型窗口中，如图18.7所示。



图18.7 添加“Chirp Signal”信号

step 4
查看添加的“Chirp Signal”信号源。当选择了添加的合适位置后，

松开鼠标左键，在对应的位置就会显示用户添加的信号模块，如图

18.8所示。

图18.8 添加信号模块

说明



当用户向模型窗口中添加了模块后，对话框的名称由“untitled”变为“untitled*”，同时，所

添加的模型块也会采用默认的设置和大小，可以根据需要修改这些属性。

18.2.2 设置模块属性

在Simulink中，除了可以添加模块，还可以设置模块的外观和运
算属性。外观属性很好理解，就是指模块的外表颜色或者文本标志

等。运算属性主要是指仿真的各种参数等。本小节将延续前面小节的

步骤，演示如何设置模块的属性。

例18.2 设置模块的属性。

step 1
编辑“Chirp Signal”模块的外观属性。选中“Chirp Signal”模块，当

模块出现对应的模块柄后，按下鼠标并进行拖动，改变模块大小；然

后选择菜单栏中的“Format”→“Background Color”→“Green”命令，将模
块的背景颜色设置为绿色，如图18.9所示。



图18.9 设置模块的外观属性

step 2
设置“Chirp Signal”模块的参数。双击模块窗口的“Chirp Signal”模

块，打开“Block Parameters:Chirp Signal”对话框，设置该模块对应的参
数，如图18.10所示。



图18.10 设置模块参数

提示

对于不同的程序模块，MATLAB会显示不同的参数对话框，可以设置各参数的数值。同

时，对于不同的模块，MATLAB都会设置不同的默认参数数值。

step 3
添加“Sine Wave”模块。重复以上步骤，向模块窗口中添加“Sine

Wave”模块，并设置模块的外观属性，得到的结果如图18.11所示。



图18.11 添加“Sine Wave”程序模块

step 4
设置“Sine Wave”模块的属性，并查看相应的帮助文件。双击上面

步骤中添加的“Sine Wave”模块，在打开的对话框中设置参数，然后单
击该对话框中的“Help”按钮，查看关于正弦函数的帮助文件，如图
18.12所示。



图18.12 设置模块的属性

step 5
添加数学运算符模块，并设置相应的属性。选择“Simulink Library

Browser”对话框左窗格的“Math Operations”模块库，然后在右窗格中选
择“Add”模块，向模块窗口中添加该模块，并设置其外观属性，得到
的结果如图18.13所示。



图18.13 添加数学运算符

step 6
添加显示屏模块，并设置其相应的属性。选择“Simulink Library

Browser”对话框左窗格的 “Sinks”模块库，然后在右窗格中选
择“Scope”模块，向模块窗口中添加该模块，并设置其外观属性，得到
的结果如图18.14所示。



图18.14 添加显示屏模块

18.2.3 连接模块

在Simulink中，各个模块之间都需要相互关联，一个孤立的模块
不能完成仿真。同时，在Simulink中，模块之间的连接关系就相当于
是运算关系。本小节中，需要计算的是使用“chirp”信号和正弦函数信
号叠加后的信号波形。因此，两个信号模块之间的连接关系应该是加

号。在本小节中，将详细讲解如何连接已经添加的模块。

例18.3 连接Simulink的功能模块。

step 1



连接程序模块。将鼠标指向“Chirp Signal”模块的右侧输出端，当
光标变成十字符时，按住鼠标左键，将其移到“Add”模块的左侧的数
步输入端，如图18.15所示。

图18.15 连接程序模块

step 2
连接其他程序模块。可以使用上面步骤中的方法，连接其他的程

序模块，然后调整各模块的相对位置，得到的结果如图18.16所示。



图18.16 完成连接的程序模块

说明

模块是MATLAB中进行建模的基本单元，可以对其进行复制、移动、旋转等基本操作，

来修改其对应的外观属性。对于连接线，可以产生水平、垂直、斜向的连接线，也可以产生

曲折、分支的连接线等。

18.2.4 运行仿真系统

Simulink仿真的最后一步就是运行前面的仿真系统。具体操作步
骤如下。

例18.4 运行前面小节创建的仿真系统。

step 1
查看仿真结果。单击模型窗口中“仿真启动”图标，或者选择菜单

栏中的“Simulink”→“Start”命令，进行模型的仿真，然后双击模型块中
的“Scope”图标，查看叠加后的信号波形，如图18.17所示。



图18.17 查看仿真结果

step 2
修改仿真显示的结果。单击“Scope”对话框中的“自动刻度”图标，

将波形充满整个坐标框，如图18.18所示。

图18.18 修改仿真显示的结果



step 3
修改仿真的参数。在默认的情况下，模型仿真的时间是10s，可以

修改该仿真时间，例如，改为20s，重新进行仿真。得到的仿真结果如
图18.19所示。

图18.19 修改仿真参数

18.3 Simulink的工作环境

前面已经介绍过，当用户启动Simulink后，将会打开“Simulink
Library Browser”对话框，该对话框将是用户创建Simulink模型的主要
环境，下面详细介绍该工作环境的主要功能。首先，启动Simulink，
打开“Simulink Library Browser”对话框，如图18.20所示。可以使用工



具栏中的按钮对Simulink模型进行设置，对应的工具栏如图18.21所
示。

图18.20 “Simulink Library Browser”对话框

图18.21 对话框的工具栏

将工具栏中的按钮依次命名为1～4，下面详细介绍工具栏对应按
钮的功能：

 
◆ 1号按钮：标准的Windows工具菜单，表示新建一个Simulink

模型。

◆ 2号按钮：标准的Windows工具菜单，表示打开一个已经创建
的Simulink模型。



◆ 3号按钮：将Simulink的“Simulink Library Browser”对话框设置
在桌面的最高层。

◆ 4号按钮：进行关键词查找。可以在其后面的关键词填写框中
输入模块的关键词，MATLAB将会在对应的路径中进行查找。

 
由于模块查找是比较重要的使用方法，下面以查找包含关键

词“clock”的模块为例，演示如何使用该项功能，如图18.22所示。

图18.22 模块搜索

在关键词填写栏中输入“clock”之后，MATLAB便会在指定的模型
库中进行查找，当查找到模块之后，会将该模块突出显示，并给出对

应的说明。如果查找的结果多于1个，可以连续单击“查找”按钮，依次
循环查看找到的多个结果。



提示

如果在指定的模块库中没有查找到包含关键词的模块，MATLAB会在“Simulink Library

Browser”对话框的文字说明区中加以说明。

 
除了工具栏之外，“Simulink Library Browser”对话框中的模型库总

览表和子目录对用户创建Simulink模型也是十分重要的内容。其中，
模块库总览表位于对话框中的左侧，具有很好的层次结构，具体介绍

如下：

 
◆ 第一层是Simulink模块组，其中包括了Simulink、Aerospace

Blockset、Communication Blockset、Control System Toolbox等多个模块
组，该模块组中包含的模块个数取决于用户安装的组件。

◆  第二层内容包含的是子模块库，以SimMechanics模块组为
例，其包含了Bodies、Constrants&Drivers、Force Elements、Joints、
Sensors &Actuators和Utilities等6个子模块库。

提示

如果在第二层子模块库中，对应的模块前面还有“＋”标记，表明在该子模块库中，还包

含了下一层的子模块库内容。

18.3.1 Simulink模型窗口界面

在Simulink中，除了“Simulink Library Browser”对话框之外，还提
供了空白模型窗口，可以在该窗口界面中对Simulink进行必要的操
作。在本小节中，以MATLAB 7.0提供的“f14.mdl”文件为例，介绍模



型窗口的使用方法。首先，需要打开demo文件夹目录下的“f14.mdl”文
件，如图18.23所示。

图18.23 Simulink模型窗口界面

图18.23所示的对话框只是“模型框”的单窗口形式，单击“Toggle
Model Browser”按钮可以切换到双窗口形式，在双窗口形式中，左侧
窗口是“Model Browser”，显示该模型的分层子系统目录，右侧窗口显
示相应系统的连接图，如图18.24所示。

图18.24 双窗口形式



从这个简单的对话框可以看出，Simulink中的模型窗的基础组成
部分是：菜单栏、工具栏、编辑框和状态栏，下面将详细介绍这些组

成部分的功能。

其中，模型窗的工具栏如图18.25所示。

图18.25 模型窗的工具栏

将工具栏中的按钮从左到右依次命名为1、2……11按钮，数值框
1，下拉菜单1等，下面依次介绍各自的功能：

 
◆ 按钮1～7：Windows的标准按钮，对应的功能就是Windows操

作系统之下的功能，依次为新建、打开、保存、打印、剪切、复制和

粘贴。

◆ 按钮8：撤销上一个操作步骤。
◆ 按钮9：返回上一个操作步骤。
◆ 按钮10：开始仿真按钮，用户单击该按钮，就可以开始整个

系统的仿真。

◆ 按钮11：停止仿真。用户单击该按钮，就可以停止整个系统
的仿真。

◆ 数值框1：设置仿真时间。默认情况下，该数值为10.0。
◆ 下拉菜单1：设置仿真的加速模式。MATLAB提供了Normal、

Accelerator和External三种仿真加速模式，可以根据需要选择对应的加
速模式。

◆ 按钮12：准备系统的仿真。
◆ 按钮13：产生RTW程序代码。
◆ 按钮14：刷新整个系统。
◆ 按钮15：更新整个系统。



◆ 按钮16：为子系统产生程序代码。
◆ 按钮17：显示Simulink的模块库浏览器。
◆ 按钮18：打开模块管理器。
◆ 按钮19：打开或者隐藏模型浏览器。
◆ 按钮20：转到上一级系统中。
◆ 按钮21：打开调试器。

说明

这个工具栏中的各个按钮并不会在同一个时间内全部有效，对于不同的Simulink对象，

MATLAB会启用不同的工具栏按钮。

 
在模型窗口的状态栏中，会显示整个仿真系统的状态，以图18.24

为例，从左到右的文字的含义依次如下：

 
◆ Ready：表示模型已经准备就绪，等待系统的仿真命令。
◆ 100%：表示编辑框的显示比例。
◆ ode45：表示仿真选用的积分算法是“ode45”。

说明

除了这些参数，当用户在进行模型仿真的时候，在状态栏的其他空白处还会出现对应的

动态仿真信息。

 
在MATLAB的模型窗口界面中，多数主要的功能都是通过该界面

对应的菜单选项来实现的，因此下面将详细介绍各菜单选项的主要功

能，为了节省篇幅，在介绍菜单选项功能的时候，将不介绍Windows
标准菜单的功能。



18.3.2 使用“File”菜单

“File”菜单的主要选项以及对应的功能如表18.1所示。

表18.1 “File”菜单选项和功能

对于其他子菜单的功能，在本小节中就不详细介绍了，只介绍生

成模型报告文件的方法。还是以以上实例为例，可以选择菜单栏中

的“File”→“Print Details”命令，打开“Print Details-f14”对话框，可以在
该对话框中设定相应的报告参数，然后单击“Print”按钮，如图18.26所
示。



图18.26 生成模型报告文件

18.3.3 使用“Edit”菜单

“Edit”菜单的主要选项以及对应的功能如表18.2所示。

表18.2 “Edit”菜单选项和功能



提示

在以上菜单选项中，当涉及子系统的操作时，用户必须选中对应的子系统才能激活该选

项，例如“Mask Subsystem”选项；当涉及模块的操作时，用户必须选中对应的模块才能激活对

应的选项，例如“Block Properties”选项。

 
由于大部分的菜单选项都必须选中各自的对象，因此在本小节中

还是以以上实例为例，介绍“Find”菜单的对应使用方法。在Simulink的
模型窗口中，当用户选择“Find”菜单选项后，会打开对应的“Find”对话
框，在该对话框中可以搜索各种常见的对象。选择菜单栏中

的“Edit”→“Find”命令，打开“Find：f14”对话框，如图18.27所示。



图18.27 搜索对话框

可以在 “Filter options”面板设置搜索的模式，然后在 “Search
criteria”面板中输入搜索的关键词，如果搜索的系统包含多个系统或者
子系统，则需要在“Start in system”下拉菜单中选择搜索范围。最后，
在“Match case”选项框中选择搜索匹配方式，然后单击“Find”按钮，进
行搜索，如图18.28所示。

图18.28 搜索结果

从搜索结果中，取消选中“Stateflow objects”选项，选择“Match
whole word”的Match方式，选中“Look inside masked systems”选框，在
以上搜索方式下关键词“Gain”的搜索结果只有两个。保持以上关键词
不变，修改各个搜索参数，可以查看新的搜索结果，如图18.29所示。



图18.29 修改搜索条件

从以上搜索结果可以看出，保持“Gain”关键词不变，修改搜索条
件后，得到的搜索结果就会发生很大的变化，结果有13个。

18.3.4 使用“View”菜单

“View”菜单的主要选项以及对应的功能如表18.3所示。

表18.3 “View”菜单选项和功能

在模块资源管理器中查看模块的参数设置、仿真参数设置、解法

器选择、模块的各种信息等，选择菜单选项 “View”→“Model
Explorer”命令，打开“Model Explorer”对话框，如图18.30所示。



图18.30 模型资源管理器

在 “Model Explorer” 对 话 框 中 ， 包 含 了 “Model
Hierarchy”、“Contents”和“Model Properties”三个主要面板，同时包含
一个主要工具栏和搜索工具栏。在“Model Hierarchy”面板中，主要显
示了Simulink模块的树形体系结构，主要体系结构的节点包括Simulink
Root、Base Workspace和Model Nodes等，可以在该面板中查看对应对
象的各种属性。

在 “Contents”面板中将会用列表的形式显示用户在 “Model
Hierarchy”面板中选择的对象的属性，或者显示用户在搜索工具栏中查
询的结果。例如，在本例中可以选择“Aircraft Dynamics Model”选项，
查看对应的属性内容，如图18.31所示。



图18.31 查看对象的属性内容

提示

在“Contents”面板中显示的对象属性内容取决于用户在“Model Hierarchy”面板中选择的对

象类型，如果选择的是模型或者子系统，在默认情况下，“Contents”面板中将会显示该模型或

者子系统所包含的高层模块的名称或者类型。

 
除了默认的“Contents”面板之外，MATLAB还提供了自定义内容

面板，可以使用自定义面板来设置显示属性的内容选项。选择“Model
Explorer”对话框中的“View”→“Customize Contents”命令，在默认的显
示面板中添加“Customize Contents”面板，可以在其中选择显示的属性
内容，如图18.32所示。



图18.32 显示“Customize Contents”面板

这 个 面 板 只 选 择 显 示 各 个 对 象 的 Name 、 MaskType 、
TreatAsAutomaticUnit和Priority属性，因此在右侧的“Contents”面板中
只显示了这些属性数值。

18.3.5 使用“Simulation”菜单

和前面的菜单选项相比，Simulation菜单所包含的选项比较简单，
Start菜单选项表示开始运行仿真系统，Stop菜单选项表示停止仿真系
统，“Configuration Parameters”菜单选项则表示设置仿真参数和选择解
法 器 。 选 择 “Simulation”→“Configuration Parameters” 命 令 ， 打
开“Configuration Parameters：f14/Configuration”对话框，如图18.33所
示。



图18.33 仿真参数对话框

在仿真参数对话框中，主要包含了Solver、Data Import/Export、
Optimization 、 Diagnostics 、 Hardware Implementation 和 Model
Referencing等面板，可以在对应的面板中设置仿真的各种参数数值。

18.3.6 使用“Help”菜单

“Help”菜单的主要选项以及对应的功能如表18.4所示。

表18.4 “Help”菜单选项和功能



选择“Help”→“Block Support Table”命令，查看模块支持的数据类
型，如图18.34所示。

图18.34 模型所支持的数据类型

18.4 Simulink中的数据类型

熟悉编程语言的读者对“数据类型”的概念应该不会陌生，数据类
型直接决定了系统分配给不同变量的存储空间，也决定了程序运算的

精度范围和性能等。MATLAB也是一种程序语言，因此也需要设置
Simulink中信号和模块参数的数据类型。
实质上，Simulink在进行整个系统的仿真之前和仿真过程中都会

进行一个额外的数据类型检查，这种检查是系统自行完成的，用户无



须为此编写专门的程序代码。这种数据类型的检查也可以认为是模型

的安全性检测。这种检测可以确保整个模型（或者被称为系统）产生

的程序代码不会出现上溢或者下溢，不至于产生一些不精确的程序结

果。

最后，在Simulink中，默认的数据类型是Double，如果没有特别
指出模型的数据类型，一般都将是Double数据类型。

18.4.1 Simulink支持的数据类型

作为MATLAB的重要组件，Simulink支持MATLAB中所有的内置
数据类型，所谓的内置数据类型是指MATLAB自行定义的数据类型。
为了帮助读者理解Simulink支持的数据类型，表18.5列出了内置数据类
型。

表18.5 MATLAB的内置数据类型

除了表18.5中列出的内置数据类型，Simulink还专门定义了
Boolean数据类型，取值为0和1，其内部数据类型为Uint18（无符号的
18位整数）。绝大多数的Simulink模型的数据类型都是默认的Double
类型，有些模块需要Boolean数据类型，还有一些模块支持多数据的输
入或者复数信号等。

对于一个已经完成的Simulink模块，可以使用多种方法来查看模
块或者信号所支持的数据类型。在一个完整的Simulink仿真系统中，
如果希望了解某单个模块所支持的数据类型，可以双击该模块，打开



对应的模块参数设置对话框，在其中查看数据类型。还是以前一小节

中的“f14.mdl”文件为例，双击其中的“Nz Pilot”模块，在打开的模块参
数对话框中选择“Signal specification”选项卡，如图18.35所示。

图18.35 查看模块所支持的数据类型

提示

如果在打开的参数对话框中没有特别指出该模块支持的数据类型，就表明该模块只支持

默认的Double数据类型。

 
如果希望一次查看多个模块的输入/输出数据类型，选择菜单栏中

的“Format”→“Prot/Signal Displays”→“Prot Data Types”命令，查看各模
块的输入/输出数据类型，结果如图18.36所示。



图18.36 查看各模块的数据类型

当选择了对应的菜单选项后，在模型窗口中会在各个模块的输入

口和输出口中显示参数的数据类型。除了可以查看各个对象的数据类

型之外，还可以为各个对象设置数据类型，输入的格式为

Type(value)，还是以前一小节的实例为例，可以修改模块中对应的输
入数值，如图18.37所示。



图18.37 设置模块参数的数值

在模块参数对话框中，在Noise power文本框中输入“single(5.1)”，
将模块的参数设置为5.1的单精度浮点数据类型。如果模块不支持用户
设定的数据类型，那么MATLAB会弹出相应的警告信息。

18.4.2 数据传递

一般情况下，Simulink系统中会包含多个数据模块和信号模块，
而且在仿真过程中，各个不同的模块之间会不断地实现数据传递，但

是这些不同类型的模块所支持的数据类型往往不完全相同。如果使用

信号线相连的两个模块所支持的数据类型有冲突，当用户进行模块仿

真的时候，MATLAB在查看端口数据类型或者更新数据类型时会弹出



提示对话框，提示用户出现冲突的信号和端口，同时，这些有冲突的

信号路径会高亮显示。

在实际建模过程中输入信号的数据类型和模块的数据类型往往是

不同的，Simulink在计算过程中会将参数类型转换为信号的数据类
型。但是，并不是所有的情况都会自动转换，当信号的数据类型无法

表示参数数值时，将会自动中断仿真，并给出错误信息。

例18.5 使用简单的数学算例演示Simulink的数据类型转换规则。

step 1
打开Simulink的空白模板编辑器，向其中添加“Constant”数值模

块，将其数值设置为2.5，同时打开其参数管理器，将其数据类型选择
为“Boolean”，如图18.38所示。

图18.38 添加参数模块并设置属性

step 2
添加下一个常数数值模块，将其数值设置为1.5，然后将其输出的

数据类型设置为“Boolean”，得到的结果如图18.39所示。



图18.39 添加下一个参数模块

提示

为了使模块在外观上更加美观，将上面两个常熟数值模块的背景颜色设置为粉红色。

step 3
添加运算模块。为了演示上面模块中的数学运算过程，向模块中

添加加法、积分运算模块，然后添加“Scope”模块，如图18.40所示。

图18.40 添加的模块系统

step 4



进行系统仿真。单击空白模块界面中的“开始仿真”按钮，将系统
进行仿真，得到的提示对话框如图18.41所示。

图18.41 错误提示信息

在错误提示对话框中，系统提示了信息“Only 'double' signals are
accepted by type Integrator. The signals at the ports of 'untitled/Integrator'
are of data type 'boolean'”，表示“Integrator”模块只接受“double”数据类
型，而在本仿真系统中， “Integrator”模块输入数据的数据类型
是“Boolean”，Simulink无法在这两种数据类型之间实现转换，因此提
示用户发生了数据类型的错误，并在模块界面中高亮显示错误

的“Integrator”模块，如图18.42所示。

图18.42 高亮显示错误模块



step 5
修改仿真系统。为了能够修改这个仿真系统，需要在“常数”模块

和“加法”模块中间添加“Commonly Used Blocks”模块库下的“Data Type
Conversion”模块，实现数据转换，并设置该数据模块的属性，如图
18.43所示。

图18.43 添加数据转换模块

在“Block Parameters: Data Type Conversion”对话框中，将模块的输
出数据类型设置为“double”，这样就可以将Boolean数据类型转换为
Double数据类型，然后将这些数据进行叠加，最后进行积分。

说明

在Simulink中，“Data Type Conversion”模块的主要功能就是将输入数据的数据类型转换为

指定的数据类型，但是数据转换并不能保证原始数据不变，因此在使用这个模块时需要谨

慎。

step 6



查看仿真结果。在修改了仿真模块之后，就可以进行系统仿真，

结果如图18.44所示。

图18.44 查看仿真结果

说明

从仿真结果可以看出，积分结果是“y=2x”，而不是“y=4x”，这就表明尽管使用了“Data

Type Conversion”模块，但是转换结果是1或者0，而不是原始的常数模块中的数值2.5和1.5，

两个模块转换的数值结果都是1。

18.4.3 向量化模块

在Simulink模块库中几乎所有模块都是向量化的模块（Blocks
Vectorized），向量化模块的输入量和输出量之间的关系是符合数学规
则的向量关系。向量信号是多个信号的集合，对应着模块窗口中几条

并行连线的合成。在默认情况下，Simulink中大多数的模块输出数据



是标量信号，当输入的是向量信号，而模块的参数类型是标量时，

Simulink会进行自动匹配。
例18.6 使信号模块输出向量信号。

step 1
打开新的空白模型界面，在其中添加“Chirp Signal”信号，然后双

击该信号模块，打开对应的参数设置器，在其中设置信号的参数，如

图18.45所示。

图18.45 设置模块的属性

在参数设置对话框的“Initial frequency”文本框中输入向量“[0.1
0.4]”，在“Target time”文本框中输入向量“[100 250]”，在“Frequency at
target time”文本框中输入向量“[1 2]”，然后单击“OK”按钮，完成向量
的输入。

说明



在Simulink中，“Chirp Signal”模块的输出数是一个线性信号，该信号是一个频率随着时间

线性变化的正弦波形。

step 2
向该模块添加“Scope”模块，然后运行仿真，再双击“Scope”模

块，查看仿真结果，如图18.46所示。

图18.46 查看仿真结果

提示

在该实例中，模块中所有参数都是按照向量元素的位置和信号对应的，不存在着向量的

匹配问题，因此在输入向量参数的时候需要注意这种匹配关系。

18.4.4 使用Mux模块

在Simulink中，Mux模块的功能是将输入参量转换为一个单个输
出数据，该模块接受的输入参量包括标量、向量或者矩阵信号，根据



输入参量的不同数据类型，其输出数据结果可能是一个向量或者复合

信号（例如，包括矩阵和向量的复合信号）。在本小节中，将结合具

体例子讲解如何使用Mux模块。
例18.7 使用“Mux”模块输出向量信号。

step 1
打开新的空白模型界面，在其中添加“Chirp Signal”信号，然后双

击该信号模块，打开对应的参数设置器，在其中设置信号的参数，如

图18.47所示。

图18.47 添加“Chirp Signal”信号

step 2
在其中添加“Sine Wave”信号，然后双击该信号模块，打开对应的

参数设置器，在其中设置信号的参数，如图18.48所示。



图18.48 添加“Sine Wave”信号

step 3
添加“Mux”模块，将上面两个信号模块进行向量化处理，然后添

加“Scope”模块，显示向量化处理的结果，如图18.49所示。

图18.49 添加“Mux”模块



step 4
设置“Mux”模块的属性。在MATLAB中，可以设置“Mux”模块的

属性包括输入数据的数目和显示的数据类型，双击系统中的“Mux”模
块，得到的参数对话框如图18.50所示。

图18.50 设置“Mux”模块的属性

step 5
查看仿真的结果。单击模块界面中的“开始仿真”按钮，然后双

击“Scope”模块查看仿真的结果，如图18.51所示。



图18.51 查看仿真结果

从本实例中可以看出，用户使用了两个标量输入信号：Chirp波
w（t）和正弦波s（t），经过“复用”模块的处理，得到的结果是一个

向量波形

说明

之所以分别设置两个波形的频率属性，是为了在最后的步骤中将两个波形差开显示，使

得结果更加明显。

18.4.5 标量扩展

MATLAB还提供了标量扩展（Scalar expansion）功能，该功能具
体就是向量化模块执行符合正则运算所必须具备的自适应能力。标量

扩展包含的内容为输入的标量扩展和参数标量扩展，下面举例详细说

明这些用法。



例18.8 通过“乘/除”模块来显示输入扩展功能。

step 1
打 开 新 的 空 白 模 型 界 面 ， 在 其 中 添 加 “Signal

Generator”和“Constant”模块，然后双击“Signal Generator”模块，打开
参数设置器，设置信号的参数，如图18.52所示。

图18.52 添加“Signal Generator”模块

step 2
添加“Divide”模块和“Scope”模块，如图18.53所示。

图18.53 添加程序模块



step 3
单击模块界面中的“开始仿真”按钮，然后双击“Scope”模块，查看

仿真的结果，如图18.54所示。

图18.54 查看仿真结果

说明

在该实例中，“Signal Generator”模块产生了一个向量信号，然后使用乘法模块将向量信号

结果同时乘以0.5，得到最后的信号结果。

18.5 Simulink的基本操作

前面章节中已经介绍了关于Simulink的操作界面和数据类型，从
本节开始，将介绍如何创建Simulink模型，由于Simulink可以创建各种
复杂的系统，所以将主要介绍创建Simulink模型中共用的知识和操
作。



18.5.1 Simulink模型的工作原理

尽管Simulink系统为用户屏蔽了许多烦琐的编程工作，似乎用户
不需要了解Simulink的基础工作原理，但是，如果深入了解Simulink的
基础原理，就可以更加高效灵活地使用Simulink模型。创建Simulink模
型的基本步骤包括创建模型图标和控制系统仿真，但是用户对模型的

图标之间的映射关系以及Simulink如何利用这种映射关系进行仿真，
可能还是比较陌生，在本小节中将简要介绍这些基本内容。

一般来讲，系统或者模型的当前数值或者产出，都是某个临时变

量原来数值的函数，这些临时变量就是所谓的 “状态 ”数值。当
Simulink从某个模型的图形化模块系统中计算结果的时候，首先需要
保存当前时间步骤中变量的数值，然后以此为基础计算变量后续数

值。Simulink通过模拟定义状态的模块来完成以上步骤。
其中，系统状态随时间而变化的函数关系（也可以称为数学模

型）是由一系列数学方程式来描述的，每一个模块都代表一组数学方

程组，Simulink称这些方程组为模型的方法。图18.55代表了定义状态
的系统模块的图形原理。

图18.55 模块的图形化形式

从宏观上来看，Simulink模型通常包括三种组件：信号源、系统
和信号接收器（或者称为信宿）。其中信号源可以是常数、正弦波、

阶梯波等，信号接收器则可以是示波器或者图形记录仪等。这三种组

件可以直接从Simulink的模型库中获取，也可以使用提供的模型自行
创建系统。



提示

并不是所有的Simulink模型都包括这三个组件，用于研究初始条件对系统影响的Simulink

模型就不必包含信号源组件。

 
Simulink对模型系统进行仿真的过程，也就是在用户定义的时间

段内根据模型提供的信息计算系统的状态和输出的过程。大致来讲，

Simulink的仿真过程可以分为模型编译阶段、连接阶段和仿真环阶段
等三个阶段，每个阶段都会完成该阶段的任务。其中，模型编译阶段

的主要任务包括调用模型编译器，将模型编译成为可以执行的形式，

详细的任务列表如下：

 
◆ 评价模型参数的表达式并确定它们的数值。
◆ 确定信号的属性。
◆ 传递信号属性并确定没有定义的信号属性。
◆ 对系统模块进行优化。
◆ 展开模型的继承关系。
◆ 确定模型运行的优先级。
◆ 确定模块的采样时间。
 
连接阶段的主要任务包括创建按照执行的次序安排的方法运行列

表，同时定位和初始化存储在每个模块的信息。

仿真环阶段主要分为两个部分，第一个阶段是仿真环初始化阶

段，这个阶段只运行一次，主要用于初始化系统的状态和输出；第二

个阶段是仿真环迭代阶段，该阶段在定义的时间段内每隔一个时间步

就重复运行一次，用于在每一个时间步计算模型的新输入、输出和状

态。



18.5.2 操作模块

模块是创建Simulink模型的基础元素，用合适的方式把各种不同
的模块连接在一起就可以创建出各种动态系统。

在详细介绍如何操作模块之前，首先介绍一个使用技巧。为了更

加了解模块的属性和特征，可以设置属性，当用户使用鼠标在模块上

方移动时，Simulink显示关于该模块的基本属性信息。至于需要显示
哪些属性，可以通过模块界面中的“View”菜单下的“Block data tips”菜
单选项来设置，下面举例来详细说明。

例18.9 设置模块显示的属性选项。

step 1
打开保存过的“Sim4”文件，然后选择菜单栏中的“View”→“Block

Data Tips Options”→“Parameter Names And Values”命令，如图18.56所
示。

图18.56 设置模块显示的属性选项

step 2



查看模块的属性。完成以上设置之后，将鼠标移到“Sine Wave”模
块，系统会显示对应的属性和数值，如图18.57所示。

图18.57 显示模块的属性和数值

step 3
打开新的模块文件。在以上操作界面中，打开一个新的模块文

件“Sim2”，查看对应的菜单选项属性设置，如图18.58所示。

图18.58 查看新文件的显示属性

说明



可以看出，对于不同的文件，该属性显示的选项在默认情况下是不会被选中的，对于不

同的文件需要重新设置该属性。

 
除了这些小技巧，还可以对模块进行各种操作，例如复制、移

动、旋转等，对于这些操作，一般都可以使用多种方法来实现，在本

小节中只是提供一些比较常用或者比较便捷的操作方法，其他的方法

请读者自行尝试。

18.5.3 显示模块的属性

对于比较复杂的模块系统，如果能够直接在模块下方显示模块的

属性数值，可以大大加强该系统的可读性和交流程度。为此，可以选

中对应的模块，然后打开“Block Properties”对话框，在其中设置“Block
Annotation”的属性数值。下面使用一个简单的实例来说明如何完成这
种设置。

例18.10 在模块的下方显示模块的属性数值。

step 1
打开保存过的“Sim5”文件，然后选择该模型系统中的“Signal

Generator”模块，单击鼠标右键，在弹出的快捷菜单中选择“Block
Properties”菜单选项，如图18.59所示。



图18.59 选择打开模块属性对话框的命令

step 2
查看模块属性对话框。选择该菜单选项后，系统会显示默认的模

块属性对话框，如图18.60所示。



图18.60 默认的模块属性对话框

step 3
设置显示属性的数值。选择对话框中的“Block Annotation”选项

卡，然后在 “Enter text and tokens for annotation”选框下面输入文
字 “Amplitude=%<amplitude>Frequency =%<frequency>” ， 单

击“Apply”按钮，如图18.61所示。



图18.61 设置显示属性的选项

step 4
查看设置后的模块。将相应的属性选项设置完成后，单击“OK”按

钮，关闭模块属性对话框，然后查看设置完成后的模块，如图18.62所
示。

图18.62 设置完成后的模块



说明

可以看出，当设置了在模块下方显示的属性数值选项后，在模块的下方就会显示对应的

属性名称和数值。关于设置选项的语法，感兴趣的读者可以查阅相应的帮助文件。

18.5.4 显示输出数值

在Simulink中，允许用户在运行模块的时候，在模块图标的上方
显示仿真的模块输出结果的数值。设置的方法十分简单，下面以一个

简单的案例来演示这种方法。

例18.11 显示模块在仿真过程中的结果数值。

step 1
打开保存过的“Sim5”文件，然后单击模型界面菜单栏中的 按

钮，设置显示模块运行的输出结果，如图18.63所示。

图18.63 设置显示模块运行的输出结果

step 2



查看用户设置的结果。完成以上设置之后，将鼠标移动到“Signal
Generator”模块上方，得到的结果如图18.64所示。

图18.64 查看设置的结果

step 3
设 置 显 示 选 项 。 选 择 菜 单 栏 中 的 “View”→“Port

Values”→“Options”命令，系统会显示 “Sim5- Block Output Display
Options”对话框，可以在该对话框中设置关于显示选项的属性，如图
18.65所示。

图18.65 设置显示选项

说明

如果希望加大显示文字的大小，可以使用鼠标将光标在“Font size”滚动条上向右移动；为

了提高Simulink更新文字的速度，可以使用鼠标将光标在“Refresh interval”滚动条上向右移

动。



18.5.5 连接线的分支

在Simulink中，连接线的主要功能是连接各种信号和模块，因此
有时候连接线也会被称为信号线。用户在连接模块的时候，需要特别

注意的是模块的输出、输入段和各模块之间的信号流向。关于连接线

的常用操作包括设置连接线的方向、宽度、颜色、标识等主要内容，

可以根据需要为Simulink系统模块中的连接线设置各种属性，下面详
细介绍。

在某些复杂的仿真系统中，一个信号往往需要分送到不同模型的

多个输入端口，此时就需要在该Simulink系统中绘制分支线（Branch
line）。和连接线的其他绘制方法相比，分支线的绘制过程比较复杂，
大致可以分为下面几个步骤：将光标指向分支线的起点，该起点就是

某个信号线上的某个点；按下鼠标右键，用户将会看到光标变成十字

形状，拖动鼠标，直到分支线的终点处，松开鼠标，完成分支线的绘

制。

为了让读者能够更加直观地了解连接线的分支概念，选择

MATLAB中自带的Demo文件“ifsub.mdl”，在该文件中部分系统出现了
分支，如图18.66所示。



图18.66 Simulink中的分支结构

图中高亮显示的就是一个分支结构，从“Sine Wave”信号源中输出
的信号有四个流向，其中两个直接和上面两个“Mux”模块相连，其他
两个则和程序模块相连，因此在创建的系统模块中，使用了连接线的

分支结构。

说明

为了更好地说明连接线的分支结构，选择了包含分支节点的连接线，然后单击鼠标右

键，在弹出的快捷菜单中选择“Highlight to Destination”选项，将这部分的连接线高亮显示。

18.5.6 彩色显示信号线

在Simulink所创建的离散系统中，允许用户采用多种采样频率，
如果希望了解采用不同采样频率的模块以及信号线，可以为各个采样

频率不同的信号线设置不同的颜色，这样，用户就可以十分直观地查

看系统的频率。以MATLAB自带的“enabsubs.mdl”文件为例，来说明如
何使用彩色来显示信号线，如图18.67所示。



图18.67 彩色显示信号线

选择菜单栏中的“Format”→“Port/Signal Displays”→“Sample Time
Color”命令后，Simulink会自动根据用户设置的频率大小来使用不同的
颜色来显示信号线和模块。

18.5.7 设置连接线的属性

作为Simulink中的一个重要组件，可以像其他组件一样，设置连
接线的属性，选中某个连接线，然后单击鼠标右键，在弹出的快捷菜

单中选择“Signal Parameters”命令，就可以打开该条连接线的属性对话
框。

还是以MATLAB自带的“busdemo.mdl”文件为例，选择该模型中的
某条连接线，打开对应的属性对话框，如图18.68所示。



图18.68 设置连接线的属性

说明

关于连接线的具体属性内容，这里就不详细展开介绍了，感兴趣的读者可以自行查阅相

应的帮助文件。

18.6 Simulink的信号

在Simulink中，信号被定义为动态系统的输出，这些动态系统由
Simulink图形化系统中的模块来表示。Simulink结构图中的连接线代表
了由模块图标定义的信号之间的数学关系，例如，连接模块A的输出
端和模块B输入端的连接线代表模块B的输出量取决于模块A的输出
量。也就是说，Simulink中的信号间的关系是建立在数学上的，代表
的是数学逻辑关系，而不是图标所显示的外观物理上的联系。

当心

笔者曾经阅读过关于MATLAB的Simulink的一个比喻，将Simulink中的信号比喻为沿着电

话线传输的电子信号，这种比喻似乎比较形象，但是笔者并不认同这种比喻，因为这种比喻

会误导读者，认为Simulink中的信号之间的关系是物理关系，而不是逻辑关系。



18.6.1 创建信号

在Simulink中，信号是一个完整而且复杂的系统内容，在详细介
绍各种类型的信号之前，首先介绍关于信号的基础知识，以便读者对

信号有个直观的了解。

可以直接使用模块库中的模块来创建自己的信号。例如，用户也

许需要创建一个随着时间正弦变化的某种信号，直接从Simulink模块
库中选择Sine模块添加到用户创建的模型中。除了使用这种方法之
外，还可以使用“Signal & Scope Manager”对话框来创建自己的信号系
统，而不使用Simulink提供的模块库中的信号。

说明

“Signal & Scope Manager”对话框，在用户使用信号、创建信号的过程当中会经常用到，

将在后面章节中详细介绍。

18.6.2 添加信号标签

和连接线类似，可以为信号添加标签来代表信号内容。如果信号

是“Virtual Signal”，而且其对应的“Show propagated signals”属性被选
中，则该信号的标签显示的是组成该信号的所有信号的名称。可以打

开某个信号的“Signal Properties”对话框，然后在其中为信号添加标
签。

当某个信号已经包含了标签后，可以直接选中该标签，输入新的

标签名称，然后按“Enter”键，完成名称的修改。下面以MATLAB自带
的“busdemo.mdl”文件为例，可以为添加在模型中的“Chirp Signal”信号
添加名称，如图18.69所示。



图18.69 添加信号标签

18.6.3 复数信号

在Simulink中使用的信号在默认情况下都是实数，但在实际情况
中用户经常需要处理复数信号。在Simulink中通常使用以下方法来处
理复数信号的模型：

 
◆ 向模型中添加一个Constant（常数）模块，将其参数设置为复

数。

◆ 分别生成复数的虚部和实部，然后使用Real-Imag to Complex
模块将这些部分复合为一个复数对象。

◆  分别生成复数的幅值和幅角，然后使用Magnitude-Angle to
Complex模块将这些部分复合为一个复数对象。

 
例18.12 在Simulink中处理复数信号。



step 1
打开空白模型窗口界面，然后向模块窗口中添加以下模块，使用

不同的方法来创建复数，如图18.70所示。

图18.70 使用不同的方法来创建复数信号

提示

在这个复数处理模块中，分别显示了复数的各个参数，可以使用这种参数来分别处理参

数，在Magnitude-Angle to Complex模块中，||表示的是复数的模，∠则表示复数的幅角，这两

个参数不能混淆。

step 2
将复数信号再次转换为实数信号。在模型窗口中依次添加

Complex to Real-Imag和Complex to Magnitude-Angle模块，将合成的复
数信号转换为实数信号，如图18.71所示。



图18.71 转换为实数信号

18.6.4 虚拟信号

虚拟信号是使用图形来代表其他信号的一个信号，在Simulink中
的某些模块，例如Bus Creator、Inport和Outport blocks等都可以产生虚
拟信号。虚拟信号完全是图形化的实体，没有数学或者逻辑上的作

用，当Simulink在进行系统仿真的时候会直接忽略它们。当用户运行
或者更新模型时，系统会使用信号传播来直接确定该虚拟信号代表的

信号实体，这样就可以保证整个系统的正常运行。以上介绍文字比较

抽象，下面使用一个简单的实例来说明虚拟信号的概念。

例18.13 使用一个简单的案例来演示虚拟信号的概念。

step 1
打开空白模型窗口界面，向窗口界面中添加“常数”模块，然后添

加Bus Creator、Bus Selector等虚拟信号模块和增益模块，最后添
加“Display”模块，如图18.72所示。



图18.72 添加虚拟信号模块

在这个程序系统模块中，添加了两个虚拟信号模块，得到的结果

和没有添加虚拟模块一样，分别将两个参数增益2倍或者3倍，得出最
后的增益数值。也就是说，以上模块系统和图18.73所示的模块系统效
果完全相同。

图18.73 清除虚拟信号后的系统

step 2
修改信号名称。双击系统中的“Bus Creator”模块，打开对应的对

话框，在其中修改信号的名称，如图18.74所示。



图18.74 修改信号的名称

step 3
修改信号输出的次序。双击系统中的“Bus Selector”模块，打开对

应的对话框，在其中修改信号输出的次序，如图18.75所示。



图18.75 修改信号输出的次序

说明

在默认情况下，“Bus Creator”模块输出信号的名称为signal1、signal2，为了让整个系统更

加简洁，将这两个名称分别改为S1、S2。

step 4
重新运行整个系统。完成以上修改后，单击对话框中的“OK”按

钮，关闭对话框，然后重新运行该仿真系统，得到的结果如图18.76所
示。

图18.76 重新运行系统



可以看出，当用户将“Bus Selector”虚拟模块的输出信号向量修改
以后，结果就发生了变化，得到的结果是常数1增益3得出3、常数2增
益2得出4。

提示

在Simulink中，虚拟信号模块可以代表虚拟信号或者非虚拟信号。例如，可以使用“Bus

Creator”模块来连接多个虚拟信号和非虚拟信号。

18.6.5 控制信号

在Simulink中，控制信号是指由控制其他模块执行的某个模块发
出的信号。例如，某个函数调用或者执行子系统。关于该信号的详细

内容将会在后面的章节中介绍，在这里以一个比较简单的实例来说明

控制信号的使用方法。

例18.14 使用While控制子系统，从1到自然数N的叠加和不超过
100的最大自然数。

step 1
打开空白模型窗口界面，然后向界面中添加各模块，得到的结果

如图18.77所示。

图18.77 添加While子系统



其中“Constant”模块表示的是叠加的最大数值100，“Constant1”模
块表示的是叠加的初始数值0。

step 2
设置关系表达式模块的属性。“Relational Operator”模块表示的是

最后关系中叠加数值不超过100，因此应该选择“<”。完成以上设置，
需要设置“Relational Operator”模块对应的参数属性，如图18.78所示。

图18.78 设置关系表达式

While Subsystem是本系统的核心模块，需要在后面的步骤中为其
添加对应的子系统。最后，在系统的最右侧，添加了“Display”模块，
显示该系统计算的结果。

step 3
双击“While Subsystem”模块，打开该子系统的编辑界面，然后在

其中添加该子系统的各模块，如图18.79所示。



图18.79 编写子系统的模块

step 4
设置“While Iterator”模块的属性。设置“While Iterator”模块的属性

的目的是有效地控制整个循环控制，打开模块属性对话框，在其中设

置参数数值，如图18.80所示。

图18.80 设置“While Iterator”模块的属性

在参数对话框中，“Maximum number of iterations”文本框中输入的
是“－1”，表示允许程序持续循环，直到关系条件为假。



step 5
设置“Memory”模块的属性。双击“Memory”模块，打开对应的模

块属性对话框，在其中设置属性，如图18.81所示。

图18.81 设置“Memory”模块的属性

step 6
运行整个仿真系统，得出仿真计算的结果。完成所有参数属性设

置后，单击模型界面中的“开始仿真”按钮，运行整个系统，得到的结
果如图18.82所示。

图18.82 得出仿真结果

从结果可以看出，结果为13，也就是说，13是从1到N的数值叠加
后总和小于100的最大自然数。这个结果可以使用简单的数学知识得到



验证：

根据数学知识， ，根据这个数学公式可

知，当n＝13的时候，其叠加求和为 。所

以就验证了程序代码结果是正确的。

step 7
修改程序的约束条件，重新运行仿真系统。将叠加求和的上限改

为300，然后重新运行仿真系统，得到的结果如图18.83所示。

图18.83 修改程序条件

熟悉编程的读者也许会想到，这个仿真系统的效用和以下程序代

码完全相同：

从演示过程可以看出，控制信号实质上在功能上相当于程序代

码，用好控制信号可以很方便地演示各种程序功能。

18.6.6 信号总线



在Simulink中，信号总线（Signal Buses）是指一个组合信号，该
信号由一束连接线所代表。在外观上，其相当于由包装带所捆绑的一

束电线。信号总线的组件可以包含不同的数据类型，同时其组件也可

以是复合信号。

在Simulink中，可以使用Bus Creator模块（或者Inport模块）来创
建信号总线，使用Bus Selector模块来接收信号总线，在Simulink的模
块库浏览器中，上面两个模块都被列在“Commonly Used Blocks”模块
库之下。在介绍“虚拟信号”的部分，曾经涉及“信号总线”对象，如图
18.84所示。

图18.84 信号总线对象

由于信号总线的输入信号比较复杂，如果希望直观地了解到某个

信 号 总 线 的 信 号 个 数 ， 可 以 选 中 该 总 线 对 象 ， 然 后 选

择“Format”→“Port/ Signal Displays”→“Signal Dimensions”命令，就可
以查看信号总线的组成信号个数，如图18.85所示。

图18.85 显示信号总线的信号个数



在详细介绍信号总线之前，有必要提醒读者：信号总线可能是虚

拟信号也可能不是虚拟信号。在系统进行仿真的过程中，和虚拟信号

总线相连的模块将会从分配给其组件信号的内存空间中读取输入变

量，这些组件信号一般会保存在不连续的内存空间中。与此不同的

是，和非虚拟信号总线相连的模块则从由Simulink保存的组件信号副
本中获取输入变量的数值，这些信号的信息被保存在MATLAB分配给
信号总线的连续内存空间中。

说明

在Simulink中，某些属性，例如模型引用，需要使用非虚拟信号模块，其他则需要使用虚

拟信号模块。

 
在Simulink中，使用Bus Creator和Inport模块创建的信号总线对象

在默认情况下是虚拟信号，如果创建非虚拟信号，则需要在其对应的

参数对话框中将其输出的属性设置为非虚拟。

提示

除了上面介绍的方法，还可以使用Signal Conversion模块在虚拟信号和非虚拟信号之间进

行转换。

 
在Simulink中，不是所有的信号模块都可以和信号总线相连，能

够和信号总线相连的模块是那些同时能够通过虚拟信号、非虚拟信号

的模块。所有的虚拟信号都可以和信号总线连接，同时，以下所有非

虚拟信号模块也可以和信号总线相连：

 
◆ Memory
◆ Merge



◆ Switch
◆ Multiport Switch
◆ Rate Transition
◆ Unit Delay
◆ Zero-Order Hold
 
一般情况下，Bus Creator模块是虚拟模块，因此该模块会接收信

号总线作为输入变量，但是，如果该模块处于条件执行状态或者子系

统状态下，或者其组件和某个子系统的输出端口直接相连，该模块是

非虚拟模块。在此情况下，只有其组件有相同的数据类型时，该模块

才能接收信号总线对象的数据。如果组件包含不同的数据类型，当用

户进行对应的仿真时，Simulink会中止仿真过程，并显示错误信息。
为了解决这个问题，需要添加“Signal Conversion”模块，进行信号数据
类型的转换，下面举例说明。

例18.15 演示信号总线的数据类型传递问题。

step 1
打开空白模型界面，然后在其中添加系统的模块，如图18.86所

示。



图18.86 添加程序系统的模块

step 2
修改模块的数据类型。在现有系统模块中，首先添加两

个“Constant”模块，为了演示信号总线的数据传递问题，将其中一个模
块的输出变量的数据类型改为“int16”，如图18.87所示。

图18.87 修改模块输出变量的属性

step 3
建立子系统模块。双击“Atomic Subsystem”模块，打开新的模块编

辑窗口，在其中建立对应的子系统模块，如图18.88所示。



图18.88 创建子系统模块

在图18.88所示模块中，将系统的两种输入变量分别进行对应的数
学计算，得到新的数值，之所以设计这样的模块结构，是为了在后面

的步骤中演示如何处理数据类型的冲突。

step 4
保存模型，运行仿真。保存上面步骤中设计的子系统，然后运行

系统的仿真，得到的系统提示如图18.89所示。

图18.89 系统提示的错误信息

根据系统提示信息可知，系统中止系统仿真的主要原因在于输入

变量的数据类型不能协调，而Bus Creator模块不能接收该混合数据类
型，因此系统不能进行数据传递，直接中止仿真过程。

step 5
单击“Close”按钮，返回到子系统模块界面中，添加信号转换模

块，如图18.90所示。



图18.90 添加信号转换模块

step 6
设置“Signal Conversion”模块的属性。双击该模块，打开对应的属

性对话框，将输出变量的数据类型设为“Bus copy”，如图18.91所示。

图18.91 设置信号转换模块的属性

step 7
设置“Gain”模块的“Fixed-Point”属性。选择“Gain”模块，然后选

择“Tools”→“Fixed-Point Settings”命令，打开“Fixed-Point Settings”对话
框，设置对应的属性选项，如图18.92所示。



图18.92 设置“Fixed-Point”属性

在“Fixed-Point Settings”对话框中，将模块的“Logging mode”属性
设置为“Force off”，然后将模块的“Data type override”属性设置为“True
doubles”。完成设置之后，可以重新运行该仿真系统，会发现Simulink
可以正常运行该系统。

说明

这个实例并没有得出实质的程序结果，只是为了演示信号总线之间的数据传递问题，关

于属性设置问题，将在后面的章节中详细介绍。

18.6.7 信号组

Simulink为用户提供了可以相互交换的信号组工具，用户只需
从“Sources”模块库中的“Signal Builder”模块，然后将其添加到新的模
块编辑器中，就可以创建出最简单的，也就是默认的信号组对象，创



建的系统模块如图18.93所示。双击“Scope”模块，就可以查看系统默
认的信号组，如图18.94所示。

图18.93 创建的系统模块

图18.94 查看默认的信号组

提示

可以看出，在默认情况下Simulink提供的信号是一个能够产生方形脉冲波的单个信号。

 
可以使用系统提供的“Signal Builder”对话框来完成信号的编辑工

作，包括添加新的信号、修改原有信号的属性、选择发生产出的信号

对象等。只需双击系统中的“Signal Builder”模块，就可以打开对应的
属性编辑器，如图18.95所示。



图18.95 信号组属性编辑器

在属性编辑器中，可以创建和编辑由“Signal Builder”模块创建的
信号组，其中包含了下面几个重要的控件：

 
◆ “Group”面板：在该面板中显示了该模块所代表的可交换的

信号源，该面板为每组信号显示了可以用于编辑的波形属性，该面板

的选项卡中显示了信号组的名称，在该面板中用户每次只能看到一组

信号。可以选择包含信号组名称的选项卡，来显示对应的信号组。同

时，模块将会输出在该面板中可见的信号信息。

◆ 信号坐标轴：在该信号组中，信号分别出现在独立的坐标轴
中，这些坐标轴拥有相同的时间轴。之所以设计成这样的坐标系统，

是为了方便用户比较不同信号随时间变化的情况。在 “Signal
Builder”对话框中，系统会为每组信号产生自适应的坐标系统，来显示
最佳的波形。可以使用“Signal Builder”对话框中的“坐标轴”菜单来修
改所选坐标轴的时间范围(T)和振幅(Y)的数值。



◆ 信号列表：该控件中显示了当前所选信号组的信号名称和可
见性。选择该列表中的某个条目就可以选中对应的信号，双击该条目

名称就可以在“Group”面板显示（或者隐藏）该信号的波形。
 
在“Signal Builder”对话框中，可以编辑信号组、编辑信号的各种

属性，完成这些编辑工作的操作都十分简单，这里就不详细介绍了。

下面主要介绍如何在该对话框中直接编辑信号的波形，为了简化说

明，还是以默认的信号组为例。

例18.16 显示如何编辑信号组对象。

step 1
打开系统默认的信号组对象的编辑对话框，然后使用鼠标在信号

波形的任意位置单击，选中该波形对象，此时对话框中会显示波形的

各个数据点，如图18.96所示。

图18.96 选中波形对象

说明

在“Signal Builder”对话框中，许多菜单选项只有在选中波形对象后，才会被激活，因此在

介绍如何编辑信号组对象之前，必须首先选中该波形对象。

step 2



设置Y坐标轴（振幅）网格线的属性。选中波形对象后，选择菜
单“Axes”→“Set Y snap grid”→“0.2”命令，将波形的Y轴单位网格数值
设置为0.2，如图18.97所示。

图18.97 设置振幅坐标轴的网格属性

在“Signal Builder”对话框中，每个波形坐标轴中都包含了一个无
形的网格线，来方便用户确定波形数据点的准确位置坐标，当系统生

成一个波形坐标轴的同时也会产生该网格线。当需要移动某个波形数

据点或者波形片段位置的时候，Signal Builder会将数据点或者片段移
动到网格线上的数据点上。

提示

在设置网格线的最小单位数值时，需要注意的是，当将网格线的最小单位设置得越精

细，用户就越容易移动波形片段或者数据点，但是就越难确定波形数据点的准确坐标数值。

因此，在设置最小单位网格线时需要谨慎。



step 3
设置T坐标轴（时间）网格线的属性。选中波形对象后，选择菜

单“Axes”→“Set T snap grid”→“0.1”命令，将波形的T轴单位网格数值
设置为0.1，如图18.98所示。

图18.98 设置时间轴的网格属性

说明

可以看出，在默认情况下，Y轴和T轴的网格线最小单位数值都是0，这样设置的目的在

于方便用户修改波形的位置。

step 4
上下移动波形片段。选中波形某个图形片段，然后使用鼠标将波

形图形片段上下移动，如图18.99所示。



图18.99 上下移动波形片段

step 5
左右移动波形片段。选中波形某个图形片段，然后使用鼠标将波

形图形片段左右移动，如图18.100所示。

图18.100 左右移动波形片段

由于在前面步骤中将波形的T轴单位网格数值设置为0.1，因此在
左右移动波形图形片段时，最小的移动单位就是0.1。从对话框的坐标
数值中可以看出，T的数值被改为4.1，这是最小的移动单位。

step 6
修改波形数据点的坐标数值。选中波形对象中某个数据点，然后

在以下坐标轴数值框中输入该数据点的坐标数值，如图18.101所示。



图18.101 修改数据点的坐标数值

step 7
修改波形的线型。选中波形图形，然后选择菜单栏中

的“Signal”→“Line style”→“Dashed-dotted”命令，修改该图形的线型为
点虚线类型，如图18.102所示。

图18.102 修改波形图形的线型

说明



在“Signal Builder”对话框中，如果希望选中某数据点，可以将鼠标移到该数据点上方，然

后单击鼠标左键，直到该数据点上出现圆圈为止。

step 8
修改波形的时间范围。选中波形图形，然后选择菜单栏中

的“Axes”→“Change time range”命令，打开“Set the total time range”对
话框，在其中设置波形的时间范围，如图18.103所示。

图18.103 设置波形的时间范围

step 9
将波形输出到工作空间中。选择菜单栏中的“File”→“Export to

workspace”命令，打开“Export to workspace”对话框，将波形输出到工
作空间中，如图18.104所示。

图18.104 将波形输出到工作空间中



step 10
添加新的信号。选择菜单栏中的 “Signal”→“New” →“Sampled

Gaussian noise”命令，打开“Add sampled Gaussian noise”对话框，在其
中设置Gaussian样本信号的频率、平均值和标准方差的数值，如图
18.105所示。

图18.105 添加新的信号对象

step 11
查看添加的信号。当单击“Add sampled Gaussian noise”对话框中

的“OK”按钮后，就可以在该编辑器中添加“Signal2”信号，如图18.106
所示。

图18.106 添加后的信号对象



step 12
删除原始的信号对象。在信号列表中选择“Signal1”，然后选择菜

单栏中的“Edit”→“Delete”命令，删除原来的信号对象，如图18.107所
示。

图18.107 删除原来的信号

step 13
查看删除后的信号对象。选择相应的菜单选项后，系统就会将原

来的信号删除，得到的结果如图18.108所示。

图18.108 删除后的信号



step 14
设置仿真参数。选择菜单栏中的“File”→“Simulation options”命

令，打开“Simulation Options”对话框，在其中设置仿真的参数，如图
18.109所示。

图18.109 设置仿真参数

在对话框中，将“Sample time”设置为0，表示Simulink的输出结果
是连续的图形，这也是系统的默认设置。单击对话框中的“OK”按钮，
完成设置。

step 15
查看仿真结果。返回到模型设计界面，单击“开始仿真”按钮，并

双击“Scope”模块，仿真结果如图18.110所示。



图18.110 查看连续的仿真结果

step 16
修 改 仿 真 参 数 。 返 回 到 Signal Builder 对 话 框 ， 选

择 “File”→“Simulation options”命令，打开 “Simulation Options”对话
框，修改仿真参数，如图18.111所示。

图18.111 修改仿真参数

step 17
查看仿真结果。返回到模型设计界面，单击“开始仿真”按钮，并

双击“Scope”模块，仿真结果如图18.112所示。



图18.112 显示离散的仿真结果

说明

Simulink还为“信号组”提供了多种其他的信号类型，例如，Possion random noise、

Triangle、Sampled sin等常见信号，读者可以自行了解这些信号的特征。

18.6.8 使用自定义信号源

除了使用前面所介绍的常用信号之外，还可以使用自定义的信号

源创建仿真系统。在Source模块库中提供了两种常用的模块：“From
File”和 “From Workspace”，来使用用户自行定义的信号源。其
中，“From File”模块将从MAT文件中获取信号矩阵，信号以行的方式
存放，第一行表示时间变量，其余每行存放的是信号序列；“From
Workspace”模块将从MATLAB的工作空间中指定的数组或者构架中读
取数据。

在“From Workspace”模块中，其“Data”参数指定了工作空间中的某
个变量或者表达式，该变量或者表达式代表了一个二维数据矩阵或者

是一个包含了信号数值和时间数值的构架变量。“From Workspace”模



块的图标会显示表达式中的“Data”参数数值。下面使用一个简单的例
子来说明如何使用该模块创建自定义信号。

 

例18.17 在Simulink中在[0，4π]范围内绘制函数 的图

形。

step 1
单击MATLAB命令窗口工具栏中的 按钮，打开M文件编辑器。

在M文件编辑器中输入以下程序代码：

在输入以上程序代码后，将其保存为“mysource.m”文件。

step 2
打开一个新的模型界面窗口，然后向其中添加模块，得到的结果

如图18.113所示。

图18.113 添加程序模块

step 3
设置“mysource”模块的参数。双击“mysource”模块，打开对应的

参数对话框，在“Data”数值框中输入“Ts”，如图18.114所示。



图18.114 设置模块的参数

step 4
在MATLAB的命令窗口中输入以下命令：

该代码在MATLAB的工作空间中添加Ts变量。

step 5
返回到模型界面中，设置仿真时间为“12”，然后单击“开始仿

真”按钮，进行系统的仿真，并双击“Scope”模块，查看仿真结果，如
图18.115所示。



图18.115 查看仿真的结果

step 6
在命令窗口中演示仿真结果。为了确定仿真的结果，可以在

MATLAB的命令窗口中绘制相应的函数图形，在命令窗口中输入以下
代码：

step 7
查看图形结果。输入代码后，按“Enter”键，得到的图形如图

18.116所示。



图18.116 命令窗口的结果

18.6.9 信号接收器

在前面的章节中，读者已经多次接触到各种Simulink仿真系统的
模块结构，其中常用的信号接收器包括Scope、Display和Terminator等
模块，可以根据需要选中合适的信号接收器。由于Scope（示波器）模
块是最常见的信号接收器模块，因此，在本小节中将详细介绍关于

Scope模块的基础知识。
在Simulink中，示波器的用途主要是用来接收向量信号，在仿真

过程中，示波器实时显示信号波形，但是该波形不能被直接打印或者

嵌入到文件中。无论示波器是否打开，只要用户运行仿真，示波器的

缓冲区就会接收送来的信号，该缓冲区中最多可以接收30多个信号，
它们以列的方式排列。

下面将以例18.17中的示波器为例，来说明如何编辑示波器。
例18.18 演示如何编辑示波器的属性。



step 1
设置纵坐标的属性。选中示波器，然后单击鼠标右键，在弹出的

快捷菜单中选择“Axes properties”命令，如图18.117所示。当选择了相
应的菜单选项后，Simulink会弹出相应的对话框，可以在对话框中设
置Y轴的上下限数值，如图18.118所示。

图18.117 设置示波器的坐标属性

图18.118 设置Y坐标轴的上下限

step 2
查看修改后的结果。单击“Apply”按钮后，应用以上属性设置，然

后单击“OK”按钮，关闭对话框，查看修改后的示波器模块，如图
18.119所示。



图18.119 修改后的显示情况

step 3
设置横坐标的属性。在示波器界面中，单击“Parameters”按钮，打

开示波器属性对话框，选择“General”选项卡，在其中设置坐标轴的属
性，如图18.120所示。

图18.120 设置横坐标的属性

下面详细介绍“General”选项卡中各选项的含义：
 
◆ “Time range”选框：该选框设置的是横坐标轴的刻度范围，

由于示波器显示的就是波形，因此横坐标轴就是时间轴，“Time
range”选框的默认数值为10，表示默认情况下Simulink显示的是区间



[0，10]的波形。可以根据需要修改其数值，例如在本例中选择的是
12。

◆ “Sampling”下拉菜单：该下拉菜单包含两个菜单选项：抽选
Decimation和采样时间Sample time。其中，Decimation选项用来设置显
示频度，如果选择n，则每隔n－1个数据点给予显示，默认数值为1；
Sample time选项则用来设置显示数据点的采样时间步长。默认数值为
0，表示的是显示连续信号；如果输入的数值为-1，则表示信号显示的
方式取决于输入的信号；如果输入的数值大于0，则显示离散信号。

 
设置完以上属性后，选择对话框中的“Data history”选项卡，在其

中设置关于信号数据的属性，如图18.121所示。

图18.121 设置信号数据属性

“Data history”选项卡中各选项的具体含义如下：
 
◆ Limit data points to last：设置缓冲区接收数据的长度。在默

认情况下，系统会选中该选项，同时将其数值设置为5000。如果输入
数据的长度大于这个数值，则更早的历史数据点会被系统清除。

◆ Save data to workspace：在默认情况下，该选项将不选中，
如果选中该选项，则将缓冲区中的数据送到工作空间中。可以自行设



定变量名称。

 
在本小节的最后，将介绍关于示波器的另外一个重要属性：游离

示波器。可以在示波器的“General”面板中选中“floating scope”复选
框，将Scope模块转换为游离示波器。游离示波器是可以显示多个信号
的Scope信号模块，下面以一个简单的实例来演示如何在Simulink中使
用游离示波器。

例18.19 演示如何在Simulink中使用游离示波器。

step 1
打开空白模型窗口界面，然后向界面中添加各模块，得到的结果

如图18.122所示。

图18.122 系统模块

step 2
将仿真的时间设置为“20”，单击“开始仿真”按钮，进行仿真，然

后双击以上“Scope”模块，查看仿真结果，如图18.123所示。



图18.123 查看仿真的结果

step 3
设置“Scope”模块的参数。打开Scope模块的参数设置对话框，将

其模块的坐标轴个数设置为“2”，如图18.124所示。

图18.124 设置坐标轴个数

step 4
返回到模块编辑界面，重新添加新的模块连接。由于上面步骤添

加了一个坐标轴，因此在模块编辑界面中“Scope”模块会多出一个连接
端口，将其和“Mux”模块连接起来，得到的结果如图18.125所示。



图18.125 重新连接模块

step 5
重新查看仿真结果。将仿真的时间设置为“20”，单击“开始仿

真”按钮，进行仿真，然后双击“Scope”模块，查看仿真结果，如图
18.126所示。

图18.126 查看新的仿真结果

step 6
将示波器转换为“游离示波器”。单击Scope模块中的“Floating

scope”按钮，将示波器转换为“游离示波器”，如图18.127所示。



图18.127 转换为游离示波器

step 7
打开“Signal Selector”对话框。选中第一个坐标系，然后单击鼠标

右键，在弹出的快捷菜单中选择“Signal selection”选项，如图18.128所
示。

图18.128 选择“Signal selection”选项

当 选 择 “Signal Selection” 选 项 后 ， Simulink 会 打 开 “Signal
Selector”对话框，在其中选择第一个坐标系统的显示波形，如图18.129
所示。



图18.129 选择第一个坐标轴中的波形

step 8
设置坐标轴的显示属性。在 “List contents”下拉菜单中选

择“Selected signals only”选项，如图18.130所示。

图18.130 设置显示选项

step 9



重新查看仿真结果。将仿真的时间设置为“20”，单击“开始仿
真”按钮，进行仿真，然后双击以上“Scope”模块，查看仿真结果，如
图18.131所示。

图18.131 新的仿真结果

说明

可以看出，如果设置只在“Axes1”中显示“Sine Wave”波形，那么在重新运行仿真后，在其

坐标轴中只显示正弦波形。

step 10
重复以上步骤，将“Axes2”坐标系统设置为只显示常数的波形，其

对应的“Signal Selector”参数对话框如图18.132所示。



图18.132 设置“Axes2”的信号属性

step 11
查看仿真结果。在设置信号属性后，运行仿真，得到的结果如图

18.133所示。

图18.133 显示新的仿真结果

18.7 Simulink仿真的设置



根据前面章节的介绍，读者也许已经发现，Simulink模型在本质
上就是一组计算机程序，它定义了描写仿真系统的一组微分或者差分

方程。当开始整个系统的仿真后，Simulink就开始使用一种数值求解
方法来求解方程。在进行系统仿真之前，如果不希望采用系统的默认

参数设置，就必须在运行仿真之前设置各种仿真参数。

在Simulink中，用户需要设置的仿真参数主要包括：起始时间和
终止时间、仿真步长、仿真容差、数值积分算法等，还可以设置系统

是否从外界获得数据、是否向外界传递数据等仿真参数。所有这些参

数都可以在“Configuration Parameters”对话框中完成设置，下面分小节
来详细介绍如何设置各种参数。

18.7.1 设置解算器参数

在设置仿真参数之前，首先需要打开“Configuration Parameters”对
话框，选择模型窗口中的“Simulation”→“Configuration Parameters”命
令，打开对话框，如图18.134所示。



图18.134 仿真参数对话框

在本小节中，将首先介绍如何设置解算器的参数数值。

在“Configuration Parameters”对话框的左侧选择“Solver”选项，对应
的“Solver”面板如图18.135所示。

图18.135 解算器参数设置面板

“Solver”面板各项参数的含义如下：
 
◆ Simulation time区域：可以在该区域设置系统仿真的起始时

间和终止时间，在默认情况下，系统的起始时间设置为0，终止时间为



10。可以在“Start time”选框中设置新的起始时间，在“Stop time”选框
中设置新的终止时间。

说明

可以直接在模块操作界面中设定终止时间，但是不能直接在该界面直接设定系统仿真的

起始时间。

 
◆ Solver options区域：可以在该区域中设置解算器的各种属

性。其中，在“Type”下拉菜单中可以选择解算器的类型。在Simulink
中，提供了两类解算器：固定步长（Fixed-Step）解算器和变步长
（Variable-Step）解算器，Simulink的默认设置是变步长的ode45。两
种解算器计算下一个仿真时间的方法都是在当前仿真时间上加上一个

时间步长。主要区别在于，固定步长解算器的时间步长是常数，而变

步长解算器的时间步长是根据模型动态特征来变化的。

提示

当系统模型的状态变化比较快时，为了保证计算精度必须降低时间步长；相反，如果模

型的状态变换比较慢时，则有必要增加时间步长。

 
这里根据笔者的经验给出选择不同类型的解算器的方法，当用户

希望通过自建模型生成代码并在实时计算系统中运行这些代码时，就

可以选择固定步长解算器来仿真模型，这样做的原因在于实时计算系

统会以固定的采样速率运行，若采用变步长将有可能使仿真发生错

误。

当用户不希望从模型生成代码时，解算器的选择将取决于模型的

动态特征。当模型的状态变化特别快或者包含有不连续状态时，选择



可变步长解算器可以缩短仿真时间。这是因为可变步长相对于固定步

长的解算器需要更少的时间，而且两者的计算精度相当。

当用户在“Type”下拉菜单中选择不同类型的解算器时，在其右侧
的“Solver”下拉菜单中会显示不同类型的解算器列表，表18.6列出了
Simulink中的定步长常见解算器。

表18.6 Simulink中的定步长解算器

最后将介绍默认的ode45计算方法特点，在Simulink中，默认的
Solver类型是变步长的ode45方法。之所以选择这些方法作为默认方
法，是因为这种解算器能在保证计算精度的前提下，使用尽可能大的

步长，能够排除积分步长和输出“解点”间隔之间的相互制约，可以不
必为获得光滑输出而设定很小的步长。

说明

关于该面板的其他属性，例如变步长解算器的步长、容差和输出设置等，都将在后面的

章节中详细介绍，这里就不展开分析了。

18.7.2 仿真数据的输入输出设置

在Simulink中，设置向MATLAB工作空间中输出模型仿真结果数
据或者设置从工作空间中读入仿真结果，也是属性设置的一个重要内

容。为了能够设置这方面的属性，用户需要在 “Configuration



Parameters”对话框的左侧选择“Data Import/Export”选项，在其右侧就
会显示“Data Import/Export”面板，如图18.136所示。

图18.136 数据输入/输出设置

在详细介绍该面板的功能时，首先有必要介绍Simulink的内状态
向量的相关知识。前面已经介绍过，Simulink模型可以认为是一组联
立的一阶微分或者差分方程。构成模型的传递函数模块、状态方程模

块、非线性模块等都会随着相应的状态变量而变化，因此就会引出状

态变量的存放（Access）问题，在Simulink中解决存放问题的方法就是
设置仿真数据的输入或者输出的属性。

提示

Simulink中提供了直接获取系统的状态向量的具体指令，可以从中获得详细的状态信息，

这些内容都在后面章节中详细介绍。

 
下面详细介绍该面板各选项的具体含义：

 
◆ Load from workspace区域，该区域主要包括“Input”和“Initial

state”两个复选框。
 



●Input复选框：如果在Simulink系统中选用了输入模块In，则必须
选中该选项，并需要填写在MATLAB工作空间中的输入数据变量名
称，例如[t，u]或者TU。如果输入模块中有n个，则u的第1、第2……
第n列分别送往输入模块In1、In2…In n。

●Initial state复选框：如果选中该复选框，则强迫系统模型从工作
空间中获取模型中所有内状态变量的初始数值，而不管构成该模型的

积分块是否设置过怎样的初始数值。该复选框所填写的变量名称应该

是工作空间中所存在的变量。

 
◆ Save to workspace区域，该区域主要包括Time、States、Output

和Final states复选框。
 
●Time复选框：如果选中该复选框，系统模型就会将时间独立变

量以指定的变量名称（默认名称为tout）存放在工作空间中。
●States复选框：如果选中该选项框，系统模型将会将其状态变量

以指定的变量名称（默认名称为xout）存放在工作空间中。
●Output复选框：如果系统模型中使用输出模块Out，就必须选中

该复选框，并填写在MATLAB工作空间中的输出数据变量名称，数据
的存放方式与输入情况类似。

●Final state复选框：如果选中该复选框，系统将会向工作空间中
以指定的名称（默认名称为xFinal）存放最终状态数值。如果最终状
态向量在该模型的新一轮仿真中又被用作初始数值，那么这新一轮仿

真是前一轮仿真的“继续”。

说明

在默认情况下，Simulink会选中该区域的“Time”和“Output”选项，用户可以根据需要来选

择所需的选项。



 
◆ Save options区域，该区域的主要功能是设置系统结果的保存

属性，需要特别注意的是，该区域的各种属性必须和Save to workspace
区域中的相应属性配合使用，下面详细介绍该区域的各种选项的内

容。

 
●Limit data points to last复选框：如果选中该复选框，就可以设

定保存变量接收数据的长度，默认数值为1000。如果输入数据长度超
过设定的数值，则“历史”数据会被清除。

●Decimation数值框：设定“解点”的保存频度。如果选择的是n，
则每隔n-1个数据点就会保存一个“解点”。默认数值为1。

●Format下拉列表框：Simulink提供了三种保存数据的格式：数
组、构架和带时间的构架。

18.7.3 仿真诊断设置

在Simulink中，提供了多种异常情况的诊断属性设置，并将其分
为多个子目录详细列出，其中关于“Solver”的异常诊断属性如图18.137
所示。



图18.137 关于“Solver”的异常诊断

从图18.137中可以看出，在“Diagnostics”目录下有多个子目录，分
别表示其他类别的异常诊断属性。例如关于数据兼容性的诊断属性页

面如图18.138所示。

图18.138 关于“Data Integirty”的异常诊断

在详细介绍诊断情况之前，先介绍Simulink中关于诊断的几种处
理方法：

 
◆ none：提示Simulink可以在仿真过程中忽略这种异常。



◆ warning：提示Simulink每当遇到这种异常时发出相应的警告
信息。

◆ error：提示Simulink采用发布出错信息并终止仿真的方式来
处理该异常情况。

 
由于有关异常诊断的情况比较复杂，下面只列出几种比较常见的

诊断选项。

 
◆ Algebraic loop：代数环的异常处理。在Simulink的系统模块

中，如果存在代数环的异常，将会大大减慢仿真速度，甚至会导致仿

真失败。对于这种异常，Simulink通常采用Warning的处理方式。如果
已知代数环的存在，而系统的仿真性能还可以接受，则可以将异常处

理方式转换为None。
◆ Min step size violation：用来处理最小步长欠小的异常情况。

如果发生这样的异常情况，表明微分方程解算器为了达到指定精度需

要更小的步长，但是这是解算器所不允许的。解决的方法是采用更高

阶的解算器来放松对步长的要求。对于这种异常情况，Simulink通常
采用的方式是Warning或者Error处理方式。

◆ Unconnected block input：模块输入悬垂。这种异常情况表示
在构建模块的时候有没有被使用的输入端。造成这种情况通常是因为

疏忽，如果造成这种状态是出于其他的目的，建议将该输入端与“接地
模块”相连，处理这种异常情况的主要方式是Warning或者Error。

◆ Unconnected block output：模块输出悬垂。这种异常情况表
示在构建模块的时候有没有被使用的输出端。造成这种情况通常是因

为疏忽，如果造成这种状态是出于其他的目的，建议将该输出端与“终
端模块”相连，处理这种异常情况的主要方式是Warning或者Error。



◆ Consistency checking：一致性检验。这种为了专门调试用户
自制模块的正确性，对于Simulink的标准模块不必进行一致性检验，
因此通常该选项会选择“None”，以免影响这个系统的仿真速度。

◆ Invalid root Inport/Outport block connection：该选项用来处
理其他模块和根目录级别的输出模块的异常连接的情况。选择该选项

后，Simulink会在检测程序代码过程中，发现有任何和输出模块中不
正常的连接，则会当作异常进行处理。

18.8 小结

本章主要介绍了关于Simulink的基础知识。在MATLAB中，
Simulink是进行模拟仿真的重要模块。本章主要介绍了Simulink工作环
境、Simulink中的数据类型、模块的基本操作、信号类型和操作。最
后，本章还介绍了用Simulink进行仿真的参数设置情况。关于Simulink
仿真，MATLAB中还提供了很多高级课题，这些将在后面章节中详细
讲解。

◆   ◆   ◆



第19章 Simulink建模和子系统

本章包括

◆线性建模

◆非线性建模

◆子系统

◆封装子系统

◆使能子系统

◆触发子系统

 
Simulink在电力、航空、自动化等各个领域中有着广泛的应用，

完成各种十分复杂的功能。为了能够完成这些功能，用户需要了解关

于Simulink的重要高级技术，例如，建模、子系统和封装等。同时，
Simulink作为MATLAB的一个重要组件，也可以和MATLAB的其他组
件结合起来使用，例如，Simulink可以和GUI、Virtual Reality Toolbox
等重要组件配合起来使用，完成比较复杂和综合的功能。

在本章中，将按照循序渐进、由浅入深的原则来介绍关于

Simulink的各种高级技术。首先，将通过各种例子来介绍Simulink子系
统、封装的概念，然后，介绍关于Simulink的S函数的作用等。最后，
作为介绍Simulink的最后章节，本章还将介绍Simulink性能改进、调试
等各方面内容。

19.1 Simulink线性系统建模



在Simulink中，连续系统是指可以使用微分方程来描述的系统。
在很多领域中，例如物理等都是连续时间的，连续时间系统又可以分

为两类：线性和非线性。Simulink中提供用户创建连续系统的主要模
块包括Continuous、Math和Nonlinear模块等。连续系统模型在现实的
各个领域中有着广泛的应用，所涉及的模块也比较多，在本节中选择

几个比较常见的模块来介绍如何创建连续系统模块。

19.1.1 线性系统建模简介

相对于非线性系统而言，线性系统比较简单，所涉及的模块也比

较容易，因此，在本小节中将以几个简单的实例来说明如何创建线性

系统。

例19.1 创建一个自行重新设置（Self-Resetting）的积分系统。

step 1
打开新的模块界面，然后向其中添加基本的积分模块，如图19.1

所示。

图19.1 添加基本系统模块

step 2



设置“Sum”模块的属性。双击系统中的“Sum”模块，打开其对应的
模块属性对话框，在“List of signs”文本框中设置为“|-+”，如图19.2所
示。

图19.2 设置“Sum”模块的属性

在Simulink中，“Sum”模块在“Math Operations”模块库中，其主要
功能是完成输入变量的相加或者相减的数学运算。一般情况下，其输

入变量可以是标量、向量或者矩阵。可以在“List of signs”文本框中输
入相应的数学运算符，例如，加号、减号或者分隔号等，在默认情况

下其值为“|++”，表示两个输入变量的相加运算。可以根据情况修改输
入变量的个数和运算关系，在本实例中设置为“|-+”，修改后的模块如
图19.3所示。



图19.3 修改后的模块

step 3
设置“Integrator”模块的属性。双击系统模块中的“Integrator”模

块，打开对应的属性对话框，设置对应的属性，如图19.4所示。

图19.4 设置“Integrator”模块的属性

在对话框的“External reset”下拉列表框中选择“falling”选项，表示
此端口的信号由正变负的瞬间，积分器会被强迫归零。同时，选

中“Show state port”复选框，这样积分器模块就会添加一个输出端口，
该端口将会输出关于积分状态的信号。

step 4
运行仿真系统。完成属性设置以后，将模块的仿真时间设置为6，

然后选择模块界面中的“Simulation”→“Start”命令，得到仿真结果，如
图19.5所示。



图19.5 仿真得到的结果

之所以将仿真时间设置为6，是因为在该时间范围内的结果是比较
明显的。

step 5
修改纵坐标的数值。如果沿用系统默认的10秒，则无法显示其真

正的仿真结果图形，为了更好地查看仿真的结果，可以设置仿真纵坐

标的数值，如图19.6所示。

图19.6 设置系统仿真的显示范围

step 6



查看新的仿真结果。设置信号显示范围后，单击对话框中

的“Apply”按钮，再单击“OK”按钮，得到新的仿真结果，如图19.7所
示。

图19.7 新的仿真结果

在本实例完成之后，需要分析该整个系统的基本原理。

首先，由“Clock”模块产生系统仿真时间变量t，然后经过增益模
块“Gain”得到结果变量2t，再将该变量经过积分器模块得到输出变量

，将该积分结果输入到示波器模块“Scope”中，这就是仿

真系统中的中间线路。

同时，在仿真系统中还包括“自设置”模块。首先，通过“积分
器”模块的“State port”的输出端输出系统仿真的状态量 t2，然后通
过“Sum”模块将该状态变量和常数1相连，得到“积分器”模块的状态重
设端口信号变量“1－t2”。
由于在“External reset”下拉列表框中选择“falling”选项，表示此端

口的信号由正变负的瞬间，积分器会被强迫归零。也就是说，当1－t2

＝0时，即当t＝1时，积分器的初始值被设置为0。而在此之后的积分
则变为 ，因此当该积分计算式再次达到上限积分数值

1时，即当 时，积分器再次将积分的初始数



值设置为0，而此后的积分数值变为 ，后面情况依此

类推。

19.1.2 求解抛投小球的轨迹

在本小节中，将再以综合的实例来演示如何在MATLAB中创建线
性系统建模。

例19.2 创建一个Simulink系统，演示向上抛投小球的运动轨迹。

step 1
打开新的模块界面，然后向其中添加基本的积分模块，如图19.8

所示。

图19.8 添加基本系统模块

step 2
设置第一个积分器的属性。双击左侧第一个积分器，打开积分器

的属性对话框，在其中设置其属性，如图19.9所示。



图19.9 设置第一个积分器模块的属性

在图19.8所示的系统模块中，第一个积分器的功能是积分得到小
球抛投的速度，为了能够更加逼真地模拟该抛投运动，需要为该积分

器进行外部初始条件的设置，并为其设置新的重设条件端口。因此需

要选中所有的相关端口。

step 3
设置第二个积分器的属性。双击第二个积分器，打开积分器的属

性对话框，在其中设置其属性，如图19.10所示。



图19.10 设置第二个积分器模块的属性

在系统中，第二个积分器模块的功能是由速度积分得到小球运动

的高度。因此，需要设置初始高度数值，在“Initial condition”文本框中
输入“10”，同时选中“Limit output”复选框，然后在“Lower saturation
limit”文本框中输入积分下限数值“0”，由于该积分器的输出变量是高
度，所以其数值的下限为0，其他选项保持默认设置。

step 4
设置“Scope”模块的属性。根据本实例的要求，需要显示小球运动

的高度和速度的图形，所以需要将其坐标系的个数设置为2，如图
19.11所示。



图19.11 设置示波器的属性

说明

之所以在“Scope”中没有显示任何的波形，是因为还没有进行仿真工作。

step 5
查看仿真结果。将系统的仿真时间设置为20，然后选择模块界面

中的“Simulation”→“Start”命令，得到仿真结果，如图19.12所示。



图19.12 查看仿真结果

 
在仿真结果中，上面的图形表示的是小球运动速度随着时间变化

的曲线，大致符合线性关系；下面的图形表示的是小球运动的高度随

着时间变化的曲线，大致符合二次抛物线的关系。

简要分析该系统的原理：本系统分析的是在初始高度为10m的地
方以初始速度15m/s向上抛投小球的运动轨迹，根据基础物理知识可
知，应选择重力加速度为9.81m/s2。同时，考虑到空气阻力对小球运

动的影响，每次进行积分的时候，将积分后的时间步（Time step）速
度转换为前一个时间步的0.8倍，相当于用速度的减少来替代能量的损
失，得到的结果就是包含了衰减的小球运动轨迹图形和速度图形。

说明

在该系统模块中，用到了“Initial Condition”模块来设置积分的初始条件，该模块在连续时

间，特别是积分器模块中会经常用到，关于该模块的使用方法可以查看相应的帮助文件。



19.1.3 求解二阶微分方程

在高等数学中，微分方程是一个重要的组成部分。在MATLAB
中，为求解微分方程提供了专门的命令。但是，同样可以使用

Simulink来求解二阶微分方程。在本小节中，将利用典型的例子演示
如何使用Simulink求解二阶微分方程。
例 19.3  创 建 Simulink 系 统 ， 求 解 二 阶 微 分 方 程

的方程解，其中u（t）是脉冲信号，用

户需要使用Simulink来求解函数x（t）。

step 1
改写微分方程。将需要求解的微分方程改为下面的形式：

step 2
使用Simulink创建这个微分方程，完成的系统模块如图19.13所

示。

图19.13 完成的系统模块

step 3



设置 “Pulse Generator”模块的属性。双击系统模块中的 “Pulse
Generator”模块，打开对应的属性对话框，设置相应的模块属性，如图
19.14所示。

图19.14 设置“Pulse Generator”模块的属性

说明

在属性对话框中，主要设置了“Pulse Generator”模块的信号频率。关于该信号的其他属性

的信息请查看相应的帮助文件。

step 4
设置“Sum”模块的属性。双击系统模块中的“Sum”模块，打开对应

的属性对话框，设置相应的模块属性，如图19.15所示。



图19.15 设置“Sum”模块的属性

在属性对话框中，将模块的形状参数 “Icon shape”属性设置
为“rectangular”，将模块设置为矩形，然后在“List of signs”文本框中将
符号设置为“++-”。

step 5
查看仿真结果。将系统的仿真时间设置为10，然后选择模块界面

中的“Simulation”→“Start”命令，得到仿真结果，如图19.16所示。

图19.16 仿真结果

step 6



添加新的模块，将仿真的结果传输到MATLAB的工作空间中。在
现有仿真系统模块的基础上，添加“Clock”和“To Workspace”模块，将
仿真的结果传输到工作空间中，如图19.17所示。

图19.17 添加新的模块

其中，Clock模块的功能是产生系统仿真的时间变量t，在模块中
将该时间变量和系统积分得到的x（t），通过“To Workspace”模块传递
给工作空间中的变量ScopeData。

step 7
设置“To Workspace”模块的属性。为了设置输出变量的属性，双

击“To Workspace”模块，打开模块的属性对话框，在其中设置相应的
属性，如图19.18所示。



图19.18 设置“To Workspace”模块的属性

在该对话框中，将仿真结果的输出变量名称设置为“ScopeData”，
同时将保存数据的格式设置为“Array”，即将仿真结果按照数组的格式
输出数值结果。

step 8
处理输出数据。首先运行重新设置的仿真系统，然后返回到

MATLAB的命令窗口中，输入下面的程序代码：

step 9
查看图形结果。在输入完上面的程序代码后，按“Enter”键，得到

的图形结果如图19.19所示。



图19.19 命令窗口中的绘制结果

从图形结果可以看出，通过常用的MATLAB绘图命令得到的图形
结果和仿真系统得到的图形完全相同，说明系统传递数据成功。实质

上，在Simulink中可以使用三种比较常见的方法来向MATLAB的工作
空间中存放仿真数据：

 
◆  使用示波器模块向MATLAB的工作空间中存放构架

（Structure）数组。
◆ 使用“To Workspace”模块以选定的矩阵方式向工作空间存放数

组。

◆ 设置仿真参数中的“Data Import/Export”选项的属性，以tout、
xout的名称将数据存放在工作空间中。

 
本实例使用的是第二种方法，可以根据实际情况来选择使用不同

的方法输出数据，下面简单介绍如何使用第三种方法。

step 10



修 改 数 据 传 递 方 法 。 选 择 模 块 编 辑 界 面 中

的“Simulation”→“Configuration parameters”命令，打开“Configuration
parameters”对话框，选择该对话框中的“Data Import/Export”选项卡，
在对话框的右侧选中“Time”和“States”复选框，如图19.20所示。

图19.20 设置数据输出的选项

step 11
查看数据传递结果。当完成这些设置以后，再次运行仿真系统，

查看MATLAB工作空间中的变量情况，得到如下结果：



提示

可以看出，如果选择了数据输出的“Time”和“States”选项，则可以通过内置的属性直接引

用仿真数据，例如表达式ScopeData.signals.values就引用了仿真的时间和仿真数据。

19.1.4 使用传递函数



MATLAB为用户求解微分方程提供了十分重要有效的工具：传递
函数。将微分方程进行Laplace变换，然后求解出传递函数。使用传递
函数模块，求解微分方程。在本小节中，将结合前面的例子来说明如

何使用传递函数。

例19.4 使用传递函数模块来求解上例的微分方程。

step 1
求解微分方程的传递函数。根据上面的实例中的微分方程：

将两边同时进行Laplace变换，得到的结果如下：
s2X（s）＋0.4sX（s）＋0.9X（s）＝0.7U（s）
将这个方程进行整理，得到转换公式如下：

step 2
根据该转换函数的公式，可以创建系统的模块，如图19.21所示。

图19.21 创建系统的模块

step 3
设置转换函数模块的属性。双击转换函数模块，打开对应的对话

框，在其中设置转换函数的公式，如图19.22所示。



图19.22 设置转换函数的属性

step 4
查看设置属性后的模块。当设置属性后，单击对话框中的“OK”按

钮，得到的模块如图19.23所示。

图19.23 设置属性后的模块

step 5
查看仿真结果。完成上面的模块后，双击“Sc”模块，查看仿真结

果，得到的结果如图19.24所示。



图19.24 查看仿真结果

说明

从仿真结果可以看出，使用传递函数可以获得和原始系统模型一样的仿真结果，但是在

结构上就有了明显的改观，因此如果能够熟练使用传递函数，可以很方便地求解仿真模型。

19.1.5 使用状态方程

在Simulink中，在求解微分方程的时候，还可以使用状态方程。
状态方程在前面章节中已经介绍过，这里就不重复介绍了。在

Simulink中，专门提供了“状态方程”模块，在本小节，将结合具体的
例子来讲解如何使用状态方程求解微分方程。

例19.5 使用状态方程模块求解微分方程。

step 1
求解微分方程的状态方程。根据上面的实例中的状态方程：

假 定 x （ 1 ） ＝ x ， x （ 2 ） ＝ x′ ， 则 微 分 方 程

可以转换为：



将此方程转换为如下状态方程：

其中，参数 。

step 2
根据状态方程，可以创建系统的模块，如图19.25所示。

图19.25 添加系统的模块

说明

在Simulink中，状态方程模块是在Continuous模块库下的子模块，主要用来分析实施一个

线性状态系统。

step 3
设置状态方程模块的属性。双击状态方程模块，打开对应的对话

框，在其中设置转换函数的公式，如图19.26所示。



图19.26 设置状态方程模块的属性

step 4
查看仿真结果。完成这个模块后，双击“Sc”模块，查看仿真结

果，得到的结果如图19.27所示。

图19.27 查看仿真结果

说明

在本小节中，使用多种方法来求解同一个微分方程，主要目的在于介绍在Simulink中可以

灵活使用各种模块完成建模工作。



19.1.6 “积分器”模块的工作原理

根据前面小节的内容，在连续系统建模中“Integrator”模块是一个
十分重要的模块，灵活应用“Integrator”模块可以完成各种复杂的连续
系统。因此，熟悉“Integrator”模块各种属性对用户创建模块是十分重
要的内容，在本小节中将详细介绍“Integrator”模块的各种常见属性的
设置。

在Simulink中，“Integrator”模块的功能就是对信号进行积分，选
择“Continous”模块库下的“Integrator”模块，然后添加到模型编辑界面
中，得到的默认模块如图19.28所示。

图19.28 默认的“Integrator”模块

“Integrator”模块会输出其输入信号在当前时间步（time step）中的
积分结果，可以使用一个简单的公式来描述其工作原理：

在这个公式中，y（t）表示的是“Integrator”模块的输出信号，也
就是积分结果；u（t）表示的是“Integrator”模块的输入信号；y0表示的

是积分的初始状态。其中，y（t）和u（t）都是当前仿真时间t的标量
函数表达式。

在Simulink中，可以使用多种数值积分方法来计算“Integrator”模块
的输出信号，每种方法各有优劣，在前面章节中已经介绍过，

在“Configuration Parameters”对话框的Solver面板中，可以选择不同的
数值积分方法。Simulink将“Integrator”模块作为某个状态下的动态系



统，其输入信号则是当前状态的时间导数值。下面的方程组可以表示

该原理：

除了“Integrator”模块的默认属性设置之外，“Integrator”模块还提
供了包含初始状态的积分模块，默认的初始状态数值为 0。使
用“Integrator”模块的模块属性对话框，可以根据实际问题的需要设置
新的初始状态数值，或者为“Integrator”模块添加初始状态数值端口。
在“Integrator”的模块属性对话框中，一般可以设置以下内容：

 
◆ 设置积分的上限和下限。
◆ 添加一个输入端口来重设积分的初始状态数值。
◆ 创建一个可选的状态输出端口，状态输出端口一般用来引发

仿真时间的重设。

19.2 非线性系统建模

尽管在前面章节中列举了很多关于线性系统的实际案例，但是在

实际情况中严格意义上的线性系统是很少的，大量的系统或者原件是

非线性的。因此为了完成这些内容的仿真系统，Simulink在模块库中
提供了许多典型的非线性模块。相对于线性模块，非线性模块更加复

杂，本节还将使用简单的案例来介绍非线性模块的使用方法。

19.2.1 非线性系统建模简介



为了让读者能够快速了解非线性系统的方法，本小节中，将利用

一个典型的非线性微分方程讲解如何使用Simulink求解非线性模块。
例 19.6  使用 Simulink来创建系统，求解非线性微分方程

，其中x和x′都是时间的函数，也就是

x（t）和x′（t），其初始值为x′（0）＝0，x（0）＝2。用户需要求解
该方程的数值解，并绘制函数的波形。

step 1
改写上面的微分方程，将其改写为下面的等式：

step 2
根据改写的求解方程，创建下面的Simulink仿真系统，如图19.29

所示。

图19.29 创建的系统模块

在该模型中，使用了很多新的系统模块，例如Fcn、Product等，
这些模块将在非线性微分方程中经常使用到，在后面的步骤中将详细

介绍这些模块的属性设置。



说明

在所创建的系统模块中，将x′设置为x2，将x设置为x1，之所以这样设置，是为了加强系

统模块的可读性。

step 3
设置“Fcn”模块的属性。双击系统中的“Fcn”模块，打开对应的属

性对话框，在其中设置表达式，如图19.30所示。

图19.30 设置函数表达式

在属性对话框中的“Expression”文本框中输入“3*u -2* u*u”，其中
u代表的是输入该模块信号的变量，在本实例中也就是信号变量x。在
Simulink中，Fcn模块支持所有C语言条件下的所有相关表达式。在该
表达式中可以包含变量u、数值常数、数学运算符、关系运算符、逻辑
运算符、圆括号、数学函数和MATLAB工作空间中的变量等。关于该
模块的其他信息，请查看相关的帮助文件。

说明

在Simulink中，“Fcn”模块不支持可变的参数，在系统仿真过程中该模块忽略了所有工作

空间中变量的数值变化，同时，“Fcn”模块也不支持Custom Storage数据类。



step 4
设置“Product”模块的属性。双击系统中的“Product”模块，打开对

应的属性对话框，在其中设置表达式，如图19.31所示。

图19.31 设置乘法模块的属性

在该属性对话框中，选择“Product”模块的“Multiplication”属性
为“Element-wise(.*)”，表示对模块输入变量进行点乘运算，在“Number
of inputs”文本框中输入信号的个数为“2”，这样“Product”模块会提供2
个输入端口。

提示

在Simulink中，“Product”模块对输入变量的维度和个数有着匹配的要求，同时也可以选择

不同的相乘模式，当用户选择该模块时需要根据系统的要求选择不同的属性。

step 5
设置“Integrator”模块的属性。在本实例中，用户使用的积分器模

块使用的都是默认属性端口，用户主要需要为其设置初始数值条件，



以模块“x1”为例，双击该模块，打开属性对话框，设置的初始数值如
图19.32所示。

图19.32 设置积分器模块的属性

step 6
查看系统的仿真图形结果。将系统仿真时间设置为20，然后运行

仿真，双击系统模块中的“Scope”模块，查看仿真结果，如图19.33所
示。



图19.33 查看仿真结果

在仿真结果中，黄色的曲线表示的是变量x（t），红色的曲线表
示的是t′（x）。

step 7
修改仿真的模块。为了能够在MATLAB的工作空间中演示上面的

仿真结果，添加新的系统模块，如图19.34所示。

图19.34 添加新的模块

step 8



设置“Mux”模块的属性。为了在MATLAB的工作空间中显示时间
变量，将“Mux”模块的输入端口改为3，如图19.35所示。

图19.35 修改“Mux”模块的输入端口

step 9
将系统的仿真时间修改为30，然后运行系统仿真，得出输出变

量“SimuData”，返回到MATLAB的命令窗口中输入下面的代码：

step 10
查看图形结果。在输入代码后，按“Enter”键，得到的图形如图

19.36所示。



图19.36 绘制图形结果

提示

可以看出，使用“Scope”模块绘制的函数图形和MATLAB的典型函数绘制的结果相同，表

明程序模块设计正确。

19.2.2 求解非线性摩擦模型

在本小节中，将以具体的实例来演示如何在Simulink中创建非线
性系统。

例19.7 使用Simulink创建系统来求解一个非线性摩擦模型，根据
基础的物理模型，假设物体的位移为x，而且该物体的摩擦力微分方程
如下：



在上面的微分方程中，k和δ都是方程的系统参数， 表示

的是物体的摩擦力是物体运动速度的非线性函数，也就是说

。再根据基础的物理知识，物体的摩擦力包

括静态摩擦力和动态摩擦力两种，根据物体运动的不同速度，物体运

动所受的摩擦力类型会有不同，物体会在不同的速度范围内接收不同

的摩擦力类型。

本例分析上面模型中的一种情况，其中初始位置x0＝-0.5，初始速
度x0′＝100。而且物体的位移范围为-3.5≤x≤5.5。静态摩擦力fs＝80，
动态摩擦力fk＝40，同时，为了分析的方便，将方程中的参数设置为δ
＝1，k＝-100。

step 1
根据上面的微分方程，添加相应的系统模块，如图19.37所示。

图19.37 添加微分方程的模块

在上面的程序模块中，包括两个主线，其中第一条主线的系统模

块代表的是前面包括的微分方程 ，同时示波器中显示



的是物体的位移x的波形。在本步骤中，为了简化分析，同时由于
为计算 的数值，添加了子系统模块，该子系

统模块中的输入变量包括 velocity和 velocity_stateport，其中变量
velocity_stateport是为了避免在后面步骤中出现代数环，是
由“velocity”模块的“状态”端口得到的输出变量。

step 2
设置“velocity”模块的属性。双击“velocity”模块，打开模块的属性

对话框，让其显示状态端口，如图19.38所示。

图19.38 设置积分器模块的属性

提示

在上面的系统模块中，添加了多个“Display”模块，这样做似乎让整个系统模块显得十分

臃肿，但是，有一个明显的好处在于，可以让用户在仿真过程中查看各个变量的数值，有利

于用户分析整个仿真系统。

step 3



设置计算摩擦力的子系统模块。双击子系统模块，在打开的模块

编辑器中添加子系统模块，如图19.39所示。

图19.39 添加计算摩擦力的子系统模块

step 4
查看程序模块的变化。当添加了程序模块后，原来的程序模块会

随之变化，得到的结果如图19.40所示。



图19.40 添加子系统模块后的主系统模块

和原来的系统模块相比，子系统模块多了三个输入端口，分别表

示的是静态摩擦力、动态摩擦力和外部推力等，分别在该子系统模块

中添加新的输入变量，下面将详细分析添加的子系统模块。

提示

尽管在本步骤中涉及了子系统的概念，但是在这里并不详细介绍该子系统的内容，因为

子系统（subsystem）在Simulink中是十分重要的内容，将在后面的章节中专门介绍。在这里

可以将子系统当作一个黑箱，输入所有和摩擦力相关的变量，输出的是物体运动的摩擦力。

step 5
设置“switch”模块的属性。在上面的子系统模块中，“switch”模块

是子系统的“选择”开关，该模块根据物体运动的速度和外力情况来得
出物体运动的摩擦力数值。其对应的模块属性对话框如图19.41所示。



图19.41 设置“Switch”模块的功能

step 6
查看上部分信号。下面将根据该“Switch”模块的各条信号，分析

摩擦力的数值情况，其中，和该模块顶部信号端口相连的信号如图

19.42所示。

图19.42 子系统的上部信号系统

该部分信号系统的目的在于分析物体的静摩擦力数值，首先从4号
输入模块输入物体最大静摩擦力的数值（static friction），从5号输入
模块中输入物体所受的外部推力。根据物理知识可知，当外部推力小

于最大静摩擦力时，物体所受的摩擦力数值就是外部推力；当外部推

力大于最大静摩擦力一定的数值后，物体才会开始运动。因此，添加



了“Abs”模块将求得外部推力的数值，然后使用“Min”模块求得最大静
摩擦力和外部推力的最小值，得到物体所受的静摩擦力数值，

用“Display”模块来显示该数值。

说明

在上面的模块中，用户添加了“singum”模块，该模块的主要功能在于确定摩擦力的数值

符号，最后得到的摩擦力数值在“Display”模块中显示。

step 7
查看下部分信号系统。下面分析该子系统中的下部信号系统，如

图19.43所示。

图19.43 子系统的下部信号系统

该部分系统模块主要处理的是物体运动时的摩擦力数值，物体运

动的速度和动摩擦力系数的乘积就是物体所承受的动摩擦力数值。

step 8
设置两个积分器模块的控制模块。这些系统模块的功能是设置整

个系统的积分属性，添加后的模块系统如图19.44所示。



图19.44 设计完成的系统模块

step 9
设置“velocity”积分器模块的属性。双击“velocity”积分器模块，打

开对应的属性对话框，如图19.45所示。



图19.45 设置“velocity”积分器模块的属性

将“velocity”积分器模块的重设属性设置为“rising”，具体的重设属
性将在后面的步骤中详细设置对应的逻辑模块实现。

step 10
设置“position”积分器模块的属性。双击“position”积分器模块，打

开对应的属性对话框，在其中设置其属性，如图19.46所示。



图19.46 设置“position”积分器模块的属性

在上面的程序模块中，选中“Show saturation port”复选框，这样积
分器模块中会显示“Saturation Port”。由于在前面的步骤中，设置该位
移变量积分的上下限，因此添加该端口可以显示积分达到限制的类

型，该端口输出的数据类型是布尔数据类型。

step 11
设置“Data Type Conversion”模块的属性。由于积分器模块的所有

输入变量数据类型都是“double”，因此在上面的系统模块中添加
了“Data Type Conversion”模块，将数据类型在“Boolean”和“Double”之
间转换，选择数据转换模块的属性，如图19.47所示。



图19.47 设置数据转换模块的属性

在图19.47所示的对话框中，在“Output data type mode”下拉列表中
选择 “double”数据类型，表示该模块会将输入模块的数据转换
为“double”数据类型。对于该系统模块组中的另外一个数据转换模
块，可以将其“Output data type mode”选项设置为“Boolean”。

提示

“Data Type Conversion”模块在Simulink建模中有着广泛的应用，可以实现多种数据类型之

间的转换，同时还可以起到数据保存方式之间的转换等多种功能，灵活运用该模块可以实现

多种功能，关于该模块的详细用法将在后面章节中详细介绍。

step 12
设置仿真时间，运行整个仿真系统，得到仿真结果。将系统的仿

真时间设置为2，然后运行仿真，得到的结果如图19.48所示。



图19.48 查看仿真结果

在上面的仿真结果中，各个显示模块显示了在t=2s时，物体的运
动速度、位移、摩擦力等各个物理参量的数值，同时“Scope”模块显示
了物体位移随时间变化的曲线。

step 13
修改坐标轴数值范围。为了更好地显示物体移动的变化情况，可

以修改图形中Y轴坐标数值的显示范围，如图19.49所示。



图19.49 修改图形的Y轴坐标数值

step 14
查看修改后的图形。单击对话框中的“Apply”按钮，查看修改后的

图形情况，如图19.50所示。

图19.50 修改后的显示图形

从上面的仿真结果中可以看出，在初始位置x0＝-0.5，初始速度
x0′＝100，同时在外部摩擦力系数的条件下，物体会停止在x＝-0.3的
位置，最终停止，并且开始静止的时间约为t=1.6s左右。因此，从整个
仿真系统的条件下，物体从x0＝-0.5的位置，以初始速度100的条件开
始运动，在变动的外力条件下，最终在t＝1.6s的时刻，停止在x＝-0.3
的位置，最终保持静止。

step 15



修改系统仿真的参数，得到新的仿真结果，如图19.51所示。

图19.51 修改仿真参数

在上面的仿真中，设置初始位置x0＝-1.5，初始速度x0′＝150，静
态摩擦力fs＝75，动态摩擦力fk＝50，微分方程系数δ＝3.5，k＝-225。

step 16
运行仿真。将仿真时间设置为4，然后进行仿真，得到的结果如图

19.52所示。



图19.52 重新运行系统的仿真

说明

可以看出，当用户修改了物体运动的环境后，最终物体会在t＝3.6s的时刻，停止在x＝

0.06的位置，最终保持静止。

19.3 子系统

前面已经接触到了一些关于子系统的实例，对Simulink的子系统
有了直观的印象。在本节中将使用几个比较典型的实例，来详细介绍

如何使用Simulink创建子系统，以及关于子系统的各种注意事项。

19.3.1 子系统的基础知识



当需要使用Simulink来解决或者仿真比较综合的实际问题时，模
型结构会变得比较复杂，涉及的模型原件也会变得繁多，如果所有的

原件都是在原来的模块基础上添加的，那么模型的阅读会变得越来越

艰难。这个时候，如果使用子系统则可以解决这个主要的矛盾。这

样，将复杂的模型分割为几个比较小的模块，可以使得整个模块更加

简洁、可读性更高，也可以方便用户操作比较复杂的模型。

子系统除了可以解决上面的问题之外，还具有以下几个重要的优

点：

 
◆ 减少模块窗口中模块的个数，使得模型窗口更加简洁。
◆  将一些功能相关的模块集成在一起，而且可以实现复用

（Reuse）的功能。
◆ 提高整个系统运行的效率和可靠性。
◆ 符合面向对象的概念，方便用户分析研究系统时进行概念抽

象。

说明

在仿真建模中子系统的作用，类似于在MATLAB中的M函数文件，C语言中的Function

sub-programs、FORTRAN语言中的subroutine sub-programs等。

 
在Simulink中，可以使用两种创建子系统的方法：
 
◆  通过子系统模块创建子系统：也就是先向模型中添

加“Subsystem”模块，然后打开该模块并向其中添加模块。
◆ 结合已经在模块编辑器中添加的模块，创建子系统。

说明



在Simulink中，之所以提供了两种创建子系统的方法，是因为这两种方法都有各自的适用

范围，这些内容将在后面详细介绍。

19.3.2 创建子系统

在Simulink中，为用户创建子系统提供了相应的模块。可以直接
使用子系统模块来创建复杂的系统。下面看一个具体的例子。

例19.8 使用Simulink中的Subsystem模块来创建系统，系统的输
入变量为N，输出的变量为从1到N的自然数的累积求和数值，下面分
步骤详细介绍。

step 1
单击“Simulink Library Browser”对话框中的 按钮，或者选择菜

单栏中的“File”→“New”→“Model”命令，打开空白模型窗口，然后添
加系统模块，如图19.53所示。

图19.53 添加系统模块

其中的 “Subsystem”子模块属于 “Ports & Subsystems”模块库中
的“For Iterator Subsystem”模块，该模块完成的主要功能相当于C语言



中的for循环。由于本实例比较简单，本例选用的是该模块的默认属
性，如图19.54所示。

图19.54 Subsystem的属性对话框

step 2
设置“Fcn”模块的属性。在上面的程序模块中，为了检验子系统计

算的结果，在下面的分支中添加了“Fcn”模块，属于“User-Defined
Functions”模块库下的“Fcn”模块，其模块属性如图19.55所示。

图19.55 “Fcn”模块的属性



根据基础的数学知识可知，自然数从1～n的叠加求和公式为：

因此，在上面的“Fcn”模块中，就是通过该公式得到的求和数值结
果。

step 3
双击“Subsystem”模块，打开模块编辑窗口，添加系统的模块，如

图19.56所示。

图19.56 编写子系统模块

step 4
设置“For Iterator”模块的属性。在子系统模块中，添加了“For

Iterator”模块，模块的功能在于控制For的循环条件，该模块的属性对
话框如图19.57所示。



图19.57 设置“For Iterator”模块的属性

step 5
在对话框中设置“For Iterator”模块的循环属性，将循环的输出数据

类型设为“int32”，然后使用“Data Type Conversion”模块，将该输出数
据转换为“double”数据类型。
保存子系统模块，然后运行仿真结果，得到的结果如图19.58所

示。当输入计算自然数的数值是10时，仿真系统得出结果55。可以重
新输入叠加自然数的数值，例如20，重新运行仿真，得到的结果如图
19.59所示。



图19.58 查看系统仿真的结果

图19.59 重新运行仿真

从上面的结果可以看出，当输入计算的自然数为20时，仿真结果
为210。该实例比较简单，但是演示了创建子系统的一般步骤，具体的
内容为：

step 1
从模块库中选择对应的子系统模块，然后添加到模块编辑器中。

step 2
双击相应的子系统模块，打开子系统的模块编辑器。

step 3
在模块编辑器中添加模块，创建子系统，然后保存。

step 4
运行仿真，得到结果。

说明



在Simulink中，提供了多个复杂的子系统模块，不同的模块具有不同的属性设置情况，这

些内容将在后面章节中详细介绍。

19.3.3 使用模块组合子系统

在Simulink中，还可以通过将各模块组合而创建子系统。下面将
结合具体的例子来说明如何使用模块组合为子系统。

例19.7 使用Simulink编写系统模块，求解微分方程

的数值解。

step 1
单击“Simulink Library Browser”对话框中的 按钮，或者选择菜

单栏中的“File”→“New”→“Model”命令，打开空白模型窗口，然后添
加系统模块，如图19.60所示。

图19.60 添加相应的系统模块

step 2
运行该仿真系统，得到的结果如图19.61所示。



图19.61 查看系统的仿真结果

step 3
选中模块D1和B1，然后选择“Edit”→“Create Subsystem”命令，将

选中的模块编辑为子系统，如图19.62所示。

图19.62 创建子系统模块

step 4
查看创建子系统后的模块。选择“Create Subsystem”命令后，

Simulink就会将选中的模块设置为“Subsystem”模块，可以适当编辑模



块的位置和颜色，结果如图19.63所示。

图19.63 创建子系统

step 5
查看子系统模块。双击子系统模块，打开对应的子系统模块编辑

器，查看Simulink自动创建的子系统模块，如图19.64所示。

图19.64 Simulink创建的子系统

从上面的子系统模块可以看出，Simulink会对选用的模块添加对
应的Inport和Output数据模块，作为和上一级模块实现数据传递的端
口。

step 6
重新进行系统仿真。当完成上面的子系统创建过程后，可以重新

运行系统进行系统的仿真，得到的仿真结果如图19.65所示。



图19.65 重新运行系统的仿真

上面的实例比较简单，但是演示了如何通过套装来创建子系统的

基本步骤：

step 1
按照系统的要求，创建对应的系统模块。

step 2
选择希望创建子系统的系统模块，然后选择 “Edit”→“Create

Subsystem”命令。

step 3
双击创建的子系统模块，编辑子系统的名称或者其他属性。

step 4
运行仿真，得出结果。

提示



使用这两种方法创建的子系统都是比较常见的，但是在最后的效果上还是有明显差别

的。使用第一种方法创建的子系统在执行过程中有“优先级”的差别，而使用第二种方法创建

的子系统则没有“优先级”的差别。

19.4 信号输出系统——子系统实例

在前面的章节中，已经介绍了关于子系统的基础内容，在本节中

将使用一个比较综合的例子来介绍如何在Simulink中创建子系统，以
及如何实现子系统之间的数据传递。

19.4.1 添加控制信号

例19.10 利用Simulink来创建仿真系统，该仿真系统中包含两种
数据信号：方形波脉冲和正弦波图形。其中，正弦波是输入信号，方

形波脉冲是控制信号。用户需要使用子系统模块来输出三种类型的信

号：原始的正弦波信号，经过控制信号处理后的两种正弦波信号。具

体的信号属性将会在后面步骤中详细介绍。

step 1
根据该仿真系统的功能要求，用户需要添加对应的程序模块，如

图19.66所示。



图19.66 添加程序模块

step 2
设置方形波的属性。双击“Pulse Generator”模块，打开对应的属性

对话框，在其中设置方形波的参数属性，如图19.67所示。



图19.67 方形波的属性

在本实例中，方形波的主要功能是控制信号的输出情况，因此，

属性将直接影响信号的输出结果。在Simulink中，“Pulse Generator”模
块可以生成固定间距的方形波，关于方形波的主要参数包括

Amplitude（振幅），Pulse Width（脉冲宽度），Period（周期）和
Phase Delay（相位延迟）等。为了能够让用户了解到各属性的含义，
对应的属性含义如图19.68所示。

图19.68 方形波的属性参数

step 3
显示方形波的重要参数的数值。为了增加整个仿真系统的可读

性，可以显示方形波的重要参数数值。选择“Pulse Generator”模块，然
后右击鼠标，在弹出的快捷菜单中选择“Block Properties”选项，打
开 “Block Properties ： Pulse Generator” 对 话 框 ， 选 择 “Block
Annotation”选项卡，在其中设置显示的参数数值，如图19.69所示。



图19.69 设置模块显示的参数数值

step 4
查看修改后的程序模块。单击对话框中的“Apply”按钮，就可以查

看修改后的程序模块，如图19.70所示。



图19.70 显示模块的主要参数

19.4.2 添加子系统模块

本小节的主要功能是向系统中添加相应的子系统模块。根据本实

例的特点，用户需要向系统中添加“If”和“Else”子系统模块。下面详细
讲解添加过程。

step 1
添加子系统模块的说明名称。为了能够更方便地查看系统，需要

添加子系统模块的说明名称，如图19.71所示。

图19.71 添加子系统模块的说明文字

step 2
设置“If”模块的属性。双击系统中的“If”模块，打开对应的模块属

性对话框，设置该模块的属性，如图19.72所示。



图19.72 设置“If”模块的属性

在属性设置对话框中，将If模块的输入变量个数设置为“1”，同时
If表达式为“u1＞0”，其中u1是代表输入信号的变量，由于该实例中，
If判断表达式只有一个条件，因此在“Elseif expressions”文本框中不需
要输入任何表达式。最后，由于本实例中具有两种情况下的处理模

块，因此，需要选中“Show else condition”复选框，其他属性采用系统
的默认情况。

step 3
分析If模块的功能。在Simulink中，“Ports & Subsystems”模块库下

的If模块主要功能是在Simulink中执行类似于C语言中的if-else控制流程
序语句。If模块和若干个包含执行端口的“If Action”子系统模块执行标
准的C语言中的if-else逻辑功能，其典型的模块结构系统如图19.73所
示。



图19.73 If模块的典型执行结构

针对该系统模块结构，其功能和下面的程序代码相同：

提示

和C语言类似，If模块在Simulink中可以实现各种复杂的功能，灵活使用该模块可以解决

比较复杂的实际问题。

step 4
设置“If Action”子系统模块的属性。双击“If Action”子系统模块，

打开模块编辑框，添加相应的子系统模块，如图19.74所示。



图19.74 添加“If Action”子系统模块

step 5
设置“ElseAction”子系统模块的属性。双击“Else Action”子系统模

块，打开模块编辑框，添加相应的子系统模块，如图19.75所示。

图19.75 添加“Else Action”子系统模块

step 6
设 置 “Saturation” 模 块 的 属 性 。 在 上 面 的 模 块 系 统

中，“Saturation”模块的主要功能是设置Else系统中的饱和数值范围，
其属性对话框如图19.76所示。

图19.76 设置Saturation模块的属性

step 7



设置“Scope”模块的属性。双击系统中的“Scope”模块，然后打开
该模块的属性对话框，在其中设置模块的属性，如图19.77所示。

图19.77 设置“Scope”模块的属性

说明

在属性对话框中，选中坐标轴的个数为3，然后在“Tick labels”下拉列表框中选择“all”选

项，这样Simulink会为每一个坐标轴添加图形的标题，该标题的具体文字就是在前面步骤中输

入端口中的文字名称。

19.4.3 运行仿真系统

在完成所有子系统的创建过程后将分析整个系统的仿真结果。

step 1
运行系统，得出仿真结果。前面步骤已经设置了所有的模块属

性，单击“运行仿真”按钮，查看仿真结果，如图19.78所示。



图19.78 查看仿真结果

step 2
查看系统模块。当完成仿真后，对应的模块系统如图19.79所示。



图19.79 运行仿真后的系统模块

可以看出，当运行了系统的仿真后，If模块和“If Action”、“Else
Action”模块之间的连线变成了点画线，表示对应的程序模块已经运行
完成。

在本实例中，读者基本接触到了Simulink中关于“If”子模块的基础
属性，同时也演示了使用自上向下的方法创建子系统的方法，也就是

首先搭建子系统模块的上层框架，然后再分别添加各个子系统的程序

模块，实现模块功能。对于其他的子系统模块和创建子系统的方法将

在后面章节中逐渐介绍。

19.5 封装子系统

一般（或者被称为简装）子系统操作比较简单，可以使整个模型

更加简洁，也在一定程度上提高了分析研究问题时的概念抽象的能

力，但还存在着明显的缺陷：一般子系统将直接从MATLAB的工作空
间中获取变量数值，容易发生变量冲突，同时与Simulink模块库中的
基础模块的结构不一致，也就是规范化的程度比较低。封装子系统

（Masked subsystem）就是为了改善这一问题而出现的。



从外表上来看，封装子系统和普通的模块库模块完全相同，有着

自己的图标、参数设置的对话框；从变量（或者被称为数据）传递的

层面上来看，封装子系统有着自己的工作空间，这个工作空间将独立

于基础空间和其他模块库的模块空间。本节将通过几个比较典型的实

例来介绍如何创建封装子系统，以及在创建子系统时所必须注意的事

项。

19.5.1 封装子系统的创建方法

在详细介绍封装子系统的创建方法之前，首先介绍封装子系统的

主要优点：

 
◆ 在设置各子系统中各模块的参数时，只需通过参数对话框就

可以完成。

◆ 为子系统创建一个可以反映子系统功能的图标，给用户直观
的印象。

◆ 可以避免用户在错误操作中修改模块的参数数值。
 
在Simulink中，创建子系统的一般步骤如下：

step 1
按照前面介绍的方法来创建子系统。

step 2
选择需要封装的子系统，然后在菜单栏选择 “Edit”→“Mask

subsystem”命令，打开封装编辑框，如图19.80所示。



图19.80 封装编辑器

step 3
在封装编辑框中，设置封装子系统的参数属性、模块描述和帮助

文字、自定义的图形标识等，关闭编辑器就可以得到新建的封装子系

统。

step 4
如果需要编辑封装子系统，可以选中该子系统，然后选

择“Edit”→“Edit Mask”命令，打开“Mask editor”对话框，重新设置相应
的属性。

提示

封装子系统是在简装子系统基础上经过精心设置、装饰的系统，其制作过程和Simulink模

块库中其他模块的制作方法没有太大的区别，因此了解封装子系统也可以加深对模块库的了



解。

19.5.2 封装子系统的步骤

在本小节中，将利用一个简单的实例演示如何封装子系统，例子

并不复杂，但是基本上涉及了封装子系统的各个属性，下面分步骤详

细介绍。

例 19.11  使用 Simulink中的封装子系统，求解微分方程

的数值解。

step 1
添加子系统的基础模块。为了在后面的步骤中设置封装子系统的

属性，需要首先添加子系统的模块，如图19.81所示。

图19.81 添加子系统的模块

step 2
设置“Gain”模块的属性。在前面的实例中，变量m的数值是1/2。

在本实例中，为了分析封装子系统中的参数属性，将其改为m，可以
在后面的步骤中根据需要修改m的数值，如图19.82所示。



图19.82 设置Gain模块的属性

step 3
封装上面的子系统，并设置其“图标”属性。选中该子系统，然后

选择“Edit”→“Mask Subsystem”命令，打开封装编辑框，选择“Icon”选
项卡，如图19.83所示。

图19.83 设置子系统的图标属性



在“Icon”选项卡的“Icon options”面板中，可以定义图标的边框
（Frame）是否可见，生成的端口图标是否可见（Transparency），图
标是否固定（Fixed）等属性。
在“Drawing commands”文本框中输入“image(imread('9.jpg'))”，表

示将在MATLAB的当前路径中的“9.jpg”文件作为封装子系统的图标。
在“Examples of drawing commands”面板中，向用户解释了如何使

用各种绘制图标模块的命令，每种命令都对应在右下角有一种实例，

可以依照该选框中的命令格式和右侧出现的示例图标来编写图标绘制

命令。

提示

在Simulink中，可以使用各种绘制命令显示各种图标图案，例如disp、dpoly、fprintf、

image、patch、plotport_label和text等，关于这些命令的详细使用方法，感兴趣的读者可以参

看“Simulink Reference”中的“Mask Icon Drawing Commands”部分内容。

step 4
设置封装子系统的 “Parameters”参数。选择封装编辑器中

的“Parameters”选项卡，在其中设置封装子系统的参数数值，如图
19.84所示。



图19.84 设置封装子系统的参数

在选项卡中单击 “Add”按钮，开始添加子系统的参数，
在“Prompt”栏输入“Gain”，该字符串表示的是在对话框中显示的提示
文字；在“Variable”栏输入“m”，表示用户在对话框中输入的数值将被
传给变量m。在“Type”栏选择“edit”类型。最后，在“Dialog callback”文
本框中输入下面的程序代码：

说明

在上面的程序代码中，首先检测用户输入的变量数值是否小于0，如果小于0则调用error

命令，显示错误信息，同时结束程序代码。

step 5
设置封装子系统的 “Initialization”属性。选择封装编辑器中

的“Initialization”选项卡，在其中设置封装子系统的参数初始数值，如



图19.85所示。

图19.85 设置子系统的参数初始数值

在“Initialization”选项卡中，可以定义封装子系统的初始化命令，
初始化的命令可以使用任何有效的MATLAB表达式、函数、运算符
和“Parameters”选项卡汇总定义的变量，但是初始化命令不能访问
MATLAB工作空间中的变量。

提示

可以在该选项卡中的每一行命令条的后面添加分号结束，这样就可以避免在模型仿真运

行的时候在命令窗口显示仿真结果。

step 6
定 义 封 装 子 系 统 的 说 明 文 字 。 选 择 封 装 编 辑 器 中

的“Documentation”选项卡，在其中设置封装子系统的说明文字，如图
19.86所示。



图19.86 定义封装子系统的说明文字

在“Documentation”选项卡中可以定义封装子系统的类型、模块描
述和模块的帮助信息等，这些内容可以选择性地描写，加大封装子系

统的可读性。

提示

“Documentation”选项卡中设置的文字信息都会在用户打开的子系统参数对话框中显示，

来实现用户和系统之间的互动。

step 7
查看封装结果。单击“Apply”按钮或者“OK”按钮，就可以保存封

装结果，如图19.87所示。



图19.87 查看系统封装结果

step 8
设置封装子系统的参数数值。双击Subsystem模块，打开参数对话

框，在其中输入变量m的数值，如图19.88所示。

图19.88 设置封装子系统的参数数值

在参数对话框中，上半部分的文字就是用户在“Documentation”选
项卡中填写的文字说明，下半部分的选框内容则是用户

在“Parameters”选项卡中填写的参数内容，可以在该对话框中填入变量
m的数值。

step 9
运行仿真。在设置参数后，运行该仿真系统，得到的结果如图

19.89所示。



图19.89 查看仿真结果

step 10
检测系统的错误检测功能。双击系统中的“Subsystem”模块，打开

对应的参数对话框，在其中输入负数参数值-3，单击“Apply”按钮，结
果如图19.90所示。

图19.90 系统提示错误信息

提示

还可以根据情况来修改Gain的具体数值，来查看系统仿真结果是否发生变化。

19.6 ABS系统——封装子系统实例



在了解如何在Simulink中创建封装子系统的方法之后，下面结合
一个具体的实例来说明如何在实际中应用封装子系统。在本实例中，

将会涉及该子系统的其他内容，在实例的对应位置将会给出相应的说

明。由于本实例比较复杂，因此将分小节详细介绍创建该系统的步

骤。

19.6.1 添加“Bang-bang controller”子系统

例19.12 利用Simulink来模拟防锁的刹车系统（Anti-Lock Brake
System），该刹车系统将根据车轮速度（Wheel Speed）和汽车角速度
（Vehicle angular speed）之间的相对延迟位移（relative Sp），来控制
是否运行汽车的刹车系统，下面详细介绍创建步骤。

step 1
添加“Bang-bang Controller”子系统模块。该模块的主要功能是判

断输入信号是否大于0：如果输入信号大于0则返回数值1；如果输入信
号小于0则返回数值-1；如果输入信号等于0则返回数值0，系统模块如
图19.91所示。

图19.91 添加“Bang-bang Controller”模块

step 2



封装子系统，并设置该子系统的图标。选中上面步骤中添加的系

统模块，然后选择“Edit”→“Mask Subsystem”命令，打开封装编辑器，
选择“Icon”选项卡，在其中输入绘图命令，如图19.92所示。

图19.92 设置封装子系统的图标

在“Drawing commands”文本框中输入的绘图命令为：

step 3
在命令窗口中演示上面绘图的结果是跳跃式的间断函数，可以在

MATLAB的命令窗口演示该命令，得到的结果如图19.93所示。



图19.93 演示子系统的图标

step 4
设置子系统的说明文字。选择封装编辑框中的“Documentation”选

项卡，在其中设置封装子系统的说明文字，如图19.94所示。



图19.94 设置子系统的说明文字

19.6.2 添加“brake torque”子系统

在本小节中，将主要讲解如何添加“brake torque”子系统，并介绍
各模块的主要功能。下面详细介绍添加的过程。

step 1
保存封装子系统的属性设置，然后添加 “刹车转矩（ brake

torque）”系统的程序模块，如图19.95所示。

图19.95 添加系统模块

step 2
分析系统模块的功能。该系统模块并不复杂，各个系统模块的属

性和功能如下所示：

 
◆ “Desired relative slip”模块：常数（Constant）模块，数值为

0.2，表示该系统自行设置的相对位移数值。
◆ 圆形求和（Sum）模块：该模块主要用来计算系统设定的相

对位移数值和系统积分得到的相对位移模块的数值差值。

◆ “Ctrl”模块：增益（Gain）模块，其目的在于将系统得到的相
对位移进行适当的缩放，其中Ctrl是系统的初始参数数值。



◆ “Relative Slip”模块：该模块的主要功能在于计算整个系统的
两个信号车轮速度（Wheel Speed）和汽车角速度（Vehicle angular
speed）之间的相对延迟位移，其具体的表达式为“1.0 - u(1)/(u(2) +
(u(2)==0)*eps)”，其中u1代表的是车轮速度，u2代表的是汽车角速
度，该信号将需要添加新的系统模块进行计算。

◆ “Bang-bang controller”模块：前面步骤中添加的封装子系统
模块。

◆ “Hydraulic Lag”模块：Transfer Fcn模块，该模块的主要功能
在于将“Bang-bang controller”模块中输出的信号通过公式转换为水力延
迟数值，其中表达式中TB是初始参数的数值。

◆ “Brake pressure”模块：积分器模块，将前面步骤计算得到的
水力延迟数值进行数值积分，得出系统的“刹车压力”数值。

◆ “Force & torque”模块：增益模块，参数数值表示的是扭矩大
小，因此，刹车压力的数值和扭矩模块相乘得到的结果就是刹车转矩

（brake torque）。

提示

关于后面的一些系统模块，由于缺乏足够的输入信号，将在后面的步骤中添加信号之后

再详细介绍具体的功能。

19.6.3 添加“tire torque”子系统

在本小节中，将主要讲解如何添加“tire torque”子系统模块，并设
置对应的属性。下面详细讲解添加过程。

step 1
添加“轮胎转矩（tire torque）”系统的程序模块，如图19.96所示。



图19.96 添加轮胎扭矩的系统模块

step 2
设置 “mu-slip friction curve”模块的属性。这个模块是 “Lookup

Table”函数模块，该模块的输入信号是计算得到的“slip”数值，输出的
数值是系数“mu”，也就是系统摩擦系数μ。该模块的属性对话框如图
19.97所示。

图19.97 Lookup Table模块的属性

step 3
分析“mu-slip friction curve”模块的数据。在“Look-up method”下拉

列表框中，选择插补数据的方法为“Interpolation-Extrapolation”，该选



项是Simulink中的默认选项，这样系统会对数据进行线性的插补和外
推。单击“Edit”按钮，可以编辑系统的输入数据，如图19.98所示。

图19.98 编辑模块的数据

提示

“Lookup Table”函数模块是Simulink中常见的非线性模块，其属于“Lookup Tables”模块库

中，Simulink提供了多维的数据查找模块，感兴趣的读者可以查看相应的帮助文件。

step 4
设置“Weight”模块的属性。这个模块是Gain模块，该Gain模块的

功能是计算物体的重量，其表达式为“m*g/4”，对应的参数对话框如图
19.99所示。



图19.99 “重量”模块数值

step 5
设置“Rr”模块的属性。该模块属于Gain模块，该Gain模块中的数

值是Rr，代表的是轮胎的半径。从“Weight”模块中输出的信号经过该
模块后的结果就是“tire torque”。

说明

当添加了上面的程序模块后，再将上面程序得出的数值和得到的brake torque相减，得到

的力矩计算结果经过“1/I”增益模块后得到加速度，然后将经过积分器模块得到速度的数值。

step 6
添加计算汽车运动角速度的程序模块，如图19.100所示。



图19.100 计算汽车运动的角速度

在所添加的模块中，首先通过“-1/m”增益模块得到汽车运动的加
速度，然后将加速度经过积分器模块得到。汽车运动的速度数值，最

后将该数值除以汽车车轮的半径，得到汽车运动的角速度

提示

在上面的系统模块中，slp和yout模块都是“To Workspace”模块，分别向MATLAB的工作空

间输入相对位移数据和各种速度、位移数据。

19.6.4 添加子系统的程序代码

在本小节中，将详细讲解如何为各子系统添加对应的程序代码。

这些程序代码的主要功能是读入系统数据、设置仿真参数等。下面详

细讲解添加步骤。

step 1



填写关于该系统的数据文件。在前一节制作的系统模块中，用户

引用了各种系统参数数值，用户在运行仿真之前必须给这些参数进行

赋值。返回到MATLAB的命令窗口，单击命令窗口工具栏中的 按

钮，或者选择菜单栏中的“File”→“New”→“M-file”命令，打开M文件
编辑器，输入下面的代码：

将其保存为“Simdata.m”文件，在用户运行该仿真系统时，将需要
首先加载该文件中的数据。

step 2
编写运行仿真系统的代码。单击命令窗口工具栏中的 按钮，或

者选择菜单栏中的“File”打开M文件编辑器，输入下面的代码：
→“New”→“M-file”命令，





将上面的代码保存为“runsim.m”文件，它将是运行该仿真的主要
代码文件。

19.6.5 添加“Subsystem”子系统

在本小节中，将详细讲解如何向整体系统添加“Subsystem”子系
统，同时讲解如何设置该子系统的属性。

step 1



添 加 新 的 “Subsystem” 模 块 。 选 择 “Simulink Library
Browser”中“Commonly Used Blocks”模块库的“Subsystem”模块，双击
该模块，将子系统默认的数据输入和数据输出模块删除，得到的结果

如图19.101所示。

图19.101添加新的“Subsystem”模块

step 2
封装上面的子系统。选中上面的子系统，单击鼠标右键，在弹出

的快捷菜单中选择“Mask Subsystem”选项，打开封装编辑器，设置子
系统的图标，如图19.102所示。

图19.102 封装子系统



单击“Apply”按钮，保存上面的设置，得到的结果如图19.103所
示。

图19.103 设置子系统的图标

step 3
设置子系统模块的外观属性。为了使系统模块的外观美观，需要

设置该模块的背景颜色和名字属性等，得到的结果如图19.104所示。

图19.104 设置系统模块的外观属性

提示

在上面的步骤中，将子系统模块的名称首先改为“Run”，之所以然后将其隐藏，是因为该

模块上的文字已经介绍了该模块的功能。

step 4
设置模块的属性。选择该系统模块，单击鼠标右键，在弹出的快

捷菜单中选择 “Block Properties”选项，打开属性对话框，选
择“Callbacks”选项卡，设置“OpenFcn”对应的调用函数，如图19.105所
示。



图19.105 设置模块的属性

在“General”选项卡中，将该模块的“OpenFcn”的调用函数设置
为“runsim”，当用户双击该模块时，Simulink将会调用runsim的M文
件。

提示

在“Callback functions list”列表框中列出了所有相关的调用函数名称，如果在右侧的选框

中编写了对应的调用函数名称，则会在列表名称后面添加*号。

step 5
查看添加的所有系统模块。前面的步骤已经添加了所有的系统模

块，可以查看完成的完整系统模块，如图19.106所示。



图19.106 完整的系统模块

19.6.6 运行仿真系统

在完成了整个系统的创建之后，将运行该仿真系统，并分析对应

的仿真结果。

step 1
运行仿真模块。在本实例中，将不能使用Simulink中的仿真按钮

得到最后的结果，而需要双击前面添加的封装子系统模块，得到的结

果如图19.107所示。



图19.107 查看仿真结果

step 2
查看MATLAB命令窗口中的数据。返回到MATLAB的命令窗口

中，查看Simulink运行仿真后的命令窗口，如图19.108所示。



图19.108 返回MATLAB命令窗口

在MATLAB的命令窗口中，选择 “Workspace”选项卡，查看
MATLAB的工作空间中的变量情况，表明通过Simulink来加载原始数
据成功，同时，在命令窗口中显示加载信息：

同时，可以查看仿真后的变量数据，例如，输入“yout”，查看最
后的输出结果，得到的结果如下：



说明

除了可以显示仿真系统得出的结果之外，还可以对仿真结果进行各种处理，这里限于篇

幅，就不详细介绍了，读者可自行尝试。

19.7 使能子系统

在Simulink中，使能（Enabled）子系统是条件执行子系统中的一
种，只有当控制信号为正值的时候，才会在仿真时间步长时执行子系

统。一般来讲，使能子系统包含一个控制信号的输入数值，该控制信

号数值可以是标量也可以是向量。当该子系统的输入变量是标量的时

候，如果该输入数值大于0，Simulink将执行该子系统；当子系统的输



入变量是向量的时候，则当向量中任何一维数据大于0时，执行该子系
统。

Simulink将会使用“zero-crossing slope”方法判断是否应该执行某个
使能子系统。如果信号穿过零点并且斜率大于0，则执行该使能子系
统；如果信号穿过零点并且斜率小于0，系统则禁止该使能子系统，下
面详细介绍使能子系统的相关知识。

19.7.1 创建使能子系统

在Simulink中提供了专门的“Enabled Subsystem”模块，可以使用该
模块来创建使能子系统，创建方法和其他子系统并没有太大的不同，

但是关于使能子系统Simulink提供了一些比较特殊的属性选项，本小
节将利用一个简单的例子说明如何创建使能子系统。

例19.13 利用4个离散模块和一个控制信号来演示Simulink中使能
子系统的工作原理。

step 1
分析系统模块，在本系统中包含的4个离散模块如下：
模块A：Unit Delay模块，样本时间为0.25秒。
模块B：Unit Delay模块，样本时间为0.5秒。
模块C：包含在“enabled subsystem”中，Unit Delay模块，样本时间

为0.125秒。
模块D：包含在“enabled subsystem”中，Unit Delay模块，样本时

间为0.25秒。

说明



之所以在该系统中添加这些系统模块，是为了造成系统信号在时间上的错开，这样就可

以在后面的步骤中显示使能子系统的启动时间。

step 2
添加系统模块，得到的结果如图19.109所示。

图19.109 添加系统模块

step 3
设置方形波属性。在系统中，控制信号是方形波，该方形波的数

值在0.375秒从0变到1，在0.875秒从1变到0，该模块的属性对话框如图
19.110所示。



图19.110 方形波的属性

step 4
添加子系统模块。双击使能子系统，在打开的模块编辑框中添加

子系统的模块，如图19.111所示。



图19.111 添加子系统模块

step 5
设置“Enable”模块的属性。双击“Enable”模块，设置模块对应的属

性，如图19.112所示。

图19.112 设置“Enable”模块的属性

step 6
运行系统仿真，得到仿真结果。将仿真时间设置为20，然后单击

模块对话框中的“开始仿真”按钮，运行系统仿真，得到仿真结果，如
图19.113所示。



图19.113 得到仿真结果

上面的仿真结果并不复杂，在这里就不详细展开说明其具体含义

了，为了便于了解整个仿真的运行情况，图19.114显示了使能子系统
的启动时间。

图19.114 使能子系统的运行情况

19.7.2 信号输出系统——使能子系统实例

在了解使能子系统的基础知识之后，本小节将使用一个综合实例

来说明如何设置使能子系统的属性，从而产生不同效果的信号。



例19.14 创建一个使能子系统模块，该子系统根据不同的属性对
同一个输入信号和控制信号产生不同的输出信号结果。

step 1
添加系统模块。根据本实例的要求，可以添加系统模块，如图

19.115所示。

图19.115 添加系统模块

step 2
设置输入信号的属性。双击“Sine Wave”模块，打开对应的属性对

话框，在其中设置输入信号的属性，如图19.116所示。



图19.116 设置输入信号的属性

step 3
查看输入信号的图形。根据所设置的属性，“Sine Wave”模块将会

产生离散的正弦函数图形，如果不太熟悉离散函数的图形特性，可以

在系统运行之前首先查看函数图形，如图19.117所示。



图19.117 查看离散函数的图形

step 4
设置控制信号的属性。双击“Discrete Pulse Generator”模块，打开

对应的属性对话框，在其中设置控制信号的属性，如图19.118所示。



图19.118 设置控制信号的属性

注意

之所以在前面的步骤中将输入信号和控制信号都设置成离散形式，是为了在后面的步骤

中比较不同的信号特征。

step 5
添加子系统的模块。双击系统中的“enab1”模块，在打开的模块编

辑器中添加对应的子系统模块，如图19.119所示。



图19.119 添加子系统模块

step 6
添加子系统的“Enable”模块属性。双击“Enable”模块，打开对应的

属性对话框，设置该模块的属性，如图19.120所示。

图19.120 设置“Enable”模块的属性

在属性对话框中，将 “States when enabling”下拉列表框设置
为“reset”，表明当系统启动“使能”子系统模块时，将会把所在子系统
所有内部状态重新设置为初始数值。

step 7



设置子系统中“Out1”模块的属性。选择子系统中的“Out1”模块，
单击鼠标右键，在弹出的快捷菜单中选择“Outport Parameters”选项，
打开对应的属性对话框，在其中设置该模块的属性，如图19.121所
示。

图19.121 设置输出模块1的属性

在属性对话框的“Output when disabled”下拉列表框中选择“reset”，
该选项属性表明当系统中的使能子系统没有运行的时候，输出信号使

用的是“Reset”状态。同时，设置该输出模块的初始数值为5，当系统
恢复初始状态时，将保持数值为5。

提示

在上面的系统模块中，当运行使能子系统时，“使能”状态数值为“Reset”；但是，仅仅设

置这个属性选项还不能确定输出信号的属性。因此，有必要设置输出模块的信号输出的属

性。



step 8
设置子系统中“Out2”模块的属性。选择子系统中的“Out2”模块，

单击鼠标右键，在弹出的快捷菜单中选择“Outport Parameters”选项，
打开对应的属性对话框，在其中设置该模块的属性，如图19.122所
示。

图19.122 设置输出模块2的属性

在“Output when disabled”下拉列表框中选择“held”，该选项属性表
明当系统中的使能子系统没有运行的时候，输出信号使用的

是“held”状态。同时，设置该输出模块的初始数值为“[]”，当系统恢复
初始状态时，将保持数值为0。

step 9



添加第二个子系统的模块。双击系统模块中的“enab2”模块，打开
模块编辑器，在其中添加该系统的模块，如图19.123所示。

图19.123 添加第二个子系统的模块

上面的子系统模块和第一个子系统模块类似，只是在属性上有点

差别。其中，“Enable”模块的状态属性为“held”；第一个输出模块的状
态属性也是“held”，同时初始数值为1；第二个输出模块的状态属性
是“held”，初始数值为0。

step 10
运行系统仿真。单击模块编辑器中的“开始仿真”按钮，运行整个

系统，得到的结果如图19.124所示。



图19.124 查看系统仿真的结果

提示

可以看出，尽管输入信号和控制信号完全相同，但是当为“Enable”模块和输出模块设置不

同的状态属性的时候，得出的结果会完全不同。

19.8 触发子系统

在Simulink中，触发（Triggered）子系统是条件执行子系统中的
一种，该子系统只有当触发事件（或者是信号）发生的时候才会执

行。一个典型的触发子系统包括信号控制输入端口，也被称为触发输

入端口，这个端口输入的信号将决定执行子系统的条件。

19.8.1 触发子系统简介

可以设置三种类型的触发事件来触发不同的子系统，各种触发事

件的情况如下：

 



◆ rising：当控制信号从负数或者零转换到正数，或者当初始数
值为负时，信号转换到零的时候，将会触发该子系统。

◆ falling：当控制信号从正数或者零转换到负数，或者当初始数
值为正时，信号转换到零的时候，将会触发该子系统。

◆ either：当系统发生上面两种情况中任何一种时，都会触发子
系统。

提示

如果在离散系统中使用了触发模块，只有当信号在上升或者下降之前，多于单位时间步

的时间范围内保持数值0，才会触发子系统，这样就可以避免因为系统采样而触发子系统。

 
为了演示上面的提示信息，可以查看离散系统的时间图表，如图

19.125所示。

图19.125 离散系统的时间图表

在图19.125中，在时间t＝3的时候，rising(R)触发系统不会发生，
因为，在该时间步信号上升之前，仅保存了一个时间段的零值，因此

不能触发子系统。

19.8.2 触发子系统的属性



在本小节中，将以一个比较简单的实例介绍触发子系统的触发属

性，为了让读者了解详细的属性内容，下面将分步骤详细介绍。

例19.15 创建简单的触发子系统模块，使用不同的触发类型，得
出不同的输出信号。

step 1
分析系统的输入信号。在本实例中，将选择频率为8rad/sec的正弦

波作为系统的输入信号，其对应的属性如图19.126所示。

图19.126 系统输入信号的属性

提示

在上面的系统模块中，为了方便在后面的步骤中分析子系统的性能，需要显示该波形的

主要属性：频率。在其模块属性对话框的 “Block Annotation”选项卡中添加 “Freq: %



<Frequency> rad/sec”的描述性文字，其语法在前面章节中已经介绍过，这里就不详细介绍

了。

step 2
分析系统的控制信号。在本实例中，将选择频率为1Hertz的方形

波作为系统的控制信号，其对应的属性如图19.127所示。

图19.127 系统控制信号的属性

在“Wave form”下拉列表框中选择“square”类型，表示控制信号类
型为方形波，同时在“Frequency”文本框中输入“1”，在“Units”下拉列
表框中选择“Hertz”作为频率单位，因此也就设置了该方形波的频率为
1Hertz。

说明

在实例中，输入信号是连续的正弦函数图形，控制信号则是离散的方形波图形，这样设

置的目的在于更方便地分析触发子系统的性能。

step 3



添加系统模块。根据前面步骤设置的输入信号和控制信号，可以

添加对应的系统模块，如图19.128所示。

图19.128 添加系统模块

提示

在该系统模块中总共有三个触发子系统，分别是三种不同的触发类型，从上向下依次

为：Rising、Falling和Either。该三种触发机制对应的输入信号和控制信号都相同，因此可以

比较因为出发机制不同得出的不同结果。

step 4
运行系统仿真。当添加了所有模块后，运行系统仿真，结果如图

19.129所示。



图19.129 查看不同的输出信号

在图19.129所示的图形结果中，第一幅图形显示的是输入信号和
控制信号，第二幅图形显示的是Rising触发子系统的输出结果，第三
幅图形显示的是Falling触发子系统的输出结果，第四幅图形显示的是
Either触发子系统的输出结果。
可以看出，在Simulink中，触发子系统一旦被触发，其输出结果

就会保持不变，直到下次系统被再次触发为止。在Simulink中，触发
子系统的输入信号也可以是向量，如果是向量输入信号，则向量中的

一个分量信号触发了系统，则子系统就会被触发。



提示

在Simulink中，还可以使用function-call函数的方式调用触发子系统，由于这种触发方法

必须和S函数配合使用，在这里就不详细介绍了。

19.9 触发子系统实例

在本节将通过一个比较综合的实例来介绍如何使用触发子系统仿

真某机械从启动到均衡速度的过程，该过程将涉及节流系统

（Throttle）、吸气系统（Intake）、压缩系统（Compression）、燃烧
系统（Combustion）和机械系统（Vehicle Dynamics）等。
在运行的整个过程中，其中机械最个系统的气阀吸气终的运行速

度 将 会 影 响 整 速 度 ， 从 而 制 约 该 综 合 系 统 的 压 缩 系 统

（Compression），在Simulink中，该部分的功能将需要通过触发系统
实现，由于整个系统比较复杂，下面将分小节详细介绍该系统的实现

过程。

19.9.1 添加系统模块

例19.16 创建仿真系统实现某机械的发动机从启动到真正运行阶
段的物理系统。

step 1
添加整个机械的发动机运行模块，得到的结果如图19.130所示。



图19.130 整个机械运行的系统模块

在系统模块中，为了便于分辨整个系统中的不同模块，对包含了

子系统的模块都设置了模块阴影，因此，包含子系统的模块

有 ： “Throttle & Manifold” 、 “Intake” 、 “Compression” 、 “valve
timing”、“Combustion”、“Drag Torque”和“Vehicle Dynamics”等，这些
模块分别代表了整个系统中的某个部分，分别实现对应的系统功能。

说明

由于整个系统比较复杂，在这里将无法完全按照步骤来介绍该系统的搭建过程，因此，

在本小节中将介绍该系统中比较重要的模块属性。

step 2
设置“throttle”模块的属性。在本模块系统中，“throttle”模块的功

能是输出调节阀的角度θ，从属性角度来看属于“阶跃”波形，该阶跃波
形在t=5s的时刻从初始数值8.973跳跃到11.93，然后保持不变，其对应
的属性对话框如图19.131所示。



图19.131 设置输出信号的属性

提示

在比较复杂的系统中，系统模块的初始数值是比较重要的参数，这些数值将直接影响整

个系统的运行情况。

19.9.2 设置“Throttle & Manifold”子系统属性

从本小节开始，将需要设置该系统中各子系统的属性。本小节

中，将首先设置“Throttle & Manifold”子系统的模块属性。具体操作步
骤如下。

step 1
设置 “Throttle & Manifold”子系统的模块。双击 “Throttle &

Manifold”模块，在打开的模块编辑器中，添加对应的系统模块，如图
19.132所示。



图19.132 设置“Throttle & Manifold”子系统模块

step 2
分析子系统模块的功能。上面的子系统模块的功能是通过两个输

入信号变量：Throttle Angle和Engine Speed，经过必要的模块运算，得
到输出变量“Mass Airflow Rate”。其具体的转换方式为：通过其中的子
系统将变量Throttle Angle（气压阀角度）、Manifold Pressure（支管压
力）和Atmospheric Pressure（大气压力）通过计算得到变量Throttle
Flow（气压流体）；然后将计算得到的变量和Engine Speed（发动机
速度）通过下一个子系统模块得出输出变量mdot to Cylinder（汽缸速
度）和Manifold Pressure（支管压力）。

step 3
设置“Saturation”模块的属性。“Saturation”模块的目的是为了控制

输入信号的角度范围，其属性如图19.133所示。



图19.133 设置控制信号的属性

step 4
添加计算变量Throttle Flow（气压流体）的子系统模块。双击系统

的Throttle Flow（气压流体）的模块，在其中添加子系统的模块，如图
19.134所示。

图19.134 计算中间参量的子系统模块



step 5
分析子系统模块的功能。

在上面的模块中，首先将调节阀的角度θ通过经验公式f（θ）计算
出中间参数数值δ1，其中f（θ）的具体表达式为：2.821－0.05231θ＋
0.10299θ2－0.00063θ3

然后计算变量Manifold Pressure（支管压力）和Atmospheric
Pressure（大气压力）的数值比例λ，通过程序模块保证λ＜1，然后当λ
小于0.5时，中间参数数值δ2就等于常数Sonic Flow；当λ大于0.5时，将
其通过公式 计算得到中间参数数值 δ2。最后，通

过“signum”模块计算流体压力的方向，当大气压力大于支管压力的时
候，选择正号；当大气压力小于支管压力的时候，选择负号。

在子系统的最后，将两个中间参数相乘得到变量Throttle Flow（气
压流体）的数值，上面的计算公式相当于： Throttle－Flow＝
signum（Pm－Pa）×δ1×δ2。

提示

在上面的分析过程中，多次出现了以经验公式计算某些物理参量，至于这样经验公式的

由来和具体的参数含义，由于过于专业，这里就不详细介绍了，读者也没有太大的必要了解

具体的含义。之所以在这里展开分析具体的含义，是为了读者更加熟悉模块的功能。

step 6
添加计算输出变量mdot to Cylinder（汽缸速度）和Manifold

Pressure（支管压力）子系统模块，添加的系统模块如图19.135所示。



图19.135 计算中间参数的子系统模块

step 7
分析子系统模块的功能。这个子系统模块并不复杂，假定

Manifold Pressure（支管压力）为变量x，mdot to Cylinder（汽缸速
度）为变量y，上面的系统相当于求解下面的方程组：

在上面的方程组中，v代表的是系统最后求得的发动机速度，T－
F就是在上面子系统模块中求得的变量Throttle－Flow的数值，其中
0.41328是量纲转换系数。

注意

由于整个系统比较复杂，在求解某个变量的时候，除了需要了解各个变量的物理含义之

外，还需要了解各个变量的物理单位。在不同量纲的物理量之间进行转换的时候，有时必须

注意量纲转换的系数问题。

19.9.3 设置“Intake”子系统属性



本小节将主要讲解如何设置“Intake”子系统的属性，具体操作过程
如下。

step 1
设置“Intake”模块的属性。双击系统中的“Intake”模块，设置该积

分器的重设属性，如图19.136所示。

图19.136 设置积分器模块的属性

step 2
分析“Intake”模块的属性。在属性对话框中，将积分器的“External

reset”属性设置为 “either”，该积分器的主要功能是将 “Throttle &
Manifold”子系统模块输出的中间变量进行积分，得到的结果是整个系
统吸入的气体质量。这一点可以从量纲的角度分析，变量Mass Airflow
Rate的单位是g/s，经过积分得到的物理量的单位是g。

提示



由于所有的变量都是中间参量，因此在系统中使用的是该积分器模块的状态端口，而不

是输出端口。因此为了避免输出端口悬垂，添加了“Terminator”模块。

19.9.4 设置“Compression”子系统属性

本小节将主要讲解如何设置“Compression”子系统的属性，下面详
细讲解操作过程。

step 1
设 置 “Compression” 子 系 统 模 块 的 属 性 。 双 击 系 统 中

的“Compression”模块，添加对应的系统模块，如图19.137所示。
在 “Compression”模块中，将积分器模块中输出的 “质量 ”变量数
值“mass(k+1)”输入到该子系统中，经过Unit Delay模块得到压缩后的气
体质量“mass(k)”。

图19.137 “Compression”子系统模块

step 2
设置“Trigger”模块的属性。双击“Trigger”模块，打开模块的属性

对话框，设置整个系统的触发类型，如图19.138所示。



图19.138 设置触发器类型

19.9.5 设置“Combustion”子系统属性

本小节将主要讲解如何设置“Combustion”子系统的属性，下面详
细讲解操作过程。

step 1
设置“Combustion”子系统的模块。双击系统中的“Combustion”模

块，添加对应的系统模块，如图19.139所示。

图19.139 设置“Combustion”子系统模块

step 2



分析“Combustion”子系统的功能。在该子系统模块中，首先将变
量Air Charge、Stoichiometric Fuel（化学燃料）和Spark Advance（进
给）通过下面的经验公式得到发动机扭矩的第一部分数据δ1：

然后将变量Air Charge、Spark Advance（进给）和发动机速度通
过下面的经验公式得到发动机扭矩的第二部分数据δ2：

最后，通过加法模块将上面两个部分的数据相加得到发动机的扭

矩数值：

δ＝δ1＋δ2

说明

在上面的公式中，变量Stoichiometric Fuel（化学燃料）和Spark Advance（进给）都是常

数变量模块，而另外两个变量则是经过系统运算得到的中间变量。

19.9.6 设置“Drag Torque”子系统属性

本小节将主要讲解如何设置“Drag Torque”子系统的属性，下面详
细讲解操作过程。

step 1
设置“Drag Torque”子系统的模块。双击系统中的“Drag Torque”模

块，添加对应的系统模块，如图19.140所示。



图19.140 设置“Drag Torque”子系统的模块

在上面的模块中，将输出该系统的阻力矩的数值，其由两种阶跃

波形相互叠加而得到，这是一种简化的阻力矩，两种阻力矩的主要参

数分别如下：

跳跃时间：2s；初始数值：25；终止数值：20。
跳跃时间：8s；初始数值：0；终止数值：5。

step 2
显示叠加信号的结果。为了让用户有一个更加完整的印象，可以

使用Scope模块来显示两个信号叠加后的结果，如图19.141所示。



图19.141 阻力矩的信号图形

19.9.7 设置“Vehicle Dynamics”子系统属性

本小节将主要讲解设置“Vehicle Dynamics”子系统的属性，下面详
细讲解操作过程。

step 1
设置“Vehicle Dynamics”子系统的模块。双击系统中的“Vehicle

Dynamics”模块，添加对应的系统模块，如图19.142所示。

图19.142 设置“Vehicle Dynamics”子系统的模块

step 2
分析“Vehicle Dynamics”子系统的功能。在该子系统模块中，将前

面步骤中计算得到的发动机扭矩和阻力矩相减，得到发动机实际承受

的动力矩，然后将其和逆惯性距相乘再经过积分，得到发动机的速度

N。

提示

根据量纲分析，经过该系统得到的发动机速度的量纲是rad/s，也就是弧度每秒，但是本

实例中需要得到的单位是rpm，因此还需要经过量纲的转换工作。

19.9.8 设置“valve timing”子系统属性



本小节将主要讲解设置“valve timing”子系统的属性，下面详细讲
解操作过程。

step 1
设置“valve timing”子系统的模块。双击系统中的“valve timing”模

块，添加对应的系统模块，如图19.143所示。

图19.143 设置“valve timing”子系统的模块

在上面的程序模块中，首先通过输入端口输入发动机速度进行

TDC（上死点）和BDC（下死点）的检测，输出触发的信号，然后设
置触发器模块的属性，得出输出信号。

step 2
添加“TDC and BDC detection”子系统模块。双击系统中的“TDC

and BDC detection”模块，打开对应的模块添加模块，在其中添加系统
模块，如图19.144所示。

图19.144 “TDC and BDC detection”模块

在该模块中，将发动机的转速进行积分得到发动机旋转的弧度，

然后将弧度和π进行比较，如果积分的结果超过π，就将积分器进行重



设，重新运行积分。

step 3
设置积分器模块的属性。双击系统中的积分器模块，打开对应的

模块属性对话框，设置积分器属性，如图19.145所示。

图19.145 设置积分器的属性

step 4
设置“positive edge to dual edge conversion”子系统模块。双击系统

中的“positive edge to dual edge conversion”模块，在其中添加系统模
块，如图19.146所示。



图19.146 设置子系统模块

19.9.9 运行仿真系统

前面已经完成了整个系统的创建过程。接下来将运行该仿真系

统，并分析对应的仿真结果。

step 1
运行仿真系统。前面的步骤已经完成整个系统的模块设置，现在

可以运行整个系统，得到仿真结果，如图19.147所示。



图19.147 发动机速度

step 2
分析仿真结果。从结果中可以看出，发动机的速度有一个启动过

程，然后在10s左右保持稳定，达到最后的均衡速度。

19.10 小结

本章主要介绍了Simulink中的一些高级技术，主要包括线性和非
线性建模。同时，本章还详细讲解了Simulink中的重要子系统：封装
子系统、使能子系统和触发子系统，并分别使用综合的典型例子说明

如何使用这些子系统。在后面的章节中，将重点讲解另外一个重要技

术：S函数。

◆   ◆   ◆



第20章 S函数和仿真结果分析

本章包括

◆S函数原理

◆S函数模块

◆分析Simulink模块

◆系统平衡点分析

 
在本章中，将介绍Simulink仿真中的重要技术：S函数。S函数是

一种描述动态系统的计算机语言，用户可以直接使用M函数文件编
写，也可以使用C、C++、Ada或者Fortran等语言编写。在本章中，将
详细讲解如何编写S函数。同时，在介绍仿真的技术之后，将详细讲
解如何分析仿真结果。

20.1 S函数

在 Simulink中， S函数（ S-Function）或者系统函数（ System
Function）是用户用来自建Simulink模块所需要的、而且具有调用格式
的函数文件。通过C、C++、Ada或者Fortran语言编写的S函数将需要
通过编译而生成MEX文件，然后就可以像其他MEX文件一样动态连接
MATLAB。限于篇幅，本节只介绍使用MATLAB语言编写的S函数。

20.1.1 S函数概述



在Simulink中，S函数采用一种特殊的调用语法使得函数可以和
Simulink方程解法器进行交互，这种形式的交互和解法器和Simulink系
统自身提供的模块之间的交互十分相似。S函数的形式比较通用，用
户可以使用S函数来描述连续、离散和混合系统。
一般而言，S函数可以使用在以下场合：
 
◆ 生成用户自行研究中可能反复调用的S函数模块。
◆ 可以创建代表硬件驱动的模块。
◆ 用户可以通过S函数将某个系统描述成一组数学方程组。
◆ 构建用于图形动画表现的S函数模块。
 
使用S函数的最主要的优点就是S函数模块可以被重用于各种场

合，该S函数模块又可以通过设置不同的参数来显示不同的特性。

提示

在Simulink中，用户只需遵循一些简单的原则，就可以将自己设计的算法用S函数来实

现，当用户编写好自己的S函数后，就可以在后续操作中调用该函数，并封装该函数。

20.1.2 S函数的运行机理

为了帮助读者更好地理解S函数，在详细介绍S函数的各种属性之
前，首先简要地介绍S函数的基本运行机理。在Simulink仿真过程中，
将各种状态方程对应成为不同的仿真阶段，在仿真的开始和结束，还

包括系统的初始化和结束任务两个阶段。在以上每一个仿真阶段，

Simulink都会重复地调用模型。Simulink的仿真流程如图20.1所示。



图20.1 Simulink的仿真流程

根据流程图可知，在仿真的初始化阶段，Simulink会将库中的模
块并入用户自行创建的模型中，确定模块端口中的数据类型、采样时

间，并评估模块的参数，决定模块运行的优先级，然后进行仿真循

环，每一次的仿真循环就被称为仿真步。在每一个仿真步的不同仿真

阶段，系统会按照优先级运行模块。当系统完成某个仿真循环后，就

会进入下一个循环仿真步，如此循环直到仿真结束。

说明

如果在仿真运行中设置了积分的时间步长，那些Simulink会对时间步长进行细化，然后进

行系统的仿真。

 
在Simulink中，S函数是由一系列回调方法组成的，在每个仿真阶

段，Simulink会调用相应的回调方法来执行相应的任务，和一般模型



的仿真类似，S函数的回调方法会完成和流程类似的任务，这里就不
重复介绍了。

20.1.3 S函数模板

在MATLAB的早期版本中，S函数的编写工作比较随意，对于开
发人员和用户而言，这种随意的要求使得用户用在S函数的编写上的
精力和时间都比较多，而在MATLAB 6.x版本后，MATLAB提供了编
写S函数的M文件标准模板，使得S函数的开发效率大大提高，开发的
S函数结果可靠性也显著提高。
其中，S函数M文件形式的标准模板是特殊的M文件，名为

sfuntmpl.m 。 默 认 情 况 下 ， 其 保 存 路 径 的 目 录 为

MATLAB7.0\toolbox\simulink\blocks。为了简便描述该函数文件，下面
简要给出该模板文件，并给出对应的说明文字。



在以上程序代码模板中，多次引用了系统函数simsizes，默认情况
下，其保存路径的目录为MATLAB7.0\toolbox\simulink\simulink。该函
数的主要目的在于设置某个S函数的大小，具体的函数程序代码如
下：



下面再对模板函数代码进行简要的说明：

在函数function [sys,x0,str,ts] = sfuntmpl(t,x,u,flag)中，对应的输入
参数如下：



 
◆ t 表示当前时刻，采用绝对计量的时间数值。
◆ x 表示模块的状态向量。
◆ u 表示模块的输入向量。
◆ flag 程序的标记变量，对应不同的操作类型。
 
其对应的状态过程模块如图20.2所示。

图20.2 系统的状态过程模块

20.1.4 添加S函数模块

在本小节中，将用一个简单的仿真系统，来演示如何在Simulink
中使用S函数编写程序模块，达到有限积分的功能，下面分步骤详细
介绍。

例20.1 创建一个简单的实例，来说明如何创建S函数。

step 1
打开Simulink的空白模板编辑器，向其中添加正弦函数模块，将

其振幅设置为5，该函数模块将作为输入信号，如图20.3所示。



图20.3 添加输入信号模块

step 2
添加S函数模块和示波器模块。选择Simulink中 “User-Defined

Functions”模块库中的S-Function模块，将其添加到模块编辑器中，然
后将其名称改为“Limit integrator by m-file S-Function”，如图20.4所
示。

图20.4 添加S函数模块

step 3



封装S函数模块。选择模块中的S函数模块，单击鼠标右键，在弹
出的快捷菜单中选择“Mask S-Function”命令，如图20.5所示。在选择
了对应的菜单选项后，就会弹出对应的封装对话框，选择“Icon”选项
卡，在其中设置封装子系统的图标，如图20.6所示。

图20.5 封装S函数模块



图20.6 设置封装子系统的图标

step 4
设置仿真模块的参数。选择“Parameters”选项卡，在其中设置仿真

模块的参数数值，如图20.7所示。



图20.7 设置仿真模块的参数

提示

在“Parameters”选项卡中分别设置了积分的上、下限和初始状态，其中变量名称分别和S

函数中的名称相对应。

step 5
设置仿真系统的说明文字。选择“Documentation”选项卡，在其中

设置封装子系统的说明文字，如图20.8所示。



图20.8 设置仿真系统的说明文字

step 6
查看封装后的子系统模块。完成所有设置后，系统模块如图20.9

所示。

图20.9 完成后的系统模块

20.1.5 添加S函数程序代码

在添加了S函数的模块之后，将对S函数的模块添加相应的程序代
码。下面详细介绍操作步骤。

step 1



设置仿真系统的函数参数。选择模块中的S函数模块，单击鼠标
右键，在弹出的快捷菜单中选择“S-Function Parameters”选项，如图
20.10所示。当选择了对应的菜单选项后，可以打开S函数参数对话
框，如图20.11所示。

图20.10 设置仿真系统的函数参数

图20.11 S函数的参数设置

step 2



添加S函数的程序代码。在“S-Function Name”文本框中输入函数名
称 “limintm” ， 在 “S-Function Parameters” 文 本 框 中 输 入 参 数 名
称“lb,ub,xi”。单击“Edit”按钮，就可以查看对应的S函数，其代码如
下：

说明



以上代码就是对应的S函数，其整体的框架和Simulink提供的S函数模板大致相同，这里

就不重复介绍了。

step 1
设置仿真运行的参数。双击系统的S函数模块，打开对应的模块

参数对话框，在其中设置积分参数，如图20.12所示。

图20.12 设置积分的上下限

在对话框中，将积分的上限设置为3，积分的下限设置为-3，然后
将积分的初始数值设置为1，单击“Apply”按钮，保存所有的设置。最
后单击“OK”按钮，关闭对话框。

20.1.6 运行仿真

在完成了仿真模块和代码的添加之后，同时设置了仿真的参数。

在本小节中，将讲解如何运行该仿真系统。

step 1



运行系统仿真。将系统仿真的时间设置为14，然后单击“开始仿
真”按钮，得到的仿真结果如图20.13所示。

图20.13 得到仿真结果

step 2
修改系统仿真参数，重新运行仿真。双击S函数模块，打开函数

参数的设置对话框，在其中重新设置系统参数，如图20.14所示。

图20.14 重新设置仿真参数



step 3
重新运行仿真。设置参数后，单击“OK”按钮，然后重新运行仿

真，结果如图20.15所示。

图20.15 新的仿真结果

20.2 振荡运行系统——S函数综合实例

本节将介绍如何在Simulink中使用S函数来模拟动态物体和弹簧系
统的运动，首先根据物理知识列出物体的状态微分方程，然后根据微

分结果变量参数来编写对应的S函数，实现实体动画的演示。同时，
本实例还将涉及读取数据、状态分析等关于Simulink的多种知识，下
面分小节详细介绍。

20.2.1 添加系统模块

例20.2 创建两个物体和弹簧系统振荡运动的仿真模型。



step 1
添加系统模块。由于本实例中的系统模块比较复杂，在本章的开

始首先给出所有的系统模块连接方法，然后再分步骤详细介绍每个模

块的属性，如图20.16所示。

图20.16 添加系统模块

step 2
设置输入信号的属性。在本实例中，输入信号是方形波，代表的

是左侧物体所承受的周期外力，其具体的属性如图20.17所示。

图20.17 方形波的属性



step 3
设置“Plant”模块的属性。在本实例中，“Plant”模块属于“State

Space”模块库，代表了该系统运动的微分方程组，其属性如图20.18所
示。

图20.18 设置“Plant”模块的属性

step 4
分析“Plant”模块的原理。该模块定义的微分方程组是系统运动的

核心方程组，因此有必要在这里详细展开介绍。根据所设置的模块参

数，x′＝Ax＋Bu对应的微分方程组如下：



在方程组中，参量x1（t）和x3（t）分别表示左边、右边物体的位
移（或者被认为坐标），m1和m2分别表示左边和右边物体的质量，

x2（t）和x4（t）是方程组中的中间变量，其物理含义分别是两个物体
运动的速度，但是在本实例中并不处理这些变量，只是用作设置方程

组的中间变量；u表示左侧物体所承受的外力（也就是外部信号），其
由两个部分组成，一部分是方形波输入信号，另外一个部分则是自反

馈的信号。

根据下一个方程y＝Cx＋Du，得到的关系等式如下：

其中y表示的是该模块的输出信号，参量x1（t）和x3（t）分别表
示左边、右边物体的位移。

说明

可以看出，该“State Space”模块输入物体系统的受力信号，然后根据运动的微分方程组，

得到两个物体运动的位移信号。



step 5
设置“Demux”模块的属性。在本实例中，“Demux”模块的功能在

于将上面模块中的输出信号y进行分割，其属性如图20.19所示。

图20.19 设置“Demux”模块的属性

在对话框中，将“Display option”下拉列表设置为“none”，同时取
消选中“Bus selection”复选框，因此该模块在外观上就和普通模块一
致。同时，将上个步骤的输出信号y分割为一个二维向量y1和一个一维

向量信号y2。其中，二维向量信号y1为：

因此，和“Actual Position”示波器模块相连的输入信号y1是两个物

体运动的位置，在进行实体仿真过程中，该示波器将显示两个物体的

位移情况。

20.2.2 添加S函数的程序代码



在添加了S函数的模块之后，将对模块添加相应的程序代码。下
面详细介绍操作步骤。

step 1
设置“Animation function”模块的属性。在本实例中，“Animation

function”模块的功能在于设置S函数实现实物的仿真，其属性如图
20.20所示。

图20.20 设置“Animation function”模块的属性

step 2
添加S函数的程序代码。在参数设置对话框中，单击“Edit”按钮，

就可以打开仿真函数的代码：





在以上代码中，首先创建了新的图形界面，然后在该图形窗口界

面上添加物体对象，并通过高级句柄语言来设置物体运动的坐标信

息，实现最后的动态运动。



20.2.3 添加子系统模块

在本实例中，需要添加子系统模块，该模块的主要功能是输入振

荡系统的信号，并输出对应的结果。下面详细介绍操作的步骤。

step 1
添加“Inputs & Sensors”子系统的模块。双击“Inputs & Sensors”模

块，打开模块编辑器，在其中添加子系统的模块，如图20.21所示。

图20.21 添加“Inputs & Sensors”子系统的模块

在本实例中“Inputs & Sensors”子系统的功能是将两组信号合并为
一个向量，其中一组信号为u（也就是以上合成的输入信号），另外一
组信号是一维向量信号y2＝x3（t），得到的输出结果信号是：

step 2
添加“State estimator”子系统的模块。双击“State estimator”模块，

打开模块编辑器，在其中添加子系统的模块，如图20.22所示。

图20.22 添加“State estimator”子系统的模块



step 3
设置“State estimator”模块的属性。双击“State estimator”模块，打

开对应的属性对话框，如图20.23所示。

图20.23 设置模块的属性

step 4
查看参数数值。在参数对话框中，ae、be、ce和de都是在运行仿

真系统之前加载的变量参数，其具体的数值可以使用MATLAB的相关
命令获得，结果如下：



可以看出，ae和ce是4×4的矩阵，be和de是2×4矩阵，根据“State
Space”模块的属性特点，该模块的输出变量是一个四维的向量，其次
序和前面步骤中设置的变量次序相同。

说明

关于该微分方程组的含义，可以参看前面的步骤进行分析，和前面的一个明显不同在

于，其输入变量是一个二维向量，而不是一维标量。

step 5
设置“Inputs & Sensors1”模块的属性。在本系统中，“Inputs &

Sensors1”模块的功能是进行信号选择，其属性如图20.24所示。



图20.24 设置信号选择的属性

在对话框中的“Elements”文本框中输入“[1 3]”，表示选择输入信号
的第一列和第三列的信号，分别表示通过模拟系统微分方程得到的两

个物体运动的位移；在“Input port width”文本框中输入“4”，表示输入
信号为4维向量，也就是通过“State estimator”子系统的模块输出的
x1（t）、x2（t）、x3（t）和x4（t）信号。

step 6
添加“Feedback gain using LQR design”子系统的模块。在本实例

中，该模块的功能是输出反馈信号，其具体的子系统模块如图20.25所
示。

图20.25 添加反馈信号的模块



step 7
设置“Feedback gain using LQR design”模块的属性。双击“Feedback

gain using LQR design”模块，打开对应的属性对话框，在其中设置模
块参数，如图20.26所示。

图20.26 设置模块的属性

说明

在模块对话框中的参数k也是在运行系统之前加载的数值变量，具体数值可以在MATLAB

命令窗口中查看，这里就不重复介绍了。

step 8
封装以上子系统。由于上面子系统的功能是对参数进行放大，所

以有必要将其进行封装，设置封装系统图标的对话框如图20.27所示。
设置封装子系统的参数对话框如图20.28所示。



图20.27 设置封装子系统的图标

图20.28 设置封装子系统的参数

step 9



设置系统的模块属性。在模块编辑器中单击鼠标右键，在弹出的

快捷菜单中选择“Model Properties”命令，打开“Model Properties”对话
框，选择“Callbacks”选项卡，在“Model pre-load function”选框中输
入“load sim38”，如图20.29所示。

图20.29 设置系统的加载函数

step 10
查看仿真系统的数据文件。在以上命令行中，sim38是关于该系统

参数的mat数据文件，用户可以通过加载数据的命令来查看该数据文件
的内容，如图20.30所示。



图20.30 查看数据文件

20.2.4 运行仿真系统

前面小节已经完成了仿真模块和代码的添加，同时设置了仿真的

参数。在本小节中，将讲解如何运行该仿真系统。

step 1
运行系统仿真。将系统的仿真时间设置为10000，然后单击“开始

仿真”按钮，得到动态仿真的结果，选取其中两个仿真画面来显示仿真
结果，如图20.31和图20.32所示。



图20.31 动态仿真画面1

图20.32 动态仿真画面2

step 2
查看示波器的图形。用户可以查看两个物体位置的变化情况，其

中“Actual Position”示波器中显示的图表如图20.33所示。而通过系统仿
真得到的模拟位移图形如图20.34所示。



图20.33 两个物体的真实位移图形

图20.34 通过仿真得到的位移图形

step 3
查看系统模块的变化。当仿真结束后，系统模块的改变情况如图

20.35所示。



图20.35 运行后的系统模块

提示

由于在以上模块中，有些模块的输入或者输出信号是多维向量，因此在运行系统仿真

后，对应的信号连接线会被加粗，来提示用户该信号是多维向量。

20.3 分析仿真结果

在前面的章节中已经介绍了关于Simulink中几个创建的内容，本
节将介绍如何对各种仿真系统的结果进行分析。分析仿真结果也是创

建仿真系统的重要部分，了解仿真结果，对仿真结果进行处理，是仿

真模型分析的重要步骤，下面分小节详细分析。

20.3.1 分析Simulink模型的特征

在某些情况下，用户需要在命令窗口中对Simulink的模型属性进
行分析，然后再根据仿真系统的属性特征进行处理。主要的属性包

括：系统模型中包含了多少连续状态、包含了多少离散状态、模型中

那些模块对应着状态向量中的哪个分量等。

前面已经介绍过，在本质上Simulink模型都是图形化的微分或者
差分方程，无论是高阶微分或者差分方程，还是传递函数，Simulink
都是使用连续或者离散的状态方程加以描述。Simulink模型库中的积
分器模块、传递函数模块和状态空间模块都分别对应着连续或者离散

的状态变量。

在Simulink中，从模型中获取状态信息的命令就是模型名称本
身，但是不能包含扩展名，具体的调用格式如下：



下面以具体的实例来介绍该命令的使用方法。

例20.3 使用命令来分析前面例子中的Anti-Lock Brake System的
模块属性。

step 1
根据前面章节中的内容，该系统的模块如图20.36所示。

图20.36 系统的模块

step 2
查看该模块的属性特征。在MATLAB的命令窗口中输入以下命

令：



注意

由于以上系统运行系统仿真之前，需要加载关于系统参数的数据文件，因此在了解这些

属性之前，需要首先运行仿真，加载对应的数据。

 
下面简要介绍代码的结果：

 
◆ Sizes：Sizes是一个7维向量，对应各分量向量的含义如下：
 
●Sizes(1)：表示状态向量中的连续分量个数。
●Sizes(2)：表示状态向量中的离散分量个数。
●Sizes(3)：表示输出分量个数。
●Sizes(4)：表示输入分量个数。
●Sizes(5)：表示系统中不连续解的个数。
●Sizes(6)：表示系统中是否包含直通回路。
●Sizes(7)：表示状态中不同采样速率的个数。
 



◆ X0：返回模型状态向量的初始数值。在Simulink中，积分器
所设置的初始数值可以被模型窗口仿真参数对话框中的参数设置来修

改，而在仿真参数对话框中设置的初始值又可以在命令窗口中的x0初
始值来重新设置。

◆ StateCell：是一个元胞数组，依次给出了所有状态变量对应
模块所在的模块名称、子系统名称和模块名称。

说明

根据以上介绍，sim32系统中包含了5个连续状态变量，同时包含了2个不同的采样速率，

系统可以在时间上分成2个部分。

20.3.2 使用Sim命令

当用户在模型窗口中直接运行某个系统的仿真时，每一运行都是

针对某一个固定的模块参数设置，在运行过程中一般不能轻易修改这

些参数的数值。MATLAB中，允许用户使用命令来运行Simulink仿
真，通过命令进行模型的仿真使得用户可以从M文件运行仿真，用户
可以在程序代码中不断地修改模块参数，也可以让用户使用所有M文
件中的循环结构实现复杂的仿真过程。

在Simulink中，使用sim命令运行Simulink仿真的具体调用格式如
下：

 
◆ [t,x,y] = sim(model);
◆ [t,x,y] = sim(model,timespan,options,ut);
◆ [t,x,y1, y2, ..., yn] = sim(model,timespan,options,ut);
 
关于上面调用格式中的参数说明如下：



 
◆ model：被运行的模型名称，不包含扩展名，但是，该模型文

件必须在MATLAB的搜索路径上。
◆ y：输出矩阵，取自模型中输出端口模块的记录，y中的第k列

数值也就是第k个输出端口的时间变量记录。
◆ y1, y2, ..., yn：每个向量都是列向量，分别输出n个输出端口

模块上的记录。

◆ x：状态矩阵。每个数据列表示状态变量的记录。状态变量的
排列次序可以从前一节的StateCell中获取。

◆ timespan：用来指定仿真的时间区间，可以选取以下变量：
 
●[]：空矩阵，表示使用模块编辑器中设置的仿真时间。
●T_final：标量参数，指定的是系统仿真的终止时间。
●[T_start T_final]：二维向量参数，指定系统仿真的起始和终止

时间。

●OutputTimes：任何指定输出时间记录点的向量。
 
◆ Options：设置仿真参数中具有最高级别的优先权，它可以覆

盖模型参数对话框中的参数设置。关于Options参数的结构和设置，将
在后面的命令中详细介绍。

◆ ut：赋给仿真对象的输入端口模块的数值，具有最高的设置
优先权。

 
例20.4 使用sim命令运行Simulink的仿真文件，动态设置关于该

仿真系统的参数，然后运行得到相应的仿真结果。

step 1



查看原始的系统模块。在本例中选择的仿真文件是前面例20.2所
创建的仿真系统sim28文件，原始的系统模块如图20.37所示。

图20.37 原始的系统模块

step 2
返回到MATLAB的命令窗口中，输入以下命令代码：

在以上代码中，通过使用循环结构为该线性系统设置不同的积分

初始数值，然后通过sim命令在不同的初始条件下运行系统的仿真，最
后，通过plot命令绘制通过sim命令获取的仿真数据。

说明

在以上步骤中使用到了simset命令，该命令的主要功能是设置编辑仿真参数。

step 3
查看运行结果。在输入以上代码后，按“Enter”键，得到的图形结

果如图20.38所示。



图20.38 查看程序代码运行的结果

20.3.3 使用simset命令

前面已经提到过，使用simset命令可以设置编辑仿真参数，在
Simulink中，simset命令的常见调用格式如下：

 
◆ options = simset(property, value, ...);
◆ options = simset(old_opstruct, property, value, ...);
◆ options = simset(old_opstruct, new_opstruct);
◆ simset
 
在以上命令中，property参数的含义是指该系统某种参数属性，

old_opstruct和new_opstruct分别代表的是设置系统的原来属性或者现在
的属性数值。其中，用户可以使用simset来显示关于设置参数的各种
细节信息，得到的结果如下：



说明

上面的所有系统参数用户都可以使用simset命令进行访问，但是在运行仿真时，只有一些

常见的属性需要经常访问并编辑，其他参数将主要用于参考检测系统的性能。

 
例20.5 使用simset命令设置仿真系统的不同求解器参数，然后比

较两种不同参数得到的仿真结果，为了简便分析过程，将沿用前一个

例子。

step 1
在MATLAB的命令窗口中输入以下命令代码：



step 2
查看图形结果。在输入代码后，得到的图形如图20.39所示。

图20.39 运行程序得到的结果

说明

在以上程序结果中，使用了不同的解法器ode15s和ode45来求解同一个仿真系统，然后比

较仿真结果中9～10s的图形，可以看出使用不同的解法器会得出类似但是有差别的计算结

果。

 
关于simset命令，笔者认为有必要注意以下内容：
 



◆ 命令simset命令所设置的参数将在仿真过程中被优先使用，但
是并不修改仿真系统对话框中的参数设置，对话框中的参数设置是持

久的，而simset命令修改的参数数值只限于使用在当前命令中。
◆ 系统模型的参数中包含了SrcWorkspace和DstWorkspace两个比

较特殊的变量，其中SrcWorkspace指定系统表达式中计算所在的空
间，取值为字符串，分别为 {'base'} |'current' | 'parent'，依次表示
MATLAB的基础工作空间、当前空间和调用当前系统的函数空间，其
中current是默认数值；DstWorkspace则是指定“To Workspce”模块输出
数据所在的空间，取值为字符串，分别为{'base'} | 'current' | 'parent'，
含义相同。

说明

simset命令获取的系统模块的参数只是一些高层属性，如果希望对系统的底层参数进行操

作和编辑，则需要使用set_param命令来实现，感兴趣的读者可以查看相应的帮助文件。

 
在本小节的最后，将简要说明使用simget命令获取模型的信息。

在Simulink中，simget命令的常用调用格式如下：
 
◆ struct = simget(model)
◆ value = simget(model, property)
◆ value = simget(OptionStructure, property)

说明

以上命令中各参数的含义和前面各命令的参数含义相同，这里就不重复介绍了。其中

property是使用simset命令可以访问的任何一个参数名称。

20.3.4 模型的线性化



如果希望利用发展成熟的线性分析方法来解决现实中的非线性问

题，则需要研究如何将这些非线性问题进行线性化，然后研究线性化

后的模型问题。所谓的模型线性化是指将用户所建模型用状态空间矩

阵A、B、C和D表示的线性方程组表示，状态空间矩阵按照以下方程
组的形式来描述线性的输入/输出关系：

其中，x、u和y分别表示状态、输入和输出向量，系统中的输入/
输出变量必须使用Simulink提供的输入模块和输出模块。这是一种简
化方程，只有在输入信号附近、输入信号时间点附近很小的范围内才

成立，同时，该简化的线性方程并不是对所有的非线性系统都成立，

有些非线性系统这种处理也会影响整个系统的性质。

在Simulink中，提供了两种线性分析的命令，分别对连续系统和
离散系统进行线性操作，其中对连续系统进行线性操作的命令如下：

通过使用以上线性命令，不仅可以获取非线性系统的近似线性数

学模型，还可以来获取线性模块的数学描述。由于这样获取的数学模

型中没有进行“零-极点”对消，有可能阶次比较高，所以可以使用
Control Toolbox中的minreal命令来求取最小值。
例20.6 演示如何使用Simulink来对非线性系统进行线性化。

step 1
添加非线性系统的模块。在本实例中，由于只是为了演示线性化

的操作方法，因此添加的非线性模块比较简单，如图20.40所示。



图20.40 非线性系统的模块

step 2
对非线性模块进行线性化操作，并得到线性模块的参数。在

MATLAB的命令窗口中输入以下程序代码：

step 3
将系统的状态空间转换为LTI对象。在MATLAB的命令窗口中输

入以下代码：



说明

LTI(Linear, Time-Invariant)对象是Simulink中主要的系统对象，用户可以使用Control

System Toolbox中对应的函数来对转换后的LTI对象进行分析。

step 4
绘制系统的波特相位振幅图。在MATLAB的命令窗口中输入以下

代码：

step 5
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

20.41所示。



图20.41 系统的波特相位振幅图

提示

波特相位振幅图是LTI的振幅和相位变量的图表，其具体的物理含义比较复杂，关于bode

命令的详细使用方法，可查看相应的帮助文件。

step 6
绘制系统的单位阶跃和脉冲响应图表。在命令窗口中输入以下代

码：

step 7
查看图形结果。输入程序代码后，按“Enter”键，得到的图形如图

20.42所示。



图20.42 计算系统的响应信息

20.3.5 系统平衡点分析

在非线性系统的分析中，分析系统的稳定性或者稳态性状的时候

需要分析系统的平衡点。在Simulink中，所谓平衡点是指所有状态导
数都等于零的点。如果只有部分状态导数是零，则称为偏平衡点。

Simulink通过使用trim命令来决定动态系统的稳定状态点，用户可以很
方便地查看系统的平衡点性能，其具体的调用格式如下：

在以上调用格式中，只有第一个输入变量是必须的，其他的输入

参数都是可选的。其中x0，u0，y0表示的是开始搜索（x，u，y）点的
状态、输入和输出变量的初始数值，每一个分量的输入格式都必须是

列向量的形式；ix,iu,iy则分别用来表示x0,u0,y0中保持不变的分量下
标，options是优化算法的参数选项数值。
例20.7 演示如何使用Simulink来对系统的平衡点进行分析。

step 1



添加非线性系统的模块。为了分析系统的平衡点，首先需要添加

系统模块，添加的模块如图20.43所示。

图20.43 添加系统模块

step 2
设置命令搜索的初值条件。在MATLAB的命令窗口中输入以下代

码：

step 3
检测搜索点的平衡性。在命令窗口中输入以下代码：



step 4
修改命令搜索的初值条件，并检测搜索点的平衡性能。在

MATLAB的命令窗口中输入以下代码：

说明

并不是所有求解平衡点的问题都会有解，如果无解，trim命令将会返回一个离期望状态偏

差很小的一个解。

20.4 交替执行系统——综合实例1

在本章的最后，将使用Simulink来完成两个比较综合的实例，通
过这些综合实例，可以加深读者对Simulink各种组件的认识，同时也
会加强读者了解Simulink和实际问题相互联系的能力。为了让读者加
强对Simulink复杂模型创建过程的了解，在本节中依照步骤详细介绍
各种实例的创建过程。



20.4.1 添加系统模块

在本小节中，将介绍如何在Simulink中创建交替执行系统，所涉
及的Simulink组件包括：Merge模块、条件执行系统、逻辑运算模块、
Simulink中的Boolean信号、交替执行系统和利用程序修改模块的背景
颜色等各种内容。

例20.8 使用Simulink来创建交替执行系统，在不同时段显示两种
不同的信号图形，最后完成的综合信号图形如图20.44所示。

图20.44 交替执行系统的图形

在图20.44所示的图形中，在0～5s的时间段内显示的是正弦函数
图形，在5～10s的时间段内显示的则是周期折线图形，在下一个10s
内，将重新显示这样的图形。下面将分步骤详细介绍该图形的创建过

程。

step 1
创建系统模块。在本小节中所创建的系统模块如图20.45所示。



图20.45 添加的系统模块

step 2
系统模块功能分析。由于系统模块比较复杂，为了便于更好地了

解系统模块的功能，下面简要介绍模块的功能。

 
◆ 输入信号：在系统的左侧有两个信号输入模块：“Repeating

Sequence”模块和正弦波形模块。两个模块可以产生标量输出信号，其
形式和模块上的图标相同。

◆ 条件执行系统：上面两个不同的输入信号分别和两个不同
的“Enabled”子系统相连接，两个子系统的控制信号是由“Discreate
Pulse Generator”模块产生的离散信号，该信号将以5s为周期，数值为0
或者1。当控制信号输出数值为1时，系统将会触发上面的子系统；当
控制信号输出为0时，系统将会触发下面的子系统。

◆ Merge模块：两个子系统输出的信号作为Merge模块的输入信
号，产生一个综合后的信号，在Scope模块中显示。

20.4.2 设置系统模块的属性



在本小节中，将为前面小节添加的模块设置属性。本例中，需要

设置的属性包括信号属性以及子系统的初始化属性等。具体操作步骤

如下。

step 1
设置“Sine Wave”模块的属性。在本系统中，输入信号的属性将会

影响整个系统的输出结果，因此需要设置对应的属性，如图20.46所
示。

图20.46 设置正弦波的属性

在图20.46所示的对话框中，将正弦波的振幅设置为1，频率设置
为pi，将Phase和Bias都设置为0，得到周期为2s的正弦波图形。



step 2
设置“Repeating Sequence”模块的属性。作为另外一个输入信号，

用户需要设置“Repeating Sequence”模块产生信号的属性，如图20.47所
示。

图20.47 设置“Repeating Sequence”信号的属性

step 3
分析 “Repeating Sequence”模块的属性。由于是第一次使用

到“Repeating Sequence”模块，这里将详细介绍该信号的属性特征。在
Simulink中，模块将会输出用户自行设定的波形，而且输出的信号为
标量信号。用户可以在属性对话框中设置参数“Time values”和“Output
values”的数值，从而设置输出信号的属性。其中参数“Times values”指
定了样本时间变量，参数“Output values”指定了对应信号时间内的信号
振幅。

提示

实质上，参数“Times values”也等于指定了波形的周期时间。对于样本时间内的数据

点，“Repeating Sequence”模块将会使用线性插值的方法计算数值。



在本实例中，指定的时间参数为“[0 1]”，输出数值参数为“[0
2]”，将会产生一个周期为1s的折线波形，振幅为2。

step 4
查看“Repeating Sequence”的子系统模块。从图20.47所示的对话框

中可以看出该模块本身是经过封装的子系统模块，其对应的子系统如

图20.48所示。

图20.48 模块对应的子系统模块

step 5
查看 “Repeating Sequence”模块的源代码。在该子系统中，

startTime和Fcn1模块对应的都是S函数模块，其中startTime模块是由C
语言编写并经过编译的文件，具体代码如下：



由于以上代码是经过C语言编译后完成的，超过了本书讨论的范
围，这里就不详细分析了。之所以列出以上代码，是为了便于理解模



块产生的原理。同时，由于该模块是经过封装的模块，可以在封装属

性对话框中设置模块的初始化属性，如图20.49所示。

图20.49 模块的初始化属性

step 6
设置控制信号模块的属性。在本实例中，控制信号是离散信号，

需要为其设置具体的参数属性，如图20.50所示。



图20.50 设置控制信号模块的属性

在参数对话框中，将“Pulse type”参数设置为“Sample-based”。这
样，该模块将会产生一个用户指定的波形间隔输出离散波形。

step 7
设置“Data Type Conversion”模块的属性。由于控制信号的功能是

触发子系统，因此需要将输出信号转换为“Boolean”数据类型，该模块
的属性如图20.51所示。



图20.51 设置“Data Type Conversion”模块的属性

step 8
设置Simulink中的Boolean signals属性。选择模块编辑对话框中

的“Simulation”→“Configuration Parameters”命令，打开“Configuration
Parameters”对话框，在左窗格中选择“Optimization”选项，在右窗格中
选中“Implement logic signals as boolean data”复选框，如图20.52所示。



图20.52 设置Simulink的属性

提示

由于在后面的步骤中需要将Boolean信号作为Logical Operator模块的输入信号，所以需要

在Simulink中对Boolean signals进行属性设置。

20.4.3 添加“Enabled”子系统

在本例中，为了演示出交替执行的效果，需要在本Simulink中添
加“Enabled”子系统。具体操作步骤如下。

step 1
设置“Enabled”子系统的模块。双击以上子系统模块，打开模块编

辑器，在其中添加子系统的模块，如图20.53所示。

图20.53 添加子系统模块

step 2
设置“Enable”模块的属性。双击“Enable”模块，打开对应的属性对

话框，设置的属性如图20.54所示。



图20.54 设置“Enable”模块的属性

step 3
设置“S-Function”模块的属性。双击“S-Function”模块，打开对应

的属性对话框，设置的属性如图20.55所示。

图20.55 设置“S-Function”模块属性

step 4
添加S函数的程序代码。单击对话框中的“Edit”按钮，查看S函

数“mergefcn”的具体代码：



以上程序代码的主要功能是实现两个信号的融合，这里主要分析

mdlUpdate函数，其程序代码如下：



以上程序代码的主要功能是动态设置两个子系统的背景颜色。在

程序代码中，根据子系统是否运行，使用以下程序代码设置

BackgroundColor属性：

step 5
设置“NOT”模块的属性。双击子系统的“NOT”模块，打开属性对

话框，在其中设置模块的属性，如图20.56所示。

图20.56 设置“NOT”模块的属性

提示

在对话框中，选择 “Signal data types”选项卡，在 “Output data type mode”选框中选

择“Boolean”选项，设置该模块的输出信号的属性为Boolean。



step 6
设置“Merge”模块的属性。双击子系统的“Merge”模块，打开属性

对话框，在其中设置模块的属性，如图20.57所示。

图20.57 设置“Merge”模块的属性

20.4.4 运行仿真系统

前面小节已经完成了仿真模块，同时设置了仿真的参数。在本小

节中，将讲解如何运行该仿真系统。

step 1
运行系统。将系统的仿真时间设置为30，然后运行仿真系统，当

运行上面的子系统模块时，系统的模块如图20.58所示。当程序运行下
面的子系统模块时，系统的模块如图20.59所示。



图20.58 执行上面的子系统

图20.59 执行下面的子系统

step 2
查看仿真结果。同时，得到的仿真图形如图20.60所示。

图20.60 仿真结果图形



20.5 雷达轨迹分析——综合实例2

本节将介绍一个综合的实例，来分析雷达系统绘制的飞机运动的

轨迹，和前一节类似，本综合实例需要运用Simulink中的封装子系
统、S函数运算等常见功能，由于模型创建比较复杂，下面将分小节
详细介绍。

20.5.1 系统模块简介

例20.9 使用Simulink来创建雷达飞行轨迹系统，并根据仿真得到
的结果绘制各种参数的图形，其中雷达获取的飞机运动轨迹和模拟的

运动轨迹如图20.61所示。同时，为了分析系统模拟的精度，系统需要
分析实际轨迹和模拟轨迹的偏差程度，绘制偏差程度的图形，如图

20.62所示。

图20.61 雷达获取的飞机轨迹



图20.62 实际轨迹和模拟轨迹的误差曲线

最后，得到飞机在不同方向上运行轨迹的对比情况，如图20.63所
示。

图20.63 不同方向轨迹的对比情况

20.5.2 添加系统模块

下面将详细分析该系统的创建过程。

step 1
创建系统模块。在本小节中所创建的系统模块如图20.64所示。



图20.64 创建系统模块

step 2
分析系统模块功能。由于此系统比较复杂，在详细介绍系统各个

模块的属性和功能之前，首先介绍该系统模块的整体功能。

 
◆  求解飞机在笛卡儿系的运动轨迹坐标。在 “Cartesian to

Polar”模块左侧的系统模块，其主要功能是求解飞机在笛卡儿坐标系
下的轨迹坐标数值。首先通过“Random aircraft motion”模块产生的随机
数值作为飞机运动的初始信号，将该信号分别通过 “Cross-Axis
Acceleration Model”和“Thrust-Axis Accleration Model”子系统模块，输
出飞机横轴（Cross-Axis）和推力轴（Thrust-Axis）运动的加速度，然
后将以上加速度数值信号分别通过两次积分器模块，得出飞机在横轴

（Cross-Axis）和推力轴（Thrust-Axis）方向上的运动位移数值。最后
将两个位移数值通过“Actual Position”模块，传递到MATLAB的工作空
间中。

◆ 将笛卡儿系的坐标转换为极坐标。将系统计算出来的飞机运
动轨迹的XY坐标，通过“Cartesian to Polar”模块转换为极坐标下的数值
Range（极径）和Bearing（极角）。



◆ 计算飞机运动轨迹的极坐标。将上面模块转换得到的极坐标
数值加上使用雷达系统的测量误差数据，得出实际使用雷达测量得到

飞机运动轨迹的极坐标，并将得到的转换数据通过“Send Radar Range
and Bearing Angle Meas. to Workspace”模块传递到工作空间中。

◆ 将极坐标数据进行“Kalman Filter”处理，得到处理后的数据。
将上面步骤得到的极坐标数据，经过“Radar Kalman Filter”模块得出经
过 “Kalman Filter”处理后的数据，并分别通过 “Residuals”和 “Est.
Position”模块传递到工作空间中。

step 3
设置系统模块的属性。由于系统模块繁多，为了方便查看系统采

样的层次，可以选择模块编辑对话框中的 “Format”→“Port/Signal
Displays”→“Sample Time Colors”命令，当运行仿真系统后，不同采样
时间的模块会显示不同颜色，如图20.65所示。

图20.65 设置模块的采样属性

step 4



设 置 系 统 的 解 算 器 。 选 择 模 块 编 辑 对 话 框 中

的“Simulation”→“Configuration Parameters”命令，打开“Configuration
Parameters”对话框，在左窗格中选择 “Solver”选项，在右窗格
的“Type”下拉列表中选择“Fix-step”选项，在“Solver”下拉列表中选
择“ode5(Dormand-Prince)”选项，如图20.66所示。

图20.66 设置系统的解法器

step 5
设置“Random aircraft motion”模块的属性。双击系统中的“Random

aircraft motion”模块，打开对应的属性对话框，在其中设置其属性，如
图20.67所示。



图20.67 设置“Random aircraft motion”模块的属性

在本实例中“Random aircraft motion”模块的功能是产生飞机运动的
随机坐标数值。选择该模块，然后单击鼠标右键，在弹出的快捷菜单

中选择“Link Options”→“Go To Library Block”命令，打开Simulink中的
模块库，可以查看该模块在模块库中位置，如图20.68所示。



图20.68 Simulink中的模块库

如果希望编辑该模块，则首先需要选择该模块，然后单击鼠标右

键，在弹出的快捷菜单中选择“Link Options”→“Disable Link”命令，取
消该模块和模块库的关联。然后选择该模块，单击鼠标右键，在弹出

的快捷菜单中选择“Edit Mask”命令，打开关于该封装模块的编辑器。
例 如 ， 要 修 改 该 模 块 的 初 始 值 ， 可 以 选 择 编 辑 器 中

的“Initialization”选项卡，在其中设置模块的初始数值，如图20.69所
示。

图20.69 设置模块的初始数值

20.5.3 添加“Cross-Axis Acceleration Model”子
系统

在本小节中，将详细讲解如何添加 “Cross-Axis Acceleration
Model”子系统的模块，并分析该子系统的属性。



step 1
添加“Cross-Axis Acceleration Model”子系统的模块。双击系统中

的“Cross-Axis Acceleration Model”子系统，打开模块编辑框，添加对
应的子系统，如图20.70所示。

图20.70 添加子系统模块

step 2
分析子系统模块功能。根据Simulink的基础知识可知，该子系统

模块相当于以下微分方程组：

其中I表示的是前面步骤中输入的随机信号，K表示的是微分方程
的参数，x表示的是微分方程的中间变量，α则是模块输出的横轴加速
度。

提示

上面系统求解的是飞机运动在横轴方向上的加速度，“Thrust-Axis Accleration Mode”子系

统模块和该模块在结构上完全相同，只是参数K在数值上不同。

20.5.4 添加“Cartesian to Polar”子系统



在本小节中，将详细讲解如何添加“Cartesian to Polar”子系统的模
块，并分析该子系统的属性。

step 1
添加“Cartesian to Polar”子系统的模块。双击系统中的“Cartesian to

Polar”子系统，打开模块编辑框，添加对应的子系统，如图20.71所
示。

图20.71 添加“Cartesian to Polar”子系统的模块

在子系统模块中，hypot和atan2都是MATLAB中内置的数学操作
函数，分别将输入的x和y坐标数值转换为极坐标下的r和θ，其具体的
计算公式如下：

step 2
封装“Cartesian to Polar”子系统的模块。选择“Cartesian to Polar”子

系统模块，然后单击鼠标右键，在弹出的快捷菜单中选择“Mask
Subsystem”命令，打开模块编辑器，选择“Icon”选项卡，在其中设置封
装子系统的图标，如图20.72所示。



图20.72 设置封装子系统的图标

step 3
设置“Radar Measurment Noise”模块的属性。双击系统中的“Radar

Measurment Noise”模块，打开其属性对话框，在其中设置对应的属
性，如图20.73所示。

图20.73 设置“Radar Measurment Noise”模块的属性



说明

关于该模块的属性设置，和前面步骤中设置“Random aircraft motion”模块的属性类似，这

里就不重复介绍了。

step 4
设置“Meas. Noise Intensity”模块的属性。双击系统中的“Meas.

Noise Intensity”模块，打开其属性对话框，在其中设置对应的属性，如
图20.74所示。

图20.74 设置模块的参数数值

在参数设置对话框中，设置该模块的参数数值K和前面步骤中加
速度中参数K相同，为了后面步骤的操作方便，有必要对该模块进行
封装。

step 5



封装“Meas. Noise Intensity”模块。选择“Meas. Noise Intensity”子系
统模块，然后单击鼠标右键，在弹出的快捷菜单中选择 “Mask
Subsystem”命令，打开模块编辑器，选择“Parameters”选项卡，设置封
装子系统的参数，如图20.75所示。

图20.75 设置封装模块的参数

对于其他封装模块的参数数值，限于篇幅，这里就不一一列出

了，主要是设置对应的图标、文字提示等属性，完成后的封装系统如

图20.76所示。

图20.76 完成后的封装子系统



20.5.5 添加“Radar Kalman Filter”子系统

在本小节中，将详细讲解如何添加“Radar Kalman Filter”子系统的
模块，并分析该子系统的属性。

step 1
添加“Radar Kalman Filter”子系统的模块。双击系统中的“Radar

Kalman Filter”模块，打开模块编辑器，在其中添加子系统的模块，如
图20.77所示。

图20.77 添加“Radar Kalman Filter”子系统的模块

step 2
设置“Zero-Order Hold”模块的属性。该系统的主要功能是将极坐

标数据经过Kalman Filter处理，双击“Zero-Order Hold”模块，打开对应
的属性对话框，在其中设置其具体属性，如图20.78所示。



图20.78 设置“Zero-Order Hold”模块的属性

说明

在Simulink中，“Zero-Order Hold”（简称为ZOH）模块的主要功能是实现离散信号和连续

信号之间的转换，关于该模块的详细信息请查看帮助文件。

step 3
设 置 “Extended Kalman Filter” 模 块 的 属 性 。 双 击 系 统 中

的“Extended Kalman Filter”模块，打开属性对话框，设置该模块的属
性，如图20.79所示。

图20.79 设置模块的属性

step 4
查看程序代码。在属性对话框的“MATLAB function”文本框中输

入“aero_extkalman”，这是M文件的名称，其具体的代码如下：



在以上程序代码中，依次按照步骤计算Extended Kalman Filter中
的转换工作，得到的结果就是将极坐标数值转换为Kalman Filter处理
后的数据。

20.5.6 添加程序代码



在前面小节中，已经添加了系统模块。在本小节中，将对模块添

加相应的程序代码。下面详细介绍操作步骤。

step 1
编写系统参数的M文件，其具体代码如下：

以上数据都是仿真系统的基础参数数据，将以上代码保存

为“aero_raddat.m”文件，在后面的步骤中将在运行仿真系统之前加载
这些数据。

step 2
编写绘制参数图形的M文件，其具体代码如下：



提示



在以上程序代码中，依次利用仿真系统传递到MATLAB工作空间中的变量，绘制各种参

数的图形，关于该代码的主要分析工作交给读者自行完成。

step 3
加载以上程序代码。在模块编辑器中单击鼠标右键，在弹出的快

捷菜单中选择“Model Properties”命令，打开“Model Properties”对话
框，选择“Callbacks”选项卡，在该选项卡对应的选框中加载以上程序
代码，如图20.80所示。

图20.80 设置系统模块的属性

20.5.7 运行仿真系统

前面小节已经完成了仿真模块，同时设置了仿真的参数。在本小

节中，将讲解如何运行该仿真系统。



step 1
运行系统仿真，得到仿真结果。将系统仿真时间设置为100，然后

运行系统，得到的仿真结果如图20.81所示。

图20.81 得到的仿真结果

step 2
查看运行后的系统模块。由于设置了不同采样模块为不同的颜

色，因此运行后的系统模块如图20.82所示。



图20.82 运行的系统模块

20.6 小结

本章主要讲解了S函数和分析仿真结果。其中，S函数属于
Simulink仿真系统中的高级内容，本章首先介绍了S函数的原理，并通
过典型例子来讲解如何使用S函数创建仿真系统。同时，本章还介绍
了如何分析仿真的结果。最后，本章还利用两个比较综合的例子来介

绍如何使用各种技术进行复杂的仿真。

◆   ◆   ◆



Part 7

第7部分 高级应用

第21章 文件I/O
第22章 MATLAB编译器
第23章 应用程序接口



第21章 文 件 I/O

本章包括

◆打开外部文件

◆关闭外部文件

◆读取二进制文件

◆写入二进制文件

◆读取文本文件

◆写入文本文件

◆处理图像对象

 
为了加强MATLAB的应用功能，实现MATLAB和其他格式的文件

的相互交换是很重要的部分内容。MATLAB系统具有直接对磁盘文件
进行访问的功能，用户不仅可以进行高层程序设计，也可以对低层次

的文件进行读写操作，这就增加了MATLAB程序设计的灵活性和兼容
性。

在MATLAB中，提供了许多有关文件输入和输出的函数，使用这
些函数用户可以很方便地实现各种格式的读取工作，大多数函数都是

基于C语言的文件I/O函数，因此比较容易上手。

21.1 处理文件名称

为了实现各种不同格式文件的读取工作，MATLAB首先提供了能
够处理文件路径或者名称的函数，使用这些函数用户可以对文件路径



进行各种处理：分割路径名称、组合路径名称等，下面使用简单的例

子来说明如何使用这些函数。

例21.1 获取文件路径的各种信息，并对路径的各个部分进行处
理。

step 1
编写路径处理的代码。选择菜单栏中的 “File”→“New”→“M-

file”命令，打开M文件编辑器，然后在其中添加以下程序代码：

将代码保存为“fileinfo.m”文件，在后面的程序代码中需要调用该
函数来处理文件的名称和后缀信息。

step 2
处理文件路径信息。在MATLAB的命令窗口中输入以下代码：



从以上结果可以看出，在MATLAB中可以使用fileparts函数来返回
文件路径各部分的信息，其完整的调用格式为：

在该函数返回的参数中，pathstr表示的是文件路径，name则是文
件名称，ext返回的则是文件的后缀（包含了后缀前面的点号），versn
返回的是文件版本。

提示

考虑到用户使用的操作系统的问题，MATLAB提供了“filesep”函数来返回文件路径的分隔

符。在Windows操作系统中，该函数返回的是“\”；在UNIX操作系统中，该函数返回的是“/”。

 
例21.2 利用路径各部分的内容创建完整的文件路径。

step 1
创建文件路径。在MATLAB的命令窗口中输入以下代码：

step 2
查看程序结果。以上程序代码可以得到如下结果：



从以上结果可以看出，在MATLAB中用户可以使用fullfile命令来
得到完整的文件路径，其完整的调用格式如下：

在该命令中，前面的参数分别表示的是文件的路径，最后一个参

数表示的是文件名称，该文件名称中如果不包含后缀，则创建的完整

路径也不包含后缀。

说明

除了上面介绍的函数之外，MATLAB还提供了tempdir和tempname两个命令，可以使用这

些命令来了解临时路径的信息。

21.2 打开和关闭文件

在对文件进行处理的所有工作当中，打开文件或者关闭文件都是

十分基础的操作。本节将介绍如何在MATLAB中打开和关闭文件。根
据操作系统的要求，在程序代码中需要使用或者创建某个磁盘文件的

时候，必须向操作系统发出打开文件的命令，使用完毕之后，也必须

向操作系统发出关闭文件的命令。

对于和MATLAB同等层次的文件，可以使用load、save等命令对
该文件进行操作。本节将主要介绍如何在MATLAB中读取低层次的数
据文件方法。



21.2.1 打开文件

在本小节中，将主要使用简单的实例介绍如何在MATLAB中打开
磁盘中的文件，然后详细介绍对应命令的使用方法。

例21.3 在MATLAB中使用fopen命令打开磁盘文件。

step 1
以读写的方式打开磁盘文件fgetl.m。在MATLAB的命令窗口中输

入以下代码：

step 2
查看程序结果。在输入以上代码后，得到的结果如下：

由于在运行该命令的时候，命令查找的范围是用户设置的文件路

径：\MATLAB7.0\work，而fgetl.m是函数fgetl的M文件，默认保存路
径为MATLAB7.0\toolbox\matlab\iofun。

step 3
查看M文件的程序代码。为了和后面步骤中打开的文件内容相比

较，下面列出该文件的代码：



说明

尽管在系统中存在该函数文件，但是该文件不在搜索路径上，当fopen以读写方法打开的

时候，将会返回错误信息。

step 4
以只写的方式打开磁盘文件fgetl.m。在MATLAB的命令窗口中输

入以下代码：

step 5
查看程序结果。以上程序代码得到的结果如下：

前面步骤已经提到，fgetl.m并不在命令搜索路径上，但是该命令
并没有返回错误信息，而是返回了正整数的信息，表示已经打开该文

件。这是因为当以只写方式打开文件时，如果命令没有搜索到对应的

文件，则会自动创建该文件。因此，当用户使用该命令后，系统会在



搜索路径\MATLAB7.0\work上创建一个空白的M文件，该文件名称为
fgetl。

说明

在MATLAB中，fopen命令打开文件的方式是只读方式，因此在默认情况下，如果用户不

输入打开文件的方式，MATLAB就会使用只读方式打开文件。

step 6
以读写的方式打开磁盘文件fgetl.m。在MATLAB的命令窗口中输

入以下代码：

step 7
查看程序代码的结果。以上程序代码可以得到以下结果：

说明

从以上结果可以看出，当首先以只写的方式打开磁盘文件fgetl.m后，命令会自动创建对

应的空白文件，再次使用读写方式打开该文件时，系统会打开对应的空白文件，并返回打开

文件的数值信息。

 
这些例子基本演示了MATLAB中fopen命令的使用方法，其对应的

完整调用格式如下：

 
◆ [fid,message] = fopen(filename, mode)
◆ [fid,message] = fopen(filename, mode, machineformat)



 
在以上命令中，filename表示的是打开文件的名称，mode表示打

开文件的方式，其具体的类型包括：

 
◆ “r”：以只读方式打开文件。
◆ “w”：以只写方式打开文件，并覆盖原来的内容。
◆ “a”：增补文件，在文件尾部增加数据。
◆ “r+”：读写文件。
◆ “w+”：创建一个新文件或者删除已有的文件内容，并进行读

写操作。

◆ “a+”：读取和增补文件。

说明

在默认情况下，MATLAB会选择使用二进制的方式打开文件，而在该方式下，字符串不

会被特殊处理。如果需要用文本形式打开文件，则应在以上mode字符串后面添加“t”，例

如，“rt”、“rt+”等。

 
在两种fopen命令格式中，fid是一个非负整数，一般被称为文件标

识，在MATLAB中，用户对文件的任何操作，都需要通过fid参数来传
递，MATLAB会根据fid的数值来标识所有已经打开的文件，然后实现
对文件的读、写和关闭等各种操作。如果程序代码得到fid的数值
是-1，则表示fopen不能打开对应的文件，可能是因为该文件本身不存
在，用户却以读写的方式来打开，或者文件存在但是不在搜索路径

上。

说明



具体的fid数值是没有太大的意义的，一般是由系统自动获取的，用户只需查看fid数值是

否为-1即可。

21.2.2 关闭文件

在前面小节中曾经介绍过，在打开文件后，如果完成了对应的读

写工作，应该关闭文件，否则打开的文件就会过多，造成系统资源的

浪费。在本小节中将以一个简单的实例来说明如何在MATLAB中关闭
对应的文件。

例21.4 在MATLAB中关闭对应的磁盘文件。

step 1
创建文件fgetl.m，然后删除该文件。在MATLAB的命令窗口中输

入以下代码：

step 2
查看程序代码的结果。以上程序代码可以得到如下结果：

提示

以上结果表明，当用户使用fopen命令创建了对应的空白文件fgetl.m，并打开对应的文件

后，如果在关闭该文件前，直接使用删除文件，系统会提示用户删除命令被拒绝。

step 3
首先关闭文件，然后删除该文件。在MATLAB的命令窗口中输入

以下代码：



step 4
查看程序代码的结果。当用户输入以上程序代码后，得到的结果

如下：

提示

从以上结果可以看出，当用户首先关闭对应的文件后，删除创建的文件，然后再次打开

对应的文件，返回的信息是无法找到文件，表明已经删除了该文件。

 
以上例子已经演示了如何在MATLAB中关闭文件，在MATLAB

中，可以使用fclose命令关闭已经打开的文件，其具体的调用命令如
下：

在以上命令中，fid表示使用fopen命令得到的文件标识参数，第二
个命令表示使用命令删除所有已经打开的文件。如果使用该命令得到

的结果 status=0，则表示关闭文件的操作成功，否则得到的结果
status=-1。

说明

从前两小节可以看出，在MATLAB中打开和关闭文件对应的命令比较简单，但是笔者还

是不建议在程序代码中循环使用这些命令，因为这样会降低程序的效率。

21.3 处理二进制文件



对于MATLAB而言，二进制文件是相对比较容易处理的，和后面
要介绍的文本文件或者XML文件相比，这些文件是比较容易和
MATLAB进行交互的，因此在本节中将首先介绍如何读取和写入二进
制文件。

21.3.1 读取M文件

常见的二进制文件包括.m和.dat等，可以使用MATLAB中提供的
fread命令来读取对应的文件，在本小节还是以具体的实例来说明如何
使用该命令。

例21.5 在MATLAB中读取ball.m文件的内容。

step 1
查看ball.m文件的内容。为了检查在后面的步骤中使用fread命令

的结果，在本步骤中首先使用M文件编辑器查看该文件的代码内容，
得到结果如下：





说明

之所以在本步骤中打开该M文件，是因为该M文件包含了MATLAB中的各种常见命令，

利用该文件查看fread命令对各种代码的处理方法。

step 2
读取ball.m文件的内容。在MATLAB的命令窗口中输入以下代

码：



当读取了以上文件后，可以查看data变量的属性：

说明

从以上结果可以看出，data是数值数组，也就是说，尽管打开的文件中是程序代码，但是

使用fread命令读取该文件后，得到的是数值数组。

step 3
查看读取的数据结果。在MATLAB的命令窗口中输入以下代码：

step 4
查看程序代码的结果。在命令窗口中输入变量名称，得到的结果

如下：

说明



根据前面步骤的结果，数值数组data的大小是2522x1，因此以上结果中省略了部分数据，

列出的是部分数据结果。

step 5
查看程序代码。在命令窗口中使用以下命令代码：

以上程序代码得到的结果如下：

提示

从结果来看，以上命令代码和“type ball.m”是相同的，相当于将该文件中的所有代码都显

示出来。

21.3.2 读取TXT文件

TXT文件也是比较常见的二进制文件，在本小节中，将以一个简
单的例子来介绍如何在MATLAB中读取TXT文件。



例21.6 在MATLAB中读取readtxt.txt文件中的内容，并对读取的
内容进行处理。

step 1
在本实例中，readtxt.txt是文本文件，其中的内容包含了以下字母

文字：

step 2
读取readtxt.txt文件的内容。在MATLAB的命令窗口中输入以下代

码：

step 3
查看程序代码的结果。在命令窗口中输入变量名称，得到的结果

如下：

说明

和前面步骤类似，默认情况下读取文件得到的数组是数值数组，而不是读取文件里的文

本内容，用户需要使用其他具体命令来转换。



step 4
读取readtxt.txt文件的部分内容。在MATLAB的命令窗口中输入以

下代码：

step 5
查看程序代码的结果。在命令窗口中输入变量名称，得到的结果

如下：

说明

可以看出，可以使用fread命令的第二个参数来设定读取文件的部分内容，在以上步骤中

选择的是5，表示的是选择前面5个数值内容。

step 6
读取readtxt.txt文件的部分文本内容。在MATLAB的命令窗口中输

入以下代码：

step 7
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：



step 8
处理readtxt.txt文件的部分文本内容。在MATLAB的命令窗口中输

入以下代码：

step 9
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：

以上例子并不复杂，基本上演示了如何在MATLAB中读取二进制
文件的方法。在MATLAB中，读取二进制文件的命令是fread，其调用
格式如下：

在以上命令中，参数fid表示的是使用fopen命令打开的文件标识，
参数count表示的是读取二进制文件的大小，可以选取下面三个参数：

 
◆ n：读取前面n个整数，并写入到一个向量中。
◆ inf：读取文件，直到文件结尾处。
◆ [m,n]：读取数据到m*n的矩阵中，按照列排列，n可以是inf，

但是m不能是inf。
 



最后一个参数precision用来控制二进制数据转换成MATLAB矩阵
式时的精度。

21.3.3 写入二进制文件

在MATLAB中，如果希望按照指定的二进制文件格式将矩阵的元
素读入文件，可以使用fwrite命令来完成这样的任务，和前面小节类
似，在本小节中将使用简单的例子来说明如何使用该命令。

例21.7 在MATLAB中使用fwrite命令来写入二进制文件。

step 1
在MATLAB的命令窗口中输入以下程序代码：

step 2
查看程序代码的结果。在命令窗口中输入变量名称，得到的结果

如下：

说明



可以看出整个过程是，首先创建并打开一个空白的二进制文件，然后将MATLAB中创建

的magic矩阵读入该文件后，最后再打开该文件，阅读该文件的内容。

21.4 处理文本文件

为了能够处理文本文件，MATLAB提供了多种处理函数，来使用
不同的格式读取不同数据类型的文本文件，本节将通过实例来详细介

绍。

21.4.1 读取文本文件

在MATLAB中，提供了多个函数来读取文本文件中的数据，其中
比较常见的函数包括csvread、dlmread和textread等，这些函数在实际
使用中有各自的使用范围和特点，在本小节中，将主要使用实例来说

明这些函数的使用方法。

例21.8 在MATLAB中使用csvread和dlmread命令读取文本文件。

step 1
查看原始的数据文件。在本实例中，需要读取的文件是

txtlist.dat，其文件中包含的主要数据如下：

step 2
使用命令读取该数据文件。在MATLAB的命令窗口中输入以下程

序代码：



step 3
查看程序代码的结果。在命令窗口中输入变量名称，得到的结果

如下：

说明

从以上结果可以看出，使用csvread和dlmread命令，可以根据不同的条件来读取原始文本

文件中的数据，其中在dlmread命令中，用户可以自行设置数据之间的分隔符。

 
例21.9 在MATLAB中使用textread命令来读取文本文件。

step 1
查看原始的数据文件。在本实例中，需要读取的文件是

txtlist2.txt，其文件中包含的第一行数据如下：



step 2
使用命令读取该数据文件。在MATLAB的命令窗口中输入以下程

序代码：

step 3
查看程序代码的结果。在命令窗口中输入变量名称，得到的结果

如下：

说明

从以上结果可以看出，在textread命令中，用户可以指定读取数据的格式，来得到对应的

输入结果，具体的使用方法将在后面的内容中介绍。

 
例21.10 在MATLAB中使用textscan命令读取文本文件。

step 1
查看原始的数据文件。在本实例中，用户需要读取的文件是

txtscan.dat，其文件中包含的数据如下：

step 2



使用命令读取该数据文件。在MATLAB的命令窗口中输入以下程
序代码：

step 3
查看程序代码的结果。在命令窗口中输入变量名称，得到的结果

如下：

说明

可以看出，使用textscan命令得到的结果将会被存储在元胞数组中，该元胞数组包含的列

数就是原始数据文件中使用分隔符隔开的数据列。

step 4
查看C1数组的结果。在命令窗口中输入以下程序代码：

step 5
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：



为了便于在后面的步骤中比较各种查看方法，将以上结果整理如

下：

step 6
读取原始文件，并忽略第三列数据。在命令窗口中输入以下程序

代码：

step 7
查看C2的属性。在命令窗口中输入以下程序代码：

step 8
查看C2数组的结果。在命令窗口中输入以下程序代码：



step 9
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：

同样，将以上结果整理如下：

说明

从以上结果可以看出，当在textscan命令中使用textscan(fid, '%7c %6s %*f %d8 %u%f %f

%s')后，其中%*f所替代的对应数据列会被跳过，不被读入。

step 10
仅仅读取原始文件的第一列数据。在命令窗口中输入以下程序代

码：

step 11
查看names的属性。在命令窗口中输入以下程序代码：



step 12
查看程序代码的结果。在命令窗口中输入以下程序代码：

step 13
消除原始第三列数据前面的标签。在命令窗口中输入以下程序代

码：

step 14
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：

step 15
查看C2的属性。在命令窗口中输入以下程序代码：

step 16



查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如
下：

说明

从以上结果中可以看出，相对于原始的第二列数据，通过该命令得到的第二列数据清除

了字符串“Level”，只留下了数值代码。

 
最后，将以上结果整理如下：

根据以上例子可知，在MATLAB中读取文本文件的命令如下：
 
◆ M = csvread('filename', row, col) 在该命令中，filename是需

要打开的文本文件，row是需要读取的行，col则是需要读取的数据
列。

◆ A = dlmread('filename', delimiter) 在该命令中，filename是
需要打开的文本文件，delimiter表示的是用户自行指定的分隔符。

◆ C = textscan(fid, 'format', N) 在该命令中，fid是使用fopen命
令得到的文件标识fid，format则表示读取文件的变量格式，N表示的是
读取数据的循环次数。



21.4.2 使用csvwrite命令读入文本文件

前面，已经介绍过如何在MATLAB中读取文本文件，在本小节
中，将利用一些简单的实例详细介绍如何在MATLAB中写入文本文
件。

例21.11 使用csvwrite命令向文本文件写入MATLAB的数据。

step 1
将数据写入csblist文本文件中。在MATLAB的命令窗口中输入以

下程序代码：

step 2
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：

step 3
将数据写入csblist文本文件中，并在数据列的前侧添加两个数据

列。在命令窗口中输入以下代码：

step 4
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：



step 5
将数据写入csblist文本文件中，并在数据列的前侧添加4个数据

列，同时在数据列上方添加2个数据行。在命令窗口输入以下代码：

step 6
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：

说明

在以上命令中，都是在没有对应数据文件之前使用写入命令，但是使用该命令会首先创

建该文件，然后实现写入任务。

21.4.3 使用dlmwrite命令读入文本文件

在MATLAB中，用户还可以使用dlmwirte命令来读入文本文件，
下面使用具体的实例来说明如何使用该命令。

例21.12 使用dlmwrite命令向文本文件写入MATLAB的数据。

step 1



将数据写入myfile文本文件中。在MATLAB的命令窗口中输入以
下程序代码：

step 2
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：

step 3
修改数据精度，然后将数据写入myfile文本文件。输入以下程序

代码：

step 4
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：

step 5
向myfile文本文件写入多行数据。输入以下程序代码：



step 6
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：

从以上例子可以看出，在MATLAB中，用户可以使用csvwrite和
dlmwrite命令写入文本文件，它们的调用格式如下：

 
◆ csvwrite('filename',M,row,col) 在该命令中，filename表示的

是数据写入的文件名称，M是对应的数据矩阵，row和col分别表示在
原始数据基础上添加的数据列和数据行。

◆ dlmwrite('filename', M, '-append', attribute-value list) 在该
命令中，filename表示的是数据写入的文件名称，M是对应的数据矩
阵，'-append'表示保留原来的写入工作，最后的参数表示用户可以根
据情况设置相应的参数属性。

21.5 处理图像

在MATLAB中，图像一直以来都是十分重要的组成部分，
MATLAB可以在图像处理方面发挥多种作用，并完成各种复杂的工



作。MATLAB还专门提供了Image Acquisition、Image Processing等工
具箱，来完成各种复杂的图像处理工作。本节将以一个简单的实例来

说明如何在MATLAB中读取和编辑图像对象。
例21.13 向MATLAB读入某图像文件，并进行适当的处理。

step 1
读入图像文件。输入以下程序代码：

step 2
查看图形结果。输入代码后，按“Enter”键，得到的图形如图21.1

所示。

图21.1 读入图像文件

step 3
查看图像信息数组。在MATLAB命令窗口中输入以下程序代码：

说明



在MATLAB中，imread函数将返回图像的数据，并将数据保存在数组中。如果使用命令

读取的是色图，数组将是三维数组，大小为M*N*3。同时，该数组的数据类型取决于图像文

件的数据类型。

step 4
在图像文件中添加文字信息。输入以下程序代码：

step 5
查看图形结果。输入代码后，按“Enter”键，得到的图像结果如图

21.2所示。

图21.2 添加说明文字后的图像

step 6
选取需要测量角度的部分图像。在命令窗口中输入以下程序代

码：



step 7
查看图形结果。输入代码后，按“Enter”键，得到的图像结果如图

21.3所示。

图21.3 选取部分图像

说明

在以上程序代码中，起始参数设置的是选取图像对象的起始点的像素信息数据，如果希

望了解这些信息的具体内容，可以使用imview函数查看具体信息。

step 8
将以上图像转换为黑白原色图像。在命令窗口中输入以下程序代

码：



step 9
查看图形结果。输入代码后，按“Enter”键，得到的图像结果如图

21.4所示。

图21.4 转换后的图像

step 10
计算图像边界，并在边界线上添加直线。在命令窗口中输入以下

程序代码：



step 11
查看图形结果。输入代码后，按“Enter”键，得到的图像结果如图

21.5所示。

图21.5 向图像文件中添加边界线

step 12
计算两个边界线之间的夹角。在命令窗口中输入以下程序代码：



提示

由于在前面步骤中获取的边界数据并不完全处在一条直线上，因此，首先使用polyfit命令

进行数据拟合，然后使用线性代数的定义来求取夹角，得出夹角结果。

step 13
计算两个边界线之间的交点。在命令窗口中输入以下程序代码：

step 14
显示计算结果。在命令窗口中输入以下程序代码：

step 15
查看图形结果。输入代码后，按“Enter”键，得到的图像结果如图

21.6所示。



图21.6 显示计算结果

21.6 小结

本章主要介绍了打开外部文件、关闭外部文件、读取二进制文

件、写入二进制文件、读取文本文件、写入文本文件和处理图像对象

的内容，通过这些基础内容可以了解MATLAB如何进行文件输入和输
出。在后面的章节中，将介绍如何使用MATLAB的编译器。

◆   ◆   ◆



第22章 MATLAB编译器

本章包括

◆安装编译器

◆配置编译器

◆编译命令

◆编译过程

◆创建独立的应用程序

 
前面已经介绍了MATLAB在各个方面的具体运用，读者也许已经

对其强大的功能有所了解，但是希望MATLAB能够更快地运行程序代
码，或者希望获得可摆脱MATLAB运行环境而独立运行的可执行文
件。为了满足用户这方面的需求，MATLAB提供了编译器Complier 4.0
组件，使用该编译器可以完成以上任务。在本章中，将向读者详细介

绍MATLAB编译器的知识。

22.1 编译器概述

在MATLAB 7.0中提供的编译器是Complier 4.0，该编译器将用户
在MATLAB中编写的M文件作为输入参数，然后产生可以重新分配并
独立运行的应用程序或者软件组件。通过编译器产生的这些应用程序

都是和平台相关的。下面将详细介绍关于该编译器的主要功能和注意

事项。

22.1.1 编译器的功能



在MATLAB 7.0中，Complier 4.0可以产生下面几种应用程序或者
组件：

 
◆ 独立运行的程序：独立运行的程序软件就是在其运行的过程

中可以不需要MATLAB 7.0软件同时运行，它们可以在没有安装
MATLAB 7.0的机器上运行。

◆  C和C++共享库（在Windows操作系统中为动态链接库
DLL）：这些共享库可以在没有安装MATLAB 7.0的机器上运行。

◆ Excel附件：需要安装MATLAB7.0Builder for Excel。
◆ COM对象：需要安装MATLAB7.0Builder for COM。
 
MATLAB的编译器支持所有的MATLAB功能和对象，用户不需要

对私人的函数或者方法进行特殊的处理，Complier 4.0可以直接处理这
些文件。限于篇幅，在本章中将主要介绍前两种类型的应用程序，对

于后两种应用程序将在后面的章节中加以介绍。

提示

在MATLAB中，有些工具箱将无法和Complier 4.0兼容，对于有些工具箱的特殊函数或者

功能，Complier 4.0也无法兼容。如果需要了解工具箱的兼容性，请查阅对应的MATLAB

Compiler product网站上的内容。

22.1.2 Complier 4.0的性能改进

在MATLAB 7.0中，选用的编译器是Complier 4.0，相对于以前的
版本，该编译器在性能和功能上有了很大的改进，下面将主要介绍该

编译器在性能上的改进，这样熟悉以前版本的读者可以了解到差异。

 



◆ Compiler 4.0使用的是MATLAB的新组件MATLAB Component
Runtime (MCR)，而不是使用MATLAB C/C++ Math and Graphics资源
库。MCR是共享资源库中的独立运行组件，该组件可以执行经过编译
器编译过的M文件代码。

◆ 在Compiler 4.0中，只产生接口函数的代码，而在之前的编译
器版本中，编译器将产生整个M文件的编译代码。

◆ Compiler 4.0删除了某些以前编译器版本中产生代码和格式的
参数选项，提高了使用编译器的便捷性。

◆ Compiler 4.0并不能加速应用程序的运行，经过编译器编译过
的程序代码和在MATLAB环境中运行的应用程序速度基本相当。经过
编译的程序代码运行速度和JIT加速器加速的程序代码速度相同。

◆ 到目前为止，用户只能在Windows和Linux操作系统中使用
Compiler 4.0。

22.2 编译器的安装和配置

在实现MATLAB编译器的各种功能之前，需要首先安装MATLAB
的编译器以及其他程序语言的编译器，本节将主要介绍编译器的安装

和配置。

22.2.1 前提准备

当用户首次使用程序编译器的时候，MATLAB会自动对其进行适
当的配置，如果对程序编译器有特殊的要求，可以自行手动设置编译

器的配置，下面详细介绍。

step 1



安装下面任何一种可以和MATLAB兼容的ANSI C/C++编译器：
 
◆ LCC：MATLAB 7.0自带的编译器，只能编译C代码，不能编

译C++。
◆ Borland C++：可以接受的版本为5.3、5.4、5.5和5.6。
◆ Microsoft Visual C/C++：可以接受的版本为6.0、7.0和7.1。

提示

在默认情况下，只要用户安装了MATLAB 7.0，就可以编译C语言程序代码，但是如果需

要编译某些C++代码，则需要安装另外两个编译器中的一种。根据笔者的经验，为了在后面

步骤中方便使用编译器，建议使用完全安装。

step 2
安装MATLAB 7.0的Complier 4.0。
在默认情况下，MATLAB 7.0中的Complier的安装会包含在

MATLAB 7.0的安装过程中，当选择的是Typical（典型）安装模式
时，MATLAB Complier会自动被选中。当选择的是自定义安装模式的
时候，Complier选项也会被默认选中，只需选中该选项，就可以安装
Complier 4.0组件，如图22.1所示。



图22.1 安装Complier 4.0

22.2.2 配置编译器

在做好了安装编译器的准备工作之后，下面将来了解如何对编译

器进行配置，由于编译器的配置与用户所使用的系统属性有关，因此

在本章仅仅介绍在没有安装其他编译器的情况下，如何正确配置编译

器，对于安装了其他类型编译器的用户，其设置工作和本小节类似。

例22.1 在MATLAB中对编译器应用程序MEX进行配置。

step 1
启动配置。在MATLAB的命令窗口中输入mex –setup，系统会出

现以下提示：

step 2
启动MATLAB的自动定位系统。对于以上提示内容，如果键入

y，mex将会自动搜索外部编译器的类型、版本以及所在的路径。



MATLAB会给出对应搜索结果，也就是系统所安装的所有外部编译
器，并提示用户输入对应的数字，如下：

step 3
确定选择的编译器类型。由于在笔者的系统中，没有安装其他编

译器，因此只有两个选项，当选择默认的编译器后，系统会提示用户

确定选择：

step 4
结束配置。如果以上定位信息没有错误，可以键入y，结束编译器

的配置工作，MATLAB会显示如下结束信息：

说明

按照上面步骤完成的配置具有永久性，也就是说，这些配置不会随着用户关闭程序而失

效。但是，这些配置工作又是可以修改的，可以随时根据版本的情况，重新对编译器进行配

置。

 
例22.2 验证编译器的配置工作，编译MEX文件。

step 1



创建编译文件。前面步骤已经对编译器进行了对应的配置，在本

步 骤 中 ， 需 要 验 证 这 种 配 置 工 作 是 否 正 确 。 选 择 路 径

\MATLAB7.0\extern\examples\mex中的yprime.c文件，将其复制到当前
路径中，该文件的具体代码如下：



step 2
查看对应的M文件。以上程序代码是MATLAB 7.0自带的MEX文

件，其对应的文件是yprime.m，具体代码如下：



step 3
直接运行MEX文件。在MATLAB的命令窗口中输入以下程序代

码：

step 4
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：

提示

在以上程序代码中，首先使用mex yprime.c命令代码，MATLAB会将yprime.c生成为

yprime.dll文件，然后通过yprime(1,1:4)调用该yprime.dll文件，并得出结果。

step 5
查看yprime.dll文件的定位信息。在MATLAB的命令窗口中输入以

下程序代码：

说明

从以上结果中可以看出，对于MEX文件，该编译器可以正常编译出执行文件，并将该执

行文件保存在与原来MEX文件相同的路径中。

 
例22.3 验证编译器的配置工作，编译M文件。

step 1



创建编译文件。前面步骤中已经使用该编译器编译了MEX文件，
在本步骤中将检验编译器编译M文件的功能，其具体代码如下：

说明

以上程序代码是对例22.2的yprime的M文件代码的修改，主要是减少了对应函数中的参数

输入。

step 2
编译该文件。在MATLAB的命令窗口中输入以下代码：

step 3
运行可执行文件。以上程序代码将会生成mymex.exe的可执行文

件，可以在DOS环境下运行该可执行文件，具体的情况如图22.2所
示。



图22.2 在DOS下执行文件

说明

从运行结果可以看出，在DOS环境中执行exe文件得到的结果和前面步骤中在MATLAB环

境下运行的结果相同，表示编译成功。

 
前面已经介绍过如何配置默认的LCC编译器，如果在用户的系统

中安装了其他编译器，则需要使用mbuild命令进行配置，下面以安装
了Microsoft Visual C/C++ 6.0的系统为例，简要列出安装的过程，具体
的过程如下：



提示

从以上过程可以看出，配置外部程序代码编译器和配置默认编译器的过程大致相同，只

是涉及的具体选项不同。另外，上面所有的配置结果都是在Windows操作系统中演示的，使

用UNIX操作系统的读者请查看对应的帮助文件。

22.3 编译过程

在详细介绍如何在MATLAB中使用编译命令之前，笔者认为读者
有必要大致了解在MATLAB中编译文件的基本原理，这样在编译出现



问题的时候，可以根据基本原理进行修改。下面，将简要介绍

MATLAB编译过程。

22.3.1 安装MCR

MCR是MATLAB Component Runtime的缩写，Complier 4.0编译器
采用该技术，其具体含义是一组用来保证M文件执行的独立的共享
库，MCR对MATLAB 7.0语言提供完全的支持。如果希望使用
MATLAB编译器生成的组件，必须安装MCR，下面介绍其安装的详细
过程。

例22.4 在Windows操作系统中安装MCR组件。

step 1
复制安装文件。在默认路径\toolbox\compiler\deploy\win32中找到

MCRInstaller文件，然后将该文件复制到用户自行设定的路径中，本例
中选择的是E:\Study\Matlab。

step 2
运行安装文件。双击MCRInstaller.exe文件，打开安装界面，如图

22.3所示。



图22.3 安装MCR的界面

step 3
选择安装路径。单击“Next”按钮，然后选择路径，如图22.4所

示。

图22.4 选择安装路径

说明



在“Select Installation Folder”页面中，可以单击“Browse”按钮自行选择安装的路径，也可

以单击“Disk Cost”按钮，查看安装所需要消耗的磁盘空间。

step 4
运行安装。单击“Next”按钮，系统会开始按照用户设定的路径和

其他属性进行安装，如图22.5所示。

图22.5 MCR安装过程界面

当安装结束后，系统会提示用户已经安装完成，单击对应的按钮

就可以完成整个安装过程。最后，如果希望修复或者卸载MCR，也可
以双击以上MCRInstaller.exe文件，MATLAB会自动检索该系统中是否
安装MCR，如果检测的结果表明在该系统中已经安装过MCR，系统会
显示修复或者卸载MCR，如图22.6所示。



图22.6 修复或者卸载MCR的界面

22.3.2 代码的编译过程

在 MATLAB 7.0 中 ， Complier 4.0 编 译 器 采 用 了 Component
Technology File (CTF)的存档方案来组织配置文件包，所有的M文件均
采用了高级加密标准（AES）进行了密码为1024位的加密，保存为
CTF格式。每一个由MATLAB编译器产生的应用程序或者共享库均有
一个与之对应的CTF存档，包括所有基于MATLAB 7.0的M文件或者
MEX文件等。
在MATLAB 7.0编译器中，生成独立文件或者程序组件的过程完

全是自动的，为了能够生成一个独立运行的MATLAB应用程序，用户
只需提供一系列用来构成应用程序的M文件程序代码，编译器就会自
动运行对应的程序过程。

下面，将以MATLAB中的 foo.m和 bar.m文件为例，演示在
MATLAB中编译器编译这两个文件的过程。
例22.5 演示MATLAB中编译器编译文件的过程。



step 1
绘制编译过程的流程图。为了能够让读者对编译器编译文件的过

程有一个直观的印象，首先绘制编译过程的流程图，如图22.7所示。

图22.7 编译文件的流程图

step 2
解读编译过程的流程图。在本步骤中，将结合编译原理来说明编

译文件的过程：

 
◆ 依赖性分析（Dependency analysis）：分析判断输入的M文

件、MEX文件以及P文件所依赖的函数之间的关系，其中这些函数包
括了输入文件所调用的M文件以及MATLAB提供的函数。



◆ 代码生成（Code generation）：生成所有用来产生目标组件
的代码，包括从命令行获得的M函数相关的C和C++接口代码，对于共
享库和组件来说，这些代码包括了所有的接口函数代码。

◆  存档生成（Archive creation）：在依赖性分析中生成的
MATLAB 7.0可执行文件列表用来生成CTF存档文件，其中包括程序运
行时所需组件的数据，存档在加密后被压缩在一个单独的文件，同时

路径信息也被保存。

◆ 编译（Compilation）：编译生成的C和C++文件，得到目标
代码。对于那些含有用户提供C或者C++代码的目标文件，这些代码同
样也会被编译。

◆ 链接（Linking）：将生成的目标文件以及相关的MATLAB的
共享库链接起来，生成最终的组件。

22.4 编译命令

在MATLAB中提供了mcc命令来进行编译工作，下面将主要介绍
mcc命令的使用方法和注意事项，关于比较复杂的编译文件、方法以
及过程将在后面详细介绍。

22.4.1 编译命令的格式和选项

无论是希望生成一种或者多种应用程序，或者希望创建一个C共
享库以及软件组件，只要源文件是M文件，都可以使用编译命令mcc
来实现，可以在MATLAB环境以及DOS或者UNIX环境中使用该命
令。

可以使用一种或者多种MATLAB编译器参数给mcc命令，大部分
参数的名字由一个字母组成，可以独立地使用两个参数，如以下示例



代码：

除了以上命令格式之外，MATLAB还提供了多种参数来实现不同
的编译工作，但是MATLAB中还提供了Macros参数来简化编译任务编
译参数，它使用户在面对一个简单的问题时可以不再亲自手工组合多

种参数来实现某种特定的编译过程，而仅仅使用参数-m或者-l就可以
解决问题。例如，对于以上问题可以使用以下代码：

提示

对于比较简单的问题，还是建议使用具体的编译命令，这样可以方便用户理解mcc命令的

具体参数选项含义。

22.4.2 处理脚本文件

在前面章节中曾经介绍过，在MATLAB中，有两种M文件类型：
脚本文件和函数文件。在MATLAB中，Complier 4.0编译器无法编译脚
本文件，但是可以编译调用脚本文件的函数文件。因此，用户不能直

接在mcc命令行中引用脚本文件，但是可以在该命令行中引用包含该
脚本文件的函数文件。这种方法也是处理脚本文件编译问题的最好方

法，因为将脚本文件转换为函数文件是十分简单的，只需在脚本文件

的顶行加入函数声明代码行就可以了。下面将以一个具体的实例来说

明如何处理脚本文件的编译工作。

例22.6 编译脚本文件Compli_ball，然后运行编译后的文件。

step 1
查看脚本文件Compli_ball的代码。为了查看后面步骤中编译的结

果，首先查看该文件的具体代码：



说明

以上程序代码的主要功能是计算抛物线的水平距离，代码内容并不复杂。

step 2
运行脚本文件 Compli_ball。在 MATLAB的命令窗口中输

入“Compli_ball”，查看脚本文件的运行结果：



说明

之所以需要演示以上脚本文件，是为了和后面步骤中编译文件得到的结果进行对比，验

证编译工作的正确性。

step 3
添加函数声明行。在原来的脚本文件的上端添加以下程序代码：

添加了以上程序代码后，保存原来的脚本文件。

step 4
编译脚本文件。在MATLAB的命令窗口中输入以下程序代码：

step 5



运行可执行文件。运行DOS窗口，在上面步骤保存的路径中，运
行编译完成的Compli_ball.exe文件，得到的结果如图22.8所示。

图22.8 在DOS窗口中运行编译文件

说明

从以上结果可以看出，经过编译得到的结果和在MATLAB中运行的结果是相同的，同

时，该例子演示了如何将脚本文件转换为函数文件再编译的方法。

22.5 创建独立运行的程序

创建独立运行的应用程序是MATLAB编译器的重要功能，下面将
使用不同的实例来说明如何在MATLAB中编译创建独立运行的程序代
码。



22.5.1 编译M文件

上面已经演示过如何将脚本文件编译为可独立执行的程序，下面

将以一个简单的实例说明如何编译函数文件。

例22.7 编译M文件timings.m，然后运行编译后的文件。

step 1
查看M文件timings.m的程序代码如下：



step 2
运行M文件timings.m的代码。在MATLAB的命令窗口中输入以下

代码：

说明

以上程序代码的功能主要是比较向量化程序代码和一般循环语句的程序效率。

step 3
编译该M文件。在MATLAB的命令窗口中输入以下代码：

step 4
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：





step 5



在DOS环境下运行编译后的可执行文件。在上面步骤中保存的路
径中，运行编译完成的timings.exe文件，得到的结果如图22.9所示。

图22.9 在DOS环境下执行可执行文件

22.5.2 编译M和C的混合文件

除了前面介绍的编译M文件之外，MATLAB 7.0提供的Complier
4.0还可以编译M文件和C文件混合的文件。下面将以一个简单的例子
来演示如何编译M和C的混合文件。
例22.8 编译由M文件和C文件组成的混合文件。

step 1
简述文件组成部分。在本实例中，需要编译的文件包括：

 
◆ mrank.m：该M文件包含了函数，该函数返回1~n维magic矩阵

的秩。



◆ mrankp.c：在该C语言程序代码中，调用mrank文件中定义的
函数，并返回该函数定义的输出参数数值。

step 2
查看mrank.m文件中的程序代码。该M文件包含的程序代码如下：

step 3
查看mrankp.c文件中的程序代码。该C文件包含的程序代码如下：



step 4
解释mrankp.c文件中的程序代码。该C文件包含的程序代码含义如

下：

 
◆  mxArray *N……else n = 12：这段代码的主要功能是定义

mlfMrank函数的输入参数。
◆  mclInitializeApplication(NULL,0) ……libPkgInitialize()：该

段程序代码的功能是初始化MCR参数，并产生libPkg共享库。
◆  N = mxCreateScalarDouble(n)……mlfMrank(1, &R, N)：该

段程序代码的功能是首先创建包含参数n的矩阵，然后调用编译版本的
mrank.m.函数。

◆  mlfPrintmatrix(R) ……mclTerminateApplication()：该段程
序代码的功能是输出计算结果，然后释放在程序编译过程中分配的矩

阵，最后终止M函数的编译。

step 5
编译以上文件。在MATLAB的命令窗口中输入以下程序代码：

step 6
运行可执行文件。在DOS环境中运行mrank.exe文件，如图22.10所

示。



图22.10 在DOS环境下运行文件

step 7
验证编译结果。在MATLAB的命令窗口中输入以下程序代码：

提示

根据前面步骤中的mrankp.c程序代码，当用户在DOS环境中没有输入任何的参数时，将

自动选用参数12，因此在MATLAB命令窗口中输入“mrank(12)”来验证编译结果正确性。



22.5.3 编译包含绘图命令的M文件

安装了MCR之后，MATLAB可以编译包含绘图命令的M文件，这
是因为在安装了MCR后，MATLAB会在编译过程中加入图形库。下面
将以一个简单的实例来说明如何编译包含绘图命令的M文件。
例22.9 编译Areoplot.m文件，该文件的功能主要是绘制在某圆柱

体周围的非粘性、无漩涡且不可以压缩的流体的流线型线和压力系数

图形。

step 1
查看Areoplot.m文件的代码，其具体的程序代码如下：





step 2
编译Areoplot.m文件。在MATLAB的命令窗口中输入以下程序代

码：

step 3
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：





提示



之所以在以上步骤中列出了详细的编译过程，是为了了解编译包含图形代码的M文件和

一般M文件有什么区别。

step 4
运行编译后的Areoplot.exe文件。在DOS环境中运行编译后的可执

行文件，具体情况如图22.11所示。

图22.11 在DOS环境中运行可执行文件

提示

由于在实例中的所有结果都是图形化结果，没有任何的数据结果，因此在DOS环境下不

会显示任何结果，当查看了所有图形结果并关闭窗口后，DOS会提示可以输入下一条命令。

 
执行经过编译的文件后，MATLAB得到的流线型图形如图22.12所

示。



图22.12 程序绘制的流线型图形

程序绘制的速度向量图形如图22.13所示。

图22.13 绘制的速度向量图形



程序绘制所得到的表面压力系数图形如图22.14所示。

图22.14 表面压力系数图形

step 5
对比图形界面结果。

需要提醒读者的是，尽管在DOS环境下运行可以得到类似的结
果，但是得到的图形窗口和在MATLAB运行程序得到的结果还是有所
不同，例如，在MATLAB环境下得到的速度向量图形如图22.15所示。



图22.15 在MATLAB环境中得到的图形

22.6 小结

本章主要介绍了如何在MATLAB中安装和配置编译器，同时介绍
了MATLAB中的编译命令和过程，最后还介绍了如何使用编译器来创
建独立的应用程序。在后面的章节中，将介绍如何在MATLAB中编写
应用程序接口。

◆   ◆   ◆



第23章 应用程序接口

本章包括

◆使用C语言创建MEX文件

◆使用C语言创建MAT文件

◆使用Fortran语言创建MAT文件

◆MATLAB的引擎技术

◆Java接口

 
在前面的章节中，主要介绍了MATLAB自身的功能和使用方法，

但是作为一个优秀的工程软件，MATLAB除自身功能强大、环境友好
之外，还有很好的开放性。这种开放性体现在MATLAB可以和外部应
用程序实现“无缝”结合，提供了专业应用程序接口API。
在本章中主要从下面几个方面来介绍MATLAB应用程序接口，首

先介绍MEX文件：外部程序调用接口，在MATLAB中使用C语言或者
Fortran语言编写的程序代码，用来提高程序运行的效率；然后介绍
MAT文件应用程序：数据输入输出接口，向MATLAB输入或者输入数
据的程序代码。

最后，将介绍MATLAB计算引擎函数库：在MATLAB和其他应用
程序中建立客户机/服务器关系，将MATLAB作为计算引擎，在其他应
用程序中调用，从而降低应用程序的计算量。在Windows操作系统
中，MATLAB支持该系统提供的COM标准，同时支持Java语言，因此
MATLAB几乎可以和任何一种软件进行交互。

23.1 C语言MEX文件



MEX文件是一种可以在MATLAB中调用的C语言或者Fortran语言
衍生程序代码，而MEX本身就是MATLAB和Executable两个单词的缩
写。通过C语言编写的MEX文件程序代码，经过适当的编译后，生成
的目标文件能够被M语言解释器调用执行，在Windows操作系统下这
些文件使用后缀dll（dynamic link library）。MEX文件的使用极为方
便，其调用方式与MATLAB的内建函数完全相同，只需在命令窗口输
入对应的文件名称即可。

23.1.1 MEX文件的数据

和其他语言程序代码的编写一样，在MATLAB中如果希望编写
MEX程序代码，则首先有必要了解MEX文件中的数据类型，以及这些
数据类型和MATLAB对应的数据之间的联系等。在本小节中，将简要
介绍MEX中的主要数据类型。
由于在MATLAB中所有的数据都是以矩阵或者阵列（Array）储存

的，因此如果使用C语言来编写MEX文件，就必须能够处理对应的数
据类型。在C语言中，Array数据类型用mxArray来定义，这种结构体
包含的信息有：变量类型、维数和数据等。对于数值类型的变量，该

结构体说明变量是实数还是复数；对于稀疏类型的变量，该结构体说

明变量的下标和最大非零元素；对于构架类型的变量，该结构体说明

变量的域名和对应的数值。

根据上面的介绍，该结构体的存储信息如下：

 
◆ 复数双精度数值矩阵：该结构体将存储这些变量的双精度类

属性、维数、双精度变量的实部向量和虚部变量、实部变量指针pr、
虚部变量指针pi。



◆ 其他数值矩阵：带符号和不带符号的8位、16位和32位整数矩
阵、单精度浮点数矩阵存储方式和双精度矩阵相同。

◆ 字符串：字符串类，每个字符串用16位ASCII Unicode码表
示。

◆ 元胞数组变量：每一个mxArray结构体对应一个元胞变量，这
样就可以保证每一个元胞变量能够存放任何一个数据类型的MATLAB
变量；存储方式和数值数组相同，但是部分数组数值包含了mxArray
结构体的指针信息。

◆ 构架数据类型：单构架的存储方式和数值矩阵的方法相同，
每个数值域对应着依此为名称储存的mxArray结构体。

23.1.2 MEX文件的结构

尽管在前面曾经介绍过，在MATLAB中调用MEX文件会很简单，
但是使用一般格式编写的C语言程序代码并不能直接编译成可以被
MATLAB调用的MEX文件，只有符合某种特殊格式的C程序代码才能
编译成为MEX文件。在本小节中，将以一个简单的例子来说明MEX的
典型结构。

例23.1 编写C语言MEX程序代码，实现的功能是将输入变量乘
以2然后输出。

step 1
编写对应的C语言程序代码。在任何可以编译C语言程序代码的编

译器中，输入下面的程序代码：



step 2
编写对应的C语言MEX程序代码。在C语言编译器中编写对应的C

语言MEX程序代码，其对应的代码如下：

说明

当输入上面的程序代码后，将文件保存为twotimes.c，但是不要在C语言编译器中编译上

面的文件代码，该文件需要在MATLAB环境中编译。

step 3



在MATLAB环境中编译并链接上面的文件。在MATLAB的命令窗
口中输入下面的程序代码：

第一行代码编译了timestwo文件，然后定位编译后的文件，得到
的编译后的文件信息如下：

step 4
演示程序代码功能。在MATLAB的命令窗口中输入下面的代码：

提示

可以看出，编译后的程序代码得到的结果和原来的C语言程序代码功能完全相同，表示

MATLAB的编译成功。

 
下面将以这个简单的例子来说明MEX的一般结构。
 
◆ #include "mex.h"……y[0] = 2.0*x[0]：主要功能是首先进行头

文件声明，声明与MEX交互所需要的宏、函数等，然后列出了计算子
程序代码，这段程序代码和原始的C语言程序代码几乎没有差别。

◆  void mexFunction(int nlhs, mxArray *plhs[], int nrhs const
mxArray *prhs[])……mexErrMsgTxt("Too many output arguments")：功
能是首先声明接口子程序代码，然后检测程序代码输入参数的个数。

◆ mrows = mxGetM(prhs[0]) ……mexErrMsgTxt("Input must be a
noncomplex scalar double.")：主要功能是检测输入参数是否是标量，如
果不是标量，则显示提示错误信息，并退出程序代码。



◆ plhs[0] = mxCreateDoubleMatrix(mrows,ncols, mxREAL)：功能
是为返回参数创建存储的数组空间。

◆ x = mxGetPr(prhs[0]) …… y = mxGetPr(plhs[0])：功能是为输
入和输出参数分配指针变量。

◆ timestwo(y,x)：该段程序代码的功能是调用计算子程序代码。

说明

上面的分析过程中，大部分的程序代码是使用C语言创建MEX文件所必需的，但是也有

部分程序代码是这个实例所特有的，希望读者仔细区分。

 
根据上面的分析，可以了解到C语言MEX文件结构的信息：
 
◆ 首先，C语言MEX程序代码必须以#include "mex.h"开始，来

确保程序数据接入和交互被正确声明。

◆ C语言MEX程序代码文件由两个相互独立的子程序组成：计
算 子 例 程 （ Computational routine ） 和 接 口 子 程 序 （ Gateway
routine）。其中，计算子例程的功能是完成所需的计算，它和具有相
同功能的一般C源程序文件几乎相同；接口子程序的功能则是计算子
程序和MATLAB的接口，用户实现两个不同内存空间中的通信。

◆ 接口子程序的名称只能是带有规范参数的mexFunction。

说明

尽管通过本小节的介绍，可以看出创建MEX文件的方法并不复杂，但是由于MATLAB本

身是高效的系统，如果不是出于实际需要，不建议使用MEX文件的方法。

 
在本小节的最后部分，提供另外一组程序代码实现上面程序的功

能，该程序代码中使用一种特殊的API函数mxGetScalar，该函数将直



接返回数组中数值，而不需要使用数值副本的指针变量，具体的程序

代码如下：

说明

为了节省篇幅，在上面的程序代码中省略了处理输入或者输出参数的程序代码段，这段

代码和原来的程序代码相同。

23.1.3 MEX文件的实例

在前面的小节中，已经介绍了MEX文件的数据类型和程序结构，
本小节将分别介绍几个不同的实例，加深读者对MEX文件的理解。
例23.2 编写C语言的MEX文件，向MEX文件中传递构架和元胞

数据。

step 1



打开用户在系统中安装的任意一个C语言开发工具，然后在该开
发工具中输入下面的程序代码：





在输入上面的代码后，将其保存为phonebook.c，并将该C语言程
序代码文件复制到MATLAB的用户工作路径中。

step 2
编译上面的程序代码。返回到MATLAB的命令窗口中，输入下面

的程序代码：

step 3
查看程序代码的结果。按“Enter”键，得到的结果如下：



上面的结果表明，MATLAB已经将上面的程序代码编译为dll文
件。

step 4
运行程序代码。在MATLAB的命令窗口中输入下面的程序代码：

step 5
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：

说明

从上面的结果可以看出，在MATLAB中创建了单构架变量后，使用phonebook程序可以显

示该构架变量的具体信息。在上面的程序代码中，使用mxGetField（针对构架变量）和

mxGetCell（针对元胞变量）分别返回mxArray.数据类型的指针，这是在MEX文件中处理构架

变量和元胞变量的常见方法。

 
例23.3 编写C语言的MEX文件，在其中调用MATLAB的内置函

数。

step 1



打开用户在系统中安装的任意一个C语言开发工具，然后在该开
发工具中输入下面的程序代码：

输入上面的程序代码后，将其保存为sincall.c，然后将该程序代码
文件保存到MATLAB的目录路径中。

step 2



编译并运行程序代码。在MATLAB的命令窗口中输入下面的程序
代码：

step 3
查看图形结果。输入代码后，按“Enter”键，得到的图形如图23.1

所示。

图23.1 调用程序得到的结果

在C语言编写的MEX程序代码中，用户可以使用API函数
mexCallMATLAB来调用MATLAB中的函数、运算符、M文件或者其他
MEX文件。在上面的实例中，首先定义了变量mxArray，同时通过不
同的指针变量来传递数据，最后使用mexCallMATLAB来调用sine和
plot函数来计算和绘制图形结果。

说明



在MATLAB中，如果安装了Fortran安装环境，例如Compaq Visual Fortran等，则可以使用

Fortran语言编写对应的MEX文件。

23.2 MAT文件

MAT文件是用户实现MATLAB和其他应用程序进行数据交换的重
要方式和手段，在MATLAB中，MAT文件是使用C语言或者Fortran语
言编写的专门文件，它可以是MEX文件也可以是独立的可执行程序。
为了便于读写MAT文件，MATLAB提供了相应的接口函数MAT，MAT
文件应用程序就是利用这些MAT函数来完成MAT数据文件的读写工
作，本节将介绍如何使用C语言和Fortran语言编写MEX文件。

23.2.1 使用C语言创建MAT文件

在本小节中，将使用简单的实例来介绍如何使用C语言创建MAT
文件，希望读者能从中了解MAT应用程序的基本结构和应用的过程。
例23.4 使用C语言编写创建MAT文件的程序代码。

step 1
打开在系统中安装的任意一个C语言开发工具，然后输入下面的

代码：







在完成了上面的程序代码后，将其保存为matcreat.c文件。

step 2



编译上面的程序代码。在MATLAB的命令窗口中输入下面的程序
代码：

说明

上面的编译代码中，\msvc60engmatopts.bat代表的是编译器的类型，在本例中使用的C语

言编译器是Microsoft Visual C++ 6.0，因此需要选择的选项是\msvc60engmatopts.bat，读者可

以根据自己的编译器情况来选择对应的编译器类型。

step 3
运行程序代码。上面的程序代码可以在用户的目录路径中创建

mattest.mat文件，在对应的目录路径中双击该文件，然后在MATLAB
的命令窗口中输入下面的程序代码：

step 4
查看变量的结果。在MATLAB的命令窗口中输入变量名称，查看

具体的内容，得到的结果如下：



说明

除了可以编写创建MEX文件，在MATLAB中可以使用C语言来编写读取MAT文件的MEX

文件或者EXE独立应用程序，关于这方面的具体内容，可查看对应的MATLAB帮助文件。

23.2.2 使用Fortran语言创建MAT文件

前面已经介绍了如何使用C语言来创建MAT文件，在本小节中将
利用一个简单例子介绍如何使用Fortran语言创建MAT文件。
例23.5 使用Fortran语言编写创建MAT文件的程序代码。

step 1
打开系统中安装的Fortran语言开发工具（在本实例中使用的是

Compaq Visual Fortran），然后在开发工具中输入下面的程序代码：







在输入上面的代码后，将其保存为matdemo1.f，然后保存到用户
使用MATLAB的目标路径中。

step 2
编译上面的程序代码。在MATLAB的命令窗口中输入：

上面的程序代码将会产生一个MAT文件matdemo.mat，用户可以
向MATLAB中加载该数据文件。向MATLAB的命令窗口中输
入“matdemo1”，得到的结果如下：

step 3
查看加载的结果。在MATLAB中的命令窗口中输入“whos -file

matdemo.mat”，得到的结果如下：

step 4
查看变量的结果。在命令窗口中输入变量名称，就可以查看具体

的参数数值：



说明

除了可以编写创建MEX文件，在MATLAB中可以使用Fortran语言来编写读取MAT文件的

MEX文件或者EXE独立应用程序，关于这方面的具体内容，可查看对应的帮助文件。

23.3 MATLAB引擎技术

前面已经花费了一定的篇幅来介绍MEX文件，下面将会介绍另外
一种和该文件思想完全相反的内容：MATLAB引擎技术，也就是在其
他应用程序中调用MATLAB的程序，例如调用MATLAB的Math库，进
行数值计算等。此外，还将简要介绍如何在MATLAB中使用引擎技
术。

23.3.1 引擎技术概念

在MATLAB中拥有一个引擎库，在该引擎库中汇集了多种函数，
用户可以在自行编写的程序代码中引用这些函数，来实现对MATLAB
的调用。也就是说，用户可以自行编写界面运行在前台，而MATLAB
作为计算引擎后台。引擎函数本身是使用C语言或者Fortran语言编写
的，在Windows平台中，它和MATLAB之间的通信是通过ActiveX实现
的，MATLAB引擎可以运用在下面的场合中：

 
◆ MATLAB在由其他语言编写的应用程序中被当作数学库程序

调用，这样就可以在其他应用程序中利用MATLAB命令简单、计算可



靠的优点。

◆ MATLAB在专门系统中当作计算引擎使用时，前台是其他应
用程序语言所编写的GUI图形接口，后台由MATLAB来进行计算，这
样可以节省用户的开发时间。

23.3.2 引擎技术应用

在前面的小节中已经介绍了关于引擎技术的内容，在本小节中将

利用一个简单的实例介绍如何使用C语言编写程序代码，在该程序代
码中调用MATLAB计算引擎。
例23.6 使用C语言编写引擎应用的实例。

step 1
打开用户系统中安装的C语言开发工具，输入下面的程序代码：







完成上面的程序代码后，将其保存为“engwindemo.c”文件，然后
保存到用户使用MATLAB的目录路径中。

step 2
编译上面的程序代码，在MATLAB的命令窗口中输入：

step 3
运行编译文件。输入代码后，按“Enter”键，在对应的目录路径中

会创建exe文件，双击该文件或者在MATLAB的命令窗口中输入：

step 4
查看程序代码的结果。输入代码后，按“Enter”键，得到的图形如

图23.2所示。



图23.2 计算结果图形

在显示计算结果图形的同时，MATLAB还将启动一个进程，该进
程仅仅包含MATLAB的命令窗口，如图23.3所示。

图23.3 在运行程序时显示的命令窗口

step 5
查看程序变量的结果。在该命令窗口中查看程序运行的所有变量

结果：



最后，该程序还会显示程序变量信息的对话框，如图23.4所示。



图23.4 程序变量信息对话框

根据该例总结出使用C语言编写引擎文件的注意事项：
 
◆ 在代码的最开始包含程序所需的头文件，在所有的C语言引擎

应用程序中，都必须包含engine.h头文件，因为该头文件声明了所有
eng函数的原型。

◆ 在程序代码中，一般需要首先定义了Engine类型的指针，该
指针类似于打开文件时的文件指针，相当于计算引擎的接口句柄，有

了这个指针就可以在C语言中执行MATLAB的各种命令。
◆ 在程序代码的最后，一般需要关闭计算引擎，这个工作需要

函数engClose来完成，通过该函数可以关闭指针来释放内存。
◆ MATLAB的计算引擎应用程序的基础流程是打开计算引擎、

设置数据、执行MATLAB命令、获取计算结果，最后关闭计算引擎。

23.4 Java接口

Java语言是当前比较流行的面向对象的高级编程语言，能够完成
各种类型的应用程序开发，MATLAB和Java之间的关系是非常密切
的，从5.x版本开始，MATLAB就包含了Java虚拟机，在MATLAB中可
以直接调用Java应用程序。Java可以填补MATLAB在功能上的一些空
白，同时由于Java本身的优势，可以通过Java语言获得大量来自互联



网或者数据库的数据。而MATLAB的优势则是对数据进行分析、科学
计算等，充分发挥各自的优势，可以极大地提高工作效率。

在本节中，将首先介绍MATLAB中的Java接口语言基础内容，然
后以一个综合实例来说明如何使用Java语言编写综合应用实例。

23.4.1 Java接口

在MATLAB中使用Java语言之前，首先有必要了解当前MATLAB
所使用的Java虚拟机的版本，用户可以使用“version -java”命令得到版
本信息：

根据上面的版本信息，选择合适的JDK版本，避免出现不兼容的
情况。

Java是一种面向对象的高级程序语言，在这种程序语言中，类和
对象是最基础的概念，如果需要创建对象，首先必须有对应的类存

在。在MATLAB中，用户可以使用三种Java类，Java内置的函数类、
第三方定义类和用户自定义类。

在MATLAB中，提供了javaclasspath来加载和显示Java内建类和由
Mathworks公司提供的第三方定义类，用户可以使用该命令查看已经
存在的Java类，结果如下：



从上面的结果可以看出，在默认情况下将分为静态和动态Java路
径，其中静态路径主要用来保存稳定、静态的Java类，而对于需要编
辑的Java类，则建议保存在动态路径中。在默认情况下，classpath.txt
文件会保存在toolbox\local路径下，具体信息如下：

在默认情况下，MATLAB本身会自动加载Java的内置函数类，为
了查看当前使用的MATLAB中加载的所有函数类名，可以使用inmem
命令查看所有的类名，信息如下：



说明

在上面的程序代码中，m数组表示的内容是系统加载的M文件，x表示系统加载的MEX文

件，j表示的是系统加载的Java函数类。

 
在MATLAB中，用户可以直接使用Java类定义和javaObject函数创

建Java对象，这两种使用方法都比较简单，下面使用实例来简要说



明。

例23.7 在MATLAB中创建Java对象。

step 1
创建Java对象。在MATLAB的命令窗口中输入下面的程序代码：

step 2
查看程序代码的结果。在命令窗口中输入 “whos”，然后

按“Enter”键，得到的结果如下：

step 3
查看Java对象。在MATLAB的命令窗口中查看具体的变量信息：



说明

在上面的程序代码中，分别使用Java内置函数和javaObject函数来创建Java对象，可以从

该例了解到MATLAB中创建Java对象的方法。

 
例23.8 在MATLAB中对Java对象进行操作。

step 1
在MATLAB的命令窗口中输入下面的程序代码：

step 2
查看变量的结果。在命令窗口中输入变量名称，得到的结果如

下：



说明

在上面的程序代码中，首先直接使用Java类定义创建了Java对象，然后分别根据变量类型

将两组不同的变量进行连接操作。

 
例23.9 在MATLAB中设置Java对象的属性。

step 1
在MATLAB的命令窗口中输入下面的程序代码：

在这段程序代码中，使用setTitle命令设置了frame对象的标题属
性，然后使用getTitle命令来获取该对象的属性。

step 2



使用javaMethod函数设置Java对象的属性。在命令窗口中输入下
面的程序代码：

提示

在这段程序代码中，使用的Java方法是startsWith，来检测gAddress字符串对象是否

以“str”字符串对象作为开头，得到的结果是1，表明检测结果正确，也就是说，gAddress字符

串对象的确以“str”字符串对象作为开头。

 
例23.10 在MATLAB中创建Java类型的数据。

step 1
创建Java数据类型的数组。在MATLAB的命令窗口中输入下面的

程序代码：

step 2
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：



说明

在这段程序中，首先使用javaArray命令创建了一个3行4列的Java数值数组，而且该数组

中的数值类型为java.lang.Double，然后使用循环语句来添加每一个数组的数值，得到最后的

结果。

 
例23.11 在MATLAB中，将Java类型的数据转换为MATLAB中的

元胞数组。

step 1
在MATLAB的命令窗口中输入下面的程序代码：

step 2
查看程序代码的结果。输入代码后，按“Enter”键，得到的结果如

下：



说明

在上面的程序代码中，依次创建了Java类型的双精度、points和字符串数据类型，然后使

用cell命令将其转换为MATLAB中的元胞数组。

23.4.2 Java接口应用

在本小节中，将以一个比较综合的案例来说明如何在MATLAB中
编写Java接口程序代码，该程序代码的主要功能是实现用户电话号码
的交互操作，实现数据的添加、删除、显示等综合功能，下面分步骤

详细介绍。

例23.12 在MATLAB中编写用户电话号码本的Java接口程序代
码。

step 1
打开M语言编辑器，然后在编辑器中输入下面的程序代码：







上面的程序代码是该程序代码的主函数，在程序代码的开头首先

处理的是电话号码文件的路径，如果用户在运行程序代码之前就已经

创建了电话号码文件，则返回该文件的路径全称；如果没有创建电话

号码文件，则重新创建java.io.FileOutputStream对象来添加电话号码数
据。当程序代码创建了电话号码对象，则提供用户选择对应的操作，

然后主函数将需要调用对应的子函数完成对应的操作。

step 2
添加所有的子函数程序代码。在M语言编辑器中输入下面的程序

代码：







完 成 上 面 的 程 序 代 码 后 ， 将 所 有 的 程 序 代 码 保 存

为“phonebook.m”文件，然后将其保存到用户所使用的MATLAB路径
中。

step 3
运行程序代码。在MATLAB的命令窗口中输入“phonebook”，得到

的结果如下：



step 4
添加新的数据。上面的程序代码中，查看了原始的数据文件，在

后面的步骤中，用户可以在该文件中添加新的数据，具体的信息如

下：



说明



用户还可以检测该程序代码的其他功能，在本章中，限于篇幅，在这里就不一一检测具

体功能了，请用户自行尝试。

23.5 小结

在本章中，主要介绍了在MATLAB中如何使用C或者Fortran语言
创建MEX文件和MAT文件，然后介绍了MATLAB的引擎技术和Java接
口的内容，这些内容是MATLAB程序接口的重要内容，希望读者仔细
分析。

◆   ◆   ◆
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